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Πρόλογος 
Ζώντας στην εποχή του διαδικτύου, είναι δύσκολο να φανταστούμε μια εφαρμογή που να μην περιέχει συν-
δυασμό εικόνων, ήχων και βίντεο. Η συνύπαρξη πολλαπλών μέσων σε μια εφαρμογή, απαιτεί αρκετές γνώ-
σεις και δεξιότητες. Το παρόν βιβλίο εξετάζει, αρχικά, τα θεωρητικά θέματα που σχετίζονται με τα επιμέρους 
μέσα που συνθέτουν τις εφαρμογές πολυμέσων. Κάθε κεφάλαιο ξεκινά με τις απαιτήσεις ψηφιακής αναπαρά-
στασης των δεδομένων κάποιου μέσου, για παράδειγμα ήχου, και συνεχίζει με τις βασικές ιδιότητες του μέ-
σου, που επηρεάζουν την κωδικοποίηση, την προβολή και την επεξεργασία του. Στη συνέχεια παρουσιάζο-
νται τα βασικά λογισμικά και το υλικό που απαιτείται για την επεξεργασία του κάθε μέσου. Με αυτό τον τρό-
πο, ο αναγνώστης λαμβάνει μια σφαιρική ενημέρωση σχετικά με τις ιδιότητες και τις συνηθέστερες επεξερ-
γασίες κάθε μέσου. Η σχεδίαση εφαρμογών που περιέχουν πολλαπλά μέσα, εξετάζεται στη συνέχεια.  

Στο δεύτερο τμήμα του βιβλίου, μέσα από βήμα-προς-βήμα ασκήσεις, εξηγούνται οι δυνατότητες των 
σύγχρονων λογισμικών επεξεργασίας εικόνων, διανυσματικών γραφικών, ήχου, τρισδιάστατων γραφικών, 
σχεδιοκίνησης και βίντεο. Σε κάθε κεφάλαιο παρουσιάζεται κάποιο διαδεδομένο εμπορικό εργαλείο και ένα 
δωρεάν λογισμικό, αντίστοιχων δυνατοτήτων. Με αυτόν τον τρόπο, γίνεται κατανόηση των θεωρητικών θε-
μάτων που αναλύθηκαν στα προηγούμενα κεφάλαια και υποστηρίζεται η απόκτηση πρακτικών δεξιοτήτων. 
Ταυτόχρονα, γίνεται εκμάθηση και δωρεάν εργαλείων, που παρέχουν συγκρίσιμες δυνατότητες με αυτές των 
εμπορικών εργαλείων. Στο τέλος του βιβλίου γίνεται αναφορά σε τεχνολογίες που μπορούν να υποστηρίξουν 
την ανάπτυξη πολυμεσικών εφαρμογών στο διαδίκτυο. 

Πιστεύουμε ότι το παρόν βιβλίο είναι χρήσιμο για μαθήματα πολυμέσων, αλλά και πολλά άλλα μαθή-
ματα πληροφορικής. Η ανάπτυξη σύγχρονων εφαρμογών για το διαδίκτυο και τις κινητές συσκευές και η ανά-
πτυξη εφαρμογών εκπαιδευτικής τεχνολογίας, προϋποθέτουν την κατανόηση πολλών εννοιών που παρουσιά-
ζονται στο βιβλίο και θεωρούμε ότι το εγχειρίδιο θα αποτελέσει βασικό βοήθημα και για αυτά τα αντικείμενα. 
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Εισαγωγή 
Οι εφαρμογές πολυμέσων είναι εφαρμογές λογισμικού, που συνδυάζουν διάφορα μέσα, όπως κείμενο, εικό-
νες, ήχους, γραφικά τριών διαστάσεων, σχεδιοκινήσεις και βίντεο. Βαρύνουσα σημασία έχει η κατανόηση 
των ιδιοτήτων και των εργαλείων επεξεργασίας των μεμονωμένων ψηφιακών μέσων.  

Στο πρώτο μέρος του βιβλίου, που αποτελείται από τα κεφάλαια 1 έως 6, μελετώνται τα χαρακτηρι-
στικά των μέσων που αποτελούν μια εφαρμογή πολυμέσων. 

 
 Στο πρώτο κεφάλαιο γίνεται εισαγωγή στην έννοια των πολυμέσων και τη σχετική ορολογία 

που εμφανίζεται στη βιβλιογραφία.  
 

 Στο δεύτερο κεφάλαιο γίνεται παρουσίαση των θεμάτων που σχετίζονται με την επεξεργασία 
ψηφιογραφικών εικόνων και διανυσματικών γραφικών (vector graphics). 

 
 Στο κεφάλαιο τρία παρουσιάζονται έννοιες που σχετίζονται με την ψηφιοποίηση του ήχου και 

την κωδικοποίηση, τη συμπίεση και την επεξεργασία του ψηφιακού ήχου. 
 

 Στο κεφάλαιο τέσσερα γίνεται ανάλυση των βασικών θεμάτων που σχετίζονται με τα τρισδιά-
στατα γραφικά και τη σχεδιοκίνηση. 

 
 Στο πέμπτο κεφάλαιο παρουσιάζονται κάποια θέματα που αφορούν στο ψηφιακό βίντεο, αλλά 

και ζητήματα που αφορούν το αναλογικό βίντεο και τη μετατροπή του σε ψηφιακή μορφή. 
 

 Στο τελευταίο κεφάλαιο της πρώτης ενότητας, δηλαδή στο κεφάλαιο έξι, εστιάζουμε στη 
σχεδίαση και την ανάπτυξη εφαρμογών πολυμέσων. 

 

Το δεύτερο μέρος του βιβλίου αποτελείται από τα κεφάλαια 7 έως 12. Αποτελεί το εργαστηριακό 
τμήμα του βιβλίου, καθώς σε κάθε κεφάλαιο παρουσιάζονται βήμα-προς-βήμα ασκήσεις σε ένα εμπορικό και 
ένα δωρεάν λογισμικό. Πιο συγκεκριμένα: 

 
 Στο κεφάλαιο επτά παρουσιάζονται οι δυνατότητες των εργαλείων Adobe Photoshop και 

Gimp. Το πρώτο λογισμικό είναι το πιο γνωστό εργαλείο επεξεργασίας ψηφιογραφικών εικό-
νων, ενώ το Gimp αποτελεί το πιο γνωστό ελεύθερο εργαλείο επεξεργασίας εικόνων. 

 
 Στο όγδοο κεφάλαιο του βιβλίου παρουσιάζουμε κάποιες από τις δυνατότητες του εμπορικού 

εργαλείου Adobe Illustrator και του δωρεάν εργαλείου Inkscape. Και τα δύο αποτελούν ερ-
γαλεία επεξεργασίας διανυσματικών γραφικών. 

 

 Στο κεφάλαιο εννέα εστιάζουμε στα εργαλεία επεξεργασίας ήχου Adobe Audition και 
Audacity. 

 

 Στο δέκατο κεφάλαιο του εγχειριδίου παρουσιάζεται το εργαλείο 3ds Max της Autodesk και 
το εργαλείο ανοιχτού κώδικα Blender. Και τα δύο εργαλεία χρησιμοποιούνται για τη δημι-
ουργία γραφικών τριών διαστάσεων και animations. 

 

 Το κεφάλαιο έντεκα του βιβλίου παρουσιάζουμε τις συνηθέστερες δυνατότητες του εργαλείου 
επεξεργασίας βίντεο Adobe Premiere Pro και του ελεύθερου λογισμικού Avidemux. 

 

 Στο κεφάλαιο δώδεκα, που αποτελεί το τελευταίο κεφάλαιο του βιβλίου, γίνεται επισκόπηση 
των βασικών χαρακτηριστικών της HTML5 και ιδιαίτερα των χαρακτηριστικών που συνδέο-
νται με την ανάπτυξη πολυμεσικών εφαρμογών. 

 
Η διάρθρωση του βιβλίου και ο χωρισμός του σε δύο λογικές ενότητες, που αφορούν, αντίστοιχα, θε-

ωρητικά και πρακτικά ζητήματα, το καθιστούν λειτουργικό για τη χρήση του σε θεωρητικά και εργαστηριακά 
μαθήματα. 
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1. Εισαγωγή στα πολυμέσα 
 

Σύνοψη 
Στο τρέχον σύντομο κεφάλαιο γίνεται εισαγωγή στην έννοια των πολυμέσων και τη σχετική ορολογία που εμφα-
νίζεται στη βιβλιογραφία. Ορίζονται, επίσης, οι έννοιες της διαδραστικότητας και της πλοήγησης μέσω υπερσυν-
δέσμων. Δίνεται μια σύντομη ιστορική αναδρομή και εξηγούνται τα βασικά δομικά στοιχεία των εφαρμογών 
πολυμέσων και τα βασικά εργαλεία επεξεργασίας και ταυτόχρονα αναλύεται η διάρθρωση του βιβλίου. 

 
 

1.1. Βασικές έννοιες 
 
Οι περισσότερες σύγχρονες εφαρμογές είναι πολυμεσικές και διαδραστικές. Οι δύο αυτές έννοιες συναντώ-
νται συχνά πυκνά, ακόμη και σε τηλεοπτικές διαφημίσεις. Τι είναι, λοιπόν, τα πολυμέσα (multimedia); Ως 
πολυμέσα ή πολυμεσικές εφαρμογές, μπορούμε να ορίσουμε όλες τις εφαρμογές που συνδυάζουν κείμενο, 
εικόνες, βίντεο, ήχους και animation (π.χ. Εικόνα 1.1). Δεν είναι απαραίτητο να έχουν όλες τις κατηγορίες 
αυτών των μέσων, αλλά οπωσδήποτε κείμενο και εικόνες και κάποιο από τα άλλα τρία μέσα είναι απαραίτη-
το. Ζώντας βέβαια στην εποχή του διαδικτύου, είναι δύσκολο να φανταστούμε μια εφαρμογή που να μην πε-
ριέχει κάποιο συνδυασμό των παραπάνω μέσων και τελικά να εξαιρείται του παραπάνω ορισμού.  

 

 
 
Εικόνα 1.1 Πολυμεσική εφαρμογή στο διαδίκτυο. 

 
Η ορολογία «εφαρμογές ψηφιακών μέσων» (digital media applications ή απλά digital media) κερδίζει 

έδαφος σε σχέση με την ορολογία πολυμέσα ή πολυμεσικές εφαρμογές. Σε κάθε περίπτωση, όταν η εφαρμογή 
είναι πλούσια σε χρήση εικόνων, βίντεο, ήχου και άλλων μέσων, τότε θεωρείται ότι εμπίπτει στον παραπάνω 
ορισμό. Οι εφαρμογές πολυμέσων μπορούν να εκτελεστούν και σε συσκευές, όπως οι νέες έξυπνες τηλεορά-
σεις (Εικόνα 1.2). 

Βασικό σημείο των εφαρμογών πολυμέσων συνιστά η διαδραστικότητα ή (interactivity). Πρακτικά, 
η διαδραστικότητα δηλώνει τη δυνατότητα να αλληλεπιδρούμε με την εφαρμογή και να καθορίζουμε την εξέ-
λιξή της. Αυτό επιτυγχάνεται μέσω των διαθέσιμων επιλογών που μας δίνει η εφαρμογή για τον καθορισμό 
της σειράς ή του τρόπου εμφάνισης των πληροφοριών της. Οι εφαρμογές που δεν επιτρέπουν την επέμβαση 
στη εξέλιξη της εφαρμογής, ονομάζονται μη αλληλεπιδραστικές ή παθητικές. Η παρουσίαση των πληροφο-
ριών σε αυτή την περίπτωση είναι προκαθορισμένη και ο χρήστης έχει, κατά κύριο λόγο, τη δυνατότητα να 
εκκινήσει και να τερματίσει την εφαρμογή. Για παράδειγμα, μια παρουσίαση είναι μη αλληλεπιδραστική, ό-
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ταν δεν μπορούμε να κάνουμε κάποιο κλικ, ούτε να αλλάξουμε την προκαθορισμένη ροή των πληροφοριών 
της.  

 

 
 
Εικόνα 1.2 Πολυμεσικές εφαρμογές σε έξυπνες τηλεοράσεις. 

 
Στη βιβλιογραφία εμφανίζεται, επίσης, ο όρος “interactive multimedia” (αλληλεπιδραστικά πολυμέσα), 

ο οποίος αναφέρεται στη δυνατότητα αλληλεπίδρασης στις εφαρμογές πολυμέσων. Με την εξέλιξη της τε-
χνολογίας και τη δυνατότητα αλληλεπίδρασης, σχεδόν σε όλες τις εφαρμογές πολυμέσων, δεν υπάρχει ανά-
γκη για την παραπάνω ορολογία. Βέβαια, ο όρος διατηρείται, όπως μπορούμε να διαπιστώσουμε με μια ανα-
ζήτηση στο διαδίκτυο, κυρίως για να τονιστεί η δυνατότητα της αλληλεπίδρασης.  

Μια άλλη έννοια που σχετίζεται με τα πολυμέσα είναι η πλοήγηση (navigation), η οποία αναφέρεται 
στη διαδικασία αναζήτησης και εξερεύνησης των πληροφοριών της εφαρμογής. Με διαφορετικά λόγια, πρό-
κειται για τη δυνατότητα μεταφοράς στα διαφορετικά τμήματα της εφαρμογής, π.χ. στις διαφορετικές σελίδες 
της μέσω κάποιου μενού που προσφέρει. Στις σύγχρονες εφαρμογές η δομή της εφαρμογής είναι πολύπλοκη, 
έχοντας τη μορφή γράφου, όπου δηλαδή κάθε τμήμα της εφαρμογής μπορεί να συνδέεται με διάφορα άλλα 
τμήματά της. 

Η δυνατότητα αλληλεπίδρασης και οι δυνατές διαδρομές πλοήγησης στην εφαρμογή δημιουργούνται 
με τη χρήση συνδέσμων (links) ή υπερ-συνδέσμων (hyperlinks). Οι σύνδεσμοι είναι σημεία σε μια εφαρμο-
γή, όπου μπορούμε να κάνουμε κλικ με το ποντίκι ή με την αφή σε μια οθόνη αφής, και να μεταφερθούμε σε 
κάποιο άλλο σημείο της εφαρμογής. Οι εφαρμογές που συνδέονται με τη χρήση συνδέσμων και περιέχουν 
μόνο πληροφορίες σε μορφή κειμένου, ονομάζονται υπερ-κείμενα (hypertext). Οι εφαρμογές που περιέχουν 
και άλλα μέσα, π.χ. εικόνες, όπου μπορούμε να έχουμε και συνδέσμους πάνω σε εικόνες, καλούνται υπερμέ-
σα (hypermedia). Παλαιότερα ο όρος αυτός παρέπεμπε σε διαδικτυακά πολυμέσα. Οι όροι πολυμέσα, υπερ-
μέσα, και διαδραστικά πολυμέσα χρησιμοποιούνται πλέον ως ισοδύναμοι.  

Θα πρέπει να αναφερθεί εδώ ότι η οργάνωση των πληροφοριών στη λογική ενός υπερμεσικού συστή-
ματος είχε προταθεί αρχικά το 1945 από τον Vannevar Bush στην εργασία του “As We May Think” (The 
Atlantic Monthly, 1945). Στην εργασία αυτή περιέγραφε τα χαρακτηριστικά ενός συστήματος υπερμέσων, 
που θα περιείχε πληροφορίες διαφόρων ειδών, κείμενο, εικόνες, ήχους κ.ά., τα οποία θα συσχετίζονταν μετα-
ξύ τους μέσω των συνδέσμων. Η πρώτη, όμως, εφαρμογή υπερκείμενου και ο όρος hypertext κατέστη εφικτή 
τη δεκαετία ’60 από τον Ted Nelson. Το 1989 ο Tim Berners Lee δημιούργησε το γνωστό μας World Wide 
Web στο Ευρωπαϊκό Ερευνητικό κέντρο CERN, που πρακτικά είναι η πλατφόρμα εκτέλεσης όλων των σύγ-
χρονων εφαρμογών πολυμέσων. 

 

1.2. Δομικά στοιχεία: χαρακτηριστικά και εργαλεία 
 
Τα βασικά στοιχεία που περιλαμβάνουν οι εφαρμογές πολυμέσων είναι: 

 Κείμενο 
 Εικόνα 
 Ήχος 
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 Γραφικά 3D 
 Animation (σχεδιοκίνηση) 
 Βίντεο 

 
Όσον αφορά το κείμενο θα μείνουμε μόνο στο γεγονός, ότι αποτελεί το απλούστερο, αλλά ταυτόχρο-

να και το πιο διαδομένο, μέσο παρουσίασης των πληροφοριών σε οποιαδήποτε εφαρμογή πολυμέσων. Το 
κείμενο μπορεί να υπάρχει απευθείας στην εφαρμογή ή να υπάρχουν παραπομπές σε εξωτερικά αρχεία κειμέ-
νου, κυρίως, σε μορφή PDF. Το κείμενο στην εφαρμογή μπορεί να υπάρχει σε μορφή HTML, δηλαδή μέσα 
σε ειδικές ετικέτες, που σηματοδοτούν τη μορφή που θα έχει το κείμενο, όταν εμφανιστεί, όπως απεικονίζεται 
π.χ. στην Εικόνα 1.3. Το κείμενο χρησιμοποιείται για να παρουσιάσει το περιεχόμενο της εφαρμογής ή για 
την παρουσίαση κάποιου μηνύματος ή εμφανίζεται στα κουμπιά πλοήγησης. Σε σχέση με το κείμενο, κυρίως 
εστιάζουμε στην κατάλληλη επιλογή γραμματοσειράς και στη σωστή επιλογή του μεγέθους, ώστε να εμφανί-
ζεται σωστά σε οποιαδήποτε συσκευή προβολής. 

 

 
 
Εικόνα 1.3 Κείμενο σε μορφή HTML και το αποτέλεσμα εμφάνισης. 

 
Η εικόνα αποτελεί, επίσης, ένα συνηθισμένο μέσο για την παρουσίαση πληροφοριών σε οπτικοποιη-

μένη μορφή. Μια εικόνα μπορεί να είναι φωτογραφία που έχει ληφθεί με κάποια ψηφιακή φωτογραφική μη-
χανή ή ένα σχέδιο που έχει δημιουργηθεί με υπολογιστή. Τα θέματα που αφορούν τις εικόνες είναι ποικίλα 
και αφορούν τον τρόπο αναπαράστασης της οπτικής πληροφορίας στον υπολογιστή, τον τρόπο κωδικοποίη-
σης του χρώματος, το μέγεθος και τη συμπίεση των εικόνων και την επεξεργασία τους. Η επεξεργασία εικό-
νων ποικίλει από την απλή αλλαγή μεγέθους μέχρι χρωματικές βελτιώσεις και προσθήκη εφέ (π.χ. Εικόνα 
1.4). Στα κεφάλαια 2, 7 και 8 του τρέχοντος βιβλίου μελετώνται όλα αυτά τα θέματα. Στο κεφάλαιο 2 γίνεται 
παρουσίαση των χαρακτηριστικών του υλικού (ψηφιακές κάμερες, σαρωτές, οθόνες, εκτυπωτές κ.ά.), που 
αφορούν στην ψηφιοποίηση, προβολή και εκτύπωση ψηφιακών εικόνων. 

 

 
 
Εικόνα 1.4 Αρχική εικόνα και εφαρμογή εφέ. 

 
Για την επεξεργασία εικόνων υπάρχουν διαθέσιμα διάφορα λογισμικά με πιο γνωστό από αυτά να εί-

ναι το Adobe Photoshop. Συγκρίσιμες δυνατότητες έχει και το εργαλείο ανοιχτού κώδικα Gimp. Για τις δια-
νυσματικές εικόνες, που αποτελούνται από ένα σύνολο γεωμετρικών σχημάτων, τα πιο γνωστά λογισμικά 
επεξεργασίας είναι το Adobe Illustrator και το δωρεάν Inkscape. Όλα αυτά τα λογισμικά εξετάζονται στα κε-
φάλαια 7 και 8 του βιβλίου, μέσα από βήμα-προς-βήμα ασκήσεις με αναλυτικές εξηγήσεις των θεμάτων που 
προκύπτουν. 

Ο ήχος προστίθεται σε πολλές εφαρμογές πολυμέσων, ως εναλλακτικός τρόπος παρουσίασης των 
πληροφοριών ή για την ενημέρωση του χρήστη σε περίπτωση λάθους. Η ψηφιοποίηση ηχητικών σημάτων, η 
συμπίεση, οι συνήθεις επεξεργασίες, οι δυνατότητες του λογισμικού επεξεργασίας και το απαραίτητο υλικό 
μελετώνται στο κεφάλαιο 3. Ο ήχος εμφανίζεται με τη μορφή κυματομορφής, όπως βλέπουμε στην Εικόνα 
1.5, στα εργαλεία επεξεργασίας. Στο κεφάλαιο 8 γίνεται παρουσίαση των λογισμικών επεξεργασίας ήχου 
Adobe Audition και του εργαλείου ανοιχτού κώδικα Audacity μέσα από βήμα-προς-βήμα ασκήσεις. 
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Εικόνα 1.5 Αναπαράσταση του ήχου ως κυματομορφή. 

 
Οι σχεδιοκινήσεις (animation) είναι κινήσεις σχεδίων, που δημιουργούνται στο υπολογιστή με ειδικό 

λογισμικό. Τα ίδια λογισμικά χρησιμοποιούνται και για τη δημιουργία τρισδιάστατων γραφικών (3D). Η από-
δοση τρισδιάστατης όψης (Εικόνα 1.6), η προσθήκη υφής, σκιών και οι μέθοδοι κίνησης των τρισδιάστατων 
γραφικών μελετώνται στο κεφάλαιο 4. Πολλά από τα θέματα που αφορούν στην εικόνα, π.χ. χρωματικά μο-
ντέλα, αφορούν και στα τρισδιάστατα γραφικά. Φυσικά, στο αντίστοιχο κεφάλαιο εστιάζουμε στα θέματα που 
σχετίζονται αμιγώς με την απόδοση τρισδιάστασης όψης και της κίνησης των αντικειμένων στο χώρο. Στο 
κεφάλαιο 10 περιγράφουμε την υλοποίηση κάποιων από αυτές τις τεχνικές στα εργαλεία Autodesk 3ds Max 
και Blender. Το δεύτερο εργαλείο είναι ανοιχτού κώδικα, αλλά έχει πάρα πολλές δυνατότητες. 

 

 
[Πηγή: http://goo.gl/C7tUiI] 
 
Εικόνα 1.6 Σχήματα με τρισδιάστατη όψη. 

 
Η λήψη βίντεο αποτελεί μια καθημερινή ενασχόληση σχεδόν όλων των ανθρώπων που διαθέτουν κά-

ποιο είδος ψηφιακής κάμερας. Και στις εφαρμογές πολυμέσων το βίντεο έχει ουσιαστικό ρόλο, αφού μπορεί 
να χρησιμοποιηθεί για την παρουσίαση πολλών εννοιών με εύληπτο τρόπο. Τα θέματα που αφορούν στην 
επεξεργασία του βίντεο είναι πολλά, με κυρίαρχο ζήτημα τη συμπίεση, ώστε να είναι εφικτή η μεταφορά βί-
ντεο υψηλής ευκρίνειας, μέσω των δικτύων υπολογιστών και του διαδικτύου. Άλλα θέματα που αφορούν 
στην επεξεργασία βίντεο είναι η ανάλυση του βίντεο, τα πρότυπα μετάδοσης, τα μορφότυπα αποθήκευσης, το 
λογισμικό επεξεργασίας και το υλικό για σύλληψη και προβολή βίντεο. Τα θέματα αυτά παρουσιάζονται στο 
κεφάλαιο 5, ενώ στο κεφάλαιο 11 δίνονται οδηγίες βήμα-προς-βήμα για το εργαλείο Adobe Premiere Pro και 
για το δωρεάν εργαλείο Avidemux. 

Η σύνθεση των μεμονωμένων μέσων σε μια ολοκληρωμένη παρουσίαση, με την οποία οι χρήστες 
μπορούν να αλληλεπιδρούν, γίνεται με διάφορα εργαλεία. Εφαρμογές που συνδέουν διαφορετικά μέσα μπορεί 
να γίνουν ακόμη και στο PowerPoint, αλλά και σε αντίστοιχης λογικής εργαλεία. Όταν, όμως, απαιτείται κάτι 
περισσότερο διαδραστικό, τότε πρέπει να χρησιμοποιήσουμε πιο εξειδικευμένα εργαλεία και τεχνολογίες. 
Παραδείγματα τέτοιων τεχνολογιών είναι οι Flash και HTML5 (Εικόνα 1.7), που προσφέρουν τη δυνατότητα 
για υψηλού βαθμού διαδραστικότητα. Η HTML5 κερδίζει έδαφος σε σχέση με την τεχνολογία Flash και υπο-
στηρίζεται σχεδόν από όλους τους φυλλομετρητές ιστοσελίδων. Η HTML5 καλύπτεται στο κεφάλαιο 12 του 
βιβλίου. Για την HTML5 υπάρχουν ειδικά εργαλεία, όπως για παράδειγμα το δωρεάν H5P (https://h5p.org/), 
τα οποία μας βοηθούν να αναπτύξουμε διαδραστικές εφαρμογές με χρήση έτοιμων προτύπων (templates) ι-
στοσελίδων. Στο κεφάλαιο 6 εστιάζουμε στη σχεδίαση των εφαρμογών, τους ρόλους που απαιτούνται κατά 
την ανάπτυξη και τα εργαλεία ανάπτυξης ολοκληρωμένων εφαρμογών. 
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Εικόνα 1.7 Διαδραστική εφαρμογή στην HTML5. 

 
Γενικά, η ανάπτυξη διαδικτυακών πολυμεσικών εφαρμογών έχει απλοποιηθεί αρκετά ως διαδικασία, 

καθώς οι περισσότεροι ιστοχώροι παρέχουν έτοιμες πρότυπες ιστοσελίδες, που απλά πρέπει να «γεμίσουμε» 
με υλικό διαφόρων μορφών, π.χ. Εικόνα 1.8. Επιπλέον, επειδή οι πολυμεσικές εφαρμογές προορίζονται κυρί-
ως για εκπαιδευτικούς σκοπούς, έχουν αναπτυχθεί εργαλεία. όπως το Moodle (https://moodle.org/) και άλλες 
διαδικτυακές πλατφόρμες για ηλεκτρονική μάθηση, όπου μπορούμε να αναπτύξουμε ολοκληρωμένες εκπαι-
δευτικές εφαρμογές με υλικό αξιολόγησης και επιμέρους εργαλεία επικοινωνίας των μαθητών.  
 

 
 
Εικόνα 1.8 Πρότυπες ιστοσελίδες για δημιουργία ενός νέου δικτυακού τόπου. 

 

1.3. Ανακεφαλαίωση 
 
Οι εφαρμογές πολυμέσων είναι εφαρμογές παρουσίασης πληροφοριών, που συνδυάζουν κάποια από τα μέσα 
κείμενο, εικόνες, γραφικά τριών διαστάσεων, σχεδιοκινήσεις, ήχους και βίντεο. Η ανάπτυξη εφαρμογών πολ-
λαπλών μέσων, με δυνατότητες διάδρασης, αποτελεί μια σχετικά εύκολη διαδικασία, λόγω των δυνατοτήτων 
των σύγχρονων εργαλείων ανάπτυξης. Συνεπώς, βαρύνουσα σημασία έχει η κατανόηση των ιδιοτήτων και 
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των εργαλείων επεξεργασίας των μεμονωμένων ψηφιακών μέσων. Στα επόμενα κεφάλαια εστιάζουμε στα 
χαρακτηριστικά και τις τεχνολογίες που αφορούν τα δεδομένα εικόνας και ήχου, των τρισδιάστατων γραφι-
κών και των σχεδιοκινήσεων, καθώς και δεδομένα σε μορφή βίντεο, ενώ παράλληλα μελετάμε τα δημοφιλέ-
στερα εργαλεία επεξεργασίας τους. 
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2. Θεωρία Ψηφιακής Εικόνας 
 

Σύνοψη 
Στο συγκεκριμένο κεφάλαιο γίνεται ανάλυση των βασικών θεμάτων που σχετίζονται με την επεξεργασία των 
εικόνων. Αρχικά, γίνεται η διάκριση μεταξύ ψηφιογραφικών εικόνων (bitmap graphics) και διανυσματικών 
γραφικών (vector graphics). Στη συνέχεια, αναλύεται η διαδικασία ψηφιοποίησης και εξηγούνται κάποια βασι-
κά χαρακτηριστικά των εικόνων, όπως η ανάλυση και το βάθος χρώματος. Τα μοντέλα αναπαράστασης των 
χρωμάτων RGB, CMY, RYB, HSB, HSL, HSI & CIE Lab παρουσιάζονται στις επόμενες ενότητες. Ο υπολογι-
σμός του μέγεθος των εικόνων bitmap και ειδικά θέματα, όπως η διαφάνεια, το δεικτοδοτούμενο χρώμα και η 
συμπίεση, παρουσιάζονται στη συνέχεια. Η ενότητα για τις εικόνες bitmap ολοκληρώνεται με τη μελέτη των πιο 
δημοφιλών μορφοτύπων, BMP, JPEG, PNG κ.α. και την παρουσίαση των γνωστότερων εμπορικών και ελευθέ-
ρων εργαλείων λογισμικού για την επεξεργασία τους. Η επόμενη ενότητα του κεφαλαίου αναφέρεται στα διανυ-
σματικά γραφικά και εξηγεί θέματα, όπως ο τρόπος δημιουργίας τους, οι ομοιότητές τους και οι διαφορές τους 
με τις εικόνες bitmap, οι δημοφιλείς μορφές αρχείων και το λογισμικό εργασίας τους. Το κεφάλαιο ολοκληρώνε-
ται με την παρουσίαση των χαρακτηριστικών του υλικού για ψηφιοποίηση, επεξεργασία, προβολή και εκτύπωση 
των εικόνων. 

 

Προαπαιτούμενη γνώση 
Το παρόν κεφάλαιο αποτελεί αυτόνομη ενότητα παρουσίασης αρκετών θεμάτων που σχετίζονται με την ψηφιο-
ποίηση, αποθήκευση, επεξεργασία, προβολή και εκτύπωση εικόνων. Δεν απαιτούνται ιδιαίτερες γνώσεις για τη 
μελέτη του κεφαλαίου, παρά μόνο η κατοχή βασικών γνώσεων σχετικά με την ψηφιακή τεχνολογία, π.χ. η κατα-
νόηση του δυαδικού συστήματος, των μονάδων μέτρησης του μεγέθους αρχείων, η χρήση λογισμικού.  

 

2.1. Εισαγωγή 
 
Η εικόνα αποτελεί ίσως το πιο σημαντικό μέσο παρουσίασης και μετάδοσης μηνυμάτων σε όλες τις σύγχρο-
νες διαδικτυακές και πολυμεσικές εφαρμογές. Ψηφιακές εικόνες σε διάφορες μορφές και κυρίως σε μορφή 
JPEG, ανταλλάσσονται σε καθημερινή βάση είτε μέσω κινητών τηλεφώνων είτε μέσω υπολογιστών σε κοι-
νωνικά δίκτυα. Φωτογραφίες και σχέδια χρησιμοποιούνται σε όλα τα ηλεκτρονικά και εκτυπωμένα έγγραφα. 
Οι ψηφιακές εικόνες διακρίνονται σε δυο κατηγορίες:  

 
 τις ψηφιογραφικές (ή αλλιώς χαρτογραφικές ή γραφικά πλέγματος) (bitmap ή raster 

graphics),  
 και τις διανυσματικές (vector graphics).  

 
Οι ψηφιογραφικές εικόνες ή πιο απλά τα γραφικά bitmap, όπως αναφέρονται πολλές φορές ακόμη και 

στην Ελληνική βιβλιογραφία, δημιουργούνται από ένα σύνολο κουκκίδων που ονομάζονται εικονοστοιχεία 
(pixels – picture elements). Τα διανυσματικά γραφικά δημιουργούνται από επιμέρους σχήματα (π.χ. γραμμές, 
κύκλους, ορθογώνια) στα οποία εφαρμόζονται διάφοροι μαθηματικοί μετασχηματισμοί, διαφορετικά χρώμα-
τα και υφές.  

Η χρήση εικόνων εγείρει πολλά θέματα που ποικίλουν από τον τρόπο ψηφιοποίησης και τον τρόπο 
αναπαράστασης του χρώματος, ως τη μορφή αποθήκευσης και τη συμπίεση των εικόνων. Το παρόν κεφάλαιο 
παρουσιάζει αυτά τα θέματα ξεκινώντας από την ψηφιοποίηση των εικόνων και καταλήγοντας στην παρουσί-
αση των δημοφιλέστερων εργαλείων επεξεργασίας εικόνων και του υλικού ψηφιοποίησης, προβολής και ε-
κτύπωσης εικόνων. 

 

2.2. Ψηφιοποίηση 
 

Η ψηφιοποίηση (digitization) εικόνων είναι μετατροπή φωτογραφιών και σχεδίων από αναλογική μορφή 
(π.χ. τυπωμένες φωτογραφίες) σε ψηφιακή μορφή για περαιτέρω επεξεργασία. Η ψηφιοποίηση εικόνων γίνε-
ται με τη βοήθεια σαρωτών ή απευθείας με τη χρήση ψηφιακών φωτογραφικών μηχανών. Κατά τη διαδικασία 
ψηφιοποίησης η αρχική πληροφορία μετατρέπεται σε ακολουθίες δυαδικών ψηφίων. Ο τρόπος αναπαράστα-
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σης των ψηφιακών δεδομένων και ο αποθηκευτικός χώρος που απαιτείται, εξαρτάται από τη μορφή αποθή-
κευσης των δεδομένων, την ύπαρξη ή όχι χρώματος και τις διαστάσεις της εικόνας. Το υλικό (hardware) ψη-
φιοποίησης, οι μορφοποιήσεις αρχείων για αποθήκευση εικόνων και ο τρόπος αναπαράστασης του χρώματος 
θα συζητηθούν στις πιο κάτω ενότητες. 

Όπως αναφέρθηκε στο εισαγωγικό κεφάλαιο, το αναλογικό σήμα είναι συνεχές ως προς τις δυνατές 
του τιμές σε μια δεδομένη χρονική στιγμή. Το ψηφιακό σήμα έχει διακριτές τιμές που αναπαρίστανται με ένα 
πεπερασμένο σύνολο ακεραίων τιμών. Κατά τη ψηφιοποίηση, λοιπόν, πρέπει οι συνεχείς τιμές του αναλογι-
κού σήματος να προσεγγιστούν σε κάποιες τιμές του ψηφιακού σήματος. Η ψηφιοποίηση επιτυγχάνεται σε 
δύο στάδια: διακριτοποίηση (discretization) και κβάντιση (quantization). Η διακριτοποίηση αναφέρεται και 
ως δειγματοληψία (sampling). 

Η διακριτοποίηση είναι η διαδικασία λήψης, σε συγκεκριμένα χρονικά διαστήματα, τιμών του αναλο-
γικού σήματος. Οι τιμές αυτές ονομάζονται δείγματα (samples) και, θεωρητικά, έχουν άπειρη ακρίβεια σε 
αυτή τη φάση. Στην περίπτωση της εικόνας, η δειγματοληψία, αφορά τη λήψη του χρώματος σε ορισμένα 
σημεία της εικόνας και την απεικόνιση αυτού του χρώματος με αριθμητικές τιμές. Για παράδειγμα, στην Ει-
κόνα 2.1, οι αποχρώσεις εντός του λευκού πλαισίου είναι συνεχείς, δηλαδή αναλογικές. Με άλλα λόγια, υ-
πάρχει συνέχεια στις χρωματικές αποχρώσεις και δεν είναι διακριτές οι διαδοχικές αποχρώσεις. Κατά τη 
δειγματοληψία, συνεπώς, λαμβάνονται οι τιμές χρώματος σε κάποια από τα διαδοχικά pixels. 

 

 
 
Εικόνα 2.1 Οι αποχρώσεις που βρίσκονται εντός του λευκού πλαισίου στην εικόνα είναι συνεχείς, δηλ. αναλογικές. 

 
Η κβάντιση είναι η διαδικασία στρογγυλοποίησης των αριθμητικών τιμών των δειγμάτων σε ένα προκαθορι-
σμένο σύνολο σημάτων. Δηλαδή, διαδοχικά δείγματα μπορεί να αντιστοιχιστούν σε μία τιμή που θα αποτελεί 
το ψηφιακό ισοδύναμο των αρχικών αναλογικών δειγμάτων. Στην περίπτωση των εικόνων, η κβάντιση ισο-
δυναμεί με μετατροπή παρόμοιων διαδοχικών χρωμάτων σε μία απόχρωση, διότι δεν μπορούν να αναπαρα-
σταθούν στον υπολογιστή οι θεωρητικά άπειρες αποχρώσεις του αναλογικού χρώματος. Για παράδειγμα, αν 
σε μια εικόνα έχουμε τη δυνατότητα χρήσης μόνο 4 δυαδικών αριθμών, 00, 01, 10, 11, τότε όλα τα δείγματα, 
ανεξάρτητα από το πόσα είναι, πρέπει να αναπαρασταθούν με αυτούς τους αριθμούς. Έτσι, οι σκουρόχρωμες 
αποχρώσεις για παράδειγμα μπορεί να αναπαρασταθούν με τον αριθμό 00. Όσα και δείγματα να έχουμε λάβει 
κατά τη δείγματατοληψία και μπορεί να είναι χιλιάδες, θα αναπαρασταθούν με τους πιο πάνω δυαδικούς α-
ριθμούς. Δηλαδή, το αποτέλεσμα της κβάντισης θα είναι επαναλαμβανόμενες ακολουθίες από τους 4 δυαδι-
κούς αριθμούς. 

Οι δύο φάσεις μπορεί να γίνονται ταυτόχρονα ή να γίνονται σε διαφορετικό χρόνο, με τη διαδικασία 
της δειγματοληψίας φυσικά να προηγείται της κβάντισης. Η διαδικασία της ψηφιοποίησης αναφέρεται και ως 
μετατροπή σήματος από αναλογικό σε ψηφιακό (ADC – Analog to Digital Conversion), ενώ η αντίστροφη 
διαδικασία ονομάζεται μετατροπή σήματος από ψηφιακό σε αναλογικό (DAC – Digital to Analog 
Conversion). 

Η διαδικασία και το αποτέλεσμα της ψηφιοποίησης εξαρτάται από την επιθυμητή ανάλυση 
(resolution) της παραγόμενης εικόνας, την ύπαρξη χρώματος και το βάθος χρώματος (color depth). Οι ίδιοι 
παράγοντες επηρεάζουν το μέγεθος και την ευκρίνεια εικόνων και σχεδίων που δημιουργούνται απευθείας 
στον υπολογιστή με τα κατάλληλα προγράμματα επεξεργασίας εικόνων. 
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2.2.1. Ανάλυση και διαστάσεις 
 

Κατά τη διαδικασία της ψηφιοποίησης κάθε δείγμα που λαμβάνεται αναπαρίσταται τελικά με μια δυαδική 
τιμή, που συμβολίζει το χρώμα ενός pixel σε ένα σημείο της εικόνας. Όσο περισσότερα εικονοστοιχεία υπάρ-
χουν σε μία εικόνα συγκεκριμένων διαστάσεων, τόσο μεγαλύτερη είναι η ευκρίνεια της εικόνας. Ο αριθμός 
των εικονοστοιχείων στη μονάδα του μήκους αναφέρεται ως ανάλυση (resolution) της εικόνας και εκφράζε-
ται σε εικονοστοιχεία ανά ίντσα (ppi – pixels per inch).  

Οι διαστάσεις της εικόνας αναφέρονται ως το γινόμενο των pixels ανά διάσταση, π.χ. 800x600, ή με 
βάση τις ίντσες ή τα εκατοστά ανά διάσταση. Μια εικόνα 800x600 έχει 800 pixels οριζοντίως και 600 καθέ-
τως, και συνολικά 480.000 pixels. Στην περίπτωση που γνωρίζουμε τις διαστάσεις και την ανάλυση αναφέρε-
ται σε ppi, τότε πρέπει να γνωρίζουμε και τις διαστάσεις της εικόνας, ώστε να βρούμε το συνολικό αριθμό 
εικονοστοιχείων. Για παράδειγμα, μια εικόνα μεγέθους 8x6 ίντσες και 72 ppi, έχει 8x72 = 576 εικονοστοιχεία 
οριζοντίως και 6x72 = 432 εικονοστοιχεία καθέτως. Συνολικά, η εικόνα έχει 248.832 εικονοστοιχεία, δηλ. 
8x72x6x72 = 248.832 εικονοστοιχεία. 

Στις Εικόνες 2.2, 2.3 και 2.4 εμφανίζεται η ίδια πεταλούδα, στο ίδιο μέγεθος, περίπου 1,3x0,9 ίντσες 
(3,5x2,29 εκ.), σε διαφορετική ανάλυση όμως κάθε φορά. Η πρώτη εικόνα (Εικόνα 2.2) έχει ανάλυση 25 ppi 
και συνεπώς είναι 60x39 εικονοστοιχεία. Η πεταλούδα αυτή εμφανίζεται σε μεγέθυνση για να έχει τις ίδιες 
διαστάσεις με τις υπόλοιπες. Παρατηρούμε ότι σε αυτή την περίπτωση η ευκρίνεια της εικόνας είναι μικρή, 
διότι τα λίγα pixel της εμφανίζονται μεγάλα. Το ίδιο συμβαίνει και στην περίπτωση της δεύτερης πεταλούδας 
(Εικόνα 2.3), παρόλο που έχει τη διπλάσια ανάλυση σε περίπου το ίδιο μέγεθος (σ.σ. η ακριβής εμφάνιση των 
εικόνων εξαρτάται από το εργαλείο προβολής – μπορεί να εμφανιστούν με μεγάλα pixels ή θαμπές). Στην 
Εικόνα 2.4 εμφανίζεται η ίδια εικόνα στην αρκετά καλή ανάλυση των 300 ppi. Η Εικόνα 2.4 έχει προφανώς 
υψηλή ευκρίνεια σε σχέση με τις υπόλοιπες. Παρατηρούμε ότι όσο αυξάνει η ανάλυση, η εικόνα εμφανίζεται 
με υψηλότερη ευκρίνεια.  

 

 
 
Εικόνα 2.2 25 ppi (60x39 pixels) 

 

 
 
Εικόνα 2.3 50 ppi (120x78 pixels) 

 
Στην περίπτωση μικρής ανάλυσης, δηλ. λίγων εικονοστοιχείων ανά ίντσα, οι εικόνες εμφανίζονται 

μικρότερες από τις άλλες σε κανονική προβολή. Για παράδειγμα, στην Εικόνα 2.5 εμφανίζονται σε κανονική 
προβολή οι δύο πρώτες πεταλούδες των Εικόνων 2.2 και 2.3. Ενώ οι πεταλούδες των Εικόνων 2.2 και 2.3 εμ-
φανίζονται παραμορφωμένες γιατί προβάλλονται σε μεγέθυνση, στην Εικόνα 2.5 εμφανίζονται στο κανονικό 
τους μέγεθος. Έχουν μικρότερο μέγεθος, αλλά εμφανίζονται, φυσικά, καλύτερα από ότι προηγουμένως. 
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[Πηγή αρχικής εικόνας: http://goo.gl/KnENIi]  
 
Εικόνα 2.4 300 ppi (413x270 pixels) 

 

 
 
Εικόνα 2.5 Οι Εικόνες 2.2 και 2.3 σε κανονικό μέγεθος, ώστε να μην εμφανίζεται η παραμόρφωση. 

 
Συμπερασματικά, λοιπόν, στην περίπτωση χαμηλής ανάλυσης η μεγέθυνση των εικόνων έχει ως απο-

τέλεσμα την αλλοίωσή τους. Η υψηλή ανάλυση αυξάνει γενικά την ευκρίνεια των εικόνων σε διάφορες δια-
στάσεις. Στον αντίποδα, το μέγεθος των αρχείων εικόνας αυξάνεται καθώς αυξάνεται η ανάλυσή τους, εφό-
σον υπάρχουν περισσότερα pixels για τα οποία πρέπει να αποθηκεύονται πληροφορίες. Συνεπώς, η αποθή-
κευση των εικόνων απαιτεί μεγαλύτερο χώρο, αλλά και η επεξεργασία τους είναι πιο απαιτητική σε κύρια 
μνήμη του υπολογιστή. 

Η ανάλυση η οποία θα επιλεχθεί για μια εικόνα εξαρτάται και από τη χρήση της εικόνας. Για προβο-
λή μέσω υπολογιστή απαιτείται ανάλυση 72 ppi ως 96 ppi, άρα δεν χρειάζεται υψηλή ανάλυση, διότι θα αυ-
ξηθεί το μέγεθός της αναίτια. Στην περίπτωση επαγγελματικών εκτυπώσεων απαιτείται υψηλή ανάλυση, κα-
θώς τα εκτυπωτικά μηχανήματα λειτουργούν με αναλύσεις 300 ppi και πάνω. Συνεπώς, οι εικόνες με μικρή 
ανάλυση δεν είναι τόσο «καθαρές» κατά την εκτύπωση. 

 
2.2.1.1. Megapixel 

 
Ένα Megapixel (MP ή Mpx ή Mpix) ισούται με 1 εκατομμύριο εικονοστοιχεία και χρησιμοποιείται για να 
εκφράσει τον αριθμό εικονοστοιχείων σε μια εικόνα, αλλά και για να εκφράσει τον αριθμό των εικονοστοι-
χείων που μπορεί να συλλάβει μία κάμερα ή να προβάλλει μία οθόνη. Για παράδειγμα, 10 Mpx σημαίνει πε-
ρίπου 10 εκατομμύρια pixels. Η ανάλυση της συσκευής είναι σε αυτή την περίπτωση 4096x2400 pixels = 
9.830.400 εικονοστοιχεία.  

Ένα βασικό ερώτημα, που πολλές φορές μας απασχολεί, είναι πόσα Megapixels χρειαζόμαστε σε μια 
φωτογραφική μηχανή, ώστε οι φωτογραφίες να εκτυπώνονται σε καλή ανάλυση; Αυτό εξαρτάται από το μέ-
γεθος της εικόνας αρχικά. Για παράδειγμα, μια φωτογραφία 10x15cm (περίπου 4x6") χρειάζεται περίπου 
2.160.000 pixel για εκτύπωση σε ανάλυση 300 ppi. Δηλαδή, χρειάζονται περίπου 3 MP για τη συγκεκριμένη 
εκτύπωση. Για μεγαλύτερης διάστασης φωτογραφίες, π.χ. 18x23 εκ. και 20x30 εκ., χρειάζονται 4-6 MP. Φυ-
σικά σε μια φωτογραφική μηχανή δεν παίζει ρόλο μόνο η προσφερόμενη ανάλυση. Θέματα, όπως η ποιότητα 
κατασκευής, ο φακός, η νυχτερινή λήψη και οι λειτουργίες της φωτογραφικής μηχανής, είναι σημαντικά κρι-
τήρια για την επιλογή. 

 

2.2.2. Βάθος χρώματος 
 

Το βάθος χρώματος (color depth), που αναφέρεται και ως βάθος bit (bit depth), αφορά τον αριθμό των δυα-
δικών ψηφίων που χρησιμοποιούνται για την αναπαράσταση των χρωμάτων των εικονοστοιχείων της εικόνας. 
Όσο μεγαλύτερο είναι το βάθος χρώματος, δηλ. ο αριθμός των ψηφίων που χρησιμοποιούνται για κάθε χρώ-
μα, τόσο περισσότερες χρωματικές αποχρώσεις μπορεί να περιέχει μία εικόνα. Αν το βάθος χρώματος είναι n, 
τότε μπορούν να κωδικοποιηθούν 2n αποχρώσεις. 

Με βάθος χρώματος 1 bit, η εικόνα μπορεί να έχει 21=2 διαφορετικές αποχρώσεις. Συνήθως, τα χρώ-
ματα αυτά είναι άσπρο και μαύρο, αλλά μπορεί να είναι οποιαδήποτε 2 χρώματα. Οι εικόνες, σε αυτή την πε-
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ρίπτωση, ονομάζονται μονόχρωμες (monochrome ή monochromatic) ή διτονικές (duotone) ή δυαδικές (binary 
ή bi-level) (Εικόνα 2.6).  

 

 
[Πηγή αρχικής εικόνας: http://goo.gl/BC5jJ0] 
 
Εικόνα 2.6 1 bit βάθος χρώματος / 2 χρώματα. 
 

Οι grayscale εικόνες, δηλαδή οι εικόνες με γκρι αποχρώσεις μόνο, αποτελούνται από αποχρώσεις που 
ποικίλουν από το απόλυτο μαύρο μέχρι το απόλυτο λευκό. Το βάθος χρώματος είναι 8, άρα μπορούν να υ-
πάρχουν 256 (28) αποχρώσεις, με το μαύρο να είναι το 0 και το λευκό το 255. Τα σκουρόχρωμα εικονοστοι-
χεία συμβολίζονται με μικρούς αριθμούς, ενώ τα ανοιχτόχρωμα εικονοστοιχεία με μεγάλους αριθμούς. 

Στην Εικόνα 2.7 εμφανίζεται η εικόνα με βάθος χρώματος 4 bit, άρα 24 (16) χρωματικές αποχρώσεις. 
Οι Εικόνες 2.8 και 2.9 είναι έγχρωμες με 28 και 224 αποχρώσεις αντίστοιχα. Στον Πίνακα 2.1 εμφανίζονται οι 
δυνατές χρωματικές αποχρώσεις ανάλογα με το βάθος χρώματος.  

 
 

 
 

Εικόνα 2.7 4 bit βάθος χρώματος / 16 χρώματα. 

 
 

 
 
Εικόνα 2.8 8 bit βάθος χρώματος / 256 χρώματα. 
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Εικόνα 2.9 24 bit βάθος χρώματος / 16,7 εκατομμύρια χρώματα. 

 
Βάθος χρώματος Δυνατές χρωματικές αποχρώσεις 
1 21 = 2  
2 22 = 4 
3 23 = 8 
4 24 = 16 
8 28 = 256 
16 216 = 65.536 
24 224 = 16.777.216 

 
Πίνακας 2.1 Δυνατές αποχρώσεις ανάλογα με το βάθος χρώματος. 

 
Οι εικόνες με 24 bit μέγεθος χρώματος ονομάζονται και εικόνες με πραγματικό βάθος χρώματος 

(true color) και επιτρέπουν ως και 16.777.216 αποχρώσεις. Με βάση το γεγονός ότι τα χρώματα στις ηλε-
κτρονικές συσκευές δημιουργούνται με συνδυασμό του κόκκινου (red), πράσινου (green) και μπλε (blue), με 
πραγματικό βάθος χρώματος, τα 8 bit χρησιμοποιούνται για αποχρώσεις του κόκκινου, τα 8 bit για αποχρώ-
σεις του πράσινου και τα 8 bit για αποχρώσεις του μπλε. Έτσι, υπάρχουν 256 αποχρώσεις για κάθε χρώμα, 
άρα 256 x 256 x 256 = 16.777.216 αποχρώσεις. Οι εικόνες με βάθος χρώματος 16 bit ονομάζονται High 
Color ή HiColor. 

Οι σύγχρονοι υπολογιστές υποστηρίζουν και μεγαλύτερους αριθμούς δυαδικών ψηφίων ως βάθος 
χρώματος, π.χ. 30 bits (1,073 δισεκατομμύρια χρώματα), 36 bits (68,71 δισεκατομμύρια χρώματα) και 48 bits 
(281,5 τρισεκατομμύρια χρώματα). Η περίπτωση των 30 ή περισσοτέρων δυαδικών ψηφίων ως βάθος χρώμα-
τος ονομάζεται deep color. Τα επιπλέον bits, από τα 24 του πραγματικού χρώματος, χρησιμοποιούνται για 
την κωδικοποίηση στοιχείων, όπως η διαφάνεια ή η λάμψη των χρωμάτων. Στην πλειοψηφία τους, οι συ-
σκευές απεικόνισης δεν μπορούν, ακόμη, να απεικονίσουν περισσότερα από 16,7 εκατομμύρια χρωματικές 
αποχρώσεις, δηλ. πραγματικό χρώμα. 

Όσο μεγαλύτερο είναι το βάθος χρώματος, τόσο καλύτερη είναι η ευκρίνεια μιας εικόνας, αλλά αυξά-
νει και το μέγεθός της, όπως θα δούμε πιο κάτω. Η επιλογή του βάθους χρώματος εξαρτάται από το πόσες 
αποχρώσεις χρειαζόμαστε σε μια εικόνα, από τη συσκευή προβολής και από την τελική χρήση μιας εικόνας. 
Για παράδειγμα, οι εικόνες των comics αποτελούνται συνήθως από λίγα χρώματα, ενώ στην παραγωγή δια-
φημιστικών φυλλαδίων απαιτούνται πολλές αποχρώσεις για να υπάρχει υψηλή απόδοση. 

 

2.3. Χρωματικά μοντέλα 
 
Το φως και η απορρόφησή του ή η ανάκλασή του από το υλικό στο οποίο προβάλλεται, δημιουργεί τα χρώ-
ματα στις εκτυπώσεις και τις ηλεκτρονικές συσκευές. Η χρήση χρώματος στην τηλεόραση, το βίντεο, τον υ-
πολογιστή και τα εκτυπωτικά μηχανήματα οδήγησε στη δημιουργία των χρωματικών μοντέλων (color 
models). Τα χρωματικά μοντέλα περιγράφουν πώς μπορούν να κωδικοποιηθούν ως πλειάδες αριθμών τα 
χρώματα. Οι αριθμητικές αυτές παράμετροι είναι συνήθως τρεις και προσδιορίζουν τις χρωματικές αποχρώ-
σεις ως σύνθεση των τριών βασικών παραμέτρων. 

Η παραγωγή σύνθετου χρώματος βασίζεται στην τριχρωματική θεωρία (tristimulus), η οποία θεωρεί 
ότι κάθε χρώμα μπορεί να παραχθεί με προσθετική ανάμιξη τριών βασικών χρωμάτων. Αυτά τα τρία βασικά 
χρώματα είναι το κόκκινο, το πράσινο και το μπλε. Η θεωρία βασίζεται στο πώς αντιλαμβανόμαστε το χρώμα 
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μέσω του αμφιβληστροειδούς, ως διαφορετικά μήκη κύματος που διαχωρίζονται σε μικρά, μεσαία και μεγάλα 
μήκη κύματος. Το χρωματικό μοντέλο RGB βασίζεται σε αυτή τη θεωρία. Τα υπόλοιπα χρωματικά μοντέλα 
βασίζονται σε διαφορετικά χρώματα ή παραμέτρους. 

 

2.3.1. Χρωματικό μοντέλο RGB 
 
Τα μέσα που μεταδίδουν το φως, όπως η τηλεόραση ή η οθόνη του υπολογιστή, χρησιμοποιούν τον προσθε-
τικό (additive) τρόπο δημιουργίας χρώματος. Δηλαδή, βασίζονται στην πρόσθεση των βασικών χρωμάτων 
Κόκκινο (Red), Πράσινο (Green) και Μπλε (Blue) για τη δημιουργία των χρωματικών αποχρώσεων (Εικόνα 
2.10). Το χρωματικό μοντέλο σε αυτή την περίπτωση αναφέρεται συντομογραφικά ως RGB (Red, Green, 
Blue). Η ανάμειξη αυτών των βασικών χρωμάτων καλύπτει ένα μεγάλο μέρος των χρωμάτων που μπορεί να 
αντιληφθεί το ανθρώπινο μάτι. Όπως φαίνεται στην Εικόνα 2.11, η όρασή μας βασίζεται στο διαχωρισμό του 
φωτός στα τρία βασικά χρώματα που χρησιμοποιούνται και στο μοντέλο RGB.  

 
 

 
 
Εικόνα 2.10 Βασικά χρώματα χρωματικού μοντέλου RGB. 

 
Στα εργαλεία λογισμικού, ο καθορισμός των χρωματικών αποχρώσεων με βάση το μοντέλο RGB γί-

νεται με καθορισμό της αναλογίας του κόκκινου, πράσινου και μπλε με έναν αριθμό για το καθένα (Εικόνα 
2.12). Σε κάθε χρώμα αντιστοιχεί μια τιμή από 0 ως 255 για κάθε χρώμα. Επιλογή 0, 0, 0 αντιστοιχεί στο 
μαύρο, ενώ ο συνδυασμός 255, 255, 255 αντιστοιχεί στο λευκό. Το κόκκινο καθορίζεται με την τριάδα 255, 0, 
0, το πράσινο με τους αριθμούς 0, 255, 0 και το μπλε με την τριάδα αριθμών 0, 0, 255. Οι ενδιάμεσες απο-
χρώσεις δημιουργούνται με διαφορετικούς συνδυασμούς των τριών αριθμών. Για παράδειγμα, ο συνδυασμός 
90, 30, 35 αντιστοιχεί σε σκουρόχρωμη απόχρωση του κόκκινου.  
 
 

 
 

Εικόνα 2.11 Το ανθρώπινο μάτι αντιλαμβάνεται τα χρώματα με βάση τα τρία βασικά χρώματα του μοντέλου RGB. 
 

Αρκετές φορές οι αριθμοί αναφέρονται στο δεκαεξαδικό σύστημα αρίθμησης, ιδιαίτερα στην περί-
πτωση καθορισμού χρωμάτων στις ιστοσελίδες. Σε αυτή την περίπτωση, ο δεκαεξαδικός αριθμός αποτελείται 
από 3 δυάδες αριθμών, όπου το πρώτο ζεύγος αριθμών αναφέρεται στο κόκκινο, το δεύτερο ζεύγος στο πρά-
σινο και οι 2 τελευταίοι αριθμοί στο μπλε. Έτσι, το κόκκινο γίνεται FF0000, το πράσινο 00FF00 και το μπλε 
0000FF. Το άσπρο είναι FFFFFF και το μαύρο είναι 000000. Η απόχρωση 90, 30, 30 γίνεται σε αυτή την πε-
ρίπτωση 5Α1Ε23. 

Το RGB μοντέλο χρησιμοποιείται όταν ακτινοβολία φθάνει από μια πηγή εκπομπής φωτός απευθείας 
στο ανθρώπινο μάτι, όπως στην τηλεόραση. Το φως, σε αυτή την περίπτωση, ονομάζεται άμεσο. Οι οθόνες 
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παράγουν το χρώμα με την «εκτόξευση» των τριών βασικών χρωμάτων σε μια μαύρη οθόνη (Εικόνα 2.13). 
Το μαύρο χρώμα δημιουργείται όταν η πηγή φωτός δεν εκπέμπει κανένα από τα τρία βασικά χρώματα, δηλα-
δή υπάρχει απουσία φωτός. Όταν τα βασικά χρώματα εκπέμπονται στη μέγιστη έντασή τους, τότε εμφανίζε-
ται το λευκό χρώμα. 

 

 
 
Εικόνα 2.12 Καθορισμός χρωματικών αποχρώσεων στο μοντέλο RGB. 
 

 

 
 

Εικόνα 2.13 Δημιουργία αποχρώσεων σε έγχρωμη οθόνη, με βάση το φως που εκπέμπεται από διαφορετικές πηγές φωτός. 
 
 

2.3.2. Χρωματικό μοντέλο RYB 
 
Στην παραδοσιακή ζωγραφική χρησιμοποιείται το αφαιρετικό χρωματικό μοντέλο RYB με βασικά χρώματα 
τα Κόκκινο (Red), το Κίτρινο (Yellow) και το Μπλε (Blue). Με τα τρία αυτά βασικά χρώματα δημιουργού-
με τα δευτερογενή χρώματα του μοντέλου ως εξής: 

 
 Πορτοκαλί (Orange) = Κόκκινο + Κίτρινο 
 Πράσινο (Green) = Κίτρινο + Μπλε 
 Μωβ (Violet) = Μπλε + Κόκκινο 

 
Το μοντέλο RYΒ εμφανίστηκε πριν το RGB, αλλά μετέπειτα πειράματα έδειξαν ότι η περιγραφή του 

χρώματος γίνεται καλύτερα με βάση το μοντέλο RGB. Στην Εικόνα 2.14 εμφανίζεται ο χρωματικός τροχός 
του μοντέλου και στην Εικόνα 2.15 τα βασικά χρώματα του μοντέλου. 
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Εικόνα 2.14 Χρωματικός τροχός RYB. 

 

 
 

Εικόνα 2.15 Βασικά χρώματα χρωματικού μοντέλου RΥB. 

 

2.3.3. Χρωματικό μοντέλο CMY & CMYK 
 
Στην περίπτωση των εκτυπώσεων, το χρώμα δημιουργείται από ακτινοβολία που ανακλάται σε μια επιφάνεια. 
Το αφαιρετικό (subtractive) χρωματικό μοντέλο CMY (Cyan, Magenta, Yellow) το οποίο βασίζεται στο 
Κυανό (Cyan), το Πορφυρό (Magenta) και το Κίτρινο (Yellow) (Εικόνα 2.16), χρησιμοποιείται σε αυτή την 
περίπτωση για την περιγραφή των χρωμάτων.  

Τα χρώματα δημιουργούνται με τοποθέτηση ποσοστού καθενός από τα βασικά χρώματα πάνω σε μια 
λευκή επιφάνεια. Για παράδειγμα, για να αναπαραχθεί κάποια απόχρωση του κίτρινου χρώματος η ποσόστω-
ση είναι 0% Cyan, 0% Magenta, 100% Yellow (Εικόνα 2.17). Η τριάδα 60%, 80%, 0% παράγει ένα βαθύ μωβ 
χρώμα. 

 

 
 
Εικόνα 2.16 Βασικά χρώματα χρωματικού μοντέλου CMY. 

 
Τα χρώματα δημιουργούνται λόγω της ανάκλασης και της απορρόφησης του φωτός σε μια επιφάνεια. 

Οι μαύρες επιφάνειες απορροφούν όλο το φως που πέφτει πάνω τους και έτσι ανακλούν το μαύρο χρώμα, ενώ 
μια λευκή επιφάνεια ανακλά όλα τα μήκη φωτός και τελικά δημιουργείται η αίσθηση του λευκού. Το κυανό 
σε μια επιφάνεια απορροφά το κόκκινο φάσμα του φωτός και ανακλά το πράσινο και το μπλε, δημιουργώντας 
έτσι την αίσθηση του γαλάζιου. Το μοντέλο ονομάζεται αφαιρετικό, διότι με την επίθεση χρωμάτων πάνω σε, 
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συνήθως, λευκές επιφάνειες μειώνεται η ποσότητα του φωτός που ανακλάται. Με αυτό τον τρόπο, ουσιαστι-
κά, αφαιρείται η φωτεινότητα από το λευκό. 

 

 
 

Εικόνα 2.17 Καθορισμός χρωματικών αποχρώσεων στο CMY (και το CMYK). 
 

 
 

Εικόνα 2.18 Δημιουργία χρωμάτων στο CMY με επίθεση ποσοστού των βασικών χρωμάτων πάνω σε λευκή επιφάνεια. 

 
Στην Εικόνα 2.18 βλέπουμε πως τελικά δημιουργούνται τα χρώματα στις εκτυπώσεις με τοποθέτηση 

στρωμάτων των βασικών χρωμάτων πάνω σε λευκή επιφάνεια. Στο Σχήμα 2.18α έχει τοποθετηθεί η αναλογία 
50% Κυανό, 90% Πορφυρό, και 30% Κίτρινο. Τελικά, το ανακλώμενο φως δημιουργεί μια σκούρα μωβ από-
χρωση. Με την αναλογία 100%, 17%, 87% δημιουργείται μια απόχρωση του πράσινου ως ανάκλαση. 

Η τοποθέτηση ίσων ποσοτήτων των βασικών χρωμάτων Κυανό, Πορφυρό και Κίτρινο έχει ως αποτέ-
λεσμα το μαύρο χρώμα (π.χ. κεντρικό σημείο εικόνας 2.16). Στις εκτυπώσεις όμως, τόσο για οικονομία των 
τριών χρωμάτων όσο και για τεχνικούς λόγους, χρησιμοποιείται επιπλέον και το μαύρο χρώμα, επεκτείνοντας 
έτσι το μοντέλο στο CMYK (Cyan, Magenta, Yellow, Key/blacK). Το K στη συντομογραφία CMYK προκύ-
πτει από τη λέξη Key και αναφέρεται στο γεγονός ότι τα βασικά χρώματα του μοντέλου συντονίζονται με το 
μαύρο χρώμα για να δημιουργηθούν όλες οι επιθυμητές αποχρώσεις. Πολλές φορές, όμως, αναφέρεται ότι το 
Κ προέρχεται από το τελευταίο γράμμα της λέξης Black. Αν και αυτή η θεώρηση είναι λανθασμένη, τείνει να 
επικρατήσει. 
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Το CMYK είναι τελικά το μοντέλο που χρησιμοποιείται και στις επαγγελματικές, αλλά και τις εκτυ-
πώσεις σε απλούς εκτυπωτές ψεκασμού μελάνης. Έτσι, στους εκτυπωτές χρησιμοποιούνται είτε 4 χωριστά 
μελάνια ή ένα μαύρο και ένα έγχρωμο που αποτελείται από τα χρώματα Cyan, Magenta, Yellow. 
 

2.3.3.1. Σχέση των βασικών χρωμάτων RGB και CMYΚ 
 

Τα χρωματικά μοντέλα RGB και CMYK συσχετίζονται εκ των πραγμάτων, γιατί οι εικόνες που προβάλλο-
νται στον υπολογιστή είναι στο RGB, αλλά, όταν πρέπει να εκτυπωθούν, χρησιμοποιείται το CMYK μοντέλο.  

Τα βασικά χρώματα του CMY δημιουργούνται με συνδυασμό ανά δύο των βασικών χρωμάτων του 
RGB ως εξής (Εικόνα 2.10): 

 
 Blue + Green = Cyan 
 Red + Blue = Magenta 
 Green + Red = Yellow 

 
Με επίθεση ποσοστού 100% ανά δύο χρωμάτων από τα βασικά του CMY δημιουργούνται τα χρώμα-

τα του RGB (Εικόνα 2.16). Για παράδειγμα, 100% Κυανό και 100% Κίτρινο αποδίδει το Πράσινο. Επίσης, τα 
πρωτεύοντα χρώματα του RGB μπορούν να περιγραφούν με τη βοήθεια των χρωμάτων του αφαιρετικού μο-
ντέλου CMY και ως εξής: 

 
 Red = White – Green (Yellow + Cyan) – Blue (Magenta + Cyan) 
 Blue = White – Green (Yellow + Cyan) – Red (Magenta + Yellow) 
 Green = White – Red (Magenta + Yellow) – Blue (Magenta + Cyan) 

 
Τα επαγγελματικά συστήματα επεξεργασίας εικόνων, π.χ το Adobe Photoshop και το CorelDraw, επι-

τρέπουν τη χρήση διαφορετικών χρωματικών μοντέλων, ανάλογα με τον απώτερο στόχο χρήσης της εικόνας. 
Επίσης, επιτρέπουν τη μετάβαση από το ένα μοντέλο, π.χ. το RGB, στο άλλο, π.χ. CMYK. Έτσι μπορεί να 
επαληθευτεί και το ότι τα χρώματα θα εκτυπωθούν όπως φαίνονται στην οθόνη. 

 

2.3.4. Χρωματικά μοντέλα που βασίζονται στη χροιά και τη φωτεινότητα 
 
Όπως αναφέρθηκε, οι οθόνες των υπολογιστών και οι τηλεοράσεις λειτουργούν με το χρωματικό μοντέλο 
RGB, ενώ τα εκτυπωτικά μηχανήματα με βάση το CMYK. Αυτοί οι τρόποι περιγραφής δεν είναι τόσο εύκο-
λοι για τον προσδιορισμό χρωμάτων σε πολλές καταστάσεις. Για παράδειγμα, αν κάποιος ερωτηθεί για το 
χρώμα που επιθυμεί σε κάποιο αυτοκίνητο ή για το σπίτι του, τότε θα αναφέρει το βασικό χρώμα, π.χ. μπλε 
και έπειτα πόσο ανοιχτό ή σκούρο θα είναι το χρώμα αυτό. Έτσι έχει δημιουργηθεί το χρωματικό μοντέλο 
HSB και οι παραλλαγές του HSL και HSI. Στο βίντεο χρησιμοποιούνται και άλλα χρωματικά μοντέλα, όπως 
π.χ. το YUV όπου το Υ αναφέρεται στη φωτεινότητα (luminance) και οι συνιστώσες U και V αφορούν στην 
χρωματική πληροφορία (chrominance). Το συγκεκριμένο μοντέλο θα εξεταστεί στο κεφάλαιο που αφορά το 
βίντεο. 

 
2.3.4.1. Χρωματικό μοντέλο HSΒ (HSV) 
 
Το χρωματικό μοντέλο HSB (Hue, Saturation, Brightness) αποτελείται από τις συνιστώσες Απόχρωση ή 
Χροιά (Hue), Κορεσμός ή Χρωματική καθαρότητα (Saturation) και Φωτεινότητα (Brightness). Το μοντέ-
λο HSB αναφέρεται συχνά και ως HSV (Hue, Saturation, Value). 

Η χροιά προσδιορίζει το βασικό χρώμα (π.χ. κόκκινο) της απόχρωσης. Εκφράζεται ως ένας βαθμός 
από 0ο ως 360ο. Τα βασικά χρώματα στα οποία βασίζεται το μοντέλο είναι τα πρωτεύοντα κόκκινο, πράσινο 
και μπλε και τα συμπληρωματικά κυανό, πορφυρό και κίτρινο. Στις Εικόνες 2.19 και 2.20 εμφανίζονται τα 
βασικά αυτά χρώματα και κάποιες από τις ενδιάμεσες αποχρώσεις. Στην Εικόνα 2.21 εμφανίζονται όλες οι 
δυνατές αποχρώσεις του μοντέλου στον χρωματικό τροχό (color wheel), όπως ονομάζεται. Και στα δύο σχή-
ματα φαίνονται τα βασικά χρώματα και πώς οι αποχρώσεις αλλάζουν με βάση τους άλλους δύο παράγοντες. 
Το κόκκινο είναι στις 0ο, το πράσινο στις 120ο και το μπλε στις 240ο. 
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Εικόνα 2.19 Βασικά χρώματα χρωματικού μοντέλου HSB (HSV). 

 

 
 
Εικόνα 2.20 Γεωμετρική αναπαράσταση μοντέλου HSB (HSV). 

 

 
 
Εικόνα 2.21 Χρωματικός τροχός μοντέλου HSB (HSV). 

 
Ο κορεσμός είναι η καθαρότητα ή ένταση του χρώματος και αναφέρεται στο βαθμό απουσίας του 

λευκού φωτός από ένα χρώμα. Προσδιορίζεται ως ποσοστό %. Για παράδειγμα, ποσοστό κορεσμού 100% 
σημαίνει απουσία του λευκού, άρα έντονο χρώμα, ενώ ποσοστό κορεσμού 0% σημαίνει πλήρης παρουσία του 
λευκού, άρα το χρώμα εμφανίζεται ξεθωριασμένο. Καθορίζει, δηλαδή πόσο έντονο ή ξεθωριασμένο θα είναι 
το βασικό χρώμα (δηλαδή η χροιά). Στις Εικόνες 2.19 έως 2.21, καθώς ο κορεσμός αυξάνεται από το κέντρο 
του κύκλου προς την περίμετρο, αυξάνεται και η ένταση του χρώματος και εμφανίζεται το ίδιο χρώμα, αλλά 
σε πιο έντονη απόχρωση. 

Η φωτεινότητα είναι το μέτρο της φωτεινής έντασης ενός χρώματος. Χαμηλή φωτεινότητα σημαίνει 
σκούρο χρώμα, ενώ υψηλή φωτεινότητα σημαίνει ανοιχτό χρώμα. Όπως φαίνεται καθαρά στην Εικόνα 2.21, 
καθώς μειώνεται η φωτεινότητα, τα χρώματα εμφανίζονται πιο σκούρα. Όταν η φωτεινότητα είναι 100%, τό-
τε εμφανίζεται η πιο ανοιχτή απόχρωση. 

Στην Εικόνα 2.22 τα σχήματα έχουν ίδια χροιά 200 (βασικό χρώμα μπλε) και την ίδια φωτεινότητα 
100%, αλλά διαφέρουν στον κορεσμό. Το πρώτο σχήμα έχει κορεσμό 100% και τα υπόλοιπα, 60%, 40% και 
20% αντίστοιχα. Στην Εικόνα 2.23 τα σχήματα έχουν ίδια χροιά 200 και κορεσμό 100%, αλλά η φωτεινότητα 
ξεκινά από 100% και καταλήγει στο τελευταίο σχήμα σε 20%. 
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Εικόνα 2.22 Ίδια χροιά και φωτεινότητα, αλλά σταδιακά μειούμενος κορεσμός. 

 

 
 

Εικόνα 2.23 Ίδια χροιά και κορεσμός, αλλά σταδιακά μειούμενη φωτεινότητα. 

 

2.3.4.2. Χρωματικά μοντέλα HSL (HLS) και HSI 
 
Το χρωματικό μοντέλο HSL (Hue, Saturation, Lightness), το οποίο αναφέρεται και ως HLS, είναι παρόμοιο 
με το HSB. Στο HSB οι αποχρώσεις φθάνουν από το μαύρο σε μια ανοιχτόχρωμη απόχρωση των βασικών 
χρωμάτων, ενώ στο HSL οι αποχρώσεις κυμαίνονται από μαύρο ως το απόλυτο άσπρο. Το HSB (ή HSV) α-
ναπαρίσταται ως ένα ανάποδος κώνος, ενώ τα χρώματα του HSL απεικονίζονται ως ένας διπλός κώνος που 
στη μία κορυφή του είναι το μαύρο χρώμα και στην άλλη είναι το άσπρο (Εικόνα 2.24). 

 

 
 
Εικόνα 2.24 Γεωμετρική αναπαράσταση του μοντέλου HSL (HLS). 

 
Στις περισσότερες αποχρώσεις το ποσοστό κορεσμού στο HSL είναι το μισό από ότι στο HSB. Για 

παράδειγμα, το κόκκινο αναπαρίσταται ως 0ο (χροιά), 50% (κορεσμός), 100% (φωτεινότητα) στο HSL και ως 
0ο (χροιά), 100% (κορεσμός), 100% (φωτεινότητα) στο HSB (Εικόνα 2.25). 

Στο μοντέλο HSI (Hue, Saturation, Intensity) ο τελευταίος παράγοντας ονομάζεται ένταση και ανα-
φέρεται στη φωτεινότητα του χρώματος. Και οι τρεις παραλλαγές των μοντέλων, δηλ. οι HSV (ή HSB), HSL 
(ή HLS) και HSI, διαφέρουν στον ορισμό της φωτεινότητας των χρωμάτων. Αν τα μοντέλα αναλυθούν με 
μαθηματικό τρόπο, θα διαπιστώσουμε ότι η φωτεινότητα υπολογίζεται με διαφορετικό τρόπο. Στην Εικόνα 
2.26 βλέπουμε το ίδιο χρώμα σε διάφορα χρωματικά μοντέλα. 
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[Πηγή: https://goo.gl/gqCIPi] 
 
Εικόνα 2.25 Χρωματικός τροχός του μοντέλου HSL (HLS). 

 
 

 
 

Εικόνα 2.26 Καθορισμός χρώματος σε διαφορετικά χρωματικά μοντέλα. 

 
 

2.3.5. CIE ΧΥΖ, CIE Lab και CIE Luv 
 
Το 1931 η διεθνής επιτροπή Commission Internationale de l'Eclairage (CIE) καθιέρωσε το πρώτο σύστημα 
για περιγραφή με μαθηματικό τρόπο του χρώματος που ονομάστηκε CIE 1931 XYZ. Οι παράμετροι αντι-
στοιχούν, περίπου, στα χρώματα Red, Green και Blue και αναφέρονται στη δυνατότητα διέγερσης των φωτο-
αισθητήρων του ανθρώπινου ματιού από μεγάλο, μεσαίο και μικρό μήκος κύματος φωτός. Η παράμετρος Υ 
του μοντέλου αναφέρεται στη φωτεινότητα του χρώματος. Βασικό πλεονέκτημα του μοντέλου αποτελεί η 
αναφορά στον τρόπο πρόσληψης του χρώματος από το ανθρώπινο μάτι. Επίσης, το μοντέλο χρησιμοποιείται 
ως βάση για τα πιο σύγχρονα χρωματικά μοντέλα που εξετάσαμε πιο πάνω. 

 

 
 

Εικόνα 2.27 Άξονες αναπαράστασης των συνιστωσών του CIELAB. 

 
Η εκδοχή CIE Lab (ή L*a*b*) χρησιμοποιεί τη φωτεινότητα (Ligtheness ή Luminance), τις κόκκινο-

πράσινες αποχρώσεις (a) και τις κίτρινο-μπλε αποχρώσεις (b) ως τις παραμέτρους της τριχρωματικής λογικής 
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του. Το μοντέλο είναι αφαιρετικό και συνδυάζει τα χρώματα, όπως το CMYK. Αναπαρίσταται με ένα σύστη-
μα τριών αξόνων L*, a*, και b* (Εικόνα 2.27). Χρησιμοποιείται για τον καθορισμό χρωμάτων στις εκτυπώ-
σεις, διότι τα χρώματα μπορούν να οριστούν ανεξάρτητα από το υποστηριζόμενο φάσμα χρωμάτων των συ-
σκευών εκτύπωσης. Οι τιμές της φωτεινότητας (L*) κυμαίνονται από 0 έως 100, της παραμέτρου a από -128 
ως 127 (από πράσινο σε κόκκινο) και της παραμέτρου b, επίσης από -128 ως 127 (από μπλε σε κίτρινο).  

Στο CIE Luv (ή L*u*v*) οι συνιστώσες είναι παρόμοιες, αλλά το μοντέλο είναι προσθετικό. Είναι 
κατάλληλο για τον ορισμό χρωμάτων στην περίπτωση οθονών και σαρωτών και είναι ανεξάρτητο από τις δυ-
νατότητες των συσκευών αυτών. 

 

2.3.6. Φάσμα χρωμάτων (Color gamut) 
 
Το φάσμα ή γκάμα ή κλίμακα χρωμάτων (color gamut) ενός χρωματικού μοντέλου ή μιας συσκευής απει-
κόνισης ή εκτύπωσης είναι το υποσύνολο των χρωματικών αποχρώσεων που μπορούν απεικονιστούν σε αυτό 
το χρωματικό μοντέλο ή να αναπαραχθούν στη συσκευή. Δηλαδή, κάθε χρωματικό μοντέλο δεν μπορεί να 
απεικονίσει τις ίδιες ακριβώς αποχρώσεις. Έτσι, όταν ψηφιοποιείται μια εικόνα ή μετατρέπεται σε διαφορετι-
κό χρωματικό μοντέλο, π.χ. από RGB σε CMYK, τότε το φάσμα δυνατών αποχρώσεων αλλάζει και κάποια 
από τα αρχικά χρώματα αποδίδονται με παραπλήσια χρώματα. 

Η φασματική καμπύλη (color spectrum) που εμφανίζεται στην Εικόνα 2.28, δείχνει τα ορατά χρώ-
ματα. Επίσης, στην Εικόνα 2.28 εμφανίζονται τα χρώματα που μπορεί να απεικονίσουν οι κοινές συσκευές 
που λειτουργούν με τα μοντέλα RGB και CMYK. Παρατηρούμε ότι κάποιες από τις αποχρώσεις του RGB 
δεν μπορούν να αποδοθούν πιστά στο CMYK και το αντίστροφο. Συνεπώς, όταν κάποια εικόνα πρόκειται να 
εκτυπωθεί, αλλά είναι κωδικοποιημένη σε RGB, πρέπει να ελεγχθεί η σωστή εμφάνιση των χρωμάτων. Τα 
επαγγελματικά εργαλεία επεξεργασίας εικόνων παρέχουν τέτοιες δυνατότητες. 

 
 

 
 
Εικόνα 2.28 Σχέση ορατών χρωμάτων και χρωμάτων των κοινών συσκευών που χρησιμοποιούν τα μοντέλα RGB και 
CMYK. 
 

Το sRGB (standard RGB) που αναφέρεται στην Εικόνα 2.28, περιγράφει το τμήμα του φάσματος 
χρωμάτων που μπορούν να προβάλλουν συνήθως οι συσκευές. Το μοντέλο RGB, γενικά, είναι ικανό να περι-
γράψει όλα τα χρώματα με βάση τις τρεις επιμέρους συνιστώσες, ενώ το sRGB περιγράφει ένα πιο περιορι-
σμένο σύνολο αποχρώσεων που τελικά υποστηρίζουν οι συσκευές. Δημιουργήθηκε από τις εταιρείες Hewlett-
Packard και Microsoft με σκοπό να μπορούν οι συσκευές και τα ψηφιακά αρχεία που υποστηρίζουν το sRGB 
να έχουν τελικά τις ίδιες δυνατότητες απόδοσης χρώματος, άρα το ίδιο color gamut.  

Το Adobe RGB έχει δημιουργηθεί από την εταιρεία Adobe για να περιλαμβάνει τις περισσότερες α-
ποχρώσεις των εκτυπωτών CMYK στα χρώματα που μπορεί να προβάλλουν οι οθόνες υπολογιστών. Δηλαδή, 
οι οθόνες που υποστηρίζουν το Adobe RGB προβάλλουν τις αποχρώσεις του CMYK κανονικά. Άρα, όπως 
εμφανίζεται μία απόχρωση στην οθόνη, θα εμφανιστεί τελικά και στον εκτυπωτή. Στην περίπτωση του sRGB, 
αυτό δεν συμβαίνει για όλες τις αποχρώσεις. 
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2.4. Ψηφιογραφικές εικόνες (Bitmap) 
 
Στις προηγούμενες ενότητες παρουσιάστηκαν θέματα που άπτονται της ψηφιοποίησης εικόνων και της χρή-
σης και αναπαράστασης των χρωμάτων. Όπως αναφέρθηκε και στην αρχή του κεφαλαίου, οι εικόνες είναι 
είτε ψηφιογραφικές είτε διανυσματικές. Οι ψηφιοποιημένες εικόνες είναι συνήθως ψηφιογραφικές (bitmap). 
Οι bitmap εικόνες αποτελούνται από ένα σύνολο εικονοστοιχείων που διατάσσονται στο επίπεδο και έτσι 
σχηματίζεται η τελική εικόνα. Συνεπώς, τα γραφικά bitmap, ουσιαστικά είναι ένας πίνακας, όπου κάθε κελί 
του πίνακα αποτελεί ένα pixel της εικόνας. Ο πίνακας αναφέρεται και ως χάρτης, γι’ αυτό και οι εικόνες ανα-
φέρονται και ως χαρτογραφικές (Εικόνα 2.29).  

Κάθε pixel έχει ένα χρώμα και τελικά οι εικόνες δημιουργούνται ως ένα σύνολο από εικονοστοιχεία 
που έχουν κάποιο χρώμα και κάποια θέση στο χάρτη των εικονοστοιχείων. Για κάθε χαρτογραφική εικόνα 
αποθηκεύεται σε ψηφιακή μορφή το χρώμα και η θέση κάθε pixel πάνω στο χάρτη των εικονοστοιχείων. 

Για παράδειγμα, στην Εικόνα 2.29 υπάρχει η αρχική εικόνα (α) στο κανονικό της μέγεθος. Στην Ει-
κόνα 2.29β εμφανίζεται η εικόνα σε μεγέθυνση, όπου διακρίνονται τα pixel και το χρώμα κάθε εικονοστοι-
χείου. Η εικόνα αποτελείται από 256 (16x16) συνολικά εικονοστοιχεία. Η ανάλυση της εικόνας αναφέρεται 
σε ppi (pixels per inch) και, όπως αναφέρθηκε, όσο μεγαλύτερη είναι η ανάλυση τόσο πιο μεγάλη είναι η ευ-
κρίνεια της εικόνας. Επίσης, εικόνες με μεγάλη ανάλυση μπορούν πιο εύκολα να επεξεργαστούν και να μεγε-
θυνθούν ή να εκτυπωθούν με υψηλή ευκρίνεια. Το βάθος χρώματος είναι επίσης σημαντικό, γιατί το μεγάλο 
βάθος χρώματος επιτρέπει την πιστή απόδοση των χρωμάτων. 

 

 
 

Εικόνα 2.29 (α) Αρχική εικόνα bitmap. (β) Εικόνα σε μεγέθυνση όπου διακρίνονται τα εικονοστοιχεία. 

 
 

2.4.1. Μέγεθος εικόνων bitmap 
 
Το μέγεθος των ασυμπίεστων εικόνων bitmap εξαρτάται από τις διαστάσεις της εικόνας, την ανάλυση της 
εικόνας και το βάθος χρώματος. Με άλλα λόγια, το μέγεθος εξαρτάται από το σύνολο των pixels της εικόνας 
και τον αριθμό bits ανά pixel. Ανεξάρτητα από το σχήμα τους, καταλαμβάνουν το χώρο ενός ορθογωνίου πα-
ραλληλογράμμου και ακόμη και οι λευκές περιοχές, που ανάλογα με το φόντο στο οποίο τοποθετούνται μπο-
ρεί να είναι αντιληπτές, αυξάνουν το μέγεθος των εικόνων. 

 
πλάτος  ύψος (ίντσες)  οριζόντια ανάλυση  κατακόρυφη ανάλυση (ppi)  βάθος χρώματος (bits) 

 
Πίνακας 2.2 Υπολογισμός μεγέθους σε bits μιας ασυμπίεστης εικόνας bitmap. 

 
Στον Πίνακα 2.2 εμφανίζεται ο τύπος υπολογισμού του μεγέθους μιας ασυμπίεστης εικόνας σε bits. 

Για παράδειγμα, μια εικόνα με 10x5 ίντσες, οριζόντιας και κάθετης ανάλυσης 96 ppi και βάθους χρώματος 8 
bits ισούται με: 

 
(105)  (9696)  8 = 3686400 bit 
 
Διαιρώντας το αποτέλεσμα διά 8, έχουμε το μέγεθος της εικόνας σε bytes ίσο με 460800. Περαιτέρω 

διαίρεση δια 1024 δίνει μέγεθος εικόνας ίσο με 450ΚΒ. Σε MB μετατρέπεται το μέγεθος με διαίρεση του 450 
με το 1024. Το αποτέλεσμα είναι 0,44ΜΒ. Η ίδια εικόνα με 300 ppi οριζοντίως και καθέτως και 8 bit βάθος 
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χρώματος έχει μέγεθος περίπου 4,30ΜΒ. Αν το βάθος χρώματος είναι πραγματικό, δηλ. 24 bit, τότε το μέγε-
θος της εικόνας αυξάνεται σε 12,9ΜΒ. Αν και αυξάνει το μέγεθος, το μεγάλο βάθος χρώματος και η μεγάλη 
ανάλυση έχει ως αποτέλεσμα πιο ευκρινείς εικόνες. 

Σε περίπτωση που έχουμε το πλάτος και το ύψος σε εκατοστά, πρέπει να το μετατρέψουμε σε ίντσες 
με βάση τη σχέση: ίντσα = 2,54 εκατοστά. Αν γνωρίζουμε απευθείας το σύνολο των pixels της εικόνας, τότε 
απλά πολλαπλασιάζουμε τον αριθμό αυτό με το βάθος χρώματος. Στο παράδειγμά μας, η εικόνα 10x5x96x96 
αποτελείται από 460800 pixels. Με βάθος χρώματος 8bit το μέγεθός της είναι 4608008 bits = 3686400 bits = 
460800 bytes = 450 KB ≈ 0,44MB.  

Το μέγεθος της εικόνας μπορεί να δίνεται και με βάση το γινόμενο των pixels οριζοντίως και καθέ-
τως, π.χ. 960480. Σε αυτή την περίπτωση το μέγεθος ισούται με 960480βάθος χρώματος.  

Το τελικό μέγεθος μιας εικόνας εξαρτάται όμως και από άλλους παράγοντες. Βασικό ρόλο παίζει η 
μορφή (μορφότυπο ή φορμά – format) η οποία θα επιλεχθεί για την αποθήκευση της εικόνας. Τα μορφότυ-
πα αποτελούν συγκεκριμένους τρόπους αποθήκευσης των δεδομένων εικόνας. Υπάρχουν αρκετές μορφές 
αποθήκευσης εικόνων με διαφορετικά χαρακτηριστικά και διαφορετικές δυνατότητες η καθεμία. Για παρά-
δειγμα, μορφότυπα όπως το BMP, δεν υποστηρίζουν συμπίεση και το μέγεθός τους υπολογίζεται με βάση τα 
όσα ειπώθηκαν παραπάνω. Στην περίπτωση της μορφής αποθήκευσης JPEG υπάρχει δυνατότητα μεγάλης 
συμπίεσης με μικρή απώλεια πληροφορίας. 

 

2.4.2. Ειδικά θέματα ψηφιογραφικών εικόνων 
 
2.4.2.1. Indexed color (δεικτοδοτούμενο χρώμα) 
 
Όπως αναφέρθηκε σε προηγούμενη ενότητα, μια έγχρωμη εικόνα, ανάλογα με το βάθος χρώματος, μπορεί να 
χρησιμοποιεί 16 ή 24 ή ακόμη και περισσότερα bits για την αποθήκευση των χρωματικών αποχρώσεών της. 
Αυτό αυξάνει το μέγεθος της εικόνας, αν και πολλές φορές η εικόνα αποτελείται από λιγότερα χρώματα από 
ό,τι υποστηρίζει το βάθος χρώματος.  

 

 
[Πηγή αρχικής εικόνας: http://goo.gl/8kx8XQ] 

 
Εικόνα 2.30 Δίπλα στην εικόνα εμφανίζεται η παλέτα των 256 χρωμάτων που χρησιμοποιείται. 

 
Το δεικτοδοτούμενο χρώμα (indexed color) αφορά στη δυνατότητα χρήσης 256 ή λιγότερων χρω-

μάτων για την αναπαράσταση των χρωματικών αποχρώσεων της εικόνας. Στην περίπτωση αυτή, η παλέτα 
των χρωμάτων που χρησιμοποιούνται αποθηκεύεται χωριστά, σε σχέση με τις πληροφορίες της εικόνας (Ει-
κόνες 2.30 και 2.31).  

Η παλέτα περιέχει συνήθως τα κύρια χρώματα της ψηφιακής εικόνας. Με αυτό τον τρόπο υπάρχει η 
δυνατότητα έγχρωμης αναπαράστασης της εικόνας, αλλά και μικρού μεγέθους. Η παλέτα χρωμάτων μπορεί 
να δημιουργηθεί με διαφόρους τρόπους. Μπορεί να περιέχει ακριβώς τα χρώματα της εικόνας, αν η εικόνα 
περιέχει λιγότερα από 256 χρώματα, ή μπορεί να αποτελείται από τα περισσότερο χρησιμοποιούμενα χρώμα-
τα της εικόνας, ή ακόμη να περιέχει και τα χρώματα που είναι περισσότερο αισθητά στο ανθρώπινο μάτι. Ε-
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πίσης, υπάρχει η δυνατότητα να χρησιμοποιηθεί η επιλογή δεικτοδοτούμενου χρώματος Web, που αποτελεί-
ται από τα χρώματα που υπάρχουν σίγουρα στα Windows και στους υπολογιστές Macintosh. Έτσι, διασφαλί-
ζεται ότι η εικόνα θα εμφανίζεται το ίδιο, σε οποιοδήποτε υπολογιστή. Η χρήση indexed color εξασφαλίζει 
μικρότερο μέγεθος αρχείων και ίδια εμφάνιση των εικόνων, αλλά δεν ενδείκνυται για εικόνες με χιλιάδες α-
ποχρώσεις, λόγω του περιορισμού των 256 χρωμάτων. 

 

 
 

Εικόνα 2.31 Δίπλα στην εικόνα εμφανίζεται η παλέτα των 256 χρωμάτων που χρησιμοποιείται. 

 
2.4.2.2. Διαφάνεια 
 
Ο όρος διαφάνεια (transparency) αναφέρεται στη δυνατότητα κάποιων μορφών εικόνων να μην εμφανίζουν 
ένα χρώμα. Συνήθως η διαφάνεια αφορά το χρώμα του φόντου της εικόνας, έτσι ώστε, όταν εμφανίζεται σε 
φόντο με διαφορετικό χρωματισμό, να μην εμφανίζεται το πλαίσιο της εικόνας. Για παράδειγμα στην Εικόνα 
2.32, η πεταλούδα είναι με διαφανές φόντο και έτσι, όταν προβάλλεται σε γκρι ή μαύρο χρώμα, εμφανίζεται 
ενσωματωμένη στο αντίστοιχο χρώμα. Στην Εικόνα 2.33 το άσπρο χρώμα φόντου της εικόνας εμφανίζεται, 
διότι η εικόνα δεν είναι διαφανής. 

 
 

 
 
Εικόνα 2.32 Εικόνα με διαφάνεια σε κίτρινο και κυανό φόντο. 

 
Η διαφάνεια επιτυγχάνεται με ορισμό ενός χρώματος ως διαφανούς και υποστηρίζεται από κάποιες 

μορφές αρχείων, όπως π.χ. εικόνες μορφής GIF και PNG. Τα εικονοστοιχεία που αντιστοιχούν στο διαφανές 
χρώμα, δεν εμφανίζονται, αλλά στη θέση τους εμφανίζεται το χρώμα του φόντου πάνω στο οποίο προβάλλε-
ται η εικόνα. 
 
 

 
 
Εικόνα 2.33 Εικόνα χωρίς διαφάνεια σε γκρι φόντο. 
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2.4.2.3. Κανάλια εικόνας και κανάλι Άλφα 
 

Με τον όρο κανάλια (channels) σε μια εικόνα αναφερόμαστε, ουσιαστικά, στα βασικά χρώματα του χρωματι-
κού μοντέλου που χρησιμοποιείται. Για παράδειγμα, αν χρησιμοποιείται το RGB, τότε η εικόνα έχει τρία κα-
νάλια Red, Green και Blue. Σε κάθε κανάλι καθορίζεται πόσο από το αντίστοιχο χρώμα χρησιμοποιείται, κα-
θώς και άλλες παράμετροι που αφορούν το συγκεκριμένο χρώμα. Τελικά, η εικόνα συντίθεται από τις πληρο-
φορίες των τριών καναλιών. 

Αν εμφανίσουμε κάθε κανάλι χωριστά, τότε εμφανίζεται μια εικόνα με αποχρώσεις του γκρι για κάθε 
χρώμα. Στην Εικόνα 2.34α για παράδειγμα, εμφανίζεται ένας παπαγάλος που έχει σώμα με αποχρώσεις του 
κόκκινου και πράσινα και μπλε φτερά. Στην Εικόνα 2.34β εμφανίζεται το κόκκινο κανάλι της εικόνας και 
στις περιπτώσεις γ και δ το πράσινο και μπλε κανάλι αντίστοιχα. Παρατηρούμε, ότι οι αποχρώσεις δεν είναι 
ίδιες σε κάθε περίπτωση. Η φωτεινότητα κάθε καναλιού είναι ανάλογη του χρώματος. Στην περίπτωση β της 
Eικόνας 2.34 το σώμα είναι πολύ φωτεινό, διότι είναι κόκκινο, ενώ στις άλλες περιπτώσεις τα φτερά είναι πιο 
φωτεινά και το σώμα του παπαγάλου σκούρο. 
 

 
 
Εικόνα 2.34 (α) Αρχική εικόνα (β) Κόκκινο κανάλι (γ) Πράσινο κανάλι (δ) Μπλε κανάλι 

 
Η ύπαρξη καναλιών διευκολύνει την επεξεργασία της εικόνας, διότι κάθε κανάλι μπορεί να επεξερ-

γαστεί ξεχωριστά. Όπως βλέπουμε στην Εικόνα 2.35, απλές αλλαγές χρωμάτων είναι δυνατές με επεξεργασία 
του ενός καναλιού. Στη συγκεκριμένη περίπτωση, άλλαξε ομοιόμορφα το χρώμα στο σώμα του παπαγάλου, 
αλλάζοντας τις ρυθμίσεις αρχικά του μπλε καναλιού και έπειτα του πράσινου καναλιού. Φυσικά, οι πολύπλο-
κες αλλαγές χρωμάτων απαιτούν περισσότερες επεμβάσεις σε κάθε κανάλι και συνήθως γίνονται με χρήση 
των παραμέτρων χροιάς (hue), κορεσμού (saturation) και φωτεινότητας (lightness). 
 

 
 
Εικόνα 2.35 Από την εικόνα (α), με επεξεργασία του κόκκινου καναλιού δημιουργήθηκε η εικόνα (β) και με επεξεργασία 
του μπλε καναλιού η (γ). 
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Το κανάλι Άλφα (Alpha channel) είναι ένα επιπλέον κανάλι που χρησιμοποιείται στις εικόνες και 
περιέχει πληροφορίες για τη διαφάνεια των εικονοστοιχείων. Η ύπαρξη του συγκεκριμένου καναλιού επιτρέ-
πει τη μερική διαφάνεια (partial transparency) των βασικών Red, Green και Blue καναλιών της εικόνας. Στην 
περίπτωση που η μορφή αποθήκευσης υποστηρίζει το κανάλι Alpha, το χρωματικό μοντέλο αναφέρεται ως 
RGBA. Ρυθμίζοντας κατάλληλα το συγκεκριμένο κανάλι, μπορούμε να έχουμε διαφάνεια σε περισσότερα 
από ένα χρώματα σε σχέση με την κλασική έννοια της διαφάνειας που αναφέρθηκε πιο πάνω. Έτσι, υπάρχει η 
δυνατότητα πιο ομοιόμορφου συνδυασμού πολλών εικόνων, όπου δεν θα είναι διακριτά τα όρια των εικόνων. 
 
2.4.2.4. Dithering 
 
Dithering είναι η τεχνική επίτευξης μεγαλύτερης ποικιλίας χρωμάτων στις εικόνες με περιορισμένη παλέτα 
χρωμάτων, ώστε να υπάρξουν περισσότερες διαβαθμίσεις των διαθέσιμων χρωμάτων. Σε μια εικόνα στην ο-
ποία εφαρμόζεται κάποια τεχνική dithering, τα μη διαθέσιμα χρώματα προσεγγίζονται με διασπορά των υπο-
λοίπων διαθέσιμων χρωμάτων. Το ανθρώπινο μάτι αντιλαμβάνεται τη διασπορά των χρωμάτων ως μείξη τους 
και συνεπώς ως νέες αποχρώσεις. Υπάρχουν διαφορετικές τεχνικές dithering με διαφορετική ποιότητα η κα-
θεμία, αν και το αποτέλεσμα είναι συνήθως μια πιο «τραχιά» εμφάνιση των εικόνων (Εικόνα 2.36) που έχουν 
τελικά και μικρότερο μέγεθος. 
 

 
[Πηγή: http://goo.gl/MkahkU]  
 
Εικόνα 2.36 Η εικόνα (α) αποτελείται από 256 χρώματα, ενώ η εικόνα (β) από 16 χρώματα και έχει περίπου το μισό μέγε-
θος. 
 

2.4.2.5. Συμπίεση 
 
Όπως συζητήθηκε πιο πάνω, το μέγεθος των ψηφιογραφικών εικόνων αυξάνει σημαντικά, ανάλογα με το βά-
θος χρώματος και την ανάλυσή της. Έγχρωμες εικόνες υψηλής ανάλυσης έχουν μεγάλο μέγεθος, που είναι 
πολλές φορές απαγορευτικό για αρκετές χρήσεις. Για παράδειγμα, στην περίπτωση του διαδικτύου εικόνες 
μεγαλύτερες από 1 ΜΒ θα καθυστερούν τη μεταφόρτωση των ιστοσελίδων. Η λύση σε αυτό το πρόβλημα 
είναι η συμπίεση (compression) των πληροφοριών των εικόνων, ώστε να έχουν μικρότερο μέγεθος και καλή 
ποιότητα. Οι αλγόριθμοι συμπίεσης διακρίνονται σε απωλεστικούς (lossy) και μη απωλεστικούς (lossless). 

Στους απωλεστικούς αλγορίθμους συμπίεσης αφαιρούνται μη ουσιώδεις πληροφορίες από την εικόνα. 
Οι πληροφορίες αυτές αφορούν λεπτομέρειες της εικόνας που δεν μπορούν να γίνουν εύκολα αντιληπτές από 
το ανθρώπινο μάτι. Με αυτόν τον τρόπο μπορούμε να πετύχουμε υψηλούς λόγους συμπίεσης, π.χ. 10:1, με 
μικρή απώλεια πληροφορίας και πολύ καλό αποτέλεσμα.  

Χαρακτηριστικός απωλεστικός αλγόριθμος συμπίεσης είναι ο JPEG. Ο JPEG χωρίζει την εικόνα σε 
τμήματα των 8x8 εικονοστοιχείων τα οποία συμπιέζει. Λειτουργεί πιο αποτελεσματικά σε φωτογραφίες και 
όχι σε σχέδια. Έχει διαφόρους τρόπους λειτουργίας, μεταξύ των οποίων και η δυνατότητα συμπίεσης χωρίς 
απώλεια πληροφορίας, αλλά με μικρή συμπίεση. Ο JBIG2 είναι, επίσης, αλγόριθμος για διτονικές (μαυρόα-
σπρες φωτογραφίες) με υψηλή απόδοση στην περίπτωση απωλεστικής συμπίεσης. Λειτουργεί και ως μη α-
πωλεστικός αλγόριθμος, αλλά έχει μικρότερη απόδοση. 

Οι μη απωλεστικοί αλγόριθμοι συμπιέζουν τις εικόνες χωρίς απώλεια πληροφορίας. Επιτυγχάνουν 
μικρή συμπίεση, αλλά η αρχική εικόνα αναπαρίσταται πιστά κατά την αποσυμπίεση. Οι πιο δημοφιλείς μη 
απωλεστικοί αλγόριθμοι είναι οι LZW (Lempel-Ziv Welch), Run Length Encoding (RLE) και Huffman, οι ο-
ποίοι υποστηρίζονται από τα πρότυπα TIFF, GIF, PSD. 
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Ο αλγόριθμος LZW αντικαθιστά ολόκληρες λέξεις ή φράσεις με σύμβολα και δημιουργεί ένα λεξικό 
αντιστοίχισης των λέξεων και φράσεων με σύμβολα. Έτσι, οι πιο συχνά επαναλαμβανόμενες ακολουθίες χα-
ρακτήρων αντικαθίστανται με τα πιο μικρά σε bytes σύμβολα και τελικά μειώνεται ο όγκος πληροφοριών. Η 
επιλογή των κατάλληλων λέξεων ή φράσεων που θα αντικατασταθούν, ώστε να προκύψει το βέλτιστο αποτέ-
λεσμα, είναι μία αρκετά περίπλοκη διαδικασία, που έχει οδηγήσει σε μεγάλο αριθμό παραλλαγών του αλγο-
ρίθμου. Αξίζει να σημειωθεί ότι ο αρχικός αλγόριθμος δημιουργήθηκε από τους Lempel και Ziv και ονομαζό-
ταν LZ78, διότι δημιουργήθηκε το 1978, ενώ αργότερα επεκτάθηκε από τον Welch και ονομάστηκε LZW. 

Ο αλγόριθμος RLE ανιχνεύει επαναλαμβανόμενες σειρές χαρακτήρων στα δεδομένα και τις αντικαθι-
στά χρησιμοποιώντας μόνο δύο bytes, ένα για τον χαρακτήρα και ένα για τον αριθμό εμφανίσεων του χαρα-
κτήρα. Για παράδειγμα, η ακολουθία ΑΑΑΒΒΒΒCCCCCC αποθηκεύεται ως 3Α4Β6C, δηλαδή γίνεται εξοι-
κονόμηση 7 χαρακτήρων. Η συγκεκριμένη τεχνική μπορεί να χρησιμοποιηθεί για τη συμπίεση οποιουδήποτε 
τύπου αρχείων, η απόδοσή της όμως είναι μικρή.  

Στην κωδικοποίηση Huffman, κάθε χαρακτήρας δεν έχει σταθερό μήκος, αλλά μεταβλητό. Η κωδικο-
ποίηση για τους πιο συχνά εμφανιζόμενους χαρακτήρες είναι μικρότερη από ό,τι για τους λιγότερο συχνά εμ-
φανιζόμενους, με αποτέλεσμα το συνολικό μέγεθος να είναι μικρότερο. Για τους συχνότερους χαρακτήρες 
χρησιμοποιούνται μόνο 2-3 bits, ενώ για τους υπόλοιπους περισσότερα bits (μέχρι 8 ή 16). 

 
2.4.2.6. Ιστόγραμμα εικόνας 
 
Το ιστόγραμμα είναι μια γραφική απεικόνιση της κατανομής των χρωμάτων σε μία εικόνα. Προβάλλει τον 
αριθμό των pixels ανά απόχρωση της εικόνας. Στην Εικόνα 2.37 εμφανίζονται τα ιστογράμματα των παπαγά-
λων της εικόνας 2.35. Παρατηρούμε ότι η κατανομή είναι στο μέγιστο σημείο της σε διαφορετικά σημεία. Ο 
οριζόντιος άξονας αναπαριστά τις χρωματικές διαβαθμίσεις της εικόνας, ενώ ο κάθετος άξονας τον αριθμό 
των εικονοστοιχείων κάθε απόχρωσης. Όσο πιο απλωμένο είναι ένα ιστόγραμμα στον οριζόντιο άξονα, τόσο 
περισσότερες αποχρώσεις έχει η εικόνα. Αν το ιστόγραμμα είναι εντοπισμένο σε μια μικρή περιοχή, η εικόνα 
έχει χαμηλή αντίθεση και η ποιότητα της εικόνας είναι χαμηλή. 

 

 
 
Εικόνα 2.37 Ιστογράμματα των φωτογραφιών της εικόνας 2.35. 

 
Γενικά, με τη χρήση ιστογραμμάτων μπορούν να γίνουν διορθώσεις στη φωτεινότητα και την αντίθε-

ση των χρωμάτων της εικόνας. Τα ιστογράμματα μπορεί να φανούν πολύ χρήσιμα, γιατί μας βοηθούν να εξά-
γουμε συμπεράσματα και για τη μορφή μιας εικόνας. Τα σύγχρονα εργαλεία επεξεργασίας εικόνων μπορούν 
να εμφανίσουν ιστόγραμμα και ανά κανάλι εικόνας.  

 

2.4.3. Μορφές αρχείων εικόνων bitmap 
 

Τα μορφότυπα ή μορφοποιήσεις ή φορμά αρχείων (file formats) εικόνας αφορούν στον τρόπο που αποθη-
κεύονται οι πληροφορίες της εικόνας και τις τεχνικές συμπίεσης που εφαρμόζονται. Υπάρχουν διαφορετικές 
μορφοποιήσεις εικόνων, καθεμία εκ των οποίων προσφέρει διαφορετικές δυνατότητες και πλεονεκτήματα. 
 

2.4.3.1. BMP 
 
Η μορφοποίηση BMP (Bitmap) αναπτύχθηκε από τη Microsoft για ψηφιογραφικές εικόνες. Το βάθος χρώμα-
τος των αρχείων BMP μπορεί να είναι από 1 bit (διτονικές) ως και 24 bit (true color). Το μέγεθος των αρχείων 
είναι συνήθως μεγάλο και γι’ αυτό  δεν χρησιμοποιούνται στο διαδίκτυο. Χρησιμοποιούνται κυρίως στα 
Windows. Μπορεί να εφαρμοστεί ο αλγόριθμος συμπίεσης RLE (Run Length Encoding), που αποτελεί μη 
απωλεστικό αλγόριθμο, αλλά δεν επιτυγχάνεται ικανοποιητική μείωση του μεγέθους του αρχείου. Τα αρχεία 
έχουν επέκταση .bmp ή .dib και μπορούν να επεξεργαστούν και να ενσωματωθούν σε πολλές εφαρμογές. 
Πρέπει να σημειωθεί εδώ, ότι η Adobe, εταιρία που έχει δημιουργήσει το Photoshop και πολλά άλλα εργαλεία 
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για επεξεργασία εικόνων, βίντεο και γραφικών, αναφέρει τις ψηφιογραφικές εικόνες ως raster και χρησιμο-
ποιεί το Bitmap για εικόνες βάθους 1 bit, δηλαδή διτονικές. 
 
2.4.3.2. JPEG 
 
Η μορφοποίηση JPEG δημιουργήθηκε από την ομάδα εργασίας Joint Photographic Experts Group του οργα-
νισμού ISO (International Organization for Standardization) και αποτελεί το πιο διαδεδομένο πρότυπο συμπί-
εσης εικόνων. Τα αρχεία έχουν επέκταση .jpg, .jpeg ή .jpe και χρησιμοποιούνται στις εφαρμογές διαδικτύου, 
αλλά και σε άλλες περιπτώσεις, όπως κινητά τηλέφωνα και ψηφιακές φωτογραφικές μηχανές. Επιτυγχάνει 
μεγάλη συμπίεση εξαλείφοντας πληροφορίες που βασίζονται σε περιορισμούς της ανθρώπινης όρασης. Το 
ανθρώπινο μάτι δεν μπορεί να διακρίνει όλες τις λεπτομέρειες μιας εικόνας και έτσι, κάποιες μη ουσιώδεις 
λεπτομέρειες αφαιρούνται και επιτυγχάνεται η επιθυμητή συμπίεση. O αλγόριθμος JPEG ανήκει στην κατη-
γορία των απωλεστικών αλγορίθμων. Υποστηρίζει βάθος χρώματος 24 bit. 

Τα προγράμματα επεξεργασίας εικόνων επιτρέπουν στο χρήστη τον ορισμό του λόγου συμπίεσης και 
της ποιότητας εμφάνισης της εικόνας. Για παράδειγμα, στην Εικόνα 2.38, η πρώτη φωτογραφία έχει συμπιε-
στεί κατά 15%, ενώ η δεύτερη εικόνα κατά 75%. Το οπτικό αποτέλεσμα δεν αλλάζει ουσιαστικά, ενώ το μέ-
γεθος από περίπου 120 KB γίνεται περίπου 55 ΚΒ στη δεύτερη περίπτωση. Το τελικό μέγεθος της εικόνας 
εξαρτάται και από άλλους παράγοντες, όπως για παράδειγμα η ανάλυση. Και στις δύο περιπτώσεις της εικό-
νας 2.38, οι φωτογραφίες έχουν υψηλή ανάλυση 300 ppi. Αν προορίζονταν για εμφάνιση στο διαδίκτυο μόνο, 
τότε η ανάλυση θα μπορούσε να προσαρμοστεί σε 72 ή 96 ppi και να υπάρχει περαιτέρω μείωση του μεγέ-
θους. 

 

 
 

Εικόνα 2.38 Η αριστερή εικόνα έχει συμπιεστεί κατά 15%, ενώ η δεξιά κατά 75%. 
 

Στην πράξη ο JPEG είναι ο αλγόριθμος συμπίεσης. Η μορφή αρχείου που χρησιμοποιεί αυτόν τον αλ-
γόριθμο είναι η JPEG JFIF (JPEG File Interchange Format) και ουσιαστικά, όταν αναφέρουμε τη μορφή αρ-
χείων JPEG, εννοούμε τα αρχεία JPEG JFIF. Γι’ αυτό το λόγο, από κάποιες εφαρμογές χρησιμοποιούνται και 
οι επεκτάσεις .jif, .jfif και .jfi στα αρχεία που εφαρμόζεται ο αλγόριθμος JPEG. Η μορφή JFIF περιέχει, εκτός 
από τα δεδομένα εικόνας που είναι κωδικοποιημένα σε JPEG, και κάποια άλλα μεταδεδομένα (metadata) που 
χρησιμοποιούνται για τη σωστή ερμηνεία των δεδομένων εικόνας. Το JFIF αναφέρεται και ως υποδοχέας 
(container). Πρέπει, φυσικά, να αναφερθεί ότι κατ’ ουσίαν λέγοντας JPEG, εννοούμε ταυτόχρονα και τη μορ-
φή αρχείου, και έτσι ο όρος JFIF σπανίζει. 
 
JPEG 2000 

 
Ο τύπος JPEG2000 δημιουργήθηκε το 2000 για να αποτελέσει την εξέλιξη του JPEG. Τα αρχεία έχουν επέ-
κταση .jp2 ή .jpx ή .j2k ή .j2c ή .jpf. Ο νέος τύπος παρέχει συμπίεση με πολύ μικρή απώλεια πληροφορίας, με 
αποτέλεσμα η ποιότητα της συμπιεσμένης εικόνας να προσεγγίζει την ποιότητα της εικόνας χωρίς συμπίεση. 
Επίσης, η κατά στρώματα δομή (διαφορετικής ανάλυσης) που υποστηρίζει το JPEG2000 μπορεί να εξαλείψει 
την ανάγκη για αποθήκευση πολλών αρχείων διαφορετικής ανάλυσης της ίδιας εικόνας. Είναι ιδανικό για την 
προβολή στο διαδίκτυο μεγάλων σε όγκο και σύνθετων εικόνων, ωστόσο δεν υποστηρίζεται ευρέως από τα 
προγράμματα περιήγησης διαδικτύου.  

 



45 
 

JPEG XR και JPEG LS 
 

Η μορφοποίηση JPEG XR (JPEG Extended Range) δημιουργήθηκε από τη Microsoft και τον ISO. Τα αρχεία 
έχουν προέκταση .hdp ή .jxr ή .wdp και αποτελεί εξέλιξη της μορφής HD Photo που αφορά την αποθήκευση 
ψηφιακών φωτογραφιών. Πρόκειται για νέα και όχι αρκετά διαδεδομένη μορφοποίηση που επιτρέπει καλύτε-
ρη συμπίεση από τη μητρική μορφοποίηση JPEG. Υποστηρίζει μέχρι και 48 bit RGB, αλλά και CMYK εικό-
νες. Αν και στην αρχική JPEG μορφοποίηση δεν υποστηρίζεται η διαφάνεια, το πρότυπο JPEG XR υποστηρί-
ζει το κανάλι Άλφα, και συνεπώς απλή και μερική διαφάνεια. 

Η μορφή JPEG LS (lossless JPEG) στοχεύει στην ύπαρξη ενός πιο αποτελεσματικού μη απωλεστικού 
τρόπου συμπίεσης στο πρότυπο. Υπάρχουν διάφορες υλοποιήσεις του αλγορίθμου και δεν αποτελεί ακόμη 
πρότυπο. Σκοπός του JPEG LS είναι να είναι πιο γρήγορο από το JPEG 2000. 
 

2.4.3.3. GIF 
 
Το GIF (Graphics Interchange Format) υποστηρίζει βάθος χρώματος μέχρι 8 bit, άρα 256 χρώματα. Η μορφο-
ποίηση αναπτύχθηκε από την εταιρεία Compuserve και χρησιμοποιήθηκε αρχικά για τη μεταφορά εικόνων 
μέσω τηλεφωνικών γραμμών. Το μορφότυπο GIF χρησιμοποιεί τον μη απωλεστικό αλγόριθμο συμπίεσης 
Lempel-Ziv-Welch (LZW) που επιτυγχάνει υψηλό λόγο συμπίεσης, π.χ. 4:1. Ο αλγόριθμος συμπίεσης είναι 
αποτελεσματικός όταν υπάρχουν μεγάλες περιοχές στην εικόνα με ένα χρώμα. Λόγω των λίγων χρωμάτων 
που υποστηρίζει, το GIF είναι κατάλληλο για εικόνες με λίγα χρώματα, όπως λογότυπα, σχήματα και δια-
γράμματα. Υποστηρίζει δεικτοδοτούμενο χρώμα (indexed color) και έτσι επιτρέπει τη χρήση διαφορετικών 
χρωμάτων ανά εικόνα και ξεπερνά, κάπως, το εμπόδιο των 256 χρωμάτων, καθώς κάθε εικόνα μπορεί να 
χρησιμοποιεί διαφορετική παλέτα χρωμάτων. Το πρότυπο υποστηρίζει διαφάνεια εικόνων. 

Υπάρχουν δυο τύποι του προτύπου GIF, το GIF87a, που αποτελεί τις αρχικές προδιαγραφές, και το 
πρότυπο GIF89a. Το GIF87a υποστηρίζει interlacing (διαπλοκή), δηλαδή επιτρέπει τη βαθμιαία εμφάνιση 
μιας εικόνας. Η μορφή GIF89a υποστηρίζει απλά animation (κινούμενες εικόνες) και καθορισμό περιοχών 
διαφάνειας στην εικόνα. Η κίνηση παράγεται με την ύπαρξη πολλών εικόνων στο ίδιο αρχείο. Οι εικόνες 
προβάλλονται διαδοχικά, δίνοντας την εντύπωση της κίνησης. Ο δημιουργός των animated GIFs, όπως ονο-
μάζονται, μπορεί επίσης να καθορίσει την καθυστέρηση προβολής των διαδοχικών εικόνων. 

 

2.4.3.4. PNG 
 
Η μορφοποίηση PNG (Portable Network Graphics) δημιουργήθηκε για την παρουσίαση εικόνων στο διαδί-
κτυο ως εναλλακτική μορφή του GIF. Υποστηρίζει εικόνες μέχρι και true color (16.777.216 αποχρώσεις). Ο 
μη απωλεστικός αλγόριθμος DEFLATE που χρησιμοποιεί δεν παρέχει μεγάλη συμπίεση, αλλά καθιστά το 
αρχείο κατάλληλο για επεξεργασία. Αντίθετα, στα JPΕG χάνεται μέρος της αρχικής πληροφορίας και η επε-
ξεργασία είναι πιο δύσκολη. Τα αρχεία έχουν προέκταση .png. 

Τα αρχεία PNG υποστηρίζουν indexed color με βάθος χρώματος από 1 ως 8 bit, εικόνες με αποχρώ-
σεις του γκρι, εικόνες true color και 32-bit RGBA με ύπαρξη καναλιού Άλφα. Όπως και οι πιο πάνω μορφο-
ποιήσεις, βασίζεται στο μοντέλο RGB και δεν υποστηρίζει μοντέλα όπως το CMYK. Το πρότυπο υποστηρίζει 
διαφάνεια είτε σε ένα χρώμα είτε μερική διαφάνεια με χρήση του καναλιού Άλφα. 

 
2.4.3.5. TIFF 
 
Το πρότυπο αποθήκευσης TIFF (Tagged Image File Format) αφορά χαρτογραφικές εικόνες και τα αρχεία έ-
χουν προέκταση .tif ή .tiff. Υποστηρίζει RGB εικόνες μέχρι και 48 bit βάθος χρώματος και μερική διαφάνεια 
μέσω του καναλιού Άλφα. Παρέχει τη δυνατότητα για indexed color με βάθος χρώματος από 1 ως 8 bit. Τα 
αρχεία TIFF είναι συνήθως ασυμπίεστα και έχουν μεγάλο μέγεθος. Υπάρχει, όμως, η δυνατότητα εφαρμογής 
αλγορίθμων συμπίεσης, όπως ο Lempel-Ziv-Welch (LZW), ακόμη και ο JPEG, για τη μείωση του μεγέθους 
του αρχείου.  

Η μορφοποίηση TIFF χρησιμοποιείται κυρίως για την αποθήκευση εικόνων που έχουν σαρωθεί, αφού 
επιτρέπει την αποθήκευση της εικόνας χωρίς απώλεια στην ποιότητα. Είναι ανεξάρτητο υλικού και λειτουρ-
γικού συστήματος και υποστηρίζεται από όλες τις εφαρμογές. Έτσι, μπορεί να χρησιμοποιηθεί για την απο-
θήκευση και ανταλλαγή εικόνων που περιέχουν όλη την αρχική πληροφορία τους. Το πρόβλημα με τη συγκε-
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κριμένη μορφοποίηση είναι ότι έχει πολλές δυνατότητες και κάποιες από αυτές δεν υποστηρίζονται από κά-
ποιες εφαρμογές προβολής και επεξεργασίας εικόνων. Έτσι, η προβολή του και η επεξεργασία του καθίσταται 
πιο δύσκολη. 

 

2.4.3.6. PSD 
 
Τα PSD (Photoshop Document) αρχεία παράγονται από το δημοφιλές πρόγραμμα επεξεργασίας ψηφιακών 
γραφικών Adobe Photoshop, το οποίο θα παρουσιαστεί αναλυτικά στο επόμενο κεφάλαιο. Τα PSD αρχεία 
περιέχουν πλήθος πληροφοριών, όπως επίπεδα (layers), κανάλια, φίλτρα, χρωματικό μοντέλο (π.χ. RGB ή 
CMYK). Μια εικόνα συντίθεται από πολλές εικόνες ή γεωμετρικά σχήματα που τοποθετούνται σε διαφορετι-
κά επίπεδα (ή στρώματα ή στρώσεις). Με αυτό τον τρόπο, παρέχεται πλήρης ελευθερία τροποποίησης και 
πειραματισμού κατά τη σύνθεση μιας εικόνας. Οι εικόνες του Photoshop μπορεί να είναι από διτονικές (1 bit 
βάθος χρώματος) μέχρι και 32 bit έγχρωμες εικόνες. Το βάθος χρώματος μπορεί να αυξηθεί με χρήση κανα-
λιών, που θα έχουν βάθος χρώματος 16 bit ανά κανάλι.  

Η μορφή αποθήκευσης του Photoshop επιτρέπει το συνδυασμό φωτογραφιών με διανυσματικά γρα-
φικά (π.χ. γραμμές, ή κύκλους). Τα στοιχεία που συνθέτουν τα πολύπλοκα έργα που αναπτύσσονται στο 
Photoshop μπορούν να τοποθετηθούν σε διαφορετικά επίπεδα ή στρώματα (layers) και περιέχονται στο ίδιο 
αρχείο. Για παράδειγμα, στην Εικόνα 2.39 απεικονίζεται ένα έργο που αναπτύσσεται σε επίπεδα. Κάθε επίπε-
δο περιέχει μια φωτογραφία ή ένα σχήμα ή κάποιο κείμενο. Ειδικά εφέ, μερική διαφάνεια και άλλες ενέργειες 
εφαρμόζονται σε κάθε επίπεδο και τελικά παράγεται ένα σύνθετο και καλαίσθητο αποτέλεσμα.  

 

 
 
Εικόνα 2.39 Επιμέρους επίπεδα και τελική εικόνα. 
 

2.4.3.7. PSPIMAGE και CPT 
 
Η μορφοποίηση PSPIMAGE και οι επιμέρους μορφές PSP, PSPFRAME, PSPBRUSH, αφορούν το εργαλείο 
Corel PaintShop Pro. Αποτελούν τη μορφή αποθήκευσης των έργων του συγκεκριμένου εργαλείου, με το ο-
ποίο μπορούμε να επεξεργαστούμε μία ή περισσότερες φωτογραφίες, διορθώνοντας κάποια χρώματα, αποκό-
πτοντας και συνδυάζοντας τμήματά τους, προσθέτοντας κείμενο, εφαρμόζοντας φίλτρα κ.α.  Αποθηκεύοντας 
το έργο στη μορφή PSPIMAGE, μάς δίνεται η δυνατότητα να συνεχίσουμε τις αλλαγές ή να αναιρέσουμε κά-
ποιες από αυτές, πριν να παραχθεί η τελική έκδοση της εικόνας σε μία από τις προαναφερθείσες μορφές, π.χ. 
BMP ή JPEG. Οι PSP, PSPFRAME και PSPBRUSH αποτελούν μορφές αρχείων παλαιότερων εκδόσεων των 
εργαλείων και τα χαρακτηριστικά τους έχουν ενσωματωθεί στο PSPIMAGE. 

Η μορφή CPT είναι η βασική μορφή αποθήκευσης αρχείων του εργαλείου Corel PHOTO-PAINT. 
Παρέχει τη δυνατότητα αποθήκευσης πολύ-επίπεδων έργων με δυνατότητες παρόμοιες με τα αρχεία PSD και 
PSPIMAGE. 

 
2.4.3.8. Άλλες μορφές αποθήκευσης 
 
Υπάρχουν εκατοντάδες επιπλέον μορφές αποθήκευσης ψηφιογραφικών εικόνων, καθεμία από τις οποίες προ-
σφέρει κάποια πλεονεκτήματα ή έχει δημιουργηθεί για κάποιο συγκεκριμένο λειτουργικό σύστημα. Με απλή 
αναζήτηση στο διαδίκτυο θα βρούμε μορφοποιήσεις όπως η PICT που δημιουργήθηκε από την Apple, το ICO 
που είναι μορφή για αποθήκευση εικονιδίων και η μορφή SGI που δημιουργήθηκε από την εταιρεία Silicon 
Graphics. Πολλές περισσότερες μορφές υπάρχουν διαθέσιμες. 
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Στην πράξη, όμως, χρησιμοποιούνται οι μορφές που αναφέρθηκαν πιο πάνω. Στην περίπτωση γραφι-
κών διαδικτύου, χρησιμοποιούνται οι μορφές JPEG, GIF και PNG, ενώ στα Windows συνηθισμένη είναι και 
η μορφοποίηση BMP. Τα εργαλεία επεξεργασίας εικόνων μπορούν να διαχειριστούν διαφορετικές μορφές 
αρχείων και να μετατρέπουν από τη μία μορφή στην άλλη. 

 

2.4.4. Λογισμικό επεξεργασίας ψηφιακών εικόνων 
 
Το λογισμικό (software) επεξεργασίας εικόνων επιτρέπει την επεξεργασία ψηφιακών εικόνων και την αποθή-
κευση σε κάποια μορφή. Οι δυνατότητες επεξεργασίας εικόνων ποικίλουν ανά εργαλείο. Για παράδειγμα, η 
γνωστή σε όλους μας ζωγραφική των Windows και το εργαλείο Microsoft Office Picture Manager (Εικόνα 
2.40) παρέχουν λίγες δυνατότητες επεξεργασίας. Με αυτά τα εργαλεία μπορεί να γίνει περικοπή τμημάτων 
της εικόνας, μείωση των διαθέσιμων χρωμάτων, διαχείριση της αντίθεσης των χρωμάτων, τοποθέτηση κειμέ-
νου ή κάποιων σχημάτων στην εικόνα, αλλά και κάποιες πιο σύνθετες ενέργειες, όπως η κατάργηση του προ-
βλήματος των κόκκινων ματιών που προκαλούνται από το φλας των φωτογραφικών μηχανών. Επίσης, επι-
τρέπουν την αποθήκευση της εικόνας στις πιο δημοφιλείς μορφές, όπως BMP, JPEG, GIF και PNG. 

 

 
 

Εικόνα 2.40 Επεξεργασία εικόνων με τη Ζωγραφική και το Microsoft Office Picture Manager. 

 
Αν και τα συγκεκριμένα εργαλεία είναι αρκετά χρήσιμα για σύντομες εργασίες, δεν μπορούν να χρη-

σιμοποιηθούν για επαγγελματικούς σκοπούς. Το βασικό τους μειονέκτημα είναι ότι δεν υποστηρίζουν επίπε-
δα (layers) στην εικόνα. Αυτό σημαίνει ότι τα αντικείμενα που προστίθενται πάνω στην αρχική φωτογραφία 
ενσωματώνονται σε αυτήν και τα αντίστοιχα εικονοστοιχεία λαμβάνουν το χρώμα του νέου αντικειμένου. 
Έτσι, χάνεται όλη η αρχική πληροφορία. Επιπλέον, δεν παρέχουν αρκετές δυνατότητες για διαχωρισμό των 
αντικειμένων της εικόνας, χρήση φίλτρων, διόρθωση χρωμάτων κ.α. 

 
2.4.4.1. Adobe Photoshop 
 
Το Adobe Photoshop (http://www.adobe.com/gr_en/products/photoshop.html) είναι το πιο δημοφιλές εργα-
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λείο επεξεργασίας ψηφιακών εικόνων (Εικόνα 2.41). Το Photoshop παρέχει τη δυνατότητα ύπαρξης στρωμά-
των (layers – επιπέδων) που επιτρέπουν την επεξεργασία των τμημάτων που αποτελούν την εικόνα σε διαφο-
ρετικά επίπεδα.  

Το εργαλείο παρέχει πολλές δυνατότητες διόρθωσης φωτογραφιών, διαχωρισμού των αντικειμένων 
από το φόντο, εφαρμογή φίλτρων (Εικόνα 2.42), αλλαγής χρωμάτων, προσθήκη διαφάνειας, αποθήκευση σε 
διάφορες μορφές, διαχείριση καναλιών και παλετών για εικόνες που υποστηρίζουν χρωματικές αποχρώσεις, 
κ.ά. Το Photoshop μας δίδει τη δυνατότητα να επιλέξουμε το χρωματικό μοντέλο, αλλά και να μπορούμε να 
ελέγχουμε την εμφάνιση των χρωμάτων σε κάποιο άλλο μοντέλο. Για παράδειγμα, μπορεί η εικόνα να επε-
ξεργάζεται στο RGB, αλλά, όταν πρόκειται να εκτυπωθεί, να γίνει έλεγχος στο CMYK για να εξακριβωθεί 
κατά πόσο τα χρώματα αποδίδονται σωστά. Οι δυνατότητες του Photoshop μπορούν να επεκταθούν με χρήση 
επιπροσθέτων προγραμμάτων (plug-ins), πολλά από τα οποία διατίθενται δωρεάν στο διαδίκτυο. Υπάρχουν 
επίσης και οι εκδόσεις Photoshop CSx Extended που παρέχουν ακόμη περισσότερες δυνατότητες σε σχέση με 
τις βασικές εκδόσεις. 

 

 
 

Εικόνα 2.41 Επεξεργασία εικόνας στο Adobe Photoshop. Η εικόνα αποτελείται από πολλαπλά επίπεδα, όπως φαίνεται στη 
δεξιά πλευρά της εικόνας. 

 
Όταν επεξεργαζόμαστε ένα έργο στο Photoshop, τo αποθηκεύουμε σε PSD μορφή, ώστε να διατη-

ρούνται όλες οι πληροφορίες ανά επίπεδο και να μπορεί να επεξεργαστεί στη συνέχεια. Όταν όμως το έργο 
ολοκληρωθεί, τότε εξάγουμε την εικόνα σε κάποια από τις υπόλοιπες μορφές αρχείων που αναφέρθηκαν, α-
νάλογα με την τελική της χρήση. 

Η τελευταία έκδοσή του αναφέρεται ως Photoshop CC (Creative Cloud) και ουσιαστικά είναι η έκδο-
ση που παρέχεται μέσα από την υπηρεσία σύννεφου της Adobe. Η τελευταία έκδοση του εργαλείου ως αυτό-
νομη εφαρμογή ήταν η Photoshop CS6. Όσοι ασχολούνται περιστασιακά ή ερασιτεχνικά με το Photoshop, 
μπορούν να επιτελέσουν τις περισσότερες λειτουργίες τους και με χρήση των παλαιότερων εκδόσεων CS4, 
CS5 και CS6. Υπάρχουν και εκδόσεις που εκτελούνται χωρίς εγκατάσταση στον υπολογιστή μας που αποτε-
λούν εκδόσεις Portable, π.χ. Adobe Photoshop CS6 Portable Edition. 
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Εικόνα 2.42 Εφαρμογή φίλτρων στο Photoshop. 

 
2.4.4.2. Επιπλέον εφαρμογές για επεξεργασία εικόνων από την Adobe 
 
Η Adobe έχει δημιουργήσει επιπλέον εργαλεία για διευκόλυνση των επαγγελματιών ή των ερασιτεχνών χρη-
στών. Η εφαρμογή Adobe Photoshop Elements (http://www.adobe.com/gr_en/products/photoshop-
elements.html) είναι μια περιορισμένη έκδοση της εφαρμογής Adobe Photoshop. Έχει παρόμοια λογική, αλλά 
η εμφάνισή της διαφέρει αισθητά. Προορίζεται κυρίως για μη επαγγελματίες και γι’ αυτό δεν υποστηρίζει 
δυνατότητες, όπως για παράδειγμα, τα χρωματικά μοντέλα CMYK και Lab και κάποια φίλτρα. Η εφαρμογή 
απλών αλλαγών στην εικόνα, όπως για παράδειγμα, η διόρθωση του προβλήματος των κόκκινων ματιών, εί-
ναι πιο εύκολη. 

Το πρόγραμμα Adobe Photoshop Express (http://www.photoshop.com/products/photoshopexpress)  
διατίθεται για διαδικτυακή επεξεργασία εικόνων και για επεξεργασία εικόνων σε κινητές συσκευές με 
Android ή τα iPhone και iPAD. Παρέχει βασικές δυνατότητες επεξεργασίας εικόνων, όπως περικοπή μη χρή-
σιμων περιοχών, περιστροφή, αλλαγή κάποιου χρώματος και εύκολη εφαρμογή φίλτρων. Παρέχει, επίσης, τη 
δυνατότητα οργάνωσης και διαχείρισης φωτογραφιών που έχουμε ανεβάσει στο διαδίκτυο. 

Η εφαρμογή Adobe Photoshop Lightroom (http://www.adobe.com/gr_en/products/photoshop-
lightroom.html) χρησιμοποιείται για τη διαχείριση εκατοντάδων, ακόμη και χιλιάδων, φωτογραφιών από ε-
παγγελματίες φωτογράφους. Πρόκειται για σύστημα διαχείρισης, εμφάνισης και επεξεργασίας ψηφιακών φω-
τογραφιών. 

Πολλές από τις εφαρμογές της Adobe διατίθενται και μέσα από την υπηρεσία σύννεφου (cloud 
service) που διαθέτει. Δηλαδή, πρακτικά οι φωτογραφίες αποθηκεύονται στο διαδίκτυο και μπορεί να επεξερ-
γαστούν και μέσω διαδικτυακών εργαλείων της Adobe, χωρίς την ανάγκη εγκατάστασης λογισμικού στον 
υπολογιστή μας. 

 
2.4.4.3. Corel Photo-PAINT 
 
To Corel Photo-PAINT (http://www.coreldraw.com/us/product/graphic-design-software/) είναι παρόμοιο σε 
λογική και δυνατότητες με το εργαλείο Adobe Photoshop. Όπως φαίνεται στην Εικόνα 2.43, το εργαλείο πα-
ρέχει αρκετές δυνατότητες, όπως η χωριστή επεξεργασία των καναλιών R, G, B και των επιπέδων της εικό-
νας, η εφαρμογή φίλτρων (effects), η χρήση διαφόρων χρωματικών μοντέλων, η διόρθωση εικόνων, η επε-
ξεργασία περιοχών της εικόνας και η υποστήριξη διαφορετικών μορφών αποθήκευσης. Η μορφή αποθήκευ-
σης των έργων του Photo-PAINT είναι η CPT (Corel Photo-PAINT image). Πρόκειται, γενικά, για ένα ισοδύ-
ναμο, σε δυνατότητες, εργαλείο με το Photoshop, αν και το Photoshop έχει μεγαλύτερη αποδοχή στους χρή-
στες. Το Photo-PAINT έχει σχετικά πιο απλό interface και είναι πιο οικονομικό στην αγορά του.  
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Εικόνα 2.43 Corel Photo PAINT, όπου διακρίνονται τα κανάλια R, G, B της εικόνας. 

 
2.4.4.4. Corel PaintShop Pro 
 
Η εφαρμογή Corel PaintShop Pro (Εικόνα 2.44) παρέχει ένα υποσύνολο των λειτουργιών της βασικής εφαρ-
μογής της εταιρίας. Όπως και το εργαλείο Adobe Photoshop Elements, το συγκεκριμένο λογισμικό προσφέρει 
με πιο εύκολο τρόπο, μέσα από την ύπαρξη απλών μενού, τη δυνατότητα διορθώσεων σε χαρτογραφικές ει-
κόνες. Για παράδειγμα, καλλιτεχνικά εφέ μπορούν να εφαρμοστούν σε μία εικόνα, μπορεί να γίνει συνδυα-
σμός (κολλάζ) πολλών εικόνων, κ.ά. Το εργαλείο υποστηρίζει όλες τις δημοφιλείς μορφές εικόνων και απο-
θηκεύει τα σύνθετα έργα στη μορφή PSPIMAGE. 

 
2.4.4.5. GIMP 
 
Το εργαλείο GIMP (GNU Image Manipulation Program - http://www.gimp.org/) (Εικόνα 2.45) είναι ένα ερ-
γαλείο που διατίθεται δωρεάν για όλα τα σημαντικότερα λειτουργικά συστήματα, όπως Windows, Linux και 
το λειτουργικό των υπολογιστών Macintosh.  

Το GIMP παρέχει πολλές από τις δυνατότητες των πιο πάνω εργαλείων (π.χ. στρώσεις, κανάλια, εφέ) 
και διαθέτει Ελληνικό μενού επιλογών. Επίσης, υποστηρίζει τη δημιουργία κινούμενων GIF (animated GIF), 
ενός, δηλαδή αρχείου GIF που περιέχει πολλές εικόνες που προβάλλονται διαδοχικά, δίνοντας την εντύπωση 
της κίνησης. Γενικότερα, υποστηρίζει όλες τις πιο γνωστές μορφές αρχείων και το βασικό του πλεονέκτημα 
είναι ότι παρέχεται δωρεάν. 

 
2.4.4.6. Διαδικτυακές εφαρμογές 
 
Στο διαδίκτυο υπάρχουν δωρεάν εφαρμογές για την επεξεργασία εικόνων. Κάποιες είναι πιο απλές και εύ-
χρηστες, όπως η http://www.photocat.com, και κάποιες, όπως η http://apps.pixlr.com/editor, προσφέρουν αρ-
κετά σύνθετες επιλογές, συγκρίσιμες με τις παραπάνω εφαρμογές (Εικόνα 2.46). Πολλές εφαρμογές προσφέ-
ρονται και ως applications (apps) για κινητές συσκευές. 
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Εικόνα 2.44 Corel PaintShop Pro. Στην αριστερή πλευρά εμφανίζονται οι επιλογές επεξεργασίας. 

 

 
[Πηγή: http://goo.gl/CtQS84]  

 
Εικόνα 2.45 Το εργαλείο επεξεργασίας εικόνων GIMP.  
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Εικόνα 2.46 Διαδικτυακή εφαρμογή επεξεργασίας εικόνων bitmap. 

 

2.4.5. Συνήθεις λειτουργίες επεξεργασίας εικόνων 
 
Οι εφαρμογές διαχείρισης εικόνων bitmap παρέχουν πολλές δυνατότητες επεξεργασίας των ψηφιογραφικών 
εικόνων. Η παρακάτω λίστα παρουσιάζει σύντομα τις συνηθέστερες ενέργειες που εφαρμόζονται στις εικό-
νες. 

 Μετατροπή σε άλλη μορφή: Πρόκειται για αποθήκευση σε διαφορετική μορφοποίηση από 
την αρχική. Στην περίπτωση αυτή πρέπει να ληφθούν υπόψη οι δυνατότητες και οι περιορι-
σμοί του νέου φορμά. Για παράδειγμα, αν μια εικόνα BMP αποθηκευτεί σε φορμά JPEG πρέ-
πει να καθοριστεί ο βαθμός συμπίεσης της εικόνας. Αν μια εικόνα PNG με διαφανές φόντο 
αποθηκευτεί ως JPEG, τότε θα χαθεί η διαφάνεια της εικόνας, καθώς το JPEG δεν υποστηρί-
ζει αυτήν τη μορφή. 

 
 Αλλαγή μεγέθους: Η αλλαγή μεγέθους εικόνων (image resize) είναι βασική δυνατότητα των 

επεξεργαστών εικόνων. Κατά την αλλαγή μεγέθους μπορεί να γίνει μείωση ή αύξηση οριζο-
ντίως ή καθέτως ή και προς τις δύο διαστάσεις των εικόνων. Η αλλαγή μεγέθους μπορεί να 
γίνει με ταυτόχρονη αλλαγή του συνολικού αριθμού εικονοστοιχείων της εικόνας των δια-
στάσεων που αλλάζουν. Η διαδικασία αυτή ονομάζεται resampling και γενικά διατηρεί την 
ανάλυση της εικόνας και την κανονική της εμφάνιση. 

 
 Περικοπή ή ξάκρισμα: Η περικοπή (cropping) μιας εικόνας αναφέρεται στη απομάκρυνση 

των εξωτερικών περιοχών μιας εικόνας, ώστε να μείνει μόνο το βασικό θέμα της εικόνας (Ει-
κόνα 2.47β). 

 
 Απομάκρυνση αντικειμένων στην εικόνα: Με χρήση εργαλείων, όπως το clone tool, μπορεί 

να επιτευχθεί η απομάκρυνση αντικειμένων στην εικόνα που δεν είναι σημαντικά. Για παρά-
δειγμα, στην Εικόνα 2.47γ έχουν διαγραφεί οι άνθρωποι από την αριστερή πλευρά της εικό-
νας και πλέον ο θεατής της εικόνας εστιάζει στο βασικό θέμα της. 

 
 Εφαρμογή φίλτρων: Στην Εικόνα 2.47δ έχει εφαρμοστεί ένα φίλτρο καλλιτεχνικής υφής που 

προσδίδει στην εικόνα την αίσθηση σκίτσου. Γενικά, τα εργαλεία επεξεργασίας εικόνων πα-
ρέχουν πολλά φίλτρα για διαμόρφωση των εικόνων.   

 
 Επιλεκτική αλλαγή χρώματος και διόρθωση χρωμάτων: Μέσω των καναλιών της εικόνας 

μπορεί να γίνει αλλαγή μόνο συγκεκριμένων χρωμάτων της εικόνας (π.χ. Εικόνα 2.47ε). 
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 Αλλαγή ανάλυσης, βάθους χρώματος και χρωματικού μοντέλου: Τα επαγγελματικά εργα-

λεία επεξεργασίας εικόνων επιτρέπουν την τροποποίηση των βασικών χαρακτηριστικών μιας 
εικόνας, όπως είναι η ανάλυση, το βάθος χρώματος και το χρωματικό μοντέλο.  

 

 
[Πηγή αρχικής εικόνας: http://goo.gl/a8hXNC]  
 
Εικόνα 2.47 (α) Αρχική εικόνα. (β) Ξάκρισμα εικόνας. (γ) Αφαίρεση αντικειμένων. (δ) Εφαρμογή φίλτρου. (ε) Αλλαγή του 
χρώματος του ουρανού. (ζ) Οριζόντια αναστροφή. 

 
 Περιστροφή ή αλλαγή προσανατολισμού εικόνας: Με χρήση των δυνατοτήτων των εργα-

λείων, μπορεί να γίνει περιστροφή της εικόνας οριζόντια (Εικόνα 2.47ζ) ή κάθετη αναστροφή 
των εικόνων, ώστε να μπορούν να χρησιμοποιηθούν σε πιο σύνθετες δημιουργίες. 

 
 Επεξεργασία εικόνων σε επίπεδα: Τα σύνθετα έργα (π.χ. εξώφυλλα βιβλίων, αφίσες, κλπ) 

δημιουργούνται σε πολλά επίπεδα. Σε κάθε επίπεδο τοποθετείται ένα μέρος της εικόνας, όπως 
το φόντο, κείμενο, σχήματα και η τελική εικόνα δημιουργείται από το συνδυασμό των υπο-
λοίπων. Σε κάθε επίπεδο μπορεί να εφαρμοστούν φίλτρα ή οποιαδήποτε από τις παραπάνω 
λειτουργίες και το κάθε στρώμα μπορεί να επεξεργαστεί χωριστά, σε οποιαδήποτε φάση της 
δημιουργίας της εικόνας. 
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 Συνδυασμός πολλών εικόνων: Ο συνδυασμός πολλών εικόνων γίνεται ακόμη και στα πιο 
απλά προγράμματα επεξεργασίας εικόνων. Ο συνδυασμός μέσω διαφορετικών επιπέδων δίδει 
πλήρη ελευθερία στο σχεδιαστή. 

 
 Εκτύπωση εικόνων: Μέσα από τις εφαρμογές επεξεργασίας εικόνων υπάρχει η δυνατότητα 

καθορισμού του μεγέθους και της ποιότητας εκτύπωσης και είναι εφικτή η στοίχιση των ει-
κόνων σε σχέση με την περιοχή εκτύπωσης. Επίσης, υποστηρίζεται η πρόσθεση λεζάντας, 
πλαισίου, αλλά και άλλων εφέ εκτύπωσης. 

 

2.5. Διανυσματικά γραφικά 
 
Αντίθετα με τα ψηφιογραφικά γραφικά που δημιουργούνται από την παράθεση εικονοστοιχείων, τα διανυ-
σματικά γραφικά (vector graphics) αποτελούνται από ένα σύνολο σχημάτων, τα οποία περιγράφονται με μα-
θηματικό τρόπο. Τα σχήματα αυτά μπορεί να είναι απλά (π.χ. κύκλοι ή τετράγωνα) ή σύνθετες καμπύλες 
γραμμές, με διάφορα χρώματα και σκιές τα οποία καταλήγουν σε εξαιρετικές συνθέσεις (Εικόνα 2.48). Επι-
πλέον, είναι δυνατή η ύπαρξη κειμένου διαφόρων μορφών και κατευθύνσεων. 

 

 
 
Εικόνα 2.48 Απλά και σύνθετα διανυσματικά γραφικά. 

 
Η δημιουργία των διανυσματικών γραφικών βασίζεται στον καθορισμό των γεωμετρικών ιδιοτήτων 

τους. Για παράδειγμα, όταν δημιουργούμε έναν κύκλο ως διανυσματική εικόνα, το πρόγραμμα σχεδιάζει τον 
κύκλο χρησιμοποιώντας τις συντεταγμένες του κέντρου του (x, y) και την ακτίνα του R και δεν τον αντιμετω-
πίζει ως μια αλληλουχία από εικονοστοιχεία. Όλα τα σχήματα απεικονίζονται με γεωμετρικό τρόπο, με τη 
βοήθεια γραμμών, ορθογωνίων, ελλείψεων ή τόξων. Το λογισμικό επεξεργασίας διανυσματικών γραφικών, 
π.χ. CorelDraw, υποστηρίζει τη δημιουργία και επεξεργασία σύνθετων σχημάτων μέσω του καθορισμού των 
ιδιοτήτων τους (Εικόνα 2.49). Τελικά, τα σύνθετα σχήματα δημιουργούνται μέσα από απλά σχήματα. 

Στην Εικόνα 2.50 απεικονίζεται το τελικό σχήμα και τα επιμέρους σχήματα που το αποτελούν. Στην 
Εικόνα 2.51 φαίνονται ξεκάθαρα τα βήματα για τη δημιουργία ενός τοπίου, έχοντας ως αρχικά σχέδια δύο 
ορθογώνια παραλληλόγραμμα με διαβάθμιση χρώματος. 

Σε κάποιες περιπτώσεις το διανυσματικό γραφικό δημιουργείται ιχνογραφώντας (tracing) εικόνες 
bitmap. Ο σκοπός αυτής της τεχνικής είναι η αναπαραγωγή των βασικών καμπυλών και γραμμών του αρχικού 
σχήματος σε διανυσματική μορφή. Το σχέδιο που δημιουργείται μπορεί έπειτα να επεξεργαστεί περαιτέρω. 

 

2.5.1. Ομοιότητες και διαφορές διανυσματικών και ψηφιογραφικών γραφικών 
 
Τα διανυσματικά γραφικά, αν και δημιουργούνται με διαφορετικό τρόπο, έχουν κάποια κοινά στοιχεία με τις 
εικόνες bitmap. Η ανάλυση, το βάθος χρώματος και το χρωματικό μοντέλο είναι παράμετροι που αφορούν και 
σε αυτή την περίπτωση. Συνήθως η ανάλυση είναι υψηλή, δηλαδή 300 ppi και το βάθος χρώματος τουλάχι-
στον 24 bit. Το χρωματικό μοντέλο μπορεί να είναι οποιοδήποτε από αυτά που αναφέρθηκαν νωρίτερα. Επί-
σης, θέματα όπως το δεικτοδοτούμενο χρώμα, η περικοπή και η περιστροφή των σχημάτων, αλλά και άλλα 
ζητήματα που θίξαμε νωρίτερα στα γραφικά bitmap, εφαρμόζονται και στα διανυσματικά γραφικά. 
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Υπάρχουν όμως και κάποιες βασικές διαφορές μεταξύ των δύο κατηγοριών γραφικών. Στις ασυμπίε-
στες χαρτογραφικές εικόνες το μέγεθος είναι ανάλογο των διαστάσεων, της ανάλυσης και του βάθους χρώμα-
τος των εικόνων. Στα vector graphics το μέγεθος είναι πολύ μικρότερο, αφού ουσιαστικά πρέπει να αποθη-
κευτούν πληροφορίες ανά σχήμα και όχι για κάθε pixel. Για παράδειγμα, σε διανυσματική εικόνα, για έναν 
κύκλο απαιτείται η καταγραφή πληροφοριών όπως το κέντρο του, η ακτίνα του, το χρώμα γεμίσματος, το 
χρώμα περιγράμματος και κάποιες λιγοστές επιπλέον πληροφορίες. Στην περίπτωση ύπαρξης κύκλου σε χαρ-
τογραφική εικόνα πρέπει να αποθηκευτεί το χρώμα για κάθε εικονοστοιχείο της περιφέρειας και του εσωτερι-
κού του κύκλου, που σημαίνει πολύ μεγαλύτερο μέγεθος. Για να γίνει πιο κατανοητή αυτή η διαφορά, εικόνα 
BMP 300 ppi και 24 bit βάθος χρώματος που απεικονίζει τα 4 μέσα μεταφοράς που εμφανίζονται στην Εικό-
να 36, καταλαμβάνει χώρο 9,40 ΜΒ. Η ίδια εικόνα, αποθηκευμένη σε διανυσματική μορφή, καταλαμβάνει 
μόνο 229 KB (0.223 MB). 

Τα διανυσματικά γραφικά παρουσιάζουν δυναμικότητα στην επεξεργασία των μεμονωμένων αντικει-
μένων που τα συνθέτουν, ενώ τα bitmap γραφικά αποτελούν ένα ενιαίο αντικείμενο και δεν επιτρέπουν τον 
άμεσο διαχωρισμό των τμημάτων τους, ούτε και την ανεξάρτητη επεξεργασία του κάθε αντικειμένου. Επι-
πλέον, στην περίπτωση των διανυσματικών σχημάτων υπάρχει δυνατότητα μεγέθυνσης, σμίκρυνσης και πε-
ριστροφής των σχημάτων, χωρίς να προκαλούνται αλλοιώσεις. 

 

 
 
Εικόνα 2.49 Σχεδίαση γραφικών στο CorelDraw. Διακρίνονται οι γεωμετρικές παράμετροι του επιλεγμένου σχήματος. 

 
Το βασικό πλεονέκτημα των γραφικών bitmap είναι ότι μπορούν να δημιουργηθούν και να απεικονι-

σθούν σε πάρα πολλές εφαρμογές, π.χ. επεξεργαστές κειμένου, λογιστικά φύλλα, αντίθετα από τα διανυσμα-
τικά γραφικά που δημιουργούνται από εξειδικευμένο λογισμικό και δεν μπορούν να ενσωματωθούν σε πολ-
λές εφαρμογές. 

Τα γραφικά bitmap απεικονίζουν κυρίως φωτογραφίες που έχουν εισαχθεί στον υπολογιστή είτε μέσω 
φωτογραφικών μηχανών είτε μέσω σαρωτών, ενώ τα διανυσματικά γραφικά δημιουργούνται κατά κύριο λόγο 
απευθείας στον υπολογιστή. Και στην περίπτωση των διανυσματικών γραφικών, όμως, το τελικό παραγόμενο 
αρχείο είναι συνήθως σε μορφή JPEG ή κάποια αντίστοιχη. Δηλαδή, γίνεται η επεξεργασία στην αντίστοιχη 
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εφαρμογή και αποθηκεύεται στη μορφή διανυσματικών γραφικών που υποστηρίζει το εργαλείο επεξεργασίας. 
Έπειτα, για να είναι εφικτή η χρήση του έργου σε διάφορες περιπτώσεις (π.χ. διαδίκτυο και επεξεργαστές 
κειμένου) γίνεται εξαγωγή και σε κάποια μορφή ψηφιογραφικών εικόνων. 
 

 
 
Εικόνα 2.50 Σύνθετο σχήμα και τα επιμέρους σχήματα που το αποτελούν. 

 

 
 
Εικόνα 2.51 Διαδοχικοί μετασχηματισμοί για τη δημιουργία ενός σχεδίου. 

 

2.5.2. Τεχνική Anti-aliasing 
 
Anti-aliasing είναι η τεχνική εξομάλυνσης γραμμών, ώστε να εμφανίζονται ομαλές και χωρίς απότομες δια-
βαθμίσεις. Όταν μια καμπύλη ή διαγώνια γραμμή δεν μπορεί να προσαρμοσθεί και να αποδοθεί με ακρίβεια 
σε ένα ορθογώνιο πλέγμα στοιχείων, τότε εμφανίζεται με ελαφρά ζιγκ-ζαγκ (Εικόνα 2.52).  

Αυτό το φαινόμενο ονομάζεται aliasing. Με την τεχνική Anti-aliasing συμπληρώνονται με επιπλέον 
εικονοστοιχεία, τα εσωτερικά και εξωτερικά σημεία των γραμμών, ώστε να μην εμφανίζονται τα ζιγκ-ζαγκ 
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(Εικόνα 40β). Τα εικονοστοιχεία που συμπληρώνονται έχουν πιο απαλές αποχρώσεις σε σχέση με το βασικό 
χρώμα της γραμμής. Για παράδειγμα, αν η γραμμή είναι μαύρη προστίθενται γκρι εικονοστοιχεία. 

 

 
 
Εικόνα 2.52 (α) Εικόνα χωρίς την τεχνική anti-aliasing. (β) Εικόνα που έχει εφαρμοστεί η τεχνική anti-aliasing. 

 

2.5.3. OpenGL και DirectX  
 
Το OpenGL (Open Graphics Library) είναι μια βιβλιοθήκη προγραμμάτων για τη δημιουργία γραφικών 2-
διαστάσεων και 3-διαστάσεων σε διαφορετικά λειτουργικά συστήματα. Η αρχική του έκδοση δημιουργήθηκε 
από τη Silicon Graphics το 1992 και πλέον αναπτύσσεται από ένα σύνολο εταιρειών που έχουν δημιουργήσει 
τον μη κερδοσκοπικό οργανισμό Khronos Group. Είναι μια δωρεάν τεχνολογία που επιτρέπει τη δημιουργία 
σύνθετων σκηνών 2 ή τριών διαστάσεων, από ένα σύνολο στοιχειωδών σχημάτων. Για παράδειγμα, η κλήση 
της συνάρτησης “glColor3f( 0, 1, 0 )” θέτει το τρέχον χρώμα σχεδίασης σε πράσινο και η κλήση της συνάρ-
τησης “glVertex3f( -1, -1, 0 )” σχεδιάζει μια γωνία. 

Εκτός από το αρχικό πρότυπο OpenGL, πλέον έχουν δημιουργηθεί τα πρότυπα OpenGL ES, κατάλ-
ληλα για κινητά τηλέφωνα ή άλλες έξυπνες συσκευές που είναι ενσωματωμένες σε οικιακές συσκευές, συ-
σκευές για παιχνίδια και οχήματα. Επίσης, το OpenVG είναι μια βιβλιοθήκη συναρτήσεων για την επιτάχυν-
ση του υλικού στην περίπτωση προβολής γραφικών SVG ή γραφικών μέσω του εργαλείου Adobe Flash.  

Η τεχνολογία DirectX αναπτύχθηκε από τη Microsoft για τη διαχείριση εργασιών σχετικά με την επε-
ξεργασία και προβολή εικόνων, γραφικών, αλλά και ήχου και βίντεο. Αφορά τα λειτουργικά συστήματα 
Windows, αλλά και τις παιχνιδομηχανές της Microsoft. Αποτελείται από επιμέρους προγραμματιστικά εργα-
λεία, π.χ. DirectDraw για διανυσματικά γραφικά, DirectSound για ήχο και Direct3D για γραφικά τριών δια-
στάσεων. Οι συναρτήσεις που παρέχει το προγραμματιστικό περιβάλλον DirectX χρησιμοποιούνται για την 
ανάπτυξη παιχνιδιών, αλλά και για λειτουργίες οπτικοποίησης και σχεδίασης σε εργαλεία μηχανικών σχεδί-
ων. 

 

2.5.4. Μορφές αρχείων διανυσματικών γραφικών 
 
Τα περισσότερα εργαλεία επεξεργασίας διανυσματικών γραφικών έχουν τις δικές μορφές αποθήκευσης των 
έργων τους. Φυσικά, όλα μπορούν να εισάγουν αρχεία που έχουν δημιουργηθεί με χρήση άλλων εφαρμογών 
επεξεργασίας διανυσματικών γραφικών και να αποθηκεύσουν το τελικό σχήμα σε οποιαδήποτε μορφοποίηση 
ψηφιογραφικών γραφικών. Τα πιο γνωστά φορμά για διανυσματικά σχήματα είναι τα SVG, WMF, CDR, EPS 
και AI. 

 
2.5.4.1. SVG 
 
Το πρότυπο SVG (Scalable Vector Graphics) αποθηκεύει πληροφορίες για δισδιάστατα διανυσματικά γραφι-
κά σε μορφή XML (eXtensible Markup Language). Τα αρχεία έχουν επέκταση .svg ή .svgz. Τα γραφικά που 
αποθηκεύονται σε αυτή τη μορφή, ουσιαστικά αποθηκεύονται ως αρχείο κειμένου κωδικοποιημένα σε XML 
(Εικόνα 2.53).  

Όταν το αρχείο προβάλλεται σε κάποια εφαρμογή επεξεργασίας διανυσματικών γραφικών, τότε εμ-
φανίζονται τα σχήματα που περιγράφει το αρχείο SVG. Οι περισσότεροι φυλλομετρητές ιστοσελίδων (Web 
browsers), όπως ο Google Chrome, υποστηρίζουν τον τύπο αρχείων SVG και προβάλλουν άμεσα τα αποτελέ-
σματα. Τα απλά αρχεία SVG μπορούν να δημιουργηθούν ακόμη και με επεξεργαστές κειμένου, αν φυσικά 
γνωρίζουμε τη σύνταξη της XML τους. Επίσης, μπορεί να γίνει αναζήτηση στα περιεχόμενά τους και να συ-
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μπιεστούν με κάποιο γενικό εργαλείο συμπίεσης. Τα αρχεία .svgz υποστηρίζουν εγγενώς τη δυνατότητα συ-
μπίεσης. 

 
<?xml version="1.0" standalone="no"?> 
<!DOCTYPE svg PUBLIC "-//W3C//DTD SVG 1.1//EN"  
"http://www.w3.org/Graphics/SVG/1.1/DTD/svg11.dtd"> 
 
<svg height="150" width="400"> 
  <defs> 
    <linearGradient id="grad1" x1="0%" y1="0%" x2="100%" y2="0%"> 
      <stop offset="0%" style="stop-color:rgb(255,255,0);stop-opacity:1" /> 
      <stop offset="100%" style="stop-color:rgb(255,0,0);stop-opacity:1" /> 
    </linearGradient> 
  </defs> 
  <ellipse cx="200" cy="70" rx="85" ry="55" fill="url(#grad1)" /> 
  <text fill="#ffffff" font-size="45" font-family="Verdana" x="150" 
y="86">SVG</text> 
  Sorry, your browser does not support inline SVG. 
</svg> 
</body> 
</html> 

 

 
Εικόνα 2.53 Αρχείο SVG που περιγράφει σε XML μορφή το γραφικό. Δίπλα εμφανίζεται το αποτέλεσμα.   

 
2.5.4.2. WMF 
 
Τα αρχεία WMF (Windows Metafile) είναι διανυσματικές εικόνες που υποστηρίζονται από τα Windows. Ένα 
αρχείο WMF αποτελείται από κλήσεις προς τις συναρτήσεις επεξεργασίας γραφικών Graphics Device 
Interface (GDI) των Windows. Όταν ένα αρχείο WMF πρόκειται να παρουσιαστεί (συνήθως με κλήση της 
συνάρτησης PlayMetaFile( ) των Windows), το διανυσματικό γραφικό σχεδιάζεται ως αποτέλεσμα της κλή-
σης των συναρτήσεων. Τα αρχεία WMF εξαρτώνται άμεσα από το λειτουργικό σύστημα και έχουν και κά-
ποια προβλήματα ασφάλειας, καθώς περιέχουν κλήσεις σε κώδικα των Windows. 

Στις νέες εκδόσεις των Windows το φορμά εξελίχθηκε και παρουσιάστηκαν οι εκδόσεις του 
Enhanced Metafile (EMF), Enhanced Metafile Format Plus Extensions (EMF+), Compressed Windows 
Metafile (WMZ) και Compressed Windows Enhanced Metafile (EMZ). Τα αρχεία που εμπίπτουν σε αυτές τις 
κατηγορίες έχουν επέκταση .wmf, .emf, .wmz ή .emz. 

 
2.5.4.3. CDR 
 
Η μορφή CDR αποτελεί τη μορφή αποθήκευσης του εργαλείου CorelDraw. Οι διανυσματικές εικόνες CDR 
αποτελούνται από ένα σύνολο γεωμετρικών σχημάτων μαζί με τα επιπλέον χαρακτηριστικά τους, όπως χρώ-
μα, σκιά, κ.α. Ο συγκεκριμένος τύπος δημιουργείται μόνο από το CorelDraw, αλλά μπορεί να εισαχθεί σε 
άλλα πακέτα γραφικών, όπως το Adobe Illustrator. Τα αρχεία του CorelDraw μπορεί να έχουν μία από τις 
επεκτάσεις .cdr, .cdx, .cdt, ή .cmx ανάλογα με τα επιπλέον χαρακτηριστικά τους. Τα cdr είναι τα βασικά αρ-
χεία, τα cdx (CorelDRAW Compressed File) είναι συμπιεσμένα, τα cdt (ConceptDraw PRO Template) αποτε-
λούν πρότυπα για γρήγορη δημιουργία άλλων γραφικών και τα cmx (Corel Metafile Exchange Image File) 
περιέχουν πληροφορίες για ανταλλαγή δεδομένων με άλλες εφαρμογές. 

 
2.5.4.4. EPS 
 
Τα αρχεία EPS (Encapsulated PostScript) χρησιμοποιούνται για να περιγράψουν γραφικά ή εικόνες. Οι βασι-
κές επεκτάσεις που συναντάμε για τη μορφοποίηση είναι .epi, .eps, .eps2, .eps3, .epsf και .epsi. Ουσιαστικά 
είναι αρχεία κειμένου (Εικόνα 2.54), που μπορεί να περιέχουν και δυαδικό κώδικα, για την περιγραφή των 
σχημάτων. 
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… 
%%BeginProlog 
/inch {72 mul} def 
%%EndProlog 
/Times-Roman findfont 
1.00 inch scalefont 
setfont 
%%Page:      1     1     
 … 
newpath 
   276   651    10 0 360 arc closepath fill 
newpath 
   344   647    10 0 360 arc closepath fill 
newpath 
   536   589    10 0 360 arc closepath fill 
 … 
140 151 lineto stroke 
 …  

 
Εικόνα 2.54 Τμήμα αρχείου EPS και δίπλα εμφανίζεται το αποτέλεσμα. 

 
2.5.4.5. ΑΙ 
 
Τα αρχεία ΑΙ (Adobe Illustrator Artwork) είναι η μορφή αποθήκευσης του εργαλείου Adobe Illustrator. Αρχι-
κά, τα αρχεία ΑΙ ήταν στην πράξη τα αρχεία EPS, αλλά πλέον περιέχουν επιπρόσθετα χαρακτηριστικά για την 
αναπαράσταση των διανυσμάτων της εικόνας. 

 

2.5.5. Λογισμικό επεξεργασίας 
 
Το λογισμικό (software) επεξεργασίας διανυσματικών εικόνων δύο διαστάσεων επιτρέπει τη δημιουργία σύν-
θετων σχημάτων. Τα σχήματα αποτελούνται από απλά γεωμετρικά σχήματα και καμπύλες (π.χ. Bezier). Στα 
επιμέρους σχήματα που αποτελούν το σύνθετο γραφικό έχουν γίνει διάφοροι μετασχηματισμοί (π.χ. περι-
στροφή) και έχει εφαρμοστεί σκίαση και διάφορα άλλα οπτικά εφέ. Στη συνέχεια, παρουσιάζονται τα πιο 
γνωστά εργαλεία επεξεργασίας διανυσματικών γραφικών. 

 

2.5.5.1. CorelDraw 
 
Η εφαρμογή CorelDraw (Εικόνα 2.49 πιο πάνω) βρίσκεται ήδη στην έκδοση 17, η οποία ονομάζεται X7 και 
περιλαμβάνεται στην ομάδα εργαλείων επεξεργασίας εικόνας CorelDraw Graphics Suite Χ7. Η σουίτα εργα-
λείων περιέχει και άλλα εργαλεία, όπως το εργαλείο γραφικών bitmap Corel Photo-PAINT. Η ομάδα έχει δη-
μιουργηθεί για περιβάλλον Windows, αν και υπήρξαν εκδόσεις και για άλλα λειτουργικά συστήματα. Παρέχει 
δυνατότητες όπως ταίριασμα κειμένου σε κάποιο σχήμα, σύνθετες και βαθμωτές σκιάσεις, εφαρμογή οπτικών 
εφέ, προβολή του σχήματος από διάφορες όψεις. Συνεργάζεται άμεσα με το λογισμικό Corel Photo-PAINT. 

 
2.5.5.2. Adobe Illustrator 
 
Το Adobe Illustrator είναι λογισμικό της Adobe για δημιουργία διανυσματικών γραφικών (Εικόνα 2.55). 
Πλέον ονομάζεται Adobe Illustrator CS5 που αντιστοιχεί στην 15η κατά σειρά έκδοση της εφαρμογής. Έχει 
παρόμοια εμφάνιση με την εφαρμογή του Photoshop της ίδιας εταιρείας και είναι διαθέσιμο για τα λειτουργι-
κά συστήματα Windows και Mac OS (για υπολογιστές Macintosh). Η νέα έκδοση έχει και κάποιες δυνατότη-
τες για τρισδιάστατα γραφικά. 
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Εικόνα 2.55 Adobe Illustrator. 

 

2.5.5.3. Inkscape 
 
Το δωρεάν εργαλείο Inkscape (https://inkscape.org/en/) είναι λογισμικό ανοιχτού κώδικα, με αρκετές δυνατό-
τητες που το καθιστούν ανταγωνιστικό σε σχέση με τα αντίστοιχα εργαλεία που αναφέρθηκαν πιο πάνω. Α-
ποθηκεύει τα σχήματα στη μορφή SVG (Scalable Vector Graphics) και είναι διαθέσιμο για τα λειτουργικά 
συστήματα Windows, Mac OS και τις διάφορες παραλλαγές του Unix. Όπως φαίνεται και στην Εικόνα 2.56, 
έχει αρκετές δυνατότητες και το βασικό του πλεονέκτημα είναι ότι παρέχεται δωρεάν. 
 

 
[Πηγή: https://goo.gl/Zmw4Vo]  
 
Εικόνα 2.56 Το Inkscape είναι εργαλείο σχεδίασης διανυσματικών γραφικών ανοιχτού κώδικα.  
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 Οι σαρωτές χειρός (handheld) χρησιμοποιούν την ίδια τεχνολογία με τους επίπεδους σαρω-

τές, αλλά είναι μικρότεροι σε μέγεθος και είτε πρέπει να τους κινήσει ο χρήστης πάνω στην 
επιφάνεια που θα σαρωθεί είτε γίνεται εισαγωγή ενός φύλλου χαρτιού σε αυτούς.  

 
 Οι σαρωτές τυμπάνου (drum) χρησιμοποιούνται στην έκδοση εντύπων για την ψηφιοποίηση 

εικόνων εξαιρετικής ποιότητας. Πρόκειται για ογκώδη, συνήθως, μηχανήματα με υψηλή 
ποιότητα σάρωσης.  

 
 Τέλος, υπάρχουν και οι σαρωτές βιβλίων (book scanners) που λειτουργούν με χρήση μιας 

φωτογραφικής κάμερας και πηγές φωτός που κατευθύνονται προς το βιβλίο. Η κατασκευή 
τους επιτρέπει στο χρήστη να γυρίζει τις σελίδες εύκολα και γρήγορα και έτσι η διαδικασία 
είναι αρκετά γρήγορη. Είναι ακριβές συσκευές και χρησιμοποιούνται σε έργα ψηφιοποίησης 
και διατήρησης σημαντικών βιβλίων. 

 

2.6. Υλικό για ψηφιοποίηση εικόνων 
 
Στις προηγούμενες ενότητες παρουσιάστηκαν θεωρητικά και πρακτικά θέματα που σχετίζονται με την ψηφιο-
ποίηση και την αναπαράσταση των πληροφοριών εικόνας και την περαιτέρω επεξεργασία τους. Στην παρού-
σα και τις επόμενες ενότητες θα παρουσιαστεί το βασικό υλικό (hardware) που απαιτείται για την ψηφιοποίη-
ση, επεξεργασία, προβολή και εκτύπωση των εικόνων. Οι βασικές συσκευές που εμπλέκονται σε αυτά τα 
στάδια είναι ο σαρωτής, η φωτογραφική μηχανή, η κάρτα γραφικών, η οθόνη και ο εκτυπωτής. Η ψηφιοποίη-
ση εικόνων επιτυγχάνεται είτε μέσω σαρωτών είτε με χρήση ψηφιακών φωτογραφικών μηχανών. 
 

2.6.1. Σαρωτής 
 
Οι σαρωτές (scanners) συνοδεύουν όλα τα σύγχρονα υπολογιστικά συστήματα είτε ως αυτόνομα μηχανήματα 
είτε ως μέρος ενός πολυμηχανήματος σάρωσης και εκτύπωσης. Χρησιμοποιούνται πολύ συχνά για την ψηφι-
οποίηση εικόνων και κειμένων.  

Υπάρχουν αρκετά είδη σαρωτών ανάλογα με τον τρόπο λειτουργίας και χρήσης τους (Εικόνα 2.56).  
 Οι επίπεδοι σαρωτές (flatbed) αποτελούν την πιο κοινή κατηγορία. Χρησιμοποιούνται για 

σάρωση πρωτοτύπων που είναι μη διαπερατά από το φως (π.χ. φωτογραφίες που έχουν ήδη 
εμφανισθεί). Οι σαρωτές τροφοδοσίας φύλλου (sheet-fed) είναι παρόμοιοι με τους επίπεδους 
σαρωτές με τη διαφορά ότι κινείται το έγγραφο και όχι η κεφαλή σάρωσης. Μοιάζει με έναν 
μικρό εκτυπωτή και συνήθως είναι ενσωματωμένοι στα πολυμηχανήματα.  

 
2.6.1.1. Τρόπος λειτουργίας 
 
Η διαδικασία ψηφιοποίησης ενός κειμένου ή εικόνας σε ηλεκτρονική μορφή αρχίζει με την τοποθέτηση του 
εγγράφου στη γυάλινη επιφάνεια του σαρωτή. Η εσωτερική λάμπα του σαρωτή φωτίζει το έγγραφο. Η κεφα-
λή ανάγνωσης ή σάρωσης κινείται αργά κατά μήκος του εγγράφου. Η κίνηση γίνεται με τη βοήθεια μιας ζώ-
νης και ενός μηχανισμού σταθεροποίησης για να μην υπάρξει απόκλιση από την πορεία σάρωσης. Οι  αντα-
νακλάσεις του εγγράφου εξαιτίας του φωτός που προσπίπτει σε αυτό, συλλαμβάνονται από έναν ή περισσό-
τερους γωνιακούς καθρέφτες και το φως οδηγείται σε μια συσκευή σύζευξης φορτίου (CCD – Charge 
Coupled Device). Η συσκευή αποτελείται από ένα σύνολο μικρών φωτοευαίσθητων πυκνωτών, που μετατρέ-
πει τα φωτόνια (σωματίδια φωτός) σε ηλεκτρόνια (ηλεκτρικό ρεύμα), που αντιπροσωπεύουν τις ακολουθίες 
δυαδικών ψηφίων. 

Οι παλαιότεροι σαρωτές ολοκληρώνουν τη διαδικασία με τρία περάσματα της εικόνας. Σε κάθε πέ-
ρασμα χρησιμοποιείται διαφορετικό φίλτρο χρώματος (Red, Green, Blue) μεταξύ του φακού και της διάταξης 
CCD. Μετά την τριπλή σάρωση το λογισμικό δημιουργεί από τις τρεις εικόνες μια έγχρωμη πλήρους χρώμα-
τος εικόνας. Οι σύγχρονοι σαρωτές επιτελούν τη λειτουργία με ένα μόνο πέρασμα. Ο φακός διασπά την εικό-
να σε τρία μικρότερα αντίτυπα της αρχικής. Κάθε αντίτυπο περνά από ένα φίλτρο χρώματος (Red, Green, 
Blue) και οδηγείται σε διαφορετικό τμήμα του πίνακα των CCD. Κατόπιν, γίνεται η σύνθεση σε μια ολοκλη-
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ρωμένη έγχρωμη εικόνα. Η εικόνα κωδικοποιείται στο χρωματικό μοντέλο RGB και συνήθως αποθηκεύεται 
στη μορφή BMP ή TIFF. 

 

 
 
Εικόνα 2.57 Διάφοροι τύποι σαρωτών. 

 
Υπάρχουν κάποιοι σαρωτές που με την τεχνολογία CIS (Contact Image Sensor), αντί της τεχνολογίας 

CCD. Φως από τρεις διόδους, που αντιστοιχούν στις τρεις συνιστώσες κόκκινο, πράσινο και μπλε του φωτός, 
προσπίπτει πάνω στο χαρτί και ανακλάται προς έναν φακό. Ο αισθητήρας CIS συγκεντρώνει έπειτα το φως 
από κάθε δίοδο και μετατρέπει το αρχικό φως σε ηλεκτρικό σήμα. Επειδή ο αισθητήρας, οι φακοί και οι δίο-
δοι ανήκουν στο ίδιο κύκλωμα, οι σαρωτές αυτής της κατηγορίας είναι πιο μικροί και απαιτούν λιγότερη ε-
νέργεια. Η ποιότητα σάρωσης είναι παρόμοια και στις δύο περιπτώσεις με τους σαρωτές CCD να υπερτερούν 
κάπως των CIS, σύμφωνα με πρόσφατες εργαστηριακές δοκιμές. 
 
2.6.1.2. Βασικά χαρακτηριστικά 
 

 Βάθος χρώματος: Όλοι οι σαρωτές υποστηρίζουν βάθος χρώματος τουλάχιστον true color, 
δηλαδή 24 bit, αποδίδοντας έτσι περίπου 16,8 (224=16.777.216) εκατομμύρια χρώματα. Συνε-
πώς, μπορούν να αποδώσουν με ευκρίνεια έγχρωμες εικόνες. Κάποιοι σαρωτές υποστηρίζουν 
μεγαλύτερο βάθος χρώματος, π.χ. 30 bit, 36 bit ή 48 bit. 

 
 Ανάλυση και παρεμβολή: Η ανάλυση των σαρωτών ορίζεται σε ppi (pixels per inch) και α-

ναφέρεται στον αριθμό των φωτοευαίσθητων αισθητήρων της διάταξης CCD ανά διάσταση. 
Οι περισσότεροι σαρωτές έχουν πραγματική ανάλυση (ή οπτική ανάλυση) 300x300 ppi με 
βάση τους αισθητήρες τους, αν και υπάρχουν και πιο ακριβά μοντέλα με μεγαλύτερη πραγ-
ματική ανάλυση. Παρόλα αυτά, πολλοί σαρωτές επιτυγχάνουν υψηλότερες αναλύσεις που 
μπορεί να φτάσουν και 4800x4800 ppi με χρήση τεχνικών λογισμικού. Η τεχνική αυτή ονο-
μάζεται παρεμβολή (interpolation) και αναφέρεται στην πρόσθεση επιπλέον εικονοστοιχείων 
μεταξύ αυτών που καταγράφουν οι αισθητήρες του σαρωτή. Τα νέα εικονοστοιχεία έχουν 
απόχρωση ίση με το μέσο όρο των τιμών των γειτονικών του pixel. Έτσι, αν η ανάλυση ορι-
ζοντίως είναι 300 ppi, τότε προσθέτοντας ένα εικονοστοιχείο ανά σαρωμένο εικονοστοιχείο, 
επιτυγχάνουμε διπλασιασμό της ανάλυσης. Θα πρέπει να σημειώσουμε εδώ ότι πολλές φορές 
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η ανάλυση αναφέρεται σε dpi (dots per inch), όπως και στους εκτυπωτές. Πρακτικά αυτό εί-
ναι λανθασμένο, καθώς πρόκειται για διαφορετική μονάδα, αλλά είναι συχνό λάθος. 

 
 Μέγεθος επιφάνειας σάρωσης: Οι περισσότεροι οικιακοί σαρωτές έχουν περιοχή σάρωσης 

A4 (21,6 x 27,9 cm). Υπάρχουν διαθέσιμοι και σαρωτές με επιφάνεια σάρωσης Α3 (29,7cm x 
43,2 cm). 

 
 Δυναμικό πεδίο (dynamic range): Το δυναμικό πεδίο ενός σαρωτή είναι ο λόγος του υψηλό-

τερου (πιο φωτεινού) σήματος προς το χαμηλότερο (πιο σκοτεινό) σήμα που μπορεί να κατα-
γράψει. Το πιο φωτεινό σήμα αντιστοιχεί στην πιο φωτεινή απόχρωση της εικόνας που σα-
ρώνεται και το πιο σκοτεινό αντιστοιχεί στις πιο σκούρες περιοχές της εικόνας. Όσο υψηλό-
τερη είναι η τιμή του δυναμικού πεδίου ενός σαρωτή, τόσο καλύτερα είναι. Τυπικές τιμές εί-
ναι οι 2.4, 3.6 και 4.8. Στους περισσότερους οικιακούς σαρωτές η τιμή για το δυναμικό πεδίο 
δεν αναφέρεται, διότι όλοι μπορούν να καλύψουν αποτελεσματικά τις ανάγκες σάρωσης φω-
τογραφιών, κειμένων και σχεδίων ενός απλού χρήστη. 

 
 Συνοδευτικό λογισμικό και λοιπά χαρακτηριστικά: Το συνοδευτικό λογισμικό των σαρω-

τών είναι σημαντικό, γιατί παρέχει λειτουργίες, όπως προεπισκόπηση εικόνων, επιλογή περι-
οχών για σάρωση και δυνατότητες αναγνώρισης χαρακτήρων για διάφορες γλώσσες, όπως 
Ελληνικά και Αγγλικά. Στα υπόλοιπα χρήσιμα χαρακτηριστικά των σαρωτών συγκαταλέγο-
νται ο τρόπος σύνδεσης με τον υπολογιστή (π.χ. USB ή FireWire), η ταχύτητα σάρωσης ανά 
τύπο εγγράφου, οι αυτοματοποιημένες λειτουργίες με το πάτημα ενός πλήκτρου (π.χ. η απευ-
θείας αποστολή email), οι υποστηριζόμενοι τύποι μέσων (π.χ. φωτογραφικό χαρτί ή slide και 
αρνητικά 35 mm), οι φυσικές του διαστάσεις και το βάρος του. 

 
2.6.1.3. TWAIN – ISIS 
 
Στην περιγραφή των σαρωτών αναφέρονται πολλές φορές οι όροι TWAIN και ISIS. To TWAIN είναι ένας 
οδηγός λογισμικού για επικοινωνία συσκευών σύλληψης εικόνων με εφαρμογές επεξεργασίας εικόνων. To 
TWAIN δεν είναι ακρώνυμο, αλλά το όνομα του προγράμματος. Μέσω αυτού του λογισμικού οι επεξεργα-
στές εικόνων δεν χρειάζεται να επικοινωνούν απευθείας με το σαρωτή, ούτε να γνωρίζουν τις τεχνικές του 
λεπτομέρειες. Ο οδηγός TWAIN αναλαμβάνει αυτό το έργο. 

Το ISIS (Image and Scanner Interface Specification) είναι σύστημα λογισμικού για διαχείριση των ε-
νεργειών του σαρωτή. Μπορεί να χρησιμοποιηθεί από τα εργαλεία επεξεργασίας εικόνων και για τη διαδικα-
σία της σάρωσης, αλλά και για τη διαδικασία της επεξεργασίας.  
 

2.6.2. Ψηφιακή φωτογραφική μηχανή 
 
Οι ψηφιακές φωτογραφικές μηχανές (digital cameras) διαχωρίζουν το φως και το μετατρέπουν σε ηλεκτρικά 
σήματα που αντιστοιχούν στα κανάλια Red, Green και Blue (Εικόνες 2.58 και 2.59). Δηλαδή, συλλαμβάνουν 
το φως και δημιουργούν τρεις αναπαραστάσεις της εικόνας που «βλέπει» ο φακός. Μια ψηφιακή φωτογραφι-
κή μηχανή αποτελείται από ένα σύνολο ηλεκτρονικών κυκλωμάτων και καθρεφτών. Οι καθρέφτες και τα φίλ-
τρα διαχωρίζουν το φως στις συνιστώσες R, G και Β και τις οδηγούν στη συσκευή σύζευξης φορτίου (CCD - 
Charge-Coupled Device) ή τη συσκευή ημιαγωγών CMOS (Complimentary Metal Oxide Semiconductor), 
ανάλογα με ποια τεχνολογία χρησιμοποιείται. Το αποτέλεσμα αυτής της διαδικασίας είναι η δημιουργία των 
τριών διαφορετικών σημάτων που αντιστοιχούν στα βασικά χρώματα του μοντέλου RGB. 

Η ανάλυση των ψηφιακών φωτογραφικών μηχανών καθορίζεται σε pixels, αλλά αναφέρεται σε 
Megapixels (MP ή Mpx ή Mpix), διότι οι εικόνες περιέχουν εκατομμύρια εικονοστοιχεία. Για παράδειγμα, 
ανάλυση 8 Megapixel σημαίνει 3264x2448 ή 7.990.272 εικονοστοιχεία. Ανάλυση 12,1 MP σημαίνει 
4000x3000 pixels. Παρατηρούμε ότι η συνολική ανάλυση είναι κατά προσέγγιση ίση με τον αριθμό των 
πραγματικών pixels. Κάθε εικονοστοιχείο αντιστοιχεί σε έναν αισθητήρα στην περίπτωση των μηχανών CCD. 
Κάποιοι αισθητήρες χρησιμοποιούνται από την ίδια την ψηφιακή μηχανή για εσωτερικούς λόγους. Συνεπώς, 
στην πραγματικότητα υπάρχουν κάποια επιπλέον εικονοστοιχεία, τα οποία όμως είναι δεσμευμένα. 
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Εδώ θα πρέπει να σημειωθεί ότι υψηλότερη ανάλυση δεν σημαίνει απαραίτητα και μεγαλύτερη ευ-
κρίνεια στην τελική εικόνα. Στην πράξη, περισσότερα megapixels σημαίνει περισσότερα εικονοστοιχεία ανά 
διάσταση και όχι περισσότερα εικονοστοιχεία ανά ίντσα. Δηλαδή, με πιο απλά λόγια, μεγαλύτερες εικόνες. Η 
ευκρίνεια, όπως έχει αναφερθεί, εξαρτάται από τα εικονοστοιχεία ανά ίντσα. Έτσι, για μεγέθη φωτογραφιών 
5x7 ιντσών (περίπου 13x18 εκατοστά), ανάλυση μεγαλύτερη από 3 MP παράγει εικόνες υψηλής ποιότητας, 
καθώς η ανάλυση προσεγγίζει τα 300 ppi ανά διάσταση. Ενώ, αν η φωτογραφία εκτυπωθεί σε διάσταση 
16x20 ίντσες, η ανάλυση 3 MP παράγει εικόνες με 100 περίπου ppi ανά διάσταση. Συνεπώς, η μεγάλη ανά-
λυση σε megapixels είναι σημαντική, όταν απαιτούνται μεγάλες φωτογραφίες υψηλής ανάλυσης.  

Οι φωτογραφικές μηχανές αποθηκεύουν τις φωτογραφίες τους σε μορφή JPEG ή TIFF. Στην περί-
πτωση αποθήκευσης σε JPEG, οι χρήστες μπορούν να καθορίσουν την ποιότητα της φωτογραφίας. Το μέγε-
θος του αρχείου εξαρτάται από το μέγεθος της εικόνας και το φορμά που χρησιμοποιείται. Για παράδειγμα, 
φωτογραφία 1600x1200 καταλαμβάνει χώρο περίπου 6 MB σε μορφή TIFF, 1,7 MB σε JPEG με υψηλή ποιό-
τητα και 420 KB σε μορφή JPEG με χαμηλότερη ποιότητα. 

 
 

 
 
Εικόνα 2.58 Δημιουργία R, G, B αναπαραστάσεων της αρχικής φωτογραφίας. 

 
Αρκετές φωτογραφικές μηχανές αποθηκεύουν τα δεδομένα σε «ακατέργαστη» (RAW) μορφή. Δηλα-

δή, περιέχουν τις πληροφορίες των αισθητήρων όπως αυτές λαμβάνονται, καθώς και επιπλέον δεδομένα για 
τον τρόπο χρήσης των πληροφοριών των αισθητήρων. Τα αρχεία που καλούνται RAW δεν μπορούν να επε-
ξεργαστούν απευθείας με κάποιο επεξεργαστή εικόνας, διότι στην ουσία δεν πρόκειται για πρότυπη μορφή. 
Τα δεδομένα που αποθηκεύονται ποικίλουν ανά φωτογραφική μηχανή και έχουν διαφορετική δομή και επέ-
κταση. Για παράδειγμα, τα αρχεία .kdc αφορούν τις μηχανές Kodak, ενώ τα .nrw τις μηχανές Nikon. Φυσικά, 
όλες οι φωτογραφικές μηχανές, ακόμη και των κινητών τηλεφώνων μπορούν τελικά να παράγουν αρχεία 
JPEG. 

 

 
 
Εικόνα 2.59 Διαδικασία μετατροπής του φωτός σε διακριτά ηλεκτρικά σήματα.  

 
Στην περίπτωση φωτογραφικών μηχανών, το μέσο και ο συνολικός χώρος αποθήκευσης, η δυνατότη-

τα μεταβλητού εστιακού μήκους, ο τρόπος εστίασης, το μέγεθος της οθόνης θέασης της εικόνας, το συνοδευ-
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τικό λογισμικό, η δυνατότητα αλλαγής φακού και κάποιες άλλες επιπλέον δυνατότητες είναι κάποια από τα 
κριτήρια αξιολόγησης των μηχανών.  

 

2.7. Υλικό για επεξεργασία και προβολή εικόνων 
 
Η κάρτα γραφικών (graphics card) και η οθόνη (monitor) είναι τα κύρια εξαρτήματα των υπολογιστών που 
εμπλέκονται στην επεξεργασία και προβολή των εικόνων. 

 

2.7.1. Κάρτα γραφικών 
 
Η κάρτα ή προσαρμογέας γραφικών ενός υπολογιστή είναι υπεύθυνη για τη δημιουργία και την απεικόνιση 
των δεδομένων στην οθόνη. Στη βιβλιογραφία αναφέρεται είτε ως κάρτα ή προσαρμογέας γραφικών, είτε ως 
κάρτα ή προσαρμογέας βίντεο, είτε ως επιταχυντής γραφικών (video card, video adapter, graphics accelerator 
card, display adapter, ή graphics card). Η κάρτα γραφικών παίρνει ως είσοδο τα ψηφιακά αποτελέσματα προ-
γραμμάτων, τα μετατρέπει σε ηλεκτρικά σήματα, τα οποία αποστέλλονται στην οθόνη του υπολογιστή για 
προβολή. Ουσιαστικά, καθοδηγεί την οθόνη ορίζοντας ποιες κουκκίδες πρέπει να φωτιστούν και με ποιο από 
τα τρία βασικά χρώματα (Red, Green, Blue). 

Η κάρτα γραφικών είναι μια πλακέτα κυκλωμάτων, η οποία περιλαμβάνει έναν επεξεργαστή και κυ-
κλώματα μνήμης RAM (εικόνα 47). Διαθέτει, επίσης, ένα μικροκύκλωμα εισόδου / εξόδου (BIOS), το οποίο 
αποθηκεύει τις ρυθμίσεις της κάρτας και εκτελεί διαγνωστικά για τη μνήμη, την είσοδο και την έξοδο κατά 
την εκκίνηση του συστήματος. Ο επεξεργαστής γραφικών της κάρτας (Graphics Processing Unit - GPU), εί-
ναι υπεύθυνος για την εκτέλεση των πολύπλοκων μαθηματικών και γεωμετρικών υπολογισμών που είναι α-
παραίτητοι για την απόδοση των γραφικών. Λόγω της ύπαρξης ξεχωριστού επεξεργαστή πάνω στην κάρτα 
γραφικών, είναι απαραίτητη η χρήση ενός ανεμιστήρα για την ψύξη της κάρτας. Πολλές κάρτες, εκτός από τις 
βασικές τους λειτουργίες, έχουν επιπλέον δυνατότητες για σύλληψη βίντεο και για την επεξεργασία και προ-
βολή γραφικών τριών διαστάσεων. Επίσης, έχουν επιπλέον εισόδους και εξόδους για απευθείας σύνδεση με 
τηλεόραση ή άλλες συσκευές. 

 

 
 

Εικόνα 2.60 Κάρτα γραφικών όπου διακρίνεται και ο ανεμιστήρας. 

 
2.7.1.1. Θύρες διασύνδεσης 
 
Οι βασικές έξοδοι μιας κάρτας γραφικών για σύνδεση με την οθόνη του υπολογιστή ή άλλες συσκευές, όπως 
ο βιντεοπροβολέας, είναι οι VGA (ή D-SUB), DVI και η νεότερη HDΜΙ (Εικόνα 2.61).  

Η θύρα VGA (Video Graphics Array) είναι αναλογική και ουσιαστικά μετατρέπει το σήμα σε αναλο-
γικό για να προβληθεί σε οθόνες τύπου CRT που θα εξετάσουμε πιο κάτω. Εξακολουθεί να αποτελεί τον 
κλασικό τρόπο διασύνδεσης υπολογιστών και συσκευών προβολής, αν και πρωτοεμφανίστηκε στη δεκαετία 
του '80. 
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Η θύρα DVI (Digital Visual Interface) σχεδιάστηκε ώστε να παρέχει υψηλής ανάλυσης ψηφιακή πλη-
ροφορία σε ψηφιακές οθόνες (π.χ. LCD και TFT) ή ψηφιακούς προβολείς. Υπάρχει σε τρεις τύπους DVI-D 
(ψηφιακό), DVI-A (αναλογικό) και το συνδυασμένο DVI-I (αναλογικό και ψηφιακό). Οι τρεις τύποι διαφέ-
ρουν στον αριθμό των επαφών που διαθέτουν και την ταχύτητα μεταφοράς των ψηφιακών δεδομένων προς το 
ψηφιακό μέσο προβολής των δεδομένων. Οι εκδόσεις που υποστηρίζουν και αναλογική πληροφορία παρέ-
χουν επιπλέον επαφές για μεταφορά δεδομένων και σε αναλογική μορφή. Γενικότερα, σε σχέση με το πρότυ-
πο VGA, επιτρέπει ταχύτερη μεταφορά δεδομένων στην οθόνη και σε καθαρά ψηφιακή μορφή, άρα χωρίς 
αλλοιώσεις του σήματος. 

 

 
 

Εικόνα 2.61 VGA, DVI και HDMI έξοδοι κάρτας γραφικών. 
 
Το πρότυπο HDMI (High-Definition Multimedia Interface) αποτελεί επέκταση του DVI. Υποστηρίζει 

τη μεταφορά ψηφιακών πληροφοριών εικόνας και ήχου σε συστήματα σε οθόνες υπολογιστών ή τηλεόρασης, 
καθώς και άλλες ψηφιακές συσκευές. Υπάρχουν τέσσερις τύποι HDMI θυρών που αριθμούνται Α, Β, C και 
D. Διαφέρουν ως προς τον αριθμό των επαφών, το μέγεθος, την κωδικοποίηση του σήματος και τη συσκευή 
που προορίζονται (π.χ. υπολογιστές χειρός ή φορητούς υπολογιστές). Σε όλες τις περιπτώσεις, το βασικό πλε-
ονέκτημα είναι η δυνατότητα για τη μεταφορά εικόνας και ήχου σε ψηφιακή μορφή μέσω ενός μέσου. 

Πλέον έχει αναπτυχθεί και η θύρα DisplayPort που έχει ίδια λογική με τη θύρα HDMI, δηλ. μπορεί 
να μεταφέρει εικόνα και ήχο. Έχει κάποια πλεονεκτήματα σε σχέση με τη HDMI, αλλά δεν είναι ακόμη τόσο 
ευρέως διαδεδομένη, όσο η HDMI. 

 

2.7.1.2. Επιπλέον χαρακτηριστικά 
 
Εκτός από τον τρόπο διασύνδεσης με την οθόνη του υπολογιστή ή άλλες συσκευές, οι κάρτες γραφικών έχουν 
κάποια χαρακτηριστικά που είναι αρκετά σημαντικά. 

 
 Μνήμη: Η μνήμη της κάρτας γραφικών λειτουργεί ως καταχωρητής των εικόνων που πρόκει-

ται να απεικονισθούν στην οθόνη. Όσο μεγαλύτερο είναι το μέγεθος της μνήμης γραφικών, 
αλλά και η ταχύτητα ανάγνωσης και εγγραφής των δεδομένων από και προς τη μνήμη, τόσο 
ταχύτερη είναι η απεικόνιση των δεδομένων στην οθόνη. Αν η μνήμη της κάρτας δεν είναι 
αρκετή, τότε καταναλώνει τμήμα της κύριας μνήμης του συστήματος. Αυτό συμβαίνει κυρίως 
στους φορητούς υπολογιστές. 

 
 Μέγιστη ανάλυση: Η μέγιστη ανάλυση της κάρτας γραφικών ορίζεται με τον αριθμό των εικο-

νοστοιχείων που μπορεί να προβάλλει. Όσο μεγαλύτερο είναι το γινόμενο των εικονοστοι-
χείων οριζοντίως x καθέτως, τόσο καλύτερη είναι η κάρτα. Σε αρκετές περιπτώσεις, η μέγι-
στη ανάλυση διαφοροποιείται ανάλογα με τη θύρα εξόδου. Για παράδειγμα, σε μια σχετικά 
καλή κάρτα γραφικών η ανάλυση αναφέρεται ως εξής: 2048x1536 για διασύνδεση μέσω α-
ναλογικής οδού και 2560x1600 μέσω DVI. 

 
 Ταχύτητα μετατροπής ψηφιακού-αναλογικού σήματος: Στην περίπτωση που η οθόνη είναι α-

ναλογική, η κάρτα μετατρέπει τις πληροφορίες εικόνας σε αναλογικές. Η διαδικασία γίνεται 
μέσω του RAMDAC (Random Access Memory Digital-Analog Converter), που αναφέρεται 
ως ψηφιακός-αναλογικός μετατροπέας της κάρτας. Η ταχύτητα μετατροπής που προσδιορίζε-
ται σε MHz είναι σημαντική, καθώς επιταχύνει τη διαδικασία και τελικά την γρήγορη εναλ-
λαγή των εικόνων. 

 
 Υποστηριζόμενες τεχνολογίες λογισμικού: Οι εταιρείες κατασκευής των καρτών, αλλά και ε-

ταιρείες κατασκευής λογισμικού γραφικών έχουν υλοποιήσει λογισμικό για την αυτοματο-
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ποίηση των λειτουργιών επεξεργασίας των γραφικών. Οι κάρτες μπορεί να έχουν εγγενή υ-
ποστήριξη αυτών των τεχνολογιών και συνεπώς πιο γρήγορη αποστολή των δεδομένων στην 
οθόνη. Τεχνολογίες που υποστηρίζονται ευρέως είναι οι DirectX της Microsoft και ΑΤΙ 
PowerPlay της εταιρείας ATI, που έχει πλέον αγοραστεί από την AMD. Επίσης, σε πολλές 
κάρτες υποστηρίζεται και η τεχνολογία OpenGL (Open Graphics Library). 

 

2.7.2. Οθόνη 
 
Η οθόνη (monitor) ενός υπολογιστή είναι επιφορτισμένη με την προβολή των πληροφοριών εικόνας στο χρή-
στη. Λειτουργούν με τη λογική του χρωματικού μοντέλου RGB. Οι οθόνες των σύγχρονων υπολογιστών είναι 
συνήθως τεχνολογίας Υγρών Κρυστάλλων (LCD – Liquid Crystal Display), αν και ακόμη υπάρχουν και οι 
παλαιότερες οθόνες Σωλήνων Καθοδικών Ακτίνων (CRT – Cathode Ray Tube) (Εικόνα 2.62). Οι οθόνες Ορ-
γανικών Φωτοδιόδων (OLED) αποτελούν τεχνολογία που είναι υπό ανάπτυξη. 

 

2.7.2.1. Οθόνες CRT 
 
Οι οθόνες καθοδικού σωλήνα αποτελούν την πιο παλαιά τεχνολογία οθονών και στην πράξη έχουν καταργη-
θεί, εφόσον δεν πωλούνται στα καταστήματα ηλεκτρονικών. Θα αναφερθούν σύντομα τα χαρακτηριστικά 
τους, επειδή υπάρχουν ακόμη σε εργαστήρια υπολογιστών. Επίσης, με αυτόν τον τρόπο λειτουργούν και οι 
παλαιότερου τύπου τηλεοράσεις.  

Οι οθόνες χρησιμοποιούν τρία ηλεκτρονικά πυροβόλα που αντιστοιχούν στα χρώματα του μοντέλου 
RGB. Τα πυροβόλα εκπέμπουν ηλεκτρόνια προς το εμπρόσθιο τμήμα της οθόνης, το οποίο είναι επικαλυμμέ-
νο με φώσφορο. Όταν στα εικονοστοιχεία της οθόνης προσπέσουν οι τρεις δέσμες ηλεκτρονίων, αυτά διεγεί-
ρονται και φωσφορίζουν δημιουργώντας τις διάφορες αποχρώσεις. Τα χρώματα που ακτινοβολούν τα φω-
σφορίζοντα σημεία της οθόνης είναι το κόκκινο (R), το πράσινο (G) και το μπλε (B). Τα υπόλοιπα χρώματα 
μπορούν να γίνουν με ρύθμιση της φωτεινότητας κάθε κουκκίδας φωσφόρου.  

Οι οθόνες CRT είναι ογκώδεις, με αναλύσεις που δεν ξεπερνούν τα 1280x1024 pixels. Επίσης, είναι 
αναλογικές και ο βασικός τρόπος σύνδεσης με τον υπολογιστή ήταν μέσω της θύρας VGA της κάρτας γραφι-
κών.  

 
2.7.2.2. Οθόνες LCD, TFT και LED 
 
Οι οθόνες υγρών κρυστάλλων βασίζονται στις ιδιότητες λάμψης των υγρών κρυστάλλων, δηλαδή ενός υλικού 
που βρίσκεται πιο κοντά στην υγρή μορφή από ότι στη στερεά μορφή. Οι κρύσταλλοι είναι ευαίσθητοι στην 
αλλαγή της θερμοκρασίας και με την έκλυση θερμότητας μετατρέπονται σε κανονικό υγρό. Οι κρύσταλλοι 
είναι τοποθετημένοι πάνω σε έναν πίνακα κελιών και ανάλογα με την κατάστασή τους καθορίζουν το ποσο-
στό του φωτός που διαπερνά τα κελιά και συνεπώς, καθορίζουν το σχηματισμό της εικόνας που εμφανίζεται 
στην οθόνη. Το φως προέρχεται από λαμπτήρες φθορισμού που υπάρχουν στο εσωτερικό των οθονών. Υπάρ-
χουν διαφορετικές τεχνολογίες στις οθόνες LCD με βάση τη διάταξη των κρυστάλλων και τον τρόπο εφαρμο-
γής ηλεκτρισμού στις διατάξεις, αλλά όλες λειτουργούν με βάση την παραπάνω βασική αρχή. 

Ο νεότερος τύπος οθονών υγρών κρυστάλλων είναι οι TFT (Thin Film Transistor) (Εικόνα 2.62). 
Δομούνται σε πολλαπλά επίπεδα και οι υγροί κρύσταλλοι υπάρχουν μεταξύ δυο γυάλινων επιφανειών. Στο 
μπροστινό μέρος της οθόνης υπάρχει μια γυάλινη επιφάνεια χρώματος στην οποία προσπίπτει το φως που 
διαπερνά τους υγρούς κρυστάλλους. Σε σχέση με τις οθόνες CRT, oι οθόνες TFT έχουν μικρότερο μέγεθος 
και βάρος, χαμηλή ακτινοβολία και κατανάλωση ενέργειας, καθώς και υψηλότερη μέγιστη ανάλυση. Ως μειο-
νέκτημα των οθονών υγρών κρυστάλλων μπορεί να αναφερθεί η μικρότερη γωνία θέασης σε σχέση με τις 
CRT. 

Το μέγεθος των οθονών εκφράζεται σε ίντσες. Παλαιότερα επικρατούσαν οι οθόνες 17" (ιντσών), 
αλλά πλέον μεγέθη 19" ή 21" ή ακόμη μεγαλύτερα αποτελούν τη συνηθέστερη επιλογή. Ένα άλλο βασικό 
χαρακτηριστικό όλων των τύπων των οθονών είναι η μέγιστη υποστηριζόμενη ανάλυση. Τυπικές αναλύσεις 
είναι οι 1024x768, 1280x720, 1280x1024, 1440x900. Σε οθόνες μεγέθους 24" και άνω η ανάλυση ξεκινά από 
1920x1080 και φθάνει ως και 2560x1600. Στην περίπτωση τηλεοράσεων, οι αναλύσεις 1280x720 και 
1920x1080 αναφέρονται ως 720p και 1080p αντίστοιχα. Περισσότερα γι’ αυτό το ζήτημα θα αναφερθούν στο 
κεφάλαιο για το βίντεο. 
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Εικόνα 2.62 CRT και LCD/TFT οθόνη. 

 
Στην περίπτωση των οθονών υγρών κρυστάλλων, άλλα ενδιαφέροντα χαρακτηριστικά είναι ο λόγος 

αντίθεσης (contrast ratio), η φωτεινότητα, η γωνία θέασης, το βήμα κουκίδας (dot pitch) και ο χρόνος α-
πόκρισης. 

 Ο λόγος αντίθεσης ορίζει τη διαφορά μεταξύ του πιο φωτεινού και του πιο σκοτεινού χρώμα-
τος που μπορεί να εμφανίσει η οθόνη. Όσο μεγαλύτερη είναι η αντίθεση, τόσο πιο καθαρές 
θα εμφανίζονται οι εικόνες. Η αντίθεση διαχωρίζεται σε στατική αντίθεση και δυναμική αντί-
θεση. Η στατική (ή τυπική) αφορά την αντίθεση σε μια δεδομένη χρονική στιγμή, ενώ η δυ-
ναμική αφορά την αντίθεση που διαμορφώνεται με την πάροδο του χρόνου. Τυπικές τιμές για 
την πρώτη περίπτωση είναι 1000:1, ενώ για τη δεύτερη 50000:1. 

 
 Η φωτεινότητα αναφέρεται στο πόσο φωτεινές εμφανίζονται οι εικόνες στην οθόνη. Εκφρά-

ζεται σε φωτεινότητα ανά τετραγωνικό μέτρο (cd/m2) και συνήθως κυμαίνεται μεταξύ του 
250 και 300. Η φωτεινότητα είναι συνήθως ανάλογη του λόγου αντίθεσης. 

 
 Όπως αναφέρθηκε, η γωνία θέασης είναι ίσως το μόνο μειονέκτημα των οθονών υγρών κρυ-

στάλλων σε σχέση με τις οθόνες CRT. Αν ο θεατής κοιτάζει από πλάγια μια οθόνη υγρών 
κρυστάλλων, τότε πιθανώς δεν βλέπει καλά την εικόνα που απεικονίζεται. Μεγαλύτερη γωνία 
θέασης σε μια οθόνη LCD (ή TFT) σημαίνει πιο σωστή εμφάνιση της οθόνης από πλάγια. Οι 
σύγχρονες εικόνες έχουν δυνατότητα θέασης υπό γωνία 170 μοίρες. 

 
 Το βήμα κουκίδας (dot pitch ή pixel pitch) είναι η απόσταση μεταξύ διαδοχικών κουκκίδων 

ίδιας απόχρωσης (Εικόνα 2.63). Οι τριάδες κουκκίδων (R, G, B) αποτελούν ουσιαστικά υπο-
διαίρεση των εικονοστοιχείων. Η απόσταση αυτή σχετίζεται με τη λεπτομέρεια παρουσίασης 
των πληροφοριών στην οθόνη. Τυπικές τιμές γι’ αυτή την απόσταση στις οθόνες LCD είναι 
0.250mm, 0.258mm και 0.294mm. Μικρότερο βήμα κουκκίδας σημαίνει ότι οι κουκκίδες εί-
ναι πιο κοντά, άρα οι εικόνες εμφανίζονται πιο ρεαλιστικές και ευκρινείς. Διαφορετικά, τα 
εικονοστοιχεία των εικόνων εμφανίζονται πιο μεγάλα, άρα η εικόνα λιγότερο λεπτομερής. 
Στην περίπτωση κειμένου, το λίγο μεγαλύτερο βήμα κουκκίδας έχει ως αποτέλεσμα το κείμε-
νο να εμφανίζεται λίγο μεγαλύτερο και συνεπώς, λιγότερο κουραστικό. 

 
 O χρόνος απόκρισης αφορά στο χρόνο που απαιτείται για την προβολή μιας νέας εικόνας 

στην οθόνη. Υπολογίζεται σε milliseconds και συνήθεις τιμές στις νέες οθόνες είναι 2 ως 5 
milliseconds. Προφανώς, μικρότερος χρόνος σημαίνει και πιο γρήγορη ανανέωση της οθόνης, 
άρα πιο ρεαλιστική κίνηση στην περίπτωση προβολής βίντεο. 

 
 Οι οθόνες LED (Light Emitting Diode) είναι ουσιαστικά οθόνες LCD, στις οποίες ο φωτι-

σμός προέρχεται από μία συστοιχία μικροσκοπικών λαμπτήρων LED. Αναφέρονται και οθό-
νες LCD με LED backlight. Οι οθόνες LED έχουν αρκετά πλεονεκτήματα σε σχέση με τις 
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LCD. Έχουν καλύτερη δυναμική αντίθεση και φωτεινότητα με αποτέλεσμα να είναι πιο φω-
τεινή και ζωντανή η εικόνα. Επίσης, καταναλώνουν λιγότερη ενέργεια και είναι πιο λεπτές 
(Εικόνα 2.64).  

 

 
 

Εικόνα 2.63 Τριάδες κουκκίδων της οθόνης και η μεταξύ τους απόσταση. 

 

 
 

Εικόνα 2.64 Οθόνη LED. 

 

2.7.2.3. Οθόνες ΟLED 
 
Στις οθόνες OLED (Organic Light Emitting Diode) ο φωτισμός προέρχεται από τη λάμψη οργανικού υλικού 
στο οποίο έχει εφαρμοστεί ηλεκτρική τάση. Δηλαδή, δεν υπάρχει μια πηγή φωτισμού, όπως οι λαμπτήρες 
φθορισμού ή τα λαμπάκια LED, αλλά κάποια οργανικά μόρια ή πολυμερή τα οποία έχουν τη δυνατότητα να 
λάμπουν. Με βάση τον τρόπο λειτουργίας τους, οι οθόνες OLED έχουν βασικά πλεονεκτήματα έναντι των 
οθονών υγρών κρυστάλλων που παρουσιάστηκαν στην προηγούμενη ενότητα. Αρχικά, έχουν λιγότερη κατα-
νάλωση ενέργειας. Επίσης, εφόσον δεν περιέχουν κάποιο λαμπτήρα φωτισμού, έχουν πολύ μικρότερο πάχος 
που τους επιτρέπει να είναι και εύκαμπτες (Εικόνα 2.65). Έχουν μικρότερο χρόνο απόκρισης, βελτιωμένη 
φωτεινότητα και πιο ευρεία γωνία θέασης. Οι ιδιότητες αυτές τους επιτρέπουν να χρησιμοποιηθούν σε ένα 
ευρύ φάσμα εφαρμογών. 

 

 
 

Εικόνα 2.65 Οθόνες OLED. 



70 
 

 
Υπάρχουν κάποια προβλήματα με την τεχνολογία OLED και γι’ αυτό τον λόγο ακόμη δεν κατέχουν 

κυρίαρχη θέση στην αγορά. Πρώτον, το κόστος κατασκευής τους είναι μεγαλύτερο. Αν και καταναλώνουν 
λιγότερη ενέργεια σε εικόνες με μαύρο φόντο, απαιτούν περισσότερη ενέργεια από τις LCD σε εικόνες με 
άσπρο φόντο. Επιπλέον, είναι πιο ευαίσθητες στην υγρασία και λειτουργούν κυριολεκτικά ως καθρέπτης σε 
εξωτερικούς χώρους με αυξημένο φως (π.χ. ηλιόλουστες ημέρες). Το βασικό όμως πρόβλημα είναι ότι με την 
πάροδο του χρόνου το οργανικό υλικό χάνει την φωτεινότητά του. Έτσι, με εργαστηριακές μετρήσεις, υπολο-
γίστηκε ότι ο μέσος χρόνος ζωής τους (δηλαδή καλής λειτουργίας τους) είναι μικρότερος από τις οθόνες υ-
γρών κρυστάλλων. Φυσικά με χρήση πιο προηγμένων τεχνικών αυτό αναμένεται να αλλάξει σύντομα. Η νεό-
τερη γενιά των οθονών LED, που αναφέρεται συντομογραφικά ως AMOLED (Active-Matrix Organic Light 
Emitting Diode ή Active-Matrix OLED), προσφέρει μεγαλύτερο ρυθμό ανανέωσης και ακόμη μικρότερη κα-
τανάλωση ενέργειας. 

 
 Οθόνες Plasma 
Οι οθόνες πλάσματος  (PDP – Plasma Display Panel) περιέχουν μεταξύ δύο γυάλινων επιφανειών χιλιάδες 
μικροσκοπικές κυψελίδες που περιέχουν αέριο νέον ή ξένο και άλλα αδρανή αέρια. Τα αέρια αυτά αποτελούν 
το plasma. Οι κυψελίδες λάμπουν, όταν τροφοδοτηθούν με ηλεκτρικό ρεύμα. Στις έγχρωμες οθόνες πλάσμα-
τος, η πίσω επιφάνεια κάθε κυψελίδας καλύπτεται με φώσφορο και τα υπέρυθρα σωματίδια που εκπέμπονται 
από το plasma διεγείρουν το φώσφορο και έτσι παράγονται τα χρώματα. 

Οι οθόνες πλάσματος, συνήθως, αφορούν μοντέλα μεγάλων διαστάσεων, π.χ. 37 ιντσών και μεγαλύ-
τερα. Έχουν μικρό χρόνο ανανέωσης των περιεχομένων της οθόνης και μεγαλύτερη αντίθεση από όλα τα 
προηγούμενα μοντέλα. Έχουν μεγαλύτερη διάρκεια ζωής, αλλά και μεγαλύτερη κατανάλωση ηλεκτρικής ε-
νέργειας. Χρησιμοποιούνται ως οθόνες τηλεόρασης κυρίως, και όχι στους υπολογιστές. 

 

2.8. Υλικό εκτύπωσης εικόνων 
 
Η εκτύπωση εικόνων γίνεται κυρίως με χρήση των, γνωστών μας, εκτυπωτών (printers), αν και υπάρχουν συ-
στήματα όπως σχεδιογράφοι (plotters) που χρησιμοποιούνται για αρχιτεκτονικά σχέδια και γενικότερα διανυ-
σματικά γραφικά, αλλά και άλλα επαγγελματικά εκτυπωτικά μηχανήματα. Υπάρχουν τρεις βασικές κατηγορί-
ες εκτυπωτών οικιακής χρήσης: Κρουστικοί ή ακίδων (Dot matrix), Ψεκασμού μελάνης (Inkjet) και Laser. 

 

2.8.1. Εκτυπωτές ακίδων 
 
Οι εκτυπωτές ακίδων περιέχουν μια κεφαλή με ακίδες, οι οποίες ακουμπούν σε μια ταινία με μελάνη που βρί-
σκεται μεταξύ των ακίδων και του χαρτιού (Εικόνα 2.66). Τα σχήματα δημιουργούνται, σταδιακά, πάνω στην 
επιφάνεια εκτύπωσης ως ένα σύνολο από κουκκίδες, οι οποίες είναι αρκετά μεγάλες και εμφανείς και συνε-
πώς η ποιότητα εκτύπωσης είναι χαμηλή. Είναι παλαιότερης τεχνολογίας και χρησιμοποιούνται για την εκτύ-
πωση κειμένου σε πολλαπλά αντίγραφα, π.χ. μηχανογραφικών καταστάσεων, με ένα πέρασμα. 

 

2.8.2. Εκτυπωτές & σχεδιογράφοι ψεκασμού μελάνης 
 
Οι εκτυπωτές ψεκασμού μελάνης εκχύουν μικρές σταγόνες μελάνης, διαφόρων χρωμάτων, σε χαρτί για να 
δημιουργήσουν την εικόνα (Εικόνα 2.67). Οι σταγόνες είναι πολύ μικρές, με διάμετρο 50-60 μm, και τοποθε-
τούνται με πολύ μεγάλη ακρίβεια πάνω στο χαρτί. Με την ίδια τεχνική λειτουργούν και οι σχεδιογράφοι 
(plotter) ψεκασμού μελάνης. Η ανάλυση των εκτυπωτών είναι υψηλή και μπορεί να φθάσει ως και 4800x1200 
(dpi – dots per inch) με τη βοήθεια ειδικού λογισμικού. Προφανώς, οι εκτυπωτές λειτουργούν με τη λογική 
του χρωματικού μοντέλου CMYK. Το dpi αναφέρεται στις μικρές κουκκίδες του εκτυπωτή που χρησιμοποι-
ούνται για να εκτυπώσουν ένα pixel και δεν είναι το ίδιο με το ppi. Συνήθως, ο εκτυπωτής τυπώνει στα 600 
dpi, ενώ οι φωτογραφίες μας μπορεί να είναι σε ανάλυση 96 ppi ή 300 ppi κ.λπ. Οι δύο αριθμοί δεν σχετίζο-
νται άμεσα, αλλά όσο αυξάνουν τα dpi εκτύπωσης, τόσο πιο ποιοτικά τυπώνεται μια φωτογραφία. Όταν τυ-
πώνουμε φωτογραφίες, πρέπει να έχουμε και μεγάλη ανάλυση της φωτογραφίας (π.χ. 300 ppi), αλλά και με-
γάλη ανάλυση εκτύπωσης (π.χ. 1200 dpi και πιο πάνω). 
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Εικόνα 2.66 Εκτυπωτής Dot Matrix και κεφαλή εκτύπωσης. 

 

 
 

Εικόνα 2.67 Εκτυπωτής και σχεδιογράφος ψεκασμού μελάνης. 

 
Οι συσκευές εκτύπωσης inkjet χρησιμοποιούν 2 ή περισσότερα δοχεία μελάνης για την αναπαραγωγή 

των εικόνων. Έχουν σίγουρα ένα δοχείο με μαύρο μελάνι και είτε ένα δοχείο για τα χρώματα Cyan, Magenta 
και Yellow ή διαφορετικό δοχείο για καθένα από τα χρώματα Cyan, Magenta και Yellow. Στους σχεδιογρά-
φους χρησιμοποιούν και επιπλέον μελάνια για καλύτερη ποιότητα, π.χ. ματ μαύρο μελάνι. Επίσης τα μελάνι 
μπορεί να είναι σε υγρή μορφή (τεχνολογία dye) ή σε μορφή μικρών κόκκων σε διαλυτικό (τεχνολογία 
pigment). Η τεχνολογία pigment παράγει εκτυπώσεις μεγαλύτερης διάρκειας, αλλά προς το παρόν η τεχνολο-
γία εκτύπωσης dye παράγει πιο πολλές αποχρώσεις. 

Η έκχυση της μελάνης στο χαρτί γίνεται είτε με την τεχνική της θερμικής φυσαλίδας (thermal bubble 
ή bubble jet) είτε με τη χρήση πιεζοηλεκτρικού κρυστάλλου (piezoelectric crystals). Σύμφωνα με την πρώτη 
τεχνική, στην κεφαλή του εκτυπωτή υπάρχουν μικρές αντιστάσεις που δημιουργούν θερμότητα και εκχύονται 
φυσαλίδες μελάνης που κατευθύνονται στο χαρτί. Στη δεύτερη τεχνική, χρησιμοποιείται πιεζοηλεκτρικός 
κρύσταλλος ο οποίος, όταν εφαρμοστεί ρεύμα, δονείται και έτσι ωθεί μια μικρή σταγόνα μελάνης στην επι-
φάνεια εκτύπωσης. 

 

2.8.3. Εκτυπωτές Laser 
 
Οι εκτυπωτές Laser χρησιμοποιούν ένα φωτοευαίσθητο τύμπανο το οποίο είναι ηλεκτρικά φορτισμένο, οπότε 
όταν προσπίπτει φως πάνω σε αυτό δημιουργεί ηλεκτρικά την εικόνα ή το κείμενο που θα εκτυπωθεί. Έπειτα, 
οι κόκκοι τόνερ (λεπτόκοκκη σκόνη) έλκονται πάνω στο τύμπανο στα σημεία που έχει δημιουργηθεί το ηλε-
κτρικό αντίγραφο της εκτύπωσης. Όταν το χαρτί περνά κοντά στην επιφάνεια του τυμπάνου, έλκει τους κόκ-
κους τονερ. Στη συνέχεια, το χαρτί περνά από δύο κυλίνδρους θέρμανσης που λιώνουν τη σκόνη και έτσι γί-
νεται η δημιουργία της εικόνας ή του κειμένου στο χαρτί (Εικόνα 2.68). 

Το αντικείμενο που πρόκειται να εκτυπωθεί, είτε είναι κείμενο είτε εικόνα, μετατρέπεται σε διανυ-
σματικό γραφικό με τη βοήθεια της γλώσσας PCL της Hewlett Packard (Printer Command Language) ή της 
γλώσσας PostScript της εταιρείας Adobe. Οι υπολογιστές στέλνουν τα δεδομένα στους εκτυπωτές, μέσω της 
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PCL ή της PostScript σε διανυσματική μορφή και οι εκτυπωτές αναλαμβάνουν την εκτύπωση των αντίστοι-
χων κουκκίδων στο χαρτί. 

Οι έγχρωμοι εκτυπωτές laser λειτουργούν με την ίδια λογική, αλλά εκτελούν την ίδια διαδικασία 4 
φορές. Κάθε φορά εκτυπώνουν ένα χρώμα από τα κυανό (cyan), πορφυρό (magenta), κίτρινο (yellow) και 
μαύρο (black). Συνδυάζοντας τόνερ αυτών των χρωμάτων σε διαφορετικές αναλογίες δημιουργούνται οι επι-
θυμητές αποχρώσεις. 

 

 
 

Εικόνα 2.68 Διαδικασία εκτύπωσης σε εκτυπωτή Laser. 

 
Οι εκτυπωτές laser έχουν χαμηλότερο κόστος εκτύπωσης ανά σελίδα. Έτσι, αν και συνήθως είναι πιο 

ακριβοί από τους εκτυπωτές ψεκασμού μελάνης στις περιπτώσεις μαζικών εκτυπώσεων το συνολικό κόστος 
είναι μικρό. Επίσης, εκτυπώνουν γρήγορα αρκετές σελίδες και έχουν καλύτερη ποιότητα από τους προηγού-
μενους εκτυπωτές. 

 

2.9. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο παρόν κεφάλαιο παρουσιάστηκαν οι βασικές έννοιες που σχετίζονται με την ψηφιοποίηση εικόνων, την 
αναπαράστασή τους σε ψηφιακή μορφή και την επεξεργασία τους με χρήση του κατάλληλου λογισμικού. Ε-
πίσης, έγινε αναφορά στο υλικό που απαιτείται για τη ψηφιοποίηση, την προβολή και την εκτύπωση εικόνων. 
Βασικός στόχος των προηγουμένων ενοτήτων ήταν να γίνει εκτενής αναφορά στα ζητήματα που άπτονται της 
επεξεργασίας εικόνας, κυρίως από μία πρακτική οπτική γωνία.  

Η ψηφιοποίηση εικόνων είναι η μετατροπή τους από αναλογική μορφή (π.χ. τυπωμένες φωτογραφίες) 
σε ψηφιακή μορφή. Το πρώτο στάδιο της ψηφιοποίησης είναι η δειγματοληψία όπου λαμβάνονται ανά τακτά 
χρονικά διαστήματα τιμές του αναλογικού σήματος (δείγματα). Έπειτα, κατά την κβάντιση, οι αριθμητικές 
τιμές στρογγυλοποιούνται σε ένα προκαθορισμένο σύνολο σημάτων. 

Ο αριθμός των εικονοστοιχείων σε κάθε διάσταση της εικόνας ονομάζεται ανάλυση της εικόνας και 
αναφέρεται σε εικονοστοιχεία ανά ίντσα (ppi). Το βάθος χρώματος είναι ο αριθμός των δυαδικών ψηφίων που 
χρησιμοποιούνται για την αναπαράσταση του χρώματος κάθε εικονοστοιχείου. Με βάθος χρώματος Ν μπο-
ρούν να κωδικοποιηθούν 2Ν αποχρώσεις. Όσο μεγαλύτερο είναι το βάθος χρώματος, τόσο περισσότερες χρω-
ματικές αποχρώσεις μπορεί να περιέχει μία εικόνα. 

Τα χρωματικά μοντέλα περιγράφουν πώς μπορούν να κωδικοποιηθούν ως πλειάδες αριθμών τα χρώ-
ματα. Το προσθετικό μοντέλο RGB βασίζεται στα τρία χρώματα Κόκκινο (Red), Πράσινο (Green) και Blue 
(Μπλε) για τη δημιουργία των αποχρώσεων. Στο αφαιρετικό μοντέλο CMYK τα βασικά χρώματα είναι το 
Κυανό (Cyan), το Πορφυρό (Magenta) και το Κίτρινο (Yellow). Τα χρωματικά μοντέλα HSΒ (ή HSV), HSL 
(ή HLS) και HSI βασίζονται στην απόχρωση, στην ένταση και τη φωτεινότητα του χρώματος για να προσδιο-
ρίσουν τις διάφορες αποχρώσεις. Το φάσμα ή γκάμα ή κλίμακα χρωμάτων (color gamut) ενός χρωματικού 
μοντέλου ή μιας συσκευής απεικόνισης ή εκτύπωσης είναι το υποσύνολο των χρωματικών αποχρώσεων που 
μπορούν απεικονιστούν σε αυτό το χρωματικό μοντέλο ή να αναπαραχθούν στη συσκευή. 

Οι ψηφιογραφικές (bitmap) εικόνες αποτελούνται από ένα σύνολο εικονοστοιχείων που διατάσσονται 
στο επίπεδο και έτσι σχηματίζεται η τελική εικόνα. Το μέγεθος των ασυμπίεστων εικόνων bitmap εξαρτάται 
από τις διαστάσεις της εικόνας, την ανάλυση της εικόνας και το βάθος χρώματος. Το μέγεθος των εικόνων 
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μπορεί να μειωθεί μέσω της χρήσης κάποιας τεχνικής συμπίεσης. Οι αλγόριθμοι συμπίεσης μπορεί να είναι 
μη απωλεστικοί (χωρίς απώλεια πληροφορίας) ή απωλεστικοί (με απώλεια πληροφορίας). 

Στις εικόνες bitmap υπάρχουν αρκετά θέματα που είναι σημαντικά. Το δεικτοδοτούμενο χρώμα 
(indexed color) είναι η χρήση 256 ή λιγότερων χρωμάτων για την αναπαράσταση των χρωματικών αποχρώ-
σεων της εικόνας. Η παλέτα αποτελείται, συνήθως, από τις πιο συχνές αποχρώσεις της εικόνας. Διαφάνεια 
είναι η δυνατότητα κάποιων μορφών εικόνων, π.χ. GIF και PNG, να μην εμφανίζουν ένα χρώμα, ώστε, όταν 
προβάλλεται σε φόντο διαφορετικού χρωματισμού, να μην εμφανίζεται το αρχικό φόντο και η εικόνα να εμ-
φανίζεται ενσωματωμένη. 

Οι χρωματικές αποχρώσεις του κόκκινου, πράσινου και μπλε μιας εικόνας μπορούν να επεξεργα-
στούν χωριστά, μέσω των καναλιών της εικόνας. Το κανάλι Άλφα (Alpha channel) είναι ένα επιπλέον κανάλι 
που περιέχει πληροφορίες για τη διαφάνεια των εικονοστοιχείων και μέσω του οποίου είναι δυνατή η μερική 
διαφάνεια. Η επίτευξη μεγαλύτερου βάθους χρώματος στις εικόνες με περιορισμένη παλέτα χρωμάτων, ώστε 
να υπάρξουν περισσότερες διαβαθμίσεις των διαθέσιμων χρωμάτων, γίνεται μέσω της τεχνικής dithering. Το 
ιστόγραμμα μιας εικόνας είναι μια γραφική απεικόνιση της κατανομής των χρωμάτων σε μία εικόνα και μπο-
ρεί να χρησιμοποιηθεί για χρωματικές διορθώσεις. 

Οι βασικές μορφές αποθήκευσης ψηφιογραφικών εικόνων είναι οι BMP, JPEG, TIFF, PNG και GIF. 
Καθένα από αυτά τα μορφότυπα έχει διαφορετικό σκοπό και χαρακτηριστικά, π.χ. δυνατότητα συμπίεσης ή 
διαφάνεια, ενώ υποστηρίζονται σχεδόν από όλα τα προγράμματα επεξεργασίας γραφικών, αλλά και επεξερ-
γαστές κειμένου ή άλλο γενικής χρήσης λογισμικό. Επίσης, υπάρχουν και ειδικές μορφές αποθήκευσης, όπως 
τα αρχεία PSD και CPT των εργαλείων επεξεργασίας Adobe Photoshop και Corel Photo-Paint αντίστοιχα, με 
επιπλέον δυνατότητες. Αυτά τα εργαλεία επεξεργασίας εικόνων έχουν πολλές δυνατότητες, όπως πολλαπλά 
επίπεδα, επεξεργασία καναλιών εικόνας, εφαρμογή φίλτρων, κ.ά. Το εργαλείο επεξεργασίας εικόνων GIMP 
είναι λογισμικό ανοιχτού κώδικα με παρόμοιες δυνατότητες με τα εμπορικά λογισμικά επεξεργασίας εικόνων. 

Τα διανυσματικά γραφικά αποτελούνται από ένα σύνολο σχημάτων τα οποία περιγράφονται με μα-
θηματικό τρόπο. Έχουν μικρότερο μέγεθος από τις εικόνες bitmap, μπορούν να αυξομειωθούν χωρίς παρα-
μόρφωση, αλλά απαιτείται ειδικό λογισμικό για την επεξεργασία τους. Τα πιο διαδεδομένα μορφότυπα για 
διανυσματικά γραφικά είναι τα SVG, WMF, EPS, AI και CDR. Τα εργαλεία Adobe Illustrator, CorelDraw και 
το εργαλείο ανοιχτού κώδικα Inkscape, παρέχουν προχωρημένες δυνατότητες δημιουργίας και επεξεργασίας 
διανυσματικών γραφικών με εντυπωσιακά αποτελέσματα. 

Η ψηφιοποίηση, προβολή και εκτύπωση εικόνων απαιτεί και την ύπαρξη κατάλληλου υλικού. Ο σα-
ρωτής και η ψηφιακή κάμερα χρησιμοποιούνται για την εισαγωγή εικόνων στον υπολογιστή, η κάρτα γραφι-
κών και η οθόνη για την προβολή τους και οι εκτυπωτές και οι σχεδιογράφοι για την εκτύπωσή τους. Το υλι-
κό εξελίσσεται, αλλά οι βασικές λειτουργίες του και η χρησιμότητα του παραμένει ίδια. Οι δυνατότητες αλ-
λάζουν, δημιουργώντας νέους τρόπους αξιοποίησης και προβολής των ψηφιακών εικόνων. 
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3. Θεωρία Ψηφιακού Ήχου 
 

Σύνοψη 
Στο παρόν κεφάλαιο ασχολούμαστε τον ψηφιακό. Αρχικά, ορίζονται οι μορφές ήχου που συναντάμε στους υπο-
λογιστές και έπειτα ορίζεται ο ήχος ως φυσικό μέγεθος, δηλαδή ορίζονται κάποια από τα φυσικά του χαρακτηρι-
στικά, όπως η συχνότητα, η ένταση, η χροιά κ.ά. που επηρεάζουν και την επεξεργασία του ήχου στους υπολογι-
στές. Στην τρίτη ενότητα του κεφαλαίου αναλύεται η διαδικασία ψηφιοποίησης ήχου μέσω της δειγματοληψίας 
και εξηγείται ο τρόπος υπολογισμού του μεγέθους των αρχείων ήχου. Αναλύονται, επίσης, ειδικά θέματα, όπως 
οι τεχνικές κωδικοποίησης, τα χαρακτηριστικά των CD και DVD ήχου, η αλλαγή ρυθμού δειγματοληψίας, η πε-
ριβάλλουσα έντασης ήχου και οι γλώσσες προγραμματισμού ήχου. Στη συνέχεια, παρουσιάζονται τα χαρακτηρι-
στικών των δημοφιλών μορφών αποθήκευσης αρχείων ήχου (WAV, MP3, AIFF κ.α.) και το λογισμικό για εγ-
γραφή και επεξεργασία ψηφιακού ήχου. Η τέταρτη ενότητα του κεφαλαίου εισάγει τον αναγνώστη στην ψηφιακή 
μουσική και πιο συγκεκριμένα στα πρότυπα MIDI, MusicXML και XMF και στο λογισμικό επεξεργασίας του 
μουσικού κειμένου. Η τελευταία ενότητα παρουσιάζει τα χαρακτηριστικά των μικροφώνων, της κάρτας ήχου και 
των ηχείων, δηλαδή του υλικού που αφορά την ψηφιοποίηση, επεξεργασία και αναπαραγωγή ήχου. 

 
Προαπαιτούμενη γνώση 
Το τρέχον αποτελεί αυτόνομη ενότητα και δεν υπάρχουν προαπαιτούμενες ενότητες. Βασικές δεξιότητες ψηφια-
κής τεχνολογίας, όπως η κατανόηση του δυαδικού συστήματος, των μονάδων μέτρησης του μεγέθους ψηφιακών 
αρχείων και η χρήση λογισμικού είναι τα προαπαιτούμενα που πρέπει να γνωρίζει ο εκπαιδευόμενος. 

 

3.1. Εισαγωγή 
 
Ο ήχος (sound) χρησιμοποιείται σε όλες τις εφαρμογές πολυμέσων με διαφόρους τρόπους. Αρχικά χρησιμο-
ποιείται για την αφήγηση των πληροφοριών σχετικά με τα παρουσιαζόμενα θέματα, ως εναλλακτικό μέσο του 
κειμένου και της εικόνας. Για παράδειγμα, αν θέλουμε να παρουσιάζουμε τον τρόπο λειτουργίας ενός λογι-
σμικού, μπορούμε να έχουμε γραπτές οδηγίες ή να εμφανίζουμε στατικές εικόνες ή να παραθέτουμε αποσπά-
σματα βίντεο με επίδειξη των λειτουργιών του, που θα περιέχουν και ηχητικές πληροφορίες ή να έχουμε μόνο 
ηχητικές πληροφορίες ή οποιοδήποτε συνδυασμό των επιλογών αυτών. Επιπρόσθετα, ο ήχος μπορεί να χρη-
σιμοποιηθεί με τη μορφή μουσικής παρασκηνίου κατά την παρουσίαση ενός θέματος, για να προσθέσει έναν 
ευχάριστο μουσικό τόνο, καθιστώντας τη χρήση της εφαρμογής πιο ενδιαφέρουσα. Τέλος, ο ήχος μπορεί να 
υπάρχει σε μια εφαρμογή για τη σήμανση συγκεκριμένων λειτουργιών, π.χ. όταν γίνεται μια λάθος επιλογή να 
ακούγεται ένας βραχύς και κάπως έντονος ήχος. Γενικά, η ύπαρξη ηχητικών εφέ προσδίδει ρεαλισμό στις ε-
φαρμογές και βοηθά στην εξοικείωση του χρήστη με το πρόγραμμα, αλλά μπορεί να βοηθήσει και ειδικές 
κατηγορίες χρηστών. Ο ψηφιακός ήχος που συναντούμε στους υπολογιστές είναι δύο μορφών: 

 
 ο ήχος κυματομορφών ή ψηφιακός (wave ή digital audio), και  
 ο ήχος σε μορφή μουσικής, αποθηκευμένος με το πρότυπο Midi. 

 
Με την πρώτη μορφή, μπορούμε να αποθηκεύσουμε ήχο που έχει προέλθει από εγγραφή, π.χ. ανθρώ-

πινη ομιλία, μουσική, ήχους περιβάλλοντος, με χρήση ενός ή περισσοτέρων μικροφώνων. Ο ήχος αποθηκεύε-
ται ως ένα σύνολο διακριτών ηχητικών δειγμάτων. Στα αρχεία Midi, ο ήχος αποθηκεύεται ως μουσική που 
έχει δημιουργηθεί από μουσικά όργανα και έχει εισαχθεί στον υπολογιστή. Για παράδειγμα, αποθηκεύεται 
πληροφορία για τη μουσική νότα, το όργανο που την παρήγαγε, την ένταση και τον χρόνο που έμεινε πατημέ-
νο το πλήκτρο που παρήγαγε τη νότα. Επίσης, καταγράφονται και πληροφορίες ειδικών εφέ για κάθε νότα. 
Να αναφέρουμε εδώ, ότι στα Αγγλικά ο όρος “sound” χρησιμοποιείται για τον ήχο που ακούμε ή παράγεται 
από κάποια φυσική πηγή (π.χ. ανθρώπινη ομιλία, θρόισμα αέρα, ένα αντικείμενο που πέφτει, το κελάηδισμα 
πουλιών κ.α.), ενώ ο όρος “audio” είναι πιο τεχνικός όρος και αναφέρεται σε ήχο που προέρχεται από εγγρα-
φή ή μετάδοση μέσω ηλεκτρονικής συσκευής. 
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3.2. Ο ήχος ως φυσικό μέγεθος 
 
Ο ήχος είναι ένα κύμα και μεταδίδεται σε κάποιο μέσο, όπως ο αέρας, το νερό κ.λπ. Δημιουργείται από δο-
νούμενα αντικείμενα, όπως για παράδειγμα οι φωνητικές χορδές των ανθρώπων ή από κάποιο μουσικό όργα-
νο. O ήχος παράγεται από μια ταχεία μεταβολή στη μέση πυκνότητα ή την πίεση των μορίων του αέρα πάνω 
και κάτω από την τρέχουσα ατμοσφαιρική πίεση. Οι μικρές αλλαγές στην ατμοσφαιρική πίεση αναφέρονται 
ως πίεση ήχου (sound pressure) και οι διακυμάνσεις της πίεσης ως ηχητικά κύματα (sound waves).  

Απλουστεύοντας την περιγραφή της διαδικασίας, μπορεί να ειπωθεί ότι η δόνηση ενός σώματος δη-
μιουργεί κίνηση των μορίων του αέρα που βρίσκονται κοντά στο δονούμενο σώμα. Έπειτα, αυτά τα μόρια 
πιέζουν τα μόρια του αέρα που βρίσκονται πιο μπροστά κ.ο.κ. και έτσι τελικά μεταδίδεται η κίνηση, δηλ. το 
ηχητικό κύμα (Εικόνα 3.1). Όταν η πίεση των μορίων του αέρα φτάσει στο τύμπανο του αυτιού (ή σε κάποια 
συσκευή, όπως το μικρόφωνο), τότε το τύμπανο πάλλεται μετατρέποντας την μηχανική ενέργεια της κίνησης 
σε ηλεκτρική ενέργεια που μεταδίδεται στον εγκέφαλο για περαιτέρω επεξεργασία. Στην πράξη, σε όλη αυτή 
τη διαδικασία δεν υπάρχει κίνηση σωματιδίων, αλλά μετάδοση κινητικής ενέργειας των σωματιδίων που τα-
λαντώνονται που τελικά φθάνει στο αισθητήριο όργανό μας. 

Κατά τη διαδικασία της δημιουργίας του ήχου, όσο μεγαλύτερη είναι η ένταση της αρχικής ομιλίας ή 
πιο έντονη η πίεση της χορδής, αν πρόκειται για μουσική από έγχορδο, τόσο πιο μεγάλη πίεση δημιουργείται 
στα μόρια του αέρα και τελικά στο τύμπανο του ανθρώπινου αυτιού. Έτσι, η ένταση του ήχου που αντιλαμ-
βανόμαστε είναι αυξημένη. 

 

 
 
Εικόνα 3.1 Μεταφορά του ήχου μέσω των μορίων του αέρα. 

 
Το ηχητικό σήμα, δηλαδή η ταλάντωση των μορίων του αέρα, αναπαρίσταται γραφικά ως μια αρμο-

νική ημιτονοειδής καμπύλη (Εικόνα 3.2) και ονομάζεται κυματομορφή (waveform). Η κυματομορφή παρι-
στάνει τη μετατόπιση των μορίων του αέρα, που δημιουργείται λόγω της πίεσης, σε συνάρτηση με το χρόνο. 
Τα μόρια ταλαντεύονται προς μία κατεύθυνση και επιστρέφουν στη θέση ισορροπίας. Κατόπιν, συνεχίζουν 
παρόμοια κίνηση προς την αντίθετη κατεύθυνση και επανέρχονται στη θέση ισορροπίας. Έτσι, δημιουργείται 
η ημιτονοειδής αναπαράσταση του ήχου.  
 
 

 
 

Εικόνα 3.2 Γραφική αναπαράσταση του ήχου ως ημιτονοειδή καμπύλη. 
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Πρέπει να αναφέρουμε ότι η Εικόνα 3.2 δεν απεικονίζει την ακριβή μορφή ενός φυσικού ήχου, αλλά 
μια μεμονωμένη συχνότητα του ήχου. Γενικά, μέσα από αυτή την απλουστευμένη αναπαράσταση θέλουμε να 
δείξουμε ότι οι ήχοι μπορούν να αναλυθούν σε ημιτονοειδείς. 

Κάθε ήχος έχει ένα σύνολο από χαρακτηριστικά, κάποια εκ των οποίων εξαρτώνται από την υποκει-
μενική αντίληψη των ανθρώπων, ενώ κάποια είναι ανεξάρτητα αυτής. Έτσι, τα χαρακτηριστικά χωρίζονται σε 
αντικειμενικά και υποκειμενικά. Στα αντικειμενικά χαρακτηριστικά κατατάσσονται η συχνότητα και η ένταση, 
ενώ στη δεύτερη κατηγορία ανήκουν η ακουστικότητα, το ύψος και η χροιά. 
 

3.2.1. Συχνότητα 
 
Η συχνότητα (frequency), με βάση την επιστήμη της Φυσικής, είναι ο αριθμός των κυμάτων που δημιουρ-
γούνται από το σώμα που δονείται ανά δευτερόλεπτο. Ορίζεται σε Hertz (Hz), δηλαδή κύκλους σήματος ανά 
δευτερόλεπτο. Στην πράξη, 100Hz σημαίνει ότι το αυτί μας δέχεται 100 κύματα (συνεχόμενες πιέσεις των 
μορίων του αέρα) ανά δευτερόλεπτο. Μεγαλύτερη συχνότητα σημαίνει περισσότεροι κύκλοι ανά δευτερόλε-
πτο. Για παράδειγμα, στην Εικόνα 3.3 απεικονίζονται οι κυματομορφές δύο ήχων. Θεωρώντας ότι το χρονικό 
διάστημα και στις δύο περιπτώσεις είναι 1 δευτερόλεπτο, ο πρώτος ήχος έχει συχνότητα 2Hz και ο δεύτερος 
4Hz. 

Το ανθρώπινο αυτί μπορεί να αντιληφθεί ήχους από 20Hz ως περίπου 20KHz. Οι ήχοι με συχνότητα 
μικρότερη των 15Hz ονομάζονται υπόηχοι (infrasounds), ενώ ήχοι άνω των 20ΚHz καλούνται υπέρηχοι 
(ultrasounds). Κάποια ζώα είναι ικανά να ακούσουν ένα φάσμα υποήχων, ενώ οι υπέρηχοι μπορούν να ληφ-
θούν με ειδικά μηχανήματα και έχουν εφαρμογή στην ιατρική, αλλά και άλλες επιστήμες. 
 

 
 
Εικόνα 3.3 Αναπαράσταση ήχων διαφορετικής συχνότητας. 

 

3.2.2. Ένταση 
 
Η ένταση (amplitude) καθορίζει πόσο δυνατά ακούγεται ένας ήχος. Η απόσταση του μέγιστου σημείου μιας 
κυματομορφής ήχου από τη μέση τιμή του, ονομάζεται πλάτος (Εικόνα 3.4). Μεγαλύτερο πλάτος σημαίνει 
μεγαλύτερη ένταση ήχου. Η ένταση μπορεί να αυξηθεί μέσω των εργαλείων επεξεργασίας ήχου και οι αλλα-
γές αποτυπώνονται στις κυματομορφές τους (Εικόνα 3.5). 
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Εικόνα 3.4 Πλάτος κυματομορφής. 
 

 
 
Εικόνα 3.5 Κυματομορφές του ίδιου ήχου με διαφορετική ένταση. 

 
Ως φυσικό μέγεθος, η ένταση αφορά τη δύναμη του ηχητικού κύματος και εκφράζεται σε Watt/m2. 

Για λόγους απλότητας και συσχέτισης με την ανθρώπινη αντίληψη χρησιμοποιείται η μονάδα decibel (db). Το 
μέτρο και η ονομασία του έχει τις ρίζες του στη μονάδα μέτρησης bel, που ονομάστηκε έτσι προς τιμήν του 
Alexander Graham Bell. Είναι μια λογαριθμική μονάδα μέτρησης και ουσιαστικά μετρά το λόγο μεταξύ της 
δύναμης δύο κυμάτων. Ορίζεται, όπως στην ακόλουθη εξίσωση: 

 

0

10log10
P

P
 , όπου P η (μέση) τιμή ισχύος του μετρούμενου ήχου και Po η ισχύς του ήχου αναφοράς. 

 
Θεωρώντας ότι στην περίπτωση «ησυχίας», δηλαδή απουσίας θορύβου, η δύναμη του κύματος είναι 

πάρα πολύ μικρή και χρησιμοποιώντας αυτή τη δύναμη ως το κύμα αναφοράς W2, προκύπτει ότι η ησυχία 
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αντιστοιχεί σε 0 db. Διπλασιασμός της έντασης ενός ήχου σημαίνει αύξηση κατά περίπου 3 db. Στην Εικόνα 
3.5, ο δεύτερος ήχος προέκυψε από τον πρώτο ήχο, αυξάνοντας την ένταση κατά 6 περίπου db. Δηλαδή, τε-
τραπλασιάστηκε η έντασή του. Γενικότερα, ένας ήχος 10 φορές πιο ισχυρός από την απόλυτη σιγή αντιστοι-
χεί σε ένταση 10 db, ενώ ένας ήχος 100 φορές πιο ισχυρός έχει ένταση 20 db. Ήχοι με ένταση πάνω από 130 
db ξεπερνούν το όριο του πόνου, καθώς η δύναμη του κύματος είναι μεγάλη. Ο ήχος της κανονικής αναπνοής 
είναι περίπου 10 db. 

 

3.2.3. Ακουστικότητα 
 
Η ακουστικότητα ή ακουστότητα (loudness) είναι η υποκειμενική ένταση του ήχου, που εξαρτάται από την 
ακουστική ικανότητα του ακροατή, τη διάρκεια του ήχου και τη συχνότητα. Για παράδειγμα, ήχος 60 db δεν 
γίνεται αντιληπτός με την ίδια ένταση από διαφορετικούς ανθρώπους. Επίσης, δύο ήχοι 60 db δεν θεωρού-
νται, τελικά, ίδιας έντασης ακόμη και από τον ίδιο ακροατή. Ένας ήχος 1 KHz, 70 dB θεωρείται πιο ισχυρός 
από ότι ένας ήχος 200Hz, 70 dB. 

Μια από τις μονάδες μέτρησης που χρησιμοποιείται για την ακουστικότητα ονομάζεται Phon και εί-
ναι ανάλογη της έντασης του ήχου, αλλά και της συχνότητάς του. Θεωρώντας ότι ο ήχος έχει συχνότητα 
1000Hz, τότε ο αριθμός των decibel ισούται με τον αριθμό των Phon. Η μονάδα μέτρησης Phon θεωρείται 
πλέον παρωχημένη και στη θέση της χρησιμοποιείται το μέτρο Α-στάθμισης (A-weighting) decibel (dBA ή 
db(A)). Γενικότερα, οι μονάδες ακουστικότητας χρησιμοποιούνται ώστε να συνάδουν με την αντίληψη των 
ανθρώπων για την ένταση του ήχου και όχι την ένταση του κύματος που περιγράφηκε στην προηγούμενη ε-
νότητα. 

 

3.2.4. Ύψος 
 
Το ύψος (pitch) είναι ένα υποκειμενικό χαρακτηριστικό που μας επιτρέπει να διακρίνουμε τους ήχους σε ο-
ξείς (μεγάλης συχνότητας), μέσους (μεσαίας συχνότητας) και σε βαρείς (μικρής συχνότητας). Αφορά τον τρό-
πο με τον οποίο αντιλαμβανόμαστε τη συχνότητα. Οι βαρείς ή βαθείς ήχοι είναι τα μπάσα (bass) και παράγο-
νται από όργανα όπως το τύμπανο, ενώ οι οξείς ήχοι είναι τα πρίμα (tremble) και παράγονται από το φλάουτο 
και το βιολί. Με διαφορετικά λόγια, αν και δύο όργανα ή υλικά μπορούν να παράγουν ήχους παρόμοιας συ-
χνότητας, ακούγονται διαφορετικά, δηλαδή έχουν διαφορετικό ύψος. 

Η αλλαγή ύψους στην περίπτωση παραγωγής ήχου γίνεται, για παράδειγμα, με μεταβολή του μήκους 
του υλικού που ταλαντώνεται ή μεταβολή του πάχους του υλικού που παράγει τον ήχο. Το ύψος μεταβάλλε-
ται μη γραμμικά με τη συχνότητα, δηλαδή ίσες μεταβολές στη συχνότητα δεν προκαλούν ίδιες μεταβολές 
στην «αίσθηση» του ύψους. Επίσης, αν αυξηθεί η ένταση του ήχου το ύψος μπορεί, ανάλογα με τη συχνότη-
τα, να γίνει πιο μεγάλο ή πιο μικρό. Δηλαδή, να δίνεται η αίσθηση είτε οξύ ήχου είτε βαρύ ήχου. Η μονάδα 
μέτρησης του ύψους είναι η Mel (παράγεται από το Melody). Γενικότερα, η αντίληψη του ύψους και της δια-
φοράς ύψους μεταξύ δύο ήχων είναι αποτέλεσμα πολλών παραγόντων και ιδιαίτερα της μουσικής εκπαίδευ-
σης του ακροατή. Για την αντίληψη του ύψους έχει οριστεί και το μέγεθος JND (Just Noticeable Difference) 
και αποδίδεται ως η μόλις ακουστή διαφορά του ύψους. Αφορά την αντίληψη της αλλαγής στο ύψος μεταξύ 
δύο διαδοχικών μουσικών τόνων που αναπαράγονται πολύ γρήγορα. 

 

3.2.5. Χροιά 
 
Η χροιά ή ηχόχρωμα (timbre) είναι το υποκειμενικό χαρακτηριστικό που μας επιτρέπει να ξεχωρίσουμε δύο 
ήχους που έχουν ίδιο ύψος και ένταση. Αφορά τους σύνθετους ήχους που έχουν ίδια συχνότητα, αλλά διαφο-
ρετικές υποσυχνότητες που ονομάζονται αρμονικές. Οι αρμονικές είναι υποσυχνότητες, πολλαπλάσιες μιας 
βασικής συχνότητας. Οι αρμονικές, μαζί με αυτή τη βασική συχνότητα, συνθέτουν την τελική συχνότητα του 
ήχου. Έτσι, για παράδειγμα, η νότα Λα ακούγεται με διαφορετική χροιά σε διαφορετικά όργανα, διότι, αν και 
η βασική συχνότητα της νότας είναι ίδια, διαφέρουν οι αρμονικές της σε κάθε όργανο. 

 

3.3. Ψηφιακός ήχος 
 
Το ηχητικό σήμα είναι αναλογικό, δηλαδή σε κάθε χρονική στιγμή υπάρχει διαφορετική ένταση. Για να ανα-
παρασταθεί στους υπολογιστές πρέπει να περάσει από τη φάση της ψηφιοποίησης, όπου το αναλογικό σήμα 
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μετατρέπεται σε ψηφιακό. Έπειτα, με χρήση λογισμικού επεξεργασίας ήχου μπορεί να επεξεργαστεί περαιτέ-
ρω. Η ψηφιοποίηση, οι μορφές αποθήκευσης, η κωδικοποίηση και η συμπίεση, αλλά και το λογισμικό επε-
ξεργασίας ήχου θα μας απασχολήσει στις ακόλουθες ενότητες. Εκτός από τον ψηφιοποιημένο ήχο κυματο-
μορφών που μπορεί να αναπαραστήσει οποιοδήποτε ήχο (π.χ. ήχοι περιβάλλοντος, ομιλία, μουσική), υπάρχει 
και η δυνατότητα απευθείας δημιουργίας μουσικών συνθέσεων και κωδικοποίησης του στο πρότυπο MIDI ή 
στο πρότυπο MusicXML. Η δεύτερη κατηγορία ηχητικών δεδομένων θα παρουσιαστεί στην ενότητα 5.3. 
 

3.3.1. Ψηφιοποίηση 
 
Η ψηφιοποίηση (digitization) είναι η διαδικασία μετατροπής του αναλογικού σήματος σε ψηφιακή μορφή 
και περιλαμβάνει τη φάση της δειγματοληψίας (sampling) και τη φάση της κβάντισης (quantization). Το 
αναλογικό ηχητικό σήμα μπορεί να είναι ομιλία, ήχοι περιβάλλοντος, μουσική από μια χορωδία κ.ά. Η διαδι-
κασία της ψηφιοποίησης και κβάντισης απαιτεί την ύπαρξη ενός τουλάχιστον μικροφώνου και μίας κάρτας 
ήχου. Η λειτουργία των συγκεκριμένων εξαρτημάτων θα εξεταστεί στις τελευταίες ενότητες του κεφαλαίου. 
 
3.3.1.1. Δειγματοληψία 
 
Κατά τη δειγματοληψία λαμβάνονται δείγματα (samples) από το αναλογικό σήμα, τα οποία θα αναπαραστα-
θούν τελικά με ψηφιακές τιμές. Για παράδειγμα, στην Εικόνα 3.6 εμφανίζεται η κυματομορφή ενός αναλογι-
κού σήματος. Υποθέτουμε ότι η συνολική διάρκεια του σήματος είναι 1 δευτερόλεπτο (sec). Στην Εικόνα 3.7, 
έχουν ληφθεί 27 δείγματα διακριτού χρόνου (επισημαίνονται με τους μικρούς κύκλους) από το αρχικό αναλο-
γικό σήμα. Αυτά τα δείγματα ήχου αντιπροσωπεύουν τελικά το ψηφιακό σήμα. 

Ο αριθμός λήψης δειγμάτων ανά δευτερόλεπτο ονομάζεται ρυθμός ή συχνότητα δειγματοληψίας 
(sampling rate). Καθώς πρόκειται για συχνότητα, εκφράζεται σε Hz (δείγματα/δευτερόλεπτο). Στο πιο πάνω 
παράδειγμα, ο ρυθμός δειγματοληψίας είναι 27Hz, εφόσον υποθέσαμε ότι η χρονική διάρκεια του ήχου είναι 
1 sec.  

 

 
 
Εικόνα 3.6 Κυματομορφή ενός αναλογικού σήματος. 

 

 
 
Εικόνα 3.7 Λήψη δειγμάτων από το αναλογικό σήμα. 
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Ο ρυθμός δειγματοληψίας επηρεάζει σε μεγάλο βαθμό την ποιότητα του ψηφιακού ήχου, διότι αν λά-
βουμε λίγα δείγματα, όπως στην περίπτωση της Εικόνας 3.7, τότε η ψηφιακή αναπαράσταση του ήχου δεν θα 
είναι ποιοτική. Συνήθως, λαμβάνονται χιλιάδες δείγματα ανά δευτερόλεπτο, π.χ. 44100, όποτε ο ρυθμός δειγ-
ματοληψίας εκφράζεται σε KHz, π.χ. 44,1 KHz (44100Hz). Μεγαλύτερη συχνότητα δειγματοληψίας οδηγεί 
όμως σε μεγαλύτερο μέγεθος ψηφιακού αρχείου. Τυπικές τιμές για το ρυθμό δειγματοληψίας είναι 11025Hz, 
22050Hz, 44100Hz και 48100Hz. 

Κατά τη διαδικασία δειγματοληψίας, λόγω χαμηλής συχνότητας δειγματοληψίας, η ποιότητα του ή-
χου ίσως να μην είναι υψηλή. Έτσι, έχει διατυπωθεί το πιο κάτω θεώρημα, που είναι γνωστό ως θεώρημα 
Nyquist, για τη βελτίωση της ποιότητας του ψηφιοποιημένου ήχου.  
 
 Θεώρημα Nyquist 
Η μέγιστη συχνότητα δειγματοληψίας πρέπει να είναι τουλάχιστον διπλάσια από τη μέγιστη συχνότητα του αναλογικού 
σήματος στο οποίο γίνεται δειγματοληψία. 

 
Πίνακας 3.1 Θεώρημα Nyquist. 

 
Για παράδειγμα, αν η μέγιστη συχνότητα του αναλογικού συστήματος είναι 10 KHz, η συχνότητα 

δειγματοληψίας πρέπει να είναι τουλάχιστον 20 KHz. Οι ήχοι που συνήθως ακούμε, έχουν χαμηλότερη μέγι-
στη συχνότητα, άρα απαιτείται και χαμηλότερος ρυθμός δειγματοληψίας. Με δεδομένο ότι οι άνθρωποι μπο-
ρούν να ακούσουν ήχους με συχνότητα μέχρι και 20KHz, προκύπτει ότι η συχνότητα δειγματοληψίας 40 KHz 
θα ήταν επαρκής για όλους τους ήχους. Στην περίπτωση της τηλεφωνίας, αφού οι συχνότητες της φωνής δεν 
ξεπερνούν τα 4 KHz, χρησιμοποιείται συχνότητα δειγματοληψίας 8 KHz. Βέβαια, το Θεώρημα Nyquist κα-
θορίζει ένα θεωρητικό όριο και συνεπώς, μεγαλύτερες συχνότητες δειγματοληψίας, πιθανώς να βοηθούν στην 
πιστότερη μετατροπή του σήματος από αναλογικό σε ψηφιακό, αλλά και τη μετέπειτα μετατροπή του ξανά σε 
αναλογικό σήμα για αναπαραγωγή από τα ηχεία. 

 

3.3.1.2. Κβάντιση 
 
Όπως και στην περίπτωση της εικόνας, κάθε δείγμα του ήχου θα αναπαρασταθεί τελικά ως ένας δυαδικός α-
ριθμός. Στη διαδικασία της κβάντισης, τα δείγματα μεταβάλλονται, ώστε να λαμβάνουν τιμές από ένα προκα-
θορισμένο σύνολο διακριτών τιμών. Για παράδειγμα, αν επιβάλλεται να χρησιμοποιήσουμε μόνο 4 δυαδικούς 
αριθμούς, τότε όλα τα δείγματα θα αναπαρασταθούν με χρήση δεκαέξι σταθμών έντασης. Φυσικά, οι 4 αριθ-
μοί θα επαναλαμβάνονται για να περιγράψουν όλα τα δείγματα, αλλά οι διαφορετικές στάθμες έντασης θα 
είναι τελικά μόνο 16.  

Ο αριθμός των δυνατών σταθμών έντασης εξαρτάται από το μέγεθος δείγματος (sample size ή bit 
depth), που αποκαλείται πολλές φορές και ανάλυση (resolution). Tο μέγεθος δείγματος είναι ο αριθμός των 
bits που χρησιμοποιούνται για την κωδικοποίηση κάθε δείγματος και είναι σταθερός. Αν το μέγεθος δείγμα-
τος είναι n, δηλαδή χρησιμοποιούνται n bits για κάθε δείγμα, τότε μπορούν να κωδικοποιηθούν 2n στάθμες 
έντασης. Με μέγεθος δείγματος 1 bit, μπορούμε να έχουμε 2 στάθμες έντασης και συνεπώς, μικρή ποιότητα, 
έστω και αν ο ρυθμός δειγματοληψίας είναι μεγάλος. Αν το μέγεθος είναι 8 bit, μπορούμε να έχουμε 28 = 256 
στάθμες έντασης. Με μέγεθος δείγματος 16 bit, μπορούμε να έχουμε 216 = 65536 στάθμες έντασης. 

Ο συνολικός αριθμός δειγμάτων εξαρτάται από το ρυθμό δειγματοληψίας. Άρα, μεγαλύτερος ρυθμός 
δειγματοληψίας σημαίνει περισσότερα δείγματα από το αρχικό αναλογικό σήμα. Όμως, για να έχουμε καλή 
ποιότητα, απαιτείται και μεγάλο μέγεθος δείγματος, ώστε να μπορούμε να προσεγγίσουμε σωστά, στην κα-
τάλληλη στάθμη έντασης, το κάθε δείγμα. 

 

3.3.2. Κανάλια ήχου 
 
Οι ήχοι, ανάλογα με τον αριθμό των πηγών εγγραφής χωρίζονται σε μονοφωνικούς, στερεοφωνικούς ή πο-
λυφωνικούς. Παλαιότερα, οι ηχογραφήσεις γινόταν με χρήση ενός μικροφώνου που λάμβανε ήχο από όλες 
τις πηγές (π.χ. τραγουδιστή και μουσικά όργανα) και δημιουργούσε ένα ψηφιακό σήμα του ήχου που λαμβά-
νονταν. Δηλαδή, όπως αναφέρεται, υπήρχε ένα κανάλι ήχου και ο ήχος ονομάζονταν μονοφωνικός 
(monophonic ή mono). 

Ο στερεοφωνικός (stereophonic ή stereo) ήχος αποτελείται από δύο διαφορετικά κανάλια μεταφοράς 
του σήματος, το αριστερό και το δεξί. Τα κανάλια αυτά μεταφέρουν διαφορετική πληροφορία για τον ίδιο 



82 
 

ήχο, διότι για τη δημιουργία στερεοφωνικού ήχου απαιτείται η ηχογράφηση από δύο διαφορετικά σημεία η-
χογράφησης. Η αναπαραγωγή του ήχου γίνεται από δύο ηχεία και έτσι τελικά ακούγεται διαφορετικός ήχος 
από το αριστερό και δεξί ηχείο. 

To Dolby Surround (αποδίδεται ως περιβάλλων ήχος) αποτέλεσε την εξέλιξη του στερεοφωνικού 
ήχου. Σε αυτό, το αναλογικό σύστημα, έχουν προστεθεί δύο επιπλέον κανάλια ήχου, έτσι ώστε συνολικά να 
γίνουν 4. Τα διαφορετικά κανάλια διαχέονται μέσω ηχείων στο χώρο γύρω από τους θεατές μιας ταινίας, έτσι 
ώστε να τους δίνεται η εντύπωση πως βρίσκονται στο σημείο δράσης της ταινίας. Για τη σωστή αναπαραγωγή 
του ήχου, απαιτούνται 4 ηχεία. Τα δύο τοποθετούνται μπροστά από τον ακροατή και το άλλο ζεύγος ηχείων 
είναι τοποθετημένα στο πίσω και πλαϊνό τμήμα του χώρου όπου βρίσκεται ο ακροατής. 

Το σύστημα 5.1 είναι το όνομα για το σύστημα πολυκάναλου ήχου που αποτελείται από 5 κανάλια 
πλήρους εύρους συχνοτήτων και ένα κανάλι χαμηλών συχνοτήτων. Το x.1 αναφέρεται στο subwoofer (υπο-
γούφερ) που αναλαμβάνει τις χαμηλές συχνότητες ή μπάσα. Για τη σωστή αναπαραγωγή του ήχου απαιτού-
νται 3 μπροστινά ηχεία (αριστερά – κέντρο – δεξιά), 2 ηχεία στο πίσω μέρος (αριστερά – δεξιά) και το 
subwoofer (Εικόνα 3.8). Στο σύστημα 7.1 υπάρχουν συνολικά 8 κανάλια και τελικά τοποθετούνται 8 ηχεία 
γύρω από τον ακροατή.  

Το σύστημα 5.1 αναφέρεται και ως Dolby Digital ή AC3. Γενικότερα, οι τεχνολογίες Dolby Digital 
Pro Logic, Dolby Digital Live, Dolby Digital Plus και άλλες παρόμοιες τεχνολογίες αφορούν πολυκάναλο 
ήχο, 5.1 ή 7.1 και παρέχουν διάφορες δυνατότητες αναπαραγωγής, ανάλογα με την ποιότητα και τον αριθμό 
των ηχείων. Οι τεχνολογίες αυτές υποστηρίζονται μέσω των καρτών ήχου. Οι βασικές εταιρείες που δραστη-
ριοποιούνται στον τομέα της ανάπτυξης τεχνολογιών πολυκάναλου ήχου και γενικότερα προϊόντων ψηφιακού 
ήχου υπολογιστών είναι η Dolby και η DTS (Digital Theater Systems). 

Η DTS έχει δημιουργήσει τον κωδικοποιητή DTS-HD Master Audio που προσφέρει δυνατότητα απω-
λεστικής και μη απωλεστικής συμπίεσης, για χρήση με δίσκους Blu-Ray. Υποστηρίζει ρυθμό δειγματοληψίας 96 
ΚHz με μέγεθος δείγματος 24bit για πολυκάναλο ήχου 7.1. Αντίστοιχα το Dolby TrueHD είναι ένα μη απω-
λεστικό φορμά ήχου  που αναπτύχθηκε από την Dolby. Αποτελεί διάδοχο του συστήματος AC3 και υποστη-
ρίζει 8 κανάλια (σύστημα 7.1) ήχου, με μέγιστο ρυθμό δειγματοληψίας 96 ΚHz στα 24 bit ανά δείγμα. 

 

 
 
Εικόνα 3.8 Κατανομή ηχείων στο σύστημα ήχου 5.1. 

 

3.3.3. Μέγεθος αρχείων ασυμπίεστου ήχου 
 
Το μέγεθος ενός ασυμπίεστου ψηφιακού αρχείου ήχου κυματομορφών εξαρτάται κατά κύριο λόγο από τον 
αριθμό των δειγμάτων στη μονάδα του χρόνου και τον αριθμό των δυαδικών ψηφίων που χρησιμοποιούνται 
για την αποθήκευση των δειγμάτων. Με άλλα λόγια, εξαρτάται κυρίως από τον ρυθμό δειγματοληψίας και το 
μέγεθος (ανάλυση) δείγματος. Ο αριθμός καναλιών και η χρονική διάρκεια είναι, επίσης, παράγοντες που κα-
θορίζουν το τελικό μέγεθος του ασυμπίεστου ήχου. Ο τύπος υπολογισμού του μεγέθους σε bits δίνεται στον 
Πίνακα 3.2. 
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αριθμός καναλιών  ρυθμός δειγματοληψίας (Hz)  μέγεθος δείγματος (bits)  διάρκεια (sec) 

 
Πίνακας 3.2 Υπολογισμός μεγέθους σε bits ασυμπίεστου ήχου. 

 
Για στερεοφωνικό αρχείο ήχου (2 κανάλια), διάρκειας 1 λεπτού (60 sec), με ρυθμό δειγματοληψίας 

22050Hz και μέγεθος δείγματος 16 bit ο τύπος γίνεται: 
 

2  22050  16  60 = 42.336.000 bit 
 

Διαιρώντας το αποτέλεσμα διά 8, έχουμε μέγεθος ήχου 5.292.000 bytes. Περαιτέρω διαίρεση δια 
1.024, μετατρέπει το μέγεθος σε περίπου 5.168 ΚΒ. Με διαίρεση του 5.168 με το 1.024, μετατρέπεται το μέ-
γεθος σε MB και ισούται με περίπου 5 ΜΒ. Με διπλάσιο ρυθμό δειγματοληψίας, ο ήχος του 1 λεπτού θα έχει 
μέγεθος περίπου 10 ΜΒ. 

Με το παράδειγμα, γίνεται αντιληπτό ότι ασυμπίεστος ήχος διάρκειας ακόμη και 1 λεπτού έχει μέγε-
θος αρκετά MBs που για τη μετάδοση μέσω του διαδικτύου είναι απαγορευτικό. Παραδείγματος χάριν, έστω 
ότι η ταχύτητα μεταφοράς πληροφορίας από κάποια διαδικτυακή διεύθυνση είναι 2 Mbps (Mega bits per 
second), δηλαδή 2.000.000 bits/sec. Για τη μεταφορά των 42.336.000 bit του αρχικού αποτελέσματος απαι-
τούνται περίπου 21 (≈42.336.000/2.000.000) δευτερόλεπτα. Δηλαδή, απαιτούνται 21 δευτερόλεπτα για ήχο 
διάρκειας μόνο 1 λεπτού. Γι’ αυτό τον λόγο, έχουν εμφανιστεί διάφορες μορφές κωδικοποίησης των δειγμά-
των ήχου που επιτρέπουν τη συμπίεση του ήχου. 

 

3.3.4. Ρυθμός μετάδοσης 
 
Ο ρυθμός μετάδοσης ή μεταφοράς (bit rate) είναι ο ρυθμός επεξεργασίας ή μεταφοράς πληροφορίας από ένα 
μέσο. Εκφράζεται σε bits/sec και συντομογραφικά αναφέρεται ως bps. Ο αριθμός αυτός είναι σημαντικός, 
ιδιαίτερα στον ήχο, αλλά και στο βίντεο, όπου έχουμε συνεχή και δυναμική ροής πληροφορίας, διότι, αν ο 
ρυθμός μεταφοράς είναι μικρός, δεν μπορεί να γίνει σωστή αναπαραγωγή της πληροφορίας. 

Για παράδειγμα, όπως είδαμε πιο πάνω στο παράδειγμα του Πίνακα 3.2, ήχος διάρκειας 1 λεπτού έχει 
μέγεθος 42.336.000 bit. Για να μπορέσει να αναπαραχθεί σωστά ο ήχος, π.χ. μέσω διαδικτύου, απαιτείται 
ρυθμός μεταφοράς ίσος με 42.336.000 bit/60 sec = 705.600 bps = 705,6 Kbps ≈ 0,7 Mbps. Για τη μετατροπή 
ισχύει 1 Μbps = 106 bps και 1 Κbps = 103 bps. Δηλαδή, εδώ χρησιμοποιείται ο αριθμός 1000 για μετατροπή 
μεταξύ των μονάδων μέτρησης. 

Ο ρυθμός μεταφοράς δεδομένων μπορεί να είναι σταθερός (CBR – Constant Bit Rate) ή μεταβλητός 
(VBR – Variable Bit Rate). Στην περίπτωση του ήχου, σταθερός ρυθμός μεταφοράς σημαίνει ότι τα δεδομένα 
ήχου μεταδίδονται με σταθερό ρυθμό. Η CBR μέθοδος είναι χρήσιμη στην περίπτωση μεταφοράς δεδομένων 
μέσω καναλιών μειωμένης χωρητικότητας. Συνήθως, δίδεται η μέγιστη χωρητικότητα του καναλιού μεταφο-
ράς ως προτεινόμενος CBR ρυθμός. Ο μεταβλητός ρυθμός μεταφοράς VBR επιτρέπει μεγαλύτερους ρυθμούς 
σε περιπτώσεις πιο πολύπλοκων δεδομένων ενός αρχείου και μικρότερους ρυθμούς σε λιγότερο πολύπλοκα 
δεδομένα.  

Εκτός από το ρυθμό μεταφοράς bit ανά δευτερόλεπτο, υπάρχει και ο ρυθμός μεταφοράς συμβόλων 
ανά δευτερόλεπτο (baud rate) που αναφέρεται κυρίως στις τηλεπικοινωνίες. Το baud rate ταυτίζεται με το bit 
rate, μόνο στην περίπτωση που κάθε σύμβολο έχει κβαντιστεί σε ένα bit, δηλαδή, αν χρησιμοποιηθεί ένα bit 
για κάθε σύμβολο. 

 

3.3.5. Κωδικοποίηση και συμπίεση ήχου 
 
3.3.5.1. Τεχνικές κωδικοποίησης 
 
Οι τεχνικές κωδικοποίησης αφορούν στον τρόπο που αποθηκεύονται τα ψηφιακά δείγματα που ελήφθησαν 
κατά τη διαδικασία της δειγματοληψίας. Οι πιο περίπλοκες στοχεύουν στη συμπίεση των δεδομένων, ώστε να 
μειωθεί το μέγεθος του αρχείου που προκύπτει. Οι πιο γνωστές μέθοδοι κωδικοποίησης είναι οι PCM, DPCM 
και ADPCM. Άλλες μέθοδοι κωδικοποίησης του ηχητικού σήματος είναι οι Mu-Law PCM, A-Law PCM και 
η LPC (Linear Predictive Coding). 

 
 Η παλμοκωδική κωδικοποίηση PCM (Pulse Code Modulation) είναι η πιο απλή και πιο δι-

αδεδομένη μέθοδος κωδικοποίησης του ήχου. Στην κωδικοποίηση PCM τα δείγματα που 
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λαμβάνονται στρογγυλοποιούνται στην πλησιέστερη στάθμη έντασης και αποθηκεύονται όλα 
τα δείγματα κανονικά με όλα τα bits που περιέχουν. Δεν πραγματοποιεί συμπίεση και το αρ-
χείο ήχου έχει μεγάλο μέγεθος που δίνεται από τον τύπο που αναφέρθηκε στην προηγούμενη 
ενότητα. Η αναπαραγωγή των αρχείων ήχου γίνεται χωρίς απώλειες. Η ποιότητα του ήχου 
εξαρτάται από το ρυθμό δειγματοληψίας. 

 
 H διαφορική παλμοκωδική κωδικοποίηση DPCM (Differential Pulse Code Modulation) 

είναι μια μέθοδος όπου γίνεται δειγματοληψία του αναλογικού σήματος και πρόβλεψη μιας 
τιμής για το δείγμα. Έπειτα, αποθηκεύεται η διαφορά μεταξύ της πραγματικής τιμής και της 
τιμής που έχει προβλεφθεί και έτσι αποθηκεύονται λιγότερα δυαδικά ψηφία για το δείγμα. 
Με αυτό τον τρόπο επιτυγχάνεται συμπίεση του σήματος. 
 

 Η προσαρμοστική διαφορική παλμοκωδική κωδικοποίηση ADPCM (adaptive DPCM) 
είναι πιο αποτελεσματική μέθοδος από τις προηγούμενες και τελικά αποθηκεύει τα δείγματα 
χρησιμοποιώντας 4 bit για κάθε δείγμα, σε αντίθεση με την PCM που χρησιμοποιεί 8 ή 16 bit. 
Στην ADPCM, αντί να χρησιμοποιείται ένας σταθερός μηχανισμός πρόβλεψης, χρησιμοποιεί-
ται ένας δυναμικός μηχανισμός που προσαρμόζεται ανάλογα με τα χαρακτηριστικά του προς 
δειγματοληψία σήματος και έτσι επιτυγχάνεται μεγαλύτερη μείωση δεδομένων.  

 

3.3.5.2. Codecs 
 
Οι τεχνικές κωδικοποίησης της ηχητικής πληροφορίας υλοποιούνται με προγράμματα που μπορούν να προ-
στεθούν στον υπολογιστή και είναι γνωστοί ως codecs (κωδικοποιητές). Ο όρος codec προέρχεται από τις 
λέξεις Compression και Decompression ή πιο απλά Coder – Decoder. Ένας codec είναι λογισμικό που χρησι-
μοποιείται για να συμπιέσει ή να αποσυμπιέσει ένα ψηφιακό αρχείο, όπως για παράδειγμα ένα αρχείο ήχου. 

 

 
 
Εικόνα 3.9 Εφαρμογή κωδικοποίησης ήχου σε MP3. 
 

Η κωδικοποίηση των δεδομένων γίνεται με χρήση κατάλληλων εφαρμογών κωδικοποίησης, όπως για 
παράδειγμα το εργαλείο MP3 Encoder (Εικόνα 3.9). Έχοντας ως είσοδο κάποιο ψηφιακό ηχητικό σήμα, όπου 
τα δείγματα είναι κωδικοποιημένα συνήθως σε PCM, δημιουργούν ένα αντίγραφο του αρχικού ήχου σε άλλη 
κωδικοποίηση, με κύριο όφελος τη συμπίεση των δεδομένων. Έπειτα, στον υπολογιστή πρέπει να υπάρχουν 
οι αντίστοιχοι κωδικοποιητές, ώστε να μπορεί να γίνει αναπαραγωγή των αρχείων ήχου. 

Υπάρχουν διάφορες υλοποιήσεις των μεθόδων κωδικοποίησης από διάφορες εταιρείες έχοντας κά-
ποιες διαφορές μεταξύ τους, αλλά η βασική τους λογική παραμένει η ίδια. Για παράδειγμα, στην Εικόνα 3.10 
εμφανίζονται οι βασικοί κωδικοποιητές ενός τυπικού συστήματος Windows. Παρατηρούμε ότι υπάρχουν 



85 
 

τουλάχιστον δύο υλοποιήσεις της μεθόδου ADPCM. Γενικότερα, υπάρχουν πολλά προγράμματα κωδικοποί-
ησης ήχου, δηλαδή πολλοί codecs. Συνεπώς, πρέπει να έχουμε εγκαταστήσει στον υπολογιστή μας τα αντί-
στοιχα προγράμματα για να είναι εφικτή η αναπαραγωγή του ήχου. Επίσης, υπάρχουν εργαλεία που ανακα-
λύπτουν τους κωδικοποιητές που λείπουν από ένα σύστημα και απαιτούνται για την αναπαραγωγή κάποιου 
μουσικού αρχείου. 

Οι κωδικοποιητές συμπιέζουν τελικά τα δεδομένα ήχου και η συμπίεση αυτή μπορεί να είναι απωλε-
στική (lossy) ή μη απωλεστική (lossless). Οι πιο δημοφιλείς κωδικοποιητές, όπως o MP3 και ο WMA 
(Windows Media Audio) είναι απωλεστικοί. Γνωστοί κωδικοποιητές ήχου χωρίς απώλεια πληροφοριών είναι 
οι FLAC (Free Lossless Audio Codec), ALAC (Apple Lossless Audio Codec) και MPEG-4 ALS (MPEG-4 
Audio Lossless Coding) και Windows Media Audio Lossless (WMA Lossless). 
 

 
 
Εικόνα 3.10 Εφαρμογή κωδικοποίησης ήχου σε MP3. 

 
Η συμπίεση του ήχου κυματομορφών που επιτυγχάνεται μέσω των κωδικοποιητών, βασίζεται σε διά-

φορους παράγοντες που σχετίζονται με τις συχνότητες που μπορεί να αντιληφθούν οι ακροατές. Δηλαδή, ε-
κτός της συμπίεσης που επιτυγχάνεται μέσω τεχνικών, όπως η DPCM ή η ΑDPCM, που αποθηκεύουν τις δι-
αφορές των δειγμάτων, υπάρχουν και τεχνικές που βασίζονται στις ακουστικές μας δυνατότητες. Όπως ανα-
φέρθηκε, οι άνθρωποι μπορούν να αντιληφθούν ήχους από 20 Ηz ως 20KHz, αλλά η ακοή μας είναι πιο ευαί-
σθητη στο εύρος συχνοτήτων 500Hz ως 4KHz. Έτσι, για παράδειγμα, μπορεί να γίνει αφαίρεση κάποιων δε-
δομένων με βάση τη συχνότητά τους. Υπάρχουν, επίσης, περιπτώσεις, όπου η μετάβαση από ήχο μιας έντα-
σης σε ήχο άλλης έντασης μειώνει τη δυνατότητά μας να ακούσουμε σωστά και τους δύο ήχους. Αυτά τα πα-
ραδείγματα και άλλα πιο πολύπλοκα ζητήματα που σχετίζονται με την αντίληψη του ήχου, αφορούν την Ψυ-
χοακουστική (Psychoacoustics). Η Ψυχοακουστική ασχολείται με την φυσιολογία και την ψυχολογία του ή-
χου και codecs, όπως ο MP3, βασίζονται στα συμπεράσματα της έρευνας σε αυτούς τους τομείς και μειώνουν 
αποτελεσματικά το μέγεθος του αρχείου ήχου, χωρίς σημαντική απώλεια ποιότητας. 

 

3.3.6. Ειδικά θέματα ψηφιοποιημένου ήχου  
 

3.3.6.1. Χαρακτηριστικά CD και DVD ήχου 
 
Τα CD και DVD χρησιμοποιούνται για την αποθήκευση ήχου που μπορεί να αναπαραχθεί σε διάφορες συ-
σκευές. Στον Πίνακα 3.3 συνοψίζονται οι δυνατότητες των δύο μέσων. Παρατηρούμε ότι ο οπτικός δίσκος 
CD έχει μικρότερες δυνατότητες για ήχο. Γενικά, σε ένα CD 700 MB μπορεί να αποθηκευτούν μέχρι και 80 
λεπτά ασυμπίεστου ήχου, ενώ σε DVD-Audio (DVD-A) η χρονική διάρκεια εξαρτάται από το μέγεθος του 
DVD, τον αριθμό των καναλιών του ήχου και το μέγεθος δείγματος. Ο μέγιστος ρυθμός μεταφοράς δεδομέ-
νων (bit rate), σε CD, είναι περίπου 1441 Κbits/sec. Τα αρχεία ήχου έχουν προέκταση .cda. 

Στην περίπτωση του DVD-A ο ήχος μπορεί να είναι από μονοφωνικός έως και εξακάναλος (σύστημα 
5.1). Στην περίπτωση των 6 καναλιών, ο μέγιστος ρυθμός δειγματοληψίας είναι 96 KHz, ενώ στην περίπτωση 
στερεοφωνικού ήχου ο μέγιστος ρυθμός δειγματοληψίας μπορεί να είναι 192 KHz με μέγεθος δείγματος 24 
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bit. Η κωδικοποίηση του ήχου είναι PCM και μπορεί να είναι μη συμπιεσμένη ή συμπιεσμένη χωρίς απώλει-
ες. Ο μέγιστος ρυθμός μεταφοράς δεδομένων είναι 9,6 Megabits/sec (Mbps). 

 
Χαρακτηριστικό CD DVD 

Μέγιστος ρυθμός δειγματοληψίας 44,1 KHz 192 KHz 
Μέγεθος δείγματος 16 bit 24 bit 
Μέγιστο πλήθος σταθμών έντασης 65536 16777216 

 
Πίνακας 3.3 Υπολογισμός μεγέθους σε bits ασυμπίεστου ήχου. Σύγκριση δυνατοτήτων CD και DVD για αποθήκευση ήχου. 

 
3.3.6.2. Συνεχής ροή δεδομένων ήχου 
 
Ο ψηφιακός ήχος αποθηκεύεται σε αρχεία ήχου, τα οποία υπάρχουν σε κάποιο ψηφιακό μέσο και είναι κωδι-
κοποιημένα σε κάποια μορφή. Η ακρόασή τους μέσω του διαδικτύου μπορεί να γίνει με μεταφορά στον υπο-
λογιστή του χρήστη και αναπαραγωγή του ήχου στη συνέχεια. Αυτή η μέθοδος δημιουργεί κάποια προβλήμα-
τα. Αρχικά, αν το αρχείο είναι μεγάλο σε μέγεθος, τότε η διαδικασία μεταφοράς είναι χρονοβόρα. Στην περί-
πτωση που πρόκειται για αρχεία με πνευματικά δικαιώματα, τότε η μεταφορά ολόκληρου του αρχείου δεν 
είναι επιτρεπτή. Ένα ακόμη πρόβλημα προκύπτει στην περίπτωση μετάδοσης ζωντανών ραδιοφωνικών προ-
γραμμάτων, όπου τα ηχητικά δεδομένα πρέπει να δημιουργούνται, να μεταφέρονται και να αναπαράγονται 
ταυτόχρονα. 
 

 
 
Εικόνα 3.11 Εκπομπή ραδιοφωνικού προγράμματος στο διαδίκτυο μέσω Windows Media Player και τραγουδιού με χρήση 
RealPlayer. 

 
Η επίλυση κάποιων από τα πιο πάνω προβλήματα έχει δοθεί μέσω της τεχνικής ροής δεδομένων ήχου 

και γενικότερα ροής δεδομένων πολυμεσικού χαρακτήρα (streaming media). Η συνεχής ροή δεδομένων ή-
χου (streaming audio) αφορά την τμηματική μετάδοση πληροφοριών ήχου σε πραγματικό χρόνο. Με αυτόν 
τον τρόπο μετάδοσης, τα δεδομένα μεταφέρονται μέσω διαδικτύου µε τη μορφή μιας συνεχούς ροής πακέτων. 
Δηλαδή ο ήχος μεταφέρεται τμηματικά και όταν μεταφερθεί ένα τμήμα του γίνεται αναπαραγωγή. Κατά τη 
διάρκεια αναπαραγωγής κάποιου τμήματος, μεταφέρεται το επόμενο τμήμα δεδομένων, κ.ο.κ. Έτσι, δίνεται η 
αίσθηση της ταυτόχρονης μεταφοράς και αναπαραγωγής των δεδομένων. Η τεχνική αυτή χρησιμοποιείται 
στους διαδικτυακούς ραδιοφωνικούς σταθμούς, αλλά και στη γνωστή υπηρεσία www.youtube.com. 

Για τη μεταφορά streaming audio απαιτείται η ύπαρξη του streaming server (εξυπηρετητή) από όπου 
θα γίνεται η μεταφορά των δεδομένων, π.χ. Flash Media Server ή Windows Media Services (WMS) και η ύ-
παρξη ενός κατάλληλου προγράμματος αναπαραγωγής στον υπολογιστή πελάτη. Για παράδειγμα, στην περί-
πτωση streaming audio απαιτείται η ύπαρξη του RealPlayer ή του Windows Media Player στον υπολογιστή 
πελάτη (Εικόνα 3.11). Αν η μετάδοση γίνεται μέσω ενός ραδιοφωνικού σταθμού, τότε απαιτείται η ύπαρξη 
streaming server που θα αποστέλλει τα δεδομένα ήχου. Σε περιπτώσεις όπου γίνεται μετάδοση τραγουδιών 
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και όχι ζωντανού προγράμματος, τότε τα τραγούδια πρέπει να είναι αποθηκευμένα σε κάποια ειδική μορφή, 
όπως για παράδειγμα τα αρχεία RealAudio (.ra). 

Οι απαιτήσεις αυτής της μορφής μεταφοράς ψηφιακών δεδομένων είναι αρκετά υψηλές όσον αφορά 
το ρυθμό μετάδοσης δεδομένων. Όσο μεγαλύτερο εύρος ζώνης διαθέτει ο χρήστης, τόσο πιο μικρές είναι οι 
πιθανότητες να παρουσιαστεί καθυστέρηση στην αναπαραγωγή του αρχείου λόγω συμφόρησης του δικτύου. 

 
3.3.6.3. Αλλαγή ρυθμού δειγματοληψίας και μεγέθους δείγματος  
 
Η αλλαγή του ρυθμού δειγματοληψίας (sample rate conversion) είναι γνωστή ως διαδικασία resampling και 
αναφέρεται στη μετατροπή του ρυθμού δειγματοληψίας σε μεγαλύτερο ή μικρότερο από αυτόν που είχε χρη-
σιμοποιηθεί για την εγγραφή του ήχου. Για παράδειγμα, ο ρυθμός δειγματοληψίας μπορεί να μετατραπεί από 
96 KHz σε 48 KHz. Στην περίπτωση μετατροπής σε μικρότερο ρυθμό, γίνεται μείωση του μεγέθους του ήχου, 
αλλά και μείωση των διαθέσιμων συχνοτήτων, γεγονός που μπορεί να επηρεάσει την ποιότητα. 

Μετατροπή μπορεί να γίνει και στο μέγεθος δείγματος (sample depth conversion). Σε αυτή την περί-
πτωση, γίνεται χρήση μικρότερου ή μεγαλύτερου αριθμού δυαδικών ψηφίων για κάθε δείγμα. Η μετατροπή 
έχει, συνήθως, νόημα μόνο στη χρήση μικρότερου αριθμού δείγματος. Για παράδειγμα, αν θέλουμε να εγ-
γράψουμε σε CD, ήχο που έχει μέγεθος δείγματος 24 bit, πρέπει να μειώσουμε το μέγεθος στα 16 bit. Σε αυτή 
την περίπτωση, γίνεται μείωση του μεγέθους του αρχείου, αλλά χάνονται κάποιες από τις διαθέσιμες στάθμες 
έντασης και ενδεχομένως, να έχουμε μείωση ποιότητας. 

 

3.3.6.4. Φάσμα συχνοτήτων 
 
Η εμφάνιση του φάσματος συχνοτήτων (spectral view) ενός ηχητικού σήματος αφορά στην αναπαράσταση 
των συχνοτήτων του ήχου σε σχέση με την ένταση ή το χρόνο.  

 

 
 
Εικόνα 3.12 Φάσμα συχνοτήτων ενός στερεοφωνικού ήχου στο εργαλείο Audacity. 

 
Στην Εικόνα 3.12 βλέπουμε το φάσμα συχνοτήτων ενός στερεοφωνικού ήχου. Το φάσμα συχνοτήτων 

μας βοηθά να ανακαλύπτουμε τις κυρίαρχες συχνότητες σε ένα απόσπασμα ήχου και με χρήση κάποιων από 
τις δυνατότητες των εργαλείων επεξεργασίας ήχου να απομακρύνουμε τις μη επιθυμητές συχνότητες ή γενι-
κώς να εφαρμόσουμε κάποιες συνολικές μετατροπές στα δεδομένα. 
 
3.3.6.5. Περιβάλλουσα έντασης ήχου 
 
Σε κάθε ήχο, η ένταση αρχίζει από ένα σημείο όπου δεν ακούγεται (σημείο με ένταση 0), φθάνει μέχρι ένα 
μέγιστο σημείο και κατόπιν, σταδιακά, αρχίζει να εξασθενεί, μέχρι να πάψει πλέον να ακούγεται. Με άλλα 
λόγια, ο ήχος αλλάζει κατά τη διάρκεια ενός χρονικού διαστήματος. Ο τρόπος που ο ήχος αλλάζει, ονομάζε-
ται περιβάλλουσα έντασης ήχου (sound envelope) και η μορφή της εξαρτάται από το όργανο που παράγει 
τον ήχο, το είδος εκτέλεσης του μουσικού κομματιού και το περιβάλλον. Η περιβάλλουσα έντασης ήχου έχει 



88 
 

τη μορφή καμπύλης και ακολουθεί τη μορφή του κύματος του ήχου, δηλαδή εξαρτάται από το πλάτος και τη 
συχνότητα του κύματος (Εικόνα 3.13). 

 

 
 
Εικόνα 3.13 Περιβάλλουσα έντασης ήχου. 
 

Τα βασικά στάδια στα οποία υποδιαιρείται η περιβάλλουσα ενός ήχου είναι: 
 Δράσης (attack), όπου η ένταση του ήχου αυξάνει από το επίπεδο μηδέν μέχρι ένα μέγιστο 

επίπεδο. 
 Διατήρησης στο μέγιστο επίπεδο (hold), όπου η ένταση του ήχου διατηρείται για κάποιο 

διάστημα στη μέγιστη τιμή της. 
 Μερικής εξασθένησης (decay), όπου η τιμή της έντασης του ήχου φθίνει μέχρι ένα βαθμό. 
 Διατήρησης σε ενδιάμεσο επίπεδο (sustain), όπου η ένταση του ήχου διατηρείται για κάποιο 

διάστημα σε κάποια ενδιάμεση τιμή. 
 Τερματισμού ή αποδέσμευσης (release), όπου η ένταση του ήχου φθίνει μέχρι τον τερματι-

σμό της. 
 
Μέσω προγραμμάτων επεξεργασίας ήχου μπορούμε να τροποποιήσουμε την περιβάλλουσα έντασης 

ενός ήχου, δηλαδή να τροποποιήσουμε τη μορφή της καμπύλης της. Με αυτόν τον τρόπο τροποποιούμε την 
κυματομορφή του ήχου ή διαφορετικά διαμορφώνουμε την ένταση του ήχου. Τα εργαλεία επεξεργασίας ήχου 
παρέχουν και προκαθορισμένες μορφές επεξεργασίας της περιβάλλουσας (Εικόνα 3.14). 
 

 
 
Εικόνα 3.14 Επεξεργασία της περιβάλλουσας με το εργαλείο Adobe Audition. 

 
3.3.6.6. Γλώσσες προγραμματισμού ήχου 
 
Οι γλώσσες προγραμματισμού για ήχο είναι ειδικά σχεδιασμένες για την παραγωγή και επεξεργασία ηχητι-
κών δεδομένων. Κάποιες από τις γλώσσες είναι σχεδιασμένες για να επεξεργάζονται μουσικές συνθέσεις, π.χ. 
συνθέσεις MIDI και κάποιες είναι προσανατολισμένες στην επεξεργασία ψηφιοποιημένου ήχου κυματομορ-
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φών. Για παράδειγμα, η γλώσσα MPL (MIDI Programming Language) είναι σχεδιασμένη για δημιουργία και 
επεξεργασία αρχείων μουσικής MIDI.  

Παρακάτω, βλέπουμε ένα απόσπασμα από κάποιο πρόγραμμα στη γλώσσα CSound, η οποία αναπτύ-
χθηκε με βάση τη γλώσσα προγραμματισμού C, αρχικά στο Πανεπιστήμιο MIT και εξελίχθηκε από άλλες 
εταιρείες. Βρίσκεται στην έκδοση 5 και μπορεί να χρησιμοποιηθεί για αρχεία MIDI, αλλά και αρχεία ψηφιο-
ποιημένου ήχου (π.χ. αρχεία wav). Τα αρχεία CSound έχουν επέκταση .csd. Η γλώσσα μπορεί να χρησιμο-
ποιηθεί σε συνδυασμό με συμβατικές γλώσσες προγραμματισμού, όπως οι Python, Java, Lisp, Tcl και C++ 
και τα προγράμματα επεξεργασίας ήχου να εκτελεστούν μέσα από αυτές τις γλώσσες. Ακόμη και το πρότυπο 
MPEG-4 υποστηρίζει δικές του γλώσσες προγραμματισμού, όπως η Structured Audio Orchestra Language 
(SAOL) και η Structured Audio Score Language (SASL). 

 

<CsInstruments> 
    sr     = 96000           ; Ρυθμός δειγματοληψίας 
    nchnls = 1               ; Αριθμός καναλιών 
      ... 
 
    if gkinput=1 then  
 aasigL, aasigR diskin2 "808loop.wav",1,0,1 
      ...  
  </CsInstruments> 

 

3.3.7. Μορφές αποθήκευσης αρχείων ήχου 
 
Όπως και στην περίπτωση των εικόνων, υπάρχουν αρκετά φορμά (μορφοποιήσεις) αποθήκευσης δεδομένων 
ήχου κυματομορφών. Πριν αναλυθούν οι κυριότερες μορφές, πρέπει να γίνει αναφορά στη διαφορά μεταξύ 
μορφής αποθήκευσης και κωδικοποιητή ήχου. Μια μορφοποίηση αρχείου περιέχει κωδικοποιημένα τα δεδο-
μένα ήχου είτε σε μορφή PCM είτε με άλλο τρόπο. Έτσι, για παράδειγμα, ο codec MP3 χρησιμοποιείται στα 
αρχεία MP3, αλλά μπορεί να χρησιμοποιηθεί και σε άλλου τύπου αρχεία, π.χ. σε αρχεία βίντεο. Γενικώς, τα 
φορμά έχουν τη λογική του υποδοχέα (container) που περιέχουν τα δεδομένα ήχου κωδικοποιημένα με κά-
ποιο τρόπο, αλλά και επιπλέον μεταδεδομένα για να μπορεί να γίνει σωστή αποκωδικοποίηση και μετάφραση 
του ήχου. 

Οι μορφοποιήσεις διακρίνονται σε τρεις βασικές κατηγορίες: σε αυτές που δεν υποστηρίζουν συμπίε-
ση (π.χ. WAV), σε αυτές που υποστηρίζουν μη απωλεστική συμπίεση (π.χ. FLAC) και σε αυτές που παρέ-
χουν απωλεστική συμπίεση (π.χ. MP3). 
 
3.3.7.1. WAV 
 
Τα αρχεία WAV (Waveform Audio) κωδικοποιούν τον ήχο κυρίως στην ασυμπίεστη μορφή LPCM (Linear 
PCM – γραμμική PCM). Τα αρχεία έχουν προέκταση .wav. Οι ρυθμοί δειγματοληψίας που υποστηρίζει το 
συγκεκριμένο φορμά ξεκινούν από 11025Hz και φθάνουν μέχρι και 48000Hz. Συνήθως, χρησιμοποιείται 
ρυθμός δειγματοληψίας 22050Hz ή 44100Hz. Το μέγιστο μέγεθος δείγματος 16 bit και ο ήχος μπορεί να είναι 
μονοφωνικός ή στερεοφωνικός.  

 

 
 
Εικόνα 3.15 Επιλογές κωδικοποίησης κατά την εγγραφή αρχείων WAV. 
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Στην Εικόνα 3.15 εμφανίζονται κάποιες από τις επιλογές κωδικοποίησης ήχου σε μορφή WAV. Εμ-
φανίζεται και ο απαιτούμενος ρυθμός μεταφοράς δεδομένων, ώστε να γίνεται κατανοητή και η απαιτούμενη 
ταχύτητα μεταφοράς δεδομένων. Με μεγάλο ρυθμό δειγματοληψίας και μεγάλο μέγεθος δείγματος, τα αρχεία 
WAV μπορούν να έχουν πολύ καλή ποιότητα ήχου. 

Εκτός από την κωδικοποίηση PCM μπορεί να χρησιμοποιηθεί και κωδικοποίηση ADPCM στα αρχεία 
WAV. Οι μορφές Microsoft ADPCM WAV και International Multimedia Association (IMA) ADPCM WAV 
κωδικοποιούν τα δεδομένα με αυτή τη μέθοδο, αλλά η συμπίεση που προσφέρουν είναι μικρή. Η μορφοποίη-
ση WAV υποστηρίζεται από σχεδόν όλα τα προγράμματα επεξεργασίας ή αναπαραγωγής ήχου. Το βασικό 
τους μειονέκτημα είναι το μεγάλο μέγεθος τους και συνεπώς, είναι απαγορευτική η χρήση τους σε διαδικτυα-
κές εφαρμογές. Ένας άλλος περιορισμός είναι ότι τα αρχεία WAV δεν μπορεί να είναι μεγαλύτερα από 4 GB. 

 
3.3.7.2. AIFF 
 
Τα αρχεία AIFF (Audio Interchange File Format) δημιουργήθηκαν από την εταιρεία υπολογιστών Apple, αλ-
λά πλέον η μορφοποίηση είναι ευρέως διαδεδομένη. Τα δεδομένα ήχου κωδικοποιούνται με την PCM, αν και 
υπάρχει η μορφή AIFC η οποία υποστηρίζει συμπίεση. Υποστηρίζει μέγεθος δείγματος μέχρι 16bit και ρυθμό 
δειγματοληψίας μέχρι 44,1 KHz. Η συγκεκριμένη μορφοποίηση χρησιμοποιείται συχνά από επαγγελματικά 
προγράμματα επεξεργασίας ήχου για την καταγραφή του αρχικού μη επεξεργασμένου ήχου, διότι έτσι διατη-
ρείται το ηχητικό σήμα σε υψηλή ποιότητα. Το βασικό τους μειονέκτημα είναι και εδώ το μεγάλο μέγεθος 
αρχείου. Τα αρχεία AIFF έχουν προέκταση .aif ή .aiff ή .aifc. 

 
3.3.7.3. AU 
 
Η μορφή AU δημιουργήθηκε από τη Sun Microsystems για το λειτουργικό σύστημα Unix και μερικές φορές 
αναφέρεται ως μορφοποίηση “audio/basic”. Τα αρχεία έχουν προέκταση .au ή .snd. Είναι ένα από τα πρώτα 
πρότυπα που χρησιμοποιήθηκαν στις ιστοσελίδες και χρησιμοποιείται συχνά για μικρά ηχητικά εφε, όπου η 
ποιότητα δεν είναι σημαντική. Κυρίως, πρόκειται για αρχεία με ρυθμό δειγματοληψίας 8000Hz και μεγέθος 
δείγματος 8 bit. Χρησιμοποιεί διάφορες κωδικοποιήσεις των δεδομένων ήχου, όπως μη συμπιεσμένη PCM, μ-
law, a-law και ADPCM. Το μέγεθος του παραγόμενου αρχείου είναι μικρό, αλλά η ποιότητα είναι χαμηλή και 
η χρήση των .au περιορίζεται σε συστήματα Unix, αν και υποστηρίζεται από όλα τα υπόλοιπα λειτουργικά 
συστήματα. 

 
3.3.7.4. FLAC 
 
Η μορφή FLAC (Free Lossless Audio Codec) είναι κωδικοποιητής με μη απωλεστική συμπίεση. Επιτυγχάνει 
συμπίεση κατά 50% ως 60% σε σχέση με το αρχικό μέγεθος. Η αποσυμπίεση αρχείων FLAC (.flac) οδηγεί 
στους αρχικούς ήχους, χωρίς να υπάρξει καμία αλλοίωση ή απώλεια λόγω της συμπίεσης. Τα αρχεία FLAC 
περιέχουν τα δεδομένα κωδικοποιημένα σύμφωνα με τον ομώνυμο codec, αλλά και επιπλέον μεταδεδομένα 
για τη χρήση πληροφοριών των μουσικών άλμπουμ που ανήκει κάποιο τραγούδι, των στίχων του τραγουδιού 
(lyrics), καθώς και άλλα μεταδεδομένα. 

Είναι ανοιχτό και δωρεάν φορμά και, αν και δεν έχει ακόμη ευρεία αποδοχή, αναμένεται να αυξηθεί η 
χρήση του λόγω της μεγάλης μη απωλεστικής συμπίεσης που προσφέρει. Ήδη οι νέες εκδόσεις των περισσό-
τερων εφαρμογών αναπαραγωγής και επεξεργασίας ήχου υποστηρίζουν, είτε εγγενώς είτε με χρήση επιπρό-
σθετων προγραμμάτων (plug-ins), το νέο φορμά. 

 
3.3.7.5. Windows Media Audio  
 
Η μορφή WMA (Windows Media Audio) αναπτύχθηκε από τη Microsoft και αποτελεί ταυτόχρονα κωδικο-
ποιητή και μορφοποίηση. Τα αρχεία έχουν προέκταση .wma. Η τεχνολογία WMA αποτελείται από τέσσερις 
επιμέρους κωδικοποιητές. Ο αρχικός κωδικοποιητής ονομάζεται WMA και υποστήριζε απωλεστική συμπίε-
ση. Έπειτα, δημιουργήθηκαν οι κωδικοποιητές WMA Pro, ο WMA lossless για μη απωλεστική συμπίεση και 
ο WMA Voice για αποτελεσματική κωδικοποίηση φωνής. Η μορφοποίηση μπορεί να χρησιμοποιηθεί και για 
streaming audio. 
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Τα απλά WMA αρχεία έχουν ρυθμό δειγματοληψίας 48 KHz και στερεοφωνικό ήχο. Η μορφή WMA 
έχει το βασικό πλεονέκτημα έναντι του MP3 ότι τα τραγούδια μπορούν να είναι προστατευμένα (copyright) 
και έτσι πολλές δισκογραφικές εταιρείες το υιοθέτησαν. Ο WMA Pro codec υποστηρίζει δειγματοληψία 96 
KHz και μέχρι 8 κανάλια ήχου (σύστημα 7.1). Η τελευταία έκδοση του WMA lossless επιτυγχάνει ικανοποιη-
τική συμπίεση, μέχρι και 60%, χωρίς απώλεια πληροφορίας. Φυσικά, η συμπίεση που τελικά επιτυγχάνεται 
εξαρτάται από πολλούς παράγοντες.  
 

3.3.7.6. Κωδικοποίηση ήχου MPEG 
 
Η ομάδα MPEG (Moving Picture Experts Group) αποτελεί ομάδα εργασίας που ασχολείται με τη δημιουργία 
προτύπων κωδικοποίησης για δεδομένα ήχου, βίντεο και τρισδιάστατων γραφικών. Όσον αφορά τον ήχο, έχει 
δημιουργήσει διάφορα πρότυπα συμπίεσης. Το πιο γνωστό εξ αυτών είναι ο κωδικοποιητής MP3. Επιπλέον, 
στη λίστα κωδικοποιητών ήχου περιλαμβάνονται, μεταξύ άλλων, και οι MPEG AAC και MPEG ALS. Όλοι 
οι κωδικοποιητές βασίζονται σε παρόμοιες παραμέτρους που προκύπτουν από το ψυχοακουστικό μοντέλο, 
αλλά διαφέρουν σε τεχνικές λεπτομέρειες και δυνατότητες. 

 
MPEG-1 Layer III (MP3) 

 
Το MP3 είναι το πιο γνωστό πρότυπο απωλεστικής συμπίεσης ηχητικών δεδομένων. Τα αρχεία MP3 έχουν 
προέκταση .mp3 και αποθηκεύουν τα δεδομένα κωδικοποιημένα χρησιμοποιώντας τον MP3 codec. Το MP3 
δεν είναι το MPEG-3, όπως υπονοεί η ονομασία του, αλλά είναι το MPEG-1 Layer 3. Αναπτύχθηκε στις αρ-
χές της δεκαετίας ’90 από το Γερμανικό ερευνητικό Ινστιτούτο Fraunhofer Institute σε συνεργασία με εται-
ρείες και Πανεπιστήμια και πρόκειται για απωλεστική μορφή συμπίεσης με μεγάλο λόγο συμπίεσης. Είναι 
εξαιρετικά δημοφιλές πρότυπο και υποστηρίζεται σε εφαρμογές λογισμικού, αλλά και απευθείας στο υλικό 
π.χ. mp3 players. Η κωδικοποίηση σε MP3 δεν είναι δωρεάν και όσοι επιθυμούν να δημιουργήσουν εφαρμο-
γές ή υλικό κωδικοποίησης/αποκωδικοποίησης πρέπει να πληρώσουν κάποιο αντίτιμο στην εταιρεία Thom-
son που έχει τελικά τα δικαιώματα εκμετάλλευσης. 

Η συμπίεση στο MP3 βασίζεται στο ψυχοακουστικό μοντέλο και παραμέτρους που περιγράψαμε σε 
προηγούμενη ενότητα. Ο αλγόριθμος που χρησιμοποιείται μπορεί να μειώσει σημαντικά τον απαιτούμενο 
ρυθμό μεταφοράς δεδομένων και τελικά το χρόνο μεταφοράς του αρχείου μέσω του διαδικτύου. Φυσικά, όσο 
μεγαλύτερη συμπίεση επιτυγχάνεται, τόσο μεγαλύτερη είναι η μείωση στην ποιότητα ήχου. Το MP3 υποστη-
ρίζει μέγιστο ρυθμό μεταφοράς 320 Kbps και μέγιστο ρυθμό δειγματοληψίας 48 KHz. Κάποιες υλοποιήσεις 
του MP3, όπως ο κωδικοποιητής LAME MP3, μπορεί να υποστηρίξουν ρυθμό μεταφοράς δεδομένων ως 640 
Kbps, αλλά οι εξειδικευμένες υλοποιήσεις δεν υποστηρίζονται ευρέως. Γενικώς, αν και το MP3 υποστηρίζε-
ται ευρέως, προσφέρει μεγάλη συμπίεση, αλλά χαμηλή ποιότητα ήχου και έχει και κάποιους τεχνικούς περιο-
ρισμούς που βαθμιαία το καθιστούν παρωχημένο. Επίσης, η μορφοποίηση μπορεί να χρησιμοποιηθεί για 
streaming audio. 

 
MPEG AAC 
 
Η κωδικοποίηση MPEG AAC (Advanced Audio Coding) αποτελεί εξέλιξη του MP3. Είναι μέρος του MPEG-
2 και του MPEG-4 προτύπου και παρέχει απωλεστική συμπίεση. Αναπτύχθηκε τμηματικά και έτσι αναφέρε-
ται ως MPEG-2 Part 7 και MPEG-4 Part 3. Προσφέρει καλύτερη ποιότητα ήχου σε σχέση με το MP3 στον 
ίδιο ρυθμό μεταφοράς. Αποτελεί το προκαθορισμένο φορμά ήχου σε διάφορες συσκευές όπως iPhone, iPod, 
Playstation 3 και κινητά τηλέφωνα των εταιρειών Nokia, Sony-Ericsson και κινητά με το λειτουργικό An-
droid. 

Σε σχέση με το MP3 υποστηρίζει ρυθμό δειγματοληψίας μέχρι και 96 KHz και μέχρι και 48 κανάλια 
ήχου. Γενικότερα, έχει καλύτερη συμπίεση και υψηλότερη ποιότητα ήχου σε σχέση με το MP3, αν και αυτό 
εξαρτάται κυρίως από τις ιδιότητες του μουσικού αποσπάσματος που κωδικοποιείται. Τα αρχεία που περιέ-
χουν δεδομένα κωδικοποιημένα με βάση τον codec AAC μπορεί να είναι διαφορετικού τύπου και έχουν 
προέκταση .aac ή .3gp ή .m4a ή mp4. Δεν είναι ευρέως διαδεδομένη κωδικοποίηση, αλλά κερδίζει συνεχώς 
έδαφος έναντι του MP3 και υποστηρίζεται από πολλές εφαρμογές, όπως για παράδειγμα οι Flash Player, 
Windows Media Player, RealPlayer και VLC Media Player. 
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MPEG-4 ALS 
 

Το MPEG-4 ALS (Audio Lossless) είναι μια επέκταση του προτύπου MPEG για μη απωλεστική συμπίεση. 
Πρόκειται για κωδικοποιητή και όχι αυτόνομη μορφοποίηση και αναφέρεται και ως τμήμα 14 του MPEG-4. 
Περιέχεται στα αρχεία MPEG-4 με προέκταση .mp4. Υποστηρίζει δείγματα σε PCM μεγέθους μέχρι και 32 
bit. Υποστηρίζει πολυκάναλο ήχο και έχει δυνατότητες για ροή δεδομένων (streaming). 

 

3.3.7.7. Ogg Vorbis 
 
Το Ogg Vorbis είναι αντίστοιχο του MP3 και του AAC, δηλαδή προσφέρει απωλεστική συμπίεση. Πρόκειται 
όμως για δωρεάν κωδικοποίηση και δεν απαιτείται η αγορά δικαιωμάτων, όπως στην περίπτωση του MP3. Ο 
όρος Ogg αναφέρεται στο αρχείο υποδοχέα και ο όρος Vorbis είναι ο κωδικοποιητής ήχου που περιέχεται στο 
αρχείο Ogg. Γενικά, η μορφή αποθήκευσης Ogg έχει σχεδιαστεί ώστε να μπορεί να περιέχει δεδομένα βίντεο 
και ήχου, αλλά προς το παρόν έχει υλοποιηθεί μόνο ο κωδικοποιητής ήχου. Επίσης, τα δεδομένα ήχου μπορεί 
να είναι κωδικοποιημένα και με κάποιο άλλο codec, όπως π.χ. ο FLAC. Τα αρχεία έχουν προέκταση .ogg ή 
.oga. 

Ο κωδικοποιητής Vorbis είναι ένας από τους καλύτερους codec απωλεστικής συμπίεσης ηχητικών 
δεδομένων, διότι προσφέρει καλή συμπίεση και ταυτόχρονα καλή ποιότητα με μικρότερο απαιτούμενο ρυθμό 
μεταφοράς σε σχέση με άλλα φορμά. Για ρυθμό μεταφοράς περίπου 96 Kbps αποδείχθηκε ότι έχει τα πιο ποι-
οτικά χαρακτηριστικά. Είναι μορφοποίηση πιο διαδεδομένη στους χρήστες Linux, έχει δυνατότητα για ροή 
δεδομένων (streaming) και γενικά, δεν έχει ακόμη ευρεία υποστήριξη σε επίπεδο υλικού, αλλά κυρίως λογι-
σμικού.  

 
3.3.7.8. RealAudio 
 
Τo RealAudio είναι ένα φορμά που πρωτοεμφανίστηκε το 1995 και έκτοτε έχει αναπτυχθεί, ώστε να προσφέ-
ρει διάφορες δυνατότητες. Χρησιμοποιεί διαφορετικούς κωδικοποιητές ήχου, π.χ. Dolby AC3, Sony 
ATRAC3 και RealAudio lossless format. Τα αρχεία έχουν προέκταση .ra ή .ram. Ήταν η πρώτη μορφοποίη-
ση που υποστήριζε streaming audio και έγινε γρήγορα αρκετά δημοφιλής. Αν και τα περισσότερα προγράμ-
ματα αναπαραγωγής ήχου υποστηρίζουν την αναπαραγωγή κάποιας από τις διαφορετικές εκδοχές των αρχεί-
ων RealAudio, προτείνεται η χρήση του προγράμματος RealPlayer που έχει κατασκευαστεί από την ίδια εται-
ρεία και υποστηρίζει όλους τους κωδικοποιητές. 

Οι κωδικοποιητές που χρησιμοποιούνται είναι απωλεστικοί και επιτυγχάνουν καλή συμπίεση, αλλά 
χαμηλή ποιότητα ήχου. Ο ρυθμός μεταφοράς δεδομένων κυμαίνεται από 20 Kbps μέχρι 352 Kbps στην περί-
πτωση στερεοφωνικού ήχου καλής ποιότητας. Η περίπτωση της μη απωλεστικής συμπίεσης (RealAudio 
Lossless) επιτυγχάνει μικρότερη συμπίεση, αλλά δεν υπάρχει απώλεια πληροφορίας. Ο συγκεκριμένος κωδι-
κοποιητής είναι βελτιστοποιημένος για ήχο με μέγεθος δείγματος 16 bit και ρυθμό δειγματοληψίας 44,1KHz. 
 

3.3.8. Λογισμικό για ψηφιακό ήχο 
 
Τα αρχεία ήχου περιέχουν δεδομένα που είναι πιο πολύπλοκα από ότι στην περίπτωση των εικόνων. Γι’ αυτό 
το λόγο, υπάρχουν διάφορες κατηγορίες εργαλείων ήχου που ποικίλουν σε δυνατότητες και χρησιμότητα. Το 
λογισμικό ήχου μπορεί να διακριθεί σε λογισμικό εγγραφής, αναπαραγωγής, μετατροπής μεταξύ των διαφό-
ρων μορφών ήχου, ραδιοφωνικής μετάδοσης μέσω διαδικτύου και τέλος, υπάρχουν, τα εργαλεία ολοκληρω-
μένης επεξεργασίας ήχου που παρέχουν δυνατότητες μετατροπής από μία μορφή σε άλλη, χρήση ειδικών εφέ, 
ηχογράφησης και μίξης ήχου και άλλες πιο προηγμένες δυνατότητες.  

 
3.3.8.1. Ηχογράφηση στα Windows 
 
Στο λειτουργικό σύστημα Windows υπάρχει το βοηθητικό πρόγραμμα «Ηχογράφηση» που μας επιτρέπει εύ-
κολα και γρήγορα να εγγράψουμε ήχο και να τον αποθηκεύσουμε σε μορφή WAV. Μπορεί να καθοριστεί ο 
ρυθμός δειγματοληψίας, το μέγεθος δείγματος και ο ήχος να είναι στερεοφωνικός ή μονοφωνικός (Εικόνα 
3.16). Αν η πηγή εγγραφής είναι μία, δηλαδή υπάρχει ένα μικρόφωνο μόνο, τότε δεν χρειάζεται να επιλεχθεί 
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στερεοφωνική εγγραφή. Με βάση τις επιλογές εγγραφής, το εργαλείο παρουσιάζει και τον απαιτούμενο ρυθ-
μό μεταφοράς δεδομένων. 

 

 
 
Εικόνα 3.16 Ηχογράφηση και επιλογές ήχου στα Windows. 
 

3.3.8.2. Εργαλεία αναπαραγωγής 
 
Τα πιο διαδεδομένα εργαλεία αναπαραγωγής ήχου είναι ο Windows Media Player της Microsoft και ο 
RealPlayer της RealNetworks (Εικόνες 3.17 και 3.18). Τα εργαλεία αυτά μπορούν να αναπαράγουν και αρ-
χεία βίντεο, εκτός από αρχεία ήχου. Βασική προϋπόθεση είναι η ύπαρξη των απαραίτητων codec στο σύστη-
μα, ώστε να γίνει η αναπαραγωγή του ήχου. Για παράδειγμα, αν κάποιο αρχείο ήχου χρησιμοποιεί τον FLAC 
codec, πρέπει να υπάρχει αυτός ο κωδικοποιητής εγκατεστημένος, ώστε να μπορεί να γίνει η αναπαραγωγή 
του μέσω του αντίστοιχου player. Τα εργαλεία αυτά μπορούν να αναπαράγουν και αρχεία βίντεο, εκτός από 
αρχεία ήχου. Βασική προϋπόθεση είναι η ύπαρξη των απαραίτητων codec στο σύστημα, ώστε να γίνει η ανα-
παραγωγή του ήχου. Για παράδειγμα, αν κάποιο αρχείο ήχου χρησιμοποιεί τον FLAC codec, πρέπει να υπάρ-
χει αυτός ο κωδικοποιητής εγκατεστημένος, ώστε να μπορεί να γίνει η αναπαραγωγή του μέσω του αντίστοι-
χου player. 
 

 
 
Εικόνα 3.17 Windows Media Player. 
 

Υπάρχουν αρκετά επιπλέον προγράμματα αναπαραγωγής μουσικής και άλλων ψηφιακών μέσων, ό-
πως για παράδειγμα βίντεο. Γνωστοί players είναι οι δωρεάν GOM Player, VLC Player, KMPlayer, iTunes 
και οι απλές και προηγμένες εκδόσεις των QuickTime και Winamp. Το σύγχρονο λογισμικό αναπαραγωγής 
ψηφιακών μέσων έχει αρκετές δυνατότητες. Μπορούν να αντιγράψουν CD και DVD, να προβάλλουν διαφο-
ρετικές απεικονίσεις κατά τη διάρκεια αναπαραγωγής των μέσων, να μετατρέψουν αρχεία σε άλλες μορφές, 
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κ.ά. Υποστηρίζουν, επίσης, την αναπαραγωγή ροής δεδομένων ήχου (streaming audio) και μπορούν να ενσω-
ματωθούν σε ιστοσελίδες για την αναπαραγωγή των ηχητικών δεδομένων. 

 

 
 

Εικόνα 3.18 RealMedia Player. 

 
3.3.8.3. Λογισμικό μετατροπής 
 
Όπως είδαμε πιο πάνω, υπάρχουν διάφορες κωδικοποιήσεις ήχου και γι’ αυτό έχουν αναπτυχθεί εφαρμογές 
λογισμικού που μετατρέπουν από τη μία μορφή στην άλλη (Εικόνες 3.9 και 3.19).  

 

 
 
Εικόνα 3.19 Μετατροπέας αρχείων ήχου. 

 
Μια συνήθης διαδικασία είναι η μετατροπή αρχείων CD στη μορφή MP3 ή σε κάποια άλλη συμπιε-

σμένη μορφή. Η διαδικασία αυτή είναι γνωστή ως ripping (απόσπαση αρχείων). Οι ψηφιακοί μετατροπείς 
επιτρέπουν τον καθορισμό διαφόρων παραμέτρων (π.χ. ρυθμός μεταφοράς, συχνότητα δειγματοληψίας) για 
να επιτευχθεί η επιθυμητή ποιότητα. Με μια απλή αναζήτηση στο διαδίκτυο μπορούν να βρεθούν πολλοί με-
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τατροπείς, κάποιοι εκ των οποίων είναι δωρεάν. Οι περισσότερες εφαρμογές μπορούν να μετατρέψουν αρχεί-
α, μαζικά, από μία μορφή σε μία άλλη. 

 
3.3.8.4. Ραδιοφωνική μετάδοση μέσω διαδικτύου 
 
Για τη μετάδοση ήχου μέσω διαδικτύου απαιτείται η ύπαρξη λογισμικού για ήχο ροής δεδομένων στον υπο-
λογιστή εξυπηρετητή (streaming audio server). Στον υπολογιστή πελάτη απαιτείται λογισμικό αναπαραγωγής 
streaming audio, π.χ. Windows Media Player ή RealPlayer. Το διαδικτυακό πρόγραμμα μουσικής μπορεί να 
προέρχεται από ένα πραγματικό ραδιοφωνικό σταθμό ή να αφορά τη μετάδοση μουσικής που έχουμε στον 
υπολογιστή μας. Σε οποιαδήποτε περίπτωση ο streaming audio server (π.χ. Windows Media Server) είναι υ-
πεύθυνος για τη μετάδοση της ροής δεδομένων ήχου. Ο streaming audio server λαμβάνει το ραδιοφωνικό σή-
μα, το οποίο έχει κωδικοποιηθεί σε κάποια μορφή ροής δεδομένων ήχου, όπως WMA, MP3, RealAudio ή 
Ogg Vorbis και το μεταδίδει. Όταν πρόκειται για ζωντανό ραδιοφωνικό πρόγραμμα και όχι απλή μετάδοση 
μουσικής μέσω κάποιο υπολογιστή, απαιτείται και λογισμικό αυτοματοποίησης της ραδιοφωνικής μετάδοσης, 
όπως ο QuickTime Broadcaster της Apple, Andromeda Webcasts, TuneTracker κ.α. Επίσης, υπάρχουν και 
διαδικτυακοί τόποι, μέσω των οποίων ερασιτέχνες μπορούν να μεταδώσουν μουσική μέσω Internet. 

 

3.3.8.5. Εργαλεία επεξεργασίας 
 
Τα εργαλεία επεξεργασίας ήχου (sound editing) προσφέρουν διάφορες δυνατότητες για επεξεργασία ήχου 
ακόμη και σε επίπεδο κυματομορφής. Τα ολοκληρωμένα εργαλεία μπορούν να χρησιμοποιηθούν για ηχογρά-
φηση, μετατροπή μεταξύ μορφοποιήσεων, μίξη ήχου, απομάκρυνση θορύβου, αποκοπή ή εισαγωγή τμημάτων 
ήχου σε συγκεκριμένα σημεία, εφαρμογή διαφόρων εφέ, ανάλυση φάσματος κ.ά. Υπάρχουν αρκετά εργαλεία 
για επεξεργασία ήχου, πολλά εκ των οποίων είναι δωρεάν. Το πιο γνωστό δωρεάν λογισμικό είναι το Audaci-
ty, ενώ οι πιο γνωστές εμπορικές εφαρμογές είναι το Adobe Audition και το Sony SoundForge. 

 
Audacity 

 
Το δωρεάν εργαλείο Audacity (Εικόνα 3.20) αναπτύχθηκε από τον Dominic Mazzoni και συντηρείται από μια 
πολυμελή ομάδα (http://audacity.sourceforge.net/). Βρίσκεται στην έκδοση 2.x και είναι αρκετά δημοφιλές.  

 

 
 
Εικόνα 3.20 Δωρεάν εργαλείο επεξεργασίας ήχου Audacity. 

 
Το εργαλείο είναι διαθέσιμο για όλα τα διαδεδομένα λειτουργικά συστήματα, δηλαδή Windows, Mac 

OS και συστήματα Linux. Μπορεί να επεξεργαστεί τις βασικές μορφοποιήσεις ήχου και μέσω επιπρόσθετων 
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βιβλιοθηκών αρχεία, όπως WMA, AAC και AC3. Υποστηρίζει την εγγραφή από διάφορες πηγές και παρέχει 
πληθώρα εφέ και τρόπους επεξεργασίας του ηχητικού σήματος, μέσω μιας σχετικά εύχρηστης διεπαφής χρή-
στη. 
 
Adobe Audition 

 
To Adobe Audition (Εικόνα 3.21) αποτελεί εξέλιξη του δημοφιλούς εργαλείου Cool Edit που κυκλοφορούσε 
στο τέλος της περασμένης και στις αρχές της τρέχουσας δεκαετίας. Το νέο εργαλείο διατίθεται και μέσω των 
υπηρεσιών σύννεφου της Adobe. Έχει παρόμοιες λειτουργίες με το Audacity, αλλά προσφέρει τελικά περισ-
σότερες δυνατότητες.  
 
 

 

 
 
Εικόνα 3.21 Εργαλείο Adobe Audition. 

 
Για τους πιο έμπειρους χρήστες στην επεξεργασία ήχου, το Audition προσφέρει περισσότερες δυνα-

τότητες και επαγγελματικές λειτουργίες. Για τους χρήστες που έχουν λιγότερες απαιτήσεις, η προηγούμενη 
εφαρμογή, Audacity, αποτελεί μια καλή και φυσικά ανέξοδη λύση. 

 
Sony Sound Forge 

 
Το εργαλείο SoundForge (Eικόνα 3.22) της Sony διατίθεται σε δύο εκδόσεις. Η έκδοση Sound Forge Audio 
Studio αφορά τον ερασιτέχνη χρήστη, ενώ η έκδοση Sound Forge Pro παρέχει πολλές περισσότερες λειτουρ-
γίες για τον επαγγελματία χρήστη. Αν και θεωρείται ότι είναι λίγο πιο δύσχρηστο στη χρήση του σε σχέση με 
το Adobe Audition, έχει περισσότερες δυνατότητες και παράγει πιο ποιοτικά αποτελέσματα. 

 

3.4. Ψηφιακή μουσική 
 
Στις προηγούμενες ενότητες παρουσιάστηκαν έννοιες που αφορούν τα αρχεία ήχου κυματομορφών. Ο ψηφο-
ποιημένος ήχος, που προκύπτει μέσα από τη διαδικασία της δειγματοληψίας μπορεί να αναπαραστήσει οποιο-
δήποτε ήχο, π.χ. ομιλία, ήχους περιβάλλοντος, μουσική που έχει ψηφιοποιηθεί και εγγράφεται στον υπολογι-
στή με χρήση μικροφώνου και κάρτας ήχου. Εκτός από αυτή τη μορφή ήχου, υπάρχει και το διεθνές πρότυπο 
MIDI (Musical Instrument Digital Interface - Ψηφιακή Διασύνδεση Μουσικών Οργάνων) που αποτελεί πρω-
τόκολλο για την καταγραφή και ανταλλαγή σε δυαδική μορφή μουσικών πληροφοριών μεταξύ ηλεκτρονικών 
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μουσικών οργάνων και υπολογιστών. Οι μορφές MusicXML και XMF (eXtensible Music Format) αποτελούν 
επιπλέον πρότυπα για καταγραφή και διαμοιρασμό μουσικών συνθέσεων. 

 

 
 
Εικόνα 3.22 Εργαλείο Sound Forge. 

 

3.4.1. MIDI 
 
Τα MIDI αρχεία ονομάζονται και συνθέσεις ή ακολουθίες MIDI. Σύμφωνα με το πρότυπο, καταγράφεται η 
μουσική νότα, το όργανο που την παρήγαγε, η ένταση και ο χρόνος που διαρκεί η νότα (δηλαδή το τέμπο). 
Επίσης, καταγράφονται και πληροφορίες ειδικών εφέ για κάθε νότα. Στην ορολογία του MIDI οι πληροφορίες 
ονομάζονται μηνύματα (MIDI messages) που περιγράφουν γεγονότα, όπως για παράδειγμα η αλλαγή νότας ή 
τέμπο. Όλα τα ηλεκτρονικά όργανα που «καταλαβαίνουν» την κωδικοποίηση MIDI μπορούν να ανταλλάξουν 
μηνύματα MIDI μεταξύ τους. Τα αρχεία MIDI μπορούν να συνδέσουν τους ήχους πολλών διαφορετικών ορ-
γάνων στα κανάλια που διαθέτουν. Ο όρος κανάλια αναφέρεται στον αριθμό τον διαφορετικών μουσικών ορ-
γάνων που μπορούν να υπάρχουν σε μια σύνθεση MIDI. Για παράδειγμα, μια συσκευή MIDI με πολυφωνία 
64 σημαίνει ότι μπορεί να αναπαράγει τους ήχους 64 μουσικών οργάνων ταυτόχρονα. Οι κάρτες ήχων συνή-
θως έχουν πολυφωνία 128, αλλά με τη βοήθεια λογισμικού μπορούν να φθάσουν μέχρι και 1024 κανάλια. Με 
τη χρήση πολλών καναλιών δημιουργούνται εύκολα συνθέσεις οργάνων.  

Η έκδοση Basic MIDI (ή MIDI 1.0) αφορά στις αρχικές προδιαγραφές MIDI και εμφανίστηκε το 
1983. Περιγράφει τον τρόπο καταγραφής και ανταλλαγής μουσικής μεταξύ ηλεκτρονικών συσκευών. Τα αρ-
χεία της βασικής έκδοσης MIDI, ή καθιερωμένα MIDI, όπως κάποιες φορές αποκαλούνται, έχουν προέκταση 
.mid ή .smf. 

 

 
 
Εικόνα 3.23 Ελεγκτής, συνθετητής MIDI. 

 
Αρχικά, τα μηνύματα MIDI δημιουργούνταν μόνο από ηλεκτρονικές συσκευές που ονομάζονται ελε-

γκτές (controllers) MIDI και συνδέονταν με τον υπολογιστή. Ένας MIDI ελεγκτής μπορεί να είναι πληκτρο-
λόγιο (Εικόνα 3.23), κιθάρα, σαξόφωνο ή κάποιο άλλο όργανο με δυνατότητα εξόδου MIDI. Πλέον, τα αρ-
χεία MIDI μπορούν να παραχθούν και με χρήση εφαρμογών λογισμικού που ονομάζονται ακολουθητές MIDI 
(sequencers). Τα όργανα που μπορούν να λάβουν ως είσοδο μηνύματα MIDI, έχουν αποθηκευμένα διάφορα 
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αποσπάσματα ήχων και ηχητικά εφέ και μπορούν να τα συνδυάζουν και τελικά, να αναπαράγουν το μουσικό 
σήμα, ονομάζονται συνθετητές MIDI (synthesizers). Τα μουσικά πληκτρολόγια, όπως αυτό της Εικόνας 3.23, 
είναι ουσιαστικά ταυτόχρονα controllers και synthesizers. 

Η διασύνδεση των συσκευών MIDI γίνεται μέσω των θυρών MIDI IN, MIDI OUT και MIDI THRU. 
Η θύρα εισόδου MIDI IN είναι η υποδοχή εισόδου, στην οποία εισάγονται πληροφορίες σε μια ηλεκτρονική 
συσκευή συμβατή με το πρότυπο. Συνδέεται πάντα στο MIDI OUT ή στο MIDI THRU άλλων οργάνων. Η 
θύρα MIDI OUT είναι η υποδοχή εξόδου των πληροφοριών MIDI. Αυτή η υποδοχή συνδέεται με την MIDI 
IN υποδοχή άλλης συσκευής, ώστε η δεύτερη συσκευή να λάβει τα μηνύματα. Το όργανο που στέλνει τις 
πληροφορίες, ονομάζεται κύριος ή οδηγός (master), ενώ αυτό που τις δέχεται εξαρτώμενος (slave). Η ενδιά-
μεση θύρα MIDI THRU είναι η υποδοχή που εξάγει τις πληροφορίες που εισάγονται στο MIDI IN του ίδιου 
οργάνου. Χρησιμοποιείται για να στείλει τις πληροφορίες που δέχεται μια ηλεκτρονική συσκευή στη θύρα 
της MIDI IN προς ένα άλλο όργανο, ώστε να δημιουργούνται συστάδες από μουσικές συσκευές συμβατές με 
το πρότυπο. Πολλές από τις σύγχρονες συσκευές μπορούν να διασυνδεθούν με υπολογιστές και να αποστεί-
λουν μηνύματα MIDI μέσω της θύρας USB. 

Το General MIDI (GM-1) εμφανίστηκε το 1991 και αποτελείται από ένα σετ 128 οργάνων και ένα 
καθορισμένο πλήθος ήχων. Το General MIDI είναι επέκταση ορισμένων προδιαγραφών του Basic MIDI, χω-
ρίς όμως να αποτελεί επίσημο πρότυπο. Αποτελεί, στην ουσία, μια προτεινόμενη τακτική που θα πρέπει να 
υιοθετούν όλες οι συσκευές MIDI, αν θέλουμε να αναπαράγουν με τον ίδιο τρόπο όλους τους μουσικούς τό-
νους. Αναθεωρήθηκε και επεκτάθηκε δύο φορές το 1999 και το 2003. Σύμφωνα με το General MIDI, υπάρ-
χουν 128 αριθμοί οργανωμένοι σε 16 ομάδες. Κάθε αριθμός αφορά ένα όργανο ή κάποιο μουσικό εφέ. Στον 
Πίνακα 3.3 αναφέρονται κάποιοι από τους 128 αριθμούς. 

 
Αριθμός 
1. Ακουστικό πιάνο 
33. Ακουστικό μπάσο 
41. Βιολί 
58. Τρομπόνι 
78. Φλάουτο 
125. Ήχος τηλεφώνου 
126. Ήχος ελικοπτέρου 
128. Ήχος πυροβολισμού 

 
Πίνακας 3.3 Παράδειγμα αντιστοίχησης αριθμών και μουσικών οργάνων στο MIDI. 
 

Το Extended MIDI αποτελεί τροποποίηση της γλώσσας περιγραφής του ήχου που υποστηρίζει το 
Basic MIDI. Η τροποποιημένη έκδοση της γλώσσας που προτάθηκε είναι αρκετά πιο πολύπλοκη από την τω-
ρινή της μορφή και για την αναπαραγωγή του ήχου απαιτείται ειδικό υλικό. Το προτεινόμενο νέο πρότυπο 
προαπαιτεί την ύπαρξη άδειας χρήσης από τον εκάστοτε δημιουργό, σε αντίθεση με τις δυο προηγούμενες 
μορφές του MIDI. Γι’ αυτούς τους λόγους, το Extended MIDI δεν καθιερώθηκε ως πρότυπο. 

Η δημιουργία MIDI αρχείων μπορεί να γίνει με δύο τρόπους. Όπως αναφέραμε, τα ηλεκτρονικά μου-
σικά όργανα που έχουν έξοδο MIDI OUT παράγουν κωδικοποιημένο τον ήχο, ο οποίος μπορεί πλέον να εισα-
χθεί στον υπολογιστή ή σε άλλο ηλεκτρονικό όργανο για αναπαραγωγή ή επεξεργασία. Επιπλέον, η δημιουρ-
γία αρχείων MIDI μπορεί να γίνει με χρήση προγραμμάτων επεξεργασίας μουσικού κειμένου (music notation 
ή scorewriter) (π.χ. Sibelius ή MuseScore) και ακολουθητές (sequencers) (π.χ. Cubase ή CakeWalk Sonar) 
που είναι προγράμματα λογισμικού που προσομοιώνουν τη λειτουργία διαφόρων μουσικών οργάνων. 

 

3.4.2. MusicXML 
 
Το πρότυπο MusicXML αναπτύχθηκε από την εταιρεία Recordare και είναι βασισμένο στην XML (Εικόνα 
3.24). Βρίσκεται ήδη στην έκδοση 2 και υποστηρίζει τη μουσική σημειογραφία που αναπτύχθηκε από τον 17ο 
αιώνα και έπειτα.  

Τα πλεονεκτήματα αυτής της μορφής αναπαράστασης της ψηφιακής μουσικής πηγάζουν από το γε-
γονός ότι βασίζεται σε XML δομές. Δηλαδή, μπορεί εύκολα να διαμοιραστεί μεταξύ ετερογενών συστημάτων 
υλικού και λογισμικού και είναι πιο κατανοητή στον άνθρωπο από άλλες μορφές. Βασικό μειονέκτημα έναντι 
των αρχείων MIDI είναι το μέγεθός τους. Για παράδειγμα, σε ένα αρχείο MIDI διάρκειας 1 λεπτού που είχε 
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μέγεθος περίπου 5 KB, το αντίστοιχο αρχείο στη μορφή MusicXML έχει μέγεθος 225 ΚΒ, δηλαδή περίπου 44 
φορές πιο μεγάλο αρχείο. Για το λόγο αυτό, έχει δημιουργηθεί και η συμπιεσμένη μορφή του προτύπου με τα 
αρχεία να έχουν προέκταση .mxl σε αυτή την περίπτωση. Φυσικά, τα πλεονεκτήματα που απορρέουν από την 
XML κωδικοποίηση χάνονται σε αυτή την περίπτωση. 

 
      <note default-x="141.75" default-y="-20.00"> 
       <chord/> 
         <pitch> 
           <step>B</step> 
           <alter>-1</alter> 
           <octave>4</octave> 
 </pitch> 
 <duration>1</duration> 
         <voice>1</voice> 
         <type>eighth</type> 
         <stem>down</stem> 
         <staff>1</staff> 
        </note> 

 
Εικόνα 3.24 Απόσπασμα κώδικα MusicXML 
 
 

3.4.3. XMF (Extensible Music Format) 
 
Τα αρχεία XMF είναι αρχεία υποδοχείς που μπορούν να περιέχουν ένα ή περισσότερα αρχεία μουσικής, π.χ. 
αρχεία MIDI, μαζί με άλλα αρχεία ψηφιοποιουμένου ήχου, π.χ. αρχεία WAV, ώστε να δημιουργείται μια 
μουσική σύνθεση από επιμέρους αρχεία. Τα επιμέρους αρχεία ήχου που αποτελούν τη σύνθεση μπορεί να 
βρίσκονται εντός του υποδοχέα XMF ή να είναι εξωτερικά αρχεία και να αναφέρονται μέσα στο αρχείο υπο-
δοχέα. Υπάρχουν 4 βασικές εκδόσεις της μορφοποίησης. Η ανάπτυξη και συντήρηση του προτύπου γίνεται 
από την ένωση εταιρειών που αναπτύσσουν και το πρότυπο MIDI.  
 

3.4.4. Σύγκριση ψηφιοποιημένου ήχου και ψηφιακής μουσικής 
 
Τα αρχεία ήχου κυματομορφών περιλαμβάνουν ήχους από εξωτερικές πηγές που ψηφιοποιούνται μέσω εξαρ-
τημάτων, όπως η κάρτα ήχου. Τα αρχεία αυτού του τύπου περιέχουν την ακριβή ψηφιακή εικόνα της κυματο-
μορφής τους ήχου, όπως προκύπτει κατόπιν της δειγματοληψίας. Τα αρχεία ψηφιακής μουσικής MIDI και 
MusicXML καταγράφουν πληροφορίες για τον τρόπο με τον οποίο μπορεί να αναπαραχθεί ένα μουσικό κομ-
μάτι. Δηλαδή, αποτελούνται από πληροφορίες για τους επιμέρους ήχους που παράγονται από τα διάφορα όρ-
γανα και συνθέτουν τον τελικό ήχο. 

Η βασική διαφορά ανάμεσα στις δύο μορφές ψηφιακού ήχου είναι ότι τα αρχεία  κυματομορφών 
μπορούν να απεικονίσουν διαφορετικούς ήχους, π.χ. ομιλίες, ήχους περιβάλλοντος, μουσική, ενώ τα αρχεία 
για ψηφιακή μουσική αποθηκεύουν ήχους που έχουν παραχθεί από μουσικά όργανα. Η δημιουργία αρχείων 
της πρώτης μορφής απαιτεί απλά την ύπαρξη ενός μικροφώνου και μιας κάρτας ήχου, ενώ για αρχεία ψηφια-
κής μουσικής απαιτούνται γνώσεις μουσικής και το κατάλληλο υλικό ή λογισμικό.  

Τα αρχεία MIDI και κατ’ επέκταση τα αρχεία MusicXML, έχουν συνήθως μικρότερο μέγεθος, διότι 
δεν περιέχουν τα πραγματικά δεδομένα ήχου, αλλά οδηγίες για την αναπαραγωγή του ηχητικού αποσπάσμα-
τος, υπό τη μορφή αριθμών, για τη νότα, το μουσικό όργανο, τη διάρκεια, κ.α. Το μέγεθος των αρχείων αυτών 
εξαρτάται από το πλήθος των μουσικών οργάνων της σύνθεσης και την πολυπλοκότητα του μουσικού κομμα-
τιού. Το μέγεθος των αρχείων ψηφιοποιημένου ήχου εξαρτάται άμεσα από τη χρονική διάρκεια του ήχου, το 
μέγεθος δείγματος και το ρυθμό δειγματοληψίας. 

Τα αρχεία MIDI και MusicXML μπορούν να επεξεργαστούν πιο εύκολα, καθώς περιέχουν διακριτές 
πληροφορίες μουσικής φύσης. Στην περίπτωση του ψηφιοποιημένου ήχου, είναι πιο δύσκολες οι αλλαγές στα 
δείγματα που αποτελούν το απόσπασμα ήχου. Τα αρχεία ψηφιακής μουσικής μπορούν να εύκολα να μετα-
τραπούν σε αρχεία WAV, ενώ το αντίθετο είναι πιο δύσκολο. Στην πραγματικότητα, υπάρχουν μετρατροπείς 
WAV σε MIDI, αλλά λειτουργούν αποτελεσματικά, όταν ο ψηφιοποιημένος ήχος προέρχεται από ένα μουσι-
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κό όργανο. Ένα μειονέκτημα των MIDI και MusicXML είναι ότι ο ήχος τους ακούγεται πιο τεχνητός ή μηχα-
νικός, σε σχέση με τον ψηφιοποιημένο ήχο. 

 
3.4.5. Λογισμικό επεξεργασίας μουσικού κειμένου 
 
Το λογισμικό επεξεργασίας μουσικού κειμένου (music notation ή scorewriter) επιτρέπει τη δημιουργία και 
επεξεργασία μουσικών συνθέσεων σε επίπεδο παρτιτούρας (Εικόνες 3.25 και 3.26). Όλα τα προγράμματα 
επεξεργασίας μουσικού κειμένου υποστηρίζουν την επιλογή νότας και μουσικού οργάνου και παρέχουν διά-
φορες προηγμένες δυνατότητες, όπως χρήση προκαθορισμένων τμημάτων μουσικής, διαφορετικές σημειο-
γραφίες μουσικού κειμένου, ύπαρξη σχολίων στο μουσικό κείμενο, και υποστήριξη διαφόρων μορφοποιήσε-
ων (π.χ. MIDI ή MusicXML) για εισαγωγή ή εξαγωγή των συνθέσεων.  

 

 
 

Εικόνα 3.25 Εργαλείο ανοιχτού κώδικα για επεξεργασία μουσικού κειμένου MuseScore. 

 

 
 
Εικόνα 3.26 Λογισμικό επεξεργασίας μουσικού κειμένου Sibelius. 

 
Τα εργαλεία μπορεί να είναι ανοιχτού κώδικα, όπως το MuseScore (Εικόνα 3.25) ή εμπορικά εργα-

λεία, όπως το Sibelius (Εικόνα 3.26) ή το Finale της MakeMusic. Οι εφαρμογές αυτές μπορούν να αποθηκεύ-
σουν τα δεδομένα σε κάποιο από τα πρότυπα MIDI ή MusicXML ή σε κάποια δική τους μορφοποίηση που 
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υποστηρίζει το εργαλείο. Επίσης, υποστηρίζουν τη μετατροπή της ψηφιακής μουσικής σε ήχο κυματομορφών 
και σε κάποιες περιπτώσεις την αντίστροφη διαδικασία. Επιπρόσθετα, κάποια από τα εργαλεία παρέχουν και 
λειτουργίες οπτικής αναγνώρισης χαρακτήρων για την ψηφιοποίηση κειμένου που αποτελείται από μουσικά 
σύμβολα. 

 
3.4.6. Ακολουθητές λογισμικού 
 
Ένας ακολουθητής λογισμικού (sequencer) είναι μια εφαρμογή που προσομοιώνει τη λειτουργία των μουσι-
κών οργάνων (Εικόνα 3.27). Οι εκδόσεις των εμπορικών εργαλείων, π.χ. CakeWalk Sonar ή Cubase, υποστη-
ρίζουν διάφορα μουσικά όργανα και επιτρέπουν πολύπλοκες συνθέσεις που παλαιότερα απαιτούσαν εξειδι-
κευμένο υλικό. Η λειτουργία τους βασίζεται στο συνδυασμό αποθηκευμένων δειγμάτων μουσικής από διάφο-
ρα μουσικά όργανα. Οι ακολουθητές λογισμικού έχουν γενικά περισσότερες δυνατότητες από τους συνθετη-
τές υλικού, καθώς μπορούν να εκμεταλλευτούν όλες τις δυνατότητες των υπολογιστών. Απαιτούν όμως ισχυ-
ρούς επεξεργαστές, μεγάλη κύρια μνήμη και κάρτα ήχου με αρκετές δυνατότητες. 

 
 

 
 
Εικόνα 3.27 Εργαλείο CakeWalk Sonar. 

 

3.5. Υλικό για ψηφιοποίηση και επεξεργασία ήχου 
 
Στις πιο πάνω ενότητες, αναλύθηκαν τα ζητήματα που σχετίζονται με τη ψηφιοποίηση ήχου, τις μορφές απο-
θήκευσης του ψηφιοποιημένου ήχου κυματομορφών, τα εργαλεία επεξεργασίας, αλλά και τις μορφές αποθή-
κευσης και τα εργαλεία ψηφιακής μουσικής. Για την ψηφιοποίηση, επεξεργασία και αναπαραγωγή ήχου είναι 
απαραίτητη η ύπαρξη μικροφώνου, κάρτας ήχου και ηχείων. Στις ακόλουθες ενότητες θα αναλυθεί ο ρόλος 
και τα χαρακτηριστικά του υλικού για ήχο. 

 

3.5.1. Μικρόφωνο 
 
Το μικρόφωνο (microphone) προσομοιάζει τη λειτουργία του ανθρώπινου αισθητηρίου οργάνου της ακοής. 
Δηλαδή, λαμβάνει τη μηχανική ενέργεια που προκαλείται από την ταλάντωση των μορίων του αέρα και τη 
μετατρέπει σε ηλεκτρική ενέργεια. Ανεξάρτητα από τη μορφή τους (Εικόνα 3.28), όλα τα μικρόφωνα έχουν 
ένα διάφραγμα που είναι αρκετά λεπτό και δονείται, όταν προσπίπτουν σε αυτό τα ηχητικά κύματα. Ανάλογα 
με τον τύπο του μικροφώνου, το διάφραγμα μπορεί να είναι χάρτινο ή πλαστικό ή από αλουμίνιο. Πίσω από 
το διάφραγμα υπάρχει ένα πηνίο στο οποίο δημιουργούνται ηλεκτρικά φορτία από τη δόνηση του διαφράγμα-
τος. Το αρχικό ηλεκτρικό σήμα ενισχύεται και τελικά, το νέο σήμα αντιπροσωπεύει το αρχικό ακουστικό σή-
μα. Τα μικρόφωνα διακρίνονται σε μικρόφωνα δυναμικού πηνίου, πυκνωτή, πιεζοηλεκτρικού κρυστάλλου και 
ταινιοειδή, ανάλογα με την τεχνολογία κατασκευής τους. Γενικότερα, τα σύγχρονα μικρόφωνα επιτρέπουν σε 
ένα ευρύ φάσμα συχνοτήτων να αποδοθεί σωστά. 

Τα βασικά χαρακτηριστικά των μικροφώνων είναι η ευαισθησία (sensitivity) και η φασματική από-
κριση (frequency response). Η ευαισθησία του μικροφώνου αφορά την ικανότητα του μικροφώνου να λαμ-
βάνει αδύναμους ήχους. Μεγαλύτερη ευαισθησία σε ένα μικρόφωνο σημαίνει δυνατότητα απόδοσης ήχων 
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χαμηλής έντασης. Η ευαισθησία εκφράζεται σε db και συνήθως είναι αρνητικός αριθμός, καθώς αντιστοιχεί 
τελικά σε ηλεκτρικό σήμα που είναι μικρότερο από 1 Volt. Τυπικές τιμές, για απλά μικρόφωνα υπολογιστή, 
είναι οι τιμές -62db, -58db και -54db. Μικρόφωνα με ευαισθησία -54 db είναι γενικά καλύτερα από μικρόφω-
να με ευαισθησία -62 db, αλλά θα συλλαμβάνουν και τους εξωτερικούς θορύβους. 

 

 
 
Εικόνα 3.28 Διάφοροι τύποι μικροφώνων. 

 
Η φασματική απόκριση ή συχνότητα ανταπόκρισης, όπως επίσης αναφέρεται, αφορά στο φάσμα συ-

χνοτήτων που μπορεί ένα μικρόφωνο να αναπαραστήσει σωστά. Είναι, λοιπόν, εξίσου σημαντικό κριτήριο με 
την ευαισθησία για την επιλογή ενός μικροφώνου. Για παράδειγμα, μικρόφωνο με εύρος συχνοτήτων 20Hz - 
20 KHz είναι καλύτερο από μικρόφωνο με εύρος 30Hz - 16 KHz. 

Οι δύο πιο πάνω παράγοντες είναι αρκετοί για την αγορά μικροφώνου για απλές ηχογραφήσεις με τη 
βοήθεια υπολογιστή. Στην περίπτωση φυσικά, που οι επαγγελματικές απαιτήσεις είναι μεγαλύτερες, απαιτεί-
ται η αγορά πιο ακριβού μοντέλου και εκεί παίζει ρόλο ο τύπος του μικροφώνου, καθώς και άλλα χαρακτηρι-
στικά. 

 

3.5.2. Κάρτα ήχου 
 
Η κάρτα ήχου (sound card) (Εικόνα 3.29) σε ένα υπολογιστή αναλαμβάνει τις λειτουργίες που σχετίζονται με 
την εγγραφή, επεξεργασία και αναπαραγωγή του ήχου. Λαμβάνει το αναλογικό σήμα του μικροφώνου και το 
ψηφιοποιεί, αλλά μετατρέπει και το ψηφιακό σήμα σε αναλογικό για αναπαραγωγή μέσω των ηχείων. Γενι-
κώς, οι λειτουργίες της κάρτας μπορούν να συνοψισθούν στις αναπαραγωγή (play), εγγραφή (record), σύνθεση 
(synthesize) και επεξεργασία (processing). 

 

 
 

Εικόνα 3.29 Τυπική κάρτα ήχου. 
 
Το σημαντικότερο τμήμα της κάρτας ήχου είναι ο ψηφιακός επεξεργαστής σήματος (DSP - Digital 

Signal Processor) ή επεξεργαστής ήχου, που αναλαμβάνει τους περισσότερους υπολογισμούς που σχετίζονται 
με την επεξεργασία ήχου. Οι δυνατότητες των καρτών ήχου αξιολογούνται με βάση το μέγιστο υποστηριζό-
μενο ρυθμό δειγματοληψίας (π.χ. 192 KHz) και το μέγιστο μέγεθος δείγματος (π.χ. 24 bit). 

Μια τυπική κάρτα ήχου αποτελείται, επίσης, από ένα ολοκληρωμένο κύκλωμα ήχου που περιέχει συ-
νήθως ένα ψηφιακό-σε-αναλογικό μετατροπέα (DAC – Digital-to-Analog Converter) και ένα αναλογικό-σε-
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ψηφιακό μετατροπέα (ADC – Analog-to-Digital Converter). Ο DAC αναλαμβάνει τη μετατροπή του σήματος 
από ψηφιακό σε αναλογικό για την έξοδο μέσω ηχείων ή ακουστικών ή άλλων συσκευών ήχου, όπως ενισχυ-
τές, και ο ADC την αντίστροφη διαδικασία κατά την είσοδο σήματος μέσω μικροφώνου. Και στις δύο περι-
πτώσεις, το μέγιστο υποστηριζόμενο μέγεθος δείγματος είναι το κριτήριο αξιολόγησης των κυκλωμάτων αυ-
τών. Συνήθως, το μέγιστο μέγεθος δείγματος (μέγιστη ανάλυση) είναι 24 bit. 

Οι κάρτες ήχου έχουν μια κύρια είσοδο (Line In), από όπου μπορεί να εισαχθεί το ηχητικό σήμα, από 
αναλογικά όργανα καταγραφής ταινιών, κασετών ή παρόμοιων ηχητικών πηγών (Εικόνα 3.30). Η θύρα αυτή 
είναι χρώματος ανοιχτού μπλε. Κάποιες διαθέτουν και μια θύρα εισόδου MIDI/Game port για MIDI συσκευές 
ή για σύνδεση Joystick, αν και στους σύγχρονους υπολογιστές η σύνδεση αυτών των συσκευών γίνεται μέσω 
της θύρας USB. Το μικρόφωνο συνδέεται στη ροζ θύρα της κάρτας (Mic In). 

 

 
 
Εικόνα 3.30 Έξοδοι σύγχρονης κάρτας ήχου. 

 
Στη θύρα Line Out, που έχει χρώμα ανοικτό πράσινο, συνδέονται τα ηχεία. Στις σύγχρονες κάρτες, η 

θύρα αυτή ονομάζεται Front Out, διότι οι κάρτες υποστηρίζουν ήχο 5.1 ή 7.1 και έχουν περισσότερες θύρες 
εξόδου για ηχεία. Στην θύρα ανοιχτού πράσινου συνδέονται τα πρόσθια ηχεία, ενώ στις θύρες που έχουν πορ-
τοκαλί, μαύρο και γκρι χρώμα, συνδέονται τα πίσω και τα πλαϊνά ηχεία, καθώς και το κεντρικό subwoofer. 
Κάποιες σύγχρονες κάρτες ήχου διαθέτουν και ψηφιακή έξοδο ήχου, μέσω ομοαξονικού καλωδίου ή οπτικής 
ίνας για έξοδο ήχου προς συσκευές που διαθέτουν την ανάλογη είσοδο. Σε αυτές τις περιπτώσεις, ο ψηφιακός 
πολυκάναλος ήχος είναι σε μορφή DTS ή Dolby Digital. 

Η φασματική απόκριση συχνοτήτων είναι ένα επιπλέον χαρακτηριστικό των καρτών ήχου. Συνήθως, 
το εύρος συχνοτήτων είναι αρκετά μεγάλο, π.χ. 10Hz έως 48KHz, που είναι αρκετό για τις τυπικές ανάγκες 
επεξεργασίας ήχου. Οι κάρτες ήχου συνδέονται στις υποδοχές PCI, αν και κάποιες συσκευές επεξεργασίας 
ήχου, που συνήθως χρησιμοποιούνται για επέκταση των δυνατοτήτων των βασικών καρτών ήχου, συνδέονται 
σε USB θύρες. Τα πιο φθηνά μοντέλα υπολογιστών περιέχουν κάρτα ήχου ενσωματωμένη στην κεντρική 
πλακέτα, που έχουν όμως λιγότερες δυνατότητες.  

 

3.5.3. Ηχεία 
 
Τα ηχεία (speakers) (Εικόνα 3.31) αναπαράγουν τον ήχο που λαμβάνουν από τις κάρτες ήχου. Πρόκειται για 
αναλογικές συσκευές που δέχονται το ηλεκτρικό σήμα και μέσω της δόνησης των χάρτινων κώνων τους, πα-
ράγεται ο ήχος.  

 

 
 

Εικόνα 3.31 (α) Τυπικό συστήματα ηχείων.(β) Σύστημα ηχείων 5.1. 
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Πιο συγκεκριμένα, τα περισσότερα ηχεία περιέχουν εσωτερικά έναν μόνιμο μαγνήτη και ένα πηνίο 
φωνής πίσω από έναν, συνήθως, χάρτινο κώνο (Εικόνα 3.33). Το ηλεκτρικό σήμα εισέρχεται στο πηνίο φω-
νής και παράγει ένα μεταβαλλόμενο μαγνητικό πεδίο που αναγκάζει το πηνίο φωνής να δονείται. Το πηνίο 
φωνής συνδέεται με τον εύκαμπτο χάρτινο κώνο που υπάρχει στο πρόσθιο τμήμα του ηχείου και συνεπώς, ο 
κώνος δονείται και δημιουργείται το ακουστικό κύμα, δηλαδή η ταλάντωση των μορίων στον αέρα. Η πίεση 
αυτή μεταδίδεται στη συνέχεια μέσω της δόνησης των σωματιδίων του αέρα, όπως στην περίπτωση παραγω-
γής και μετάδοσης ήχου από οποιοδήποτε άλλο σώμα. 

 

 

 
Εικόνα 3.33 Εσωτερική άποψη ηχείου. 

 
Τα ηχεία διαφέρουν στο μέγεθός τους, την ποιότητα κατασκευής τους και τη σκληρότητα του χάρτι-

νου κώνου. Ανάλογα με τις συχνότητες που μπορούν να παράγουν, τα ηχεία διακρίνονται σε woofers, 
tweeters και midrange. Τα woofers είναι τα μεγαλύτερα ηχεία και μπορούν να παράγουν ήχους χαμηλών συ-
χνοτήτων (μπάσα). Τα tweeters είναι μικρές μονάδες που παράγουν τις υψηλές συχνότητες ήχου (πρίμα) και 
τα midrange είναι ηχεία ενδιάμεσων διαστάσεων για να παράγουν τις ενδιάμεσες συχνότητες ήχου. 

Τα βασικά χαρακτηριστικά των απλών ηχείων υπολογιστή αφορούν τις συχνότητες που μπορεί να 
αναπαράγουν (π.χ. 50Hz – 20 KHz) και την ισχύ τους που εκφράζεται σε Watt. Μεγαλύτερη ισχύς σε Watt 
σημαίνει μεγαλύτερη ένταση ήχου σε decibels, αν και η σχέση τους είναι λογαριθμική, όπως είδαμε πιο πάνω. 
Δηλαδή, διπλασιασμός της ισχύος δεν αντιστοιχεί σε διπλασιασμό της έντασης, αλλά σε μικρή αύξηση της 
έντασης. 

 

3.6. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο παρόν κεφάλαιο παρουσιάστηκαν οι βασικές έννοιες που σχετίζονται με την ψηφιοποίηση ήχου και την 
αναπαράστασή του σε ψηφιακή μορφή. Επιπλέον, παρουσιάστηκαν τα βασικά χαρακτηριστικά διαφόρων 
μορφών ψηφιοποιημένου ήχου και ψηφιακής μουσικής και τα εργαλεία αναπαραγωγής και επεξεργασίας αυ-
τών των μορφών. Σύντομη αναφορά έγινε και στο υλικό που απαιτείται για την αναπαραγωγή και επεξεργα-
σία ήχου σε ένα τυπικό υπολογιστικό σύστημα.  

Ο ήχος δημιουργείται από δονούμενα αντικείμενα, όπως για παράδειγμα, οι φωνητικές χορδές των 
ανθρώπων και μεταδίδεται σε κάποιο μέσο, όπως ο αέρας. Η συχνότητα του ήχου είναι ο αριθμός των κυμά-
των που δημιουργούνται από το σώμα που παράγει τα ηχητικά κύματα ανά δευτερόλεπτο. Η ένταση καθορί-
ζει πόσο δυνατά ακούγεται ένας ήχος και συνήθως, εκφράζεται στη μονάδα decibel (db). Η ακουστότητα, που 
είναι η υποκειμενική ένταση του ήχου, εξαρτάται από την ακουστική ικανότητα του ακροατή, τη διάρκεια του 
ήχου και τη συχνότητα. Το ύψος είναι ένα υποκειμενικό χαρακτηριστικό που μας επιτρέπει να διακρίνουμε 
τους ήχους σε οξείς (μεγάλης συχνότητας), μέσους (μεσαίας συχνότητας) και σε βαρείς (μικρής συχνότητας). 
Η χροιά ή ηχόχρωμα είναι το υποκειμενικό χαρακτηριστικό που μας επιτρέπει να ξεχωρίσουμε δύο ήχους που 
έχουν ίδιο ύψος και ένταση. 

Η ψηφιοποίηση ήχου περιλαμβάνει τις φάσεις της δειγματοληψίας και της κβάντισης. Κατά τη δειγ-
ματοληψία λαμβάνονται, περιοδικά, δείγματα, ανάλογα με τη συχνότητα δειγματοληψίας. Στη διαδικασία της 
κβάντισης, τα δείγματα μεταβάλλονται, ώστε να λαμβάνουν τιμές από ένα προκαθορισμένο σύνολο διακρι-
τών τιμών. 
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Οι ήχοι, ανάλογα με τον αριθμό των πηγών εγγραφής χωρίζονται σε μονοφωνικούς, στερεοφωνικούς 
ή πολυφωνικούς. Το σύστημα 5.1 είναι το όνομα για το σύστημα πολυκάναλου ήχου που αποτελείται από 5 
κανάλια πλήρους εύρους συχνοτήτων και ένα κανάλι χαμηλών συχνοτήτων. 

Το μέγεθος ενός ασυμπίεστου ψηφιακού αρχείου ήχου κυματομορφών εξαρτάται κατά κύριο λόγο 
από τον αριθμό των δειγμάτων, το μέγεθος δείγματος και τη διάρκεια. Ο ρυθμός μετάδοσης είναι ο ρυθμός 
μεταφοράς πληροφορίας από ένα μέσο και μπορεί να είναι σταθερός (CBR) ή μεταβλητός (VBR). 

Επειδή ο ασυμπίεστος ήχος έχει μέγεθος απαγορευτικό για διάφορες εφαρμογές, αναπτύχθηκαν διά-
φορες τεχνικές κωδικοποίησης και συμπίεσης. Γνωστές τεχνικές κωδικοποίησης που επιτυγχάνουν μικρή συ-
μπίεση αποτελούν οι DPCM και ADPCM και διαδεδομένες απωλεστικές τεχνικές μεγάλης συμπίεσης αποτε-
λούν οι MP3, WMA και Vorbis. Κωδικοποιητές, όπως οι FLAC και MPEG-ALS προσφέρουν μη απωλεστική 
συμπίεση ηχητικών δεδομένων. Οι πιο γνωστές μορφοποιήσεις για αποθήκευση δεδομένων ψηφιοποιημένου 
ήχου είναι οι WAV, AIFF, WMA, MP3, Ogg Vorbis και RA. Τα φορμά αυτά ενσωματώνουν κάποιον κωδι-
κοποιητή που, ενδεχομένως, να υποστηρίζει συμπίεση δεδομένων. 

Η συνεχής ροή δεδομένων ήχου (streaming audio) αφορά την τμηματική μετάδοση πληροφοριών ή-
χου σε πραγματικό χρόνο μέσω διαδικτύου και την άμεση αναπαραγωγή του. Η διαδικασία resampling αφορά 
στην μετατροπή του ρυθμού δειγματοληψίας σε μεγαλύτερο ή μικρότερο από το ρυθμό που είχε χρησιμοποι-
ηθεί για την εγγραφή του ήχου. Το φάσμα συχνοτήτων αναπαριστά τις συχνότητες του ήχου σε σχέση με την 
ένταση ή το χρόνο και βοηθά στη μαζική επεξεργασία των συχνοτήτων του αποσπάσματος ήχου. Οι γλώσσες 
προγραμματισμού για ήχο είναι ειδικά σχεδιασμένες για την παραγωγή και επεξεργασία ηχητικών δεδομένων. 

Για την επεξεργασία και την αναπαραγωγή ψηφιοποιημένου ήχου έχουν αναπτυχθεί διάφορες εφαρ-
μογές. Τα εργαλεία ολοκληρωμένης επεξεργασίας ήχου Audacity, Adobe Audition και Sony Sound Forge 
έχουν δυνατότητες μετατροπής από μία μορφή ήχου σε άλλη, χρήση ειδικών εφέ, ηχογράφησης και μίξης ή-
χου και άλλες πιο προηγμένες δυνατότητες. Επίσης, υπάρχουν και εφαρμογές λογισμικού με πιο ειδικούς 
σκοπούς, π.χ. εγγραφή ή αναπαραγωγή αρχείων ήχου. 

Το πρότυπο MIDI, αλλά και άλλες μορφές, όπως οι MusicXML και XMF αποτελούν πρότυπα για κα-
ταγραφή και διαμοιρασμό μουσικών συνθέσεων. Οι μορφές αυτές αποθηκεύουν πληροφορίες για μουσικές 
συνθέσεις, όπως οι νότες, η διάρκεια, το μουσικό όργανο που παρήγαγε τη μουσική, κ.ά. Η δημιουργία αυτών 
των συνθέσεων μπορεί να γίνει με είσοδο δεδομένων από κάποιο μουσικό όργανο ή μέσω προγραμμάτων ε-
πεξεργασίας μουσικού κειμένου. 

Το υλικό που είναι απαραίτητο για την ψηφιοποίηση, επεξεργασία και αναπαραγωγή ήχου είναι το 
μικρόφωνο, η κάρτα ήχου και τα ηχεία. Και στις τρεις περιπτώσεις υλικού, το εύρος συχνοτήτων που υπο-
στηρίζεται είναι σημαντικός παράγοντας. Στην κάρτα ήχου οι έξοδοι, ο μέγιστος υποστηριζόμενος ρυθμός 
δειγματοληψίας και το μέγιστο μέγεθος δείγματος είναι, επίσης, καθοριστικοί παράγοντες. Τα ηχεία διαφορο-
ποιούνται με βάση το μέγεθος, την ποιότητα και το υλικό κατασκευής τους. 
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4. Θεωρία Ψηφιακών Γραφικών 3Δ & Σχεδιοκίνησης 
 

Σύνοψη 
Στο συγκεκριμένο κεφάλαιο γίνεται ανάλυση των βασικών θεμάτων, που σχετίζονται με τα τρισδιάστατα γραφι-
κά και τη σχεδιοκίνηση. Αρχικά αναφέρονται συνοπτικά τα βήματα δημιουργίας των τρισδιάστατων γραφικών 
και παρουσιάζονται οι τεχνικές μοντελοποίησης τρισδιάστατων σχημάτων με πολύγωνα και καμπύλες NURBS. 
Στη συνέχεια γίνεται ανάλυση των τεχνικών ρεαλιστικής απόδοσης με χαρτογράφηση υφής, σκιών και σκιάσεων 
με τις τεχνικές Radiosity και Ray Tracing και παρουσιάζονται τα βασικά εργαλεία για τη δημιουργία τρισδιά-
στατων γραφικών. Στη δεύτερη ενότητα του κεφαλαίου μελετάμε κάποια θέματα που σχετίζονται με τη σχεδιοκί-
νηση (animation). Παρουσιάζονται οι κλασικές τεχνικές cel και path animation για την κίνηση δισδιάστατων 
εικόνων και οι τεχνικές απόδοσης κίνησης στον χώρο kinematics και motion capture. Κάποιες σχετικές τεχνικές 
για προσομοίωση ειδικών περιπτώσεων κίνησης, τα εργαλεία, καθώς και οι μορφοποιήσεις αρχείων animation, 
παρουσιάζονται στο τέλος του κεφαλαίου. 

 

Προαπαιτούμενη γνώση 
Το κεφάλαιο αποτελεί αυτόνομη ενότητα παρουσίασης αρκετών θεμάτων, που σχετίζονται με τη μοντελοποίηση 
τρισδιάστατων γραφικών και την ρεαλιστική απόδοση. Θα πρέπει να έχει γίνει μελέτη του προηγούμενου κεφα-
λαίου, ώστε να έχουν γίνει κατανοητά τα θέματα που συνδέονται με τις εικόνες, π.χ. τα χρωματικά μοντέλα, τα 
φίλτρα κ.ά.  

 

4.1. Εισαγωγή στα γραφικά 3Δ 
 
Τα τρισδιάστατα γραφικά (3D graphics ή γραφικά 3Δ) αποτελούν βασικό τμήμα όλων των πολυμεσικών 
εφαρμογών. Σε κάποιες εφαρμογές εμφανίζονται απλά τρισδιάστατα γραφικά για μενού πλοήγησης και άλλα 
εικονίδια (Εικόνα 4.1). Τα περισσότερα από αυτά τα εικονίδια δημιουργούνται σχεδόν σε όλες τις εφαρμογές 
γραφικών, με εφαρμογή κάποιου φίλτρου για μετατροπή σε 3D και κάποιο φίλτρου φωτισμού. Ακόμη και 
εφαρμογές γραφείου, π.χ. Word, παρέχουν κάποιες δυνατότητες για απλά τρισδιάστατα γραφικά. 

 

 
[Πηγή: http://goo.gl/C7tUiI]  
 
Εικόνα 4.1 Τρισδιάστατα εικονίδια. 

 
Σε πιο πολύπλοκες εφαρμογές παιχνιδιών, εικονικής πραγματικότητας (virtual reality) και σχεδιαστι-

κών συστημάτων για μηχανικούς, τα σχέδια είναι πιο πολύπλοκα (Εικόνες 4.2 & 4.3). Στα πολύπλοκα αυτά 
σχέδια απαιτείται η δημιουργία του τρισδιάστατου γραφικού, η τοποθέτηση υφών πάνω στο αντικείμενο και 
τη χρήση φωτισμού και σκίασης. Κάποια από αυτά τα στάδια θα μελετήσουμε στις παρακάτω ενότητες του 
κεφαλαίου. 

 

4.2. Απεικόνιση 3Δ 
 

Το βάθος πεδίου (depth of field) και η εστίαση σε κάποιο σημείο (focal point) είναι ιδιότητες, που όταν απο-
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δοθούν σε ένα αντικείμενο, τότε εμφανίζεται ότι υπάρχει η έννοια του βάθους, δηλαδή της τρίτης διάστασης. 
Το βάθος πεδίου και, γενικά, η τρισδιάστατη απεικόνιση ενός αντικειμένου επιτυγχάνεται με συνδυασμό δια-
φόρων τεχνικών. Για παράδειγμα, το αντικείμενο μπορεί να περιστραφεί, να αποτελείται από επιμέρους αντι-
κείμενα, να γίνεται αλλαγή του μεγέθους του, να εφαρμόζονται εφέ σκίασης και φωτισμού και να αλλάζει η 
γωνίας θέασης. Στην Εικόνα 4.4, για παράδειγμα, φυσικά αντικείμενα έχουν τοποθετηθεί σε διαφορετικές 
θέσεις, ενώ με τη βοήθεια σκίασης και θόλωσης των αντικειμένων απεικονίζονται ως αιρούμενα στον χώρο. 
Στην Εικόνα 4.5 εμφανίζονται κάποιες μπάλες που έχουν δημιουργηθεί από υπολογιστή. Το βάθος πεδίου 
επιτυγχάνεται με σταδιακή μείωση του μεγέθους των αντικειμένων και θόλωση. 

 

 
[Πηγή: http://goo.gl/jA7lFd] 
 
Εικόνα 4.2 Τρισδιάστατο σχέδιο. 

 

 
[Πηγή: http://goo.gl/yYWvnt] 
 
Εικόνα 4.3 Τρισδιάστατο σχέδιο σε εφαρμογή εικονικής πραγματικότητας. 

 
Για την απόδοση βάθους σε ένα σχήμα πρέπει να εφαρμοστούν τα εξής γενικά βήματα: 
 

 Δημιουργία του σχήματος, ως ένα σύνολο από άλλα σχήματα, είτε ως αυτόνομο σχήμα που 
υπάρχει στην εφαρμογή. Η δημιουργία του σχήματος αναφέρεται ως μοντελοποίηση 3Δ (3d 
modeling) και είναι το πιο σημαντικό βήμα της διαδικασίας. Για παράδειγμα, στην Εικόνα 4.6 
εμφανίζεται ο σκελετός (wireframe) του σχήματος της Εικόνας 4.2. 

 
 Τοποθέτηση χρώματος ή υφής πάνω στο αντικείμενο, ώστε να πάρει κάποια συγκεκριμένη 

μορφή και να φτάσουμε σε κάποιο ρεαλιστικό αποτέλεσμα. Στην Εικόνα 4.6 τοποθετήθηκαν 
υφές, προκειμένου να δημιουργηθεί η Εικόνα 4.2. Στην Εικόνα 4.7 εφαρμόστηκε κάποιο 
χρώμα και σκιάσεις, ώστε να δημιουργηθεί η Εικόνα 4.8. 
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[Πηγή: http://goo.gl/GdqKLp] 
 
Εικόνα 4.4 Φυσικά αντικείμενα που εμφανίζονται στον χώρο. 

 

 
[Πηγή: https://goo.gl/MWosOS] 
 
Εικόνα 4.5 Τρισδιάστατα σχήματα που έχουν δημιουργηθεί σε υπολογιστή. 

 

 
 
Εικόνα 4.6 Σύνθετο σχήμα που έχει δημιουργηθεί από απλούστερα σχήματα και γραμμές. 

 
 Εφαρμογή σκίασης (shading) πάνω στο αντικείμενο. Πρόκειται για τη διαδικασία δημιουργί-

ας σκουρόχρωμων και ανοιχτόχρωμων περιοχών στην επιφάνεια του αντικειμένου, που δημι-
ουργούνται στο αντικείμενο, όταν αυτό φωτίζεται από μία ή περισσότερες πηγές φωτός. Οι 
περιοχές που είναι στραμένες προς την πηγή φωτός είναι ανοιχτόχρωμες, ενώ οι υπόλοιπες 
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είναι πιο σκοτεινές. Αυτό προσδίδει την εντύπωση ότι οι περιοχές που είναι σκουρόχρωμες, 
βρίσκονται στο βάθος της σκηνής και έτσι ενισχύεται η τρισδιάστατη μορφή. 

 
 Εφαρμογή σκιών (shadows). Πρόκειται για διαδικασία που αναφέρεται στην ύπαρξη σκιών, 

που δημιουργεί το αντικείμενο πάνω σε μια επιφάνεια ή σε κάποιο άλλο αντικείμενο. Εξαρ-
τάται, επίσης, από την κατεύθυνση της πηγής φωτός που προσπίπτει στο αντικείμενο. Αυτή η 
τακτική προσδίδει την αίσθηση της μπροστά και πίσω όψης του αντικειμένου. 

 
 Προσθήκη εικόνων φόντου ή άλλων εικόνων, που προσδίδουν ρεαλισμό στην τρισδιάστατη 

απεικόνιση. 
 

4.2.1. 3Δ μοντελοποίηση 
 
Η τρισδιάστατη μοντελοποίηση (3D modeling) είναι η διαδικασία ανάπτυξης γραφικών και εικόνων, που 
εμφανίζονται να έχουν τρεις διαστάσεις. Η διαδικασία είναι αρκετά σύνθετη, αλλά γενικά μπορούμε να πούμε 
ότι περιλαμβάνει την ένωση διαφόρων σημείων στο επίπεδο με γραμμές και καμπύλα τμήματα, με σκοπό τη 
δημιουργία ενός σκελετού (π.χ. Εικόνες 4.6 και Εικόνα 4.7). Χρησιμοποιείται στη δημιουργία γραφικών σε 
παιχνίδια, ταινίες με animation, σε προσομοιώσεις στην Ιατρική και τη μηχανική και, γενικά, όπου απαιτού-
νται τρισδιάστατα γραφικά. Οι κύριες τεχνικές, που χρησιμοποιούνται στην τρισδιάστατη μοντελοποίηση, 
είναι η μοντελοποίηση με πολύγωνα (polygon modeling), καθώς και η τεχνική που είναι γνωστή με το ακρω-
νύμιο NURBS (Non-Uniform Rational B-Spline). 

 

 
 
Εικόνα 4.7 Σύνθετο σχήμα που έχει δημιουργηθεί από απλούστερα σχήματα και γραμμές. 
 
 

 
 
Εικόνα 4.8 Το σχήμα της προηγούμενης εικόνας με χρώματα στην επιφάνεια και υφές. 
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4.2.1.1. 3Δ μοντελοποίηση με πολύγωνα 
 
Τα περισσότερα προγράμματα σχεδίασης, περιέχουν έτοιμα απλά σχήματα, όπως κύβους, κώνους και σφαίρες 
(π.χ. Εικόνα 4.9). Όμως, για να δημιουργήσουμε πιο σύνθετα αντικείμενα, μπορούμε να συνδυάσουμε πολύ-
γωνα. Ως πολύγωνο μπορούμε να ορίσουμε οποιοδήποτε σχήμα έχει ακμές και γωνίες. Ακόμη και ένα τρίγω-
νο αποτελεί πολύγωνο.  

 

 
 
Εικόνα 4.9 Απλό τρισδιάστατο αντικείμενο.  

 
Στην Εικόνα 4.10 εμφανίζεται ένα πολύγωνο με τα βασικά τμήματα που μας ενδιαφέρουν: 

 Vertex (κορυφή): Είναι το σημαντικότερο τμήμα ενός πολυγώνου, γιατί έχει συντεταγμένες 
στον χώρο. Αυτά τα σημεία συνδέονται δημιουργώντας τα σχήματα που βλέπουμε. Σε ένα 
τρίγωνο υπάρχουν 3 κορυφές. Με ένωση αυτών των κορυφών σχηματίζεται το τρίγωνο. 

 Edge (ακμή): Είναι η γραμμή που συνδέει δύο κορυφές. Στο τρίγωνο π.χ. έχουμε 3 ακμές. 
 Face (πρόσοψη ή έδρα): Είναι ο χώρος μεταξύ των ενωμένων κορυφών. Πρακτικά, είναι το 

τμήμα που έχει μετατραπεί σε pixels και εμφανίζεται στην οθόνη του υπολογιστή μας. 
 

 
 
Εικόνα 4.10 Πολύγωνο όπου διακρίνονται τα βασικά στοιχεία του.  

 
Τα ίδια δομικά στοιχεία αποτελούν οποιοδήποτε πολύγωνο. Μπορούμε να τροποποιήσουμε (μετακι-

νήσουμε, περιστρέψουμε, αλλάξουμε διαστάσεις) οποιοδήποτε πολύγωνο, μετακινώντας πρακτικά τις κορυ-
φές. Τα υπόλοιπα τμήματα ακολουθούν τις κορυφές. Ο δημιουργός των τρισδιάστατων μοντέλων εργάζεται, 
συνήθως, σε επίπεδο σημείων, ώστε να δημιουργήσει ένα πιο σύνθετο μοντέλο. Τα πολύγωνα παίζουν σημα-
ντικό ρόλο στη δημιουργία γραφικών 3D. Απλά σκεφτείτε ότι το σχήμα της Εικόνας 4.9 αποτελείται από 3 
επιμέρους πολύγωνα, προκειμένου να δημιουργηθεί ο κύβος. 

Συνήθως τα αντικείμενα 3Δ αποτελούνται από τρίγωνα. Ακόμη και σύνθετα αντικείμενα, όπως χαρα-
κτήρες ταινιών animation, συνθέτονται από τρίγωνα. Στην Εικόνα 4.11 βλέπουμε μια σφαίρα που αποτελείται 
από πολύγωνα. Η ίδια σφαίρα εμφανίζεται στην Εικόνα 4.12, μόνο που τώρα εμφανίζονται τα τρίγωνα, στα 
οποία μπορεί να αναλυθεί.  

Πρακτικά, βέβαια, δεν είναι απαραίτητο να δημιουργηθούν όλα τα σχέδια σε επίπεδο τριγώνων, αλλά 
μπορεί να χρησιμοποιηθούν και τετράγωνα ή και σχήματα με περισσότερες γωνίες. Σε κάθε περίπτωση, κάθε 
πολύγωνο μπορεί να αναλυθεί σε τρίγωνα. Οι ομάδες πολυγώνων που σχηματίζουν ένα μοντέλο, ονομάζονται 
polygon mesh (πλέγμα πολυγώνων). 

Έχοντας εξηγήσει τι είναι τελικά τα πλέγματα πολυγώνων και από τι απαρτίζονται, πρέπει να δούμε 
πώς δημιουργούνται τα τρισδιάστατα μοντέλα. Ένας τρόπος είναι η χρήση βασικών, θεμελιωδών (primitive) 
σχημάτων. Όλα τα εργαλεία τρισδιάστατων γραφικών διαθέτουν έτοιμα τρισδιάστατα αντικείμενα, όπως π.χ. 
η σφαίρα των Εικόνων 4.11 και 4.12. Δηλαδή, σχεδιάζουμε απευθείας, με ένα απλό κλικ, ένα βασικό τρισ-
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διάστατο σχέδιο, χωρίς να χρειαστεί να κατέβουμε σε επίπεδο τριγώνων ή πολυγώνων. Στη συνέχεια μπορού-
με να αρχίσουμε να διαμορφώνουμε το σχήμα σε κάποια άλλη μορφή που επιθυμούμε (π.χ. Εικόνα 4.13). Η 
διαμόρφωση μπορεί να γίνει είτε μέσω των παραμέτρων των σχημάτων είτε με τα εργαλεία (scale, rotate, 
freehand κ.ά.) που διαθέτει το λογισμικό επεξεργασίας. 

 

 
 
Εικόνα 4.11 Σφαίρα όπου διακρίνονται τα πολύγωνα από τα οποία αποτελείται.  

 

 
 
Εικόνα 4.12 Σφαίρα όπου διακρίνονται τα τρίγωνα από τα οποία αποτελείται.  

 

 
 
Εικόνα 4.13 Τροποποίηση σφαίρας στο 3ds Max.  

 
Ένας άλλος τρόπος είναι η δημιουργία σημείο-προς-σημείο (point-to-point) ενός μοντέλου πολυγώ-

νων. Με απλά λόγια αρχίζουμε κάνοντας κλικ σε διάφορα σημεία στην οθόνη, τα οποία τελικά θα αποτελέ-
σουν τις κορυφές του πολυγώνου. Κάθε κορυφή συνδέεται με την προηγούμενη με μια ακμή και όταν δημι-
ουργηθούν τρεις κορυφές δημιουργείται τελικά ένα τρίγωνο. Συνεχίζουμε τη διαδικασία και έτσι δημιουργού-
νται περισσότερα τρίγωνα, καταλήγοντας τελικά στο πλέγμα πολυγώνων, που εμφανίζει το σχήμα που θέλου-
με. Πρόκειται, προφανώς, για πιο επίπονη διαδικασία σε σχέση με την προηγούμενη, η οποία όμως παρέχει 
μεγαλύτερη ευελιξία στον σχεδιαστή. 

Αφού δημιουργηθεί κάποιο πλέγμα πολυγώνων, στη συνέχεια μπορεί να γίνει επεξεργασία με διάφο-
ρες τεχνικές, π.χ. με τη διαδικασία λάξευσης κορυφών και ακμών (λειτουργίες chamfer και bevel) και με την 
τεχνική ανύψωσης/εξώθησης (λειτουργία extrude). Επιπλέον, υπάρχει η δυνατότητα διαίρεσης των σχημάτων 
σε μικρότερα πολύγωνα και τρίγωνα, για καλύτερο χειρισμό τους. Η τεχνική smoothing είναι μια τεχνική αύ-
ξησης των προσόψεων ενός πολυγώνου. Γενικά, λογισμικά, όπως τα 3ds Max και Maya της Autodesk και το 
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εργαλείο ανοιχτού κώδικα Blender, παρέχουν πολλές δυνατότητες για τροποποίηση των πολυγώνων. 
 

4.2.1.2. Μοντελοποίηση NURBS 
 
Οι καμπύλες NURBS (Non-Uniform Rational B-Spline) είναι ειδικοί τύποι καμπυλών, που έχουν σημεία ελέγ-
χου (control points), για να βοηθήσουν στη ρύθμιση του σχήματος της καμπύλης (Εικόνα 4.14). Μέσα από τη 
σχεδίαση και τροποποίηση των καμπυλών τελικά μοντελοποιείται το τρισδιάστατο σχήμα. Τα σημεία ελέγ-
χου, που ονομάζονται και κορυφές ελέγχου (control vertices), εμφανίζονται εκτός της καμπύλης, ως ευθείες, 
βοηθώντας την πιο εύκολη διαχείριση της καμπύλης. Οι καμπύλες μπορούν, στη συνέχεια, να ενωθούν μαζί, 
δημιουργώντας ένα 3Δ σχήμα, όπως φαίνεται π.χ. στην Εικόνα 4.15. 

 

 
 
Εικόνα 4.14 Παράδειγμα καμπύλης NURBS.  

 

 
[Πηγή: http://goo.gl/Mi4ArV] 
 
Εικόνα 4.15 3Δ μοντέλο από καμπύλες NURBS.  

 
Η δημιουργία τρισδιάστατων μοντέλων με χρήση NURBS συνιστά πιο δύσκολη διαδικασία σε σχέση 

με την τεχνική των πολυγώνων. Η συγκεκριμένη τεχνική δεν προτείνεται για τη δημιουργία μοντέλων, τα ο-
ποία στη συνέχεια θα χρησιμοποιηθούν σε κινήσεις. Αντίθετα, για δημιουργία στατικών μοντέλων είναι κά-
πως πιο εύκολη, όταν τελικά γίνει πλήρως αντιληπτή η λειτουργία των καμπυλών από τον δημιουργό. Στο 
σημείο αυτό, θα πρέπει να αναφερθεί ότι στη βιβλιογραφία οι δημιουργοί τρισδιάστατων μοντέλων αναφέρο-
νται ως "3D artists", δηλαδή καλλιτέχνες τρισδιάστατων σχημάτων. Θεωρείται μια μορφή τέχνης, ενώ οι δη-
μιουργοί είναι απαραίτητοι στη δημιουργία παιχνιδιών και ταινιών animation. 

 
4.2.1.3. 3Δ Σάρωση 
 
Τρισδιάστατα μοντέλα μπορούν να δημιουργηθούν πλέον και με τη χρήση τρισδιάστατου σαρωτή. Τα δεδο-
μένα χρησιμοποιούνται για να συγκεντρώσουν δεδομένα για το σχήμα και ίσως για το χρώμα. Η σάρωση 
πραγματοποιείται με χρήση συνήθως κάποιας δέσμης laser, που εκπέμπει ο σαρωτής. Η αναδόμηση του σχή-
ματος με πολύγωνα γίνεται με ειδικό λογισμικό (π.χ. MeshLab), το οποίο ανιχνεύει τα γειτονικά σημεία και 
τα συνδέει με γραμμές. Η συγκεκριμένη τεχνική είναι χρήσιμη για μοντελοποίηση ανθρώπινων χαρακτήρων 
και πολύπλοκων σκηνών, π.χ. αρχαιολογικούς χώρους, γήπεδα κ.ά. 

 

4.2.2. Υφές και φωτισμός 
 
Το επόμενο στάδιο, μετά τη δημιουργία του 3Δ μοντέλου, είναι το στάδιο που αναφέρεται με τον όρο render-
ing. Δεν υπάρχει ακριβής μετάφραση του όρου, γι’ αυτό συνήθως χρησιμοποιείται ο Αγγλικός όρος. Κάποιες 
φορές μπορεί να το συναντήσετε ως «απόδοση», όρος που υστερεί όμως σημασιολογικά, καθώς δεν αποδίδει 
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την εργασία που επιτελείται. Μπορούμε να τον μεταφράσουμε ως ρεαλιστική απόδοση, δηλαδή μετατροπή 
τρισδιάστατου σχεδίου με χρώματα, υφές και φωτισμό, ώστε να μοιάζει με ρεαλιστική φωτογραφία και όχι 
απλά με ένα σύνολο πολυγώνων ή γραμμών. Γενικά, η διαδικασία rendering αφορά το σύνολο των ενεργειών 
για μετατροπή του τρισδιάστατου σχεδίου σε ψηφιογραφική εικόνα στο επίπεδο, που όμως, θα δίνει κανονικά 
την εντύπωση των τριών διαστάσεων. Η διαδικασία αυτή είναι απαιτητική υπολογιστικά, γιατί τα αρχικά σχέ-
δια αποτελούνται από γραμμές, που συνδέουν κορυφές ή καμπύλες. Οι περιοχές μπορεί να καλυφθούν με 
χρώμα ή υφές και απαιτείται ο υπολογισμός σκιών και σκιάσεων, ώστε να είναι φωτορεαλιστική η απεικόνιση 
των σχημάτων στον χώρο. Το φως και η γωνία θέασης παίζουν, επίσης, σημαντικό ρόλο στη διαδικασία ren-
dering της σκηνής. 

 
4.2.2.1. Γέμισμα με υφές  
 
Η διαδικασία εισαγωγής μιας εικόνας ή ενός επαναλαμβανόμενου σχεδίου στην επιφάνεια του σχήματος ονο-
μάζεται χαρτογράφηση υφής (texture mapping) (Εικόνα 4.16). Η υφή μπορεί να αναδεικνύει το υλικό κατα-
σκευής κάποιου αντικειμένου, π.χ. τούβλα ή ξύλο, ή να είναι κάποια υφή παραγόμενη από υπολογιστή. 

 

 
 
Εικόνα 4.16 Απλές υφές πάνω σε τρισδιάστατα αντικείμενα. 

 

 
[Πηγή: https://goo.gl/4nqieF] 
 
Εικόνα 4.17 Διαφορετικές υφές στα πολύγωνα του μοντέλου. 
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Οι υφές εφαρμόζονται στην πρόσοψη κάθε πολυγώνου, που αποτελεί το τρισδιάστατο μοντέλο, ή γε-
νικά σε κάθε πλευρά του τρισδιάστατου σχήματα. Οι υφές αυτές ονομάζονται detail textures και μπορούν να 
χρησιμοποιηθούν σε διάφορες περιπτώσεις. Για παράδειγμα, στην Εικόνα 4.17 εφαρμόζονται διαφορετικές 
υφές για την ρεαλιστική απεικόνιση του δέρματος ενός δεινοσαύρου (Εικόνα 4.17). 

Οι τεχνικές που εφαρμόζονται για την προσθήκη υφής σε ένα τρισδιάστατο μοντέλο ποικίλουν. Υ-
πάρχουν διαφορετικές υπολογιστικές τεχνικές, που οδηγούν σε διαφορετικά αισθητικά αποτελέσματα. 

Η τεχνική environmental mapping ή reflectance mapping βασίζεται σε μαθηματικές συναρτήσεις 
για την απόδοση των ανακλάσεων άλλων αντικειμένων του περιβάλλοντα χώρου, στην επιφάνεια του αντι-
κειμένου που σχεδιάζουμε (π.χ. Εικόνα 4.18). 

 

 
[Πηγή: http://goo.gl/hj0sRH] 
 
Εικόνα 4.18 Παράδειγμα reflectance mapping. 

 
Η τεχνική bump mapping είναι η τεχνική προσομοίωσης προεξοχών και ρυτίδων στην επιφάνεια ε-

νός αντικειμένου (Εικόνα 4.19). Η διαδικασία επιτυγχάνεται με διαφορετικό φωτισμό σε διάφορα σημεία της 
επιφάνειας, χωρίς ουσιαστικά να αλλάζει η επιφάνεια. Μια σχετική τεχνική είναι το normal bumping, που 
εφαρμόζεται σε μοντέλα με λίγα πολύγωνα. Στην τεχνική displacement mapping τροποποιείται και η γεωμε-
τρία του σχήματος, δηλαδή το τρισδιάστατο μοντέλο, ώστε να προστεθούν πτυχώσεις και προεξοχές (Εικόνα 
4.20). 

 

 
[Πηγή: http://goo.gl/03NEY6] 
 
Εικόνα 4.19 Παράδειγμα bump mapping. 

 

 
[Πηγή: http://goo.gl/kZv3uq]  
 
Εικόνα 4.20 Παράδειγμα displacement mapping. 

 

 
[Πηγή: http://goo.gl/ySNc0U]  
 
Εικόνα 4.21 Παράδειγμα procedural texturing. 
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Η τεχνική procedural texturing βασίζεται σε μαθηματικές συναρτήσεις, που έχουν ως παράμετρο 

και τον χρόνο, και έτσι δημιουργούν υφές, οι οποίες μπορούν να μεταβληθούν, καθώς κυλά ο χρόνος (Εικόνα 
4.21). Κυρίως βασίζεται σε τεχνικές fractal, προκειμένου να δημιουργήσουν διάφορες υφές. 
 
4.2.2.2. Σκιές και σκιάσεις 

 
Το φως, που προσπίπτει σε ένα αντικείμενο, δημιουργεί διαβαθμίσεις στο χρώμα πάνω στην επιφάνεια του 
αντικειμένου και παράγει σκιές (shadows) και σκίαση (shading). Η σκίαση είναι η χρωματική διαβάθμιση 
στην επιφάνεια του αντικειμένου, λόγω του φωτός που προσπίπτει σε αυτό, ενώ οι σκιές δημιουργούνται στα 
περιβάλλοντα αντικείμενα από το 3Δ σχήμα που δημιουργούμε. 

Ο φωτισμός μπορεί να χρησιμοποιηθεί ακόμη και για την απόδοση χαρακτηριστικών κίνησης στα α-
ντικείμενα. Για παράδειγμα, αν σε μια σκηνή μία πηγή φωτός είναι σταθερή, π.χ. μία λάμπα, και η θέση στην 
οποία προσπίπτει το φως στο αντικείμενο αλλάζει, τότε εμφανίζεται ότι το αντικείμενο κινείται. Η σκίαση 
που δημιουργείται πάνω στο αντικείμενο, δίνει την αίσθηση του όγκου. Στην Εικόνα 4.22 εμφανίζονται δύο 
απλοί κύκλοι, που δημιουργήθηκαν σε ένα πρόγραμμα δημιουργίας σχεδίων 2Δ. Εφαρμόζοντας απλά χρώμα 
γεμίσματος και κάποια πηγή φωτισμού, εμφανίζονται ως τρισδιάστατες σφαίρες, ως αποτέλεσμα της χρωμα-
τικής διαβάθμισης στην επιφάνεια του αντικειμένου. Αντίστοιχα οι σκιές που δημιουργούνται στα περιβάλλο-
ντα αντικείμενα προσδιορίζουν τη θέση του αντικειμένου στον χώρο. 
 

 
 
Εικόνα 4.22 Μπάλες με διαφορετικό φωτισμό στην επιφάνειά τους. 

 
4.2.2.3. Μέθοδος Radiosity 

 
Η μέθοδος radiosity βασίζεται στη θεωρία μεταφοράς της θερμικής ενέργειας για τη δημιουργία ρεαλιστικών 
σκιών και σκιάσεων στα αντικείμενα μιας σκηνής.  

Σύμφωνα με αυτή τη θεωρία, η ακτινοβολία (radiation) περιγράφεται ως μεταφορά ενέργειας από μία 
επιφάνεια, όταν αυτή διεγερθεί θερμικά. Αυτός ο ορισμός αφορά αντικείμενα που εκλύουν θερμική ενέργεια, 
π.χ. πηγές φωτός, και αντικείμενα που λαμβάνουν ενέργεια και μπορούν να τη μεταδώσουν. Η θεωρία μετα-
φοράς θερμικής ενέργειας χρησιμοποιείται στην τρισδιάστατη μοντελοποίηση για την περιγραφή μεταφοράς 
φωτός μεταξύ των επιφανειών των αντικειμένων που συνθέτουν μια σκηνή. 

Η τεχνική στηρίζεται στην υπόθεση ότι οι επιφάνειες των αντικειμένων εκλύουν ομοιόμορφα το φως 
στις επιφάνειες των γειτονικών τους αντικειμένων και ότι υπάρχει ισοζύγιο ενέργειας, που εκλύεται και α-
πορροφάται στα αντικείμενα μιας σκηνής. Το αποτέλεσμα είναι ίδιο, ανεξάρτητα από τη θέση του θεατή. Τα 
αντικείμενα, τα οποία έχουν επεξεργαστεί με τη συγκεκριμένη τεχνική, εμφανίζονται με απαλές, διαβαθμιζό-
μενες σκιές. Χρησιμοποιείται κυρίως για τη φωτορεαλιστική απεικόνιση εικόνων στο εσωτερικό κτιρίων και 
παράγει πολύ υψηλά αισθητικά αποτελέσματα. 

 
4.2.2.4. Μέθοδος Ray Tracing 

 
Η τεχνική ray tracing (ανίχνευση ακτίνας) χρησιμοποιεί πολύπλοκους υπολογισμούς για τις επιδράσεις του 
φωτός στο αντικείμενο. Αυτό οδηγεί σε δημιουργία αντικειμένων, που περιέχουν στην επιφάνειά τους τμήμα-
τα, τα οποία μοιάζουν με καθρέφτη, διαφανή τμήματα και σκιές, δημιουργώντας εντυπωσιακά αποτελέσματα 
(Εικόνα 4.24). 

Η τεχνική ray tracing προσπαθεί να ακολουθήσει (trace) τις ακτίνες φωτός, καθώς αυτές εξακτινώνο-
νται, όταν προσπίπτουν στα αντικείμενα της σκηνής. Υπολογίζεται το χρώμα κάθε ακτίνας που προσπίπτει 
στη σκηνή, πριν αυτή φθάσει στο ανθρώπινο μάτι. Οι ακτίνες ξεκινούν από μια πηγή φωτός και, όταν προ-
σπίπτουν σε κάποιο αντικείμενο, ανακλώνται και διασκορπίζονται (Εικόνα 4.25). Η πορεία των ακτινών φω-
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τός ακολουθούνται σε αντίθετη κατεύθυνση. Δηλαδή, αρχίζουμε από το μάτι ή την κάμερα και ακολουθούμε 
την ακτίνα μέχρι κάποιο pixel στη σκηνή. Στη συνέχεια το χρώμα του pixel τίθεται ίσο με την τιμή που επι-
στρέφεται από την ακτίνα. Σχετικές τεχνικές είναι η cone tracing και η beam tracing. 

 

 
[Πηγή: http://goo.gl/QvqTJY] 
 
Εικόνα 4.23 Σκηνή που έχει δημιουργηθεί με την τεχνική Radiosity.  

 

 
[Πηγές: http://goo.gl/zm2RKb, https://goo.gl/0X4e1r] 
 
Εικόνα 4.24 Εικόνες που έχει δημιουργηθεί με την τεχνική Ray Tracing.  

 

4.3. Λογισμικό επεξεργασίας γραφικών 3Δ 
 

Το λογισμικό επεξεργασίας τρισδιάστατων γραφικών είναι αρκετά σύνθετο. Υπάρχουν εξειδικευμένα εργα-
λεία που χρησιμοποιούνται για αρχιτεκτονικά σχέδια, π.χ. τα εργαλεία CAD, και εργαλεία που χρησιμοποιού-
νται σε παιχνίδια ή ταινίες, π.χ. το RenderMan της Pixar. Η δημιουργία τρισδιάστατων σχημάτων και οι ολο-
κληρωμένες σκηνές με αυτά τα εργαλεία απαιτούν αρκετό χρόνο για να δημιουργηθούν, καθώς και εξειδικευ-
μένες γνώσεις, μεράκι, αλλά και φαντασία. Σε κάθε περίπτωση, με εργαλεία, όπως το Autodesk 3ds Max, το 
δωρεάν Blender και το Autodesk Maya, μπορούμε να δημιουργήσουμε τρισδιάστατα γραφικά σε σχετικά α-
ποδεκτό χρόνο. Άλλα γνωστά εργαλεία για δημιουργία τρισδιάστατων μοντέλων είναι τα Cinema 4D, Modo, 
SketchUp και Lightwave. 
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Οι πιο γνωστές μορφοποιήσεις αρχείων τρισδιάστατων γραφικών είναι .obj, .max, .fbx, .c4d, .dwg, 
.dxf, .3dm, .blend, .ma, .c4d, .lwo, .skp, .z3d.  

 

 
 
Εικόνα 4.25 Ακτίνες φωτός προσπίπτουν στην επιφάνεια.  

 

4.3.1. Autodesk 3ds Max 
 
Το 3ds Max της Autodesk (http://www.autodesk.com/products/3ds-max/) υποστηρίζει τη δημιουργία μοντέ-
λων με τις τεχνικές που εξετάσαμε πιο πάνω. Η βασική μορφοποίηση του εργαλείου είναι η .max. Προσφέρει 
αρκετές δυνατότητες για μοντελοποίηση τρισδιάστατων αντικειμένων και ρεαλιστικής απόδοσης με υφές, 
τεχνικές σκίασης και φωτισμού (π.χ. Εικόνα 4.26). Χρησιμοποιείται για την παραγωγή πολλών διαφημιστι-
κών σποτ και εφέ σε ταινίες. Οι δυνατότητες του λογισμικού μπορούν να επεκταθούν με χρήση προσθέτων 
(plugins). Το εργαλείο πρωτοεμφανίστηκε το 1990 και πλέον βρίσκεται στην έκδοση 2016, η οποία είναι δια-
θέσιμη μόνο για αρχιτεκτονική 64bit. 

 

 
 
Εικόνα 4.26 Autodesk 3ds Max.  

 

4.3.2. Autodesk Maya 
 
To εργαλείο Maya (http://www.autodesk.com/products/maya/) είναι, επίσης, της εταιρείας Autodesk (Εικόνα 
4.27). Χρησιμοποιείται για τη δημιουργία διαδραστικών εφαρμογών 3D, για βιντεοπαιχνίδια, ταινίες κινουμέ-
νων σχεδίων, τηλεοπτικές σειρές ή οπτικά εφέ. Οι εγγενείς μορφοποιήσεις του λογισμικού είναι .ma και .mb. 
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Οι δυνατότητές του συγκρίνονται συχνά με το 3ds Max. Το 3ds Max υπερτερεί σε απλότητα, όσον αφορά τη 
μοντελοποίηση των τρισδιάστατων μοντέλων, και γενικά προτιμάται, όταν πρόκειται για τη δημιουργία μο-
ντέλων. Το Maya είναι πιο δημοφιλές ανάμεσα στους animators, καθώς παρέχει περισσότερες δυνατότητες 
για κίνηση των μοντέλων. Επιπλέον, το Maya διατίθεται για Windows, Linux και Apple MAC OS, ενώ το 3ds 
Max είναι διαθέσιμο μόνο για Windows. 

 

 
 
Εικόνα 4.27 Autodesk Maya.  

 
 

4.3.3. Blender 
 
Το Blender (www.blender.org) είναι ένα δωρεάν και ανοιχτού κώδικα λογισμικό για τη δημιουργία τρισδιά-
στατων γραφικών και σχεδιοκίνησης (animation). Αναπτύσσεται συνεργατικά από ανεξάρτητους προγραμμα-
τιστές και παρέχει πολλές δυνατότητες για μοντελοποίηση και ρεαλιστική απόδοση. Έχει απλούστερο inter-
face (Εικόνα 4.28) σε σχέση με τα άλλα εργαλεία, αλλά έχει συγκρίσιμες δυνατότητες, όσον αφορά τη μοντε-
λοποίηση και την κίνηση των αντικειμένων. 
 

 
 
Εικόνα 4.28 Blender.  
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4.4. Animation (σχεδιοκίνηση) 
 
Η δημιουργία κινούμενων σχεδίων αποτελούσε στο παρελθόν μια διαδικασία, που απαιτούσε να ζωγραφι-
στούν οι διαδοχικές εικόνες με το χέρι. Κάθε εικόνα σχεδιαζόταν πάνω σε μια ζελατίνη (celluloid), γι’ αυτό 
ονομάζονται cels. Τα cels (Εικόνα 4.29) απεικόνιζαν κάθε χαρακτήρα σε διαφορετική στάση και μπορούσαν 
να τοποθετηθούν σε διαφορετικά backgrounds. Στη συνέχεια τα cels φωτογραφίζονταν σε φιλμ, για να μπο-
ρέσουν να προβληθούν στην τηλεόραση ή τον κινηματογράφο. Στη σημερινή εποχή τα λογισμικά δημιουργί-
ας τρισδιάστατων γραφικών και προσομοιώσεων κίνησης (σχεδιοκίνηση ή animation) παρέχουν τη δυνατότη-
τα κίνησης των μοντέλων. Επίσης, μέσα από ειδικά εφέ και τεχνικές επιτρέπουν τη γρήγορη ανάπτυξη anima-
tions. 

 

 
 
Εικόνα 4.29 Διαδοχικές φιγούρες που συνέθεταν την προσομοίωση κίνησης.  
 

4.4.1. Βασικές αρχές σχεδιοκίνησης του Lasseter 
 

O John Alan Lasseter εργάζεται στη Disney και έχει απασχοληθεί στις περισσότερες μεγάλες παραγωγές της, 
όπως Beauty and the Beast, Finding Nemo, Cars, Toy Story κ.ά. Έχει διατυπώσει κάποιες αρχές, που διέπουν 
την κίνηση σχεδίων δύο και τριών διαστάσεων, και οι οποίες είναι σωστές έως και σήμερα. Πιο κάτω περι-
γράφουμε τις πιο σημαντικές. 

 
 Squash and stretch (συμπίεση και άπλωμα): Είναι το μάζεμα και τέντωμα ενός αντικειμένου 

καθώς κινείται, διατηρώντας ταυτόχρονα τη μάζα του κατά τη διάρκεια της κίνησης. Έτσι, 
ένα αντικείμενο, που προσπίπτει σε μία επιφάνεια και ανακλάται, φαίνεται ότι συμπιέζεται 
και απλώνεται, ώστε να είναι αληθοφανής η κίνηση (Εικόνα 4.30). 

 

  
 
Εικόνα 4.30 Συμπίεση και άπλωμα για πιο αληθοφανή κίνηση.  

 
 Timing and Motion (συγχρονισμός): Η σωστή ταχύτητα μιας ενέργειας προσδίδει ρεαλισμό 

και φυσικότητα στην κίνηση. Αν, για παράδειγμα, η κίνηση είναι πολύ αργή, τότε θα φαίνε-
ται αφύσικη. Η ταχύτητα θα πρέπει να εξαρτάται από το μέσο και τον τρόπο κίνησης ενός α-
ντικειμένου. Για παράδειγμα, η επιτάχυνση βαρύτερων αντικειμένων πρέπει να είναι διαφο-
ρετική από την επιτάχυνση ή επιβράδυνση ελαφρύτερων αντικειμένων. 
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 Anticipation (προετοιμασία): Αφορά την ενημέρωση του θεατή στο τι πρόκειται να κινηθεί ή 

να ακολουθήσει τη σκηνή που ολοκληρώνεται, ώστε να επικεντρωθεί στην κίνηση και όχι 
στο πώς ακριβώς γίνεται. Για παράδειγμα, τo σήκωμα του ποδιού και η τοποθέτηση του σώ-
ματος υποδηλώνουν ότι το κινούμενο αντικείμενο θα τρέξει. 

   
 Staging (σκηνοθεσία): Αφορά τη σωστή τοποθέτηση των αντικειμένων και της γωνίας λήψης 

της κάμερας. Η σκηνοθεσία είναι εξαιρετικά σημαντική διαδικασία, γιατί αφορά άμεσα το τι 
τελικά βλέπει ο θεατής και πού γίνεται η εστίαση. 

 
 Follow through (ολοκλήρωση): Η ολοκλήρωση της κίνησης πρέπει να είναι σταδιακή. Δηλα-

δή, αν κινείται ένας χαρακτήρας, τότε πρέπει να σταματήσουν κάποια μέρη (π.χ. χέρια ή μαλ-
λιά), να μειωθεί η ταχύτητα και στη συνέχεια να σταματήσουν κάποια άλλα τμήματα κ.ο.κ. 
Αν το αντικείμενο σταματήσει απότομα, τότε εμφανίζεται σαν να υπάρχει πρόβλημα. 

 
 Overlapping action (επικαλυπτόμενη κίνηση): Οι περισσότερες κινήσεις είναι συνδυασμός 

απλών κινήσεων. Για παράδειγμα, όταν ένας άνθρωπος γράφει, συνήθως κινεί και άλλα μέρη 
του σώματός τους (ώμους, κεφάλι κ.ά.), εκτός από τα χέρια του και τις παλάμες. Συνεπώς, 
για να εμφανιστεί φυσική μια κίνηση, που προσομοιώνει κάποιον να γράφει, πρέπει να υπάρ-
χει συνδυασμός επικαλυπτόμενων κινήσεων. 

 
 Slow in and out (είσοδος και έξοδος): Αναφέρεται στα αρχικά και τελευταία στάδια της κίνη-

σης. Η ταχύτητα εισόδου και εξόδου ενός αντικειμένου από τη σκηνή πρέπει να είναι διαφο-
ρετική. Για παράδειγμα, μια μπάλα, που αναπηδά, κινείται γρηγορότερα καθώς πλησιάζει ή 
φεύγει από το έδαφος, και πιο αργά καθώς πλησιάζει τη μέγιστη θέση της. 

 
 Arcs versus linear motion (καμπύλη τροχιά αντί γραμμικής κίνησης): Οι κινήσεις δεν πρέπει 

να είναι σε ευθεία τροχιά, αλλά να ακολουθούν μια καμπύλη, μη ομοιόμορφη τροχιά, ώστε 
να είναι πιο ρεαλιστική η κίνηση. 

 
 Exaggeration (υπερβολή): Αναφέρεται στην ανάδειξη κάποιων ιδιοτήτων των αντικειμένων 

σε σημείο υπερβολής, ώστε να προσελκύεται το ενδιαφέρον του θεατή και να αναδεικνύεται 
η ενέργεια που επιτελείται. Για παράδειγμα, ένας χαρακτήρας παραμορφώνεται σε μεγάλο 
βαθμό, για να αναδειχτεί η σφοδρότητα της κίνησης. Μετά ο χαρακτήρας επανέρχεται, ειδικά 
στα κινούμενα σχέδια. 

 
 Secondary action (δευτερεύουσα ενέργεια): Είναι μια κίνηση που προκύπτει άμεσα από μια 

άλλη ενέργεια, για να αυξήσει την πολυπλοκότητα και το ενδιαφέρον σε μια σκηνή. Παρά-
δειγμα δευτερεύουσας δράσης είναι η κίνηση των μαλλιών, καθώς ένας χαρακτήρας τρέχει. Η 
δευτερεύουσα δράση πρέπει πάντα να είναι λιγότερο εμφανής από την κύρια δράση, για να 
μην τίθεται στο επίκεντρο του ενδιαφέροντος του θεατή. 

 
 Appeal (ελκυστικότητα): Είναι ξεκάθαρο ότι το συγκεκριμένο χαρακτηριστικό δεν μπορεί εύ-

κολα να οριστεί με συμβατικούς όρους, αλλά επαφίεται στη δημιουργικότητα της ομάδας που 
δημιουργεί το animation. 

 
Από τις πιο πάνω αρχές γίνεται ξεκάθαρο ότι η διαδικασία δημιουργίας ενός ρεαλιστικού animation 

είναι μια δύσκολη διαδικασία, που απαιτεί προσοχή στις λεπτομέρειες, γνώσεις και έμπνευση. 
 

4.4.2. Κίνηση στο επίπεδο: Cel και Path Animation 
 
Η προσομοίωση κίνησης αντικειμένων δύο διαστάσεων ονομάζεται και προσομοίωση κίνησης στο επίπεδο. H 
ψευδαίσθηση κίνησης, μπορεί να δημιουργηθεί και με αλλαγή χρωμάτων σε κάποια από τα αντικείμενα και 
το background της σκηνής. Συνήθως, όμως, η δημιουργία των κινήσεων δισδιάστατων αντικειμένων στους 
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υπολογιστές γίνεται με τις τεχνικές cel animation (σχεδιοκίνηση με κυψέλες) και path animation (σχεδιοκί-
νηση με παράθεση πλαισίων και καθορισμός τροχιάς). 

Η τεχνική cel animation προέρχεται από την τεχνική που περιγράψαμε πιο πάνω και πραγματοποιού-
ταν αρχικά με τη χρήση ζελατινών και ζωγράφισμα των σχεδίων. Μόνο που στους υπολογιστές τα cels (δια-
δοχικές εικόνες – καρέ) δημιουργούνται ως ψηφιογραφικές εικόνες ή διανυσματικά γραφικά σε κάποια εφαρ-
μογή υπολογιστών (π.χ. Εικόνα 4.31). Οι εικόνες αυτές προβάλλονται γρήγορα, σε αμετάβλητο υπόβαθρο, 
δίνοντας την ψευδαίσθηση της κίνησης.  

 

 
[Πηγή: http://goo.gl/ZkUHHK]  
 
Εικόνα 4.31 Παράδειγμα χαρακτήρα σε διαφορετικές φάσεις για cel animation.  

 
Στην τεχνική path animation δημιουργούμε τα βασικά πλαίσια/καρέ (keyframes) της κίνησης. Δηλα-

δή, το αντικείμενο σχεδιάζεται στην αρχική και τελική του θέση, καθώς και σε κάποια βασικά σημεία της κί-
νησης. Επίσης, καθορίζεται η τροχιά κίνησης του αντικειμένου, ενώ ο υπολογιστής αναλαμβάνει τη δημιουρ-
γία των ενδιάμεσων πλαισίων. Στην Εικόνα 4.32 εμφανίζουμε τα keyframes της κίνησης ενός κύκλου. Τα εν-
διάμεσα πλαίσια δημιουργούνται με την τεχνική tweening, που παίρνει την ονομασία της από τη λέξη 
"between" (ανάμεσα), η οποία αναφέρεται στον σχεδιασμό των πλαισίων μεταξύ δύο βασικών καρέ. Με την 
τεχνική αυτή, μπορεί να δημιουργηθούν μη ομαλές κινήσεις, στην περίπτωση που δεν έχουν δημιουργηθεί 
αρκετά ενδιάμεσα καρέ. 

 

 
 
Εικόνα 4.32 Παράδειγμα keyframes μιας μπάλας σε path animation.  

 
Ο αριθμός των καρέ ανά δευτερόλεπτο (frames per second) είναι σημαντικός στην τεχνική path ani-

mation. Συνήθως καθορίζεται αυτόματα από το πρόγραμμα δημιουργίας των σχεδιοκινήσεων. Αν κατά την 
κίνηση εμφανίζεται κάποιο μικρό τρεμόπαιγμα (flickering), τότε πρέπει να αυξηθεί ο αριθμός των πλαισίων 
ανά δευτερόλεπτο. 

Υπάρχει και η τεχνική sprite animation που, ουσιαστικά, αφορά την εναλλαγή παρόμοιων εικόνων 
στο ίδιο σημείο. Δηλαδή, δεν υπάρχει κίνηση στο επίπεδο, αλλά εναλλαγή διαδοχικών εικόνων, οι οποίες δί-
νουν την ψευδαίσθηση περιστροφής αντικειμένων. Χρησιμοποιούνται, συνήθως, σε εφαρμογές πολυμέσων 
και ιστοσελίδες, για να προσελκύσουν το ενδιαφέρον ενός ανθρώπου.  
 

4.4.3. Κίνηση στον χώρο 
 
Η κίνηση στον χώρο αφορά την κίνηση τρισδιάστατων αντικειμένων. Αναφέρεται ως Computer animation ή 
Computer Generated Imagery (CGI). Τα λογισμικά που αναφέραμε πιο πάνω, υποστηρίζουν και το animation 
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αντικειμένων 3Δ. Για την απόδοση κίνησης στα αντικείμενα 3Δ χρησιμοποιείται κατά κύριο λόγο η τεχνική 
των βασικών καρέ (keyframes). Στον σχεδιασμό των βασικών πλαισίων πρέπει να ληφθούν υπόψη και παρά-
γοντες, όπως οι πηγές φωτός, η γωνία θέασης και η περιστροφή στον χώρο. Τα σημαντικά πλαίσια δεν είναι 
στατικά, αλλά ορίζονται παραμετρικά με βάση μαθηματικούς υπολογισμούς κατά τη διάρκεια της κίνησης. 
Αυτό επιτρέπει την προσαρμογή της κίνησης των αντικειμένων. Είναι προφανές ότι η κίνηση στον χώρο είναι 
αρκετά πιο απαιτητική, τόσο σε σχεδίαση, όσο και σε υπολογιστική ισχύ. Οι τεχνικές που παρουσιάζουμε στη 
συνέχεια χρησιμοποιούνται σε παιχνίδια και ταινίες.  
 
4.4.3.1. Pose-based animation 
 
Η τεχνική pose-based βασίζεται στη λογική του path animation της σχεδιοκίνησης στο επίπεδο. Ο σχεδιαστής 
της κίνησης σχεδιάζει τις βασικές στάσεις/πόζες (key poses) και το λογισμικό υπολογίζει τα ενδιάμεσα στάδι-
α. Πρέπει να δημιουργηθούν αρκετές βασικές στάσεις, ώστε η κίνηση να είναι ομαλή.  
 
4.4.3.2. Kinematics 
 
Η τεχνική κινηματικής για την απόδοση κίνησης σε τρισδιάστατα αντικείμενα βασίζεται στη θέση και την τα-
χύτητα και επιτάχυνση των τρισδιάστατων μοντέλων. Βασίζεται σε τεχνικές της θεωρίας της κινηματικής της 
Φυσικής και βασίζεται σε μαθηματικά μεγέθη, όπως οι συντεταγμένες, ο χρόνος κ.ά. Διακρίνεται στην 
forward kinematics (πρόσθια) και η inverse kinematics (αντίστροφη). 

Στην πρόσθια κινηματική μέθοδο οι θέσεις συγκεκριμένων αντικειμένων, σε κάποια δεδομένη χρονι-
κή στιγμή, υπολογίζονται από τη θέση και τον προσανατολισμό του αντικειμένου. Λαμβάνονται υπόψη πλη-
ροφορίες, όπως οι ενώσεις χεριών και σώματος ενός ανθρώπινου μοντέλου. Για παράδειγμα, αν το αντικείμε-
νο που κινείται είναι ένα ανθρώπινο χέρι, τότε αυτό συνδέεται με τον ώμο, που παραμένει σε μια σταθερή 
θέση. Η θέση των χεριών υπολογίζεται από τις γωνίες των ενώσεων ώμων, αγκώνων, καρπών, αντιχείρων και 
αρθρώσεων. Οι ενώσεις που αφορούν τον ώμο, τον καρπό, καθώς και η βάση του αντίχειρα, έχουν περισσό-
τερους από έναν βαθμούς ελευθερίας κίνησης, οι οποίοι πρέπει να ληφθούν υπόψη. Εάν το μοντέλο που έ-
πρεπε να κινηθεί ήταν ένας άνθρωπος, τότε η θέση του ώμου θα έπρεπε, επίσης, να υπολογιστεί από άλλες 
ιδιότητες του μοντέλου, π.χ. το σώμα. 

 

 
 
Εικόνα 4.33 Τα τρισδιάστατα μοντέλα σχηματίζονται ως ένα σύνολο τμημάτων που ενώνονται. 

 
Στην αντίστροφη κινηματική διαδικασία οι παράμετροι ενός αντικειμένου αποφασίζονται από διάφο-

ρα ενωμένα τμήματα προκειμένου να επιτευχθεί η επιθυμητή θέση. Για παράδειγμα, σε ένα τρισδιάστατο μο-
ντέλο ενός ανθρώπινου σώματος αποφασίζονται οι γωνίες του καρπού και του αγκώνα, ώστε να καθοριστεί η 
κίνηση του χεριού, όταν μεταβεί από την κατάσταση ακινησίας σε κατάσταση χαιρετίσματος. Η αντίστροφη 
κινηματική είναι σημαντική για προγραμματισμό παιχνιδιών.  
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4.4.3.3. Καταγραφή κίνησης 
 
Στην τεχνική motion capture (καταγραφή κίνησης) καταγράφονται ψηφιακά οι κινήσεις πραγματικών αντι-
κειμένων, π.χ. ανθρώπων που κινούνται ή συμμετέχουν σε κάποιο παιχνίδι. Αναφέρεται ως MoCap για συ-
ντομία. Αρχικά αναπτύχθηκε ως εργαλείο ανάλυσης στη βιομηχανική έρευνα, όμως στη αναπτύχθηκε και 
χρησιμοποιείται πλέον στη σχεδιοκίνηση για ταινίες και για παιχνίδια.  

Σύμφωνα με τη συγκεκριμένη τεχνική, κάποιος άνθρωπος κινείται μπροστά σε μία ή περισσότερες 
κάμερες. Η ταινία μεταφέρεται από την κάμερα σε κάποιον υπολογιστή, που διαθέτει πρόγραμμα καταγραφής 
και επεξεργασίας των αποθηκευμένων κινήσεων. Το αντικείμενο, που κινείται, φορά μια μαύρη ενδυμασία με 
λευκές κουκκίδες ή αισθητήρες στις αρθρώσεις του σώματος (αγκώνες, γόνατα, ώμους κ.ά.), όπως φαίνεται 
στην Εικόνα 4.34. Το πρόγραμμα, που εφαρμόζει την τεχνική motion capture, αναγνωρίζει τις άσπρες κουκ-
κίδες ή ανιχνεύει τις θέσεις των αισθητήρων. Κατόπιν συνδέει τα σημεία που ανίχνευσε με γραμμές. Τα ση-
μεία χρησιμοποιούνται ως ενώσεις, ενώ οι γραμμές, που συμπλήρωσε το πρόγραμμα, αναγνωρίζονται ως ο-
στά. Έτσι, δημιουργείται ένα τρισδιάστατο μοντέλο, που κινείται παρόμοια με τον ηθοποιό που χρησιμοποιή-
θηκε (Εικόνα 4.35). 

 

 
[Πηγή: http://goo.gl/6Hm7z0]  
 
Εικόνα 4.34 Ηθοποιός με αισθητήρες. 

 

 
[Πηγή: https://goo.gl/yXUwvJ] 
 
Εικόνα 4.35 Από την καταγραφή της κίνησης στη μοντελοποίηση. 

 
Η καταγραφή εκφράσεων προσώπου και μικρών κινήσεων άκρων, αναφέρεται ως performance 

capture. Τα προγράμματα που καταγράφουν τις κινήσεις, επιτρέπουν στους χρήστες να επεξεργάζονται και 
να συνδυάζουν πολλαπλές εισόδους και τμήματα κινήσεων, αλλά και να δημιουργούν σημαντικά καρέ. Το 
τελικό αποτέλεσμα είναι υψηλής ποιότητας και έχει ρεαλιστική κίνηση. 
 

4.4.4. Σχετικές τεχνικές και τεχνολογίες 
 
Εκτός από τις παραπάνω τεχνικές, εφαρμόζονται διάφορες διαδικασίες για την προσομοίωση κινήσεων σε 
ειδικές περιπτώσεις. 
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4.4.4.1. Σύστημα σωματιδίων 
 
Το σύστημα σωματιδίων (particle system) είναι μια τεχνική για την προσομοίωση φαινομένων, τα οποία είναι 
αρκετά δύσκολο να αποδοθούν ρεαλιστικά στον υπολογιστή με βάση τις προηγούμενες τεχνικές. Παραδείγ-
ματα τέτοιων φαινομένων είναι η προσομοίωση καπνού, φωτιάς, εκρήξεων, ανακλάσεων, βροχής, ομίχλης, 
χιονιού, σκόνης και άλλων ειδικών εφέ, όπως απεικονίζεται στην Εικόνα 4.36. 

 

 
[Πηγή: https://goo.gl/ewhNoG]  
 
Εικόνα 4.36 Σύστημα σωματιδίων για προσομοίωση έκρηξης. 

 
Η θέση των σωματιδίων στην τρισδιάστατη σκηνή και η συμπεριφορά των σωματιδίων ορίζεται από 

ένα σύστημα που καλείται emitter. Η συμπεριφορά των σωματιδίων καθορίζεται από διάφορες παραμέτρους 
που αφορούν το πόσα σωματίδια παράγονται στη μονάδα του χρόνου, την αρχική κατεύθυνσή τους, την ταχύ-
τητα, τον χρόνο ζωής κάθε σωματιδίου μέχρι να ολοκληρώσει τον κύκλο του, το χρώμα του και άλλες πολλές 
παραμέτρους. Αυτές οι παράμετροι καθορίζουν τη δημιουργία του τελικού σχεδίου. 

 

4.4.4.2. Θάμπωμα κίνησης 
 
Το θάμπωμα κίνησης (motion blur) είναι το θάμπωμα που δημιουργείται από αντικείμενα που κινούνται γρή-
γορα. Βασίζεται στο θόλωμα του φόντου που εμφανίζεται, όταν φωτογραφήσουμε ένα αντικείμενο που κινεί-
ται γρήγορα. Στην κίνηση των τρισδιάστατων μοντέλων, το φαινόμενο αυτό προσομοιώνεται με αύξηση των 
καρέ ανά δευτερόλεπτο. Έτσι, όταν δούμε ένα αντικείμενο που εμφανίζεται με θολό φόντο ή το ίδιο εμφανί-
ζεται θαμπό, τότε θεωρούμε ότι το αντικείμενο κινείται με μεγάλη ταχύτητα (Εικόνα 4.37).  

 

 
[Πηγή: http://goo.gl/NRfp5t]  
 
Εικόνα 4.37 Το θάμπωμα του φόντου εμφανίζει το αντικείμενο ως κινούμενο. 

 
4.4.4.3. Βάθος πεδίου 
 
Το βάθος πεδίου (depth of field) ορίζεται ως η απόσταση μεταξύ της πρόσθιας και της πίσω πλευράς του α-
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ντικειμένου που έχει την εστίαση. Μειώνοντας το μέγεθος και το θάμπωμα κάποιου αντικειμένου, μπορούμε 
να το έχουμε σε τρισδιάστατη όψη (π.χ. Εικόνα 4.38). Για κάθε θέση του φακού υπάρχει μόνο μια απόσταση 
στην οποία ένα αντικείμενο είναι εστιασμένο, δηλαδή η ευκρίνειά του είναι υψηλή. Επομένως, τροποποιώ-
ντας το βάθος πεδίου κάποιων αντικειμένων, αυτά εμφανίζονται ως κινούμενα . Στην Εικόνα 4.39 εμφανίζε-
ται το περιβάλλον του 3ds Max, όπου ρυθμίζονται οι κάμερες, προκειμένου να προσδώσουν την έννοια της 
προοπτικής και της τρισδιάστατης όψης.   

 

 
[Πηγή: https://goo.gl/Db6I9x] 
 
Εικόνα 4.38 Το θάμπωμα του φόντου εμφανίζει το αντικείμενο σαν να είναι στο βάθος. 

 

 
 
Εικόνα 4.39 Καθορισμός βάθους πεδίου στο 3ds Max. 

 
4.4.4.4. Εικονική και επαυξημένη πραγματικότητα 
 
Η εικονική πραγματικότητα (Virtual Reality - VR) είναι η προσομοίωση ενός περιβάλλοντος από έναν υπολο-
γιστή (π.χ. Εικόνα 4.40). Σύμφωνα με τον πατέρα του όρου Jaron Lanier, η εικονική πραγματικότητα αφορά 
«ένα αλληλεπιδραστικό, τρισδιάστατο περιβάλλον, φτιαγμένο από υπολογιστή, στο οποίο μπορεί κάποιος να εμ-
βυθιστεί». Ο όρος «εμβύθιση (immersion)» αναφέρεται στην αίσθηση του χρήστη ότι υπάρχει φυσικά μέσα 
στον χώρο και περιηγείται στα αντικείμενα. Οι εικόνες είναι στερεοσκοπικές, δηλαδή δύο εικόνες από διαφο-
ρετικές οπτικές γωνίες. Κάθε μάτι δέχεται διαφορετική εικόνα και έτσι δημιουργείται η αίσθηση του βάθους 
στον χώρο. Απαιτείται η ύπαρξη κατάλληλων γυαλιών ή πιο πολύπλοκων συσκευών όρασης και ήχου, που 
τοποθετούνται στο κεφάλι του χρήστη. Με κατάλληλα γάντια επιτυγχάνεται, επίσης, η αίσθηση της αφής 
στον χρήστη. Επιπλέον, με κατάλληλους αισθητήρες σε διάφορα μέρη του σώματος του χρήστη, μπορεί το 
σύστημα να αντιλαμβάνεται τις κινήσεις του χρήστη και να δημιουργεί τον τρισδιάστατο χαρακτήρα του 
(avatar), βοηθώντας έτσι τον χρήστη να έχει την εντύπωση της φυσικής παρουσίας του στον χώρο. 

Η επαυξημένη πραγματικότητα (augmented reality) αφορά τις τεχνολογίες που επιτρέπουν τη ζωντανή 
και σε πραγματικό χρόνο προβολή του πραγματικού περιβάλλοντος (π.χ. ενός μουσείου), εμπλουτισμένη (ε-
παυξημένη) με εικόνες δύο και τριών διαστάσεων, οι οποίες έχουν δημιουργηθεί μέσω υπολογιστή. Η εικονι-
κή πραγματικότητα μας εισάγει εξ ολοκλήρου σε έναν κόσμο που δημιουργείται από υπολογιστή. Αντίθετα, 
στην τεχνολογία της επαυξημένης πραγματικότητας υπερθέτονται εικόνες, οι οποίες δημιουργήθηκαν από 



127 

υπολογιστή, πάνω από τον πραγματικό κόσμο. Χρησιμοποιούνται, επίσης, ειδικά γυαλιά, που μας επιτρέπουν 
να βλέπουμε τον πραγματικό κόσμο και τις εικόνες που δημιουργούνται από τον υπολογιστή.  

 

 
[Πηγή: http://goo.gl/rGlsfI] 

 
Εικόνα 4.40 Παράδειγμα εικονικού κόσμου. 

 
Όλες αυτές οι τεχνολογίες απαιτούν τη δημιουργία τρισδιάστατων μοντέλων και τη φωτορεαλιστική 

απόδοση των επιφανειών. Αυτό μπορεί να επιτευχθεί είτε με τη χρήση κάποιων από τα λογισμικά που είδαμε 
παραπάνω είτε με ειδικές εφαρμογές για ανάπτυξη εφαρμογών εικονικής και επαυξημένης πραγματικότητας. 
Επιπρόσθετα, για την ανάπτυξη σχετικών εφαρμογών υπάρχουν ειδικές ομάδες εργαλείων, όπως οι Unreal 
Engine 4 (https://www.unrealengine.com) και Unity3D (https://unity3d.com), αλλά και ειδικές γλώσσες XML, 
όπως είναι η Augmented Reality Markup Language (ARML). 

 

4.5. Λογισμικό animation 
 
Στο διαδίκτυο υπάρχουν ορισμένα εργαλεία, όπως είναι τα http://goanimate.com, https://www.moovly.com, 
http://www.animaker.com και https://www.mixamo.com της Adobe, με τα οποία μπορούμε να δημιουργή-
σουμε προσομοιώσεις κίνησης στο επίπεδο (2D) και τον χώρο (3D). Τα λογισμικά Autodesk 3ds Max, Auto-
desk Maya και Blender, που είδαμε πιο πάνω, χρησιμοποιούνται επίσης για δημιουργία animations. Ειδικά τα 
εργαλεία της Autodesk θεωρούνται κορυφαία στον χώρο. Άλλα σημαντικά εργαλεία είναι τα CINEMA 4D, 
LightWave και Modo. Η Autodesk διαθέτει και το εργαλείο MotionBuilder για animation τρισδιάστατων χα-
ρακτήρων. Κάποιες από τις διαθέσιμες μορφοποιήσεις για κινούμενα τρισδιάστατα μοντέλα είναι οι .fbx, .dae, 
.bvh, .max, .3ds, .3dm, .c4d, .blend, .ma, .mb, .b3d, .obj. 

 

4.6. Ανακεφαλαίωση – βασικές έννοιες 
 
Στις προηγούμενες ενότητες παρουσιάσαμε κάποια θέματα που σχετίζονται με τα τρισδιάστατα γραφικά και 
την κίνηση σχεδίων, τα οποία έχουν δημιουργηθεί με υπολογιστή. Η διαδικασία δημιουργίας τρισδιάστατων 
ρεαλιστικών σχεδίων διακρίνεται στα βήματα της μοντελοποίησης και της φωτορεαλιστικής απόδοσης. Η 
μοντελοποίηση είναι η διαδικασία δημιουργίας του σχήματος ως ένα σύνολο από πολύγωνα ή με χρήση των 
καμπύλων NURBS. Στο στάδιο της φωτορεαλιστικής απόδοσης το σχήμα «ντύνεται» αρχικά με κάποια υφή ή 
χρώμα. Η χαρτογράφηση υφής μπορεί να γίνει με διάφορες τεχνικές και να δημιουργηθούν αντικατοπτρισμοί 
στην επιφάνεια ενός αντικείμενου ή απόδοση ανάγλυφης υφής. Στη συνέχεια μπορεί να γίνει εφαρμογή σκιών 
και σκιάσεων στην επιφάνεια, ώστε να είναι πιο ρεαλιστική η επιφάνεια. Η απόδοση σκιών και σκιάσεων γί-
νεται με τεχνικές, όπως η radiosity και η ray tracing. 

Η δημιουργία προσομοιώσεων κίνησης στο επίπεδο γίνεται με τις τεχνικές cel και path animation. 
Στην πρώτη τεχνική ζωγραφίζονται διαδοχικές στάσεις του σχεδίου και προβάλλονται γρήγορα, δίνοντας την 
αίσθηση της κίνησης. Στην τεχνική path animation σχεδιάζονται κάποια σημαντικά πλαίσια του αντικειμένου 
σε διάφορες θέσεις και ορίζεται η τροχιά κίνησης. Το λογισμικό σχεδιάζει τα ενδιάμεσα πλαίσια. Η κίνηση 
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σχεδίων στον χώρο γίνεται με τεχνικές, όπως η motion capture, όπου γίνεται καταγραφή των κινήσεων πραγ-
ματικών ηθοποιών που φέρουν ειδικούς αισθητήρες. Άλλες τεχνικές βασίζονται στη σχεδίαση βασικών καρέ 
ή καθορισμού της κίνησης με βάση την κίνηση των επιμέρους τμημάτων τους. Με κάποιες ειδικές τεχνικές, 
όπως το σύστημα σωματιδίων, το θάμπωμα κίνησης και το βάθος πεδίου επιτυγχάνεται η ψευδαίσθηση κίνη-
σης σε κάποιες ειδικές περιπτώσεις.  

Τα λογισμικά 3ds Max και Maya της Autodesk θεωρούνται κορυφαία όσον αφορά τη μοντελοποίηση 
τρισδιάστατων γραφικών και τη δημιουργία animations. Το Blender είναι δωρεάν εργαλείο ανοιχτού κώδικα 
για τη δημιουργία και κίνηση τρισδιάστατων γραφικών που έχει, επίσης, αρκετές δυνατότητες. Στο διαδίκτυο 
υπάρχουν κάποιες ιστοσελίδες για τη δημιουργία σύντομων δισδιάστατων animations. 
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5. Θεωρία Ψηφιακού Βίντεο 
 

Σύνοψη 
Το τρέχον κεφάλαιο παρουσιάζει θέματα που σχετίζονται με το ψηφιακό βίντεο. Αρχικά γίνεται εισαγωγή στα 
βασικά χαρακτηριστικά του βίντεο, όπως η ανάλυση και ο αριθμός πλαισίων ανά δευτερόλεπτο. Στη συνέχεια 
γίνεται σύντομη αναφορά στο αναλογικό βίντεο και τους τρόπους μετατροπής του σε ψηφιακή μορφή. Στην επό-
μενη ενότητα γίνεται περιγραφή του τρόπου σύλληψης βίντεο και του υπολογισμού του μεγέθους ασυμπίεστου 
ψηφιακού βίντεο. Γίνεται εκτενής αναφορά στη συμπίεση βίντεο με χρήση κωδικοποιητών/αποκωδικοποιητών 
(codecs) και δίνεται έμφαση στη συμπίεση MPEG. Παρουσιάζονται οι codecs H.264 και H.265 και συζητείται ο 
τρόπος επιλογής ενός κωδικοποιητή για τα οπτικά δεδομένα του βίντεο. Οι συνήθεις μορφοποιήσεις αρχείων 
παρουσιάζονται στη συνέχεια. Στην επόμενη ενότητα γίνεται αναφορά σε λογισμικό για προβολή, απλές επεξερ-
γασίες και ολοκληρωμένες επεξεργασίες του ψηφιακών αρχείων βίντεο. Το κεφάλαιο ολοκληρώνεται με αναφο-
ρά στο υλικό για σύλληψη, προβολή και αποθήκευση βίντεο. 

 
Προαπαιτούμενη γνώση 
Πολλά από τα θέματα που παρουσιάζονται προϋποθέτουν κατανόηση των σχετικών εννοιών που αφορούν την 
εικόνα και τον ήχο. Συνεπώς είναι απαραίτητο να μελετηθούν πρώτα τα κεφάλαια 2 και 3, όπου αναλύονται τα 
αντίστοιχα θέματα. 

 

5.1. Εισαγωγή στο ψηφιακό βίντεο 
 
Ένα απόσπασμα βίντεο (video clip) αποτελείται από διαδοχικές εικόνες, οι οποίες προβάλλονται γρήγορα και 
έτσι τα αντικείμενα εμφανίζονται ως κινούμενα. Οι διαδοχικές εικόνες, που αποτελούν το απόσπασμα βίντεο, 
ονομάζονται πλαίσια ή καρέ (frames). Τα πλαίσια είναι φωτογραφίες που έχουν μικρές διαφορές, όπως φαί-
νεται στην Εικόνα 5.1. Οι διαδοχικές στατικές οθόνες προβάλλονται με κάποιο πρόγραμμα προβολής βίντεο, 
π.χ. τον VLC player, και έτσι εμφανίζεται η κίνηση. 

 

 
 
Εικόνα 5.1 Πλαίσια ενός αποσπάσματος βίντεο. 

 
Ένα από τα βασικά χαρακτηριστικά ενός αποσπάσματος βίντεο είναι ο αριθμός των πλαισίων ανά 

δευτερόλεπτο (frame rate) που μετράται σε frames per second (fps). Αφορά τον αριθμό των πλαισίων που 
προβάλλονται ανά δευτερόλεπτο κατά την αναπαραγωγή ενός αποσπάσματος βίντεο. Ο αριθμός αυτός είναι 
σημαντικός, γιατί καθορίζει την ομαλότητα της εικόνας και το μέγεθος του αρχείου. Για να είναι ομαλή η εμ-
φάνιση του βίντεο χωρίς απότομες αλλαγές στις εικόνες, πρέπει ο αριθμός των πλαισίων ανά δευτερόλεπτο να 
είναι μεγάλος, π.χ. 25 fps ή 30 fps. Βέβαια, έτσι μεγαλώνει και το μέγεθος του βίντεο, γιατί κάθε απόσπασμα 
ασυμπίεστου βίντεο έχει μέγεθος όσο το συνολικό μέγεθος των πλαισίων που το αποτελούν. Ωστόσο, με τε-
χνικές συμπίεσης το μέγεθος του βίντεο μειώνεται. Εδώ πρέπει να αναφέρουμε την έννοια μετείκασμα 
(persistence of vision), που αναφέρεται στην ιδιότητα του ανθρώπινου συστήματος οπτικής αντίληψης να α-
ντιλαμβάνεται ως συνεχόμενη τη ροή διαδοχικών εικόνων, όταν το frame rate ξεπερνά ένα όριο, περίπου 16 
έως 18 fps. 

Στην Εικόνα 5.1 εμφανίζονται λιγότερα καρέ από ό,τι στο πραγματικό βίντεο. Αν οι συγκεκριμένες 
εικόνες προβάλλονταν, τότε η κίνηση της μπάλας θα ήταν απότομη. Δηλαδή, δεν θα υπήρχε μια ομαλή κίνη-
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ση της μπάλας από τον έναν παίκτη στον άλλο και θα φαινόταν πως η μπάλα και οι παίκτες μεταπηδούν στη 
νέα θέση τους. 

 

5.1.1. Βασικά χαρακτηριστικά ψηφιακού βίντεο 
 

Το ψηφιακό βίντεο αποτελείται από διαδοχικές στατικές εικόνες και έτσι έχει κάποια κοινά χαρακτηριστικά 
με την εικόνα. Με «Δεξί κλικ, Ιδιότητες» σε κάποιο αρχείο βίντεο στα Windows εμφανίζονται τα χαρακτηρι-
στικά του, όπως παρουσιάζεται στην Εικόνα 5.2.   

 Η ανάλυση (video resolution), η οποία αναφέρεται στη βιβλιογραφία και ως χωρική ανάλυση (spatial 
resolution) ή απλά μέγεθος (size), είναι η οριζόντια και κάθετη διάσταση της εικόνας. Εκφράζεται σε pixels 
(εικονοστοιχεία). Για παράδειγμα, βίντεο με ανάλυση 640×480 σημαίνει ότι οι εικόνες που αποτελούν το βί-
ντεο έχουν διάσταση 640 pixels οριζοντίως και 480 pixels καθέτως. Στην αναλογική τηλεόραση η ανάλυση 
ήταν 768×484 ή 768×576. Στους υπολογιστές η ανάλυση των οθονών είναι υψηλότερη και έτσι το ψηφιακό 
βίντεο έχει υψηλή ανάλυση.  

 

 
 
Εικόνα 5.2 Ιδιότητες βίντεο. 

 
Στους σύγχρονους υπολογιστές η ανάλυση του βίντεο είναι συχνά αρκετά υψηλή και φτάνει στα 

1920×1080. Η ανάλυση αυτή είναι γνωστή ως Full HD (Full High Definition) και ουσιαστικά αποτελείται 
από 1080 οριζόντιες γραμμές. Συνήθως αναφέρεται είτε ως Full HD είτε ως 1080p. Η σηματοδότηση 1080i 
σημαίνει ότι εφαρμόζεται η πεπλεγμένη σάρωση (interlaced), που είναι μια μέθοδος όπου κάθε εικόνα σχεδιά-
ζεται σε 2 περάσματα: πρώτα οι μονές γραμμές του πλαισίου (1η, 3η, 5η κ.λπ) και μετά οι άρτιες. Αυτή η μέ-
θοδος αυξάνει τεχνητά τον αριθμό των φορών που επανασχηματίζεται η εικόνα στην οθόνη του υπολογιστή, 
δηλαδή αυξάνει τη συχνότητα. Συνήθεις αναλύσεις βίντεο που προβάλλονται μέσω του διαδικτύου, π.χ. στο 
YouTube, είναι οι 360p (480×360), 480p (640×480) και 720p (1280×720). Η ανάλυση 720p είναι αρκετά 
υψηλή για διαδικτυακό βίντεο και μπορεί να υποστηριχθεί με τις τρέχουσες ταχύτητες στο internet. Η ανάλυ-
ση Full HD απαιτεί υψηλές ταχύτητες μεταφοράς δεδομένων στο διαδίκτυο και σε αρκετές περιπτώσεις μπο-
ρεί να είναι απαγορευτική για απευθείας προβολή. 

Με την εξέλιξη της τεχνολογίας έχει εμφανιστεί και ο όρος UHD (Ultra High Definition). Συναντά-
ται, επίσης, με την ορολογία 4K και ουσιαστικά αναφέρεται σε όλες τις αναλύσεις που είναι υψηλότερες από 
το Full HD. UHD ανάλυση θεωρείται η 2160p (3840×2160). Η ανάλυση 4K×2K (4096×2160 pixels), χρησι-
μοποιείται από κάποιους βίντεο προβολείς και από αρκετές επαγγελματικές φωτογραφικές μηχανές. Πλέον 
έχουμε φτάσει να μιλάμε για το 8K UHD, που αφορά ανάλυση 7680×4320 (33.2 megapixels), ενώ αναμένε-
ται συνεχώς να αυξάνουν αυτοί οι αριθμοί, καθώς θα προχωρά η τεχνολογία. 

Το βάθος χρώματος (color depth) ή χρωματική ανάλυση (color resolution) είναι ο αριθμός των δυα-
δικών ψηφίων (bits) που χρησιμοποιούνται για την αναπαράσταση του χρώματος κάθε εικονοστοιχείου. Με 
βάθος χρώματος Ν μπορούν να κωδικοποιηθούν 2Ν αποχρώσεις. Τυπικές αναλύσεις χρώματος RGB για βί-
ντεο είναι οι 16 bits/pixel (65,536 χρώματα) και πραγματικού βάθους χρώματος 24 bits/pixel (16.777.216 α-
ποχρώσεις ή 16.7 εκατ. χρώματα).  
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O αριθμός πλαισίων ανά δευτερόλεπτο (frame rate ή frames per second) ή αλλιώς συχνότητα 
πλαισίων (frame frequency) είναι ο αριθμός των διαφορετικών καρέ (εικόνων) που προβάλλονται ανά δευτε-
ρόλεπτο. Τυπικοί ρυθμοί είναι οι 24, 25, 30, 48, 50, 60 fps.  

Η χρονική διάρκεια (duration) είναι ο χρόνος που διαρκεί η προβολή του βίντεο και εκφράζεται σε 
δευτερόλεπτα. 

Ένα επιπλέον χαρακτηριστικό του ψηφιακού βίντεο είναι ο λόγος πλευρών (aspect ratio), ο οποίος 
αναφέρεται στον λόγο της οριζόντιας διάστασης προς την κάθετη διάστασης. Στις παλαιότερες τηλεοράσεις ο 
λόγος αυτός ήταν 4:3 (περίπου 1,33:1) και γι’ αυτό είχαν τετράγωνη εμφάνιση. Αυτό ίσχυε, επειδή το τηλεο-
πτικό σήμα, δηλαδή το βίντεο που μεταδίδονταν και προβάλλονταν στην τηλεόραση, είχε λόγο 4:3. Στο ψη-
φιακό βίντεο ο λόγος είναι 16:9 (περίπου 1,77:1). Οι σύγχρονες οθόνες τηλεόρασης και υπολογιστών έχουν 
αναλογία 16:9 και εμφανίζονται μακρόστενες. Στην Εικόνα 5.3 βλέπουμε την ίδια εικόνα σε λόγο 4:3 και 
16:9. Η αρχική εικόνα έχει φωτογραφηθεί με λόγο 4:3 και γι’ αυτό στη δεύτερη περίπτωση εμφανίζονται κά-
πως πιο αφύσικα (πιο πεπλατυσμένα) τα αρχαία κολωνάκια. Αντίστοιχα, αν η αρχική εικόνα ήταν σε 16:9, θα 
εμφανιζόταν αφύσικη κατά τη μετατροπή της σε 4:3. Βέβαια, ο λόγος πλευρών του βίντεο, που θα χρησιμο-
ποιήσουμε στην εφαρμογή πολυμέσων ή στην ιστοσελίδα μας, εξαρτάται από τον λόγο που έχει χρησιμοποι-
ηθεί κατά την εγγραφή του βίντεο. 

Σκοπός της ψηφιακής τηλεόρασης είναι το ψηφιακό τηλεοπτικό σήμα να είναι Full HD και με λόγο 
16:9. Στην Ελλάδα η Digea εκπέμπει τηλεοπτικό σήμα σε Standard Definition (SD), που είναι μικρότερο από 
το Full HD σήμα. Επίσης το σήμα της Digea είναι 576i. Επομένως, δεν είναι απαραίτητο στις παλαιές τηλεο-
ράσεις να χρησιμοποιούμε αποκωδικοποιητή που υποστηρίζει σήμα Full HD. Η ανάλυση είναι είτε 4:3 ή 
16:9, ανάλογα με το σήμα που εκπέμπει το κάθε κανάλι. 

 

 
[Πηγή αρχικής εικόνας: http://goo.gl/Z6yhal] 
 
Εικόνα 5.3 Η ίδια φωτογραφία με αναλογίες 4.3 και 16:9. 

 
Ένα βασικό χαρακτηριστικό ενός βίντεο είναι, επίσης, ο ρυθμός μεταφοράς bit (bit rate). Ο αριθμός 

αυτός αφορά τα δεδομένα που περιέχονται σε ένα δευτερόλεπτο ενός αρχείου ή μιας ροής βίντεο και εκφρά-
ζεται σε bit ανά δευτερόλεπτο (bits per second ή bit/s ή bps) ή Kilobit ανά δευτερόλεπτο (Kbit/s ή Kbps) ή 
Megabit ανά δευτερόλεπτο (Mbit/s ή Mbps). Μεγαλύτερος ρυθμός μετάδοσης σημαίνει και καλύτερη ποιότη-
τα βίντεο, γιατί τελικά μπορούν να μεταδοθούν περισσότερα δεδομένα, άρα βίντεο μεγαλύτερης ανάλυσης. Ο 
ρυθμός μεταφοράς δεν αφορά μόνο τη μετάδοση μέσω του διαδικτύου, αλλά και οποιοδήποτε μέσο από το 
οποίο πρέπει να διαβαστεί το βίντεο και να προβληθεί. Για παράδειγμα, το βίντεο ποιότητας DVD έχει ρυθμό 
μετάδοσης περίπου 5 Mbps, ενώ το βίντεο στην τηλεόραση HDTV έχει ρυθμό μετάδοσης που προσεγγίζει τα 
20 Mbps. Το βίντεο 720p στο διαδίκτυο χρειάζεται bit rate από 1500 έως 4000 Kbps. Θα πρέπει να σημειωθεί 
ότι με τεχνικές συμπίεσης μειώνεται ο απαιτούμενος ρυθμός μεταφοράς. Πρέπει, επίσης, να σημειωθεί ότι το 
συνολικό bit rate εξαρτάται από το bit rate για τα δεδομένα οπτικής πληροφορίας, αλλά και τα δεδομένα για 
ήχο, αν και στο παρόν κεφάλαιο εστιάζουμε κυρίως στα δεδομένα οπτικής πληροφορίας. 

Συνήθως ο ρυθμός μετάδοσης bit είναι σταθερός (CBR – Constant Bit Rate). Ο ρυθμός μετάδοσης 
μπορεί να είναι και μεταβλητός (VBR – Variable Bit Rate), για να επιτευχθεί καλύτερη ποιότητα βίντεο. Στις 
σκηνές γρήγορης κίνησης ο ρυθμός μετάδοσης είναι υψηλός, ενώ στις σκηνές με αργή κίνηση το bit rate είναι 
χαμηλό. 

Επειδή το μέγεθος του ψηφιακού βίντεο είναι αρκετά μεγάλο και απαγορευτικό σε κάποιες περιπτώ-
σεις, π.χ. για μετάδοση μέσω διαδικτύου ή για αποθήκευση πολλών βίντεο σε κάποιο μέσο, έχουν αναπτυχθεί 
διάφορες τεχνικές συμπίεσης (compression). Οι αλγόριθμοι συμπίεσης έχουν διάφορα χαρακτηριστικά, όπως 
ο λόγος συμπίεσης, η τεχνική συμπίεσης και η πολυπλοκότητα. 
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5.2. Αναλογικό βίντεο 
 
Πριν προχωρήσουμε στην αναλυτική μελέτη των θεμάτων που σχετίζονται με τo ψηφιακό βίντεο, θα αναλύ-
σουμε κάποια θέματα που σχετίζονται με το αναλογικό βίντεο. Ορισμένα από αυτά τα ζητήματα αφορούν και 
στο ψηφιακό βίντεο. Επιπλέον, ακόμη υπάρχουν βίντεο σε αναλογική μορφή σε παλαιότερα μέσα, όπως είναι 
οι κασέτες, όπου το βίντεο αποθηκευόταν σε μαγνητική ταινία. Κάποια από αυτά τα χαρακτηριστικά είναι 
σημαντικό να τα γνωρίζουμε κατά τη μετατροπή του βίντεο σε ψηφιακό. 

Το αναλογικό βίντεο (analog video) είναι το τηλεοπτικό σήμα που λαμβάναμε πριν την έλευση της 
ψηφιακής τηλεόρασης, αλλά και το βίντεο που εγγραφόταν με τις αντίστοιχες αναλογικές κάμερες. Μια βασι-
κή διαφορά του αναλογικού βίντεο και του ψηφιακού βίντεο προκύπτει ακριβώς από τον τρόπο κωδικοποίη-
σης. Το αναλογικό βίντεο αποθηκευόταν σε μαγνητικές ταινίες και, όταν γινόταν αντιγραφή σε άλλη κασέτα 
ή ακόμη και εξαιτίας των πολλών χρήσεων της ίδιας κασέτας, είχαμε ως αποτέλεσμα την αλλοίωση της εικό-
νας. Αντίθετα, το ψηφιακό βίντεο αποθηκεύεται σε δυαδικά ψηφία και δεν αλλοιώνεται με την αντιγραφή ή 
τις πολλαπλές χρήσεις.    

Αρχικά το τηλεοπτικό σήμα ήταν ασπρόμαυρο και, όταν το σήμα έφτανε στον τηλεοπτικό δέκτη, η 
εικόνα σχηματιζόταν με εκτόξευση ηλεκτρονίων προς τη γυάλινη επιφάνεια της τηλεόρασης. Τα ηλεκτρόνια 
διέγειραν τον φώσφορο με τον οποίο ήταν καλυμμένη η επιφάνεια των CRT τηλεοράσεων και εμφανιζόταν η 
εικόνα. 

Η διέγερση του φωσφόρου από τα ηλεκτρόνια γίνεται γραμμή προς γραμμή. Σαρώνεται, δηλαδή, η 
οθόνη από αριστερά προς τα δεξιά και από πάνω προς τα κάτω. Έτσι, φωτίζεται όλη η οθόνη, δημιουργώντας 
ένα από τα πλαίσια του βίντεο. Η διαδικασία επαναλαμβάνεται πολλές φορές ανά δευτερόλεπτο και έτσι εμ-
φανίζονται οι στατικές εικόνες ως κινούμενες. Η σάρωση της οθόνης μπορεί να είναι πεπλεγμένη (interlaced) 
ή προοδευτική - μη πεπλεγμένη (progressive - non-interlaced). Στην πεπλεγμένη σάρωση η εικόνα εμφανίζεται 
σταδιακά, όπως φαίνεται στην Εικόνα 5.4. 

 

 
 
Εικόνα 5.4 Πεπλεγμένη σάρωση. 

 
Στην πεπλεγμένη σάρωση εμφανίζονται πρώτα οι μονές γραμμές και έπειτα οι ζυγές γραμμές. Με την 

τεχνική αυτή δίνεται η δυνατότητα της σταδιακής εμφάνισης του καρέ και, επειδή εμφανίζονται οι γραμμές 
σε δύο χρόνους, δίνεται οι ψευδαίσθηση μεγαλύτερου frame rate. Ο σκοπός, βέβαια, δεν ήταν να αυξηθεί το 
frame rate, αλλά να μειωθεί το flickering (τρεμόπαιγμα) που προκαλούνταν εξαιτίας τεχνικών περιορισμών 
στα χημικά, με τα οποία ήταν καλυμμένες οι οθόνες. Με τη διπλή σάρωση της οθόνης το flickering μειωνό-
ταν.  

Σε κάποια μορφότυπα εικόνων, π.χ. στις εικόνας png, η πεπλεγμένη σάρωση βοηθά στο να βλέπουμε 
άμεσα την εικόνα που σχηματίζεται, ακόμη και πριν μεταφορτωθεί στον υπολογιστή μας. Όπως αναφέραμε 
πιο πάνω, η τεχνική πεπλεγμένης σάρωσης χρησιμοποιείται και στο ψηφιακό βίντεο, π.χ. το βίντεο 1080i εί-
ναι πεπλεγμένο, ενώ το p μετά τον αριθμό, π.χ. 1080p, δηλώνει ότι η σάρωση είναι προοδευτική. 

 

5.2.1. Διεθνή πρότυπα για αναλογικό βίντεο 
 

Στην ακόλουθη λίστα παραθέτουμε τα διεθνή πρότυπα για το τηλεοπτικό αναλογικό βίντεο. 
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 To PAL (Phase Alternate Line) είναι το Γερμανικό στάνταρ για κωδικοποίηση τηλεοπτικού 
σήματος, που επικράτησε στις περισσότερες χώρες του κόσμου. Προβλέπει 625 γραμμές με 
50 Hz κατακόρυφη συχνότητα οθόνης και ρυθμό ανανέωσης 25 πλαίσια ανά δευτερόλεπτο. Η 
οριζόντια συχνότητα είναι 15.625 kHz. Υποστηρίζει λόγο εικόνας 4:3 με εύρος ζώνης βίντεο 
4 MHz. Το PAL χρησιμοποιεί το χρωματικό μοντέλο YUV, που αναφέρουμε πιο κάτω. Η 
σάρωση είναι πεπλεγμένη και εμφανίζονται πρώτα οι μισές και έπειτα οι υπόλοιπες μισές.  

 Το NTSC (National Television Standards Committee) είναι το Αμερικάνικο στάνταρ για την 
κωδικοποίηση του αναλογικού βίντεο. Προβλέπει 525 γραμμές πεπλεγμένης σάρωσης με κά-
θετη συχνότητα οθόνης 60 Hz. Ο ρυθμός ανανέωσης είναι 30 καρέ ανά δευτερόλεπτο και ο-
ριζόντια συχνότητα ανανέωσης 15.734 kHz. Υποστηρίζει λόγο εικόνας 4:3 και χρησιμοποιεί 
το χρωματικό μοντέλο YIQ. Χρησιμοποιείται στη Νότια Αμερική, την Ιαπωνία και σε άλλες 
χώρες του κόσμου.  

 Το SECAM (Sequentiel Coleur A Memoire) είναι το Γαλλικό στάνταρ για κωδικοποίηση τη-
λεοπτικού βίντεο. Η εικόνα αποτελείται από 625 γραμμές με κάθετη συχνότητα 50 Hz, οριζό-
ντια συχνότητα 15.625 kHz και ρυθμό ανανέωσης 25 πλαίσια ανά δευτερόλεπτο. Υποστηρί-
ζει μορφότυπο εικόνας 4:3 και χρησιμοποιείται, κυρίως, στη Γαλλία και στη Ρωσία. Και στο 
τρέχον πρότυπο η σάρωση είναι πεπλεγμένη. 

 
Τα παραπάνω πρότυπα έχουν κάποια κοινά χαρακτηριστικά, που λαμβάνουν όμως διαφορετικές τιμές 

και τελικά διαχωρίζουν το σήμα. Τα βασικά χαρακτηριστικά έχουν ως εξής: 
 Οι γραμμές ανά πλαίσιο (lines per frame) είναι ο αριθμός γραμμών του κάθε πλαισίου του 

βίντεο. Τα PAL και SECAM ορίζουν 625 γραμμές ανά πλαίσιο, ενώ στο NTSC είναι 525 
γραμμές. Σε κάθε περίπτωση οι τιμές αυτές είναι οι μέγιστες δυνατές και, τις περισσότερες 
φορές, οι ορατές γραμμές είναι λιγότερες. Για παράδειγμα, στο SECAM εμφανίζονται συνή-
θως 576 γραμμές, αντί για 625. 

 H κατακόρυφη συχνότητα (vertical frequency) αναφέρεται στον ρυθμό κατακόρυφης ανα-
νέωσης της εικόνας στο δευτερόλεπτο. Μετριέται σε Hertz και τυπικές τιμές είναι τα 50 ή 60 
Hz. 

 Ο αριθμός καρέ (frames per second) είναι ο αριθμός εικόνων που σχηματίζονται κάθε δευ-
τερόλεπτο. Εξαρτάται από την κατακόρυφη συχνότητα. Για παράδειγμα, αν ο ρυθμός είναι 50 
Hz, και εφόσον η σάρωση είναι πεπλεγμένη, τότε σχηματίζονται 25 πλαίσια ανά δευτερόλε-
πτο. Σε κάθε δευτερόλεπτο σχηματίζονται 50 πεδία, δηλαδή τμήματα με μονές γραμμές και 
τμήματα με ζυγές γραμμές, λόγω της πεπλεγμένης σάρωσης. 

 Ο λόγος εικόνας (aspect ratio), που συναντάται και ως μορφότυπο, αναφέρεται στον λόγο 
της οριζόντιας (πλάτος) προς την κάθετη διάσταση (ύψος) της εικόνας. Συνήθως, στο αναλο-
γικό σήμα o λόγος είναι 4:3. 

 Το χρωματικό μοντέλο (color model) είναι ο τρόπος κωδικοποίησης της χρωματικής πληρο-
φορίας που μεταφέρεται μαζί με το ασπρόμαυρο σήμα. Το αναλογικό σήμα χρησιμοποιούσε, 
κατά κύριο λόγο, διαφορετικά χρωματικά μοντέλα σε σχέση με αυτά που εξετάσαμε στο κε-
φάλαιο 2 του βιβλίου. Τα μοντέλα κωδικοποίησης χρώματος τα εξετάζουμε στη συνέχεια. 

 

5.2.2. Κωδικοποίηση χρώματος 
 
Όταν το αναλογικό σήμα βίντεο ήταν ασπρόμαυρο, χρειαζόταν μόνο η μεταφορά πληροφορίας για τη φωτει-
νότητα του κάθε pixel. Στο έγχρωμο σήμα, όμως, απαιτείται και η μεταφορά της χρωματικής πληροφορίας. 
Για τον σκοπό αυτό αναπτύχθηκαν διάφοροι μέθοδοι κωδικοποίησης της χρωματικής πληροφορίας. Τα μο-
ντέλα χωρίζονται στις κατηγορίες Component, Y/C και Composite. 

Το αναλογικό component βίντεο μεταφέρει τη χρωματική πληροφορία ως δύο ή περισσότερα χωριστά 
σήματα (components). Το component βίντεο μπορεί να είναι κωδικοποιημένο ως RGB ή YUV ή YIQ ή 
YCBCR ή YPBPR. 

Στην κωδικοποίηση RGB η χρωματική πληροφορία βασίζεται στα τρία χρώματα Red, Green και Blue. 
Το βασικό πλεονέκτημα αυτού του τύπου κωδικοποίησης είναι η υψηλή ποιότητα μετάδοσης, καθώς και ότι 
αποτελεί το βασικό μοντέλο κωδικοποίησης του χρώματος και στους υπολογιστές.  
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Το YUV χρησιμοποιεί, επίσης, τρεις συνιστώσες. Το Υ αναφέρεται στη φωτεινότητα (luminance) και 
οι συνιστώσες U και V αφορούν στη χρωματική πληροφορία (chrominance). Το μοντέλο YUV χρησιμοποιεί-
ται στα συστήματα μετάδοσης PAL και NTSC. Χρησιμοποιήθηκε ως εναλλακτικό του RGB, προκειμένου το 
έγχρωμο σήμα να είναι συμβατό με τις παλαιότερες ασπρόμαυρες τηλεοράσεις. Οι ασπρόμαυρες τηλεοράσεις 
απλά αγνοούν τις U και V χρωματικές πληροφορίες. Επειδή γίνεται διαχωρισμός της φωτεινότητας από το 
χρώμα, υποστηρίζεται η αποδοτική συμπίεση του χρώματος. Οι συνιστώσες Y, U και V μπορούν να προκύ-
ψουν από τα σήματα R, G, B του προηγούμενου μοντέλου, σύμφωνα με τις ακόλουθες εξισώσεις: 

Y = 0.299R + 0.587G + 0.114B 
U = − 0.147R − 0.289G + 0.436B 
V = 0.615R − 0.515G − 0.100B 

 
Στην κωδικοποίηση YIQ τα αρχικά I, Q αντιστοιχούν στους όρους in-phase και quadrature (τετρα-

γωνισμός). Αντιστοιχούν στο μοντέλο YUV και χρησιμοποιούνταν παλαιότερα στο NTSC. Τα συστήματα 
YCBCR (ή YCC) και YPBPR αποτελούν προσαρμοσμένες εκδόσεις του YUV για οικιακές συσκευές αναλογι-
κού βίντεο και συσκευές ψηφιακής τεχνολογίας, όπως ψηφιακές κάμερες. 

Στο χρωματικό μοντέλο Y/C η φωτεινότητα Y και το χρώμα C μεταφέρονται σε χωριστά συγχρονι-
σμένα σήματα. Το χρώμα C προκύπτει, συνδυάζοντας τα σήματα U και V του μοντέλου YUV. Ο τρόπος κω-
δικοποίησης Y/C προσφέρει μεγαλύτερη συμπίεση, αλλά έχει χαμηλότερη ποιότητα από τους προηγούμενους 
τρόπους. 

Το composite σήμα προσφέρει μεγαλύτερη συμπίεση από τα προηγούμενα. Η φωτεινότητα και η 
χρωματική πληροφορία συντίθενται σε ένα μοναδικό σύνθετο σήμα. 

Η γνώση του τρόπου κωδικοποίησης του σήματος και του χρώματος του αναλογικού βίντεο είναι ση-
μαντικό, γιατί υπάρχουν ακόμη αρκετά βίντεο σε αναλογική μορφή, που μπορεί να χρειαστούν μετατροπή σε 
ψηφιακό βίντεο. Ειδικά σε εφαρμογές ψηφιακής διατήρησης ή ακόμη και στη μετατροπή βίντεο που έχουμε 
εγγράψει με αναλογικές κάμερες. 
 

5.2.3. Αποθήκευση αναλογικού βίντεο 
 
Το αναλογικό βίντεο αποθηκευόταν σε μαγνητικές ταινίες διαφόρων μεγεθών και χωρητικοτήτων (Εικόνα 
5.5). Η εγγραφή στις ταινίες γινόταν με κάμερες, συνήθως ογκώδεις σε σχέση με τις σημερινές κάμερες και 
τα κινητά τηλέφωνα. Η αναπαραγωγή των VHS βιντεοκασετών γινόταν με ειδικά μηχανήματα, π.χ. με τον 
VHS player, που απλά τον αποκαλούσαμε «βίντεο». Για τις υπόλοιπες, μικρότερου μεγέθους, κασέτες συν-
δεόταν η κάμερα με την τηλεόραση και γινόταν αναπαραγωγή του περιεχομένου τους. 

 

 
 
Εικόνα 5.5 Κασέτες με μαγνητικές ταινίες για αποθήκευση βίντεο. 

 
Το VHS (Video Home System) ήταν το πρώτο πρότυπο για αποθήκευση και αναπαραγωγή σε βιντεο-

κασέτες, οι οποίες χρησιμοποιούνται σε οικιακό εξοπλισμό βίντεο (VCR – Video Cassette Recorder). Μπο-
ρούσαν να εγγράψουν βίντεο σε NTSC ή PAL με διαφορετική ταχύτητα και διάρκεια, ανάλογα με τον τύπο 
σήματος. Το πρότυπο S-VHS (Super VHS) βελτιώνει τη φωτεινότητα τους σήματος, που εγγράφεται με τον 
τρόπο VHS. Υπήρξε βελτίωση στις λεπτομέρειες της εικόνας και οριζόντια ανάλυση 400 γραμμών, σε αντί-
θεση με τις 240 γραμμές, που υπάρχουν στην περίπτωση του VHS. Εκτός από το S-VHS υπήρχαν και τα πρό-
τυπα D-VHS (Digital VHS) και W-VHS (high definition analogue video tape). 



135 

Το μορφότυπο Betamax (ή Beta) χρησιμοποιόταν στις πρώτες βιντεοκάμερες και πρόσφερε πολύ 
υψηλή ανάλυση. Μαλιστα, για κάποιο διάστημα αντικατέστησε το VHS. To Extended Definition Betamax 
έφτανε ανάλυση 700×576 με κωδικοποίηση PAL. 

Οι νεώτερες και μικρότερες κασέτες των 8mm υποστήριζαν τα μορφότυπα Video8, Hi8 και Digital8. 
Στα δύο πρώτα μορφότυπα το βίντεο ήταν αναλογικό, ενώ στο Digital8 ήταν ψηφιακό.  
 

5.2.4. Μετατροπή αναλογικού βίντεο σε ψηφιακό 
 
Η μετατροπή του αναλογικού βίντεο σε ψηφιακό είναι λογικά η μόνη διαδικασία, στην οποία θα χρειαστεί 
πλέον να χρησιμοποιήσουμε αναλογικό βίντεο. Η διαδικασία γίνεται μέσω ειδικού υλικού. Στην Εικόνα 5.6 
εμφανίζεται μια συσκευή, όπου στη μία πλευρά διαθέτει καλώδια S-Video και Composite, τα οποία μπορεί να 
συνδεθούν στα αντίστοιχα καλώδια εξόδου της συσκευής αναπαραγωγής του αναλογικού βίντεο. Η άλλη έ-
ξοδος συνδέεται με τη USB θύρα του υπολογιστή μας. Μέσω κατάλληλου λογισμικού γίνεται η εγγραφή 
(σύλληψη) σε ψηφιακή μορφή. Υπάρχουν και πιο σύνθετες συσκευές που επιτρέπουν απευθείας την προβολή 
του αναλογικού βίντεο σε ψηφιακές συσκευές. Στην Εικόνα 5.7 βλέπουμε μια συσκευή, η οποία έχει εισόδους 
για αναλογικές και ψηφιακές συσκευές και έχει έξοδο σε θύρα HDMI (High-Definition Multimedia 
Interface), η οποία αποτελεί ένα πρότυπο σύνδεσης για τη μετάδοση ψηφιακού ήχου και εικόνας. 

Κάποιες παλαιότερες, συνήθως, κάρτες βίντεο έχουν εισόδους για βίντεο και συνδέονται είτε με συ-
σκευές αναπαραγωγής βίντεο ή απευθείας με το αναλογικό βίντεο (π.χ. Εικόνα 5.8). Κάποιες κάρτες βίντεο 
διαθέτουν και τηλεοπτικό δέκτη (TV-tuner), οπότε λαμβάνουν απευθείας τηλεοπτικό σήμα, το οποίο μετα-
τρέπουν, και μπορούν να αποθηκεύσουν, σε ψηφιακό σήμα. 

 

 
 
Εικόνα 5.6 Μετατροπέας αναλογικού βίντεο σε ψηφιακό. 

 
 

 
 
Εικόνα 5.7 Σύνθετη συσκευή με έξοδο. 
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Εικόνα 5.8 Κάρτα βίντεο με διάφορες εισόδους. 

  
 

5.3. Σύλληψη, μέγεθος, συμπίεση, κωδικοποιητές και μορφοποιήσεις αρχείων 
 

5.3.1. Σύλληψη  
 
Με τον όρο «σύλληψη» (capture) αναφερόμαστε στον τρόπο με τον οποίο καταφέρνουμε να εγγράψουμε το 
ψηφιακό βίντεο σε κάποιο μέσο. Ένας τρόπος είναι η μετατροπή του αναλογικού βίντεο σε ψηφιακό, σύμφω-
να με τους τρόπους που μελετήσαμε στο τέλος της προηγούμενης ενότητας. Ο άλλος τρόπος είναι με χρήση 
προφανώς κάποιας κάμερας, που μπορεί να συλλάβει και να εγγράψει σε κάποιο μέσο το ψηφιακό βίντεο. 

Οι ψηφιακές κάμερες προς το τέλος της δεκαετίας ’90 και αρχές του 2000 αποθήκευαν το βίντεο σε 
κασέτες Digital8 ή κασέτες DV. Οι κασέτες DV υπήρχαν σε διάφορους τύπους, ωστόσο, είχε επικρατήσει ο 
τύπος Mini DV με διαστάσεις 3,7x2,5x0,6 ίντσες (95x62,5x15 mm). Αποθήκευαν μέχρι και 90 λεπτά βίντεο. 
Στη συνέχεια, εμφανίστηκαν οι Micro MV με μικρότερο μέγεθος και οι κασέτες DVCAM και DVDPRO, που 
αποτελούν παραλλαγές του αρχικού DV προτύπου. Για παράδειγμα, είχαν μεγαλύτερο πλάτος ταινίας ή μεγα-
λύτερη ταχύτητα εγγραφής, ώστε να εγγράφεται βίντεο μεγαλύτερης διάρκειας σε αυτές. Οι κασέτες αυτές, αν 
και αποθήκευαν ψηφιακά το βίντεο, έχουν πλέον πάψει να κυκλοφορούν και απλά υπάρχουν ως απομεινάρια 
μιας παλαιότερης εποχής. 

Η επόμενη γενιά από βιντεοκάμερες αποθήκευαν το βίντεο απευθείας σε DVD διαμέτρου 8cm. Το 
DVD μπορεί να εισαχθεί απευθείας στον υπολογιστή ή στο DVD player για προβολή. Το βίντεο αποθηκεύο-
νταν με βάση το πρότυπο συμπίεσης MPEG-2 Part 2 ή MPEG-1 Part 2 και βάθος χρώματος 8-bit. Η ανάλυση 
έφτανε μέχρι και 720×576 στα 25 καρέ ανά δευτερόλεπτο. 

Πλέον, η σύλληψη βίντεο γίνεται με ψηφιακές βιντεοκάμερες, οι οποίες είναι είτε ανεξάρτητες μονά-
δες, ή ενσωματωμένες σε κινητά τηλέφωνα, ή σε υπολογιστές. Ακόμη και οι συσκευές, που είναι πρωτίστως 
φωτογραφικές μηχανές, διαθέτουν λειτουργία εγγραφής βίντεο. Η εγγραφή γίνεται σε οποιοδήποτε μέσο μπο-
ρεί να εγγράψει ψηφιακή πληροφορία, π.χ. σε σκληρούς δίσκους και κάρτες μνήμης (memory sticks). Τα α-
κριβά κινητά τηλέφωνα μπορούν να εγγράψουν βίντεο 1080p HD στα 30 fps ή στα 60 fps.  

Μερικά κινητά προσφέρουν τη δυνατότητα εγγραφής που καλείται “slow-mo” (slow motion – αργή 
κίνηση) σε ανάλυση 1080p στα 120 fps ή 720p στα 240 fps. Δηλαδή, εγγράφουν πολλά frames ανά δευτερό-
λεπτο. Ωστόσο, όταν προβάλλονται σε κάποια συσκευή που έχει τη δυνατότητα να προβάλει λιγότερα καρέ 
ανά δευτερόλεπτο, π.χ. 30 fps, τότε η κίνηση εμφανίζεται μεν ομαλά, όμως σε αργή κίνηση. Το αρχικό βίντεο 
πρέπει να έχει επεξεργαστεί με κάποιο λογισμικό, ώστε να μειωθεί το frame rate, προκειμένου να φαίνεται 
τελικά ομαλή η κίνηση. 

Μπορεί να ειπωθεί ότι πλέον η εγγραφή ψηφιακού βίντεο είναι μια συνηθισμένη διαδικασία και ο δι-
αμοιρασμός, με υπηρεσίες όπως το www.youtube.com συνιστά, επίσης, μια απλή διαδικασία. Εκεί όπου τελι-
κά πρέπει να εστιάσει κάποιος χρήστης, ο οποίος ασχολείται με το ψηφιακό βίντεο, είναι τα χαρακτηριστικά 
του μέσου σύλληψης. Για παράδειγμα, οι web κάμερες που χρησιμοποιούνται με κάποιον υπολογιστή κατη-
γοριοποιούνται με βάση τη μέγιστη ανάλυση που υποστηρίζουν, π.χ. 640x480, 1280x720, 1280x1024 ή 
1920x1080. Η ποιότητα κατασκευής, η δυνατότητα λήψης φωτογραφιών πολλών megapixels, οι λειτουργίες 
για νυχτερινές λήψεις και οι δυνατότητες σταθεροποίησης, αποτελούν κάποιες ενδεικτικές δυνατότητες, που 
διαφοροποιούν τις ψηφιακές κάμερες. Δηλαδή, δεν πρέπει να εστιάζουμε μόνο στην ανάλυση του βίντεο, αλ-
λά και στις υπόλοιπες δυνατότητες, οι οποίες μας επιτρέπουν τη λήψη βίντεο. 
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5.3.2. Μέγεθος ασυμπίεστου βίντεο και ρυθμός μεταφοράς 
 
Το μέγεθος ενός ασυμπίεστου αποσπάσματος βίντεο εξαρτάται από την ανάλυση, το βάθος χρώματος, τον 
αριθμό των πλαισίων ανά δευτερόλεπτο και τη χρονική διάρκεια. Με άλλα λόγια, το μέγεθος εξαρτάται από 
το μέγεθος κάθε πλαισίου επί το σύνολο των πλαισίων. Στον Πίνακα 5.1 εμφανίζεται ο τύπος υπολογισμού. 

 
οριζόντια ανάλυση  κάθετη ανάλυση  βάθος χρώματος (bits)  ρυθμός πλαισίων  διάρκεια (sec) 

 
Πίνακας 5.1 Υπολογισμός μεγέθους σε bits ασυμπίεστου βίντεο. 

 
Έστω ότι έχουμε 1 λεπτό, δηλαδή 60 sec, έγχρωμου βίντεο με πραγματικό βάθος χρώματος 24 bit με 

ανάλυση 320x200 και 30 fps (καρέ ανά δευτερόλεπτο). Ο αποθηκευτικός χώρος που απαιτείται είναι: 
 
320  200  24  30  60 = 2.764.800.000 bits = 345.600.000 bytes ≈ 329 MB. 
 
Με πιο απλά λόγια, ένα βίντεο μικρής ανάλυσης, διάρκειας ενός λεπτού καταλαμβάνει 329 MB. Αν 

το αρχείο βίντεο είναι περίπου 14 δευτερόλεπτα, θα χρειαζόταν ένα DVD για την αποθήκευσή του, γιατί το 
μέγεθος του είναι περίπου 4,6 GB. Ακόμη και να μειωθεί το βάθος χρώματος σε 8 bit, το μέγεθος αποθήκευ-
σης ασυμπίεστου βίντεο είναι απαγορευτικό. Γι’ αυτό τον λόγο εφαρμόζονται διάφορες τεχνικές συμπίεσης, 
που μειώνουν αρκετά το μέγεθος του αρχείου.  

Θα πρέπει να σημειωθεί ότι στον παραπάνω τύπο δεν ελήφθη υπόψη το μέγεθος των ηχητικών δεδο-
μένων του βίντεο, το οποίο, προφανώς, αυξάνει το συνολικό μέγεθος των δεδομένων. Ο τρόπος υπολογισμού 
των ηχητικών δεδομένων έχει αναλυθεί στο κεφάλαιο 3 του βιβλίου. Εστιάζουμε κυρίως στα δεδομένα εικό-
νας, καθώς η συμπίεση και οι κωδικοποιητές των οπτικών δεδομένων του βίντεο αποτελούν νέα θέματα, που 
δεν έχουν παρουσιαστεί σε προηγούμενα κεφάλαια.  

Ο παραπάνω τύπος, χωρίς τη χρονική διάρκεια, μπορεί να χρησιμοποιηθεί για να υπολογίσει το bit 
rate ασυμπίεστου βίντεο. Για το παραπάνω βίντεο το bit rate είναι 46.080.000 bps ή περίπου 46 Mbps. Είναι 
κατανοητό ότι το μέγεθος αυτό, που αφορά βίντεο μικρής ανάλυσης, είναι απαγορευτικό για μετάδοση μέσω 
διαδικτύου. Ο ρυθμός μετάδοσης είναι σταθερός για ασυμπίεστο βίντεο, ενώ με τις τεχνικές συμπίεσης το bit 
rate είναι συνήθως μεταβλητό. 

 

5.3.3. Συμπίεση βίντεο και κωδικοποιητές 
 
Η συμπίεση των δεδομένων εικόνας βίντεο είναι απαραίτητη, γιατί διαφορετικά η αποθήκευση και διανομή 
του βίντεο μέσω υπολογιστή θα ήταν ανέφικτη. Οι κωδικοποιητές (codecs), που αναφέρονται και ως κωδικο-
ποιητές/αποκωδικοποιητές, είναι λογισμικά που χρησιμοποιούνται για να συμπιέσουν ή να αποσυμπιέσουν 
ένα ψηφιακό αρχείο. Στο κεφάλαιο 3 μελετήσαμε το θέμα των codecs που χρησιμοποιούνται για τον ήχο. Ό-
ταν γίνεται αναπαραγωγή ενός ψηφιακού αρχείου μέσων χρησιμοποιείται ο αποκωδικοποιητής, για να απο-
συμπιέσει το αρχείο. 

Οι codecs ουσιαστικά περιέχουν τις απαραίτητες εντολές για τη συμπίεση και την αποσυμπίεση ενός 
αρχείου. Εγκαθίστανται στον υπολογιστή μας, ως βιβλιοθήκες (dll) και χρησιμοποιηούνται από τα προγράμ-
ματα προβολής των αρχείων βίντεο. Στην Εικόνα 5.9 βλέπουμε τους εγκατεστημένους codecs ενός τυπικού 
συστήματος με Windows. 

Η συμπίεση ενός αρχείου μπορεί να είναι απωλεστική ή μη-απωλεστική. Στην απωλεστική (lossy) 
συμπίεση γίνεται προσπάθεια να αφαιρεθούν οι μη ουσιώδεις πληροφορίες από την εικόνα. Όπως και στις 
απλές φωτογραφίες, έτσι και εδώ αφαιρούνται από τα πλαίσια του βίντεο λεπτομέρειες της εικόνας, οι οποίες 
δεν μπορούν να γίνουν εύκολα αντιληπτές από το ανθρώπινο μάτι. Αρκετά γνωστός απωλεστικός αλγόριθμος 
συμπίεσης είναι ο JPEG που χρησιμοποιείται στις ψηφιογραφικές εικόνες, αλλά και στο βίντεο. Γνωστός α-
πωλεστικός codec για βίντεο είναι ο MPEG-4, που μπορεί να πετύχει συμπίεση από 20 έως 200 φορές σε 
σχέση με το αρχικό μέγεθος. 

Οι μη απωλεστικοί (lossless) αλγόριθμοι συμπιέζουν τα οπτικά δεδομένα χωρίς απώλεια πληροφορί-
ας, επιτυγχάνοντας όμως μικρούς λόγους συμπίεσης, π.χ. 2:1. Η αρχική εικόνα εμφανίζει ακριβώς τις ίδιες 
οπτικές πληροφορίες και μετά την αποσυμπίεση. Κάποιοι μη απωλεστικοί κωδικοποιητές είναι οι FFV1 και 
H.264-lossless. 
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Εικόνα 5.9 Κωδικοποιητές βίντεο σε ένα τυπικό σύστημα Windows. 

  
Ένα άλλο γενικό χαρακτηριστικό συνδέεται με τον χρόνο συμπίεσης και αποσυμπίεσης. Στη συμμε-

τρική (symmetrical) συμπίεση ο χρόνος που απαιτείται για τη συμπίεση είναι ίσος με το χρόνο που απαιτείται 
για την αποσυμπίεση και προβολή ενός πλαισίου. Οι μη συμμετρικοί ή ασύμμετροι (asymmetrical) αλγό-
ριθμοι συμπίεσης απαιτούν περισσότερο χρόνο για τη συμπίεση σε σχέση με τον χρόνο αποσυμπίεσης. Συνή-
θως η συμπίεση γίνεται σε υπολογιστές με ισχυρό υλικό. 

Η χωρική συμπίεση (spatial compression), που αποκαλείται στα Αγγλικά και με τον όρο intra-
frame, βασίζεται στο μέγεθος κάθε πλαισίου και γίνεται, δηλαδή, προσπάθεια να μειωθεί το μέγεθός του. Το 
αποτέλεσμα είναι συνήθως απωλεστικό. Η χρονική συμπίεση (temporal compression) ή inter-frame βασίζε-
ται στην αναγνώριση ομοιοτήτων μεταξύ των πλαισίων του βίντεο. Καθώς εξελίσσεται το βίντεο, απομακρύ-
νονται πληροφορίες με βάση τις ομοιότητες των πλαισίων. Αναφέρεται και ως frame differencing. 

Θα πρέπει να ειπωθεί ότι υπάρχουν και κάποιοι γενικοί αλγόριθμοι συμπίεσης, που έχουμε ήδη ανα-
φέρει στο κεφάλαιο 2, όπως οι Lempel-Ziv-Welch (LZW), Huffman Coding και Run Length Encoding (RLE), 
που θα μπορούσαν να χρησιμοποιηθούν και εδώ για τη συμπίεση. Όμως, η συμπίεση θα ήταν αρκετά μικρή, 
καθιστώντας τη διαδικασία ανώφελη. 
 
5.3.3.1. Motion JPEG (M-JPEG) 
 
Ο συγκεκριμένος κωδικοποιητής αποτελεί προσαρμογή του προτύπου JPEG για βίντεο. Είναι απωλεστικός 
ασύμμετρος κωδικοποιητής, που υποστηρίζει μόνο χωρική (intraframe) συμπίεση, αντίθετα από τον MPEG, ο 
οποίος υποστηρίζει χρονική συμπίεση. Ένα σημαντικό πλεονέκτημα είναι ότι η συμπίεση μπορεί να επιτευ-
χθεί σε πραγματικό χρόνο και δεν απαιτεί εξειδικευμένο υλικό, καθώς δεν είναι υπολογιστικά απαιτητικός. 
Υποστηρίζεται ευρέως από Web browsers και βίντεο players, αλλά δεν χρησιμοποιείται ευρέως στη συμπίεση 
βίντεο, εξαιτίας της μικρής συμπίεσης που επιτυγχάνει σε σχέση με νεότερους κωδικοποιητές.  

 

5.3.3.2. MPEG codecs 
 
Οι κωδικοποιητές/αποκωδικοποιητές MPEG δημιουργήθηκαν από τη διεθνή επιτροπή Motion Picture Expert 
Group (MPEG). Πρόκειται για σειρά επιμέρους κωδικοποιητών, που αφορούν βίντεο και ήχο. Η συμπίεση 
MPEG έχει διάφορες εκδόσεις. Η έκδοση MPEG 1, για παράδειγμα, είχε σχεδιαστεί για CD-ROM με ταχύτη-
τα μεταφοράς 1,5 Mbps, ενώ η έκδοση MPEG 2 σχεδιάστηκε για DVD υψηλής ποιότητας με ταχύτητα μετα-
φοράς 3 - 6Mbps. Η έκδοση MPEG-1 Audio Layer 3, το γνωστό μας MP3 αποτελεί το στάνταρ για τη συμπί-
εση ήχου. 

Η συμπίεση οπτικών και ηχητικών δεδομένων είναι απωλεστική. Η συμπίεση της εικόνας βασίζεται 
κυρίως στη χρονική συμπίεση, δηλαδή τις ομοιότητες των καρέ του βίντεο. Τα περισσότερα από τα 30 καρέ, 
που μπορεί να περιέχει το βίντεο ανά δευτερόλεπτο, είναι όμοια μεταξύ τους. Στη χρονική συμπίεση των δε-
δομένων, η τεχνική MPEG αρχικά ταξινομεί τα πλαίσια σε τρεις κατηγορίες: τα ενδοκωδικοποιημένα καρέ (I-
frames), τα προβλεπόμενα καρέ (P-frames) και τα αμφίδρομα καρέ (B-frames). 

Ένα I-frame (intra-coded) είναι στην ουσία μια πλήρης εικόνα, ενώ παίζει τον ρόλο του σημαντικού 
καρέ στη δημιουργία της ακολουθίας των εικόνων. Οι άλλοι τύποι καρέ βασίζονται στα προηγούμενα και στα 
επόμενα καρέ και έτσι διατηρούν μόνο τμήμα των πληροφοριών τους, επιτυγχάνοντας με αυτό τον τρόπο τη 
συμπίεση του βίντεο (Εικόνα 5.10). 
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Ένα P-frame (predicted) αποθηκεύει πληροφορίες μόνο για τις αλλαγές στην εικόνα σε σχέση με το 
προηγούμενο καρέ. Στην Εικόνα 5.10, για παράδειγμα, βλέπουμε ότι το δεύτερο καρέ, δηλαδή το P-frame, 
μπορεί να βασιστεί στο προηγούμενο καρέ. Έτσι, αποθηκεύονται τελικά μόνο οι πληροφορίες για τα διαφορε-
τικά pixels. Ένα B-frame (Bi-predictive) μπορεί να δημιουργηθεί από το προηγούμενο και το επόμενο καρέ. 

 

 
 
Εικόνα 5.10 Τύποι καρέ στο MPEG. 

  
Το MPEG-1 σχεδιάστηκε για την αναπαραγωγή 30 fps από πηγές με χαμηλό ρυθμό μεταφοράς, όπως 

είναι π.χ. το CD-ROM. Το MPEG-1 σχεδιάστηκε αρχικά για μέγεθος βίντεο 352240 pixels, αλλά εξελίχθη-
κε, προκειμένου να υποστηρίζει μέγεθος βίντεο 640480 pixels. Αν και οι διαδικασίες συμπίεσης και αποσυ-
μπίεσης είναι δυνατές με λογισμικό, το MPEG-1 μπορούσε αρχικά να αναπαραχθεί μόνο με χρήση ειδικού 
υλικού, π.χ. συσκευή αναπαραγωγής CD-ROM. Με την εξέλιξη των υπολογιστών software υλοποιήσεις του 
MPEG-1 είναι εφικτές. Το MPEG-1 Audio Layer 3 χρησιμοποιείται και για τη συμπίεση του ήχου. 

Το MPEG-2 (τεχνικό πρότυπο H.222/H.262) στηρίχθηκε στο MPEG-1. Μεταφέρει 60 πλαίσια ανά 
δευτερόλεπτο και υποστηρίζει βίντεο πεπλεγμένης, αλλά και προοδευτικής σάρωσης. Στη συνήθη έκδοσή του 
(MPEG Main Profile / Main Level) υποστηρίζει μέγιστο ρυθμό πλαισίων 30 fps σε ανάλυση 720480 ή ρυθ-
μό πλαισίων 25 fps σε ανάλυση 720576. Το MPEG-2 καθιερώθηκε στην κωδικοποίηση των DVD. Άρα, λό-
γω της μεγάλης ακόμη και σήμερα εξάπλωσης των DVD, υποστηρίζεται σε όλα τα προγράμματα αναπαρα-
γωγής βίντεο. Και στα δύο πρότυπα η συμπίεση είναι απωλεστική και, προφανώς, δεν ενδείκνυνται για την 
περίπτωση επεξεργασίας του βίντεο. Δηλαδή, αν ο σκοπός μας είναι η μελλοντική επεξεργασία του βίντεο, 
τότε το βίντεο πρέπει να αποθηκευτεί σε κάποια άλλη, ασυμπίεστη μορφή. 

Το MPEG-4 είναι πρότυπο για τη συμπίεση δεδομένων βίντεο και ήχου. Εμφανίστηκε το 1988 και 
περιλαμβάνει πολλά από τα χαρακτηριστικά των MPEG-1 και MPEG-2. Αρχικά, προορίζονταν για εφαρμο-
γές με πολύ μικρό διαθέσιμο εύρος ζώνης για μεταφορά δεδομένων, π.χ. 4.8 έως 64Κbps. Δηλαδή, εύρος ζώ-
νης, όπου με τους παραδοσιακούς αλγόριθμους η αποστολή βίντεο είναι απαγορευτική. Είναι συνεχώς εξε-
λισσόμενο πρότυπο και το πεδίο εφαρμογής του είναι πολύ ευρύ, καθώς περιλαμβάνει από εφαρμογές τηλε-
διάσκεψης μέχρι και αποθήκευση στερεοσκοπικού (3D) βίντεο. 

 

 
 
Εικόνα 5.11 Κωδικοποιητές που χρησιμοποιούνται σε ένα αρχείο βίντεο. 

 
Το MPEG-4 αποτελείται από πολλά επιμέρους πρότυπα, καθένα από τα οποία καθορίζει ορισμένα 

από τα χαρακτηριστικά του MPEG-4 σε σχέση με κάποιο θέμα. Για παράδειγμα, το MPEG-4 Part 3 αφορά 
τον ήχο, το MPEG-4 Part 16 αφορά σχεδιοκινήσεις, το MPEG-4 Part 25 αφορά τα τρισδιάστατα γραφικά και 
το MPEG-4 Part 31 κωδικοποίηση βίντεο για το διαδίκτυο. Στην Εικόνα 5.11 βλέπουμε τους κωδικοποιητές 
που χρησιμοποιούνται σε ένα αρχείο βίντεο. Ο MPEG-4 AVC (Advanced Video Coding) είναι το Part 10 του 
προτύπου και είναι τεχνικά ισοδύναμο με το πρότυπο H.264. Ο AAC είναι το MPEG Part 3 του προτύπου και 
αφορά τα ηχητικά δεδομένα. Προφανώς, δεν είναι υποχρεωτικό να υλοποιηθούν όλα τα τμήματα του προτύ-
που από κάποια εφαρμογή.  



140 

Το MPEG-7 (Multimedia Content Description Interface) είναι πρότυπο, με το οποίο μπορούμε να πε-
ριγράψουμε τα μεταδεδομένα των επιμέρους τμημάτων μια πολυμεσικής εφαρμογής. Δηλαδή, έστω ότι μια 
πολυμεσική εφαρμογή αποτελείται από κάποια αρχεία ήχου και κινούμενων εικόνων. Το MPEG-7 παρέχει 
μια γλώσσα περιγραφής των τρόπων σύνδεσης των δομικών στοιχείων της εφαρμογής, αλλά και των στοιχεί-
ων των μεμονωμένων αρχείων. Χρησιμοποιεί τη γλώσσα περιγραφής XML για να αποθηκεύσει μεταδεδομέ-
να. Αν και πρόκειται για αρκετά ισχυρό πρότυπο με πολλές δυνατότητες για δόμηση πολυμεσικών εφαρμο-
γών, φαίνεται ότι δεν έγινε ευρέως αποδεκτό, εξαιτίας της πολυπλοκότητάς του, ούτε έχει υλοποιηθεί σε πολ-
λά εργαλεία. 

Η ομάδα MPEG εξελίσσει συνεχώς τα υπάρχοντα πρότυπα και αναπτύσσει νέα, που παρέχουν και-
νούργιες δυνατότητες. Για παράδειγμα, το MPEG-21 ορίζει μια γλώσσα καθορισμού των δικαιωμάτων 
(Rights Expression Language), η οποία χρησιμοποιείται για τον διαμοιρασμό δικαιωμάτων, αδειών, περιορι-
σμών, που σχετίζονται με ψηφιακά αντικείμενα. Το MPEG-DASH χρησιμοποιείται για τεχνολογίες ροής 
(streaming) με βάση το πρωτόκολλο HTTP. Στο δικτυακό τόπο http://mpeg.chiariglione.org/standards της 
ομάδας MPEG μπορείτε να βρείτε όλα τα σχετικά πρότυπα. 

 
5.3.3.3. DivX και XviD 
 
Οι codecs DivX και XviD βασίζονται στο τμήμα 2 του MPEG-4 και είναι απωλεστικοί κωδικοποιητές. Ο κω-
δικοποιητής XviD είναι ελεύθερο λογισμικό ανοιχτού κώδικα, σε αντίθεση με τον DivX που είναι εμπορικός. 
Το DivX, εκτός από κωδικοποιητή, αποτελεί και μορφοποίηση για αποθήκευση διαφόρων τύπων αρχείων με 
προέκταση .divx. Η μορφοποίηση παρέχει δυνατότητες παρόμοιες με τις δυνατότητες των DVD, δηλαδή πολ-
λαπλούς τίτλους, διαδραστικά μενού, πολλαπλά κανάλια βίντεο και ήχου, πολλαπλές μορφές αρχείων, σημεία 
έναρξης κεφαλαίων κ.ά. 

 
5.3.3.4. H.264 και H.265 
 
Ο H.264 είναι ο πιο δημοφιλής κωδικοποιητής/αποκωδικοποιητής για υλικό υψηλής ευκρίνειας. Υποστηρίζει 
απωλεστική και μη απωλεστική συμπίεση, ανάλογα με τις ρυθμίσεις που θα χρησιμοποιήσουμε. Ο ήχος συ-
νήθως κωδικοποιείται με τον codec AAC ή τον MP3. Είναι πιο αποτελεσματικός από τον MPEG-4, αν και 
πλέον συμπεριλαμβάνεται στο πρότυπο MPEG-4 ως το τμήμα 10 (Part 10), που είναι γνωστό ως AVC (Ad-
vanced Video Coding). Προκύπτει, δηλαδή, ότι η οικογένεια κωδικοποιητών MPEG υποστηρίζει τις πιο προ-
ηγμένες τεχνικές συμπίεσης, ωστόσο και άλλοι κωδικοποιητές βασίζονται στο MPEG, καθιστώντας τα όρια 
και τις διαφορές μεταξύ των codecs δυσδιάκριτα. 

Ο H.264 αποτελεί εξέλιξη των παλαιότερων προτύπων H.261 και H.263, που χρησιμοποιούνταν σε 
συστήματα συνδιάσκεψης ή σε απλές τηλεφωνικές γραμμές με μικρή ταχύτητα μεταφοράς δεδομένων. 

 

 
[Πηγή: http://goo.gl/FRpgri] 
 
Εικόνα 5.12 Το ίδιο καρέ με διαφορετικούς κωδικοποιητές. 

  
Πρόσφατα εγκρίθηκε από το ISO και την ομάδα MPEG και το πρότυπο H.265, το οποίο ονομάζεται 

High Efficiency Video Coding (HEVC). Υποστηρίζεται ότι ο συγκεκριμένος αλγόριθμος μπορεί να διπλασιά-
σει τον λόγο συμπίεσης δεδομένων, σε σύγκριση με τους κωδικοποιητές H.264 και MPEG-4 AVC, προσφέ-
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ροντας καλύτερο επίπεδο ποιότητας βίντεο (π.χ. Εικόνα 5.12). Αναμένεται να παίξει σημαντικό ρόλο σε βί-
ντεο UHD. 

 
5.3.3.5. Ποιον κωδικοποιητή να χρησιμοποιήσουμε σε μια εφαρμογή πολυμέσων; 
 
Εκτός από τους πιο πάνω κωδικοποιητές/αποκωδικοποιητές, υπάρχουν διαθέσιμοι και άλλοι κωδικοποιητές 
τόσο για οπτικά δεδομένα όσο και για δεδομένα ήχου, όπως ο ZyGoVideo, που υποστηρίζεται από το 
QuickTime της Apple, ή ο VP8, που χρησιμοποιόταν σε παλαιότερες εκδόσεις του Skype κ.ά. Επίσης, μεμο-
νωμένες εταιρίες και κοινοπραξίες εταιριών εργάζονται στη δημιουργία νέων κωδικοποιητών ή τη βελτίωση 
παλαιότερων codecs. Για παράδειγμα, η Google εργάζεται στους codecs VP9 και VP10. Συνεπώς, υπάρχουν 
αρκετοί κωδικοποιητές και πάντα θα υπάρχουν σημαντικές εξελίξεις στον συγκεκριμένο τομέα. 

Ποιον codec, λοιπόν, να χρησιμοποιήσουμε σε μια εφαρμογή πολυμέσων, που κατά πάσα πιθανότητα 
θα είναι προσβάσιμη και μέσω διαδικτύου; Από την παραπάνω συζήτηση προκύπτει ότι ο H.264 / MPEG-4 
Part 10 (AVC) είναι ο πιο αποτελεσματικός προς το παρόν για τα οπτικά δεδομένα και ο MPEG-4 Part 3 
(AAC) για τα δεδομένα ήχου. Αυτό προκύπτει, επίσης, από τις οδηγίες της Google για τα βίντεο που ανεβά-
ζουμε στο YouTube (https://support.google.com/youtube/answer/1722171), αλλά και από τις τεχνολογίες που 
υποστηρίζουν σύγχρονα περιβάλλοντα ανάπτυξης πολυμεσικών διαδικτυακών εφαρμογών, όπως η HTML5 
(https://developer.mozilla.org/en-US/docs/Web/HTML/Supported_media_formats). 

Στο διαδίκτυο κυκλοφορούν αρκετά βοηθητικά εργαλεία, που μπορούν να κωδικοποιήσουν ένα βί-
ντεο με χρήση κάποιου συγκεκριμένου codec, π.χ. http://www.h264encoder.com. 
 

5.3.4. Μορφοποιήσεις αρχείων 
 
Τα αρχεία που περιέχουν δεδομένα βίντεο έχουν κάποιες ιδιαιτερότητες σε σχέση με άλλα αρχεία, όπως είναι 
π.χ. τα αρχεία φωτογραφιών. Τα δεδομένα είναι συμπιεσμένα με κάποιους κωδικοποιητές και μπορεί διαφο-
ρετικά αρχεία, του ίδιου όμως τύπου, π.χ. αρχεία .avi, να χρησιμοποιούν διαφορετικούς κωδικοποιητές. Πρα-
κτικά, λοιπόν, τα αρχεία αυτά δρουν ως ένα ψηφιακό «κουτί» ή πακέτο (container). Ένα αρχείο τύπου πακέ-
του περιέχει τα δεδομένα του βίντεο και του ήχου που είναι κωδικοποιημένα με κάποιους κωδικοποιητές. Συ-
χνά ένα αρχείο container περιέχει μεταδεδομένα, υπότιτλους, ηχητικά δεδομένα σε άλλες γλώσσες, πληροφο-
ρίες για χωρισμό της ταινίας DVD ή Blu-ray σε κεφάλαια (chapters) κ.ά.  
 

 
 
Εικόνα 5.13 Αρχεία βίντεο που υποστηρίζει ένα τυπικό πρόγραμμα προβολής βίντεο. 

 
Υπάρχουν αρκετά μορφότυπα για βίντεο, π.χ. .MP4, .AVI, .MPG, .MKV, .RM, .WMV,.MOV, .3GP, 

και .FLV. Στην Εικόνα 5.13 βλέπουμε την πληθώρα μορφοτύπων βίντεο, που υποστηρίζει ένα τυπικό πρό-
γραμμα προβολής βίντεο. Θα πρέπει να τονιστεί ότι, ουσιαστικά, αυτό που έχει σημασία σε ένα αρχείο βίντεο 
είναι οι κωδικοποιητές που χρησιμοποιούνται. Τα αρχεία containers απλά οργανώνουν τα κωδικοποιημένα 
δεδομένα και η διαφορά τους έγκειται στις επιμέρους δυνατότητες οργάνωσης, π.χ. κάποιο μορφότυπο μπορεί 
να υποστηρίζει την ύπαρξη αρχείων ήχου σε διαφορετικές γλώσσες, ενώ κάποιο να μην υποστηρίζει αυτή τη 
δυνατότητα. Στη συνέχεια περιγράφουμε τα πιο γνωστά μορφότυπα. 
 

5.3.4.1. AVI 
 
Τα αρχεία AVI (Audio Video Interleave), με προέκταση .avi, αποτελούν ίσως την πιο παλιά μορφοποίηση αρ-
χείων βίντεο. Δημιουργήθηκαν από τη Microsoft αρχές της δεκαετίας του ‘90 ως τμήμα της τεχνολογίας βί-
ντεο για τα Windows. Τα αρχεία AVI περιέχουν δεδομένα ήχου και βίντεο και επιτρέπουν τη συγχρονισμένη 
αναπαραγωγή τους. Αρχικά τα AVI αρχεία δεν υποστήριζαν συμπίεση και τα αρχεία ήταν αρκετά μεγάλα, 
ειδικά καθώς η τεχνολογία υποστήριζε την πιο εύκολη σύλληψη του ψηφιακού βίντεο. Πλέον, έχει τη δυνα-
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τότητα για συμπίεση δεδομένων με διάφορους codecs για βίντεο και ήχο. Τα ασυμπίεστα αρχεία μπορούν να 
χρησιμοποιηθούν για αποθήκευση του βίντεο, ώστε να μπορούμε να το επεξεργαστούμε στη συνέχεια. 

Τα βασικό πλεονέκτημα των AVI αρχείων είναι ότι μπορούν να αναπαραχθούν σχεδόν σε κάθε λει-
τουργικό σύστημα και να χρησιμοποιηθούν σε εφαρμογές. Ένα μειονέκτημα του μορφότυπου είναι ότι, συνή-
θως, το μέγεθος των αρχείων είναι μεγάλο. Επίσης, δεν υποστηρίζει κάποια τεχνικά χαρακτηριστικά, π.χ. υ-
ποστήριξη κάποιων μορφών κωδικοποίησης μεταβλητού bit rate και συνεπώς έχει αρχίσει να φθίνει η χρήση 
του. 

 
5.3.4.2. QTFF 
 
Το QTFF (QuickTime File Format) είναι ένας πολυμεσικός τύπος αρχείου, που περιέχει ένα ή περισσότερα 
κομμάτια, καθένα εκ των οποίων περιέχει ήχο ή βίντεο ή κείμενο (π.χ. υπότιτλους). Είναι μορφότυπο, που 
έχει δημιουργηθεί από την Apple για τον QuickTime Player και τα αρχεία έχουν τελικά προέκταση .qt ή .mov. 
Πρόκειται για streaming format, δηλαδή γίνεται σταδιακή μεταφορά ήχου στον υπολογιστή από το διαδίκτυο 
και αναπαραγωγή των τμημάτων που έρχονται. Τα αρχεία QuickTime ονομάζονται συνήθως ταινίες, γιατί 
είναι πλούσια σε οπτικοακουστικό υλικό. Άλλωστε, η προέκταση .mov προέρχεται από τη λέξη movie. Υπάρ-
χει μια ιεραρχική δομή στην οργάνωση του υλικού, καθώς και αναφορές σε εξωτερικά αρχεία. Η αναπαραγω-
γή τους γίνεται από όλους τους σύγχρονους players και από το νεώτερο λογισμικό iTunes, που ουσιαστικά 
είναι μια διαδικτυακή υπηρεσία για οργάνωση και αναπαραγωγή αρχείων ήχου και βίντεο (Εικόνα 5.14). 

Η χρήση διαφορετικών codecs είναι πλέον εφικτή στα αρχεία ταινιών της Apple. Έχει αρκετά καλή 
ποιότητα εικόνας. Δημιουργούνται κυρίως με ειδικό λογισμικό από την Apple και είναι περισσότερο διαδε-
δομένα στα λειτουργικά συστήματα και τις πλατφόρμες της Apple.  

 

 
[Πηγή: https://goo.gl/eovVbh]  
 
Εικόνα 5.14 iTunes σε διάφορα υπολογιστικά περιβάλλοντα. 

 
5.3.4.3. MKV 
 
Τα αρχεία MKV έχουν πάρει το όνομά τους από μια Ρώσικη λέξη και είναι γνωστά ως Matroska Multimedia 
Container. Μπορούν να περιέχουν αρχεία βίντεο, ήχου, εικόνας και υπότιτλων, χωρίς περιορισμό στον αριθ-
μό των αρχείων. Είναι ανοιχτό μορφότυπο και έχει προέκταση αρχείων .mkv. Παρέχει αρκετές δυνατότητες 
ως αρχείο τύπου container, όπως για παράδειγμα πολυγλωσσικούς τίτλους, μεταδεδομένα, περιγραφές για τα 
αρχεία κ.ά. Τα δεδομένα βίντεο κωδικοποιούνται συνήθως με τον codec H.264 και με τον κωδικοποιητή MP3 
ή AAC για τον ήχο, αν και μπορεί να χρησιμοποιηθεί οποιοσδήποτε κωδικοποιητής/αποκωδικοποιητής. Ως 
τύπος πακέτου, έχει τη δυνατότητα για διαχείριση λαθών και έτσι μπορεί να αναπαράγει και μερικώς κατε-
στραμμένα αρχεία. Παρέχουν τη δυνατότητα αποθήκευσης ολόκληρης της ροής ήχου, όπως αυτή διατίθεται 
στο μέσο προέλευσης (DVD ή Blu-ray) σε μορφές, όπως DolbyDigital/AC3 ή Dolby TrueHD κ.ά. 

 
5.3.4.4. MP4 
 
Τα αρχεία MP4 είναι τύπος αρχείων πακέτου, στα οποία τα δεδομένα βίντεο συμπιέζονται με τον codec 
MPEG-4. Έχουν προέκταση .mp4 και τα ηχητικά δεδομένα κωδικοποιούνται, επίσης, με κάποιον σύγχρονο 
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codec, όπως οι MP3 ή AAC. Θεωρείται ως το προτιμώμενο φορμά για το YouTube, αλλά και άλλες πολυμε-
σικές εφαρμογές στο διαδίκτυο. Η προέκταση .m4p αφορά σε αρχεία MP4 που επιπλέον χρησιμοποιεί την 
τεχνολογία DRM (Digital Rights Management). Οι δυνατότητες του συγκεκριμένου τύπου ορίζονται στο 
MPEG-4 Part 14. 

 

 
 

Εικόνα 5.15 Αναπαραγωγή mp4 σε έξυπνο ρολόι χειρός. 

 
Ως μορφοποίηση τύπου πακέτου έχει αρκετές δυνατότητες για χρήση εικόνων, διαφορετικών αρχείων 

με αποσπάσματα βίντεο, υπότιτλων κ.ά. Έχει τη δυνατότητα για τμηματική αναπαραγωγή και γι’ αυτό προτι-
μάται στις περιπτώσεις streaming video. Μπορεί να αναπαραχθεί σε οποιαδήποτε συσκευή, όπως υπολογι-
στές, κινητά τηλέφωνα, σύγχρονες τηλεοράσεις, έξυπνα ρολόγια (π.χ. Εικόνα 5.15) κ.λπ. Φυσικά αυτό ισχύει 
για σχεδόν όλους τους σύγχρονους τύπους αρχείων βίντεο. 

 

5.3.4.5. Άλλοι τύποι αρχείων 
 
Όπως είπαμε στην αρχή της τρέχουσας υποενότητας υπάρχουν αρκετές μορφοποιήσεις για δεδομένα βίντεο. 
Πιο πάνω είδαμε τις πιο γνωστές. Οι περισσότερες από τις ακόλουθες μορφές είναι πιο παλιές, αλλά υπάρ-
χουν αρκετά βίντεο ακόμη σε αυτές τις μορφοποιήσεις: 

 WMV: το Windows Media Video είναι παλαιό μορφότυπο της Microsoft, όπου τα αρχεία έ-
χουν προεκτάσεις .wmv και .asf. Το αναφέρουμε γιατί μπορεί να υπάρχουν ακόμη σχετικά 
αρχεία. 

 FLV: το Flash Video είναι αρχείο τύπου πακέτου, που χρησιμοποιείται για διαδικτυακό βί-
ντεο με χρήση του Adobe Flash Player. Η χρήση του έχει αρχίσει να φθίνει. 

 3GPP: τα αρχεία αυτού του τύπου χρησιμοποιούνταν σε παλαιότερα κινητά τηλέφωνα. 
 WebM: είναι ένας τύπος που προορίζεται για χρήση με την HTML5 και βασίζεται στο MKV 

πρότυπο. 
 

5.4. Λογισμικό προβολής και επεξεργασίας ψηφιακού βίντεο 
 
Η λήψη, προβολή και επεξεργασία βίντεο αποτελεί μια καθημερινή λειτουργία, σχεδόν όλων όσων διαθέτουν 
ένα σύγχρονο κινητό και/ή ψηφιακή φωτογραφική μηχανή. Στη συνέχεια αναφέρουμε κάποια από τα πιο δη-
μοφιλή και χρήσιμα προγράμματα και για τη χρήση και επεξεργασία βίντεο. 

 

5.4.1. Λογισμικό προβολής 
 
Το σύγχρονο λογισμικό προβολής βίντεο (media player) έχει αρκετές δυνατότητες. Μπορούν να ανοίξουν 
διάφορους τύπους αρχείων βίντεο και ήχου, αλλά και ταινίες που είναι σε κάποιο δίσκο, όπως το DVD ή το 
Blu-ray. Πρακτικά χρησιμοποιούμε αυτά τα προγράμματα, για να προβάλλουν βίντεο που είναι αποθηκευμέ-
νο στον υπολογιστή μας ή το κατεβάζουμε από το διαδίκτυο. Οι πιο δημοφιλείς video players την περίοδο 
συγγραφής του εγχειριδίου είναι οι VLC (http://www.videolan.org/vlc), KMPlayer 
(http://www.kmplayer.com), GOM Media Player (https://player.gomlab.com) και Media Player Classic - 
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Home Cinema MPC-HC (https://mpc-hc.org/). Οι players αυτοί είναι διαθέσιμοι και για κινητές συσκευές 
μέσω υπηρεσιών, όπως το Google Play Store. 

 

 
 

Εικόνα 5.16 Αναπαραγωγή βίντεο με κάποιον media player. 

 
Τα συγκεκριμένα λογισμικά έχουν τη δυνατότητα να αναπαράγουν βίντεο που έχει κωδικοποιηθεί με 

διάφορους codecs. Διαθέτουν και λειτουργία αυτόματης αναζήτησης των codecs που λείπουν, όταν δεν μπο-
ρούν να αναπαράγουν κάποιο αρχείο. Καλό είναι να κατεβάζουμε τις νέες εκδόσεις των λογισμικών αυτών, 
ώστε να ενημερώνονται με τους νέους codecs. 

 

5.4.2. Βοηθητικά εργαλεία για απλές επεξεργασίας 
 
Αρκετές φορές χρειάζεται να ολοκληρώσουμε κάποιες απλές επεξεργασίες, όπως για παράδειγμα υπέρθεση 
τίτλων στο βίντεο ή μετατροπή από μια μορφή σε μια άλλη. Για τέτοιες απλές επεξεργασίες υπάρχουν αρκετά 
δωρεάν βοηθητικά προγράμματα στο εργαλείο. 

Μια αρκετά συχνή λειτουργία είναι η μετατροπή από μία μορφή σε μια άλλη, π.χ. από avi σε μορφή 
mp4. H μετατροπή είναι εφικτή με πληθώρα βοηθητικών εργαλείων που βρίσκουμε στο διαδίκτυο, π.χ. 
Movavi Video Converter (http://www.movavi.com/videoconverter), Any Video Converter (http://www.any-
video-converter.com/products-freeware), Free Video Converter (http://www.freemake.com/gr/free_video 
_converter) κ.ά. Τα εργαλεία αυτά μας επιτρέπουν την επιλογή του νέου μορφότυπου και των codecs για τα 
οπτικά δεδομένα και τα δεδομένα ήχου. 

Η περικοπή αρχικών και τελικών τμημάτων ενός αποσπάσματος βίντεο είναι εύκολη με χρήση απλών 
εργαλείων, όπως για παράδειγμα το Free Video Cutter Joiner (http://www.dvdvideomedia.com/ 
videocutter.html) (Εικόνα 5.19). Το συγκεκριμένο εργαλείο επιτρέπει και τη συνένωση αρχείων βίντεο σε μια 
ενιαία δομή. Δεν απαιτεί ιδιαίτερες γνώσεις επεξεργασίας βίντεο και είναι αρκετά εύχρηστο. Με αναζήτηση 
στο διαδίκτυο μπορούμε να εντοπίσουμε και άλλα παρόμοια εργαλεία, που είναι χρήσιμα στους χρήστες που 
ασχολούνται περιστασιακά με την επεξεργασία βίντεο. 

Με το εργαλείο CamStudio - Screen Recorder (http://sourceforge.net/projects/camstudio/) και άλλα 
αντίστοιχα εργαλεία, μπορούμε να καταγράψουμε σε βίντεο τις ενέργειες που εκτελούμε στην οθόνη. Στο 
αρχείο μπορούμε στη συνέχεια μπορούμε να προσθέσουμε ήχο, κάποιο τίτλο και κάποια μουσική με βοηθητι-
κά εργαλεία, που θα εντοπίσουμε στο διαδίκτυο. Ειδικά για τις κινητές συσκευές tablet και smartphones υ-
πάρχουν πολλές δωρεάν εφαρμογές, π.χ. https://play.google.com/store/search?q=video+editor. 
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Εικόνα 5.17 Μετατροπή βίντεο σε μορφή mp4 με συγκεκριμένες ρυθμίσεις κωδικοποιητή. 

 

 
 

Εικόνα 5.18 Μετατροπή βίντεο σε μορφή με συγκεκριμένες ρυθμίσεις για συγκεκριμένες συσκευές. 

 
 

 
 

Εικόνα 5.19 Εργαλείο αποκοπής και συνένωσης αποσπασμάτων βίντεο. 
 
Το YouΤube προσφέρει τη δυνατότητα προσθήκης κειμένου πάνω στο βίντεο που μεταφορτώνουμε 

στη συγκεκριμένη υπηρεσία. Γενικότερα, το YouTube υποστηρίζει τη δυνατότητα συνένωσης πολλών βίντεο 
και εικόνων, την περικοπή βίντεο και την προσθήκη μουσικής, αλλά και την εφαρμογή ειδικών εφέ 
(https://support.google.com/youtube/answer/183851). 
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5.4.3. Λογισμικό ολοκληρωμένης επεξεργασίας βίντεο 
 
Τα λογισμικά που αναφέρθηκαν ενδεικτικά πιο πάνω, έχουν περιορισμένες δυνατότητες και, παρόλο που εί-
ναι χρήσιμα, δεν μπορούν να χρησιμοποιηθούν για σύνθετες επεξεργασίες. Επίσης, όσοι ασχολούνται περισ-
σότερο εντατικά με την επεξεργασία βίντεο, χρειάζονται κάποιο εργαλείο που προσφέρει πιο ολοκληρωμένες 
δυνατότητες. Υπάρχουν αρκετά λογισμικά (video editors) για ολοκληρωμένη επεξεργασία του βίντεο. Τα πιο 
γνωστά είναι AVS Video Editor (http://www.avs4you.com/AVS-Video-Editor.aspx), Final Cut Pro 
(http://www.apple.com/final-cut-pro), Sony Movie Studio (http://www.sonycreativesoftware.com/movie stu-
dio), Pinnacle Studio (http://www.pinnaclesys.com), Adobe Premiere Pro 
(http://www.adobe.com/products/premiere.html) και το δωρεάν Avidemux (http://avidemux.sourceforge.net). 

Παλαιότερα υπήρχε διάκριση σε γραμμική (linear) και μη γραμμική (non-linear) επεξεργασία βίντεο. 
Η πρώτη μορφή χρησιμοποιούντα στο μη αναλογικό βίντεο, όπου η επεξεργασία γινόταν με χρήση μηχανη-
μάτων, που επεξεργάζονταν όλη τη μαγνητική ταινία, που περιείχε το βίντεο, από την αρχή έως το τέλος του. 
Στη μη γραμμική επεξεργασία το βίντεο εισάγεται απευθείας στον υπολογιστή, όπου και γίνεται επεξεργασία 
μεμονωμένων πλαισίων ή τμημάτων, εφαρμόζονται εφέ (π.χ. Εικόνα 5.20) και επεξεργάζεται ο ήχος. Μπορεί 
να γίνει μετατροπή από μια μορφή σε μια άλλη και να χρησιμοποιηθεί διαφορετικός codec σε σχέση με τoυς 
αρχικούς. Επιπρόσθετα υποστηρίζεται η προσθήκη τίτλων και μενού και η εξαγωγή του βίντεο σε συγκεκρι-
μένες μορφές ταινίας, π.χ. για DVD. 
 
5.4.3.1. Pinnacle Studio 
 
To Pinnacle Studio αποτελεί ένα από τα πιο εύχρηστα εργαλεία επεξεργασίας βίντεο (Εικόνα 5.20).  

 

 
 

Εικόνα 5.20 Ειδικά εφέ στην επεξεργασία βίντεο. 

 
Υποστηρίζει επεξεργασία βίντεο 4Κ. Το βίντεο εμφανίζεται πάνω σε ένα timeline (λωρίδα χρόνου). 

Επιτρέπει την προσθήκη διαφορετικών αντικειμένων (π.χ. ήχου ή κειμένου) σε παράλληλες λωρίδες, ώστε να 
μπορούν να αναπαραχθούν παράλληλα. 

 
5.4.3.2. Adobe Premiere Pro 
 
Το Adobe Premiere είναι λογισμικό επεξεργασίας βίντεο, που λειτουργεί με τη λογική του timeline (Εικόνα 
5.21). Υποστηρίζει την επεξεργασία βίντεο πολύ υψηλής ανάλυσης μέχρι και 10240×8192 pixels. Η νεότερη 
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έκδοση Adobe Premiere Pro CC έχει αρκετές δυνατότητες και έχει χρησιμοποιηθεί σε αρκετές εμπορικές ται-
νίες.  

 

 
 

Εικόνα 5.21 Adobe premiere. 
 

Το Pinnacle είναι πιο εύκολο στη χρήση σε σχέση το Adobe Premiere Pro. Το τελευταίο έχει περισ-
σότερες προηγμένες δυνατότητες και συνεργάζεται με τα υπόλοιπα εργαλεία της Adobe πιο απρόσκοπτα. 

 
5.4.3.3. Avidemux 
 
Το Avidemux είναι μια δωρεάν και ανοιχτού κώδικα εφαρμογή για την επεξεργασία βίντεο (Εικόνα 5.22). 
Υποστηρίζει τη μη γραμμική επεξεργασία βίντεο, την εφαρμογή φίλτρων και ειδικών εφέ, την αλλαγή μεγέ-
θους, την περιστροφή και τον υποτιτλισμό. Επιτρέπει την κωδικοποίηση με διαφορετικούς codecs και την 
εισαγωγή ήχου στο βίντεο ή την εξαγωγή του ήχου από αυτό. Έχει σαφώς λιγότερες δυνατότητες από τα ε-
μπορικά εργαλεία, αλλά είναι πιο εύκολο στην εκμάθηση και επαρκές για τις τυπικές επεξεργασίες βίντεο. 

 

5.5. Υλικό για ψηφιακό βίντεο 
 

5.5.1. Σύλληψη βίντεο 
 
Σε προηγούμενη ενότητα του κεφαλαίου αναφερθήκαμε στο υλικό που χρησιμοποιείται για τη μετατροπή του 
αναλογικού βίντεο σε ψηφιακό. Η σύλληψη, πλέον, του ψηφιακού βίντεο γίνεται με τις ψηφιακές κάμερες 
που είτε υπάρχουν ως αυτόνομες συσκευές είτε είναι ενσωματωμένες σε κινητά τηλέφωνα ή υπολογιστές. Οι 
ψηφιακές κάμερες λαμβάνουν το φως και το κωδικοποιούν σε χρώμα μέσω ηλεκτρικών σημάτων, με τον ίδιο 
τρόπο που μελετήσαμε στο κεφάλαιο 2 για τον τρόπο λειτουργίας της ψηφιακής φωτογραφικής μηχανής. Αυ-
τό που πρακτικά διαφοροποιεί τις κάμερες είναι τα χαρακτηριστικά τους και η ποιότητα κατασκευής τους. 

Οι web κάμερες είναι ενσωματωμένες στους υπολογιστές ή συνδέονται μέσω της USB θύρας στους 
υπολογιστές (Εικόνα 5.23). Οι καλύτερες κάμερες έχουν ανάλυση 1920x1080, δηλαδή μπορούν να συλλά-
βουν βίντεο υψηλής ευκρίνειας. Ένα άλλο βασικό χαρακτηριστικό τους είναι η ανάλυση φωτογραφίας, π.χ. 5 
ή 8 Megapixel. Οι web κάμερες δεν χρησιμοποιούνται για επαγγελματικούς σκοπούς και έτσι προτιμούνται 
πιο φθηνά μοντέλα με χαμηλότερες υποστηριζόμενες αναλύσεις για βίντεο και εικόνα. 

Αντίστοιχα, τα περισσότερα κινητά τηλέφωνα λειτουργούν με κάμερες, που συλλαμβάνουν βίντεο σε 
υψηλή ανάλυση, π.χ. 1080p@30fps. Η ποιότητα του βίντεο που εγγράφουν εξαρτάται βέβαια και από άλλους 
παράγοντες, όπως τη δυνατότητα σταθεροποίησης της εικόνας, τις λειτουργίες λήψεις σε συνθήκες μειωμένου 
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φωτισμού κ.ά. Πρέπει να σημειωθεί ότι 5-6 χρόνια πριν, οι δυνατότητες αυτές υπήρχαν μόνο σε ακριβές βι-
ντεοκάμερες και έτσι η λήψη βίντεο υψηλής ανάλυσης δεν ήταν τελικά μια απλή διαδικασία. 
 

 
 

Εικόνα 5.22 Avidemux. 
 
 

 
 

Εικόνα 5.23 USB web κάμερα. 

 
 

 
 

Εικόνα 5.24 4K κάμερα. 

 
Οι ψηφιακές βιντεοκάμερες, εκτός από την ανάλυσή τους, διαχωρίζονται με βάση διάφορα άλλα χα-

ρακτηριστικά. Το οπτικό ζουμ, η δυνατότητα για νυχτερινή λήψη και ο σταθεροποιητής εικόνας είναι κάποια 
από τα στοιχεία που διαφοροποιούν τις κάμερες. Οι βιντεοκάμερες για τον μέσο χρήστη υποστηρίζουν την 
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εγγραφή βίντεο 1080p, δηλαδή HD. Στην Εικόνα 5.24 εμφανίζεται μια ψηφιακή βιντεοκάμερα 4Κ (UHD). 
Συγκριτικά είναι λίγο μεγαλύτερες σε μέγεθος από τις κάμερες HD, αλλά αναμένεται να μειωθεί το μέγεθός 
τους με την εξέλιξη της αντίστοιχης τεχνολογίας. 

Οι 3D κάμερες έχουν δύο φακούς λήψης της εικόνας (Εικόνα 5.25) από διαφορετικές οπτικές γωνίες 
και κατά την προβολή το σήμα εκπέμπεται από διαφορετικές συσκευές προβολής (Εικόνα 5.26), δίνοντας έτσι 
τη στερεοσκοπική προβολή τριών διαστάσεων.  

 

  
 

Εικόνα 5.25 3D κάμερα. 

 

 
 

[Πηγή: http://goo.gl/o5wirG] 
 
Εικόνα 5.26 3D προβολή. 

 

5.5.2. Προβολή βίντεο 
 
Το βίντεο προβάλλεται σε κάποια οθόνη υπολογιστή, τηλεόρασης ή κινητής συσκευής. Οι σύγχρονες οθόνες 
είναι τεχνολογίας LED ή OLED. Οι οθόνες των κινητών βασίζονται κυρίως στην τεχνολογία AMOLED. Αυ-
τές οι τεχνολογίες έχουν περιγραφεί στο κεφάλαιο 2.  

Οι σύγχρονοι βιντεοπροβολείς (video projector) βασίζονται κυρίως στην τεχνολογία LED. Τα μοντέ-
λα που κυκλοφορούν στην αγορά υποστηρίζουν μέγιστη ανάλυση βίντεο 1920x1080. Οι βιντεοπροβολείς 4Κ 
έχουν ακόμη υψηλή τιμή για ευρεία χρήση, αν και η πλειοψηφία του περιεχομένου είναι σε μορφή HD ή χα-
μηλότερη. 

 

5.5.3. Αποθήκευση σε οπτικούς δίσκους DVD και Blu-ray 
 

Για την αποθήκευση ενός βίντεο υψηλής ευκρίνειας χρησιμοποιείται οποιοδήποτε ψηφιακό μέσο, δηλαδή 
κάρτες μνήμης και μαγνητικοί δίσκοι. Το Blu-ray είναι ένας οπτικός δίσκος που, επίσης, χρησιμοποιείται για 
την αποθήκευση και τη διανομή βίντεο υψηλής ευκρίνειας. Στο παρελθόν, βασικό μέσο διανομής του βίντεο 
ήταν το DVD (ακρωνύμιο των Digital Video Disc ή Digital Versatile Disc), το οποίο όμως δεν έχει αρκετή 
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χωρητικότητα για την αποθήκευση βίντεο HD. Τα single layer DVD έχουν χωρητικότητα 4,7 GB, ενώ τα dual 
layer 8,5 GB. Τα Blu-ray έχουν χωρητικότητα 25 GB και 50 GB, αντίστοιχα.  

Τεχνικά, η εγγραφή γίνεται με παρόμοιο τρόπο, μέσω μιας ακτίνας λέιζερ (laser), που διαμορφώνει 
την επιφάνεια του κατώτερου στρώματος του δίσκου, ώστε να αποτελείται από επίπεδα τμήματα (lands) και 
από κοιλώματα (pits) (Εικόνα 5.27). Τα κοιλώματα αναφέρονται συχνά και ως οπές ή κοιλάδες, ενώ τα επίπε-
δα τμήματα αναφέρονται και ως νησίδες. Η μετάβαση από ένα κοίλωμα σε ένα επίπεδο ή το αντίστροφο αντι-
προσωπεύει το ψηφίο 1. Το ψηφίο 0 αντιστοιχεί σε παραμονή της ακτίνας λέιζερ στο σημείο που βρισκόταν. 
Δηλαδή, αν είναι σε ένα pit, να παραμείνει στο pit, ενώ αν είναι σε land, να παραμείνει σε land. Η διαφορά 
μεταξύ των δύο δίσκων είναι η πυκνότητα εγγραφής ή, πιο απλά, πόσο μικρά είναι τα pits και τα lands και η 
μεταξύ τους απόσταση. 
 

 
 

Εικόνα 5.27 Η επιφάνεια ενός οπτικού δίσκου είναι διαμορφωμένη σε lands και pits. 

 
Ο ρυθμός μεταφοράς δεδομένων από DVD κυμαίνεται από 3 Mbps μέχρι 11,08 Mbps. To Blu-ray ξε-

κινά από bit rate 36 Mbit/s και, ανάλογα με την ταχύτητα ανάγνωσης ή εγγραφής, ο ρυθμός μπορεί να φτάσει 
μέχρι και 576 Mbit/s. Η κωδικοποίηση βίντεο στο Blu-ray είναι H.264/MPEG-4 AVC και στα DVD είναι 
MPEG-2. Ο ήχος στους Blu-ray δίσκους είναι πολυκάναλος και κωδικοποιείται σύμφωνα με ένα από τα πρό-
τυπα Dolby Digital, Dolby True HD, DTS και DTS-HD MA που μελετήσαμε στο κεφάλαιο 3. Για την προβο-
λή δίσκων Blu-ray απαιτείται η ύπαρξη ενός Blu-ray player, που θυμίζει τους κλασικούς DVD players, αλλά 
έχει σύγχρονες εξόδους για διασύνδεση με συσκευές προβολής, όπως το HDMI. Υπάρχουν και τα Blu-ray 
drives (ή τα Blu-ray ROM) για υπολογιστές, αλλά ακόμη δεν είναι διαδεδομένα, καθώς η διανομή του βίντεο 
υψηλής ευκρίνειας γίνεται συνήθως απευθείας μέσω υπολογιστών. 

 

5.6. Ανακεφαλαίωση – βασικές έννοιες 
 
Το κεφάλαιο παρουσιάζει κάποια θέματα που αφορούν στο ψηφιακό βίντεο. Ένα απόσπασμα βίντεο αποτε-
λείται από διαδοχικές εικόνες, οι οποίες προβάλλονται γρήγορα και έτσι τα αντικείμενα εμφανίζονται ως κι-
νούμενα. Αρχικά γίνεται αναφορά στα χαρακτηριστικά ανάλυση, βάθος χρώματος, αριθμός πλαισίων ανά 
δευτερόλεπτο, χρονική διάρκεια, λόγος εικόνας και ρυθμός μεταφοράς bit. Τα χαρακτηριστικά αυτά είναι ση-
μαντικά, καθώς επηρεάζουν το μέγεθος, την ευκρίνεια και τις αποθηκευτικές ανάγκες του βίντεο. 

Το αναλογικό βίντεο είναι το τηλεοπτικό σήμα που λαμβάναμε πριν την έλευση της ψηφιακής τηλεό-
ρασης. Τα πρότυπα PAL, NTSC και SECAM καθόριζαν τα χαρακτηριστικά του αναλογικού βίντεο και χρη-
σιμοποιούνται, μέχρι και σήμερα, ακόμη και στη μετάδοση του ψηφιακού τηλεοπτικού σήματος. Η ανάλυση 
στο αναλογικό βίντεο καθορίζεται κατά κύριο λόγο από τις γραμμές ανά πλαίσιο και όχι από τον αριθμό των 
pixels, ανά δευτερόλεπτο. Το αναλογικό βίντεο αποθηκευόταν σε κασέτες με μαγνητική ταινία, ενώ υπάρχει 
ειδικό υλικό για τη μετατροπή του σε ψηφιακή μορφή. 

Το μέγεθος ενός ασυμπίεστου αποσπάσματος βίντεο εξαρτάται από την ανάλυση, το βάθος χρώμα-
τος, τον αριθμό των πλαισίων ανά δευτερόλεπτο και τη χρονική διάρκεια. Επειδή το μέγεθος ασυμπίεστου 
βίντεο είναι απαγορευτικό και από πλευράς αποθηκευτικών αναγκών, αλλά και για λόγους μετάδοσης μέσω 
δικτύων, έχουν αναπτυχθεί διάφορες τεχνικές συμπίεσης. Οι αλγόριθμοι συμπίεσης υλοποιούνται ως λογισμι-
κό, που είναι γνωστό ως codec, και χρησιμοποιούνται για να συμπιέσουν ή να αποσυμπιέσουν ένα ψηφιακό 
αρχείο. Ο πιο αποτελεσματικός κωδικοποιητής βίντεο είναι ο H.264, που έχει υλοποιηθεί και ως το Part 10 
στο πρότυπο MPEG-4. Η συμπίεση οπτικών δεδομένων με τους αλγορίθμους αυτούς βασίζεται στις ομοιότη-
τες των καρέ και ονομάζεται χρονική ή inter-frame συμπίεση. 

Τα αρχεία που περιέχουν δεδομένα βίντεο λειτουργούν ως ένα ψηφιακό «κουτί» ή πακέτο (container). 
Ένα αρχείο τύπου πακέτου περιέχει τα δεδομένα βίντεο και ήχου που είναι κωδικοποιημένα με κάποιους κω-
δικοποιητές. Τα αρχεία αυτά απλά οργανώνουν τα κωδικοποιημένα δεδομένα και η διαφορά τους έγκειται 
στις επιμέρους δυνατότητες οργάνωσης, π.χ. δυνατότητα συμπερίληψης υπότιτλων ή ήχου σε διάφορες γλώσ-
σες. 
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Για την προβολή και επεξεργασία βίντεο υπάρχουν πολλά λογισμικά. Τα προγράμματα αναπαραγω-
γής (video players), π.χ. ο VLC και ο GOM Media Player, μπορούν να αναπαράγουν βίντεο διαφορετικών 
κωδικοποιήσεων και μπορούν να αναζητήσουν και codecs που μπορεί να μην διαθέτουμε στο σύστημά μας 
για την αναπαραγωγή ενός αρχείο βίντεο. Για απλές επεξεργασίες, όπως η μετατροπή βίντεο από μια μορφή 
σε μια άλλη και η περικοπή και συνένωση αποσπασμάτων βίντεο, υπάρχουν αρκετά βοηθητικά εργαλεία στο 
διαδίκτυο. Για ολοκληρωμένη επεξεργασία βίντεο πρέπει να χρησιμοποιηθεί λογισμικό, όπως το Adobe 
Premier Pro και το Pinnacle Studio. 

Στο τέλος του κεφαλαίου γίνεται αναφορά στο υλικό που απαιτείται για τη σύλληψη, προβολή και 
αποθήκευση ψηφιακού βίντεο. Το υλικό αυτό είναι κατά κύριο λόγο ίδιο με αυτό που απαιτείται για τη σύλ-
ληψη και προβολή στατικών εικόνων και έχει μελετηθεί αναλυτικά στο κεφάλαιο 2. Η διανομή βίντεο υψηλής 
ευκρίνειας γίνεται με δίσκους Blu-ray, που μπορούν να αποθηκεύσουν μέχρι και 50 GB δεδομένων. Προσφέ-
ρουν υψηλό ρυθμό μεταφοράς δεδομένων, ο οποίος είναι απαραίτητος για την απρόσκοπτη προβολή βίντεο 
υψηλής ευκρίνειας. 
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6. Σχεδίαση και Ανάπτυξη Εφαρμογών Πολυμέσων 
 

Σύνοψη 
Στο συγκεκριμένο κεφάλαιο εστιάζουμε στη σχεδίαση και την ανάπτυξη εφαρμογών πολυμέσων. Αρχικά 
παρουσιάζεται μια μεθοδολογία ανάπτυξης λογισμικού και επικεντρωνόμαστε σε έννοιες, όπως ο χάρτης 
πλοήγησης και τα εικονογραφημένα σενάρια. Στη συνέχεια παραθέτονται οι βασικοί ρόλοι που απαιτούνται στην 
ομάδα ανάπτυξης και τέλος αναφέρονται οι διαφορετικές προσεγγίσεις στην ανάπτυξη ολοκληρωμένων 
εφαρμογών πολυμέσων.  

 
Προαπαιτούμενη γνώση 
Το παρόν κεφάλαιο αναφέρεται στη σύνθεση ολοκληρωμένων εφαρμογών πολυμέσων, οπότε πρέπει να έχει γίνει 
μελέτη των εννοιών, που καλύπτονται στα προηγούμενα κεφάλαια.  

 

6.1. Βασικές έννοιες 
 
Στα προηγούμενα κεφάλαια αναλύθηκαν, οι έννοιες που σχετίζονται με τα επιμέρους μέσα, τα οποία 
χρησιμοποιούνται στα πολυμέσα. Στο κεφάλαιο αυτό εστιάζουμε στη σύνθεση ολοκληρωμένων πολυμεσικών 
εφαρμογών, που χρησιμοποιούνται για ενημέρωση (π.χ. Εικόνα 6.1) ή εκπαίδευση (π.χ. Εικόνα 6.2). Τα 
θέματα που μας αφορούν εστιάζουν κυρίως στον τρόπο με τον οποίο μπορούμε να οργανώσουμε μεθοδικά 
την ανάπτυξη μιας εφαρμογής πολυμέσων, στους ρόλους που είναι απαραίτητοι και τέλος, στις τεχνολογίες 
και τα εργαλεία, που μπορούν να χρησιμοποιηθούν. 

 

 
 
Εικόνα 6.1 Πολυμεσική εφαρμογή στο διαδίκτυο. 
 

Η μεθοδική οργάνωση της ανάπτυξης μιας εφαρμογής πολυμέσων είναι απαραίτητη, καθώς πρόκειται 
για σύνθετα έργα λογισμικού. Η χρήση ενός μοντέλου από το πεδίο της Τεχνολογίας Λογισμικού είναι εξίσου 
απαραίτητη. Φυσικά, όπως θα δούμε στη συνέχεια, υπάρχουν κάποια σημεία, τα οποία πρέπει να 
προσαρμοστούν στις ιδιαιτερότητες του συγκεκριμένου τύπου εφαρμογών. Οι τεχνικοί ρόλοι που απαιτούνται 
είναι ποικίλοι και πρέπει να αναγνωριστούν εξ αρχής, προκειμένου να αντιμετωπιστούν με επιτυχία οι 
τεχνικές προκλήσεις και οι ανάγκες σχεδίασης. Η γνώση των τεχνολογιών και των εργαλείων είναι επίσης 
σημαντική, καθώς θα βοηθήσει την ομάδα ανάπτυξης στην επιλογή της κατάλληλης τεχνολογίας και των 
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αντίστοιχων υποστηρικτικών εργαλείων. Βέβαια, οι τεχνολογίες αλλάζουν πολύ γρήγορα, σε αντίθεση με τις 
μεθοδολογίες και γι’ αυτό πρέπει να υπάρχει συνεχής ενημέρωση των ομάδων ανάπτυξης. 

   

 
[Πηγή: http://goo.gl/BtMgML] 
 
Εικόνα 6.2 Πολυμεσική εκπαιδευτική εφαρμογή. 

 

6.2. Σχεδίαση και ανάπτυξη εφαρμογών πολυμέσων 
 
Κάθε έργο λογισμικού περνά από διάφορες φάσεις κατά την ανάπτυξή του. Ο κύκλος ζωής λογισμικού 
(software life cycle) αποτελεί τη διαδικασία, η οποία περιλαμβάνει την κατανόηση του συστήματος που 
θέλουμε να δημιουργήσουμε, τον σχεδιασμό, την υλοποίησή του, έως και την τελική παράδοση στους 
χρήστες. Επομένως, η διαδικασία ξεκινά από τη σύλληψη της ιδέας και ολοκληρώνεται με την παράδοση του 
λογισμικού σε λειτουργία. Για τη μεθοδολογική αντιμετώπιση των διαδικασιών του κύκλου ζωής έχουν 
αναπτυχθεί διάφορα μοντέλα, τα οποία αναλύουν τις επιμέρους διαδικασίες που πρέπει να γίνουν κατά τον 
κύκλο ζωής λογισμικού. Τα μοντέλα αυτά προσπαθούν να προδιαγράψουν αναλυτικά τον κύκλο ζωής του 
λογισμικού, θέτοντας τους κανόνες της παραγωγής του λογισμικού, καθορίζοντας -με διαφορετικό τρόπο το 
καθένα- ποια βήματα πρέπει να πραγματοποιηθούν, σε ποια χρονική στιγμή, ποια παραδοτέα θα παραχθούν 
σε κάθε φάση κ.λπ.  

 

 
 
Εικόνα 6.3 Φάσεις μοντέλου καταρράκτη. 
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Ένα από τα πιο γνωστά μοντέλα είναι το μοντέλο του καταρράκτη, όπου η διαδικασία «κυλά» 
σταδιακά, από την ανάλυση των απαιτήσεων των χρηστών προς την υλοποίηση και τις διαδικασίες 
συντήρησης του λογισμικού. 

Οι φάσεις του μοντέλου του καταρράκτη είναι οι εξής: 
 Ανάλυση απαιτήσεων: Καταγράφονται και τεκμηριώνονται οι απαιτήσεις από το σύστημα, 

καθώς και τυχόν περιορισμοί σχετικά με την ανάπτυξή του. Η διαδικασία πραγματοποιείται 
σε συνεργασία με τους χρήστες του λογισμικού.  

 Σχεδιασμός: Γίνεται ο σχεδιασμός της αρχιτεκτονικής του συστήματος σε επίπεδο λογισμικού 
και υλικού σε σχέση με τις απαιτήσεις που έχουν καταγραφεί στην προηγούμενη φάση. 
Πρακτικά, γίνεται μια αφηρημένη γενική περιγραφή των υποσυστημάτων και των σχέσεων 
μεταξύ αυτών. 

 Ανάπτυξη: Στη φάση αυτή γίνεται ανάπτυξη του συστήματος σε κάποια γλώσσα 
προγραμματισμού ή με τη βοήθεια κάποιου προγραμματιστικού πλαισίου. Πρέπει να υπάρχει 
αντιστοιχία του παραγόμενου λογισμικού με τα υποσυστήματα, τα οποία έχουν ήδη 
προσδιοριστεί στη φάση του σχεδιασμού. 

 Έλεγχος: Με τη βοήθεια τυπικών χρηστών του συστήματος πραγματοποιείται ένα σύνολο 
ελέγχων που πιστοποιεί την καλή λειτουργία του συστήματος, ενώ στην περίπτωση που 
εντοπιστούν λάθη, γίνεται η διόρθωσή τους. 

 Συντήρηση: Η φάση αυτή αφορά λάθη, τα οποία εντοπίζονται κατά τη λειτουργία, αλλά και 
την επέκταση της λειτουργικότητας του συστήματος, σε περίπτωση που προκύψουν νέες 
απαιτήσεις. 

 
Το μοντέλο του καταρράκτη είναι κάπως δύσκαμπτο, επειδή θεωρεί ότι κάθε φάση ολοκληρώνεται, 

πριν μεταβούμε στην επόμενη. Στην πραγματικότητα αυτό δεν μπορεί να ισχύσει, γιατί κάποιες παραλήψεις 
μιας φάσης, ανακαλύπτονται κατά τις επόμενες φάσεις. Αποτελεί, όμως, τη βάση για άλλα πιο ευέλικτα 
μοντέλα, όπου οι φάσεις εξελίσσονται σχεδόν παράλληλα ή σε μικρούς κύκλους, ώστε να εντοπίζουμε τα 
λάθη, πριν να έχει προχωρήσει η ανάλυση.  

Στα εκπαιδευτικά υπερμεσικά συστήματα το μοντέλο έχει προσαρμοστεί στη μεθοδολογία ADDIE 
(Analysis, Design, Development, Implementation και Evaluation). Το μοντέλο ADDIE έχει στο επίκεντρο την 
αξιολόγηση (Εικόνα 6.4), καθώς θεωρείται ότι αποτελεί βασική διαδικασία κάθε φάσης. Στον Πίνακα 6.1 
εμφανίζονται κάποιες από τις ενέργειες, που γίνονται στις φάσεις του μοντέλου. 

 

 
 
Εικόνα 6.4 Φάσεις μοντέλου ADDIE. 

 
Στη φάση της ανάλυσης γίνεται αναγνώριση των δυνητικών χρηστών (target group) και ανάλυση των 

αναγκών των χρηστών. Οι απαιτήσεις χρήστη (user requirements) περιγράφουν τι θα πρέπει να κάνει το 
σύστημα για να ικανοποιήσει τις ανάγκες και τις επιθυμίες των χρηστών. Η αναγνώριση των αναγκών 
συνιστά σημαντικό τμήμα της διαδικασίας και υλοποιείται με τη συμμετοχή αντιπροσωπευτικών χρηστών. Η 
καταγραφή των απαιτήσεων μπορεί να γίνει με προσωπικές συνεντεύξεις, ερωτηματολόγια, παρατήρηση 
χρηστών, οι οποίοι χρησιμοποιούν ένα πρωτότυπο της εφαρμογής ή παρατήρηση περιβάλλοντος στο οποίο 
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λειτουργούν οι χρήστες, που θα χρησιμοποιήσουν την εφαρμογή. Η αποτύπωση των αναγκών γίνεται 
συνήθως με διαγράμματα, π.χ. διαγράμματα ροής δεδομένων ή διαγράμματα περιπτώσεων χρήσης, και με 
έγγραφα, τα οποία αποτυπώνουν σε γραπτή μορφή τις όποιες απαιτήσεις. 
 

Μοντέλο ADDIE 
ΑΝΑΛΥΣΗ ΣΧΕΔΙΑΣΜΟΣ ΑΝΑΠΤΥΞΗ  ΕΦΑΡΜΟΓΗ ΑΞΙΟΛΟΓΗΣΗ 

Ανάλυση αναγκών Στόχοι μάθησης 
Ανάπτυξη 

περιεχομένου 
Εγκατάσταση και διανομή Αντιδράσεις 

Ανάλυση κοινού στο 
οποίο απευθύνεται 

Σχεδιασμός οθονών, 
πλοήγησης και 

storyboard 

Ανάπτυξη σειράς 
μαθημάτων 

Διαχείριση δραστηριοτήτων 
εκπαιδευόμενου 

Μάθηση 

Ανάλυση εργασιών και 
θεμάτων 

Εκπαιδευτική 
στρατηγική 

  Συμπεριφορά 

 
Στρατηγική 
αξιολόγησης  

  Αποτελέσματα 

 
Πίνακας 6.1 Ενδεικτικές ενέργειες σε κάθε φάση του μοντέλου . 

 
Στη φάση της σχεδίασης τίθενται με σαφήνεια οι στόχοι της εφαρμογής και περιγράφεται η 

αρχιτεκτονική του συστήματος με χρήση διαφόρων διαγραμμάτων. Ειδικά στην περίπτωση των εφαρμογών 
πολυμέσων υπάρχουν κάποια ειδικά παραγόμενα, τα οποία μας βοηθούν να καταλάβουμε το τι τελικά θα 
δημιουργηθεί. 

Αρχικά πρέπει να δημιουργηθεί ο χάρτης πλοήγησης (navigation map), που δείχνει τις συνδέσεις 
ανάμεσα στις οθόνες ή σελίδες της εφαρμογής. Ο χάρτης πλοήγησης έχει ουσιαστικά τον ρόλο του πίνακα 
περιεχομένων μιας εφαρμογής πολυμέσων. Η πλοήγηση μπορεί να είναι γραμμική ή ιεραρχική (δενδροειδής) 
ή δικτυωτή (γράφου) (Εικόνα 6.5). Ιδιαίτερα σε πολύπλοκες εφαρμογές ο χάρτης πλοήγησης αποτελεί 
σημαντικό εργαλείο, γιατί δίνει μια εποπτική άποψη της δομής, στοιχείο που βοηθά στη διαδικασία της 
ανάπτυξης. 

 

 
 
Εικόνα 6.5 Διαφορετικοί τύποι δομών Εφαρμογών Πολυμέσων. 

 
Το επόμενο εργαλείο είναι η δημιουργία των εικονογραφημένων σεναρίων (storyboard) που 

αποτελεί μια κωδικοποιημένη, αναλυτική περιγραφή των βασικών χαρακτηριστικών μιας πολυμεσικής 
εφαρμογής με χρήση εικόνων και σχολίων. Ένα εικονογραφημένο μοντέλο καλύπτει τις εξής ανάγκες: 
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 Επικοινωνία και συνεννόηση μεταξύ των συντελεστών και των συνεργατών μιας εφαρμογής. 
 Πληρέστερη πρόβλεψη των αναγκών επεξεργασίας του υλικού κάθε ενότητας, με βάση τα 

περιεχόμενα κάθε ενότητας. 
 Αναλυτικός οδηγός για την υλοποίηση της εφαρμογής. 

 
Τα στοιχεία, τα οποία περιλαμβάνει ένα εικονογραφημένο σενάριο μιας εφαρμογής πολλαπλών 

μέσων, είναι:  
 Βασικές αρχές οργάνωσης κάθε οθόνης, σχετικές θέσεις κειμένων, εικονογραφικών 

στοιχείων και άλλων στοιχείων ήχου, βίντεο κ.λπ. 
 Τα ενεργά στοιχεία της οθόνης, με τα οποία μπορεί να πλοηγηθεί στις οθόνες της εφαρμογές. 

 
Οι οθόνες αυτές μπορεί να είναι απλά σχέδια σε χαρτί (Εικόνα 6.6) ή να δημιουργηθούν στον 

υπολογιστή με πλαίσια κειμένου (Εικόνα 6.7). Τα storyboards μπορούν να περιγραφούν και με ειδικές 
φόρμες, οι οποίες περιέχουν μικρογραφίες οθονών και χώρο, για περιγραφή με σχόλια, της λειτουργίας της 
φόρμας (Εικόνα 6.8).  
 

 
 
Εικόνα 6.6 Ενδεικτική οθόνη της εφαρμογής σε χαρτί. 
 

 
 
Εικόνα 6.7 Ενδεικτική οθόνη της εφαρμογής σε υπολογιστή. 

 
Στη φάση της ανάπτυξης γίνεται ανάπτυξη του περιεχομένου, δηλαδή του κειμένου, των εικόνων, του 

βίντεο, των ήχων και των animations, που θα χρησιμοποιηθούν για την παρουσίαση και την αξιολόγηση των 
παρουσιαζόμενων εννοιών. Εδώ εμπλέκονται όλα τα θέματα, τα οποία μελετήσαμε στις προηγούμενες 
ενότητες και θα χρησιμοποιηθούν τα εργαλεία που μελετάμε στα κεφάλαια 7 έως και 11, π.χ. προγράμματα 
επεξεργασίας εικόνων, βίντεο, ήχου και άλλα βοηθητικά εργαλεία.  

Μετά την επεξεργασία του περιεχομένου, τα υλικά που αναπτύχθηκαν θα ενσωματωθούν σε μια 
ενιαία εφαρμογή με χρήση του κατάλληλου εργαλείου. Για παράδειγμα, μπορεί να χρησιμοποιηθεί κάποια 
τεχνολογία διαδικτύου, όπως η HTML5, ή κάποιο εργαλείο, όπως το Moodle. Τα σχετικά εργαλεία 
μελετώνται πιο κάτω στο τρέχον κεφάλαιο. 
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Στις επόμενες φάσεις γίνεται έλεγχος της εφαρμογής από αντιπροσωπευτικούς χρήστες. Ο έλεγχος ως 
προς τη λειτουργικότητα, την αισθητική, την ταχύτητα εκτέλεσης των λειτουργιών, τον απαιτούμενο ρυθμό 
μετάδοσης των δεδομένων, τον έλεγχο σε διαφορετικά λειτουργικά συστήματα κ.ά. Αν βασιζόμαστε στο 
μοντέλο ADDIE, τότε, ακριβώς επειδή όπως προαναφέρθηκε το μοντέλο αυτό θέτει την αξιολόγηση στο 
επίκεντρο της όλης διαδικασίας, θα πρέπει σε κάθε βήμα να γίνεται και ο σχετικός έλεγχος. Για παράδειγμα, η 
ταχύτητα εκτέλεσης των λειτουργιών δεν μπορεί να ελεγχθεί στο τέλος, αλλά κατά την διάρκεια ανάπτυξης. 
Η αισθητική της εφαρμογής πρέπει να ελεγχθεί κατά τον σχεδιασμό της εφαρμογής.  

 

 
 
Εικόνα 6.8 Πρότυπα φύλλα καταγραφής ενός storyboard. 
 

Ένα άλλο σημαντικό ζήτημα που πρέπει να ληφθεί υπόψη κατά τη σχεδίαση της εφαρμογής, είναι η 
ευχρηστία (usability) της εφαρμογής. Αφορά την ευκολία χρήσης της εφαρμογής και τη δυνατότητα 
εκτέλεσης των λειτουργιών με εύκολο και διαφανή τρόπο. Κάποιες αρχές, οι οποίες αυξάνουν την ευχρηστία 
μιας εφαρμογής, είναι οι εξής: 

 Απλότητα στη διεπαφή χρήστη (interface) της εφαρμογής. 
 Ύπαρξη βοήθειας σε διάφορα σημεία, ώστε οι αρχάριοι χρήστες να μπορούν να επιτελέσουν 

τις λειτουργίες χωρίς λάθος. 
 Οι ενέργειες πρέπει να επιτελούνται με παρόμοιο τρόπο σε όλες τις ενότητες της εφαρμογής. 
 Η διεπαφή χρήστη πρέπει να είναι συμβατή με σύγχρονα πρότυπα με τα οποία είναι ήδη 

εξοικειωμένοι οι χρήστες.  
 Πρέπει να υπάρχουν δυνατότητες συντόμευσης για έμπειρους χρήστες. 
 Δυνατότητα ακύρωσης ενεργειών και προφύλαξη των χρηστών από λάθος ενέργειες. 
 Υψηλού επιπέδου αλληλεπίδραση με την εφαρμογή. 

 
Η ευχρηστία είναι θέμα, που εξετάζεται κατά τη σχεδίαση της εφαρμογής με τη βοήθεια χρηστών 

διαφόρων τεχνικών γνώσεων και με διάφορους τρόπους. Για παράδειγμα, μπορεί να ζητείται στους χρήστες 
να επιτελέσουν συγκεκριμένες λειτουργίες και να ελέγχεται η δυνατότητα των χρηστών να ολοκληρώσουν τις 
ενέργειες. 
 

6.2.1. Χρήστες 
 
Σε ένα τυπικό έργο ανάπτυξης λογισμικού οι ρόλοι που εμπλέκονται στην ανάπτυξη του έργου μπορούν να 
χωριστούν στις ακόλουθες κατηγορίες:  
 

 Αντιπροσωπευτικοί χρήστες, όπως εργαζόμενοι από διαφορετικά ιεραρχικά ή γνωστικά 
επίπεδα, πιθανοί πελάτες κ.λπ. 



159 
 

 Υπεύθυνοι διαφόρων τομέων, που μπορεί να είναι περισσότεροι από ένα άτομα με 
διαφορετικούς ρόλους (π.χ. πληροφορικοί, διευθυντικά στελέχη, υπεύθυνοι οικονομικής 
διαχείρισης κ.λπ.). 

 Αναλυτές και σχεδιαστές, οι οποίοι θα εφαρμόσουν τα μοντέλα ανάλυσης και σχεδίασης για 
να καταλήξουν στις προδιαγραφές και τον σχεδιασμό του συστήματος. 

 Ειδικοί ελέγχου, οι οποίοι θα ασχοληθούν με την ποιότητα, την τήρηση των προδιαγραφών 
κ.ά. 

 Προγραμματιστές, οι οποίοι θα αναπτύξουν τον κώδικα της εφαρμογής, σε μια κατάλληλη 
τεχνολογία, π.χ. για το διαδίκτυο.  

 Σχεδιαστές ιστού για τις εφαρμογές που τρέχουν στο διαδίκτυο και απαιτούν ιδιαίτερες 
γνώσεις, πέραν του κλασικού προγραμματισμού (π.χ. πολυμέσα). 

 
Επιπρόσθετα, θα πρέπει να υπάρχει μια ομάδα που θα αποτελείται από ειδικούς πολυμεσικού 

περιεχομένου. Οι ειδικοί γραφικών θα επεξεργάζονται τις φωτογραφίες και θα δημιουργούν σχήματα και 
διαγράμματα, τα οποία θα χρησιμοποιούνται στην εφαρμογή. Οι ειδικοί βίντεο, ήχου και αν χρειαστεί και 
ειδικοί τρισδιάστατων γραφικών και animation θα ασχοληθούν με την επεξεργασία των μέσων, που θα 
συνθέτουν τις πολυμεσικές παρουσιάσεις. Τέλος, θα πρέπει να συμπληρώνουν την ομάδα ανάπτυξης άτομα, 
τα οποία θα ασχοληθούν με την ευχρηστία του συστήματος και ειδικοί του θεματικού πεδίου, οι οποίοι 
ελέγξουν το περιεχόμενο της εφαρμογής. 
 

6.3. Τεχνολογίες και εργαλεία ανάπτυξης 
 
Η ανάπτυξη ολοκληρωμένων πολυμεσικών εφαρμογών γίνεται πλέον κατά κύριο λόγο στο διαδίκτυο. 
Παλαιότερα υπήρχαν εξειδικευμένα εργαλεία για ανάπτυξη εφαρμογών που εκτελούνταν τοπικά σε κάποιο 
λειτουργικό σύστημα. Τα πιο γνωστά εργαλεία ήταν τα Asymetrix ToolBook, Macromedia Director και 
Macromedia Authorware, τα οποία βασίζονταν σε διαφορετικές προσεγγίσεις ανάπτυξης. Για ιστορικούς 
κυρίως λόγους να αναφέρουμε ότι τα εργαλεία χωρίζονταν στις εξής βασικές κατηγορίες: 

 Κάρτας ή σελίδας (card ή page), όπου η εφαρμογή αναπτυσσόταν ως ένα σύνολο από σελίδες 
και προσομοίωνε τη λογική ενός βιβλίου. Παραδείγματα τέτοιων εργαλείων είναι το  
ToolBook (http://tb.sumtotalsystems.com), το οποίο έχει εξελιχθεί σε LMS (Learning 
Management System). 

 Ροής χρόνου ή χρονοδιαδρόμου (time based), με χαρακτηριστικό παράδειγμα το Adobe Flash 
(http://www.adobe.com/products/flash.html). Η εφαρμογή αναπτύσσεται ως ένα σύνολο 
αντικειμένων (π.χ. εικόνες, ήχους, κείμενο) με συγκεκριμένη συμπεριφορά, τα οποία 
τοποθετούνται σε συγκεκριμένους χρονοδιαδρόμους και εκτελούνται παράλληλα. Υπάρχει, 
δηλαδή, μια λογική ανάλογη με έναν θίασο, όπου οι ηθοποιοί εκτελούν διάφορες ενέργειες 
και τελικά δημιουργείται το συνολικό έργο. Το Adobe Flash χρησιμοποιείται ακόμη από 
εφαρμογές, που θέλουν να παρέχουν αυξημένη διαδραστικότητα, αλλά χάνει έδαφος από την 
HTML5. 

 
Οι τεχνικές αυτές εξακολουθούν να εφαρμόζονται, αλλά η ορολογία χρησιμοποιείται σπάνια. Οι 

προσεγγίσεις που χρησιμοποιούνται πλέον για την ανάπτυξη διαδικτυακών εφαρμογών πολυμέσων είναι: 
 Ανάπτυξη δικτυακών τόπων με πλούσιο πολυμεσικό περιεχόμενο με χρήση έτοιμων 

πρoτύπων (templates) ιστοσελίδας. 
 Χρήση εργαλείων για ανάπτυξη εκπαιδευτικών εφαρμογών πολυμέσων στο διαδίκτυο. 
 Χρήση προγραμματιστικών εργαλείων, όπως το Adobe Flash και η HTML5, για ανάπτυξη 

εφαρμογών με υψηλό βαθμό διάδρασης. Σε αυτή την περίπτωση χρησιμοποιούνται και άλλες 
τεχνολογίες, όπως η JavaScript και τα CSS. 

 

6.3.1. Ανάπτυξη δικτυακών τόπων με χρήση έτοιμων πρoτύπων 
 
Στο διαδίκτυο υπάρχουν ιστότοποι όπου, είτε με πληρωμή είτε δωρεάν, μπορούμε να δημιουργήσουμε 
ψηφιακό περιεχόμενο με χρήση έτοιμων προτύπων. Για παράδειγμα, στις Εικόνες 6.9 έως 6.11 βλέπουμε τις 
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έτοιμες κατηγορίες ιστοτόπων που προσφέρει μια δωρεάν διαδικτυακή υπηρεσία και τελικά έναν δικτυακό 
τόπο που παράχθηκε από αυτή τη διαδικασία.  

 

 
 
Εικόνα 6.9 Έτοιμες κατηγορίες ιστοσελίδων. 

 

 
 
Εικόνα 6.10 Υποκατηγορίες με βάση την αρχική κατηγορία. 

 
Εκτός από κάποιες δωρεάν υπηρεσίες στις οποίες μπορούμε να δημιουργήσουμε διαδικτυακό 

περιεχόμενο, πλούσιο σε πολυμεσικό υλικό, υπάρχουν και τα συστήματα διαχείρισης περιεχομένου (Content 
Management Systems - CMS), όπως το Joomla! (https://www.joomla.org) Χρησιμοποιείται για τη 
δημοσίευση περιεχομένου στον παγκόσμιο ιστό (World Wide Web) και σε τοπικά δίκτυα. Το σύστημα 
Joomla! Υποστηρίζει τη δημιουργία δυναμικών ιστοχώρων και υπάρχουν χιλιάδες έτοιμα πρότυπα και 
επεκτάσεις του συστήματος που μπορούμε να κατεβάσουμε από το διαδίκτυο, π.χ. Εικόνα 6.12. Το 
WordPress (https://wordpress.org) μπορεί επίσης να χρησιμοποιηθεί ως CMS.  

Με τη συγκεκριμένη προσέγγιση στην ανάπτυξη διαδικτυακών τόπων υπάρχουν συγκεκριμένα 
πλεονεκτήματα. Η πληροφορία είναι άμεσα διαθέσιμη στο διαδίκτυο, χωρίς να απαιτούνται ιδιαίτερες 
τεχνικές γνώσεις. Υπάρχουν πολλά δωρεάν templates και η σχεδίαση είναι responsive, δηλαδή άμεσα 
προσαρμόσιμη σε διαφορετικά υπολογιστικά περιβάλλοντα. Μπορούμε να πούμε ότι η τεχνική αυτή 
βασίζεται στην ανίχνευση κάποιων εξωτερικών μεταβλητών και με βάση τις τιμές τους, υπάρχει και ανάλογη 
ανταπόκριση και εμφάνιση της ιστοσελίδας. Για παράδειγμα, στην Εικόνα 6.13 εμφανίζεται η ίδια ιστοσελίδα 
σε διαφορετικά υπολογιστικά συστήματα. 
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Εικόνα 6.11 Δικτυακός τόπος που έχει δημιουργηθεί με χρήση προτύπων. 
 

 

 
 
Εικόνα 6.12 Joomla! template. 

 

6.3.2. Εργαλεία για ανάπτυξη εκπαιδευτικών εφαρμογών 
 
Η ψηφιοποίηση εκπαιδευτικού περιεχομένου και η ανάπτυξη ολοκληρωμένων εκπαιδευτικών πολυμεσικών 
εφαρμογών είναι μια συχνή διαδικασία. Για την ανάπτυξη εφαρμογών ηλεκτρονικής μάθησης υπάρχουν 
πολλά εργαλεία, που ονομάζονται συστήματα διαχείρισης μάθησης (Learning Management Systems - LMS). 
Υπάρχουν αρκετά τέτοια συστήματα, εμπορικά, π.χ. το Blackboard (http://www.blackboard.com), και 
ανοιχτού κώδικα με πιο γνωστό το Moodle (https://moodle.org) (Εικόνα 6.14). Άλλα εργαλεία όπως το 
Google Course Builder (https://code.google.com/p/course-builder) αρχίζουν να χρησιμοποιούνται για την 
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ανάπτυξη online μαθημάτων, που είναι πλούσια σε περιεχόμενο. Τα εργαλεία αυτά παρέχουν αρκετές 
δυνατότητες και για την ανάρτηση περιεχομένου και τη διαχείριση μαθημάτων, αλλά και για τη διαχείριση 
των εκπαιδευομένων και των εκπαιδευτικών τους δραστηριοτήτων. Υποστηρίζουν τη δυνατότητα πρόσθεσης 
νέων προτύπων και επεκτάσεων που μπορεί να κάνουν την εφαρμογή πιο εύχρηστη και καλαίσθητη. 
 

 
 
Εικόνα 6.13 Η ίδια ιστοσελίδα σε διαφορετικά υπολογιστικά περιβάλλοντα. 
 

 
 
Εικόνα 6.14 Μάθημα στο Moodle. 
 

6.3.3. Προγραμματιστικά εργαλεία 
 
Υπάρχουν διάφορα προγραμματιστικά εργαλεία για ανάπτυξη διαδραστικών εφαρμογών στο διαδίκτυο. Τα 
πιο γνωστά εργαλεία ήταν το Silverlight της Microsoft (http://www.microsoft.com/silverlight) και το Adobe 
Flash (http://www.adobe.com/products/flash.html). Η γλώσσα HTML5 έχει παραμερίσει τις προηγούμενες 
τεχνολογίες και τείνει να αντικαταστήσει καθολικά τις προηγούμενες εκδόσεις, καθώς πρόκειται για δωρεάν 
πρότυπο και με καθολική υποστήριξη στους νέους φυλλομετρητές όλων των λειτουργικών στοιχείων. 

To Adobe Flash (πρώην Macromedia Flash και Shockwave Flash) είναι μια πλατφόρμα λογισμικού 
που χρησιμοποιείται για τη δημιουργία διανυσματικών γραφικών, κινούμενων σχεδίων και παιχνιδιών για το 
διαδίκτυο. Οι εφαρμογές σε Flash μπορούν να περιέχουν κείμενο, διανυσματικών και ψηφιογραφικών 
εικόνων και βίντεο (π.χ. Εικόνα 6.15). Μπορεί να συλλάβει είσοδο από ποντίκι, πληκτρολόγιο, κάμερα και 
μικρόφωνο. Συνεργάζεται με τα υπόλοιπα εργαλεία της Adobe. Έχει αρκετά πλεονεκτήματα, αλλά δεν είναι 
δωρεάν εργαλείο και απαιτείται κάποιο πρόσθετο για την εκτέλεσή του. 

Η HTML5 είναι η νέα έκδοση της γλώσσας υπερκειμένου HTML (Hyper Text Markup Language). 
Πρωταρχικός σκοπός της HTML5 ήταν η μείωση της ανάγκης για plug-in (επεκτάσεις) διαδικτυακές 
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εφαρμογές όπως στην περίπτωση του Adobe Flash και του Microsoft Silverlight. Η HTML, γενικά, είναι μια 
γλώσσα περιγραφής, όπου με ετικέτες ορίζουμε τη μορφή του κειμένου που θα εμφανιστεί. Η HTML5 
περιέχει νέα στοιχεία, όπως: 

 Την ετικέτα <canvas> για σχεδίαση. 
 Την ετικέτα <svg> για αρχεία διανυσματικών γραφικών. 
 Τα στοιχεία <video> και <audio> για αναπαραγωγή πολυμέσων. 
 Νέα στοιχεία περιεχομένου όπως τα footer, header, nav και section. 
 Νέα στοιχεία δημιουργίας φόρμας όπως τα calendar, date, time, email, url και search.  
 

Το ακόλουθο παράδειγμα περιέχει τον κώδικα που, όταν εκτελεστεί, σε κάποιον φυλλομετρητή 
ιστοσελίδων, εμφανίζει ένα μπλε ορθογώνιο με μαύρο περίγραμμα. Γενικά, όπως βλέπουμε στην Εικόνα 6.16, 
μπορούμε να δημιουργήσουμε σύνθετες εφαρμογές και σε συνδυασμό με άλλες διαδικτυακές τεχνολογίες 
όπως η PHP, η JavaScript και τα CSS. 

 
<!DOCTYPE html> 
<html> 
<body> 
   <svg width="400" height="100"> 
   <rect width="400" height="100" style="fill:rgb(0,0,255);stroke-width:10;stroke:rgb(0,0,0)" /> 
 Sorry, your browser does not support inline SVG. 
   </svg> 
</body> 
</html> 

 

 
 
Εικόνα 6.15 Παράδειγμα ανάπτυξης σε Adobe Flash. 

 

6.4. Ανακεφαλαίωση 
 
Αρχικά ορίζεται o κύκλος ζωής λογισμικού είναι η διαδικασία που περιλαμβάνει την κατανόηση του 
συστήματος που θέλουμε να δημιουργήσουμε, το σχεδιασμό, την υλοποίησή του και την τελική παράδοση 
στους χρήστες. Έπειτα ορίζεται το μοντέλο καταρράκτη που ορίζει τις φάσεις ανάπτυξης ενός λογισμικού. 
Κάνουμε αναφορά στο μοντέλο ADDIE που εφαρμόζεται στα εκπαιδευτικά υπερμεσικά συστήματα. Οι 
φάσεις της ανάλυσης απαιτήσεων, του σχεδιασμού, της αξιολόγησης, της ανάπτυξης και της εφαρμογής 
εξηγούνται. Ιδιαίτερη αναφορά γίνεται στο χάρτη πλοήγησης που δείχνει τις συνδέσεις ανάμεσα στις οθόνες ή 
σελίδες της εφαρμογής, στα εικονογραφημένα σενάρια που αποτελεί μια κωδικοποιημένη, αναλυτική 
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περιγραφή των βασικών χαρακτηριστικών μιας πολυμεσικής εφαρμογής με χρήση εικόνων και σχολίων. Τα 
βασικά στοιχεία που βοηθούν στην αύξηση της ευχρηστίας μιας εφαρμογής παραθέτονται επίσης και γίνεται 
αναφορά στους ρόλους της ομάδας ανάπτυξης. 

 

 
 
Εικόνα 6.16 Παράδειγμα ανάπτυξης εκπαιδευτικής εφαρμογής σε HTML5. 

 
Στην τελευταία ενότητα του κεφαλαίου εστιάζουμε στις σύγχρονες προσεγγίσεις ανάπτυξης 

πολυμεσικών παρουσιάσεων. Η πρώτη προσέγγιση είναι μέσω προτύπων ιστοσελίδων που προσφέρουν 
διάφορες δικτυακές υπηρεσίες. Εφαρμογές διαχείρισης διαδικτυακού περιεχομένου, όπως το Joomla! και το 
WordPress, υποστηρίζουν την ανάπτυξη εφαρμογών πλούσιων σε πολυμεσικό υλικό. Μέσω δωρεάν 
templates μπορούν να δημιουργηθούν αρκετά θελκτικές υπερμεσικές σελίδες. Ένας άλλος τρόπος ανάπτυξης 
είναι μέσω συστημάτων δημιουργίας πολυμεσικών συστημάτων, όπως το Moodle. Και σε αυτά τα συστήματα 
μπορούν να προστεθούν επεκτάσεις και πρότυπα που υποστηρίζουν την ανάπτυξη πολυμεσικών εφαρμογών. 
Τέλος, με τεχνολογίες όπως το Adobe Flash και η HTML5 μπορούν να αναπτυχθούν διαδραστικές εφαρμογές 
και να συνδυαστούν με άλλες διαδικτυακές τεχνολογίες. 
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7. Επεξεργασία ψηφιογραφικών εικόνων με τα εργαλεία Adobe 
Photoshop & Gimp 

 
Σύνοψη 
Στο συγκεκριμένο κεφάλαιο παρουσιάζουμε μέσα από ασκήσεις τις δυνατότητες των εργαλείων Adobe Pho-
toshop και Gimp. Το πρώτο εργαλείο επιλέχθηκε γιατί είναι το πιο γνωστό εργαλείο επεξεργασίας ψηφιογραφι-
κών εικόνων, ενώ το Gimp αποτελεί το πιο γνωστό ελεύθερο εργαλείο επεξεργασίας εικόνων. Αρχικά, παρου-
σιάζουμε την εξέλιξη του εργαλείου Photoshop, εξηγούμε τις δυνατότητές του και παρουσιάζουμε βήμα-προς-
βήμα ασκήσεις που αφορούν σε θέματα διορθώσεων, αισθητικών βελτιώσεων και καλλιτεχνικών προσαρμογών 
φωτογραφιών. Γίνεται, επίσης, εισαγωγή σε σύνθετα θέματα, όπως επίπεδα και φίλτρα. Στη δεύτερη ενότητα του 
κεφαλαίου παρουσιάζουμε αντίστοιχα θέματα με το εργαλείο Gimp.  

 
Προαπαιτούμενη γνώση 
Για την κατανόηση κάποιων θεμάτων του κεφαλαίου είναι απαραίτητη η μελέτη του κεφαλαίου 2, στο οποίο 
παρουσιάστηκαν διάφορα θεωρητικά ζητήματα σχετικά με τις εικόνες. 

 

7.1. Adobe Photoshop 
 
Το Adobe Photoshop, ή πιο απλά Photoshop (http://www.adobe.com/products/photoshop.html), είναι ένα 
πρόγραμμα επεξεργασίας γραφικών που αναπτύχθηκε από την Adobe Systems.  Είναι το πιο διαδεδομένο 
πρόγραμμα επεξεργασίας φωτογραφιών και ψηφιογραφικών (bitmap) γραφικών. Εμφανίστηκε το 1988 
(http://en.wikipedia.org/wiki/Adobe_Photoshop_version_history) και μέχρι το 2002 οι εκδόσεις ονομάζονταν 
Photoshop 1, Photoshop 2,…, Photoshop 7. Από το 2002 έως και το 2012 οι εκδόσεις έγιναν γνωστές με το 
αναγνωριστικό CS (Creative Suite) π.χ. Photoshop CS, Photoshop CS1 κ.ο.κ. Οι εκδόσεις που αναφέρονται 
και ως Extended περιέχουν εργαλεία για τη δημιουργία 3D εικόνων, την επεξεργασία κινούμενων γραφικών, 
καθώς και προηγμένες δυνατότητες ανάλυσης εικόνας. Η τελευταία έκδοση του εργαλείου ως αυτόνομη ε-
φαρμογή ήταν η Photoshop CS6. Οι πιο πρόσφατες εκδόσεις διατίθενται ως υπηρεσίες σύννεφου (cloud 
service) από την Adobe και αναφέρονται ως Photoshop CC (Creative Cloud). Κάθε νέα έκδοση περιέχει προ-
φανώς περισσότερες εξειδικευμένες λειτουργίες, αλλά οι περισσότερες λειτουργίες είναι κοινές σε όλες τις 
εκδόσεις.  

Το εργαλείο παρέχει πολλές δυνατότητες διόρθωσης φωτογραφιών, διαχωρισμού των αντικειμένων 
από το φόντο, εφαρμογή φίλτρων, αλλαγής χρωμάτων, προσθήκη διαφάνειας, αποθήκευση σε διάφορες μορ-
φές, διαχείριση καναλιών και παλετών για εικόνες που υποστηρίζουν χρωματικές αποχρώσεις, κ.ά. Στο παρόν 
κεφάλαιο, θα ασχοληθούμε με ασκήσεις, τις οποίες εκτελούμε στην τελευταία αυτόνομη έκδοση του 
Photoshop, δηλαδή την έκδοση CS6. Οι περισσότερες ασκήσεις, ενδεχομένως, να λειτουργούν και σε προη-
γούμενες εκδόσεις, αλλά καλό είναι να μην χρησιμοποιηθεί κάποια αρκετά παλιά έκδοση. Επίσης, πολλές από 
τις ασκήσεις μπορούν να εκτελεστούν και διαδικτυακά στην εφαρμογή http://apps.pixlr.com/editor. Πρέπει να 
σημειωθεί ότι η παρουσίαση του εργαλείου δεν είναι σε καμία περίπτωση εξαντλητική, αλλά σκοπεύουμε 
στην παρουσίαση των βασικών δυνατοτήτων του. 
 

7.1.1. Πότε χρησιμοποιούμε το Photoshop; 
 
Το Photoshop το χρησιμοποιούμε κατά κύριο λόγο για τις ακόλουθες λειτουργίες: 

 Διορθώσεις ή βελτιώσεις φωτογραφιών: για παράδειγμα, μπορούμε να διορθώσουμε τα χρώ-
ματα μιας φωτογραφίας· να αφαιρέσουμε κάποιο ανεπιθύμητο αντικείμενο από μια φωτο-
γραφία· να αλλάξουμε τις χρωματικές αποχρώσεις, ώστε να δοθεί μια πιο ατμοσφαιρική διά-
σταση (π.χ. Εικόνα 7.1)· διορθώσεις ατελειών σε πρόσωπα κ.λπ. 

 
 Καλλιτεχνικές παρεμβάσεις: μπορούμε να εφαρμόσουμε κάποια φίλτρα για δημιουργία εφέ 

στις φωτογραφίες (π.χ. Εικόνα 7.2). 
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 Συνθέσεις εικόνων: μπορούμε να συνδυάσουμε διαφορετικές φωτογραφίες, σχήματα, κείμενο 
και φίλτρα σε διαφορετικά επίπεδα και να δημιουργήσουμε μια σύνθετη εικόνα, π.χ. ένα ε-
ξώφυλλο βιβλίου ή ένα φυλλάδιο, κ.λπ. 
 

 Δημιουργία ζωγραφιών: το photoshop περιέχει ένα σύνολο από βούρτσες που επιτρέπει τη 
δημιουργία ζωγραφιών και σε συνδυασμό με χρήση επιπέδων και μασκών και φυσικά φαντα-
σίας, μπορεί να δημιουργηθούν εντυπωσιακές συνθέσεις (π.χ. 
http://paintingwithphotoshop.weebly.com/).  
 

 Προετοιμασία εικόνων για εκτύπωση: οι περισσότερες φωτογραφίες που χρησιμοποιούμε 
στους υπολογιστές βασίζονται στο μοντέλο RGB, ενώ οι εκτυπώσεις στο CMYK. Με το 
Photoshop είναι εφικτή η μετατροπή μεταξύ των χρωματικών μοντέλων, ο διαχωρισμός των 
βασικών χρωμάτων του μοντέλου CMYK, κ.ά. 

 

 
 
Εικόνα 7.1 Αλλαγή χρωματικών αποχρώσεων σε μια εικόνα. 

 

 
 
Εικόνα 7.2 Εφαρμογή φίλτρων Trace Contour και Find Edges. 
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Το Photoshop έχει φυσικά και άλλες δυνατότητες όπως αναφέραμε, π.χ. δημιουργία 3Δ αντικειμένων, 

αλλά το χρησιμοποιούμε κυρίως για τις διαδικασίες που περιγράφουμε στην παραπάνω λίστα. 
Τα εγγενή αρχεία του Photoshop είναι τα PSD, όπως έχουμε αναφέρει στο κεφάλαιο 2. Πρόκειται για 

αρχεία που περιέχουν πλήθος πληροφοριών, όπως επίπεδα, κανάλια, φίλτρα, χρωματικό μοντέλο κ.ά. Φυσικά, 
μπορούμε να ανοίξουμε οποιοδήποτε μορφότυπο εικόνας (π.χ. BMP, JPG, PNG κ.α.) και να αποθηκεύσουμε 
σε οποιαδήποτε μορφή. Αν αποθηκεύσουμε ένα έργο PSD ως αρχείο PNG, για παράδειγμα, απλά θα ενωθούν 
τα επίπεδα και θα αποθηκευτεί ως μια εικόνα. Άρα, στα σύνθετα έργα πρέπει να διατηρούμε το αρχείο PSD 
που περιέχει όλες τις επιμέρους πληροφορίες και να αποθηκεύουμε σε κάποια άλλη μορφή την τελική εικόνα, 
αν χρειαστεί να την μοιραστούμε στο Internet ή να την εκτυπώσουμε ή να τη χρησιμοποιήσουμε σε κάποια 
άλλη εφαρμογή. 

 

7.1.2. Γνωριμία με το περιβάλλον εργασίας του Photοshop 
 
Στην Εικόνα 7.3 εμφανίζεται το περιβάλλον εργασίας του Photoshop: 

 
 Στο σημείο 1 της εικόνας εμφανίζονται τα μενού επιλογών του εργαλείου.  
 Στο σημείο 2 υπάρχει η βασική συλλογή εργαλείων (εργαλειοθήκη) του Photoshop. 
 Στο σημείο 3 εμφανίζονται κάποιες επιλογές και πλαίσια ρυθμίσεων, ανάλογα με το επιλεγ-

μένο εργαλείο της εργαλειοθήκης. 
 Στο κέντρο της οθόνης, στο σημείο 4, εμφανίζεται η εικόνα που επεξεργαζόμαστε. 
 Στα σημεία 5 και 6 υπάρχουν διάφορες παλέτες εργαλείων, π.χ. τα επίπεδα, που επιτρέπουν 

διάφορες επεξεργασίες επί των εικόνων.  
 

 
 
Εικόνα 7.3 Το περιβάλλον εργασίας του Photoshop CS6. 

 
Στα εικονίδιο των εργαλείων της εργαλειοθήκης υπάρχει ένα μικρό βέλος στην κάτω δεξιά γωνία. Αν 

κάνουμε κλικ στο εικονίδιο και το κρατήσουμε πατημένο, εμφανίζονται και άλλα εργαλεία που αφορούν στο 
ίδιο ζήτημα, αλλά προσφέρουν διαφορετικές επιλογές. 
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Για να εμφανίζεται το ίδιο περιβάλλον εργασίας, όπως στην Εικόνα 7.3, πρέπει να επιλέξετε 
«Windows > Workspace > Essentials (default)». Παρατηρούμε ότι το περιβάλλον εργασίας του Photoshop 
CS6 είναι εξ ορισμού σκουρόχωμο. Αυτό δεν συνέβαινε σε παλαιότερες εκδόσεις. Η αλλαγή έγινε, ώστε να 
μειωθεί η κούραση των ματιών στην περίπτωση πολύωρης ενασχόλησης με το εργαλείο. Αν, παρόλα αυτά, 
επιθυμείτε να αλλάξετε το περιβάλλον εργασίας χρησιμοποιώντας πιο ανοιχτόχρωμες αποχρώσεις, μπορείτε 
να επιλέξετε το μενού «Edit > Preferences > Interface» και έπειτα κάποια από τις γκρι αποχρώσεις που εί-
ναι διαθέσιμες (Εικόνα 7.4). Στις επόμενες ασκήσεις θα χρησιμοποιούμε τις ανοιχτόχρωμες αποχρώσεις. 

Τα αρχεία που επεξεργαζόμαστε στο Photoshop είναι ψηφιογραφικές εικόνες που μπορεί να έχουν 
δημιουργηθεί από την αρχή στο Photoshop ή να είναι φωτογραφίες που εισάγουμε μέσω μιας φωτογραφικής 
μηχανής ή να είναι σκαναρισμένες φωτογραφίες και γραφικά. Επίσης, αν και δεν είναι ο κύριος σκοπός του, 
υποστηρίζει κάποιες λειτουργίες επεξεργασίας δισδιάστατων και τρισδιάστατων διανυσματικών γραφικών και 
δημιουργίας βίντεο κλιπ. 
 

 
 
Εικόνα 7.4 Αλλαγή χρώματος του περιβάλλοντος εργασίας του Photoshop. 

 

 
 
Εικόνα 7.5 Μενού επιλογών του Photoshop. 

 
Στην Εικόνα 7.5 εμφανίζεται το μενού επιλογών του Photoshop. Τα πιο σημαντικά από αυτά τα μενού είναι: 

 Στο μενού File υπάρχουν οι επιλογές που σχετίζονται με το άνοιγμα και την αποθήκευση των 
αρχείων, την εισαγωγή και εξαγωγή του υλικού σε ειδική μορφή, ρυθμίσεις εκτυπώσεων κ.α. 

 Στο μενού Edit υπάρχουν επιλογές για τυπικές επεξεργασίες, όπως το undo, copy, paste, κ.λπ., 
αλλά και εξειδικευμένες εντολές για εισαγωγή πληροφορίας χρώματος με ειδικό τρόπο (fill, 
stroke), περιστροφή της εικόνας ή επιλεγμένων τμημάτων και άλλες ρυθμίσεις ορισμού ρυθ-
μίσεων από τον χρήστη. 

 Οι επιλογές στο Image είναι αρκετά σημαντικές, γιατί αφορούν στις ρυθμίσεις βάθους χρώ-
ματος και χρωματικού μοντέλου της εικόνας, ζητήματα χρωματικής ισορροπίας της εικόνας 
(πχ. brightness, contrast, κ.α.), ρυθμίσεις του μεγέθους της εικόνας και του καμβά, περικοπή 
της εικόνας, κ.λπ. 

 Το μενού Layer περιλαμβάνει όλες τις ρυθμίσεις που σχετίζονται με τα επίπεδα (layers) και 
τις μάσκες (masks), που είναι βασικές τεχνικές για τη δημιουργία σύνθετων εικόνων. Οι επι-
λογές αφορούν τη δημιουργία των επιπέδων, την επεξεργασία των ιδιοτήτων τους, τη σύ-
μπτυξη επιπέδων κ.ά. 

 Ο κατάλογος επιλογών του Filter περιέχει τα διαθέσιμα φίλτρα του Photoshop, ομαδοποιη-
μένα σε ομάδες. Όπως θα δούμε και στη συνέχεια του κεφαλαίου, μπορούμε να προσθέσουμε 
διάφορα φίλτρα που είτε φτιάχνουμε μόνοι μας είτε βρίσκουμε στο διαδίκτυο. 

 Οι επιλογές στο Window μας βοηθούν να διαμορφώσουμε το περιβάλλον εργασίας, όπως ε-
πιθυμούμε, επιλέγοντας τις παλέτες εργαλείων που θέλουμε να εμφανίζονται στην οθόνη μας. 

 
Οι υπόλοιπες επιλογές του μενού περιέχουν, επίσης, αρκετά χρήσιμες επιλογές, αλλά δεν μπορούμε 

στο πλαίσιο του τρέχοντος κεφαλαίου να τις καλύψουμε όλες και γι’ αυτόν τον λόγο, δεν θα αναφερθούμε σε 
αυτές. 

 

7.1.3. Βασικές επεξεργασίες με το Photoshop 
 
Στην τρέχουσα υποενότητα θα παρουσιάσουμε κάποιες βασικές λειτουργίες του Photoshop, όπως επιλογή 
τμημάτων, περικοπή, αλλαγή μεγέθους, δημιουργία διαφανούς υπόβαθρου κ.λπ. 
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7.1.3.1. Χαρακτηριστικά εικόνας 
 
Μέσω της επιλογής «File > Open» ανοίξτε μια φωτογραφία στο Photoshop. Όταν εμφανιστεί η φωτογραφία 
στο Photoshop, εμφανίζονται ταυτόχρονα και κάποιες πληροφορίες γι’ αυτήν. Στο πάνω μέρος της εικόνας 
(σημεία 1, Εικόνα 7.6) εμφανίζεται το όνομα του αρχείου, το ποσοστό ζουμ (π.χ. 33), το χρωματικό μοντέλο 
(RGB) και το βάθος χρώματος ανά κανάλι (8). Παρατηρούμε ότι το ζουμ είναι στο 33% του κανονικού μεγέ-
θους της εικόνας, που σημαίνει ότι πρακτικά η φωτογραφία είναι μεγάλη. Επιπλέον, στο σημείο 1 εμφανίζε-
ται και το κουμπί x για κλείσιμο του παραθύρου της εικόνας. Αν προσθέσουμε και άλλες εικόνες για επεξερ-
γασία, τότε θα εμφανίζονται οι καρτέλες όλων των εικόνων στο σημείο 1. 

Στο σημείο 2 της Εικόνας 7.6 εμφανίζεται ξανά το ζουμ και εμφανίζεται επιπλέον το μέγεθος της ει-
κόνας. Στο παράδειγμά μας, είναι 9.0 MB. Εμφανίζονται δύο αριθμοί της μορφής «μέγεθος εκτύπωσης / 
πραγματικό μέγεθος». Οι δύο αριθμοί μπορεί να διαφέρουν σε περίπτωση που προσθέσουμε επίπεδα ή εφαρ-
μόσουμε άλλες σύνθετες επιλογές. Ο πρώτος αριθμός (printsize) αντιπροσωπεύει το μέγεθος της εικόνας, αν 
είναι σε επίπεδη κατάσταση χωρίς στρώματα ή πρόσθετα κανάλια. Το πραγματικό μέγεθος περιλαμβάνει το 
πρόσθετο χώρο που η εικόνα χρειάζεται για να αποθηκεύσετε τα επιπλέον δεδομένα, όπως τα επίπεδα. 
 

 
 
Εικόνα 7.6 Εικόνα στο Photoshop. 
 

Με πάτημα των κουμπιών «Ctrl +» και «Ctrl –» μπορούμε να αυξομειώσουμε το ζουμ της εικόνας. 

Το ίδιο μπορούμε να το επιτύχουμε με το εικονίδιο  της εργαλειοθήκης. Με κλικ στο εικονίδιο αυτό, στο 
πάνω μέρος της οθόνης του Photoshop, κάτω από το μενού επιλογών, εμφανίζεται το εργαλείο για αύξηση και 
μείωση του ζουμ της εικόνας. 

Για να εμφανίσουμε τα ακριβή χαρακτηριστικά της φωτογραφίας, πρέπει να επιλέξουμε το μενού 
«Image > Image size». Θα εμφανιστεί το παράθυρο της Εικόνας 7.7, που εμφανίζει το πλάτος και το ύψος 
της εικόνας σε pixels, το πλάτος και το ύψος της εικόνας σε εκατοστά και την ανάλυση (resolution) σε 
pixels/inch (ppi). Παρατηρούμε ότι, στο συγκεκριμένο παράδειγμα, η ανάλυση είναι μόνο 72 ppi, δηλαδή εί-
ναι χαμηλή. Η φωτογραφία είναι μεγάλη σε μέγεθος, οπότε αν θέλουμε να την εκτυπώσουμε με ευκρίνεια, 
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δηλαδή με υψηλότερη ανάλυση, τότε θα πρέπει να μειώσουμε τις φυσικές της διαστάσεις εμφάνισης ή εκτύ-
πωσης. Το συγκεκριμένο θέμα το συζητάμε στην επόμενη άσκηση. 
 

 
 
Εικόνα 7.7 Χαρακτηριστικά εικόνας. 
 

7.1.3.2. Επιλογή και περικοπή 
 

Αν θέλουμε να κάνουμε επιλογή ενός τμήματος της εικόνας, τότε πρέπει να επιλέξουμε το εικονίδιο  και 
έπειτα να επιλέξουμε το τμήμα της φωτογραφίας που θέλουμε. Με αντιγραφή και επικόλληση σε άλλη εικόνα 
ή άλλο επίπεδο, να μεταφέρουμε μόνο το επιλεγμένο τμήμα. 

Αν κάνουμε κλικ στο βέλος στην κάτω δεξιά γωνία του εικονιδίου της επιλογής και το κρατήσουμε 

πατημένο, εμφανίζονται και άλλα εικονίδια για επιλογή, π.χ. . Αν επιλέξουμε το στρογγυλό εργαλείο περι-
κοπής, τότε μπορούμε να επιλέξουμε το τμήμα που μας ενδιαφέρει και να καταλήξουμε στην Εικόνα 7.8. 

Ένας τρόπος για τη δημιουργία της Εικόνας 7.8 είναι: 
1. Επιλογή του κυκλικού τμήματος της εικόνας. 
2. Δεξί κλικ > Select Inverse ή επιλογή του μενού Select > Inverse. Επιλέγεται με αυτό τον τρό-

πο το υπόλοιπο τμήμα της εικόνας. 
3. Έπειτα πατάμε το Delete ή το μενού Edit > Clear, για να διαγραφεί το επιλεγμένο τμήμα και 

να μείνει μόνο το αρχικό κυκλικό τμήμα της εικόνας. 
 

 
 
Εικόνα 7.8 Επιλογή ελειψοειδούς σχήματος της φωτογραφίας.  

 

Η περικοπή (crop) της εικόνας γίνεται και με χρήση του εργαλείου της περικοπής . Κάνουμε κλικ 
στο εργαλείο της περικοπής και έπειτα κλικ στην εικόνα, ώστε να εμφανιστεί ένα πλέγμα, όπως αυτό της Ει-
κόνας 7.9. Προσαρμόζουμε το πλέγμα στο μέγεθος που θέλουμε και έπειτα ξανακάνουμε κλικ στο εργαλείο 
περικοπής και το κουμπί «Crop» στην ερώτηση που εμφανίζεται. Η περικοπή μπορεί να γίνει και με συνδυα-
σμό του εργαλείου της επιλογής και μενού «Image > Crop». 
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Εικόνα 7.9 Περικοπή εικόνας. 

 

7.1.3.3. Απλές χρωματικές προσαρμογές 
 
Το Photoshop παρέχει τη δυνατότητα για αυτόματες χρωματικές διορθώσεις μιας φωτογραφίας, χωρίς να α-
παιτούνται ιδιαίτερες γνώσεις επεξεργασίας εικόνων. Στην Εικόνα 7.10 έχουμε εφαρμόσει κάποιες χρωματι-
κές αλλαγές. Η εικόνα (α) είναι η αρχική, ενώ η (β) έχει προκύψει μέσω της επιλογής «Image > Auto tone», 
ενώ η φωτογραφία (γ) έχει προκύψει μέσω της επιλογής «Image > Auto Color». Η εκδοχή (δ) έχει προκύψει 
μέσω της επιλογής «Image > Adjustments > Black & White».  
 

 
 
Εικόνα 7.10 Απλές χρωματικές προσαρμογές. 

 
Η επιλογή Auto Tone σκουραίνει τα πιο σκούρα εικονοστοιχεία και κάνει πιο ανοιχτόχρωμα τα πιο 

φωτεινά εικονονοστοιχεία. Η επιλογή Auto Color εκτελεί παρόμοιες λειτουργίες, αλλά με πιο ισορροπημένη 
κατανομή των χρωμάτων. Η Auto Color είναι συνήθως καλύτερη επιλογή, γιατί ενισχύει την αντίθεση και την 
επίλυση διόρθωση των χρωματικών προβλημάτων ταυτόχρονα. Φυσικά, το αποτέλεσμα εξαρτάται από τα 
χρώματα της αρχικής εικόνας. 

 
7.1.3.4. Αλλαγή ανάλυσης και μεγέθους εικόνας 

 
Η αλλαγή μεγέθους και ανάλυσης μιας εικόνας γίνεται από το μενού «Image > Image size». Εμφανίζεται το 
μενού της Εικόνας 7.11. Στην αριστερή πλευρά της εικόνας εμφανίζεται το μέγεθος μιας φωτογραφίας με α-
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νάλυση 72 ppi και στη δεξιά πλευρά το μέγεθος της εικόνας ανάλυση 300 ppi. Καταρχήν, πρέπει να παρατη-
ρήσουμε ότι το μέγεθος δεν αυξήθηκε από 20,1 MB σε 348,5 ΜΒ, όταν άλλαξε η ανάλυση. Προφανώς, αυτό 
ισχύει γιατί αυξήθηκε ο συνολικός αριθμός των pixel, αν και οι διαστάσεις της εικόνας σε εκατοστά παρέμει-
ναν οι ίδιες. Η αύξηση της ανάλυσης δεν σημαίνει απαραίτητα πιο ευκρινείς εικόνες κατά την εκτύπωση. Αυ-
τό εξαρτάται από το αρχικό μέγεθος της φωτογραφίας. Στο παράδειγμα που έχουμε στην Εικόνα 7.11, η φω-
τογραφία ήταν περίπου 114,5x76 εκ., δηλαδή μεγάλων διαστάσεων, άρα το αποτέλεσμα θα είναι ικανοποιητι-
κό. 

Στη συγκεκριμένη εικόνα, η αύξηση της ανάλυσης με την επιλογή «Resample Image» ενεργοποιη-
μένη, είχε ως αποτέλεσμα να αλλάξουν τα συνολικά pixels της φωτογραφίας, αλλά οι φυσικές διαστάσεις πα-
ρέμειναν ίδιες, δηλ. 114,5x76 εκ. Ουσιαστικά το Resample (επαναδειγματοληψία) σημαίνει αλλαγή του αριθ-
μού των pixels της εικόνας. Γι’ αυτό το λόγο, το μέγεθος της φωτογραφίας αυξήθηκε. 
 

 
 
Εικόνα 7.11 Αλλαγή ανάλυσης με επιλεγμένο το Resample Image. 

 
Στην Εικόνα 7.12 έχει γίνει αλλαγή της ανάλυσης, χωρίς την επιλογή «Resample Image» ενεργοποι-

ημένη. Αυτό έχει ως αποτέλεσμα να μην αλλάξουν τα συνολικά pixels και κατά συνέπεια, το μέγεθος της ει-
κόνας. Άλλαξαν όμως, όπως βλέπουμε, οι φυσικές διαστάσεις της φωτογραφίας. Αυτό συνέβη, διότι ουσια-
στικά κρατήσαμε σταθερό των αριθμό των pixels, αλλά ταυτόχρονα απαιτήσαμε περισσότερα pixels ανά ί-
ντσα. Είναι, συνεπώς, λογικό ότι θα μειωθούν οι διαστάσεις της εικόνας. Όταν η επιλογή «Resample Image» 
δεν είναι ενεργοποιημένη, τότε δεν είναι ενεργοποιημένο και το πλαίσιο «Pixel Dimensions», απ’ όπου μπο-
ρούμε να αλλάξουμε τα pixels ανά διάσταση. 

 

 
 
Εικόνα 7.12 Αλλαγή ανάλυσης χωρίς να είναι επιλεγμένο το Resample Image. 

 
Η ανάλυση των 300 ppi είναι απαραίτητη για την ευκρινή εκτύπωση της φωτογραφίας. Εδώ όμως, 

πρέπει να προσέξουμε ότι, αν ταυτόχρονα κάνουμε και Resample, τότε ο υπολογιστής προσθέτει επιπλέον 
pixels, μεταξύ των ήδη υπαρχόντων, με αποτέλεσμα να μην είναι σίγουρα ευκρινές το τελικό αποτέλεσμα. Αν 
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η φωτογραφία έχει μεγάλο μέγεθος, όπως στο παράδειγμά μας, και θέλουμε να αλλάξουμε την ανάλυσή της, 
τότε καλύτερα είναι να αλλάξουμε την ανάλυση, χωρίς να κάνουμε Resample και να προσαρμόσουμε τις δια-
στάσεις της φωτογραφίας σε κάποιο μικρότερο μέγεθος. Σε περίπτωση που η εικόνα είναι μικρών διαστάσεων 
και μικρής ανάλυσης, τότε πρέπει να κάνουμε και Resample, αν θέλουμε να αυξήσουμε την ανάλυση. Φυσι-
κά, το τελικό αποτέλεσμα πιθανώς να είναι κάπως θολό. Τα παραπάνω ισχύουν και αν θέλουμε να αλλάξουμε 
τις διαστάσεις της φωτογραφίας, χωρίς να αλλάξει η ανάλυση.  

Η επιλογή «Scale Styles» σχετίζεται με την αλλαγή κλίμακας όλων των επιπέδων που έχει μια εικό-
να, ενώ η επιλογή «Constrain Proportions» αφορά τη διατήρηση αναλογιών των διαστάσεων της εικόνας. 

 

7.1.3.5. Αύξηση μεγέθους καμβά 
 
Ο καμβάς (canvas) είναι η περιοχή σχεδίασης της εικόνας. Μπορούμε να αυξήσουμε το μέγεθος του καμβά, 
χωρίς να αυξήσουμε το μέγεθος των σχεδίων της εικόνας, για να προσθέσουμε νέα σχέδια. Μέσω της επιλο-
γής «Image > Canvas size» εμφανίζεται το αριστερό παράθυρο της Εικόνας 7.13.  
 

 
 
Εικόνα 7.13 Παράθυρο αλλαγής μεγέθους canva. 

 
Η αύξηση μπορεί να γίνει ομοιόμορφα προς όλες τις κατευθύνσεις, όπως φαίνεται στην αριστερή 

πλευρά της Εικόνας 7.13. Αν θέλουμε να μεγαλώσουμε το μέγεθος του καμβά προς μία κατεύθυνση, τότε 
πρέπει να κάνουμε κλικ σε κάποιο κουτάκι για να μεταφερθεί η μαύρη κουκκίδα εκεί και τα βελάκια να δεί-
χνουν προς την κατεύθυνση αύξησης, όπως στη δεξιά πλευρά της Εικόνας 7.13. 

 
7.1.3.6. Δημιουργία νέα εικόνας 
 
Αν θέλουμε να δημιουργήσουμε μια νέα εικόνα στο Photoshop, τότε επιλέγουμε «File > New».  

 

 
 
Εικόνα 7.14 Παράθυρο δημιουργίας νέας εικόνας στο Photoshop. 
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Στην Εικόνα 7.14 εμφανίζεται το παράθυρο δημιουργίας νέας εικόνας. Aν πρόκειται να δημιουργή-
σουμε μια νέα εικόνα με βάση το πρόχειρο (clipboard), τότε πρέπει στο «Preset» να επιλέξουμε 
«Clipboard». Γενικά, όπως βλέπουμε μπορούμε να ορίσουμε τις διαστάσεις της εικόνας, την ανάλυση, το 
χρωματικό μοντέλο, το βάθος χρώματος και το αν θα είναι διαφανές το υπόβαθρο. 

Αν θέλουμε να φτιάξουμε μια σύνθετη εικόνα, η οποία στη συνέχεια θα εκτυπωθεί, πρέπει να τη 
φτιάξουμε με ανάλυση 300 ppi ή ακόμη και υψηλότερη ανάλυση. Γενικά, πρέπει να χρησιμοποιούμε υψηλή 
ανάλυση κατά τη δημιουργία νέων εικόνων και αν έπειτα τη χρησιμοποιήσουμε για προβολή σε υπολογιστή 
μόνο, τότε απλά θα κάνουμε μείωση της ανάλυσης και αποθήκευση ως μια νέα εικόνα. 
 

7.1.3.7. Δημιουργία διαφανούς εικόνας 
 
Έστω ότι έχουμε μια φωτογραφία, όπως αυτή της Εικόνας 7.15. Υπάρχουν διάφοροι τρόποι να διαγράψουμε 
το υπόβαθρο και να δημιουργήσουμε μια εικόνα με διαφάνεια. Στο συγκεκριμένο παράδειγμα, θα πρέπει να 
αποθηκεύσουμε πρώτα την εικόνα σε μορφή PNG που υποστηρίζει διαφάνεια. Έπειτα, θα πρέπει να κάνουμε 

κλικ στην εικόνα με τη χρήση του εργαλείου «Magic Wand Tool» . Αν το εικονίδιο του εργαλείου δεν 

είναι ορατό, τότε πρέπει να κάνετε κλικ στο εικονίδιο «Quick Selection Tool» .  
Αφού επιλεχθεί το εργαλείο «Magic Wand Tool», πρέπει να γίνει κλικ στο κίτρινο χρώμα της εικό-

νας, ώστε να επιλεχθεί (Εικόνα 7.16). Στη συνέχεια, κάνουμε κλικ στο Delete από το πληκτρολόγιο, ώστε να 
διαγραφεί το κίτρινο χρώμα (Εικόνα 7.17). Αν έχουν μείνει τμήματα με κίτρινο χρώμα, πρέπει να τα επιλέξε-
τε πάλι με το «Magic Wand Tool» και να τα διαγράψετε. Κατά την επιλογή του υπόβαθρου, πρέπει να είναι 
τσεκαρισμένο το πλαίσιο «Contigious», στις επιλογές του εργαλείου, στο πάνω μέρος του Photoshop, ώστε να 
μην επιλεγούν τα κίτρινα τμήματα των χαρακτήρων. 
 

 
 
Εικόνα 7.15 Αρχική εικόνα. 

 

 
 
Εικόνα 7.16 Επιλεγμένο το κίτρινο υπόβαθρο. 
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Εικόνα 7.17 Εικόνα με διαφανές υπόβαθρο. 
 

7.1.3.8. Περιστροφή εικόνας, παραμόρφωση και αλλαγή κλίμακας 
 
Μέσω της επιλογής «Image > Image Rotation» μπορούμε να περιστρέψουμε την εικόνα. Η Εικόνα 7.14 έχει 
αναστραφεί οριζόντια με την επιλογή «Flip Canvas Horizontal». Οι επιλογές για περιστροφή εικόνας υπάρ-
χουν και στο μενού «Edit > Transform». 

 

 
 
Εικόνα 7.18 Οριζόντια αναστροφή εικόνας. 

 

 
 
Εικόνα 7.18 Παραμόρφωση εικόνας. 
 

Μέσα από το μενού «Edit > Transform» μπορούμε να κάνουμε και άλλες δυνατότητες παραμόρφω-
σης της εικόνας. Για παράδειγμα, μέσω της επιλογής «Edit > Transform > Skew» μπορούμε να τροποποιή-
σουμε την εικόνα τραβώντας τα άκρα του τετραγώνου που εμφανίζεται. Όταν ολοκληρώσουμε με τις επιθυ-

μητές αλλαγές κάνουμε κλικ στο εργαλείο  και να επιλέξουμε Apply στο ερώτημα που θα μας τεθεί. Υ-
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πάρχουν και άλλες επιλογές στο συγκεκριμένο, με τις οποίες μπορούμε να πειραματιστούμε, ώστε να αλλά-
ξουμε την όψη και την κλίμακα της εικόνας. 

 

7.1.4. Εισαγωγή στη χρήση επιπέδων στο Photoshop 
 
Τα επίπεδα ή στρώματα (layers) είναι μια ακολουθία ανεξαρτήτων εικόνων, σχημάτων, κειμένου κ.ά., οι ο-
ποίες δημιουργούν την τελική σύνθεση με υπέρθεση των επιμέρους αντικειμένων. Το βασικό πλεονέκτημα 
της χρήσης στρωμάτων, είναι ότι τα επιμέρους στοιχεία της εικόνας μπορούν να χρησιμοποιηθούν και να επε-
ξεργαστούν ανεξάρτητα και μεμονωμένα, καθώς αποτελούν ξεχωριστά αντικείμενα. Τα έργα που αποτελού-
νται από επίπεδα πρέπει να αποθηκευτούν ως αρχεία PSD, αν και οποιαδήποτε χρονική στιγμή το έργο μπορεί 
να αποθηκευτεί σε οποιαδήποτε άλλη μορφή.  

Στην Εικόνα 7.19 εμφανίζονται κάποια από τα layers ενός έργου. Δίπλα από το όνομα κάθε επιπέδου 
υπάρχει ένα «μάτι» για εμφάνιση/απόκρυψη του επιπέδου. Το Opacity αναφέρεται στην αδιαφάνεια ενός επι-
πέδου. Όσο μειώνουμε το ποσοστό, τόσο μειώνουμε την αδιαφάνεια, άρα αυξάνουμε τη διαφάνεια του επιπέ-
δου. Στο κάτω μέρος της καρτέλας υπάρχουν κάποια εικονίδια για δημιουργία νέου επιπέδου, διαγραφή, ομα-
δοποίηση κ.ά. των επιπέδων. 

 

 
 
Εικόνα 7.19 Καρτέλα layers. 

 

7.1.4.1. Δημιουργία, μετονομασία, μετακίνηση επιπέδου 
 
Η προσθήκη ενός επιπέδου σε μια εικόνα γίνεται με το μενού «Layer > New > Layer». Στην καρτέλα των 
layers θα εμφανίζονται τα επίπεδα, π.χ. η αρχική Εικόνα με όνομα «Background» και το νέο επίπεδο με 

«Layer 1». Η δημιουργία νέου layer γίνεται και με το εικονίδιο «Create a new layer»  στο κάτω μέρος της 
καρτέλας των layers. 

Για να μετονομάσουμε το επίπεδο πρέπει να κάνουμε διπλό κλικ στο όνομα του «Layer 1» και να 
δώσουμε νέο όνομα. Αυτό μας βοηθά να διαχειριστούμε καλύτερα τα επίπεδα σε σύνθετα έργα. Η μετακίνη-
ση ενός επιπέδου γίνεται με κλικ στο όνομά του και σύρσιμο του επιπέδου στη θέση που θέλουμε. 
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7.1.4.2. Δημιουργία απλού έργου με χρήση επιπέδων 

 
Έστω ότι έχουμε μια φωτογραφία πάνω στην οποία θέλουμε να βάλουμε και ένα κείμενο (Εικόνα 7.20), αλλά 
επιθυμούμε να το έχουμε σε ξεχωριστό επίπεδο, για να μπορούμε να το αλλάζουμε, όποτε θέλουμε. Το κείμε-
νο θέλουμε να είναι πάνω σε κάποιο ημιδιαφανές ορθογώνιο. Παρατηρούμε στην Εικόνα 7.20 ότι και το ορ-
θογώνια και το πλαίσιο έχουν περιστραφεί. Στην Εικόνα 7.21 εμφανίζονται τα επίπεδα της σύνθετης φωτο-
γραφίας. 

Τα βήματα για τη δημιουργία της Εικόνας 7.20 είναι: 
1. Άνοιγμα της αρχικής φωτογραφίας με το τοπίο. 
2. Προσθήκη ενός νέου επιπέδου με την επιλογή «Layer > New > Layer». 
3. Στο νέο επίπεδο πρέπει να προσθέσουμε ένα ορθογώνιο με χρήση του εργαλείου «Rectangle 

Tool» .  
o Μπορούμε να επιλέξουμε το χρώμα που μας ενδιαφέρει με κλικ στο πλαίσιο Fill στο 

πάνω μέρος της οθόνης, κάτω από το μενού. Εναλλακτικά, μπορούμε να κάνουμε 

κλικ στο εργαλείο «Set foreground color»  στην εργαλειοθήκη. Αφού επιλέξουμε 

το χρώμα που θέλουμε, μπορούμε να επιλέξουμε το «Paint Bucket Tool»  και να 
κάνουμε κλικ στο ορθογώνιο για να αλλάξει το χρώμα. Το εργαλείο «Paint Bucket 
Tool» ίσως να μην είναι ορατό, οπότε βρίσκεται κάτω από την ομάδα εργαλείων 

«Gradient Tool» . Σε αυτή την περίπτωση θα μας ζητηθεί να μετατραπεί από δια-
νυσματική μορφή σε ψηφιαγραφική μορφή (rasterize) το ορθογώνιο. 

o Μπορούμε να μειώσουμε το ποσοστό του Opacity σε 50%, για να αυξηθεί η διαφά-
νεια του επιπέδου. 

o Για την περιστροφή του ορθογωνίου, πρέπει να πάμε στην επιλογή «Edit > 
Transform Path > Rotate». Όταν γίνει περιστροφή, τότε κάνουμε κλικ στο εργαλείο 

 και επιλέγουμε Apply στο ερώτημα. 
4. Προσθήκη ενός νέου επιπέδου και προσθήκη κείμενου με χρήση του εργαλείου «Horizontal 

Type Tool» . Όταν επιλεχθεί το εργαλείο, κάτω από το μενού, εμφανίζονται οι επιλογές 
μορφοποίησης του κειμένου. 

o Για την περιστροφή του πλαισίου του κειμένου, πρέπει να πάμε στην επιλογή «Edit 
> Transform Path > Rotate». 

 

 
 
Εικόνα 7.20 Εικόνα με 3 επίπεδα. 

 
Το έργο μας πρέπει να αποθηκευτεί ως αρχείο PSD για να μπορούμε και στο μέλλον να το τροπο-

ποιήσουμε. Αν θέλουμε να δημοσιεύσουμε την εικόνα στο διαδίκτυο ή να την χρησιμοποιήσουμε μόνο σε 
ηλεκτρονικά μέσα, πρέπει να την αποθηκεύσουμε επιπρόσθετα ως PNG ή JPG. Έπειτα πρέπει να ανοίξουμε 
την εικόνα και να μειώσουμε την ανάλυση σε 72 ppi ή 96 ppi, ώστε να μειωθεί το μέγεθός της. Εναλλακτικά, 
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μπορούμε να χρησιμοποιήσουμε την επιλογή «File > Save for Web» και με ρύθμιση των παραμέτρων να πα-
ράγουμε την εικόνα με τα επιθυμητά χαρακτηριστικά. 

 

 
 
Εικόνα 7.21 Παλέτα επιπέδων. 

 

7.1.5. Διορθώσεις τόνων και αποχρώσεων 
 
Στη συγκεκριμένη ενότητα θα μελετήσουμε πώς μπορούμε να κάνουμε πιο σύνθετες χρωματικές αλλαγές σε 
φωτογραφίες. Θα μελετήσουμε τις κυριότερες επιλογές του μενού «Image > Adjustments», αν και στο συ-
γκεκριμένο μενού υπάρχουν και άλλες με τις οποίες μπορείτε να πειραματιστείτε, όταν θέλετε να διορθώσετε 
μια φωτογραφία, ώστε να φτάσετε στο επιθυμητό αποτέλεσμα. 

 
7.1.5.1. Προσαρμογή φωτεινότητας και αντίθεσης 
 
Μέσω της επιλογής «Image > Adjustments > Brightness/Contrast» μπορούμε να αυξομειώσουμε τη φωτει-
νότητα (brightness) και την αντίθεση (contrast) των χρωμάτων μιας φωτογραφίας. Οι φωτογραφίες της Εικό-
νας 7.23 προέκυψαν με προσαρμογή φωτεινότητας/αντίθεσης της αρχικής σκοτεινής φωτογραφίας της Εικό-
νας 7.22. Στην Εικόνα 7.23α έχει αυξηθεί η φωτεινότητα μόνο, ενώ η αντίθεση δεν έχει αλλάξει.  

 

 
 
Εικόνα 7.22 Αρχική σκοτεινή φωτογραφία. 

 
Παρατηρούμε ότι στη δεύτερη εικόνα ο ουρανός δείχνει σχεδόν άσπρος. Θα πρέπει να λάβουμε υπό-

ψη ότι το γαλάζιο του ουρανού σχεδόν εξαφανίστηκε. Στην εκτύπωση, αυτοί οι ελάχιστοι τόνοι γαλάζιου 
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μπορεί να μην εκτυπώνονται, με αποτέλεσμα να δείχνει η εικόνα αφύσικη. Με πειραματισμό, μπορούμε να 
διορθώσουμε καλύτερα την φωτογραφία. 
 

 
 
Εικόνα 7.23 (α) Φωτεινότητα: 40, αντίθεση: -40 (β) Φωτεινότητα: 70, αντίθεση: 0 

 

7.1.5.2. Χρωματικές διορθώσεις με χρήση της επιλογής Levels 
 
Στη φωτογραφία της Εικόνας 7.24 οι κορμοί των δέντρων είναι σχεδόν μαύροι, οπότε η φωτογραφία πρέπει 
να διορθωθεί. Αν χρησιμοποιήσουμε επιλογές που είδαμε σε προηγούμενα θέματα (π.χ. Auto Tone στο θέμα 
1.3.3 ή Φωτεινότητα και αντίθεση στο προηγούμενο θέμα), δεν θα πετύχουμε το επιθυμητό αποτέλεσμα, που 
είναι να διορθωθούν οι κορμοί, αλλά το υπόλοιπο τμήμα της φωτογραφίας να μην αλλάξει. Με την επιλογή 
«Image > Adjustments > Levels» μπορούμε να κάνουμε πιο λεπτές παρεμβάσεις σε ενδιάμεσους τόνους, 
ανταύγειες και σκιές στη φωτογραφία μας.  

 

 
 
Εικόνα 7.24 Αρχική φωτογραφία, όπου οι κορμοί δέντρων είναι σχεδόν μαύροι. 
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Εικόνα 7.25 Ρύθμιση των χρωματικών επιπέδων της φωτογραφίας. 

 

 
 
Εικόνα 7.26 Τελική εικόνα που προέκυψε από την φωτογραφία 7.24, μετά τις παρεμβάσεις στην επιλογή Levels. 

 
7.1.5.3. Χρωματικές διορθώσεις με χρήση της επιλογής Shadows/Highlights 
 
Οι σκιές και οι ανταύγειες μπορούν να διορθωθούν και μέσω της επιλογής «Image > Adjustments > 
Shadows/Highlights». Έχοντας ως αρχική φωτογραφία την Εικόνα 7.24, μπορούμε να καταλήξουμε στην 
Εικόνα 7.27. Στην Εικόνα 7.28 φαίνονται οι ρυθμίσεις που χρησιμοποιήσαμε. 

Από τα δύο τελευταία παραδείγματα, προκύπτει ότι οι παρεμβάσεις μέσω της επιλογής 
«Shadow/Highlights», έχει καλύτερα αποτελέσματα από την επιλογή «Levels» στη συγκεκριμένη φωτογρα-
φία. Σε άλλες φωτογραφίες, ίσως να αποδίδει καλύτερα η προηγούμενη τεχνική. 

 

7.1.5.4. Αύξηση χρωματικής έντασης με την επιλογή Vibrance 
 
Μέσω της επιλογής «Image > Adjustments > Vibrance» μπορούμε να αυξήσουμε ή να μειώσουμε τη χρω-
ματική ένταση (κορεσμό) μιας εικόνας, χωρίς τα χρώματα να μοιάζουν αφύσικα. Όπως έχουμε δει στο κεφά-
λαιο 2, ο κορεσμός (saturation) είναι η καθαρότητα ή ένταση του χρώματος και αναφέρεται στο βαθμό απου-
σίας του λευκού φωτός από ένα χρώμα. Η αύξηση του Saturation αυξάνει γενικά όλη την εικόνα με λιγότερο 
φυσικό τρόπο, ενώ το Vibrance έχει πιο στοχευμένη βελτίωση των χρωμάτων. 
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Εικόνα 7.27 Τελική εικόνα που προέκυψε από την φωτογραφία 7.24, μετά τις παρεμβάσεις στην επιλογή 
Shadows/Highlights. 

 

 
 
Εικόνα 7.28 Παράθυρο ρυθμίσεων Shadows/Highlights. 

 
Έστω ότι θέλουμε να κάνουμε πιο έντονο το χρώμα της τούρτας της Εικόνας 7.29. Για να προκύψει η 

Εικόνα 7.30α αυξάνουμε το Vibrance στο παράθυρο που θα εμφανιστεί μέσω της επιλογής «Image > 
Adjustments > Vibrance». Για την Εικόνα 7.30β αυξήσαμε και το Saturation και έγιναν πιο έντονα τα χρώμα-
τα της τούρτας. Όμως, έχουν επηρεαστεί και άλλα αντικείμενα της φωτογραφίας, π.χ. τα γλυκά απέκτησαν 
μια κόκκινη αφύσικη γραμμή περιγράμματος, η οποία θα είναι εμφανής αν τυπώσουμε τη φωτογραφία σε 
μεγάλες διαστάσεις.  
  

 
 
Εικόνα 7.29 Αρχική εικόνα. 
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Εικόνα 7.30 Φωτογραφίες με πιο έντονο το ροζ χρώμα. (α) Vibrance: 100 (β) Vibrance: 100, Saturation: 50.  

 

7.1.5.5. Χρωματικές αλλαγές μέσω Hue, Saturation, Brightness 
 
Όπως έχουμε δει στο κεφάλαιο 2, οι Hue, Saturation, Brightness είναι, αντίστοιχα, οι συνιστώσες Απόχρωση ή 
Χροιά, Κορεσμός ή Χρωματική καθαρότητα και Φωτεινότητα. Η αλλαγή των συνιστωσών αυτών γίνεται από 
την επιλογή «Image > Adjustments > Hue/Saturation». Έχοντας ως αρχική Εικόνα την 7.31α, καταλήξαμε 
στις 7.31β και 7.31γ με αύξηση και μείωση της τιμής της χροιάς, αντίστοιχα. 

 

 
[Πηγή αρχικής εικόνας: http://goo.gl/8kx8XQ] 

 
Εικόνα 7.31 Οι φωτογραφίες (β) και (γ) προέκυψαν με αλλαγή της χροιάς (hue) της πρώτης φωτογραφίας. 

 
7.1.5.6. Αντικατάσταση συγκεκριμένων χρωμάτων 
 
Έστω ότι έχουμε μια φωτογραφία όπως αυτή της Εικόνας 7.32. Θέλουμε να αλλάξουμε το χρώμα των μπου-
μπουκιών, χωρίς όμως να αλλάξουμε το χρώμα των φύλλων. Ένας τρόπος είναι μέσω του μενού «Image > 
Adjustments > Replace Color». Εμφανίζεται το παράθυρο της Εικόνας 7.33. 

Κάνουμε κλικ στο εργαλείο «Eyedropper Tool»  στο σημείο 1 της Εικόνας 7.33 και κάνουμε 
κλικ στην Εικόνα μας σε κάποιο κόκκινο μπουμπούκι. Το εργαλείο αυτό επιλέγει το χρώμα που υπάρχει στο 
σημείο που κάναμε κλικ. Στο σημείο 2, εμφανίζεται η απόχρωση που έχουμε επιλέξει. Με τον ολισθητή στο 
σημείο 3 της Εικόνας 7.33 μπορούμε να αυξήσουμε τη συνάφεια των χρωμάτων που θα επηρεαστούν από τις 
αλλαγές. Αυξάνοντας τη συγκεκριμένη τιμή, οι αλλαγές θα επηρεάσουν και το συγκεκριμένο χρώμα που επι-
λέξαμε, αλλά και αρκετές κοντινές αποχρώσεις του κόκκινου. Στο σημείο 4, μπορούμε να επιλέξουμε το 
χρώμα που μας ενδιαφέρει και να πειραματιστούμε με την απόχρωση, τον κορεσμό και τη φωτεινότητα. 
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[Πηγή: http://goo.gl/kXHQN5] 

 
Εικόνα 7.32 Αρχική εικόνα. 

 

 
 

Εικόνα 7.33 Παράθυρο Color Balance. 

 
Παρατηρούμε στην Εικόνα 7.34α ότι οι αλλαγές στο κόκκινο είναι μικρές και προφανώς δεν μας ικα-

νοποιούν. Μπορούμε να βελτιώσουμε την κατάσταση, αυξάνοντας την τιμή στο Fuzziness, όπως κάναμε στην 
Εικόνα 7.34β. Όπως διαπιστώνουμε, η κατάσταση έχει βελτιωθεί σχετικά, αν και υπάρχουν κάποιες αποχρώ-
σεις του κόκκινου μέσα στα τριαντάφυλλα. Πριν δούμε πώς μπορεί να βελτιωθεί περαιτέρω η φωτογραφία, 
θα πρέπει να σημειωθεί ότι η μεγάλη αύξηση του Fuzziness μπορεί να δημιουργήσει αρκετά προβλήματα σε 
φωτογραφίες που έχουν παρόμοια χρώματα. Στο παράδειγμα που εργαζόμαστε, έχουμε μεγάλες διαφορές στα 
χρώματα (αποχρώσεις του κόκκινου και του πράσινου) και συνεπώς δεν δημιουργείται πρόβλημα. Σε άλλες 
περιπτώσεις, η μεγάλη αύξηση του Fuzziness θα άλλαζε και χρώματα που δεν επιθυμούμε. 

Γενικά, δεν αυξάνουμε πολύ το Fuzziness όταν χρησιμοποιούμε τη συγκεκριμένη τεχνική, αλλά χρη-

σιμοποιούμε το εργαλείο «Add to Sample»   στο σημείο 5 της Εικόνας 7.33. Το εικονίδιο αυτό μοιάζει με 
το «Eyedropper Tool» και χρησιμεύει στο να προσθέσουμε και άλλα χρώματα που θέλουμε να επηρεαστούν 
από την αλλαγή. Στο παράδειγμά μας, λοιπόν, αντί να αυξήσουμε το Fuzziness υπερβολικά, θα μπορούσαμε 
να κάνουμε κλικ στο εργαλείο «Add to Sample» και να κάνουμε κλικ σε περιοχές που είναι κόκκινες, ώστε να 
αλλάξουν και αυτές. Η διαδικασία μπορεί να γίνει πολλές φορές, ώστε να φτάσουμε στο επιθυμητό αποτέλε-
σμα. 

Τέλος, πρέπει να σημειώσουμε ότι η αλλαγή μεμονωμένων χρωμάτων στο Photoshop γίνεται και με 

άλλες τεχνικές, όπως, για παράδειγμα το «Color Replacement Tool»  ή την επιλογή «Layer > New 
Adjustment Layer > Selective Color». 
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Εικόνα 7.34 (α) Αλλαγή χρώματος με τιμή Fuzziness 40. (α) Αλλαγή χρώματος με τιμή Fuzziness 150. 

 

7.1.6. Φίλτρα 
 
Το Photoshop διαθέτει ένα σύνολο από φίλτρα που χρησιμοποιούνται για τη βελτίωση εικόνων και την από-
δοση διαφόρων καλλιτεχνικών εφέ. Το Photoshop περιέχει αρκετά φίλτρα, που βρίσκονται στο μενού 
«Filter». Η εφαρμογή κάποιου φίλτρου μπορεί να γίνει σε ολόκληρη τη φωτογραφία ή σε κάποιο τμήμα της, 

αν το επιλέξουμε με κάποιο από τα εργαλεία επιλογής, π.χ.  ή  ή  κ.ά. Επίσης, σε σύνθετα έργα με 
πολλά επίπεδα, μπορούμε να εφαρμόσουμε διαφορετικά φίλτρα σε κάθε επίπεδο, δημιουργώντας έτσι εντυ-
πωσιακά αποτελέσματα. Στην Εικόνα 7.35 βλέπουμε την εφαρμογή του φίλτρου Ripple (κυματισμός) μέσω 
της επιλογής «Filter > Distort > Ripple» που μετατρέπει τη φωτογραφία σε μορφή ζωγραφιάς. Στην αρχή 
του κεφαλαίου, στην Εικόνα 7.2, είδαμε το αποτέλεσμα των φίλτρων Trace Contour και Find Edges. Και τα 
δύο φίλτρα βρίσκονται κάτω από το μενού «Filter > Stylize». 

 

 
 

Εικόνα 7.35 Εφαρμογή του φίλτρου Ripple στη φωτογραφία 7.32. 

 
Η Εικόνα 7.36 έχει προκύψει με εφαρμογή του φίλτρου «Plastic Wrap». Αρχικά, αλλάξαμε τα χρώ-

ματα της φωτογραφίας με χρήση της επιλογής «Color Replace» που μελετήσαμε πιο πάνω, στην υποενότητα 
1.5.6. 
 

 
 

Εικόνα 7.36 Εφαρμογή του φίλτρου Plastic Wrap στη φωτογραφία 7.32. 
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Με το μενού «Filter > Filter Gallery» ανοίγει το παράθυρο που εμφανίζεται στην Εικόνα 7.37. Πα-
ρατηρούμε ότι υπάρχουν αρκετά φίλτρα που μπορούμε να εφαρμόσουμε και να βλέπουμε απευθείας το απο-
τέλεσμα πριν εφαρμόσουμε το φίλτρο. Στην Εικόνα 7.38 βλέπουμε το αποτέλεσμα κάποιων φίλτρων. 

 

 
 

Εικόνα 7.37 Συλλογή φίλτρων αι προεπισκόπηση. 
 
 

 
 

Εικόνα 7.38 (a) Αρχική εικόνα (β) Εφαρμογή φίλτρου Colored Pencil (γ) Εφαρμογή φίλτρου Watercolor. 
 
Η διαδοχική εφαρμογή φίλτρων σε μια εικόνα μπορεί να οδηγήσει στη δημιουργία ελκυστικών σχε-

δίων. Στην Εικόνα 7.39 έχουμε εφαρμόσει πέντε φίλτρα και φτάσαμε από το αρχικό ορθογώνιο με το ίδιο 
χρώματα.  

 

 
 

Εικόνα 7.39 (α) Αρχική εικόνα (β) Φίλτρο Pointillize (γ) Φίλτρο Gaussian Blur (δ) Φίλτρο Stained Glass (ε) Φίλτρο 
Crosshatch (ζ) Φίλτρο Sponge 

 

7.1.7. Διαχωρισμός αντικειμένου από το υπόβαθρο 
 
 Ο διαχωρισμός ενός αντικειμένου από το υπόβαθρο (background) μια φωτογραφίας ή η διαγραφή του υπό-
βαθρου, είναι ένα θέμα που γίνεται με διαφορετικούς τρόπους στο Photoshop. Η τεχνική που θα χρησιμοποι-
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ηθεί εξαρτάται από τα χρώματα της αρχικής φωτογραφίας και την αντίθεσή τους. Στην υποενότητα 1.3.6 εί-

δαμε έναν από αυτούς του τρόπους με τη χρήση του εργαλείου «Magic Wand Tool» , που αφορά όμως 
εικόνες με υπόβαθρο με το ίδιο περίπου χρώμα. Στη συνέχεια, περιγράφουμε κάποιες από τις τεχνικές που 
αφορούν σε πιο σύνθετες εικόνες. 
 
7.1.7.1. Διαγραφή υπόβαθρου 
 
Στην περίπτωση που το υπόβαθρο έχει μεγάλη αντίθεση από το προσκήνιο, τότε μπορούμε να χρησιμοποιή-

σουμε το εικονίδιο «Background Eraser Tool»  από την εργαλειοθήκη. Αν δεν είναι ορατό το εργαλείο, 

τότε πρέπει να το αναζητήσετε κάτω από το εργαλείο «Eraser Tool» . Όταν επιλέξουμε το εργαλείο 
«Background Eraser Tool», εμφανίζονται οι επιλογές του εργαλείου (Εικόνα 7.41): 

 Με την πρώτη επιλογή μπορούμε να επιλέξουμε το μέγεθος του δρομέα, δηλαδή του κύκλου 
που εμφανίζεται για τη διαγραφή. Στο παράδειγμά μας έχει τεθεί στο 115, αρκετά μεγάλο δη-
λαδή, αλλά μας επιτρέπεται στη συγκεκριμένη εικόνα, λόγω των αντιθέσεων στα χρώματα. 

 Στο πλαίσιο «Limits» εμφανίζεται η επιλογή «Contiguous». Η συγκεκριμένη επιλογή δείχνει 
ότι τελικά διαγράφονται χρώματα μόνο σε περίπτωση που υπάρχουν σε συνεχόμενα pixels. Η 
επιλογή «Discontiguous» εξυπηρετεί όταν παρεμβάλλονται και άλλα αντικείμενα που δεν θέ-
λουμε να διαγράψουμε.  

 Με την επιλογή «Tolerance» καθορίζουμε τις αποχρώσεις που θα διαγράφονται σε σχέση με το 
αρχικό χρώμα που επιλέξαμε, όταν κάναμε κλικ στη φωτογραφία για να αρχίσουμε να διαγρά-
φουμε. Σε εικόνες, όπως η συγκεκριμένη που επεξεργαζόμαστε, μπορούμε να βάλουμε μεγάλη 
τιμή στο Tolerance, ακόμη και 100%, ώστε να διαγράφονται όλες οι αποχρώσεις του γαλάζιου, 
για παράδειγμα. 

 

 
 

Εικόνα 7.40 Διαγραφή υπόβαθρου με χρήση του εργαλείου «Background Eraser Tool». 

 
 

 
 

Εικόνα 7.41 Επιλογές εργαλείου «Background Eraser Tool». 

 
Στην τελική φωτογραφία (Εικόνα 7.42) εμφανίζεται το βουνό χωρίς τον ουρανό και μπορούμε πλέον 

να το συνδυάσουμε με χρήση επιπέδων (layers) με άλλες εικόνες. 
 

 
 

Εικόνα 7.42 Τελική φωτογραφία χωρίς το υπόβαθρο. 
 

7.1.7.2. Διαχωρισμός αντικειμένου με το εργαλείο Free Pen Tool 
 
Η παραπάνω τεχνική δεν μπορεί να εφαρμοστεί πρακτικά στην ακόλουθη φωτογραφία (Εικόνα 7.43), γιατί οι 
αποχρώσεις της αλεπούς και του υπόβαθρου είναι κοντινές. Άρα, όταν θα διαγράφουμε κάποιο τμήμα του 
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background, θα διαγράφεται και τμήμα της αλεπούς. Εδώ μπορούμε να χρησιμοποιήσουμε  το εργαλείο 

«Freeform Pen Tool» . Αν δεν εμφανίζεται απευθείας, τότε πρέπει να επιλέξετε το εργαλείο «Pen Tool» 

.  
Αφού επιλέξουμε το εργαλείο «Freeform Pen Tool», στις επιλογές του εργαλείου, στην πάνω αριστε-

ρή πλευρά, κάτω από το μενού, πρέπει να επιλεχθεί «Paths», αν εμφανίζεται «Shape» ή «Pixels». Στη συνέ-
χεια, πρέπει να σύρουμε αργά και σταθερά το ποντίκι γύρω από την αλεπού, έχοντας πατημένο το αριστερό 
κουμπί του ποντικιού σας. Όταν «κυκλώσουμε» την περίμετρο της αλεπούς, τότε ελευθερώνουμε το κουμπί 
του ποντικιού. Η εικόνα που θα εμφανιστεί, είναι παρόμοια με την Εικόνα 7.44.  

 

 
[Πηγή: http://goo.gl/2glErU]  

 
Εικόνα 7.43 Αρχική φωτογραφία στην οποία το προσκήνιο και το υπόβαθρο έχουν κοντινές αποχρώσεις. 

 
 

 
 

Εικόνα 7.44 Εικόνα όπου έχει επιλεχθεί η περίμετρος της αλεπούς. 

 
Παρατηρούμε στην Εικόνα 7.44, ότι σε κάποια σημεία, π.χ. στο αριστερό αυτί της αλεπούς, δεν έχει 

γίνει αρκετά καλή επιλογή. Αν κατά την επιλογή μάς έχει ξεφύγει η γραμμή από την περίμετρο, τότε πρέπει 
να κάνουμε κλικ στο αντίστοιχο σημείο και έπειτα, έχοντας το CTRL πατημένο, μπορούμε να σύρουμε τη 
γραμμή, ώστε να συμπέσει με την περίμετρο της αλεπούς και να διορθώσουμε το λάθος. Με κλικ πάνω στη 
γραμμή μπορούμε να προσθέσουμε και άλλα τετραγωνάκια, δηλαδή σημεία αλλαγής της καμπύλης της γραμ-
μής, για βελτίωση της επιλογής.  

Αφού τελικά καταλήξουμε στην επιθυμητή περίμετρο, πρέπει να κάνουμε δεξί κλικ πάνω στη γραμμή 
και να επιλέξουμε Make Selection. Η περίμετεος αλεπού πλέον θα «αναβοσβήνει» που δηλώνει ότι η αλεπού 
είναι επιλεγμένη. Μπορούμε να κάνουμε αντιγραφή/επικόλληση σε ένα νέο layer του επιλεγμένου τμήματος, 
ή μέσω του μενού «Select > Inverse», να επιλέξουμε το υπόλοιπο τμήμα της εικόνας και να το διαγράψουμε. 
Τελικά, θα εμφανιστεί η Εικόνα 7.46. 

Φυσικά, υπάρχουν και ακόμη πιο πολύπλοκες τεχνικές για το διαχωρισμό αντικειμένων από το υπό-
βαθρο, για πιο λεπτομερή επιλογή των άκρων (π.χ. https://helpx.adobe.com/photoshop/how-to/photoshop-
remove-person.html). 
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Εικόνα 7.45 Έχει γίνει Ctrl-κλικ στην περίμετρο και μπορεί να τροποποιηθεί η γραμμή. 

 

 
 

Εικόνα 7.46 Αντικείμενο που έχει αποκοπεί από το υπόβαθρο της αρχικής εικόνας 7.43. 

 

7.1.8. Χρήση βουρτσών για δημιουργία σχεδίων 
 
Το Photoshop διαθέτει διάφορες βούρτσες (brushes) με τις οποίες μπορούμε να δημιουργήσουμε σχέδια, αλλά 
και να διορθώσουμε διάφορα σημεία σε κάποιες φωτογραφίες. Οι βούρτσες επιλέγονται μέσω του εργαλείου 

«Brush Tool» . Μέσω του εικονιδίου  στην εργαλειοθήκη μπορούμε να θέσουμε το χρώμα προσκηνίου 
«Set foreground color» και το χρώμα του υπόβαθρου («Set background color»). Με κλικ στο πάνω χρωματι-
σμένο κουτάκι μπορούμε να θέσουμε το χρώμα προσκηνίου και με το άλλο μπορούμε να θέσουμε το χρώμα 
υπόβαθρου. Το χρώμα υπόβαθρου χρησιμοποιείται αυτόματα, όταν φτιάξουμε ένα νέο layer στην εικόνα μας, 
οπότε πρέπει να είμαστε προσεκτικοί στην επιλογή. 

Για να δούμε τη χρήση των βουρτσών, ας φτιάξουμε μια νέα εικόνα 300x200 pixels, 300 dpi με λευ-

κό background μέσω της επιλογή «File > New». Έπειτα επιλέξτε το εικονίδιο  και στις επιλογές του εργα-
λείου επιλέξτε μέγεθος και σχέδιο βούρτσας 134 (Εικόνα 7.47). Αφήστε τις υπόλοιπες επιλογές όπως είναι. 
Θέστε το χρώμα προσκηνίου που σας αρέσει, έπειτα δημιουργήστε ένα νέο layer για δυνατότητα αλλαγών και 
κάντε κλικ σε διάφορες θέσεις της εικόνας. Μπορείτε να αλλάξετε το χρώμα και να κάνετε κλικ με το νέο 
χρώμα και να αλλάξετε και το σχέδιο της βούρτσας, π.χ. το σχέδιο 74, και να δημιουργήσετε κάποιο σχέδιο 
σαν της Εικόνας 7.48. 

 

 
 

Εικόνα 7.47 Επιλογές για τις βούρτσες. 
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Εικόνα 7.48 Δημιουργία σχεδίου με χρήση 2 βουρτσών. 

 
Με κλικ στο κουμπί των επιπλέον ρυθμίσεων μπορούμε να ανοίξουμε την καρτέλα που εμφανίζεται 

στην Εικόνα 7.49. Μπορούμε, για παράδειγμα, να επιλέξουμε το «Scattering», ώστε τα σχέδια να διασκορπι-
στούν στην εικόνα, κ.ά. Γενικότερα, υπάρχουν αρκετές επιλογές που μπορούμε να χρησιμοποιήσουμε και με 
πειραματισμό να φτάσουμε στο αισθητικό αποτέλεσμα. Πρέπει πάντα να θυμόμαστε ότι πρέπει να εργαζόμα-
στε σε ξεχωριστά layers, ώστε να είναι πιο εύκολες οι αλλαγές στο έργο. 
 

 
 

Εικόνα 7.49 Επιπλέον επιλογές για τις βούρτσες. 

 
7.1.8.1. Δημιουργία ενός σύνθετου έργου 
 
Έστω ότι θέλουμε να δημιουργήσουμε ένα νέο έργο παρόμοιο με την κάρτα της Εικόνας 7.50. Όπως βλέπου-
με στην Εικόνα 7.51, το έργο έχει αναπτυχθεί σε 4 επίπεδα. 

5. Αρχικά δημιουργήσαμε μια εικόνα 10x5cm, ανάλυσης 300 ppi. 
6. Το χρώμα που επιλέχθηκε για το background είναι στο σύστημα RGB 50, 140, 50. Μπορούμε 

είτε κατά τη δημιουργία της εικόνας να επιλέξουμε «Background Color» ή μετά τη δημιουρ-

γία της εικόνας με χρήση του «Paint Bucket Tool» . 
7. Στη συνέχεια, μπορούμε να εφαρμόσουμε το φίλτρο «Water Paper» ή κάποιο άλλο φίλτρο, 

ώστε να αλλάξει η υφή του υπόβαθρου. 
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Εικόνα 7.50 Σύνθετο έργο στο Photoshop. 

 
 

 
 

Εικόνα 7.51 Layers της εικόνας 7.50. 

 
8. Στη συνέχεια, δημιουργούμε ένα νέο layer στο οποίο με επικόλληση μπορούμε να βάλουμε 

κάποιο λουλούδι, παρόμοιο με το λουλούδι που έχουμε πάνω αριστερά στην Εικόνα 7.50. Το 
λουλούδι μπορούμε να το αναζητήσουμε στο διαδίκτυο ή σε κάποια από τις δικές μας φωτο-
γραφίες. Αν δεν έχει διαφανές υπόβαθρο, πρέπει να το διαχωρίσουμε με κάποια από τις τε-
χνικές που μελετήσαμε πιο πάνω. 

9. Στη συνέχεια, σε νέο επίπεδο, πρέπει να δημιουργήσουμε τα χόρτα και τα φύλλα, σύμφωνα 
με την τεχνική που μελετήσαμε νωρίτερα στο κεφάλαιο. 

10. Στο τελευταίο στάδιο, πρέπει να επιλέξουμε το «Horizontal Type Tool»  και να γράψουμε 
το κείμενο της κάρτας. Το κείμενο που χρησιμοποιήσαμε είχε μέγεθος 30pt και στοίχιση δε-

ξιά. Όταν γράψουμε το κείμενο, κάνουμε κλικ στο εικονίδιο επιλογής  και μπορούμε να 
μετακινήσουμε το κείμενο εκεί που θέλουμε. 

11. Στο κείμενο μπορούμε να εφαρμόσουμε διάφορα εφέ με χρήση της επιλογής «Layer > Layer 
Style > Blending Options». Όπως φαίνεται και από την Εικόνα 7.51, έχουμε επιλέξει τα εφέ 
Bevel & Emboss, Inner Glow και Outer Glow. Με πειραματισμό με τις παραμέτρους μπο-
ρούμε να φτάσουμε στο επιθυμητό αισθητικό αποτέλεσμα. 

 
Σε κάθε επίπεδο που έχει φωτογραφίες μπορούμε να εφαρμόσουμε φίλτρα, χρωματικές προσαρμογές, 

και άλλες διορθώσεις που είδαμε στις πιο πάνω ενότητες.  
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7.1.9. Χρήση εργαλείων για διόρθωση αισθητικών προβλημάτων 
 
Αρκετές φορές έχουμε ακούσει, ακόμη και στα μέσα ενημέρωσης, για χρήση του Photoshop για την αισθητι-
κή βελτίωση διαφόρων φωτογραφιών, ώστε να μην εμφανίζονται οι ατέλειες όσων εικονίζονται σε φωτογρα-

φίες περιοδικών. Αυτό επιτυγχάνεται με τη χρήση εργαλείων «Healing Brush Tool»  και «Spot Healing 

Brush Tool» .  
 

7.1.9.1. Αφαίρεση στιγμάτων 
 

Έστω ότι έχουμε τη φωτογραφία της Εικόνας 7.52 και θέλουμε να διορθώσουμε κάποιες ατέλειες στο μέτω-

πο. Επιλέγουμε το εργαλείο «Spot Healing Brush Tool» . Στο πάνω μέρος της οθόνης, στις επιλογές του 
εργαλείου, μπορούμε να επιλέξουμε μεγαλύτερο μέγεθος βούρτσας, π.χ. , ώστε να είναι πιο εύκολη η 
διόρθωση. Μετακινώντας τον δείκτη του ποντικιού στη φωτογραφία διαπιστώνουμε ότι εμφανίζεται ένας κύ-
κλος. Πρέπει να κάνουμε κλικ σε κάθε στίγμα, ώστε περίπου το στίγμα να είναι στο κέντρο του κύκλου. Το 
Photoshop χρησιμοποιεί το χρώμα των γειτονικών pixels για να διορθώσει το πρόβλημα. Επαναλαμβάνουμε 
τη διαδικασία και φτάνουμε στο αποτέλεσμα της Εικόνα 7.53. 

 

 
 

Εικόνα 7.52 Αρχική εικόνα με αρκετά στίγματα. 

 

 
 

Εικόνα 7.53 Τελική εικόνα αισθητικά βελτιωμένη. 

 
7.1.9.2. Αφαίρεση ρυτίδων 

 
Στο ακόλουθο παράδειγμα βελτιώνουμε αισθητικά την εικόνα με την αφαίρεση των ρυτίδων από το μέτωπο 

του εικονιζόμενου. Επιλέγουμε το «Healing Brush Tool»  και κρατώντας το πλήκτρο Alt πατημένο, κά-
νουμε κλικ σε τμήμα δέρματος κοντά σε κάποια ρυτίδα. Με αυτό τον τρόπο παίρνουμε δείγμα δέρματος που 
θα χρησιμοποιήσουμε για να καλύψουμε τις ρυτίδες. Έπειτα σύρουμε το ποντίκι πάνω από τη ρυτίδα, όπως 
βλέπουμε στην Εικόνα 7.55. Επαναλαμβάνουμε τη διαδικασία για όλες τις ρυτίδες και καταλήγουμε στην Ει-
κόνα 7.56. Για πιο φυσικά αποτελέσματα, καλό θα είναι να παίρνουμε δείγμα δέρματος, με Alt-κλικ, αρκετές 
φορές, κοντά σε κάθε ρυτίδα και έπειτα να προβαίνουμε σε διόρθωση.  

Αυτές είναι κάποιες απλές και γρήγορες διορθώσεις, που παράγουν όμως εντυπωσιακά αποτελέσμα-
τα. Με πιο σύνθετες τεχνικές μπορούμε να διορθώσουμε πορώδες δέρμα, να αλλάξουμε το χρώμα των μαλ-
λιών, κ.λπ.  
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Εικόνα 7.54 Αρχική εικόνα με ρυτίδες. 

 

 
 

Εικόνα 7.55 Τρόπος εφαρμογής της διόρθωσης. 
 

 
 

Εικόνα 7.56 Τελική εικόνα αισθητικά βελτιωμένη. 

 

7.2. GIMP 
 
Το GIMP (GNU Image Manipulation Program) (http://www.gimp.org/downloads/) είναι ένα δωρεάν πρό-
γραμμα για την επεξεργασία ψηφιογραφικών (bitmap) εικόνων που, όπως και το Photoshop, υποστηρίζει: 

 Την επεξεργασία πολλαπλών μορφών αρχείων, π.χ. jpeg, gif, png, tiff, κ.ά. 
 Τη χρήση φίλτρων για την ανάδειξη συγκεκριμένων χαρακτηριστικών των εικόνων. 
 Τη δυνατότητα για χρωματικές διορθώσεις και αισθητικές βελτιώσεις φωτογραφιών. 
 Την αφαίρεση αντικειμένων από τις εικόνες. 
 Τη δημιουργία σύνθετων έργων με τη χρήση επιπέδων. 

 
Στην ιστοσελίδα http://docs.gimp.org/el/ υπάρχει ένα ολοκληρωμένο εγχειρίδιο χρήστη στα Ελληνι-

κά, το οποίο μπορείτε να χρησιμοποιήσετε για να μελετήσετε όλα τα χαρακτηριστικά του Gimp. Στις επόμε-
νες υποενότητες, θα παρουσιάσουμε κάποιες κοινές εργασίες, π.χ. διορθώσεις φωτογραφιών, διαχωρισμός 
αντικειμένων από το υπόβαθρο, δημιουργία σύνθετων έργων με χρήση επιπέδων κ.ά., ώστε να γνωρίζετε τις 
βασικές λειτουργίες του εργαλείου. 

 

7.2.1. Γνωριμία με το GIMP 
 
Το περιβάλλον εργασίας του Gimp εμφανίζεται στην Εικόνα 7.57. Το Gimp αρχικά εμφανίζεται ως 3 ξεχωρι-
στά παράθυρα (αριστερό, κεντρικό και δεξί). Για να εμφανιστεί ως ένα ενιαίο παράθυρο, όπως στην Εικόνα 
7.57, πρέπει να εκτελέσουμε «Παράθυρα > Λειτουργία μοναδικού παραθύρου». Τα μέρη που συνθέτουν το 
περιβάλλον εργασίας είναι: 
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 Στο σημείο 1 της εικόνας εμφανίζονται τα μενού επιλογών του εργαλείου.  
 Στο σημείο 2 υπάρχει η βασική συλλογή εργαλείων (εργαλειοθήκη) του Gimp. 
 Στο σημείο 3 εμφανίζονται κάποιες επιλογές και πλαίσια ρυθμίσεων, ανάλογα με το επιλεγ-

μένο εργαλείο της εργαλειοθήκης. 
 Στο κέντρο της οθόνης, στο σημείο 4, εμφανίζεται η εικόνα που επεξεργαζόμαστε. 
 Στα σημεία 5 και 6 υπάρχουν διάφορες καρτέλες εργαλείων, π.χ. τα επίπεδα, που επιτρέπουν 

διάφορες επεξεργασίες επί των εικόνων.  
 

 
[Πηγή: http://goo.gl/zl7Mto] 

 
Εικόνα 7.57 Το περιβάλλον εργασίας του Gimp 2.8. 

 
Ο βασικός τύπος αποθήκευσης των εικόνων που δημιουργούνται με το Gimp είναι ο τύπος XCF (eX-

perimental Computing Facility). Όταν δημιουργούμε σύνθετα έργα, π.χ. με επίπεδα, οι εικόνες πρέπει να απο-
θηκεύονται σε αυτή τη μορφή. Για να αποθηκεύσουμε σε κάποιον άλλο τύπο εικόνας, π.χ. JPEG, PNG, κ.ά., 
τότε πρέπει να επιλέξουμε «Αρχείο > Εξαγωγή ως». Επίσης, αν ανοίξουμε για επεξεργασία μια εικόνα σε 
ένα κοινό φορμά, π.χ. μια εικόνα με όνομα Img1.jpg, τότε θα εμφανιστεί στο μενού «Αρχείο» η επιλογή «Ε-
ξαγωγή ως Img1.jpg», ώστε να μπορέσουμε να αποθηκεύσουμε απευθείας την εικόνα στην αρχική της μορφή 
και με το ίδιο όνομα. 

 

7.2.2. Βασικές επεξεργασίες με το Gimp 
 
7.2.2.1. Επιλογές δημιουργίας νέας εικόνας και βασικά εργαλεία 
 
Για τη δημιουργία νέας εικόνας στο Gimp επιλέγουμε «Μενού Αρχείο > Νέο». Θα εμφανιστεί το ακόλουθο 
παράθυρο δημιουργίας νέας εικόνας. Στην Εικόνα 7.58, έχουμε ενεργοποιήσει και τις «Προχωρημένες ρυθμί-
σεις». Όπως βλέπετε εδώ μπορούμε να ορίσουμε το αρχικό πλάτος και ύψος της εικόνας ή να επιλέξουμε κά-
ποιο πρότυπο, π.χ. «Α4 (300 ppi)». Μπορούμε να επιλέγουμε την ανάλυση (οριζοντίως και καθέτως), να ορί-
σουμε το χρωματικό μοντέλο, το χρώμα παρασκηνίου και τον προσανατολισμό της νέας εικόνας.  
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Εικόνα 7.58 Επιλογές δημιουργίας νέας εικόνας στο Gimp.  

 
Κάποια βασικά εργαλεία του Gimp είναι: 
 

 Επιλέγουμε το χρώμα προσκηνίου και παρασκηνίου με κλικ στο εικονίδιο  στην εργαλειο-
θήκη. 

 

 Με το εργαλείο «Κουβάς γεμίσματος»  μπορούμε να γεμίσουμε κάποιο επιλεγμένο τμήμα 
ή κάποιο επίπεδο της εικόνας ή κάποιο σχήμα. 

 

 Με το εργαλείο «Εργαλείο Κειμένου»  μπορούμε να εισάγουμε κείμενο στα έργα μας.  
 

 Η «Σβήστρα»  χρησιμοποιείται για αφαίρεση περιοχών χρώματος από την τρέχουσα 
στρώση ή από μια επιλογή. 

 

 Το «Πινέλο»  χρησιμοποιείται για τη δημιουργία σχεδίων σε κάποια εικόνα και γενικά για 
να ζωγραφίσουμε πάνω σε μια εικόνα. 

 
7.2.2.2. Επιλογή τμημάτων εικόνας 

 
Όπως βλέπουμε στην Εικόνα 7.59, τα βασικά εργαλεία για την επιλογή τμημάτων της εικόνας είναι: 

 
12. Ορθογώνια επιλογή 
13. Ελλειπτική επιλογή 
14. Ελεύθερη επιλογή (λάσο) 

 
Αφού επιλέγουμε κάποιο από αυτά τα εργαλεία, μπορούμε να ρυθμίσουμε κάποιες από τις επιπλέον 

επιλογές του, που εμφανίζονται κάτω από το εργαλείο. Στο συγκεκριμένο παράδειγμα, ενεργοποιήσαμε τη 
δεύτερη επιλογή του πλαισίου «Κατάσταση» , ώστε να μπορούμε να επιλέξουμε ταυτόχρονα διαφορετικά 
τμήματα στην εικόνα. Μπορούμε να καθορίσουμε και το μέγεθος και τη θέση της επιλογής, ώστε να είμαστε 
πιο ακριβείς στις επιλογές μας. 
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Εικόνα 7.59 Επιλογή τμημάτων εικόνας.  

 
7.2.2.3. Αλλαγή μεγέθους και ανάλυσης εικόνας, περικοπή και μετασχηματισμοί εικόνας 
 
Οι περισσότερες επιλογές που σχετίζονται με την αλλαγή των χαρακτηριστικών (διαστάσεις, ανάλυση, κ.ά.) 
μιας εικόνας, βρίσκονται στο μενού «Εικόνα».  
 

 
 

Εικόνα 7.60 Αλλαγή διαστάσεων και ανάλυσης εικόνας. 

 
Για την αλλαγή των διαστάσεων και της ανάλυσης της εικόνας, πρέπει να επιλέξουμε «Εικόνα > 

Κλιμάκωση εικόνας». Στο παράθυρο (Εικόνα 7.60) που εμφανίζεται μπορούμε να αλλάξουμε τις διαστάσεις, 
σε pixels, ίντσες, εκατοστά, τυπογραφικά σημεία, κ.λπ. και να προσαρμόσουμε την ανάλυση. Όπως συζητή-
σαμε και στην ενότητα 1.3.4. του τρέχοντος κεφαλαίου, η αύξηση της ανάλυσης, δηλ. η αύξηση των pixels 
ανά διάσταση, θα έχει ως συνέπεια τη μείωση των διαστάσεων της εικόνας. Στη συγκεκριμένη φωτογραφία, 
για παράδειγμα, αν αυξήσουμε την ανάλυση στα 300 ppi, χωρίς να κάνουμε «Παρεμβολή» (Interpolation - το 
αντίστοιχο «Resample» του Photoshop), τότε ο αριθμός των pixels παραμένει σταθερός, αλλά οι διαστάσεις 
από περίπου 7x4.3", μειώνονται σε 4,66x2,95". Αν θέλουμε να κρατήσουμε και τις διαστάσεις της εικόνας 
σταθερές, τότε πρέπει να χρησιμοποιήσουμε της επιλογές της λίστας «Παρεμβολή», για να αλλάξει ο αριθμός 
των pixels της εικόνας. Η επιλογή «Κυβική» στη λίστα «Παρεμβολή» έχει καλύτερα αποτελέσματα, αλλά 
είναι πιο αργή σε σχέση με τη «Γραμμική». 

Στο παράθυρο διαλόγου που ενεργοποιείται με το μενού «Εικόνα > Μέγεθος εκτύπωσης», μπορού-
με να ορίσουμε τις διαστάσεις και την ανάλυση εκτύπωσης μιας φωτογραφίας για εκτύπωση. Είναι παρόμοια 
με την κλιμάκωση της εικόνας, αλλά δεν υποστηρίζεται δυνατότητα παρεμβολής.  
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Μέσω της επιλογής «Εικόνα > Έξυπνη περικοπή», περικόπτονται τα λευκά περιθώρια της εικόνας. 
Αν επιλέξουμε κάποιο τμήμα της εικόνας, τότε μπορούμε να εκτελέσουμε «Εικόνα > Περικοπή στην επιλο-
γή». Από το μενού «Εικόνα > Μετασχηματισμός» μπορούμε να κάνουμε περιστροφή ή αναστροφή της φω-
τογραφίας. Με την επιλογή «Εικόνα > Διαστάσεις καμβά» μπορούμε να αλλάξουμε τις διαστάσεις του καμ-
βά. Η επιλογή «Εικόνα > Ιδιότητες» μας επιτρέπει να δούμε τις ιδιότητες της φωτογραφίας. 

 

7.2.3. Χρωματικές προσαρμογές 
 
Στην τρέχουσα υποενότητα θα μελετήσουμε κάποιες από τις δυνατές προσαρμογές που μπορούμε να πραγμα-
τοποιήσουμε στο Gimp. Οι περισσότερες χρωματικές αλλαγές γίνονται μέσω του μενού «Χρώματα». 

 

7.2.3.1. Αλλαγή σε δεικτοδοτούμενο χρώμα 
 
Όπως αναφέραμε στο Κεφάλαιο 2, το δεικτοδοτούμενο χρώμα (indexed color) αφορά στη δυνατότητα χρή-
σης 256 ή λιγότερων χρωμάτων για την αναπαράσταση των χρωματικών αποχρώσεων της εικόνας. Αυτό βο-
ηθά στη μείωση του μεγέθους της εικόνας, χωρίς όμως να μειώνεται (τουλάχιστον αισθητά) η ποιότητα της 
εικόνας, στις περισσότερες περιπτώσεις. Μορφότυπα που υποστηρίζουν αυτή τη δυνατότητα είναι το PNG 
και το GIF. Αντίθετα, το JPG δεν την υποστηρίζει. Στην Εικόνα 7.61 εμφανίζεται η αρχική φωτογραφία με 
μέγεθος 227 KB.  

 

 
 

Εικόνα 7.61 Αρχική εικόνα με χρωματικό μοντέλο RGB και μέγεθος 227 KB. 

 

 
 

Εικόνα 7.62 Χρήση δεικτοδοτούμενου χρώματος για το διαδίκτυο. 

 
Το παράθυρο με τις επιλογές μετατροπής σε δεικτοδοτούμενο χρώμα (Εικόνα 7.62) ενεργοποιείται 

μέσω του μενού «Εικόνα > Κατάσταση > Από ευρετήριο». Επιλέγουμε κάποια από τις διαθέσιμες επιλογές, 
ανάλογα με το σκοπός μας, και κάνουμε κλικ στο ΟΚ. Η Εικόνα 7.63 έχει μέγεθος 50 ΚΒ, περίπου το 1/5 του 
αρχικού μεγέθους. Η μείωση του μεγέθους φυσικά είναι ενδεικτική και εξαρτάται και από το αρχικό μέγεθος 
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και από την ανάλυση της εικόνας. Εδώ χρησιμοποιήσαμε φωτογραφίας 300 ppi. Η ποιοτική διαφορά, πάντως, 
δεν είναι μεγάλη και ειδικά αν οι διαστάσεις της εικόνας είναι μικρές, δεν είναι ορατή η διαφορά. 

 

 
 

Εικόνα 7.63 Αρχική εικόνα με χρωματικό μοντέλο RGB και μέγεθος 50 KB. 
 

7.2.3.2. Φωτεινότητα και αντίθεση 
 
Μέσω του μενού «Χρώματα > Φωτεινότητα-Αντίθεση» μπορούμε να προσαρμόσουμε τη φωτεινότητα και 
την αντίθεση μιας φωτογραφίας. Στην Εικόνα 7.64 εμφανίζεται μια φωτογραφία κάπως σκοτεινή, ενώ στην 
Εικόνα 7.65 η φωτογραφία έχει γίνει πιο φωτεινή. Βλέπουμε φυσικά, ότι ένα σημείο του ουρανού, στην πάνω 
αριστερή πλευρά της φωτογραφίας, έχει γίνει σχεδόν άσπρο. Με μικρότερους αριθμούς μπορούμε να επιτύ-
χουμε κάποια καλύτερη ισορροπία.   

 

 
 

Εικόνα 7.64 Αρχική σκοτεινή φωτογραφία. 

 

 
 

Εικόνα 7.65 Τελική εικόνα πιο ανοιχτόχρωμη εικόνα με Φωτεινότητα: 60 και Αντίθεση: 20. 
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7.2.3.3. Αλλαγή αποχρώσεων και κορεσμού 
 
Το εργαλείο απόχρωσης-κορεσμού χρησιμοποιείται για τη ρύθμιση σταθμών απόχρωσης, κορεσμού και φω-
τεινότητας σε μια περιοχή χρωματικών αποχρώσεων. Ενεργοποιείται με το μενού «Χρώματα > Απόχρωση-
Κορεσμός». Παρατηρούμε ότι μπορούμε να επιλέγουμε το χρώμα στο οποίο θα κάνουμε παρεμβάσεις. Έστω 
ότι έχουμε ως αρχική φωτογραφία την Εικόνα 7.61 και θέλουμε να αλλάξουμε το πρώτο, μπλε, λουλούδι να 
μοιάζει τα υπόλοιπα λουλούδια. Πρέπει να επιλέξουμε το «ΓΑΛΑΖΙΟ» και έπειτα να αυξήσουμε την από-
χρωση σε 50. Με αλλαγές π.χ. του κόκκινου, του ματζέντα και του κίτρινου να φτάσουμε σε μπλε και μωβ 
αποχρώσεις όλων των λουλουδιών. 

 
 

 
 

Εικόνα 7.66 Παράθυρο επιλογών «Απόχρωση-Κορεσμός». 

 
 

 
 

Εικόνα 7.67 Η φωτογραφία 7.61 με διαφορετικές αποχρώσεις. 

 

7.2.4. Φίλτρα 
 
Όπως και το Photoshop, το Gimp διαθέτει αρκετά φίλτρα που μπορούμε να εφαρμόσουμε στις φωτογραφίες 
μας, δημιουργώντας διάφορα οπτικά εφέ. Στην Εικόνα 7.68 έχει εφαρμοστεί το φίλτρο «Βάν Γκόγκ» από την 
επιλογή «Φίλτρα > Καλλιτεχνικά > Βαν Γκογκ», ενώ στην Εικόνα 7.69 έχει εφαρμοστεί το φίλτρο «Φίλ-
τρα > Διάκοσμος > Fuzzy Border». Με συνδυασμό φίλτρων και χρωματικών παρεμβάσεων μπορούμε να 
δημιουργήσουμε εντυπωσιακές εικόνες. 

 



199 
 

 
 

Εικόνα 7.68 Εφαρμογή καλλιτεχνικού φίλτρου. 

 

 
 

Εικόνα 7.69 Εφαρμογή φίλτρου «Fuzzy Border». 

 

7.2.5. Εργασίες με στρώσεις 
 
Τα layers αποκαλούνται στρώσεις στα Ελληνικά στο εγχειρίδιο του Gimp. Χρησιμοποιούμε στρώσεις για να 
μπορέσουμε να δημιουργήσουμε σύνθετα έργα. Στην Εικόνα 7.70 εμφανίζεται η καρτέλα διαχείρισης των 
στρώσεων ενός έργου. Η δημιουργία μιας νέας στρώσης μπορεί να γίνει και μέσω του μενού «Στρώση > Νέα 
Στρώση» και υπάρχουν διάφορες επιλογές για το χρώμα της στρώσης (Εικόνα 7.71). 
 

 
 

Εικόνα 7.70 Παράθυρο διαχείρισης στρώσεων. 
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Εικόνα 7.71 Επιλογές για το γέμισμα της στρώσης. 

 

7.2.6. Διαχωρισμός αντικειμένου από το υπόβαθρο 
 
Υπάρχουν διάφοροι για το διαχωρισμό αντικειμένων από το υπόβαθρο που εξαρτώνται κυρίως από την αντί-
θεση των χρωμάτων. Στη συνέχεια, εξετάζουμε δύο από αυτούς του τρόπους. 
 

7.2.6.1. Εργαλείο «Ασαφής επιλογή» 
 
Όταν υπάρχει μεγάλη αντίθεση στο προσκήνιο και το παρασκήνιο, τότε μπορούμε να χρησιμοποιήσουμε το 

εργαλείο «Ασαφής επιλογή»  (σημ. το εργαλείο αναφέρετε και ως «Μαγικό Ραβδί»).  
 

 
[Πηγή: http://goo.gl/mNYLut] 

 
Εικόνα 7.72 Αρχική εικόνα από την οποία χρειαζόμαστε μόνο το άλογο. 

 

 
 

Εικόνα 7.73 Επιλογή των ορίων με διαδοχικές χρήσεις του εργαλείου «Ασαφής επιλογή». 
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Έστω ότι έχουμε την Εικόνα 7.72 και θέλουμε να διαγράψουμε το υπόβαθρο. Αρχικά κάνουμε κλικ 
στο άλογο με μεγάλη τιμή στον ολισθητή κατώφλι, ώστε να επιλεγούν όλες οι καφέ και μαύρες αποχρώσεις. 
Θα παρατηρήσουμε ότι δεν επιλέγονται όλες οι αποχρώσεις στο άλογο. Ενεργοποιούμε την επιλογή «Προ-
σθήκη στην τρέχουσα επιλογή » και έπειτα κάνουμε κλικ στα μικρά σημεία που δεν έχουν επιλεχθεί. Όταν 
φτάσουμε στο σημείο της Εικόνας 7.73, δηλαδή όπου όλο το άλογο είναι επιλεγμένο, τότε ενεργοποιούμε το 
μενού «Επιλογή > Αντιστροφή», ώστε να επιλεγεί ο ουρανός. Έπειτα, διαγράφουμε τον ουρανό και καταλή-
γουμε στην Εικόνα 7.74. Παρατηρούμε ότι έχει μείνει ένα πολύ μικρό μέρος από τη γη στα πίσω πόδια του 

αλόγου. Αυτά τα μικρά τμήματα, μπορούν, στη συνέχεια, να διαγραφούν είτε με το εργαλείο «Σβήστρα»  
είτε με το εργαλείο «Ασαφής επιλογή». 

 
 

Εικόνα 7.74 Διαχωρισμός αλόγου από το υπόβαθρο. 

 
7.2.6.2. Εργαλείο «Ψαλίδι» 
 
Πιο πάνω στο κεφάλαιο, στην Εικόνα 7.43 είδαμε μια λευκή αλεπού σε λευκό περιβάλλον, την οποία διαχω-
ρίσαμε επιλέγοντας σταδιακά τα όριά της. Το ίδιο μπορούμε να κάνουμε και στο Gimp με χρήση του εργα-

λείου «Ψαλίδι» . Κάνοντας κλικ και σύροντας το ποντίκι αργά και σταθερά γύρω από την αλεπού, προκύ-
πτει η Εικόνα 7.75. Μπορούμε να κάνουμε κλικ σε οποιοδήποτε σημείο της γραμμής, ώστε να δημιουργή-
σουμε και άλλα σημεία χειρισμού της γραμμής. Αν μεγεθύνουμε τη φωτογραφία με τον μεγεθυντικό φακό, 
μπορούμε να ρυθμίσουμε με μεγαλύτερη λεπτομέρεια την επιλογή. 

 

 
 

Εικόνα 7.75 Επιλογή αντικειμένου με το «Ψαλίδι». 

 
Στη συνέχεια, κάνουμε κλικ μέσα στην αλεπού, ώστε να ολοκληρωθεί η επιλογή. Αντιγράφουμε την 

αλεπού σε νέα στρώση ή σε νέα εικόνα ή επιλέγουμε «Επιλογή > Αντιστροφή» για να επιλεγεί το υπόβαθρο 
και να το διαγράψουμε.  
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7.2.7. Διόρθωση εικόνων 
 
Το Gimp διαθέτει μια ευρεία γκάμα εργαλείων διόρθωσης εικόνων. Παράδειγμα αποτελούν το εργαλείο «Ε-
πούλωση», «Αποκηλίδωση», «Αποράβδωση» και «Απόπλεξη».  

Το εργαλείο «Επούλωση»  μπορεί να χρησιμοποιηθεί για να διορθώσει στίγματα, ρυτίδες, κ.ά. 
Έστω ότι έχουμε ως αρχική την Εικόνα 7.75. Κάνουμε πρώτα κλικ στο εργαλείο και έπειτα με το πλήκτρο 
Ctrl πατημένο, κάνουμε κλικ σε τμήμα δέρματος κοντά σε κάποιο στίγμα. Με αυτό τον τρόπο παίρνουμε 
δείγμα δέρματος που θα χρησιμοποιήσουμε για να καλύψουμε τα στίγματα. Έπειτα κάνουμε κλικ σε κάθε 
στίγμα. Επαναλαμβάνουμε τη διαδικασία για όλα τα στίγματα και καταλήγουμε στην Εικόνα 7.57. Για πιο 
φυσικά αποτελέσματα, καλό θα είναι να παίρνουμε δείγμα δέρματος, με Ctrl-κλικ, αρκετές φορές, κοντά σε 
κάθε στίγμα και έπειτα να προβαίνουμε σε διόρθωση. Την ίδια τεχνική χρησιμοποιούμε και στην περίπτωση 
ρυτίδων. Όταν επιλέγουμε το εργαλείο «Επούλωση», μπορούμε να καθορίσουμε το μέγεθος του πινέλου 
διόρθωσης μέσω των επιλογών του εργαλείου. 
 

 
 

Εικόνα 7.76 Αρχική εικόνα με αρκετά στίγματα. 
 

 
 

Εικόνα 7.77 Τελική εικόνα αισθητικά βελτιωμένη. 

 

7.3. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο τρέχον κεφάλαιο εξηγήσαμε κάποιες από τις δυνατότητες των εργαλείων Photoshop και Gimp για επε-
ξεργασία ψηφιογραφικών εικόνων. Το Photoshop είναι εμπορικό εργαλείο, ενώ το Gimp είναι ελεύθερο. Το 
Photoshop έχει περισσότερες δυνατότητες, αλλά αναμφισβήτητα το Gimp, αν και πρόκειται για ελεύθερο λο-
γισμικό, έχει επίσης πολλές δυνατότητες που προσφέρονται μέσω του απλού του interface. Τα εργαλεία χρη-
σιμοποιούνται για τη δημιουργία σύνθετων έργων με πολλαπλά επίπεδα και τις χρωματικές διορθώσεις και 
βελτιώσεις φωτογραφιών. Στο διαδίκτυο υπάρχουν αρκετοί οδηγοί εκμάθησης (tutorials) που μας βοηθούν 
στην ολοκλήρωση συγκεκριμένων λειτουργιών.  
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8. Επεξεργασία διανυσματικών γραφικών με τα εργαλεία Adobe 
Illustrator & Inkscape 

 
 
Σύνοψη 
Στο συγκεκριμένο κεφάλαιο παρουσιάζουμε κάποιες από τις δυνατότητες των εργαλείων επεξεργασίας διανυ-
σματικών γραφικών (vector graphics) Adobe Illustrator και Inkscape. Το πρώτο εργαλείο είναι το πιο διαδεδο-
μένο εργαλείο επεξεργασίας διανυσματικών γραφικών, ενώ το Inkscape αποτελεί το πιο γνωστό ελεύθερο εργα-
λείο επεξεργασίας εικόνων. Αρχικά, παρουσιάζουμε το Illustrator, εξηγούμε τις δυνατότητές του και παρουσιά-
ζουμε βήμα-προς-βήμα ασκήσεις που αφορούν σε θέματα δημιουργίας και τροποποίησης απλών σχημάτων, εφέ 
κειμένου και δημιουργία σύνθετων γραφικών. Στη δεύτερη ενότητα του κεφαλαίου παρουσιάζουμε αντίστοιχα 
θέματα με το εργαλείο Inkscape.  

 
Προαπαιτούμενη γνώση 
Για την κατανόηση κάποιων θεμάτων του κεφαλαίου είναι απαραίτητη η μελέτη του κεφαλαίου 2, στο οποίο 
παρουσιάστηκαν διάφορα θεωρητικά ζητήματα σχετικά με τις εικόνες. Καλό θα ήταν να έχει μελετηθεί πριν και 
το κεφάλαιο 7 που παρουσιάζει λογισμικά επεξεργασίας ψηφιογραφικών εικόνων. 

 
 

8.1. Adobe Illustrator 
 
Το Adobe Illustrator (http://www.adobe.com/products/illustrator.html) είναι εργαλείο επεξεργασίας διανυ-
σματικών γραφικών. Η τελευταία έκδοση του εργαλείου ως αυτόνομη εφαρμογή ήταν η CS6. Οι πιο πρόσφα-
τες εκδόσεις διατίθενται ως υπηρεσίες σύννεφου (cloud service) από την Adobe και αναφέρονται ως Illustra-
tor CC (Creative Cloud). Κάθε νέα έκδοση περιέχει, προφανώς, περισσότερες εξειδικευμένες λειτουργίες, 
αλλά οι περισσότερες λειτουργίες είναι κοινές σε όλες τις εκδόσεις.  

Το εργαλείο παρέχει πολλές δυνατότητες δημιουργίας και επεξεργασία διανυσματικών γραφικών που 
μπορεί να οδηγήσουν στη σύνθεση πολύπλοκων σχημάτων (Εικόνα 8.1). 

 

 
 
Εικόνα 8.1 Σύνθετα διανυσματικά γραφικά. 

 
Η Adobe προσφέρει ένα σύνολο διαδικτυακών οδηγών εκμάθησης που βρίσκονται στη διεύθυνση 

https://helpx.adobe.com/illustator/tutorials.html. Εκεί περιγράφονται απλές και πιο εξειδικευμένες τεχνικές 
και προσφέρονται αντίστοιχα αποσπάσματα βίντεο, τα οποία εξηγούν την εφαρμογή τους.  

Στον διαδικτυακό τόπο https://openclipart.org/ μπορείτε να βρείτε δωρεάν διανυσματικά γραφικά, τα 
οποία μπορείτε να κατεβάσετε, συνήθως σε μορφή SVG ή EPS, και να τα χρησιμοποιήσετε στα έργα σας. 
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8.1.1. Γνωριμία με το περιβάλλον εργασίας του Illustrator 
 
Στην Εικόνα 8.2 εμφανίζεται το περιβάλλον εργασίας του Illustrator. 

 
 Στο σημείο 1 της Εικόνας 8.2 εμφανίζονται τα μενού επιλογών του εργαλείου.  
 Στο σημείο 2 υπάρχει η βασική συλλογή εργαλείων (εργαλειοθήκη) του Illustrator. 
 Στο σημείο 3 εμφανίζονται κάποιες επιλογές και πλαίσια ρυθμίσεων, ανάλογα με το επιλεγ-

μένο εργαλείο της εργαλειοθήκης. 
 Στο κέντρο της οθόνης, στο σημείο 4, εμφανίζεται η εικόνα που επεξεργαζόμαστε. 
 Στo σημείο 5 μπορούμε να εμφανίσουμε διάφορες παλέτες εργαλείων για διαμόρφωση των 

σχημάτων που δημιουργούμε, π.χ. για ορισμό διαφάνειας ή δημιουργία επιπέδων. 
 Στο σημείο 6 υπάρχουν κάποιες επιλογές σχετικά με τη μεγέθυνση κ.ά. 

 
 

 
 
Εικόνα 8.2 Το περιβάλλον εργασίας του Adobe Illustrator CS6. 

 
Η μορφή αποθήκευσης των αρχείων του Illustrator είναι η .ai. Σ’ αυτή τη μορφή διατηρούνται όλες οι 

πληροφορίες, π.χ. τα επίπεδα, τα fonts κ.ά. Γενικά, όμως, το εργαλείο έχει τη δυνατότητα να επεξεργαστεί 
πολλές μορφές διανυσματικών γραφικών, π.χ. cdr, eps, svg κ.ά. Μια συνηθισμένη πρακτική είναι η αποθή-
κευση του έργου στη μορφή ai για δυνατότητα μελλοντικών τροποποιήσεων και η εξαγωγή του έργου σε 
μορφή eps ή svg για διαμοιρασμό με άλλες εφαρμογές. 

 

 
 
Εικόνα 8.3 Αλλαγή χρώματος του περιβάλλοντος εργασίας του Adobe Illustrator CS6. 
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Παρατηρούμε ότι το περιβάλλον εργασίας του Photoshop CS6 είναι εξ ορισμού σκουρόχρωμο, ώστε 
να μειωθεί η κούραση των ματιών, στην περίπτωση πολύωρης ενασχόλησης με το εργαλείο. Αν, παρόλα αυ-
τά, επιθυμείτε να αλλάξετε το περιβάλλον εργασίας, χρησιμοποιώντας πιο ανοιχτόχρωμες αποχρώσεις, μπο-
ρείτε να επιλέξετε το μενού «Edit > Preferences > User Interface» και έπειτα κάποια από τις γκρι αποχρώ-
σεις που είναι διαθέσιμες (Εικόνα 8.3). Στις επόμενες ασκήσεις θα χρησιμοποιούμε τις ανοιχτόχρωμες απο-
χρώσεις. 

Ένα πλεονέκτημα της χρήσης του Illustrator σε σχέση με άλλα εμπορικά εργαλεία για επεξεργασία 
διανυσματικών γραφικών, π.χ. το CorelDraw, είναι ότι συνεργάζεται άμεσα με τα υπόλοιπα εργαλεία της 
Adobe. 
 

8.1.2. Δημιουργία νέου έργου 
 
Μέσω της επιλογής «File > New» μπορούμε να δημιουργήσουμε νέο έργο. Από προεπιλογή, το Illustrator 
μετρά το μέγεθος της εικόνας σε points (1 point = 1/72 της ίντσας), αλλά αυτό μπορεί να αλλάξει σε εκατο-
στά, pixels κ.ά. (Εικόνα 8.4). 

 

 
 
Εικόνα 8.4 Επιλογές δημιουργίας νέου έργου. 

 
Κάτω από την επιλογή «Advanced» υπάρχουν οι επιλογές για το χρωματικό μοντέλο και την ανάλυ-

ση. Επιλέγουμε χρωματικό μοντέλο RGB, όταν αναπτύσσουμε κάποιο γραφικό για το διαδίκτυο ή κάποια 
πολυμεσική εφαρμογή. Επίσης, κάποια από τα εργαλεία του λογισμικού λειτουργούν μόνο εάν έχουμε επι-
λεγμένο το μοντέλο RGB. Το CMYK πρέπει να το χρησιμοποιήσουμε, όταν το γραφικό που φτιάξουμε προο-
ρίζεται για εκτύπωση. 
 

8.1.3. Δημιουργία σχημάτων και απλές επιλογές διαμόρφωσης 
 
Για τη δημιουργία απλών σχημάτων, πρέπει να πάμε στην εργαλειοθήκη στην αριστερή πλευρά του Illustrator 

και να επιλέξουμε το κατάλληλο σχήμα. Ας υποθέσουμε ότι δημιουργούμε το ορθογώνιο με το εικονίδιο  
της εργαλειοθήκης. Όταν σχεδιάσουμε το ορθογώνιο, τότε εμφανίζονται κάποιες πρόσθετες επιλογές στο πά-
νω μέρος της οθόνης (Εικόνα 8.5). 

 

 
 
Εικόνα 8.5 Πρόσθετες επιλογές για το ορθογώνιο. 

 
Αρχικά, μπορούμε να δημιουργήσουμε ένα ορθογώνιο, όπως αυτό της Εικόνας 8.6α. Βάζοντας χρώμα 

γεμίσματος και χρώμα περιγράμματος προκύπτει κάποιο ορθογώνιο, όπως αυτό που εμφανίζεται στην Εικόνα 
8.6β. Το χρώμα γεμίσματος και περιγράμματος επιλέγεται από τα δύο πρώτα πλαίσια της Εικόνας 8.5. 
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Για να δημιουργήσουμε το ορθογώνιο γ της Εικόνας 8.6, πρέπει να τροποποιήσουμε τα επόμενα δύο 
πλαίσια των επιλογών, που αφορούν στο πάχος και το στυλ εφαρμογής του πάχους της γραμμής. Οι επιλογές 
εμφανίζονται στην Εικόνα 8.7. 

Το ορθογώνιο δ της Εικόνας 8.6 προκύπτει με αλλαγή του πάχους και του στυλ βούρτσας (περιγράμ-
ματος). Οι επιλογές εμφανίζονται στην Εικόνα 8.8. 

 

 
 
Εικόνα 8.6 Ορθογώνια με διάφορες επιλογές. 

 

 
 
Εικόνα 8.7 Πρόσθετες επιλογές για τη δημιουργία του ορθογωνίου της Εικόνας 8.6γ. 

 

 
 
Εικόνα 8.8 Πρόσθετες επιλογές για τη δημιουργία του ορθογωνίου της Εικόνας 8.6δ. 

 

 
 
Εικόνα 8.9 Έλλειψη με διαφορετικό στυλ βούρτσας στο περίγραμμα. 

 
Με αντίστοιχο τρόπο μπορούμε να δημιουργήσουμε και το σχήμα της Εικόνας 8.9, όπου ξεκινήσαμε 

με μια απλή έλλειψη, αλλάξαμε τα χρώματα και το στυλ βούρτσας. 
Με την επιλογή «Opacity» της εργαλειοθήκης της Εικόνας 8.4, μπορούμε να μειώσουμε την αδιαφά-

νεια των σχημάτων. Δηλαδή, να αυξήσουμε τη διαφάνειά τους, που μπορεί να χρειαστεί σε περιπτώσεις συν-
δυασμού σχημάτων. 

Μέσω του μενού «Object > Transform» μπορούμε να εφαρμόσουμε κάποιο μετασχηματισμό (π.χ. 
Rotate, Scale κ.ά.) σε κάποιο σχήμα που θα επιλέξουμε. Επίσης, με τα εργαλεία Crystallize Tool, Twirl Tool 

κ.ά. που ενεργοποιούνται με τα εικονίδια , μπορούμε να τροποποιήσουμε με 
διάφορους τρόπους τα σχήματα. Τέλος, από το μενού «Effect» μπορούμε να εφαρμόσουμε διάφορα εφέ, ό-
πως μελετήσαμε και στο προηγούμενο κεφάλαιο που αφορούσε στα προγράμματα επεξεργασίας ψηφιογραφι-
κών εικόνων. 

Παρατηρούμε, λοιπόν, ότι με μικρές παρεμβάσεις μπορούμε να δημιουργήσουμε διάφορα σχήματα, 
τα οποία μπορούμε να τα συνδυάσουμε και με κείμενο και να δημιουργήσουμε κάρτες γενεθλίων, λογότυπα 
κ.ά. Θα πρέπει να τονιστεί ότι πρόκειται για ένα ιδιαίτερα «πλούσιο» εργαλείο με πολλές επιλογές, όπου, ό-
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μως, απαιτείται κυρίως φαντασία και δημιουργικότητα για να δημιουργηθούν εντυπωσιακά σχήματα και συν-
θέσεις. 

 

8.1.4. Οργάνωση αντικειμένων 
 
Κατά τη δημιουργία σύνθετων γραφικών, έχουμε τη δυνατότητα να οργανώσουμε τα σχήματα σε πιο σύνθε-
τες δομές, να τα στοιχίσουμε, να τα περικόψουμε με διαφόρους τρόπους. Κάποιες χρήσιμες επιλογές και ερ-
γαλεία είναι: 

 Ομαδοποίηση (grouping) αντικειμένων: επιλέγουμε τα αντικείμενα και με δεξί κλικ εκτε-
λούμε την επιλογή «Group» ή από το μενού εκτελούμε «Object > Group». 

 Μεταφορά σε εμπρός/πίσω επίπεδο: επιλέγουμε ένα αντικείμενο (απλό σχήμα ή ομαδοποι-
ημένο σχήμα) και με δεξί κλικ ή από το μενού «Object > Arrange» μπορούμε να μετακινή-
σουμε το αντικείμενο μπροστά ή πιο πίσω από κάποιο άλλο αντικείμενο ή μπροστά ή πίσω 
από όλα τα αντικείμενα. 

 Στοίχιση αντικειμένων: όταν επιλέγουμε 2 ή περισσότερα αντικείμενα, εμφανίζονται τα ει-
κονίδια της Εικόνας 8.10. Μέσω αυτών μπορούμε να στοιχίσουμε τα αντικείμενα. Για παρά-
δειγμα, στην Εικόνα 8.11 τα δύο πρώτα αντικείμενα δεν είναι στην ίδια ευθεία, ενώ τα ορθο-
γώνια της δεύτερης σειράς είναι οριζοντίως στοιχισμένα. 

 

 
 
Εικόνα 8.10 Εικονίδια στοίχισης αντικειμένων. 

 

 
 
Εικόνα 8.11 Στοιχισμένα και μη στοιχισμένα αντικείμενα. 

 

8.1.5. Συνδυασμός σχημάτων για δημιουργία νέων σχημάτων 
 
Το Illustrator μας δίνει τη δυνατότητα δημιουργίας σύνθετων σχημάτων από απλούστερα σχήματα. Ένας τρό-
πος για συνδυασμό σχημάτων είναι η χρήση της επιλογής «Window > Pathfinder». Εμφανίζεται το παράθυ-
ρο της Εικόνας 8.12. Στην Εικόνα 8.13 βλέπουμε 4 σχήματα. Το αρχικό αποτελείται από ένα ορθογώνιο και 
έναν κύκλο, το οποίο απλά έχει τοποθετηθεί το ένα πάνω στο άλλο. Τα άλλα τρία σχήματα προέκυψαν με 
εφαρμογή κάποιων επιλογών του παραθύρου της Εικόνας 8.12. Για παράδειγμα, επιλέχθηκαν τα αρχικά σχή-
ματα και έγινε κλικ στο εικονίδιο  που ονομάζεται «Minus Front» και πρακτικά κάνει αφαίρεση του τμή-
ματος του σχήματος που βρίσκεται στο πρώτο επίπεδο, μπροστά από τα άλλα. Αντίστοιχα, δημιουργήθηκαν 
και τα άλλα σχήματα. 
 

 
 
Εικόνα 8.12 Επιλογές συνδυασμού σχημάτων. 

 
Στην Εικόνα 8.14 έχει εφαρμοστεί η επιλογή «Object > Blend > Make». Αρχικά, δημιουργήσαμε τα 

δύο σχήματα, δηλαδή τον κύκλο και το αστέρι. Έπειτα, τα επιλέξαμε και εφαρμόσαμε την επιλογή τρείς φο-
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ρές. Κάθε φορά αλλάζαμε το βήμα δημιουργίας των ενδιάμεσων σχημάτων, ώστε να δημιουργούνται περισ-
σότερα βήματα. Αυτό γίνεται μέσω της επιλογής «Object > Blend > Blend Options > Spacing > Specified 
Steps». Η συγκεκριμένη τεχνική είναι παρόμοια με την τεχνική morphing, όπου ξεκινάμε από ένα αρχικό 
σχήμα, το οποίο σταδιακά μετασχηματίζεται σε κάποιο άλλο. 

 

 
 
Εικόνα 8.13 Αρχικά σχήματα και σχήματα που έχουν παραχθεί με κάποιες από τις επιλογές της Εικόνας 8.12. 

 

 
 
Εικόνα 8.14 Σχήματα που έχουν παραχθεί με το Blend. 

 

8.1.6. Εφέ κειμένου 
 
Το κείμενο παίζει σημαντικό ρόλο στη δημιουργία σύνθετων έργων με διανυσματικά γραφικά. Εισάγεται με 

το εικονίδιο . Κάνουμε κλικ στο εικονίδιο, κλικ στο έργο και γράφουμε το κείμενο. Στο πάνω μέρος της 
οθόνης εμφανίζονται επιλογές σχετικά με το χρώμα, τη γραμματοσειρά, το περίγραμμα κ.ά. Έτσι μπορούμε 
να μορφοποιήσουμε το κείμενο. Για παράδειγμα, το κείμενο της Εικόνας 8.15 έχει μορφοποιηθεί με τις επι-
λογές που εμφανίζονται στην Εικόνα 8.16. 

Αν κρατήσουμε πατημένο το παραπάνω εικονίδιο, θα διαπιστώσουμε ότι εμφανίζονται και άλλα ει-
κονίδια με διαφορετική φορά στη γραφή του κειμένου. Αρκετά ενδιαφέρον είναι το εικονίδιο «Type on a 
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Path Tool» , που ουσιαστικά γράφει το κείμενο που πληκτρολογούμε πάνω στο περίγραμμα ενός σχήμα-
τος. Πρώτα πρέπει να δημιουργήσουμε το σχήμα, έπειτα να κάνουμε κλικ στο εικονίδιο και μετά κλικ πάνω 
στο σχήμα και να γράψουμε. Το περίγραμμα στη συνέχεια δεν εμφανίζεται. Για παράδειγμα, στην Εικόνα 
8.17 είχαμε δημιουργήσει αρχικά μια έλλειψη και ένα τμήμα κύκλου (τόξο). Με χρήση του «Type on a Path 
Tool» δημιουργήσαμε το κείμενο πάνω σ’ αυτά τα σχήματα. Επιπλέον, μορφοποιήσαμε διαφορετικά το κεί-
μενο σε κάθε περίπτωση. 

 

 
 
Εικόνα 8.15 Κείμενο με γέμισμα γραμμάτων. 
 

 
 
Εικόνα 8.16 Επιλογές μορφοποίησης κειμένου. 
 

 

 
 
Εικόνα 8.17 Κείμενο πάνω σε κάποιο μονοπάτι. 

 

8.1.7. 3Δ κείμενο 
 
Σε ένα νέο έργο πρέπει να δημιουργήσουμε το σχήμα και το κείμενο της Εικόνας 8.18. Η γραμματοσειρά εί-
ναι Segoe Script, bold, μέγεθος 120. Στη συνέχεια επιλέγουμε μόνο το κείμενο και εκτελούμε δεξί κλικ και 
«Create Outlines» ή το μενού «Type > Create Outlines». Αυτό γίνεται για να μετατραπεί το κείμενο σε 
σχήμα, το οποίο μπορούμε στη συνέχεια να επεξεργαστούμε. Επίσης, την τεχνική αυτή την εφαρμόζουμε, 
όταν θέλουμε να διανείμουμε το έργο και δεν χρειάζεται να ανησυχούμε για το αν υπάρχει η γραμματοσειρά 
που χρησιμοποιήσαμε. Η έλλειψη χρησιμοποιείται, απλά για να αναδειχτεί καλύτερα το τελικό αποτέλεσμα. 

 
 

 
 
Εικόνα 8.18 Αρχικό κείμενο που θα μετατρέψουμε σε 3Δ. 
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Εικόνα 8.19 Ρυθμίσεις μετατροπής κειμένου σε 3Δ. 

 

 
 
Εικόνα 8.20 Κείμενο σε μορφή 3Δ. 

 

 
 
Εικόνα 8.21 Διαφορετικά χρώματα γεμίσματος και περιγράμματος. 

 
Στη συνέχεια πρέπει να επιλέγουμε το κείμενο και να επιλέξουμε «Effect > 3D > Extrude & Bevel». 

Εφαρμόζουμε τις ρυθμίσεις της Εικόνας 8.19. Έτσι δημιουργείται το αποτέλεσμα της Εικόνας 8.20. Παρατη-
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ρούμε ότι το κείμενο είναι ήδη σε 3Δ και μάλιστα έχει πάρει μια μεταλλική λάμψη. Μπορούμε, αν θέλουμε, 
να αλλάξουμε τα χρώματα, ώστε να πειραματιστούμε για να παραχθεί κάτι πιο θελκτικό (π.χ. Εικόνα 8.21). 

Μπορούμε να προχωρήσουμε το παράδειγμα, χρησιμοποιώντας την εντολή διαίρεσης των αντικειμέ-
νων. Η συγκεκριμένη τεχνική μας δίνει τη δυνατότητα να διαιρέσουμε ένα μεμονωμένο αντικείμενο σε πολλά 
αντικείμενα, τα οποία συνθέτουν την εμφάνισή του. Πρώτα, πρέπει να αντιγράψουμε το κείμενο στο έργο και 
μετά στο αντίγραφο του κειμένου να εφαρμόσουμε την επιλογή «Object > Expand Appearance». Πρακτικά, 
λοιπόν, το αντίγραφο του κειμένου το έχουμε διαιρέσει σε δύο τμήματα: στην πρόσοψη, που είναι γκρι, και 
στο 3Δ τμήμα, που είναι άσπρο. 

 

 
 
Εικόνα 8.22 Βήματα επιλογής της πρόσοψης του κειμένου. 
 

 
 
Εικόνα 8.23 Τελικό κείμενο με διάφορα εφέ. 

 
Έπειτα, πρέπει να επιλέξουμε το μπροστά τμήμα του 2ου κειμένου που κάναμε expand. Αυτό γίνεται 

με shift-κλικ σε κάθε γράμμα και προκύπτει η επιλογή του γκρι τμήματος (Εικόνα 8.22α). Κάνουμε αντιγρα-
φή του επιλεγμένου κειμένου, μετά σβήνουμε όλο το κείμενο και κάνουμε επικόλληση. Έτσι προκύπτει η Ει-
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κόνα 8.22β. Τη νέα πρόσοψη μπορούμε να την τοποθετήσουμε πάνω στο κείμενο της έλλειψης και να εφαρ-
μόσουμε διάφορα εφέ. Για παράδειγμα, στην Εικόνα 8.23α απλά αλλάξαμε το χρώμα της πρόσοψης σε ά-
σπρο. Στην Εικόνα 8.23β αλλάξαμε το χρώμα του κειμένου σε κόκκινο και εφαρμόσαμε το εφέ Inner Glow 
(«Effect > Stylize > Inner Glow») στο μπροστινό τμήμα του κειμένου. 

 

8.1.8. Κείμενο με εικόνες στα γράμματα 
 
Στην Εικόνα 8.24 βλέπουμε μια λέξη, όπου τα γράμματα αποτελούν τμήμα εικόνας. Στο συγκεκριμένο παρά-
δειγμα, τα γράμματα της λέξης Parthenon περιέχουν τμήματα του Παρθενώνα. Χρησιμοποιήθηκε Αγγλική 
λέξη, γιατί είναι πιο εύκολο να βρεθούν κατάλληλες γραμματοσειρές. Αρχικά, λοιπόν, πληκτρολογήσαμε το 
κείμενο με γραμματοσειρά Ravie και μέγεθος 80. Δημιουργήθηκε το πρώτο κείμενο της Εικόνας 8.25. 
 

 
 
Εικόνα 8.24 Κείμενο με εικόνες στα γράμματα. 

 
Στη συνέχεια, πρέπει να το μετατρέψουμε σε σχήμα με την εντολή «Type > Create Outlines». Κάθε 

γράμμα είναι στην πράξη ξεχωριστό σχήμα. Για να μπορέσει να εφαρμοστεί η τεχνική που θέλουμε, πρέπει να 
ενωθούν σε ένα αντικείμενο. Αυτό επιτυγχάνεται με επιλογή του κειμένου και με την εφαρμογή της επιλογής 
«Object > Compound Path > Make». Θα εμφανιστεί το κείμενο με την τρίτη μορφή της Εικόνας 8.25.  

Έπειτα πρέπει να εισάγουμε τη φωτογραφία του Παρθενώνα. Αυτό γίνεται με το μενού «File > 
Place». Προσαρμόζουμε το μέγεθος της φωτογραφίας και μεταφέρουμε το κείμενο πάνω στη φωτογραφία. 
Επιλέγουμε και τα δύο αντικείμενα και εκτελούμε «Object > Clipping Mask > Make» και τελικά προκύπτει 
η Εικόνα 8.24. Η εντολή αυτή ουσιαστικά αποκόπτει το αντικείμενο που βρίσκεται στο πίσω επίπεδο στα ό-
ρια του μπροστά αντικειμένου. 

 
 

 
 
Εικόνα 8.25 Διαδοχικά βήματα για τη δημιουργία της Εικόνας 8.24. 
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8.1.9. Χρήση βουρτσών και εργαλείου spayer για δημιουργία σχεδίων 
 
Το Illustrator διαθέτει διάφορες βούρτσες (brushes) με τις οποίες μπορούμε να δημιουργήσουμε σχέδια, αλλά 
και να διορθώσουμε διάφορα σημεία σε κάποιες φωτογραφίες. Οι βούρτσες επιλέγονται μέσω του εργαλείου 

«Paintbrush Tool» . Εμφανίζεται το παράθυρο της Εικόνας 8.26. Αν δεν εμφανιστεί το παράθυρο, επιλέξ-
τε «Window > Brushes». Στη συνέχεια, μπορούμε να κάνουμε κλικ σε κάποια από τα σχέδια και να σύρουμε 
τη βούρτσα πάνω στην επιφάνεια σχεδίασης. 

Με κλικ στο εικονίδιο που βρίσκεται στο κόκκινο τετράγωνο της Εικόνας 8.26, μπορούμε να εμφανί-
σουμε και άλλες βούρτσες. Στην Εικόνα 8.27, εμφανίζεται η κατηγορία βουρτσών «Borders_Decorative». 
Κάνοντας κλικ σε κάποιο στυλ βούρτσας, προστίθεται στο βασικό παράθυρο και μπορούμε μετά να τη χρησι-
μοποιήσουμε, σύροντας το ποντίκι μας πάνω στην οθόνη. 

Μπορούμε να αλλάξουμε το γραφικό που προκύπτει από την εφαρμογή μιας βούρτσας. Απλά το επι-
λέγουμε με κλικ και κάνουμε κλικ σε κάποιο άλλο σχέδιο βούρτσας. Επίσης, μπορούμε να εφαρμόσουμε κά-
ποιο εφέ από το μενού «Effect» ή να εφαρμόσουμε κάποιο μετασχηματισμό από το μενού «Object > 
Transform». 

 

 
 
Εικόνα 8.26 Παράθυρο με στυλ βουρτσών. 
 

 
 
Εικόνα 8.27 Επιπρόσθετες βούρτσες στην κατηγορία «Borders_Decorative». 

 

 
 
Εικόνα 8.28 Επιπρόσθετα σύμβολα στην κατηγορία «Flowers». 
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Στην ίδια λογική λειτουργεί και το εργαλείο «Symbol Sprayer Tool» . Το εργαλείο αυτό «ψεκά-
ζει» σύμβολα. Με την επιλογή του εμφανίζεται το παράθυρο της Εικόνας 8.26, μόνο που τώρα είναι ενεργο-
ποιημένη η καρτέλα «Symbols». Με κλικ στο εικονίδιο που βρίσκεται στο κόκκινο ορθογώνιο της Εικόνας 
8.26 εμφανίζονται επιπλέον σύμβολα, π.χ. Εικόνα 8.28. Με κλικ σε κάποιο από αυτό, προστίθεται και μπο-
ρούμε στη συνέχεια να τα «ψεκάσουμε» στο έργο μας, δημιουργώντας κάποια σύνθεση (π.χ. Εικόνα 8.29) 
που θα μπορούσαμε να χρησιμοποιήσουμε στη δημιουργία κάποιας ευχετήριας κάρτας, κάποιας διαφήμισης 
κ.ά.  

 

 
 
Εικόνα 8.29 Σύνθεση με σύμβολα. 

 

8.1.10. Δημιουργία σύνθετων σχημάτων 
 
Στο παράδειγμα αυτό θα δημιουργήσουμε ένα πιο σύνθετο σχήμα, χρησιμοποιώντας κάποιες από τις τεχνικές 
που διδαχθήκαμε πιο πάνω. Στην Εικόνα 8.30 βλέπουμε τα διαδοχικά βήματα δημιουργίας ενός καρτούν που, 
με λίγη φαντασία, μοιάζει με μικρό χταπόδι.  

Αρχικά, σχεδιάζουμε ένα ορθογώνιο με στρογγυλεμένες άκρες (Εικόνα 8.30α) και στη συνέχεια προ-
σθέτουμε έναν κύκλο πάνω του, ώστε ο μισός κύκλος να είναι ακριβώς πάνω στο ορθογώνιο και το άλλο μισό 
να προεξέχει (Εικόνα 8.30β). 

 

 
 

Εικόνα 8.31 Προσαρμογή γραμμής 

 
Για τη δημιουργία των ποδιών πρέπει να παιδευτούμε λίγο περισσότερο. Αυτό θα γίνει με χρήση του 

«Pen Tool» . Επιλέγουμε το εργαλείο, κάνουμε κλικ στα κατάλληλα χρώματα και στην επιλογή «stroke» 
στο πάνω μέρος της οθόνης. Εμφανίζεται το παράθυρο της Εικόνας 8.31, στο οποίο προσαρμόζουμε το 
«Weight», ώστε να αλλάξουμε το πάχος της γραμμής, το «Cap», ώστε να αλλάξει το τελείωμα της γραμμής 
σε πιο στρογγυλό και το «Limit» που επηρεάζει τη γωνία σύνδεσης με το σχήμα. Στη συνέχεια, κάνουμε κλικ 
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στο σώμα του χταποδιού και σύρουμε το ποντίκι, ώστε να πετύχουμε κάποιο αντίστοιχο πόδι. Επιλέγουμε το 
πόδι και το μετατρέπουμε σε σχήμα, από γραμμή, με την εντολή «Object > Expand». Η ενέργεια αυτή διευ-
κολύνει την αντιγραφή και περιστροφή του ποδιού. 

 

 
 
Εικόνα 8. 30 Διαδοχικές φάσεις δημιουργίας ενός καρτούν που μοιάζει με χταπόδι. 

 
Αφού φτιάξουμε το ένα πόδι, μπορούμε να το αντιγράψουμε και να το περιστρέψουμε, καταλήγοντας 

στην Εικόνα 8.30γ, και έπειτα επιλέγουμε όλα τα πόδια και τα αντιγράφουμε και τα επικολλούμε. Έχοντας 
επιλεγμένα τα πόδια, εκτελούμε «Object > Transform > Reflect > Vertical», ώστε να αλλάξει ο προσανα-
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τολισμός τους. Στη συνέχεια, τα τοποθετούμε από την άλλη πλευρά του σώματος και καταλήγουμε στην Ει-
κόνα 8.30δ. 

Στη συνέχεια, επιλέγουμε όλα τα τμήματα και τα ομαδοποιούμε με δεξί κλικ και «Group». Με αντι-
γραφή/επικόλληση δημιουργούμε αντίγραφο του σχεδίου και το τοποθετούμε πάνω στο άλλο. Αυτό χρειάζε-
ται, ώστε αν χρειαστεί, να τροποποιηθεί μόνο το αντίγραφο του χταποδιού που είναι στο προσκήνιο. 

Στο επόμενο βήμα δημιουργούμε μερικούς κύκλους με πιο ανοιχτό ροζ και opacity περίπου 70%, ώ-
στε να μοιάζει περίπου στο σχήμα της Εικόνας 8.30ε. Στη συνέχεια, ομαδοποιούμε τους κύκλους και επιλέ-
γουμε τους ομαδοποιημένους κύκλους και το μπροστινό αντίγραφο του χταποδιού. Με επιλεγμένα τα δύο 
σχήματα, επιλέγουμε «Window > Pathfinder» και Alt και κλικ στο εικονίδιο «Intersect» . Δημιουργούνται 
έτσι τα ροζ ανοιχτά σχήματα που βλέπουμε πάνω στο χταπόδι στην Εικόνα 8.30στ. Το βήμα αυτό χρειάζεται 
για να δημιουργηθούν πιο εύκολα τα ροζ σχήματα. Θα μπορούσαμε να τα σχεδιάσουμε και με χρήση του ερ-
γαλείου Pen tool, απλά θα ήθελε περισσότερο κόπο. Αν μετακινήσετε το χταπόδι που βρίσκεται στο παρα-
σκήνιο της φωτογραφίας, θα δείτε ότι η ενέργεια Intersect έχει διαγράψει στην ουσία το ένα χταπόδι λόγω της 
τομής του με τους κύκλους. Γι’ αυτό χρειαζόταν η δημιουργία του αντιγράφου του χταποδιού. 

Στο τελευταίο στάδιο δημιουργούμε κάθε μάτι ως 3 ξεχωριστούς κύκλους, περίπου ομόκεντρους. 
Παρατηρούμε ότι η δημιουργία ενός σύνθετου διανυσματικού γραφικού, είναι μια διαδικασία που απαιτεί 
καλή γνώση των δυνατοτήτων του εργαλείου, αλλά και φαντασία. Το αποτέλεσμα μπορεί να είναι εντυπωσι-
ακό και με τις δυνατότητες των εργαλείων επεξεργασίας μπορούμε να του αλλάξουμε χρώματα (π.χ. Εικόνα 
8.32), να το μεγεθύνουμε, να το περιστρέψουμε κ.ά.   

 

 
 
Εικόνα 8.32 Διαφορετικά γεμίσματα και μέγεθος. 

 

8.2. Inkscape 
 
Το Inkscape (https://inkscape.org/en/download/) είναι ένα δωρεάν πρόγραμμα ανοιχτού κώδικα για την επε-
ξεργασία διανυσματικών γραφικών. Το βασικό μορφότυπο που υποστηρίζει είναι το SVG (Scalable Vector 
Graphics). Φυσικά, διαβάζει και άλλα γνωστά μορφότυπα, π.χ. ai, cdr, eps κ.ά., αλλά το SVG, «κλιμακώσιμα 
διανυσματικά γραφικά», όπως τα ονομάζει, αποτελεί τη βασική μορφοποίηση. Μπορεί να διαβάσει και να ε-
ξάγει και αρκετές μορφές ψηφιογραφικών γραφικών, π.χ. jpg, png κ.ά. Η τελευταία έκδοση κατά τη συγγρα-
φή του βιβλίου είναι η 0.91. 

Στην ιστοσελίδα https://inkscape.org/en/doc/basic/tutorial-basic.el.html και στην ιστοσελίδα 
https://inkscape.org/en/doc/advanced/tutorial-advanced.el.html υπάρχουν κάποια μαθήματα στα Ελληνικά. 
Στη διεύθυνση https://inkscape.org/en/learn/ υπάρχει πιο ολοκληρωμένη σειρά μαθημάτων στα Αγγλικά. 

 

8.2.1. Γνωριμία με το Inkscape 
 

Το περιβάλλον εργασίας του Inkscape εμφανίζεται στην Εικόνα 8.33. Παρατηρούμε ότι τα μενού επιλογών 
διατίθενται στα Ελληνικά, στοιχείο που βοηθά στη χρήση του εργαλείου. 

 Στο σημείο 1 της Εικόνας 8.33 εμφανίζονται τα μενού επιλογών του εργαλείου.  
 Στο σημείο 2 υπάρχει η βασική συλλογή εργαλείων (εργαλειοθήκη) του Inkscape. 
 Στο σημείο 3 εμφανίζονται κάποιες επιλογές και πλαίσια ρυθμίσεων, ανάλογα με το επιλεγ-

μένο εργαλείο της εργαλειοθήκης. 
 Στο κέντρο της οθόνης, στο σημείο 4, εμφανίζεται η εικόνα που επεξεργαζόμαστε. 
 Στα σημεία 5 και 6 υπάρχουν διάφορες επιπλέον καρτέλες εργαλείων, που επιτρέπουν διάφο-

ρες επεξεργασίες επί των εικόνων.  
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Εικόνα 8.33 Το περιβάλλον εργασίας του Inkscape 0.91. 
 

8.2.2. Δημιουργία και διαχείριση βασικών σχημάτων 
 

Η δημιουργία βασικών σχημάτων γίνεται με κλικ σε κάποιο από τα εικονίδια  από την εργαλειο-
θήκη και σύρσιμο του ποντικιού στην επιφάνεια σχεδίασης (π.χ. Εικόνα 8.34). Στο πάνω μέρος της οθόνης 
εμφανίζονται κάποιες επιλογές για κάθε σχήμα. Για παράδειγμα, όταν σχηματίσουμε ένα πολύγωνο, εμφανί-
ζεται στο πάνω μέρος η επιλογή για αλλαγή σε αστέρι ή παραμονή σε πολύγωνο και ο αριθμός των γωνιών 
που θα έχει το σχήμα. 

Η αποθήκευση ενός έργου σε μορφή png γίνεται με την επιλογή «Αρχείο > Εξαγωγή εικόνας PNG». 
Στη δεξιά πλευρά εμφανίζονται κάποιες επιλογές σχετικά με την εξαγωγή εικόνας, όπου μπορούμε μεταξύ 
άλλων, να ορίσουμε, αν θα εξαχθεί όλη η σελίδα ή κάποια επιλεγμένα σχήματα, ποιες θα είναι οι διαστάσεις 
και ποια θα είναι η ανάλυση της εικόνας. 

Ο χρωματισμός ενός αντικειμένου μπορεί να γίνει με κλικ στο αντικείμενο και κλικ σε κάποιο από τα 
χρώματα στο κάτω μέρος του εργαλείου. Στο σημείο 6 της Εικόνας 8.33, εμφανίζονται οι επιλογές 

 «Γέμισμα» και «Πινελιά». Η πρώτη επιλογή αφορά το γέμισμα και η δεύτερη το χρώμα περι-
γράμματος. Με διπλό κλικ σε κάποιο από τα δύο χρώματα, ανοίγει στα δεξιά ένα παράθυρο καθορισμού χρώ-
ματος σε κάποιο χρωματικό μοντέλο που θα επιλέξουμε. Επιπλέον, εκεί υπάρχουν και οι επιλογές «Αδιαφά-
νεια» και «Θόλωση». Οι επιλογές για τον χρωματισμό, την αδιαφάνεια και τη θόλωση υπάρχουν και στο με-
νού «Αντικείμενο > Γέμισμα και Πινελιά» και εμφανίζονται και με δεξί κλικ στο αντικείμενο. Στην Εικόνα 
8.35 βλέπουμε 3 αστέρια, όπου το πρώτο αστέρι έχει 15% θόλωση και το τρίτο αστέρι έχει αδιαφάνεια 20%. 
Όλα τα σχήματα έχουν πινελιά (περίγραμμα) κόκκινο. 

 

 
 
Εικόνα 8.34 Κάποια βασικά σχήματα στο Inkscape. 
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Εικόνα 8.35 Σχήματα με διαφορετική θόλωση και αδιαφάνεια. 

 
Παρατηρούμε ότι τα 3 αστέρια της Εικόνας 8.35 είναι ευθυγραμμισμένα και κατανεμημένα σε σχέση 

με την έλλειψη. Αυτό γίνεται με επιλογή των αστεριών και χρήση του μενού «Αντικείμενο > Ευθυγράμμιση 
και Κατανομή». Στη συνέχεια, πρέπει να κάνουμε την κατάλληλη επιλογή από το παράθυρο που εμφανίζε-
ται. Από το μενού «Αντικείμενο» μπορούμε να επιλέξουμε τις επιλογές «Ανύψωση», «Βύθιση», «Ανύψωση 
στην κορυφή», «Βύθιση στον πυθμένα» για μετακίνηση ενός αντικείμενου μπροστά, ή πίσω από κάποιο 
άλλο, ή μπροστά, ή πίσω από όλα τα αντικείμενα. 

 

8.2.3. Επιπλέον επιλογές τροποποίησης και συνδυασμού σχημάτων 
 
Στο πιο πάνω θέμα είδαμε κάποιες βασικές λειτουργίες διαχείρισης σχημάτων. Το Inkscape προσφέρει αρκε-
τές επιπλέον δυνατότητες τροποποίησης των σχημάτων. 

Στο παράθυρο γεμίσματος και πινελιών εμφανίζονται και τα εικονίδια , που αλλάζουν το 
μοτίβο γεμίσματος. Το πρώτο εικονίδιο έχει ως αποτέλεσμα συμπαγές χρώμα γεμίσματος, το δεύτερο γραμ-
μική διαβάθμιση, το τρίτο ακτινωτή διαβάθμιση και το τελευταίο γέμισμα με μοτίβο. Τα αποτελέσματα της 
εφαρμογής τους φαίνονται στην Εικόνα 8.36. Ειδικά για το γέμισμα με μοτίβο, όταν το επιλέξουμε, τότε εμ-
φανίζει κάτω από το εικονίδιο τη λίστα επιλογών «Γέμισμα με μοτίβο», από την οποία μπορούμε να επιλέ-
ξουμε το σχέδιο γεμίσματος. 

 

 
 
Εικόνα 8.36 Σχήματα με διαφορετικές διαβαθμίσεις γεμίσματος. 

 
Πρέπει να σημειωθεί ότι μπορούμε να δημιουργήσουμε και τα δικά μας μοτίβα γεμίσματος. 

Δημιουργούμε ένα σχήμα, π.χ. το αστεράκι της Εικόνας 8.37 στο οποίο εφαρμόσαμε και ακτινωτή 
διαβάθμιση. Σχεδιάζουμε και κάποιο άλλο σχήμα, π.χ. τον κύκλο της Εικόνας 8.37. Επιλέγουμε το αστεράκι 
και εκτελούμε «Αντικείμενο > Μοτίβο > Αντικείμενο σε μοτίβο». Στη συνέχεια επιλέγουμε τον κυκλο και 
στο παράθυρο «Γέμισμα και πινελιά» επιλέγουμε το εικονίδιο  για γέμισμα με μοτίβο. Στη λίστα επιλογών 
«Γέμισμα με μοτίβο» επιλέγουμε το μοτίβο που έχει όνομα που ξεκινά με τη λέη pattern. Προκύπτει έτσι το 
σχήμα της Εικόνας 8.38. 

Με το εργαλείο «Επεξεργασία μονοπατιών μέσω των κόμβων τους»  μπορούμε να τροποποιή-
σουμε τα σχήματα. Για παράδειγμα, στην Εικόνα 8.39 εμφανίζονται τροποποιημένα τα αντικείμενα της Εικό-
νας 8.37. Το αστέρι μπορεί απευθείας να τροποποιηθεί με το συγκεκριμένο εργαλείο, διότι ο τρόπος που απο-
τελείται εξαρχής από μονοπάτια, δηλαδή τμήματα γραμμών. Ο κύκλος, όμως, πρέπει πρώτα να τροποποιηθεί 
με χρήση του εικονιδίου «Μετατροπή του συγκεκριμένου αντικειμένου σε μονοπάτι» , που εμφανίζεται 
στο πάνω μέρος της οθόνης. Έπειτα, μπορούμε να τον τροποποιήσουμε σε όποιο σχήμα θέλουμε. 

Με την επιλογή «Αντικείμενο > Μετασχηματισμός» εμφανίζεται ένα παράθυρο, όπου μας δίνει τη 
δυνατότητα να κάνουμε «Μετακίνηση», «Κλιμάκωση», «Περιστροφή», «Στρέβλωση» ενός ή περισσοτέ-
ρων αντικειμένων. 

Στην Εικόνα 8.40 βλέπουμε το αποτέλεσμα κάποιων τεχνικών ενοποίησης μεμονωμένων αντικειμέ-
νων. Το πρώτο σχήμα αποτελείται από ένα ορθογώνιο και ένα αστέρι. Το δεύτερο σχήμα προέκυψε από την 
εφαρμογή της επιλογής «Μονοπάτι > Διαφορά» στα δύο αρχικά σχήματα. Το τρίτο σχήμα προέκυψε από την 
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επιλογή «Μονοπάτι > Τομή» και το τέταρτο από την επιλογή «Μονοπάτι > Διαίρεση». Αυτές είναι κάποιες 
από τις επιλογές που βρίσκονται κάτω από το μενού «Μονοπάτι» και μας επιτρέπουν τον συνδυασμό των 
σχημάτων σε νέα σχήματα. 

 

 
 

Εικόνα 8.37 Σχήματα για τη δημιουργία μοτίβου. 
 

 
 

Εικόνα 8.38 Σχήμα με το δικό μας μοτίβο. 

 

 
 

Εικόνα 8.39 Σχήματα που έχουν επεξεργαστεί με το εργαλείο επεξεργασίας μονοπατιών. 

 

 
 

Εικόνα 8.40 Σχήματα που έχουν συνδυαστεί. 

 

8.2.4. Χρήση βουρτσών 
 
Το εικονίδιο «Σχεδίαση πινελιών καλλιγραφικών ή βούρτσας»  χρησιμοποιείται για τη δημιουργία λωρί-
δων, που έχουν κάποιο χρώμα ως γέμισμα και κάποιο μοτίβο. Όταν επιλέξουμε το εργαλείο, στο πάνω μέρος 
εμφανίζονται κάποιες επιλογές για το σχέδιο, το πάχος κ.ά. της βούρτσας. Στην Εικόνα 8.41 εφαρμόσαμε μια 
βούρτσα στο κάτω μέρος του σχεδίου (η άσπρη λωρίδα) και δημιουργήθηκε ένα εφέ αντανάκλασης του φεγ-
γαριού στο νερό.  
 

 
 
Εικόνα 8.41 Δημιουργική χρήση βούρτσας. 
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8.2.5. Εισαγωγή κειμένου και εφέ κειμένου 
 
Η εισαγωγή κειμένου γίνεται με κλικ στο εικονίδιο «Δημιουργία και επεξεργασία αντικειμένων κειμένου» 

. Όταν επιλεγεί το εργαλείο, στο πάνω μέρος της οθόνης εμφανίζεται ένα σύνολο ρυθμίσεων, που μας επι-
τρέπουν διάφορες ρυθμίσεις (π.χ. Εικόνα 8.42). Το χρώμα αλλάζει με τις ρυθμίσεις του γεμίσματος και πινε-
λιάς. Τα γράμματα μπορούν να ανυψωθούν ή να γείρουν, με τις ρυθμίσεις που εμφανίζονται στο πάνω μέρος 
της οθόνης, με τα εικονίδια της «Κατακόρυφης μετατόπισης»  και «Περιστροφή χαρακτήρων» .  

 

 
 
Εικόνα 8.42 Παράδειγμα κειμένου με διαφορετικές ρυθμίσεις. 

 

 
 
Εικόνα 8.43 Εφαρμογή διαφορετικών φίλτρων στο κείμενο. 

 

 
 
Εικόνα 8.44 Εικόνα μέσα σε κείμενο. 
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Στο προτελευταίο κείμενο της Εικόνας 8.42 έχει προστεθεί περίγραμμα (πινελιά) και στο τελευταίο 

έχει προστεθεί μοτίβο στο περίγραμμα. Παρατηρούμε, λοιπόν, ότι με απλές παρεμβάσεις, δημιουργούμε απλά 
εφέ κειμένου, που σε συνδυασμό με άλλα αντικείμενα μπορούν να οδηγήσουν σε όμορφες συνθέσεις διανυ-
σματικών γραφικών. 

Στο κείμενο μπορούμε να εφαρμόσουμε και διάφορα εφέ, από το μενού «Φίλτρα». Για παράδειγμα, 
στην Εικόνα 8.43 έχουν εφαρμοστεί διάφορα φίλτρα στο κείμενο με εντυπωσιακά αποτελέσματα. 

Στην Εικόνα 8.44 εμφανίζεται το αποτέλεσμα της εισαγωγής μιας εικόνας ως μοτίβο ενός κειμένου. 
Εισάγουμε την εικόνα στο έργο μας με χρήση του μενού «Αρχείο > Εισαγωγή».  

Έπειτα, εφαρμόζουμε στην εικόνα την επιλογή «Αντικείμενο > Μοτίβο > Αντικείμενο σε μοτίβο». 
Στη συνέχεια, επιλέγουμε το κείμενο και στο παράθυρο «Γέμισμα και πινελιά» επιλέγουμε το εικονίδιο  
για γέμισμα με μοτίβο. Στη λίστα επιλογών «Γέμισμα με μοτίβο» επιλέγουμε το μοτίβο, το οποίο έχει όνομα 
που ξεκινά με τη λέξη pattern. Προκύπτει, έτσι, το δεύτερο κείμενο της Εικόνας 8.44. 

 

8.2.6. Επεκτάσεις 
 
Στο Inkscape μπορούν να προστεθούν διάφερες επεκτάσεις που προσφέρουν διάφορες δυνατότητες. Ανα-
πτύσσονται από ανεξάρτητους προγραμματιστές. Η έκδοση 0.91 έχει πάρα πολλές επεκτάσεις ενσωματωμέ-
νες στο μενού «Επεκτάσεις». Για παράδειγμα, με την επέκταση «Απόδοση > Ραβδωτός κώδικας > Κλασι-
κό» μπορούμε να δημιουργήσουμε τον αντίστοιχο κώδικα για τον αριθμό ISBN (Εικόνα 8.45). Ενώ με την 
επιλογή «Απόδοση > Ραβδωτός κώδικας > Κώδικας QR» μπορούμε να δημιουργήσουμε κώδικα QR. Στην 
Εικόνα 8.46 βλέπουμε τον κώδικα για το κείμενο www.inkscape.org. 
 

 

  
 
Εικόνα 8.45 Αριθμός ISBN ως ραβδωτός κώδικας. 

 
 

 
 

Εικόνα 8.46 Κώδικας QR. 

 
 

8.2.7. Δημιουργία σύνθετων σχημάτων 
 
8.2.7.1. Επέκταση θέματος 2.5 
 
Στην Εικόνα 8.47 εμφανίζεται μια πιο επεξεργασμένη απεικόνιση της φωτογραφίας 8.41. Αρχικά, δημιουρ-
γήσαμε έναν δεύτερο κύκλο (φεγγάρι) με λευκό χρώμα, μεγαλύτερης διαμέτρου, τον οποίο τοποθετήσαμε 
πάνω στο φεγγάρι που ήδη υπήρχε. Στη συνέχεια εφαρμόσαμε στον δεύτερο κύκλο θόλωση περίπου 40% (δες 
θέμα 2.2.).  

Στη συνέχεια, κάναμε διπλασιασμό της αντανάκλασης, δηλαδή της λευκής λωρίδας που υπάρχει στη 
θάλασσα, και αυξήσαμε το πλάτος της, ώστε να καλύπτει τη θάλασσα. Εφαρμόστηκε αδιαφάνεια περίπου 
20% στο νέο σχήμα, ώστε να γίνει, όπως στην Εικόνα 8.47. 
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Εικόνα 8.47 Πιο ρεαλιστική απεικόνιση της Εικόνας 8.41. 

 

8.2.7.2. Συνδυασμός τεχνικών για δημιουργία χαρακτήρα καρτούν 
 
Στο συγκεκριμένο παράδειγμα θα προσπαθήσουμε να συνδυάσουμε διάφορες τεχνικές, ώστε να δημιουργή-
σουμε ένα ζωάκι (πτηνό) ως καρτούν. Μέσα από τη δημιουργία του εξηγούνται διάφορες τεχνικές, κάποιες εκ 
των οποίων είδαμε στα πιο πάνω παραδείγματα.  

Αρχικά, δημιουργούμε δύο κύκλους και τους τοποθετούμε τον έναν πάνω στον άλλο (Εικόνα 8.48). 
Χρησιμοποιήθηκε χρώμα γεμίσματος RGB 123, 46, 9 και πλάτος πινελιάς περίπου 6. Το πλάτος πινελιάς κα-
θορίζεται από το παράθυρο «Αντικείμενο > Γέμισμα και πινελιά > Μορφοποίηση πινελιάς» (δηλαδή την 
τελευταία καρτέλα του παραθύρου). 

Στο επόμενο βήμα δημιουργούμε ένα πιο σκουρόχρωμο τμήμα στους κύκλους (Εικόνα 8.49δ). Η τε-
χνική που ακολουθήσαμε είναι: 

15. Δημιουργήσαμε δύο κύκλους, παρόμοιους με την Εικόνα 8.49α. Το χρώμα των κύκλων δεν 
παίζει ρόλο, γιατί θα αλλάξει στη συνέχεια. Απλά χρησιμοποιήσαμε τον αρχικό καφέ κύκλο 
στο σχήμα που βρίσκεται στο παρασκήνιο, ώστε το τμήμα που θα προκύψει να ταιριάζει α-
κριβώς στον καφέ κύκλο που θα δημιουργηθεί. 

16. Επιλέξαμε τους δύο κύκλους και εκτελέσαμε «Μονοπάτι > Διαφορά». Προέκυψε με αυτό 
τον τρόπο το τμήμα που εμφανίζεται στην Εικόνα 8.49β. 

17. Αλλάξαμε το χρώμα γεμίσματος σε μαύρο και την αδιαφάνεια σε 20%, μέσω του μενού «Α-
ντικείμενο > Γέμισμα και πινελιά» και προέκυψε το σχήμα της Εικόνας 8.49γ, το οποίο το-
ποθετήσαμε στον πρώτο καφέ κύκλο του σχήματος 8.49δ. 

18. Επαναλάβαμε τα βήματα 1 ως και 3 για να δημιουργηθεί το σκουρόχρωμο τμήμα του δεύτε-
ρου καφέ κύκλου της Εικόνας 8.49δ. 

 
 

  
 

Εικόνα 8.48 Αρχικοί κύκλοι σχήματος. 

 
Στα επόμενα βήματα δημιουργήσαμε τα μάτια, το ράμφος και το λειρί του πτηνού που προσπαθούμε 

να φτιάξουμε (Εικόνα 8.50). Τα μάτια είναι στην πράξη δύο ελλείψεις, η μία μέσα στην άλλη. Μετά τη δημι-
ουργία του ενός ματιού, μπορούμε να επιλέξουμε τους δύο κύκλους και να τους ομαδοποιήσουμε, με την επι-
λογή «Αντικείμενο > Ομαδοποίηση» ή με δεξί κλικ και «Ομαδοποίηση». Έπειτα, πρέπει να τους αντιγρά-
ψουμε/επικολλήσουμε ή να κάνουμε δεξί κλικ και «Διπλασιασμός», ώστε να δημιουργηθεί το ίδιο σχήμα. 
Με την επιλογή του διπλασιασμού το σχήμα εναποτίθεται ακριβώς πάνω στο προηγούμενο, άρα πρέπει να το 
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μετακινήσουμε. Όταν μετακινήσουμε το δεύτερο μάτι στο σημείο που θέλουμε, μπορούμε να εκτελέσουμε 
«Αντικείμενο > Οριζόντια αντιστροφή», ώστε να δημιουργηθεί ακριβώς το ίδιο σχήμα, αλλά με αντίθετη 
κατεύθυνση. 

 

 
 

Εικόνα 8.49 Δημιουργία σκουρόχρωμου τμήματος στους κύκλους. 

 
Ένας τρόπος για τη δημιουργία του ράμφους εμφανίζεται στην Εικόνα 8.51. Δημιουργήσαμε ένα τρί-

γωνο και έναν κύκλο με ίδιο χρώμα γεμίσματος και μαύρο περίγραμμα και τους τοποθετήσαμε τον έναν πάνω 
στον άλλο, ώστε να μοιάζει με παγωτό χωνάκι! Με την επιλογή «Αντικείμενο > Ένωση» ενοποιήθηκαν σε 
ένα αντικείμενο. Το σμικρύναμε λίγο και προέκυψε το ράμφος της Εικόνας 8.50. Θα μπορούσαμε να δημι-
ουργήσουμε το ίδιο σχήμα με το εργαλείο «Επεξεργασία μονοπατιών μέσω των κόμβων τους» , που με-
λετήσαμε στο θέμα 2.3, ξεκινώντας από ένα τρίγωνο. 

Για το λειρί χρησιμοποιήθηκε το εργαλείο «Σχεδίαση ελεύθερων γραμμών» . Με το συγκεκριμέ-
νο εργαλείο μπορούμε να δημιουργήσουμε γραφικά ελευθέρου σχήματος. Απαιτεί σταθερότητα στο χέρι, για-
τί σύρουμε το ποντίκι πάνω στην οθόνη. Όταν επιλέξουμε το εργαλείο, εμφανίζονται οι επιλογές του εργαλεί-
ου στο πάνω μέρος της οθόνης. Μπορούμε να ορίσουμε την εξομάλυνση σε 50, ώστε να εξομαλυνθεί το τρε-
μόπαιγμα της γραμμής. Επιλέγουμε γέμισμα κόκκινο και πινελιά μαύρη και δημιουργείται το λειρί, το οποίο 
το τοποθετούμε πίσω από το ράμφος του πτηνού. Αντίστοιχο σχήμα θα μπορούσαμε να δημιουργήσουμε, αν 
ξεκινούσαμε από μία έλλειψη και χρησιμοποιούσαμε το εργαλείο «Επεξεργασία μονοπατιών μέσω των 
κόμβων τους» . 

 

 
 

Εικόνα 8.50 Δημιουργία στοιχείων προσώπου. 
 

 
 

Εικόνα 8.51 Δημιουργία ράμφους. 

 
Στο επόμενο βήμα δημιουργούμε τα φτερά του πουλιού. Ο πιο εύκολος τρόπος είναι η δημιουργία 

του πρώτου σχήματος της Εικόνας 8.52. Η σχεδίασή του πριονωτού τμήματος έγινε με το εργαλείο «Σχεδία-
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ση καμπύλων Μπεζιέ και ευθειών» . Για να δημιουργηθεί ευθεία, κάνουμε κλικ στην αρχή, σύρουμε μέ-
χρι την κορυφή και κάνουμε ξανά κλικ. Σύρουμε προς τα κάτω και ξανά κλικ. Έπειτα προς την κορυφή κ.λπ. 
Στο τέλος, με διπλό κλικ σταματά η δημιουργία των γραμμών. Αφού δημιουργηθεί το πρώτο σχήμα της Εικό-
νας 8.52, κάνουμε κλικ στο εργαλείο «Επεξεργασία μονοπατιών μέσω των κόμβων τους»  και αρχίζουμε 
να αλλάζουμε τις γραμμές, όπως βλέπουμε στο δεύτερο σχήμα της Εικόνας 8.52. Στο τέλος, πρέπει να προ-
κύψει κάτι παρόμοιο με το τρίτο σχήμα της Εικόνας 8.. 

 

 
 

Εικόνα 8.52 Δημιουργία σχήματος φτερών. 

 
Περιστρέφουμε το τρίτο σχήμα της Εικόνας 8.52, αλλάζουμε το χρώμα γεμίσματος σε RGB 123, 46, 

9 και το πλάτος της πινελιάς. Με διπλασιασμό και οριζόντια αντιστροφή προκύπτουν τα φτερά της Εικόνας 
8.54. Η Εικόνα 8.54 αποτελεί και το τελικό σχέδιο, στο οποίο θέλουμε να καταλήξουμε. 

Μας απομένει, λοιπόν, η περιγραφή της δημιουργίας του σχήματος των ποδιών. Για τη δημιουργία 
των ποδιών χρησιμοποιούμε πάλι το εργαλείο «Σχεδίαση καμπύλων Μπεζιέ και ευθειών» . Δημιουργού-
με το πρώτο σχήμα της Εικόνας 8.53. Οι επιμέρους γραμμές δεν χρειάζεται να είναι ενωμένες, απλά να εφά-
πτονται. Δηλαδή, δημιουργούμε ανεξάρτητες γραμμές.  

Έπειτα, τις επιλέγουμε και εκτελούμε «Μονοπάτι > Συνδυασμός», ώστε να συνδυαστούν σε ένα 
σχήμα οι γραμμές. Αλλάζουμε το πλάτος της πινελιάς σε περίπου 6px και την άκρη σε «Στρογγυλή άκρη»  
και προκύπτει το δεύτερο σχήμα της Εικόνας 8.53. Και οι δύο αυτές αλλαγές της γραμμής γίνονται από «Α-
ντικείμενο > Γέμισμα και πινελιά > Μορφοποίηση πινελιάς».  

Στο τελευταίο στάδιο πρέπει να επιλέξουμε το αντικείμενο που έχει περίπου τη μορφή του δεύτερου 
σχήματος της Εικόνας 8.53 και να εκτελέσουμε «Αντικείμενο > Πινελιά σε μονοπάτι». Μετατρέπεται έτσι 
το αντικείμενο σε μονοπάτι, δηλαδή ένα σχήμα που αποτελείται από γραμμές και καμπύλες. Με αυτό τον 
τρόπο, όμως, μπορούμε να επεξεργαστούμε το γέμισμα και το περίγραμμα του αντικειμένου, ώστε να κατα-
λήξουμε στην τρίτη μορφή του ποδιού της Εικόνας 8.53.  

  

 
 

Εικόνα 8.53 Δημιουργία ποδιών. 
 

 
 

Εικόνα 8.54 Τελικό σχέδιο καρτούν. 
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Πρέπει να σημειωθεί ότι, πριν τη μετατροπή από πινελιά σε μονοπάτι, έπρεπε οπωσδήποτε να έχουμε 

μεγάλο πλάτος πινελιάς. Περίπου 6px, όπως είπαμε πιο πάνω, γιατί αλλιώς δεν θα μπορεί να έχει το μονοπάτι 
αρκετό πλάτος για ξεχωριστό γέμισμα και περίγραμμα. Διπλασιάζουμε το πόδι και το αντιστρέφουμε οριζό-
ντια και έπειτα τοποθετούμε τα πόδια στο καρτούν. Από το μενού «Αντικείμενο» μπορούμε να επιλέξουμε 
τις επιλογές «Βύθιση» ή «Βύθιση στον πυθμένα» για μετακίνηση των ποδιών πίσω από το σώμα. Τελικά, 
προκύπτει το πτηνό σε μορφή καρτούν της Εικόνας 8.54. 

Προφανώς, με πειραματισμό και με περισσότερη φαντασία, μπορεί να προκύψει καλύτερο αισθητικό 
αποτέλεσμα. Αυτό που μας ενδιαφέρει, όμως, είναι η κατανόηση των τεχνικών δημιουργίας σύνθετων σχημά-
των με συνδυασμό επιμέρους γραμμών ή παραμόρφωση άλλων σχημάτων. Αν και η περιγραφή των βημάτων 
δημιουργίας είναι μακροσκελής, η εφαρμογή των τεχνικών, καθώς αυξάνεται η εμπειρία μας, είναι αρκετά 
γρήγορη και τα αποτελέσματα εντυπωσιακά. 

 

8.3. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο τρέχον κεφάλαιο μελετήσαμε τις δυνατότητες των εργαλεία επεξεργασίας διανυσματικών γραφικών 
Adobe Illustrator και Inkscape. Το Illustrator είναι εμπορικό, ενώ το Inkscape είναι ελεύθερο και ανοιχτού 
κώδικα. Το Illustrator έχει αρκετές δυνατότητες και θεωρείται το καλύτερο εμπορικό λογισμικό επεξεργασίας 
διανυσματικών γραφικών. Διαθέτει πολλές επιλογές, μεγάλη βάση χρηστών και πληθώρα εκπαιδευτικού υλι-
κού σε μορφή βιβλίων και διαδικτυακών οδηγών μάθησης. Άρα, για πολλά από τα προβλήματα που θα αντι-
μετωπίσετε υπάρχει σίγουρα κάποια λύση στο διαδίκτυο.  

Το Inkscape έχει, επίσης, πολλές δυνατότητες που προσφέρονται μέσω εξελληνισμένου interface που 
διαθέτει. Οι περισσότερες λειτουργίες του είναι εύκολο να εκτελεστούν και οι δυνατότητές του μπορούν να 
επεκταθούν μέσω πρόσθετων (plugins), που αναπτύσσονται από ανεξάρτητους προγραμματιστές. 

Το Inkscape καλύπτει επαρκώς τους χρήστες που ασχολούνται περιστασιακά ή ημι-επαγγελματικά με 
τη δημιουργία διανυσματικών γραφικών. Το εξελληνισμένο μενού επιλογών βοηθά στην άμεση εύρεση των 
προσφερόμενων δυνατοτήτων. Το Adobe Illustrator είναι καταλληλότερο για πιο απαιτητικούς χρήστες που 
ασχολούνται επαγγελματικά στον συγκεκριμένο χώρο. Σε κάθε περίπτωση, και τα δύο εργαλεία απαιτούν με-
γάλη εξοικείωση, ώστε να γίνουν κατανοητές όλες οι λειτουργίες τους και οι δυνατότητές τους. 
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9. Επεξεργασία ήχου με τα εργαλεία Adobe Audition & Audacity 
 
Σύνοψη 
Στο παρόν κεφάλαιο παρουσιάζουμε τις συνηθέστερες δυνατότητες των εργαλείων επεξεργασίας ήχου Adobe 
Audition και Audacity. Το πρώτο εργαλείο αποτελεί εμπορικό εργαλείο της Adobe, ενώ το δεύτερο λογισμικό 
είναι ελεύθερο εργαλείο επεξεργασίας ψηφιακού ήχου. Αρχικά, παρουσιάζουμε το εργαλείο Adobe Audition, 
εξηγούμε τις δυνατότητές του και παρουσιάζουμε βήμα-προς-βήμα ασκήσεις που αφορούν σε θέματα ηχογράφη-
σης, μίξης και διόρθωσης ήχων. Στη συνέχεια του κεφαλαίου παρουσιάζουμε αντίστοιχες ασκήσεις στο δωρεάν 
εργαλείο ανοιχτού κώδικα Audacity, το οποίο έχει συγκρίσιμες δυνατότητες με το εμπορικό εργαλείο της Adobe. 

 
Προαπαιτούμενη γνώση 
Για την κατανόηση κάποιων θεμάτων του κεφαλαίου είναι απαραίτητη η μελέτη του κεφαλαίου 3, στο οποίο 
έγινε ανάλυση των θεωρητικών θεμάτων που σχετίζεται με τον ήχο. 

 

9.1. Adobe Audition 
 
Το Adobe Audition (http://www.adobe.com/products/audition.html) είναι η μετεξέλιξη του εργαλείου Cool 
Edit Pro της εταιρείας Syntrillium. Η Syntrillium αγοράστηκε από την Adobe το 2003 και προέκυψε η νέα 
ονομασία του εργαλείου. Η τελευταία έκδοση του εργαλείου ως αυτόνομη εφαρμογή ήταν η CS6. Οι πιο 
πρόσφατες εκδόσεις διατίθενται ως υπηρεσίες σύννεφου (cloud service) από την Adobe και αναφέρονται ως 
Audition CC (Creative Cloud). Κάθε νέα έκδοση περιέχει, προφανώς, περισσότερες εξειδικευμένες λειτουργί-
ες, αλλά οι περισσότερες λειτουργίες είναι κοινές σε όλες τις εκδόσεις.  

Το εργαλείο παρέχει πολλές δυνατότητες διόρθωσης και μίξης ήχων, εφαρμογής διαφόρων εφέ και 
φίλτρων κ.ά. Στο τρέχον κεφάλαιο, παρουσιάζουμε τις βασικές δυνατότητες του εργαλείου με ασκήσεις, τις 
οποίες εκτελούμε στην έκδοση CS6. Κάποιες από τις ασκήσεις μπορούν να εκτελεστούν και στους διαδικτυα-
κούς επεξεργαστές ήχου https://twistedwave.com/online/, https://www.filelab.com/audio-editor και 
https://soundation.com/studio. 

Επειδή πρόκειται για ένα πολύπλοκο εργαλείο με αρκετές δυνατότητες που απαιτεί εξειδικευμένες 
γνώσεις, η Adobe προσφέρει ένα σύνολο διαδικτυακών οδηγών εκμάθησης που βρίσκονται στη διεύθυνση 
https://helpx.adobe.com/audition/tutorials.html. Εκεί περιγράφονται κάποιες πιο εξειδικευμένες τεχνικές και 
προσφέρονται αντίστοιχα αποσπάσματα βίντεο, που εξηγούν την εφαρμογή τους. 
 

9.1.1. Γνωριμία με το περιβάλλον εργασίας του Audition 
 
Στην Εικόνα 9.1 εμφανίζεται το περιβάλλον εργασίας του Audition. 

 
 Στο σημείο 1 της Εικόνας 9.1 εμφανίζεται το μενού επιλογών του εργαλείου.  
 Στο σημείο 2 υπάρχουν κάποιες καρτέλες που εμφανίζουν στοιχεία, π.χ. διάρκεια και ρυθμό 

δειγματοληψίας, για τα ανοιχτά αρχεία ήχου. 
 Στο σημείο 3 εμφανίζεται η κυματομορφή του επιλεγμένου ήχου. 
 Στο σημείο 4 υπάρχουν διάφορα επιπλέον εργαλεία, π.χ. ελεγκτήρια αναπαραγωγής του ήχου 

και επιλογής τμημάτων των ήχων. 
 
Τα αρχεία που επεξεργαζόμαστε στο Audition είναι αρχεία ήχου κυματομορφών διαφόρων μορφών, 

π.χ. wav, aiff, au, αλλά και αρχεία ήχου από CD και σε μορφή mp3. Γενικά, υποστηρίζει περισσότερα από 30 
τύπους αρχείων: AAC, AIF, AIFF, AIFC, AU, AVR, BWF, CAF, FLAC, HTK, IFF, M4A, MAT, MPC, MP3, 
OGA, OGG, PAF, PCM, PVF, RAW, RF64, SD2, SDS, SF, SND, VOC, VOX, W64, WAV, WVE, XI. 

Στo Adobe Audition μπορούμε να αποθηκεύσουμε έργα στη μορφή .sesx. Πρόκειται για έργα που 
μπορούν να αποτελούν συνθέσεις από πολλά μεμονωμένα αρχεία ήχου. Τα μεμονωμένα αρχεία μπορούν να 
επεξεργάζονται χωριστά και να εξάγεται ένα τελικό αρχείο σε κάποια από τις παραπάνω μορφές, όταν ολο-
κληρωθεί η επεξεργασία. Αυτό μας δίνει τη δυνατότητα της επεξεργασίας της σύνθεσης, οποτεδήποτε χρεια-
στεί. 
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Εικόνα 9.1 Το περιβάλλον εργασίας του Adobe Audition CS6. 

 

9.1.2. Άνοιγμα και αναπαραγωγή ήχου 
 
Μέσω της επιλογής «File > Open» ανοίξτε κάποια αρχεία ήχου. Στο σημείο 1 της Εικόνας 9.2 εμφανίζονται 
τα στοιχεία των ήχων που έχετε ανοίξει (Εικόνα 9.3). Επιλέξτε τον ήχο που επιθυμείτε και με τα χειριστήρια 
στο σημείο 2 μπορείτε να κάνετε αναπαραγωγή του ήχου. 
 

 
 
Εικόνα 9.2 Αναπαραγωγή αρχείου ήχου. 

 
Αν θέλουμε να αναπαράγουμε συγκεκριμένο τμήμα του ήχου, τότε μπορούμε να κάνουμε ένα από τα 

ακόλουθα: 
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1. Κάνουμε κλικ πάνω στην κυματομορφή και επιλέγουμε ένα τμήμα της, όπως επιλέγουμε κεί-
μενο σε κάποιον επεξεργαστή κειμένου. Έπειτα, κάνουμε κλικ στο κουμπί αναπαραγωγής 
(play) του ήχου. 

2. Στο σημείο 3 της Εικόνας 9.2 υπάρχουν τα πλαίσια Start και End δίπλα από την ετικέτα 
Selection. Εκεί γράφουμε τη χρονική στιγμή έναρξης και τέλους του τμήματος ήχου που θέ-
λουμε να επιλέξουμε για αναπαραγωγή. Έπειτα, κάνουμε κλικ στο κουμπί αναπαραγωγής 
(play) του ήχου. 

 

 
 
Εικόνα 9.3 Χαρακτηριστικά αρχείων ήχου που εμφανίζονται στο σημείο 1 της παραπάνω Εικόνας. 

 

9.1.3. Εξαγωγή αρχείων ήχου από CD 
 
Η εξαγωγή αρχείων ήχου από CD γίνεται με την επιλογή «File > Extract Audio From CD». Αφού διαβα-
στούν τα αρχεία του CD, εμφανίζεται το παράθυρο της Εικόνας 9.4. Επιλέγουμε τα αρχεία που επιθυμούμε, 
κάνουμε κλικ στο ΟΚ και το Audition εξάγει διαδοχικά τον ήχο κάθε αρχείου. Στη συνέχεια, μπορούμε να 
επεξεργαστούμε τα αρχεία, να τα αποθηκεύσουμε με άλλη μορφή ή οποιαδήποτε άλλη ενέργεια είναι εφικτή 
στο συγκεκριμένο εργαλείο. 

 

 
 
Εικόνα 9.4 Επιλογή αρχείων CD. 

 

9.1.4. Μαζική επεξεργασία αρχείων 
 
Το Adobe Audition μας δίνει τη δυνατότητα να κάνουμε κάποιες ενέργειες μαζικά σε αρχεία ήχου. Για παρά-
δειγμα, έστω ότι έγινε εισαγωγή των αρχείων ενός CD και θέλουμε να αποθηκεύσουμε όλα τα αρχεία σε 
μορφή mp3. Επιλέγουμε το μενού «Window > Batch Process» και ενεργοποιείται το πλαίσιο της Εικόνας 
9.5. Σύρουμε τα αρχεία μας στο συγκεκριμένο πλαίσιο και έπειτα κάνουμε κλικ στο κουμπί «Export 
Settings», επιλέγουμε τη μορφή mp3 και κάνουμε κλικ στο κουμπί «Run». Τα επιλεγμένα αρχεία αποθηκεύ-
ονται με τη μορφή που επιλέξαμε. 
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Εικόνα 9.5 Πλαίσιο μαζικής επεξεργασίας αρχείων. 

 

9.1.5. Εγγραφή φωνής 
 
Για την εγγραφή στο Audition δημιουργούμε ένα νέο αρχείο ήχου με την επιλογή «File > New > Audio 
File». Εμφανίζεται το ακόλουθο παράθυρο (Εικόνα 9.6), στο οποίο μπορούμε να επιλέξουμε τον ρυθμό δειγ-
ματοληψίας (sample rate), τα κανάλια (channels) και το μέγεθος δείγματος (bit depth).  

Στη συνέχεια, πρέπει να επιλέξουμε το κουμπί εγγραφής  στο κάτω μέρος της οθόνης και να μιλή-
σουμε στο μικρόφωνο. Αποθηκεύουμε το αρχείο ήχου στην επιθυμητή μορφή για ολοκλήρωση της διαδικα-
σίας. 

 

 
 
Εικόνα 9.6 Ορισμός χαρακτηριστικών ήχου. 

 

9.1.6. Αντιγραφή, αποκοπή και διαγραφή τμημάτων ήχου 
 
Πολλές φορές χρειάζεται να διαγράψουμε κάποιο τμήμα ήχου ή να αντιγράψουμε κάποιο τμήμα ήχου σε νέο 
ήχο αρχείο για περαιτέρω επεξεργασία. Για τις λειτουργίες αυτές πρέπει να επιλέξουμε κάποιο τμήμα ήχου με 
έναν από τους ακόλουθους τρόπους: 

 
3. Κάνουμε κλικ πάνω στην κυματομορφή, σύρουμε το ποντίκι και επιλέγουμε ένα τμήμα της, 

όπως επιλέγουμε κείμενο σε κάποιον επεξεργαστή κειμένου. 
4. Στο κάτω δεξί μέρος του εργαλείου μπορούμε να ορίσουμε την αρχή και το τέλος της επιλο-

γής στα πλαίσια Start και End δίπλα από την ετικέτα Selection.  
 
Το επιλεγμένο τμήμα της κυματομορφής του ήχου θα εμφανιστεί, όπως στην Εικόνα 9.7. Αν θέλουμε 

να το διαγράψουμε, απλά πατάμε το Del από το πληκτρολόγιο ή «δεξί κλικ > Delete». Για παράδειγμα, στην 
Εικόνα 9.8 έχει επιλεγεί ένα τμήμα ήχου (ευθεία γραμμή) στην αρχή της κυματομορφής, που αντιπροσωπεύει 
απουσία ήχου (ησυχία). Όταν διαγραφεί το τμήμα αυτό, η μουσική του τραγουδιού αρχίζει αμέσως κατά την 
αναπαραγωγή. 

Με «δεξί κλικ > Copy To New» μπορούμε να αντιγράψουμε το επιλεγμένο τμήμα ως νέο αρχείο. 
Δημιουργούμε έτσι ένα νέο αρχείο ήχου από τμήμα του άλλου ήχου, το οποίο μπορούμε στη συνέχεια να επε-
ξεργαστούμε χωριστά και να το αποθηκεύσουμε με νέο όνομα. 

Με «δεξί κλικ > Crop» αποκόπτει τα μη επιλεγμένα τμήματα της κυματομορφής του ήχου και δια-
τηρεί το επιλεγμένο τμήμα. 
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Εικόνα 9.7 Επιλεγμένο τμήμα κυματομορφής. 

 

 
 

Εικόνα 9.8 Επιλεγμένο τμήμα που αντιπροσωπεύει ησυχία στην αρχή του ήχου. 
 
 

9.1.7. Fade-in, Fade-out 
 
Η διαδικασία Fade-in αναφέρεται στη σταδιακή αύξηση της έντασης του ήχου στην αρχή ενός μουσικού κομ-
ματιού, από ένα σημείο χαμηλής έντασης στην κανονική ένταση. Στις Εικόνες 9.9 και 9.10 εμφανίζεται η κυ-
ματομορφή ενός ήχου με διαφορετική εφαρμογή της τεχνικής Fade-in. Στην πρώτη Εικόνα (9.9) η αύξηση 
είναι πιο ομαλή, ενώ στη δεύτερη (Εικόνα 9.10) πιο απότομη. 

Η εφαρμογή της τεχνικής γίνεται με το κουμπί , που βρίσκεται πάνω αριστερά στο παράθυρο 
προβολής της κυματοφορμής. Κάνουμε κλικ και σύρουμε προς τα δεξιά, ώστε να αρχίσει να μειώνεται η 
ένταση στην αρχή του ήχου. Αν σύρουμε προς τα δεξιά και πάνω, προκύπτει η πρώτη περίπτωση (Εικόνα 
9.9), ενώ αν σύρουμε προς τα κάτω, καταλήγουμε στη δεύτερη περίπτωση (Εικόνα 9.10).  

Εάν κρατήσουμε πατημένο το CTRL από το πληκτρολόγιο και εφαρμόσουμε το Fade-in, τότε 
εφαρμόζεται η μορφή συνημιτόνου στην καμπύλη του Fade-in. Αυτό έχει ως αποτέλεσμα να αλλάζει ο ήχος 
αργά στην αρχή, πιο γρήγορα στη συνέχεια και αργά πάλι στη συνέχεια κ.ο.κ. Μοιάζει, δηλαδή, περίπου με 
την καμπύλη του συνημιτόνου που είδαμε στο κεφάλαιο 3. 
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Εικόνα 9.9 Fade-in με ομαλή αύξηση της έντασης. 

 
Η εφαρμογή του Fade-out, δηλαδή της σταδιακής εξασθένησης της έντασης στο τέλος του ήχου, 

γίνεται με το κουμπί , που βρίσκεται πάνω δεξιά στο παράθυρο προβολής της κυματοφορμής.  
 

 
 
Εικόνα 9.10 Fade-in με πιο απότομη αύξηση της έντασης. 
 

9.1.8. Διαχωρισμός μουσικής από ομιλία 
 
Ο διαχωρισμός της μουσικής από την ομιλία είναι μια διαδικασία που εξαρτάται σε μεγάλο βαθμό από τον 
τρόπο εγγραφής της φωνής και της μουσικής. Εάν βρίσκονται στο ίδιο κανάλι, ο διαχωρισμός τους είναι δύ-
σκολος και δεν είναι πάντα επιτυχημένος.  

 

 
 
Εικόνα 9.11 Παράθυρο επιλογών διαγραφής συχνοτήτων. 

 
Για τη διαγραφή της ομιλίας από ένα τραγούδι πρέπει να επιλέξουμε «Effects > Stereo Imagery > 

Center Channel Extractor». Θα εμφανιστεί το παράθυρο της Εικόνας 9.11, το οποίο μας επιτρέπει τη δια-
γραφή συχνοτήτων από τον ήχο. Στη λίστα επιλογών «Preset» πρέπει να επιλέξουμε «Vocal Remove» και να 
κάνουμε κλικ στο «Apply». Μετά την εφαρμογή του εφέ έχει γίνει αφαίρεση μεγάλου της ομιλίας, αλλά όχι 
πλήρης. Αν προβούμε σε αναπαραγωγή του ήχου, ακούγεται ένας πολύ χαμηλός ήχος ομιλίας. Η πλήρης δια-
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γραφή είναι πολύ δύσκολη και εξαρτάται από το συγκεκριμένο μουσικό κομμάτι που αναλύουμε. Μπορούμε 
να πειραματιστούμε με τις συχνότητες για καλύτερα αποτελέσματα. Σε κάθε περίπτωση, αν σκοπεύουμε να 
γράψουμε τη δική μας φωνή πάνω στον ήχο ή να χρησιμοποιήσουμε τον ήχο για καραόκε, τα αποτελέσματα 
είναι ικανοποιητικά. 

Για τη διαγραφή του ήχου ενεργοποιούμε πάλι το παράθυρο της Εικόνας 9.11 και στη λίστα επιλογών 
«Preset» πρέπει να επιλέξουμε «Acapella» και να κάνουμε κλικ στο «Apply». 
 

9.1.9. Εφέ ηχούς 
 
Μέσω της επιλογής «Effects > Delay And Echo > Echo effect > Apply» μπορούμε να προσθέσουμε ηχώ 
στον ήχο μας. Ηχογραφείστε τη φωνή σας και έπειτα εφαρμόστε το συγκεκριμένο εφέ και προβείτε σε ανα-
παραγωγή του ήχου. Στις Εικόνες 9.12 και 9.13 εμφανίζεται ο ήχος χωρίς ηχώ και με ηχώ. Παρατηρούμε ότι 
τα τμήματα σιωπής/ησυχίας γέμισαν με ήχο παρόμοιας κυματομορφής, αλλά μικρότερης έντασης με το προη-
γούμενο.  

 

 
 
Εικόνα 9.12 Ήχος χωρίς ηχώ. 

 

 
 
Εικόνα 9.13 Ο ήχος της προηγούμενης εικόνας με ηχώ. 

 
Κατά την εφαρμογή του εφέ μπορούμε να αλλάξουμε κάποιες ρυθμίσεις. Για παράδειγμα, στο Delay 

time καθορίζουμε τον χρόνο σε milliseconds μεταξύ των επαναλήψεων της ηχούς. Το Feedback καθορίζει το 
ποσοστό σταδιακής μείωσης της έντασης της ηχούς. 0% σημαίνει απουσία, ενώ 100% σημαίνει ότι η ένταση 
της ηχούς δεν μειώνεται. 

 

9.1.10. Αφαίρεση θορύβου 
 
Η αφαίρεση θορύβου είναι μια πολύπλοκη διαδικασία που εξαρτάται από το είδος του θορύβου που θέλουμε 
να αφαιρέσουμε. Θόρυβος προστίθεται κατά την εγγραφή εξαιτίας κακής ποιότητας του μικροφώνου ή κά-
ποιου εξωτερικού ήχου που ακούστηκε κατά την εγγραφή κ.ά. Υπάρχουν διάφορες τεχνικές για την αφαίρεση 
του θορύβου στο εργαλείο. Οι διαθέσιμες επιλογές βρίσκονται κάτω από το μενού «Effects > Noise 
Reduction / Restoration».  



236 
 

Στη συγκεκριμένη υποενότητα θα ασχοληθούμε με τη διαγραφή θορύβου που έχει προκληθεί από το 
μικρόφωνο κατά την εγγραφή ήχου. Για παράδειγμα, στην Εικόνα 9.14 εμφανίζεται ένας ηχογραφημένος ή-
χος, όπου τα διαστήματα με απουσία ήχου περιέχουν θόρυβο που προστέθηκε από το μικρόφωνο. Για την 
εξάλειψή του μπορούμε να εκτελέσουμε αρχικά τα «Effects > Noise Reduction / Restoration > Hiss 
Reduction (process)».  

 

 
 
Εικόνα 9.14 Ήχος με θόρυβο. 

 
Στη συνέχεια, εμφανίζεται το παράθυρο της Εικόνας 9.15. Η γραμμή στη μέση ορίζει, ποιο τμήμα του 

ήχου θα διαγραφεί. Μπορούμε να δοκιμάσουμε το «Apply» και να διαπιστώσουμε την αποτελεσματικότητα 
της τεχνικής, ακούγοντας τον ήχο. 
 

 
 
Εικόνα 9.15 Παράθυρο επιλογών «Hiss Reduction». 

 
Για πιο αποτελεσματική και πιο πιστή διαγραφή του θορύβου, που δεν θα επηρεάσει άλλες συχνότη-

τες, μπορούμε να επιλέξουμε ένα δείγμα του θορύβου και με βάση αυτό να ολοκληρώσουμε τη διαδικασία. Η 
διαδικασία γίνεται με τα εξής βήματα: 

5. Έχοντας ανοιχτό το παράθυρο της Εικόνας 9.15, κάνουμε κλικ στο τμήμα της κυματομορφής 
που περιέχει θόρυβο και την επιλέγουμε, όπως βλέπουμε στην Εικόνα 9.16. 

6. Κάνουμε κλικ στο κουμπί «Capture Noise Floor», ώστε να γίνει επιλογή του κατωφλιού δια-
γραφής με βάση τα χαρακτηριστικά του επιλεγμένου τμήματος ήχου. 

7. Παρατηρούμε ότι η γραμμή που αντιπροσωπεύει τις συχνότητες που θα διαγραφούν προσαρ-
μόζεται αντίστοιχα. 

8. Κάνουμε κλικ στο «Apply» για να εφαρμοστεί η τεχνική. 
 
Αν προβούμε σε αναπαραγωγή του ήχου, θα διαπιστώσουμε ότι ο ήχος θα είναι πλέον πιο «καθαρός» 

και θα έχει αφαιρεθεί με μεγαλύτερη αποτελεσματικότητα ο θόρυβος. 



237 
 

Με παρόμοιο τρόπο λειτουργούν και κάποιες από τις άλλες επιλογές του μενού «Effects > Noise 
Reduction / Restoration». Σε κάθε περίπτωση, η μείωση εξωτερικών θορύβων είναι μια πολύπλοκη και επα-
ναλαμβανόμενη διαδικασία, η οποία απαιτεί αρκετές φορές τη διαδοχική εφαρμογή των διαθέσιμων επιλο-
γών. 
 

 
 
Εικόνα 9.16 Επιλογή δείγματος για εφαρμογής της τεχνικής «Hiss Reduction». 

 

9.1.11. Αλλαγή έντασης ήχου 
 

Στο πάνω μέρος των κυματομορφών εμφανίζονται τα εικονίδια . Μέσω αυτών των χειριστιρίων 
μπορούμε να αυξήσουμε την ένταση του ήχου, π.χ. με κλικ στο +0 dΒ μπορούμε να βάλουμε +3 dB ή -3 dB, 
ώστε να διπλασιάσουμε ή να υποδιπλασιάσουμε την ένταση του ήχου αντίστοιχα. 
 

9.1.12. Επεξεργασία μεμονωμένων καναλιών 
 
Έστω ότι θέλουμε να επεξεργαστούμε ξεχωριστά το αριστερό και δεξί κανάλι ενός ήχου, π.χ. θα μπορούσαμε 
στο αριστερό κανάλι να έχουμε την ομιλία και στο δεξί να έχουμε τη μουσική. Στη δεξιά πλευρά των κανα-
λιών εμφανίζονται τα εικονίδια  και . Με κλικ στο L απενεργοποιείται το αριστερό (left) κανάλι και είναι 
ενεργό μόνο το δεξί κανάλι (Εικόνα 9.17). 

 

 
 
Εικόνα 9.17 Απενεργοποίηση του αριστερού καναλιού. 

 
Αν κάνετε αναπαραγωγή του ήχου, θα διαπιστώσετε ότι ο ήχος ακούγεται από ένα μόνο ηχείο ή α-

κουστικό. 
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9.1.13. Μίξη μουσικής με ομιλία 
 
Έστω ότι έχετε ηχογραφήσει την ομιλία σας και θέλετε να τη συνδυάσετε με μουσική. Ο πιο απλός τρόπος 
είναι να ανοίξετε και τα δύο αρχεία και να επιλέξετε την κυματομορφή του ενός και να κάνετε αντιγραφή και 
«Mix Paste» στον άλλο ήχο. Εμφανίζεται το πλαίσιο επιλογών της Εικόνας 9.18, όπου μπορούμε να ορίσου-
με κάποιες σχετικές επιλογές. Για παράδειγμα, μπορούμε να καθορίσουμε την ένταση καθενός ήχου, ώστε να 
υπάρχει ισορροπία. Αν κάνουμε επικόλληση της μουσικής στην κυματομορφή της ομιλίας, τότε ίσως να θέ-
λουμε να μειώσουμε την ένταση στο «Copied Audio», ώστε να ακούγεται κατά κύριο λόγο η ομιλία. Εδώ θα 
πρέπει να προσέξουμε, ώστε η διάρκεια της μουσικής και της ομιλίας να είναι παρόμοια. Σε κάθε περίπτωση 
μπορούμε να κάνουμε εύκολα αναίρεση των ενεργειών μας, για παράδειγμα να προσαρμόσουμε τη διάρκεια 
της μουσικής και να υπάρχει και το εφέ Fade-out στο τέλος, ώστε αφού τελειώσει η φωνή, να μειώνεται στα-
διακά η μουσική. 

 

 
 
Εικόνα 9.18 Επιλογές «Mix paste». 

 

9.1.14. Μίξη πολλαπλών αρχείων ήχου 
 
Ένας άλλος τρόπος μίξης πολλών αρχείων είναι με τη δυνατότητα δημιουργίας Multitrack κομματιών. Επιλέ-
γουμε «File > New > Multitrack Session» και εμφανίζεται το πλαίσιο επιλογών της Εικόνας 9.19. Αφήνουμε 
τις προκαθορισμένες επιλογές στο πρώτο πλαίσιο διαλόγου και επιλέγουμε ΟΚ. Πρέπει να σημειωθεί, ότι για 
κάθε Multitrack κομμάτι δημιουργείται ένας φάκελος στον δίσκο που αποθηκεύονται τα τμήματα. Το όνομα 
του φακέλου ορίζεται στο πλαίσιο της Εικόνας 9.19. Αν ένα τραγούδι που θα εισαχθεί στη σύνθεση, έχει δια-
φορετικά χαρακτηριστικά (ρυθμό δειγματοληψίας, μέγεθος δείγματος), τότε θα τροποποιηθεί κατά την εισα-
γωγή του και θα δημιουργηθεί ένα νέο αρχείο στον φάκελο της σύνθεσης. Άρα, όλα τα αρχεία που θα αποτε-
λούν τη σύνθεση θα υπάρχουν σ’ αυτόν τον φάκελο. 
 

 
 
Εικόνα 9.19 Επιλογές δημιουργίας Multitrack.  
 

Μετά τον ορισμό των επιλογών δημιουργείται το παράθυρο της Εικόνας 9.20. Στις διαφορετικές 
γραμμές τοποθετούνται με σύρσιμο και εναπόθεση τα διαφορετικά τμήματα. Στην Εικόνα 9.21 εμφανίζεται η 
σύνθεση, όπου έχουμε τοποθετήσει δύο αρχεία ήχου. Με διπλό κλικ σε κάθε κομμάτι μπορούμε να τα επε-
ξεργαστούμε χωριστά, προσθέτοντας κάποιο εφέ ή μειώνοντας την ένταση κ.ά. Στην Εικόνα 9.22 στο δεύτερο 
κομμάτι έχει εφαρμοστεί το εφέ Fade-out. 

Η σύνθεση αποθηκεύεται, όπως είπαμε, στον φάκελο που έχουμε καθορίσει κατά τη δημιουργία της. 
Τα ξεχωριστά αρχεία ήχου που την αποτελούν αποθηκεύονται, επίσης, σε εκείνον τον φάκελο. Για να αποθη-
κεύσουμε τη σύνθεση ως ένα αρχείο wav ή mp3 ή σε κάποια άλλη συμβατική μορφή, επιλέγουμε «File > 
Export > Multitrack Mixdown > Entire Session». 
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Εικόνα 9.20 Πλαίσιο τοποθέτησης των διαφορετικών ήχων στο αρχείο Multitrack.  

 

  
 
Εικόνα 9.21 Τμήμα της σύνθεσης Multitrack που έχουν τοποθετηθεί 2 αρχεία ήχου. 

 

 
 
Εικόνα 9.22 Το δεύτερο τμήμα της σύνθεσης έχει επεξεργαστεί. 

 

9.2. Audacity 
 

Το Audacity (http://audacityteam.org/download/) είναι ένα πρόγραμμα ανοιχτού κώδικα για την επεξεργασία 
ήχου. Διατίθεται ως ελεύθερο λογισμικό για τα λειτουργικά συστήματα Windows, Mackintosh και Linux. 
Όπως και το Adobe Audition, το Audacity έχει αρκετές δυνατότητες: 

 Δυνατότητα εισαγωγής και εξαγωγής πολλών τύπων αρχείων, όπως wav, aiff, flac κ.ά.  
 Ηχογράφηση και αναπαραγωγή αρχείων ήχου με υποστήριξη πολλαπλών καναλιών.  
 Επεξεργασία (αντιγραφή, αποκοπή, διαγραφή κ.ά.) αρχείων ήχου. 
 Μίξη αρχείων ήχου πολλαπλών καναλιών.  
 Αλλαγή έντασης της κυματομορφής του ήχου.  
 Εφαρμογή φίλτρων και εφέ στον ήχο για αφαίρεση θορύβου, σταδιακή μείωση/αύξηση έντα-

σης, μεταβολή ρυθμού κ.ά. 
 
Οι δυνατότητες του εργαλείου μπορούν να επεκταθούν με διάφορα πρόσθετα που αναπτύσσονται από 

μεμονωμένους προγραμματιστές (http://audacityteam.org/download/plugins). 
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Το Audacity υποστηρίζει τη δημιουργία έργων που περιέχουν διαφορετικά αρχεία ήχου που μπορούν 
να επεξεργαστούν χωριστά. Τα σύνθετα έργα αποθηκεύονται με τη μορφή .aup και μπορούν να εξαχθούν σε 
οποιαδήποτε τυπική μορφή ήχου. Η δυνατότητα δημιουργίας έργων επιτρέπει την ξεχωριστή επεξεργασία των 
μεμονωμένων αρχείων ήχου. 

 

9.2.1. Γνωριμία με το περιβάλλον εργασίας του Audacity 
 
Στην Εικόνα 9.23 εμφανίζεται το περιβάλλον εργασίας του Audacity. Παρατηρούμε ότι το περιβάλλον εργα-
σίας διατίθεται και στα Ελληνικά. 

 Στο σημείο 1 της Εικόνας 9.23 εμφανίζεται το μενού επιλογών του εργαλείου, καθώς και 
διάφορα άλλα χειριστήρια για αναπαραγωγή του ήχου, αντιγραφή και επικόλληση τμημάτων 
κ.ά.  

 Στο σημείο 2 εμφανίζεται η κυματομορφή του επιλεγμένου ήχου. 
 Στα σημεία 3 και 4 υπάρχουν πλαίσια και χειριστήρια για την επιλογή τμημάτων του ήχου 

και γενικά την επεξεργασία του. 
 

 
 
Εικόνα 9.23 Το περιβάλλον εργασίας του Audacity. 

 

9.2.2. Βασικές λειτουργίες με το Audacity 
 
Ανοίξτε ένα αρχείο ήχου με την επιλογή «Αρχείο > Άνοιγμα». Αν ανοίξετε δύο αρχεία ήχου, θα παρατηρή-
σετε ότι ανοίγουν ως δύο ξεχωριστά παράθυρα. Δηλαδή, κάθε αρχείο ήχου που επεξεργάζεστε ανοίγει σε ξε-
χωριστό παράθυρο. 

Η αναπαραγωγή γίνεται με τα χειριστήρια , τα οποία βρίσκονται στο πάνω μέρος του 
παραθύρου του Audacity. Κατά την αναπαραγωγή μπορούμε να αυξήσουμε την ένταση του ήχου ή να αυξή-
σουμε την ένταση ενός καναλιού, με τα χειριστήρια που βρίσκονται στο σημείο 4 της Εικόνας 9.23. 

Με το χειριστήριο  μπορούμε να κάνουμε αναπαραγωγή ενός τμήματος ήχου, προσαρ-
μόζοντας την ταχύτητα αναπαραγωγής. 

Η επιλογή ενός τμήματος της κυματομορφής για αναπαραγωγή ή για άλλη επεξεργασία γίνεται με 
απευθείας επιλογή της κυματομορφής, αρκεί να είναι επιλεγμένο το εργαλείο  στο πάνω μέρος της οθόνης. 
Εναλλακτικά, η επιλογή μπορεί να γίνει και από τα πλαίσια «Αρχή επιλογής» και «Τέλος επιλογής» στο ση-
μείο 3 της Εικόνας 9.23. Αν θέλουμε να επιλέξουμε συγκεκριμένο μήκος της κυματομορφής, απλά ορίζουμε 
την αρχή και το μήκος της επιλογής. Στην Εικόνα 9.24 έχει επιλεγεί ένα τμήμα 1 λεπτού και 30 δευτερολέ-
πτων από την αρχή του τραγουδιού. 
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Το κουμπί «Σιγή» στο σημείο 4 της Εικόνας 9.23 έχει ως αποτέλεσμα τη σιγή του συγκεκριμένου 
κομματιού. Το κουμπί «Σόλο» ενεργοποιεί τη σιγή όλων των κομματιών, πλην του συγκεκριμένου κομμα-
τιού, σε περιπτώσεις αναπαραγωγής περισσότερων ήχων. 

 
 

 
 
Εικόνα 9.24 Επιλογή τμήματος μήκους 1' και 30". 

 

9.2.3. Εγγραφή φωνής 
 
Με κλικ στο κουμπί εγγραφής  μπορούμε να εγγράψουμε ήχο με το μικρόφωνο. Στο κάτω μέρος της οθό-
νης μπορούμε να επιλέξουμε τον ρυθμό δειγματοληψίας, που είναι εξ ορισμού επιλεγμένος στα 44100 Hz. 
Στο Audacity καλείται «Ρυθμός έργου». 

Για την αποθήκευση του αρχείου πρέπει να κάνουμε «Αρχείο > Export Audio». Η επιλογή «Αποθή-
κευση έργου» αφορά την αποθήκευση ως έργου, μια ειδική μορφή του Audacity, που χρησιμοποιείται κατά 
την επεξεργασία ένα έργου. Όταν θέλουμε να δημοσιεύσουμε ή να μοιραστούμε το έργο, πρέπει να το αποθη-
κεύσουμε σε νέο έργο. Αν η επιλογή για αποθήκευση ως mp3 δεν είναι διαθέσιμη, τότε πρέπει να εγκαταστή-
σετε τον LAME MP3 encoder (http://lame.buanzo.org/#lamewindl). 

 

9.2.4. Αντιγραφή, αποκοπή, διαγραφή και μετακίνηση τμημάτων ήχου 
 
Αν θέλουμε να αντιγράψουμε ή να αποκόψουμε ένα τμήμα ήχου, πρέπει πρώτα να το επιλέξουμε και έπειτα 

με τα εικονίδια  να κάνουμε αντιγραφή και επικόλληση. Το προτελευταίο κουμπί χρησιμοποιείται 
για την περικοπή του ήχου. Δηλαδή, διαγράφει τα μη επιλεγμένα τμήματα ήχου. Το τελευταίο εικονίδιο εισά-
γει ένα τμήμα σιγής ήχου στη θέση του επιλεγμένου τμήματος. Για παράδειγμα, στην Εικόνα 9.26 έχει αντι-
κατασταθεί το επιλεγμένο τμήμα της Εικόνας 9.25 με σιγή. 

 
 

 
 
Εικόνα 9.25 Επιλεγμένο τμήμα ήχου. 

 
Η διαγραφή τμημάτων ήχου γίνεται απλά με επιλογή και κλικ του κουμπιού DEL από το πληκτρολό-

γιο ή από το μενού «Επεξεργασία > Διαγραφή». 

Με το εικονίδιο  μπορούμε να μετακινήσουμε έναν ήχο ή ένα τμήμα του ήχου, «ελευθερώνοντας 
χώρο» για την τοποθέτηση ενός άλλου τμήματος ήχου. Για παράδειγμα, στην Εικόνα 9.27 η κυματομορφή 
έχει μετακινηθεί προς τα δεξιά, ώστε να μπορεί να γίνει μια σύνθεση με την εισαγωγή ενός άλλου τμήματος 
ήχου στο αρχικό διάστημα. 
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Εικόνα 9.26 Το επιλεγμένο τμήμα ήχου της προηγούμενης εικόνας έχει αντικατασταθεί με σιγή. 

 

 
 
Εικόνα 9.27 Μετακίνηση ήχου. 

 

9.2.5. Αλλαγή έντασης, ενίσχυση (Fade-in), εξασθένιση (Fade-out) & άλλα φίλτρα 
 
Η αύξηση της έντασης του ήχου γίνεται με την επιλογή «Εφέ > Ενίσχυση…». Εκεί μπορούμε να καθορίσου-
με την αύξηση σε dB. Οι θετικές τιμές κάνουν τον ήχο πιο δυνατό, ενώ οι αρνητικές τιμές μειώνουν την έ-
νταση. 
 

 
 
Εικόνα 9.28 Παράθυρο αλλαγής της έντασης του ήχου. 

 
Οι επιλογές «Εφέ > Ενίσχυση» και «Εφέ > Εξασθένιση» αντιστοιχούν στις τεχνικές Fade-in και 

Fade-out. Με τις συγκεκριμένες επιλογές η μορφή καθορίζεται αυτόματα. Αν θέλουμε περισσότερες δυνατό-
τητες ρυθμίσεων, τότε πρέπει να χρησιμοποιηθεί η επιλογή «Εφέ > Adjustable Fade…». 
 

 
 
Εικόνα 9.29 Εφαρμογή εφέ Ενίσχυση του ήχου της Εικόνας 9.25. 

 
Μέσα από το ίδιο μενού, δηλαδή το «Εφέ» μπορούμε να εφαρμόσουμε εφέ, όπως η «Ηχώ», η «Α-

ντήχηση», η «Αναστροφή», η «Αλλαγή τέμπο» κ.ά. 
 

9.2.6. Αφαίρεση φωνής από τη μουσική 
 
Όπως αναφέραμε και στο Adobe Audition, ο πλήρης διαχωρισμός δεν είναι απόλυτα εφικτός. Στο Audition η 
δυνατότητα προσφέρεται μέσω του μενού «Εφέ > Vocal Removal…». Η εφαρμογή των παρακάτω επιλογών 
διαγράφει μεγάλο μέρος των φωνητικών, αλλά μπορεί να αλλοιώσει και τη μουσική. 
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Εικόνα 9.30 Παράθυρο επιλογών για την αφαίρεση φωνής. 

 
Μια άλλη επιλογή με την οποία μπορείτε να πειραματιστείτε για τον διαχωρισμό φωνής και μουσικής 

είναι η «Εφέ > Vocal Reduction and Isolation…», η οποία δίνει περισσότερες επιλογές. Σε κάθε περίπτωση 
πρέπει να πειραματιστείτε με τις προσφερόμενες επιλογές, ώστε να δείτε ποια επιλογή είναι αποτελεσματικό-
τερη για το τραγούδι σας. 

 

9.2.7. Αφαίρεση θορύβου 
 
Η αφαίρεση θορύβου που προκαλείται κατά την εγγραφή ήχου με χρήση μη επαγγελματικού εξοπλισμού, γί-
νεται στο Audacity με τα εξής βήματα: 

9. Επιλογή ενός τμήματος της κυματομορφής που περιέχει θόρυβο. 
10. Ενεργοποίηση του μενού «Εφέ > Noise Reduction…». 
11. Κλικ στο κουμπί «Λήψη προφίλ θορύβου» για να ληφθεί ως δείγμα το επιλεγμένο τμήμα και 

κλικ στο κουμπί «Εντάξει» για να εφαρμοστεί. 
12. Επιλέγουμε όλη την κυματομορφή (με διπλό κλικ ή Ctrl-A) και εκτελούμε «Εφέ > Επανά-

ληψη Noise Reduction…», ώστε να επαναληφθεί η διαδικασία της αφαίρεσης του θορύβου 
με βάση το δείγμα που ελήφθη στο προηγούμενο βήμα. 

 
Η διαδικασία μπορεί να γίνει και με την εγγραφή ενός τμήματος που δεν θα περιέχει τη φωνή μας. 

Δηλαδή, αρχίζουμε τη διαδικασία της εγγραφής για 2-3 δευτερόλεπτα, ώστε τελικά να γίνει εγγραφή μόνο 
του θορύβου του μικροφώνου. Εκτελούμε έπειτα τα βήματα 1, 2 και 3 πιο πάνω. Στη συνέχεια, κάνουμε την 
εγγραφή του μηνύματος που επιθυμούμε και στον νέο ήχο που ηχογραφήσαμε εκτελούμε το βήμα 4 που ανα-
φέρθηκε πιο πάνω.  
 

9.2.8. Μίξη αρχείων ήχου 
 
Η μίξη αρχείων ήχου μπορεί να σημαίνει τον συνδυασμό μιας ηχογραφημένης ομιλίας με κάποιο ήχο ή να 
έχουμε κάποια αρχεία ήχου που θα αναπαράγονται στη σειρά ή να έχουμε ξεχωριστές ηχογραφήσεις οργάνων 
που τελικά θα ενσωματωθούν σε ένα αρχείο κ.ά. 

Εάν απλά θέλουμε να συνδυάσουμε δύο ή περισσότερους ήχους στη σειρά, τότε αντιγράφουμε τον 
έναν ήχο στο τέλος του άλλου. Μπορούμε να εφαρμόσουμε εφέ Fade-out και Fade-in στο τελείωμα του πρώ-
του και στην αρχή του δευτέρου ήχου αντίστοιχα, για πιο ομαλή εισαγωγή. Έπειτα, κάνουμε Export του αρ-
χείου σε ένα νέο αρχείο και ολοκληρώνουμε τη διαδικασία. Αν θέλουμε, αποθηκεύουμε και τη σύνθεση ως 
έργο στο Audacity για μελλοντική επεξεργασία.  

 

 
 
Εικόνα 9.31 Κυματομορφές διαδοχικών ήχων. 

 
Εάν θέλουμε να συνδυάσουμε μια ηχογραφημένη ομιλία με κάποια απόσπασμα μουσικής, τότε πρέ-

πει να εκτελέσουμε αρχικά τα βήματα: 
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13. Ανοίγουμε το αρχείο με την ηχογραφημένη ομιλία  (ή μπορούμε να ηχογραφήσουμε τη φωνή 
μας). 

14. Εισάγουμε στο ίδιο έργο το αρχείο μουσικής με την εντολή «Αρχείο > Εισαγωγή > Ήχος» 
και, όπως βλέπουμε στην Εικόνα 9.32, υπάρχουν δύο αρχεία στο έργο μας. 

 
Αν πατήσουμε το κουμπί της αναπαραγωγής του ήχου, τότε ακούγονται και οι δύο ήχοι συνδυασμέ-

νοι. Πρακτικά, δηλαδή, έχουμε πετύχει τον σκοπό μας και μπορούμε με την επιλογή «Αρχείο > Export 
Audio» να αποθηκεύσουμε το έργο ως ένα αρχείο ήχου σε μορφή wav ή mp3 κ.ά.. Επίσης, μπορούμε να απο-
θηκεύσουμε και το έργο στο Audacity, ώστε να διατηρηθούν οι ήχοι χωριστά στο ίδιο έργο για μελλοντική 
επεξεργασία. 

Παρατηρούμε ότι το δεύτερο αρχείο, που αφορά τη μουσική, είναι πολύ μεγαλύτερο σε χρονική 
διάρκεια και ίσως θα έπρεπε η ένταση να είναι χαμηλότερη, ώστε να ακούγεται πιο καθαρά η φωνή. Μπο-
ρούμε να εφαρμόσουμε τις τεχνικές που μάθαμε στα προηγούμενα θέματα για να διαγράψουμε κάποιο τμήμα 
του ήχου, να μειώσουμε την έντασή του με την επιλογή «Εφέ > Ενίσχυση…» και αρνητική τιμή στο πλαίσιο 
«Ενίσχυση (dB)» και να εφαρμόσουμε την τεχνική Fade-out. 
 

 
 
Εικόνα 9.32 Διαφορετικοί ήχοι στο ίδιο έργο. 

 

9.3. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο τρέχον κεφάλαιο παρουσιάσαμε τα εργαλεία επεξεργασίας ήχου Adobe Audition και Audacity. Το πρώτο 
εργαλείο είναι εμπορικό, ενώ το δεύτερο λογισμικό είναι ελεύθερο και ανοιχτού κώδικα. Το Adobe Audition 
έχει αρκετές δυνατότητες και θεωρείται ένα από τα πιο ολοκληρωμένα εμπορικά λογισμικά, μαζί με το 
WavePad Audio Editor (http://www.nch.com.au/wavepad/) και το Sound Forge Audio Studio της Sony 
(http://www.sonycreativesoftware.com/soundforgesoftware). Παρόλα αυτά, το Audacity έχει, επίσης, πολλές 
δυνατότητες που προσφέρονται μέσω εξελληνισμένου interface που διαθέτει. Οι περισσότερες λειτουργίες 
του είναι εύκολο να εκτελεστούν και οι δυνατότητές του μπορούν να επεκταθούν μέσω πρόσθετων (plugins), 
που αναπτύσσονται από ανεξάρτητους προγραμματιστές.  
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Το Audacity καλύπτει επαρκώς τον μέσο χρήστη, ο οποίος συνήθως εκτελεί ηχογραφήσεις, απλές δι-
ορθώσεις και συνθέσεις μουσικών κομματιών. Το εξελληνισμένο μενού επιλογών βοηθά στην άμεση εύρεση 
των προσφερόμενων δυνατοτήτων του. Το Adobe Audition είναι  καταλληλότερο για πιο απαιτητικούς χρή-
στες, που ασχολούνται επαγγελματικά με την επεξεργασία ήχου. Στο διαδίκτυο υπάρχουν αρκετοί οδηγοί εκ-
μάθησης (tutorials), οι οποίοι μας βοηθούν στην ολοκλήρωση συγκεκριμένων λειτουργιών. 
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10. Γραφικά 3Δ & Σχεδιοκίνηση με 3ds Max & Blender 
 
 
Σύνοψη 
Στο παρόν κεφάλαιο γίνεται μια εισαγωγή στο λογισμικό 3ds Max της Autodesk και στο εργαλείο ανοιχτού κώ-
δικα Blender. Μέσα από βήμα-προς-βήμα ασκήσεις παρουσιάζουμε τον τρόπο λειτουργίας των εργαλείων και 
εξηγούμε κάποιες από τις βασικές τους δυνατότητες. 

Προαπαιτούμενη γνώση 
Στο κεφάλαιο 4 έγινε ανάλυση των θεωρητικών θεμάτων, που σχετίζονται με τα γραφικά 3Δ και τη σχεδιοκίνη-
ση και συνεπώς πρέπει να μελετηθεί πριν το τρέχον κεφάλαιο.  

 

10.1. 3ds Max 
 
Το 3ds Max (http://www.autodesk.com/products/3ds-max) είναι ένα εμπορικό επαγγελματικό εργαλείο της 
Autodesk για γραφικά 3Δ και animations. Οι τελευταίες εκδόσεις διατίθενται μόνο για λειτουργικά συστήμα-
τα 64-bit. Η Autodesk διαθέτει και δωρεάν εκδόσεις των λογισμικών της για φοιτητές και εκπαιδευτές. Το 
εργαλείο έχει πάρα πολλές δυνατότητες και έχει χρησιμοποιηθεί και για τη δημιουργία ταινιών. Στην ιστοσε-
λίδα http://knowledge.autodesk.com/support/3ds-max υπάρχουν οδηγοί χρήσης του εργαλείου και γενικά στο 
διαδίκτυο υπάρχουν πάρα πολλοί οδηγοί χρήσης, κυρίως, σε μορφή βίντεο. 

 

10.1.1. Γνωριμία με το περιβάλλον εργασίας του 3ds Max 
 
Στην Εικόνα 10.1 εμφανίζεται το περιβάλλον εργασίας του εργαλείου. Η βασική οθόνη χωρίζεται σε 4 τμήμα-
τα (σημείο 1) που ονομάζονται viewports και αποτελούν διαφορετικές όψεις του ίδιου αντικειμένου. Στα ση-
μεία 2, 3, και 4 υπάρχουν διάφορες ρυθμίσεις και επιλογές σχετικά με τα αντικείμενα σχεδίασης που έχουν 
τοποθετηθεί στη σκηνή.  

 

 
 
Εικόνα 10.1 Το περιβάλλον εργασίας του 3ds Max. 
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Στην προεπιλεγμένη ρύθμιση (default setting) τα τρία viewports δείχνουν από τρεις διαφορετικές δι-
διάστατες οπτικές, κάθετες μεταξύ τους (κάτοψη, πρόσοψη και πλάγια όψη), το σκελετό (wireframe) των 
σχημάτων που έχουν δημιουργηθεί. Το τέταρτο παράθυρο κάτω δεξιά δείχνει τα αντικείμενα κανονικά, δηλα-
δή από μια ενδιάμεση γωνία, με προοπτική (perspective). Σε κάθε παράθυρο υπάρχει το σύμβολο [+]. Με 
κλικ στο + εμφανίζονται οι επιλογές «Maximize viewport» για μεγέθυνση του παραθύρου ή η επιλογή 
«Restore viewport» για επαναφορά του παραθύρου.  

 

10.1.2. Δημιουργία και επεξεργασία βασικών αντικειμένων 
 
Τα βασικά (primitive) 3D σχήματα, που φαίνονται στην Εικόνα 10.2, βρίσκονται στο σημείο 3 της Εικόνας 
10.1 πιο πάνω. Τα σχήματα αυτά είναι διαθέσιμα και μέσω του μενού  «Create > Standard primitives». 
Στην Εικόνα 10.3 έχουμε σχεδιάσει διαφορετικά αντικείμενα. Τα σχήματα σχεδιάζονται με κλικ πάνω στη 
σκηνή και μετακίνηση του ποντικιού, διατηρώντας το αριστερό κουμπί του ποντικιού πατημένο.  

 

 
 
Εικόνα 10.2 Βασικά σχήματα του 3ds Max. 

 

 
 
Εικόνα 10.3 Βασικά τρισδιάστατα αντικείμενα. 

 
Στην Εικόνα 10.4 βλέπουμε τα σχήματα από άλλη οπτική γωνία. Αυτό επιτυγχάνεται με χρήση του 

λευκού εικονιδίου, που βρίσκεται στη δεξιά πλευρά κάθε παραθύρου σχεδίασης. Δηλαδή, αν κάνουμε κλικ 
στο εικονίδιο και αρχίσουμε να το περιστρέφουμε, έχοντας πιεσμένο το αριστερό κουμπί του ποντικιού, τότε 
μπορούμε να περιστρέψουμε τη σκηνή. 

Τα αντικείμενα επιλέγονται κάνοντας κλικ πάνω τους. Με δεξί κλικ πάνω σε κάποιο αντικείμενο, εμ-
φανίζονται αρκετές επιλογές, π.χ.: 

 Scale: μεταβολή μεγέθους. 
 Rotate: περιστροφή. 
 Select: επιλογή. 
 Move: μετακίνηση. 
 Curve editor: επεξεργασία των καμπυλών των σχημάτων. 
 Convert to…: επιλογές για μετατροπή σε πολύγωνα και περαιτέρω επεξεργασία. 
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Στην Εικόνα 10.5 εμφανίζονται δύο αντικείμενα. Ξεκινήσαμε με δύο αντικείμενα τύπου Sphere και 
Torus και με χρήση της επιλογής δεξί κλικ και «Scale» κάναμε μεταβολή του μεγέθους κάθε σχήματος. Η 
τοποθέτηση του σχήματος που μοιάζει με αυγό έγινε από το viewport «Top», καθώς είναι πιο εύκολα κατα-
νοητή η λειτουργία που πρέπει να γίνει. 

Η αλλαγή του χρώματος γίνεται με επιλογή του χρώματος, στη δεξιά πλευρά του 3ds Max, κάτω από 
την επιλογή του σχήματος. 

 

 
 
Εικόνα 10.4 Περιστροφή της τρισδιάστατης σκηνής. 

 

 
 
Εικόνα 10.5 Αντικείμενα στα οποία έχει γίνει μεταβολή σχήματος. 

 
Στην Εικόνα 10.6 εμφανίζονται οι κατηγορίες αντικειμένων 3D που υπάρχουν στο 3ds Max. Για πα-

ράδειγμα, το σχήμα της Εικόνας 107 δημιουργήθηκε με χρήση αντικειμένων από την κατηγορία Stairs και 
Doors. 

 

 
 
Εικόνα 10.6 Κατηγορίες δημιουργίας αντικειμένων 3D. 

 

10.1.3. Επεξεργασία μορφής σχήματος 
 
Στο σχήμα 10.8 εμφανίζονται δύο σχήματα, στα οποία εφαρμόστηκαν κάποιοι βασικοί μετασχηματισμοί. 

Χρησιμοποιήθηκε η επιλογή «Modify» . Στο αντικείμενο Torus έχουν εφαρμοστεί οι μετασχηματισμοί 
Radius 1: 37, Radius: 2, Twist: 2000, Segments: 25, Slides: 5. Στο αντικείμενο Sphere έχει αλλάξει η παράμε-
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τρος Hemisphere: 0,5. Οι παράμετροι καθορίζουν γενικά την εμφάνιση των αντικειμένων. Η παράμετρος 
twist, για παράδειγμα, καθορίζει τον αριθμό συστροφών του αντικειμένου. 

Κάτω από το εικονίδιο «Modify»  υπάρχει η αναδυόμενη λίστα «Modifier list». Εκεί παρατίθεται 
ένα σύνολο από τροποποιητές, που μας επιτρέπουν αλλαγές πάνω στα τρισδιάστατα αντικείμενα. 

 

 
 
Εικόνα 10.7 Απλό τρισδιάστατο σχήμα. 

 

 
 
Εικόνα 10.8 Σχήματα, στα οποία έχουν εφαρμοστεί απλές ρυθμίσεις. 

 
Ένας άλλος τρόπος επεξεργασίας της μορφής ενός σχήματος είναι με χρήση δεξί κλικ πάνω σε κά-

ποιο αντικείμενο και επιλογή «Convert to > Convert to Editable Mesh». Στην Εικόνα 10.9 σχεδιάσαμε μια 
σφαίρα, στην οποία εφαρμόσαμε την επιλογή αυτή. Η σφαίρα παίρνει τη δεύτερη μορφή της Εικόνας 10.9, 

όταν κάνουμε κλικ στο εικονίδιο  που αφορά τις κορυφές (vertex) του πλέγματος πολυγώνων 
(Mesh). Με κλικ και σύρσιμο κάποιων κορυφών μπορούμε να αλλάξουμε τη μορφή του αντικειμένου. 

 

 
 
Εικόνα 10.9 Αλλαγές σε ένα σχήμα με χρήση της επιλογής «Editable Mesh». 

 
Αν θέλουμε να κάνουμε Rendering της σκηνής, τότε επιλέγουμε το μενού «Rendering > Render». 

Μπορούμε να αποθηκεύσουμε τη σκηνή απευθείας ως εικόνα, με την επιλογή «Save image». 
 

10.1.4. Προσθήκη υφής 
 
Στο συγκεκριμένο παράδειγμα θα προσθέσουμε μια υφή ξύλου σε ένα αντικείμενο Box. Αρχικά σχεδιάζουμε 

το Box και έπειτα κάνουμε κλικ στο εικονίδιο . Εμφανίζεται το παράθυρο της Εικόνας 10.10. Στη συνέχεια 
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επιλέγουμε μία από τις σφαίρες που αντιπροσωπεύουν διαφορετικές υφές. Κάνουμε κλικ στο τετράγωνο εικο-
νίδιο μετά το Diffuse (σημείο 1 της Εικόνας 10.10) και επιλέγουμε «Bitmap» και OK. Εμφανίζεται το παρά-
θυρο επιλογής του αρχείου εικόνας της υφής και, όταν την επιλέξουμε, θα εμφανιστεί στη θέση ενός κύκλου. 

Στη συνέχεια μπορούμε να κάνουμε κλικ στο εικονίδιο «Assign Material to Selection» (σημείο 2 της 
Εικόνας 10.10). Τέλος, με κλικ στο εικονίδιο «Show Shaded Material to Viewport» (σημείο 3 της Εικόνας 
10.10) εμφανίζεται η υφή στο αντικείμενο (Εικόνα 10.11). Μπορούμε να φορτώσουμε και άλλες υφές στις 
άλλες σφαίρες και τελικά να εφαρμόζουμε διαφορετικές υφές στα αντικείμενα της σκηνής. 

 

 
 
Εικόνα 10.10 Material Editor. 

 

 
 

Εικόνα 10.11 Εφαρμογή υφής σε αντικείμενο. 

 

10.1.5. Απλό animation αντικειμένων 
 
Ένας απλός τρόπος κίνησης ενός αντικειμένου, π.χ. μιας σφαίρας, είναι με χρήση του κουμπιού «Auto Key», 
που υπάρχει στο κάτω μέρος του 3ds Max (Εικόνα 10.12). Αρχικά σχεδιάζουμε τη σφαίρα στο αρχικό σημείο, 
όπου θέλουμε να αρχίζει το animation, και φροντίζουμε το κουτάκι δίπλα από το Key filters να γράφει 1. Ου-
σιαστικά ορίζουμε το πρώτο σημαντικό καρέ (keyframe) της κίνησης.  

 

 
 

Εικόνα 10.12 Εικονίδια χρήσιμα για το animation με χρήση του Auto Key. 

 
Στη συνέχεια πρέπει να ορίσουμε τα υπόλοιπα keyframes της κίνησης. Μετακινούμε τη σφαίρα σε 

κάποια θέση και ορίζουμε σε ποιο καρέ (π.χ. στο 15) της κίνησης αντιστοιχεί αυτό το keyframe. Έπειτα ορί-
ζουμε κάποιο άλλο keyframe σε κάποιο άλλο καρέ (π.χ. στο 30) κ.ο.κ. Το τελικό keyframe ορίζεται στην τε-
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λική θέση, όπου πρέπει να μετακινηθεί η σφαίρα. Όταν ολοκληρώσουμε τη διαδικασία, απενεργοποιούμε το 
κουμπί «Auto Key». Κάνοντας κλικ στο εικονίδιο Play Animation , γίνεται αναπαραγωγή της κίνησης. 

Για να κάνουμε εξαγωγή του animation πρέπει να επιλέξουμε αρχικά το εικονίδιο «Render Setup» 
στο σημείο 1 της Εικόνας 10.13. Στο σημείο 2 της Εικόνας 10.13 μπορούμε να ορίσουμε πόσα frames (καρέ) 
της θέλουμε να εξάγουμε. 

Πιο κάτω στο ίδιο παράθυρο υπάρχει η ομάδα εργαλείων «Render Output», όπου πρέπει να επιλέ-
ξουμε το κουμπί «Files», για να ορίσουμε το όνομα αρχείου του animation. Πατώντας το «Save», μπορούμε 
να ορίσουμε και τον codec που θα χρησιμοποιηθεί στο βίντεο. Τέλος, με το κουμπί «Render» γίνεται εξαγω-
γή του βίντεο.  

 

 
 

Εικόνα 10.13 Επιλογές Render για την εξαγωγή του animation. 

 

10.2. Blender 
 

Το Blender (http://www.blender.org) είναι ελεύθερο λογισμικό γα τη σχεδίαση 3D γραφικών και animations. 
Αποτελεί μια από τις πιο δημοφιλείς εφαρμογές ανοικτού κώδικα στον κόσμο για σχεδίαση τρισδιάστατων 
γραφικών, που έχει χαρακτηριστικά συγκρίσιμα με τις εμπορικές εφαρμογές. Χρησιμοποιείται για μοντελο-
ποίηση, κινούμενα γραφικά και για δημιουργία αλληλεπιδραστικών 3D εφαρμογών, όπως τα βιντεοπαιχνίδια. 
Είναι διαθέσιμο σε όλα τα κύρια λειτουργικά συστήματα. 

 

10.2.1. Γνωριμία με το περιβάλλον εργασίας του Blender 
 
Κατά την εκκίνηση του Blender εμφανίζεται η οθόνη εκκίνησης (Εικόνα 10.14), η οποία δίνει γρήγορη και 
εύκολη πρόσβαση σε πρόσφατα ανοιγμένα αρχεία Blender. Εμφανίζεται και η έκδοση του Blender.  

Κάνοντας κλικ έξω από την οθόνη εκκίνησης, εμφανίζεται η προεπιλεγμένη οθόνη του Blender (Ει-
κόνα 10.15), που αποτελείται από 5 βασικές περιοχές. 

 
 Το παράθυρο Info βρίσκεται στην κορυφή του παραθύρου (σημείο 1 της Εικόνας 10.15) και 

περιλαμβάνει: 
o τη γραμμή μενού της εφαρμογής,  
o αναδυόμενη λίστα για τη διάταξη της τρέχουσα οθόνης,  
o αναδυόμενη λίστα για επιλογή σκηνής,  
o αναδυόμενη λίστα για επιλογή μηχανής απόδοσης γραφικών (Rendering), 
o πληροφορίες για τους διαθέσιμους πόρους του συστήματος. 
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Εικόνα 10.14 Αρχική οθόνη στο Blender. 

 
 Το παράθυρο 3D προβολής, στο σημείο 2 της Εικόνας 10.15, όπου σχεδιάζονται τα τρισδιά-

στατα αντικείμενα. 
 

 Σο παράθυρο Outliner πάνω δεξιά (σημείο 3), όπου εμφανίζεται μία λίστα με όλα τα αντικεί-
μενα της σκηνής. 

 
 Το παράθυρο Properties στο κάτω δεξιό μέρος (σημείο 4) περιέχονται πλαίσια ρυθμίσεων και 

επιλογών για τα αντικείμενα. Μέσω αυτών των επιλογών ορίζονται οι περισσότερες από τις 
λειτουργίες που εκτελεί το Blender στα αντικείμενα και τα υλικά για το animation και το 
rendering. 

 
 Το παράθυρο Timeline στο σημείο 5 (γραμμής χρόνου) επιτρέπει την κίνηση στον άξονα του 

χρόνου και χρησιμοποιείται για τη δημιουργία κινουμένων σχεδίων. 
 

 
 
Εικόνα 10.15 Το περιβάλλον εργασίας του Blender. 
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10.2.2. Παράθυρο 3D προβολής  
 
Το παράθυρο 3D προβολής είναι το μεγαλύτερο από τα παράθυρα στην προεπιλεγμένη οθόνη και ουσιαστικά 
αποτελεί το κεντρικό σημείο του λογισμικού. Κάποια από τα εργαλεία που συναντάμε στο παράθυρο είναι: 

 
To 3D Transform Manipulator, ένα οπτικό βοήθημα για τον μετασχηματισμό αντικειμένων 
(grab/move, rotate και scale).  

Η ρύθμισή του πραγματοποιείται από τα τέσσερα εικονίδια . 
  

O 3D Cursor, που έχει διάφορες λειτουργίες, όπως να σηματοδοτεί το σημείο όπου τα νέα αντικεί-
μενα θα εμφανίζονται, όταν δημιουργηθούν για πρώτη φορά, ή να σηματοδοτεί το κέντρο της πε-
ριστροφής.  
 

 

To Cube Mesh είναι ένας απλός κύβος που βρίσκεται στο κέντρο του 3D χώρου και χρησιμοποιεί-
ται ως υπόδειγμα σε κάθε νέο έργο.  
  

Το Lamp, το οποίο αντιπροσωπεύει τη θέση και το είδος της πηγής φωτός, η οποία είναι τοποθε-
τημένη κάπου κοντά στο κέντρο του 3D χώρου.  
 

 

Η Camera, η οποία χρησιμοποιείται για να ορίσει την οπτική γωνία (θέση) για μετατροπή των 
τριών διαστάσεων σε δυο κατά το rendering.  
 

 
 

Πίνακας 10.1 Εργαλεία του παραθύρου 3D προβολής. 

 

10.2.3. Περιήγηση στον τρισδιάστατο χώρο 
 
Μια βασική δυσκολία που αντιμετωπίζουμε, όταν εργαζόμαστε με το Βlender (ή οποιοδήποτε άλλη εφαρμογή 
για γραφικά 3D) είναι πώς θα αποδοθούν οι τρεις διαστάσεις στην οθόνη. Δηλαδή, πώς θα αποδοθούν οι τρεις 
διαστάσεις στην οθόνη των δύο διαστάσεων. Άρα, πρέπει να δούμε, πώς μπορούμε αρχικά να αλλάξουμε την 
οπτική γωνία στην 3D σκηνή του Βlender.  

Η οπτική γωνία ορίζεται από 3 παραμέτρους: 
 τη θέση μέσα στον 3D χώρο, 
 την κατεύθυνση προς την οποία κοιτάζουμε, 
 τον συντελεστή μεγέθυνσης (zoom). 

Αλλαγή της οπτικής γωνίας σημαίνει τροποποίηση μίας ή περισσότερων από αυτές τις παραμέτρους. 
 

 
 
Εικόνα 10.16 Αλλαγή οπτικής γωνίας θέασης. 
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Όταν ανοίξουμε τα εργαλεία θα παρουσιαστεί η αρχική οθόνη, όπως παρουσιάζεται στην Εικόνα 

10.15. Τοποθετώντας τον δείκτη του ποντικιού στο παράθυρο 3D προβολής μπορούμε: 
 να αλλάξουμε τη θέση από την οποία βλέπουμε τη σκηνή (π.χ. Εικόνα 10.16), κινούμενοι σε 

τροχιά γύρω από αυτήν με έναν από τους ακόλουθους τρόπους:  
o κρατώντας πατημένο το μεσαίο κουμπί του ποντικιού και μετακινώντας το ελεύθερα, 
o χρησιμοποιώντας τα πλήκτρα 2, 4, 6 και 8 από το αριθμητικό πληκτρολόγιο. 

 
 να πλησιάσουμε ή να απομακρυνθούμε από το κέντρο της σκηνής (zoom in / zoom out): 

o με τη ροδέλα στο ποντίκι, ή 
o με το μεσαίο κουμπί του ποντικιού με ταυτόχρονα πιεσμένο το πλήκτρο CTRL, ή 
o με τα πλήκτρα + και – από το αριθμητικό πληκτρολόγιο. 

 
Το Blender διαθέτει ένα σύνολο από συγκεκριμένες προβολές, οι οποίες είναι διαθέσιμες ή από το 

μενού View στη γραμμή τίτλου του παραθύρου, στο κάτω μέρος του παραθύρου, είτε από το αριθμητικό 
πληκτρολόγιο: 

 Προβολή από πάνω: 7 
 Προβολή από κάτω: CTRL + 7 
 Προβολή από την μπροστά πλευρά: 1 
 Προβολή από την πίσω πλευρά: CTRL + 1 
 Προβολή από δεξιά: 3 (π.χ. Εικόνα 10.17) 
 Προβολή από αριστερά: CTRL + 3 

 

 
 
Εικόνα 10.17 Αλλαγή οπτικής γωνίας θέασης. 

 
Πολύ χρήσιμη είναι η προβολή της σκηνής από την οπτική γωνία της κάμερας. Αυτή είναι, επίσης, 

διαθέσιμη από το μενού View στη γραμμή τίτλου του παραθύρου, αλλά και πατώντας το πλήκτρο 0 από το 
αριθμητικό πληκτρολόγιο (Εικόνα 10.18). 

 

10.2.4. Αποθήκευση και εξαγωγή 
 
Η αποθήκευση στο Blender γίνεται από το μενού με την εντολή «File > Save». Στο παράθυρο που εμφανίζε-
ται δηλώνουμε το όνομα για το νέο αρχείο και τον φάκελο αποθήκευσης. Το Blender έχει τη δυνατότητα να 
χρησιμοποιεί διαφορετική κατάληξη αρχείου σε κάθε αποθήκευση (π.χ. .blend1, .blend2, .blend3). Για παρά-
δειγμα, αν υπάρχει ένα αρχείο με όνομα Class3D.blend και προσπαθήσουμε να αποθηκεύσουμε με το ίδιο 
όνομα, τότε αυτόματα το προηγούμενο αρχείο θα μετονομαστεί σε Class3D.blend1. Με αυτόν τον τρόπο δια-
τηρούνται παλαιότερες εκδόσεις αρχείων, τα οποία μπορούμε να χρησιμοποιήσουμε, προκειμένου να αναιρέ-
σουμε αλλαγές. 
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Εικόνα 10.18 Προβολή οπτικής γωνίας κάμερας. 

 
Για την εξαγωγή μιας εργασίας χρησιμοποιούμε την επιλογή «File > Export» και στη συνέχεια επι-

λέγουμε τη μορφή αρχείου (Εικόνα 10.19).  
 

 
 
Εικόνα 10.19 Εξαγωγή σε άλλες μορφές. 

 
Μία από τις σημαντικότερες λειτουργίες της εφαρμογής είναι η δημιουργία και εξαγωγή της εργασίας 

ως εικόνα ή βίντεο, δηλαδή η εφαρμογή rendering. Για τον σκοπό αυτό μπορεί να χρησιμοποιηθεί είτε η οπτι-
κή γωνία του παραθύρου 3D προβολής είτε η οπτική γωνία της κάμερας. 

Για να δημιουργηθεί μία εικόνα (ή ένα βίντεο) από την οπτική γωνία του χρήστη (δηλαδή ότι βλέπει 

μέσα από το παράθυρο 3D προβολής), χρησιμοποιούνται τα εικονίδια , τα οποία βρίσκονται κάτω από 
το παράθυρο 3D προβολής. Το αποτέλεσμα για ένα απλό σχέδιο εμφανίζεται στην Εικόνα 10.20. 

 

 
 
Εικόνα 10.20 Rendering εικόνας από την οπτική γωνία του χρήστη. 

 
Για να δημιουργηθεί η εικόνα ή το βίντεο από την οπτική γωνία της κάμερας χρησιμοποιούνται τα ει-

κονίδια , τα οποία βρίσκονται στο παράθυρο 
Properties. Το αποτέλεσμα για ένα απλό σχέδιο εμφανίζεται στην Εικόνα 10.21. 
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Και στις δύο περιπτώσεις η παραγόμενη εικόνα εμφανίζεται σε νέο παράθυρο. Κάτω από το παράθυ-
ρο 3D προβολής, υπάρχει το μενού «Image > Save as Image», από όπου μπορούμε να αποθηκεύσουμε τη 
σκηνή ως μια εικόνα. 

 

 
 

Εικόνα 10.21 Rendering εικόνας από την οπτική γωνία της κάμερας. 
 

 
 

Εικόνα 10.22 Ρυθμίσεις βίντεο στο παράθυρο Properties. 

 

 
 

Εικόνα 10.23 Προκαθορισμένες ρυθμίσεις βίντεο. 

 

 
 

Εικόνα 10.24 Επιλογές φακέλου και μορφότυπου αποθήκευσης. 

 
Αν επιλέξουμε να παράγουμε βίντεο, τότε αρχίζει η διαδικασία δημιουργίας του βίντεο με βάση τις 

ρυθμίσεις, για τις οποίες έχουμε ορίσει αντίστοιχο πεδίο του παράθυρου Properties. Για παράδειγμα, στην 
Εικόνα 10.22, βλέπουμε τις διαστάσεις και το frame rate (fps) που έχουν οριστεί. Στην Εικόνα 10.23 εμφανί-
ζονται οι επιλογές της αναδυόμενης λίστα «Render Presets». Οι προεπιλογές αυτές αφορούν τις ρυθμίσεις του 
παραγόμενου βίντεο, π.χ. HDTV 1080p. Στο κάτω μέρος του παράθυρου Properties υπάρχει η κάρτα 
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«Output», όπου μπορούμε να ορίσουμε τον φάκελο αποθήκευσης του βίντεο και τη μορφή εξόδου του βίντεο 
(Εικόνα 10.24). 

 

10.2.5. Εισαγωγή, επιλογή, διαγραφή αντικειμένου 
 
Για την εισαγωγή νέου αντικειμένου στον χώρο δημιουργίας των γραφικών, πρέπει να επιλέξουμε από τη 
γραμμή μενού της εφαρμογής, στο κάτω μέρος της οθόνης, την επιλογή «Add > Mesh». Εμφανίζεται το με-
νού της Εικόνας 10.25, όπου μπορούμε να επιλέξουμε το κατάλληλο σχήμα. Όπως αναφέραμε στο Κεφάλαιο 
4, τα σχήματα αυτά είναι βασικά (primitive) και αποτελούνται από ένα πλέγμα πολυγώνων (mesh). Υπάρχουν 
ως αυτόνομα σχήματα στα εργαλεία σχεδίασης τρισδιάστατων γραφικών. 
 

 
 

Εικόνα 10.25 Βασικά σχήματα. 
 
Κάνοντας κλικ στο όνομα ενός σχήματος, π.χ. «UV Sphere», δημιουργείται το αντίστοιχο αντικείμενο 

στο κέντρο της σκηνής (π.χ. Εικόνα 10.26).  
Η επιλογή ενός σχήματος γίνεται με δεξί κλικ πάνω σε κάποιο αντικείμενο. Το επιλεγμένο αντικείμε-

νο έχει πορτοκαλί περίγραμμα, όπως βλέπουμε στην Εικόνα 10.26. Με κλικ στο πλήκτρο DEL του πληκτρο-
λογίου μπορούμε να διαγράψουμε ένα αντικείμενο. 

 

 
 

Εικόνα 10.26 Σχήματα που έχουν προστεθεί στη σκηνή. 

 

10.2.6. Μετακίνηση, περιστροφή, μεταβολή μεγέθους αντικειμένου 
 
Όταν επιλέγουμε ένα αντικείμενο στον 3D χώρο, εμφανίζονται οι οπτικοί χειριστές, όπως φαίνονται στην Ει-
κόνα 10.27.  

Ένας από τους γρηγορότερους τρόπους για τη διαχείριση του επιλεγμένου αντικειμένου είναι μέσω 
του πληκτρολογίου. Πιέζοντας κάθε ένα από τα πλήκτρα G, R και S, ενεργοποιούνται, αντίστοιχα, οι κατα-
στάσεις μετακίνησης (grab), περιστροφής (rotate) και μεταβολής μεγέθους (scale), για το επιλεγμένο αντι-
κείμενο. Έπειτα σύρουμε το ποντίκι και αυξάνει το μέγεθος ή μετακινείται ή περιστρέφεται το αντικείμενο, 
ανάλογα με το επιλεγμένο αντικείμενο. Αν, σύροντας το ποντίκι, κρατήσουμε το μεσαίο κουμπί του ποντικιού 
πατημένο, η αλλαγή συμβαίνει μόνο κατά μήκος ενός άξονα. Παραδείγματος χάριν, στην Εικόνα 10.28 βλέ-
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πουμε ένα σχήμα που δημιουργήθηκε από έναν κύβο. Πατήσαμε το πλήκτρο S και έπειτα με πιεσμένο το με-
σαίο πλήκτρο του ποντικιού σύραμε προς τα εμπρός, δηλαδή στον άξονα Χ. 

 

 
 

Εικόνα 10.27 Χειριστές σε ένα σχήμα. 
 
Εκτός από τα πλήκτρο G, R και S μπορούμε να χρησιμοποιήσουμε τα εικονίδια 3D Transform 

Manipulator  . Τα εικονίδια έχουν την ίδια συμπεριφορά, όπως τα πλήκτρα G, R, και S.  
Για να οριστικοποιηθεί η επιθυμητή μεταβολή πρέπει να κάνουμε αριστερό κλικ ή να πιέσουμε το 

πλήκτρο Enter. Για να ακυρωθεί μια μεταβολή πρέπει να γίνει δεξί κλικ ή να πιέσουμε το Esc. 
Μπορούμε, επίσης, να μετακινήσουμε το αντικείμενο μέσα στον χώρο απλά με κλικ στο αντικείμενο 

και κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού. 
Με κλικ στην άκρη ενός βέλους από τα τρία βέλη, μπορούμε να το μετακινήσουμε κατά μήκος αυτού 

του άξονα. Σύροντας το ποντίκι κατά μήκος του επιλεγμένου άξονα, μετακινείται και το ποντίκι. Στην Εικόνα 
10.29 έχουμε επιλέξει τον άξονα Χ (κόκκινο βέλος), οπότε το αντικείμενο μετακινείται κατά μήκος του άξο-
να. 

 

 
 

Εικόνα 10.28 Μεταβολή μεγέθους σε έναν άξονα. 

 
 

 
 

Εικόνα 10.29 Μετακίνηση στον άξονα X. 
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10.2.7. Μετασχηματισμοί αντικειμένων 
 
Στο προηγούμενο θέμα είδαμε αλλαγές που επηρεάζουν όλο το αντικείμενο. Αν θέλουμε να μεταβάλουμε 
κορυφές ή ακμές ή προσόψεις, τότε χρειάζεται να αλλάξουμε αρχικά την κατάσταση λειτουργίας. Στο κάτω 
μέρος της οθόνης πρέπει να επιλέξουμε «Edit Mode» στην αναδυόμενη λίστα «Object Mode» (Εικόνα 
10.30). 

Στο κάτω μέρος της οθόνης εμφανίζονται τα εικονίδια , μέσω των οποίων μπορούμε να επι-
λέξουμε, αν θα επεξεργαστούμε τις κορυφές (vertex) ή τις ακμές (edge) ή τις προσόψεις (faces).  

Η επιλογή (κορυφής, ακμής ή πρόσοψης) γίνεται με δεξί κλικ. Στην Εικόνα 10.31 εμφανίζεται ένας 
κύβος, όπου έχουν επιλεχθεί κάποιες κορυφές του. Στη συνέχεια, με χρήση του πλήκτρου G ή του αντίστοι-
χου πλήκτρου από τα εικονίδια 3D Transform Manipulator, έχει μετασχηματιστεί. 

 

 
 

Εικόνα 10.30 Αλλαγή κατάστασης επεξεργασίας αντικειμένων. 

 

 
 

Εικόνα 10.31 Αλλαγή κατάστασης επεξεργασίας αντικειμένων. 
 

10.2.8. Υλικό και υφή αντικειμένων 
 
Το υλικό (material) καθορίζει τα βασικά οπτικά χαρακτηριστικά ενός αντικειμένου, δηλαδή το χρώμα του και 
το πόσο θαμπό ή γυαλιστερό είναι. Η υφή (texture) μπορεί είτε να αναδεικνύει το υλικό κατασκευής κάποιου 
αντικειμένου, π.χ. τούβλα ή ξύλο, είτε να είναι κάποια υφή παραγόμενη από υπολογιστή. Βασικός στόχος της 
υφής είναι το αντικείμενο να δείχνει πιο φυσικό. Στο Blender η υφή εφαρμόζεται στο υλικό και έτσι ο καθο-
ρισμός του υλικού προηγείται του καθορισμού της υφής.  

Αρχικά πρέπει να εντοπίσουμε το εικονίδιο «Material»  στο παράθυρο 
Properties στη δεξιά πλευρά του Blender. Έπειτα πρέπει να κάνουμε κλικ στο κουμπί «New», ώστε να προ-
σθέσουμε ένα νέο υλικό (Εικόνα 10.32). Εμφανίζεται η Εικόνα 10.33, όπου εμφανίζεται το νέο υλικό και κά-
ποιες ρυθμίσεις. 

 

 
 

Εικόνα 10.32 Προσθήκη νέου υλικού. 

 
Οι σημαντικότερες ρυθμίσεις, οι οποίες σχετίζονται με το νέο υλικό, είναι: 

 Diffuse: το βασικό χρώμα του υλικού. 
 Specular: το πόσο γυαλιστερό ή θαμπό είναι. 
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 Mirror: οι ανακλαστικές ιδιότητες του υλικού. 
 Shading: σκίαση. 
 Transparency: διαφάνεια. 

 
Μπορούμε να πειραματιστούμε με τις επιλογές, ώστε να επιτύχουμε τον επιθυμητό χρωματισμό και 

γενικά το αισθητικό αποτέλεσμα που θέλουμε. Στην Εικόνα 10.34 έχει γίνει rendered ενός αντικειμένου από 
την οπτική του χρήστη. Στη δεξιά πλευρά φαίνονται κάποιες από τις ρυθμίσεις που εφαρμόστηκαν. 
 

 
 

Εικόνα 10.33 Ιδιότητες νέου υλικού. 

 

 
 

Εικόνα 10.34 Αντικείμενο που έχει γίνει rendered. 
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Η υφή προστίθεται το εικονίδιο «Texture»  στο παράθυρο Proper-
ties στη δεξιά πλευρά του Blender. Κάτω από το παράθυρο κάνουμε κλικ στο «New» και επιλέγουμε κάποια 
από τις προκαθορισμένες υφές στο πλαίσιο «Type». Για παράδειγμα, στην Εικόνα 10.35 εμφανίζεται κάποια 
από τις προκαθορισμένες υφές και το αποτέλεσμα εμφανίζεται στην Εικόνα 10.36. Στο κάτω μέρος του παρα-
θύρου των ρυθμίσεων των υφών μπορούμε να πειραματιστούμε με τα χρώματα. 

Στο πλαίσιο «Type» μπορούμε να επιλέξουμε «Image or Movie» και να εισάγουμε ένα δικό μας αρ-
χείο, το οποίο θα χρησιμοποιηθεί ως υφή. Στην Εικόνα 10.37 βλέπουμε ότι έχει επιλεγεί μια υφή μορφής ξύ-
λου και στην Εικόνα 10.38 φαίνεται το αποτέλεσμα της εφαρμογής της υφής. 

 
 

 
 

Εικόνα 10.35 Επιλογή κάποιας από τις προκαθορισμένες υφές. 

 
 

 
 

Εικόνα 10.36 Αντικείμενο που έχει γίνει rendered με την προκαθορισμένη υφή της προηγούμενης εικόνας. 

 
 

 
 

Εικόνα 10.37 Προσθήκη εικόνας ως υφής. 
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Εικόνα 10.38 Αντικείμενο που έχει γίνει rendered με την υφή της προηγούμενης εικόνας. 

 

10.2.9. Animation ενός αντικειμένου 
 
Το animation ενός αντικειμένου στο Blender μπορεί να γίνει με τη διαδοχική προβολή καρέ, τα οποία δίνουν 
την αίσθηση της κίνησης, όπως έχουμε εξηγήσει στο Κεφάλαιο 4. Πρακτικά χρειάζεται να ορίσουμε τα 
keyframes που καθορίζουν την κίνηση του αντικειμένου. Για την εξαγωγή της σχεδιοκίνησης σε βίντεο, πρέ-
πει να ορίσουμε το Frame Rate. Συνήθως, ορίζεται στα 24 fps. Υπάρχουν διάφοροι τρόποι κίνησης ενός αντι-
κειμένου. Ο πιο απλός τρόπος είναι με τη μετακίνηση του αντικειμένου σε κάποια σημεία και την καταγραφή 
των βασικών keyframes.  

Έστω ότι θέλουμε να δημιουργήσουμε ένα animation ενός κύβου στον χώρο. Ορίζουμε στο παράθυρο 

Properties, στη δεξιά πλευρά του εργαλείου, το frame rate 24 fps . Στο κάτω μέρος ορίζουμε 48 

καρέ με ορισμό του End στο 48 . Συνεπώς, ορίσαμε ένα animation 2 δευτερο-
λέπτων. 

Στη συνέχεια πρέπει να ορίσουμε τα keyframes. Έστω ότι θέλουμε να ορίσουμε τη θέση του αντικει-

μένου στα frames 1, 15, 35 και 48. Πιέζουμε το εικονίδιο , ώστε να καταγραφούν από το λογισμικό τα 
keyframes που θα ορίσουμε. Μετακινούμε το αντικείμενο, με χρήση δεξί κλικ και σύρσιμο στη θέση που θέ-
λουμε να βρίσκεται στο καρέ 1. Στο κάτω μέρος, δίπλα από τα πλαίσια Start και End, ορίζουμε τον αριθμό 

. Στη συνέχεια μετακινούμε το αντικείμενο σε μια νέα θέση και ορίζουμε ως αριθμό καρέ το 15 
στο αντίστοιχο πλαίσιο. Επαναλαμβάνουμε και τη θέση στα υπόλοιπα καρέ και το animation είναι έτοιμο. Με 

χρήση των χειριστηρίων  μπορούμε να δούμε το animation. Στην παραπάνω ενότητα 2.4 αυ-
τού του κεφαλαίου είδαμε πώς μπορεί να εξαχθεί το animation ως αρχείο βίντεο.  

Στις ιστοσελίδες https://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Basic_Animation και 
http://www.raywenderlich.com/52804/beginning-blender-tutorial-animating-rendering-mushroom μπορείτε να 
βρείτε και άλλα παραδείγματα animation στο Blender. 

 

10.3. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο τρέχον κεφάλαιο έγινε επισκόπηση των βασικών δυνατοτήτων των εργαλείων επεξεργασίας γραφικών 3Δ  
και animation 3ds Max και του δωρεάν εργαλείου Blender. Και τα δύο εργαλεία έχουν πάρα πολλές δυνατό-
τητες και έχουν χρησιμοποιηθεί ακόμη και στη δημιουργία ταινιών. Η παρουσίαση ενός μεγαλύτερου συνό-
λου των δυνατοτήτων τους θα απαιτούσε πολλά κεφάλαια ή ακόμη και ένα βιβλίο, καθώς κάθε ενέργεια είναι 
συνήθως πολύπλοκη και απαιτεί πολλαπλά βήματα. Το 3ds Max είναι πιο ώριμο εργαλείο και κάποιες από τις 
επιλογές του εφαρμόζονται με πιο εύκολο τρόπο σε σχέση με το Blender. Ωστόσο, πρέπει να έχουμε υπόψη 
μας ότι το Blender είναι, επίσης, αρκετά ισχυρό εργαλείο και διατίθεται δωρεάν. Η βιβλιογραφία είναι πιο 
φτωχή στην περίπτωση του Blender, αν και τελευταία έχουν εμφανιστεί βιβλία που εξηγούν ακόμη και τον 
τρόπο δημιουργίας παιχνιδιών με το συγκεκριμένο εργαλείο. 
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11. Επεξεργασία βίντεο με με τα εργαλεία Adobe Premiere & 
Avidemux 

 
 
Σύνοψη 
Στο παρόν κεφάλαιο παρουσιάζουμε τις συνηθέστερες δυνατότητες των εργαλείων επεξεργασίας βίντεο Adobe 
Premiere Pro και Avidemux. Το πρώτο εργαλείο αποτελεί εμπορικό εργαλείο της Adobe, ενώ το δεύτερο λογι-
σμικό είναι ελεύθερο εργαλείο επεξεργασίας βίντεο. Μέσα από βήμα-προς-βήμα ασκήσεις εξηγούμε τον τρόπο 
λειτουργίας των εργαλείων και παρουσιάζουμε κάποιες από τις βασικές τους δυνατότητες. 

Προαπαιτούμενη γνώση 
Για την κατανόηση κάποιων θεμάτων του κεφαλαίου είναι απαραίτητη η μελέτη του κεφαλαίου 5, στο οποίο 
έγινε ανάλυση των θεωρητικών θεμάτων που σχετίζεται με το βίντεο. Καλό είναι να έχει μελετηθεί και το κεφά-
λαιο 2 που αφορά την εικόνα, καθώς κάποια θέματα, όπως τα χρωματικά μοντέλα και η ανάλυση είναι σχετικά. 

 

11.1. Adobe Premiere Pro 
 
Το Adobe Premiere Pro (http://www.adobe.com/products/premiere.html) είναι ένα επαγγελματικό και εμπο-
ρικό εργαλείο για επεξεργασία βίντεο. Οι πιο πρόσφατες εκδόσεις διατίθενται ως υπηρεσίες σύννεφου (cloud 
service) από την Adobe και αναφέρονται ως Premiere Pro CC (Creative Cloud). Η τελευταία έκδοση του ερ-
γαλείου, ως αυτόνομη εφαρμογή, ήταν η CS6. Πρέπει να σημειωθεί ότι οι εκδόσεις από την CS5 και έπειτα, 
απαιτούν έκδοση λειτουργικού συστήματος 64-bit, γιατί οι απαιτήσεις σε αποτελεσματική χρήση μνήμης εί-
ναι αυξημένες. 

Το εργαλείο παρέχει πολλές δυνατότητες για την επεξεργασία βίντεο, όπως αλλαγή ρυθμού δειγμα-
τοληψίας και ανάλυσης του βίντεο, πρόσθεση υπότιτλων, ενσωμάτωση μουσικής και άλλων μέσων κ.ά. Στο 
τρέχον κεφάλαιο παρουσιάζουμε τις βασικές δυνατότητες του εργαλείου με ασκήσεις, τις οποίες εκτελούμε 
στην έκδοση CS6. Επειδή πρόκειται για ένα πολύπλοκο εργαλείο με αρκετές δυνατότητες, που απαιτεί εξειδι-
κευμένες γνώσεις, η Adobe προσφέρει ένα σύνολο διαδικτυακών οδηγών εκμάθησης που βρίσκονται στη 
διεύθυνση https://helpx.adobe.com/premiere-pro/tutorials.html. Εκεί περιγράφονται κάποιες πιο εξειδικευμέ-
νες τεχνικές και προσφέρονται αντίστοιχα αποσπάσματα βίντεο, τα οποία εξηγούν την εφαρμογή τους. 
 

11.1.1. Γνωριμία με το περιβάλλον εργασίας του Adobe Premiere 
 
Στην Εικόνα 11.1 εμφανίζεται το περιβάλλον εργασίας του Premiere Pro. Το περιβάλλον εργασίας του Adobe 
Premiere Pro χωρίζεται σε πλαίσια (panels), που περιέχουν τα εικονίδια για να επεξεργαστούμε το βίντεο ή 
δείχνουν τα αποτελέσματα του βίντεο που επεξεργαζόμαστε. Στo Premiere Pro επεξεργαζόμαστε σύνθετα 
έργα, τα οποία αποθηκεύονται στη μορφή .prproj. Πρόκειται για έργα που μπορούν να αποτελούν συνθέσεις 
από μεμονωμένα αρχεία βίντεο, εικόνων και ήχου. Τα μεμονωμένα αρχεία τοποθετούνται στο έργο μας, μπο-
ρούμε να τα επεξεργαστούμε και, όταν ολοκληρωθεί η επεξεργασία, να εξάγουμε ένα τελικό αρχείο βίντεο. 
Αυτό μάς δίνει τη δυνατότητα της επεξεργασίας των αρχείων της σύνθεσης οποτεδήποτε χρειαστεί. 

 
 Στο σημείο 1 της Εικόνας 11.1 υπάρχει το μενού επιλογών. 
 Στο σημείο 2 υπάρχει το «project» πάνελ, όπου φαίνεται όλο το υλικό που έχουμε διαθέσιμο 

για επεξεργασία, όπως βίντεο, ήχους, τίτλους, γραφικά, στατικές εικόνες. Τα υλικά της σύν-
θεσης μπορούμε να τα οργανώσουμε σε φακέλους στο «project» panel. 

 Στο πλαίσιο «Source» στο σημείο 3 μπορούμε να βλέπουμε κάποιο από τα υλικά που έχουμε 
εισάγει στο «project» πάνελ. 

 Στο πλαίσιο «Program» στο σημείο 4 βλέπουμε τα αποτελέσματα της επεξεργασίας του έρ-
γου μας. 

 Στο πλαίσιο «Tools» στο σημείο 5 είναι όλα τα εργαλεία που έχουμε στη διάθεσή μας για την 
επεξεργασία του υλικού. 
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 Ο χρονοδιάδρομος «Timeline»  βρίσκεται στο σημείο 6. Εκεί υπάρχουν χωριστά κανάλια για 
τον ήχο, το βίντεο και για άλλο υλικό. Έτσι, μπορούν ταυτόχρονα να παίζουν δυο ή περισσό-
τερα κανάλια που περιέχουν ήχο, βίντεο, εικόνες ή υπότιτλους. 

 

 
 
Εικόνα 11.1 Το περιβάλλον εργασίας του Adobe Premiere Pro. 
 

11.1.2. Εισαγωγή μέσων σε ένα έργο  
 
Όπως αναφέρθηκε πιο πάνω, τα έργα που δημιουργούμε στο Premiere Pro είναι σύνθετα και μπορούν να πε-
ριέχουν διαφορετικά μέσα. Όταν ξεκινήσουμε το λογισμικό, μας ζητά να δημιουργήσουμε ένα νέο έργο, να 
ορίσουμε όνομα αρχείου και να το αποθηκεύσουμε σε κάποιον φάκελο. Με το μενού «File > New > Project» 
μπορούμε να δημιουργήσουμε ένα νέο έργο οποιαδήποτε στιγμή. 

Για να χρησιμοποιήσουμε κάποια μέσα στο έργο μας, όπως βίντεο, εικόνες, ήχους κ.ά., πρέπει πρώτα 
να τα εισάγουμε. Αυτό γίνεται με την επιλογή «File > Import». Στην Εικόνα 11.2 εμφανίζονται το «project» 
πάνελ με τα αρχεία που έχουν εισαχθεί στο έργο μας.  

 

 
 
Εικόνα 11.2 Τα αρχεία που έχουν εισαχθεί στο έργο μας. 

 
Αν θέλουμε να διαγράψουμε κάποιο από τα αρχεία αυτά, απλά κάνουμε κλικ στο όνομα του αρχείου 

και πατάμε το πλήκτρο delete ή το εικονίδιο  στο κάτω μέρος του παραθύρου. 
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11.1.3. Προσθήκη τίτλου έναρξης σε βίντεο  
 
Για την άσκηση αυτή θα πρέπει να έχετε εισάγει ένα απόσπασμα βίντεο στο έργο μας. Έπειτα εκτελούμε «Ti-
tle > New Title > Default Still» και εμφανίζεται το παράθυρο της Εικόνας 11.3. Με τις επιλογής «Title > 
New Title > Default Roll» και «Title > New Title > Default Crawl» ο τίτλος θα εμφανίζεται κινούμενος 
πάνω στο βίντεο. 

Με τα εργαλεία στο παράθυρο της Εικόνας 11.3 μπορούμε να επεξεργαστούμε τη μορφή που θα έχει 
ο τίτλος. Μπορούμε να ορίσουμε τη γραμματοσειρά, το μέγεθος, να προσθέσουμε εφέ, αλλά και να δημιουρ-
γήσουμε σχήματα με τα εργαλεία που υπάρχουν στην αριστερή πλευρά. Στο κάτω μέρος του παραθύρου υ-
πάρχουν τα «Text Styles» για τη μορφή του κειμένου. Με τη γραμμή κύλισης δίπλα από τα δείγματα των 
στυλ εμφανίζονται αρκετά ακόμη στυλ. Κλείνοντας το παράθυρο του τίτλου, εμφανίζεται το αρχείο «Tile 01» 
στο «project» πάνελ. 

 

 
 
Εικόνα 11.3 Παράθυρο επεξεργασίας τίτλου. 

 

 
 
Εικόνα 11.4 Χρονοδιάδρομος, όπου εμφανίζεται το βίντεο και ο τίτλος. 

 
Το τελευταίο βήμα είναι η τοποθέτηση του τίτλου και του αποσπάσματος βίντεο πάνω στον χρονο-

διάδρομο, ώστε να γίνεται η αναπαραγωγή τους παράλληλα. Σύρουμε τον τίτλο στη σειρά Video 2 του Time-
line και το βίντεο στη σειρά Video 1 του Timeline, ώστε να εμφανιστεί κάποια εικόνα παρόμοια με την Εικό-
να 11.4. Στο πάνω δεξί μέρος του Premiere Pro εμφανίζεται το απόσπασμα με τον τίτλο σε υπέρθεση (Εικόνα 
11.5).  

Ο τίτλος που έχει τοποθετηθεί στο χρονοδιάγραμμα μπορεί να συρθεί προς τα δεξιά, ώστε να εμφανί-
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ζεται στο τέλος του βίντεο ή σε κάποια άλλη στιγμή. Επίσης, με κλικ στο τέλος του πλαισίου «Title 01» στον 
χρονοδιάδρομο μπορούμε να αυξήσουμε ή να μειώσουμε τη διάρκεια εμφάνισης του τίτλου. 

Αφού ολοκληρώσουμε την επεξεργασία, μπορούμε να εκτελέσουμε την επιλογή «File > Export > 
Media», να ορίσουμε κάποιες ρυθμίσεις κωδικοποίησης και να αποθηκεύσουμε το έργο μας στην επιθυμητή 
μορφή. 

 

 
 
Εικόνα 11.5 Βίντεο με τον τίτλο που προσθέσαμε. 

 
Μέσω της επιλογής «Title > New Title» μπορούμε να προσθέσουμε και δεύτερο τίτλο, δηλαδή κά-

ποιο κείμενο, το οποίο είτε θα το τοποθετήσουμε στο τέλος του βίντεο ή θα εμφανίζεται σε όλη τη διάρκεια 
του βίντεο. 
 

11.1.4. Εισαγωγή και διαγραφή ήχου 
 
Έστω ότι έχουμε εισάγει κάποιο βίντεο, το οποίο δεν έχει ήχο και θέλουμε να εισάγουμε κάποιο μουσικό 
κομμάτι. Όταν το σύρουμε στο timeline, θα εμφανίζεται όπως στην Εικόνα 11.6. Δηλαδή, στον χρονοδιάδρο-
μο του Audio δεν εμφανίζονται δεδομένα ήχου. Αντίθετα, αν περιέχει ήχο, μόλις το σύρουμε στον χρονοδιά-
δρομο, τότε θα εμφανιστεί, όπως φαίνεται στην Εικόνα 11.7. 

 

 
 
Εικόνα 11.6 Βίντεο που δεν περιέχει ήχο. 

 
Στην περίπτωση που θέλουμε να εισάγουμε κάποιον ήχο, πρέπει πρώτα να τον εισάγουμε με την επι-

λογή «File > Import». Στη συνέχεια χρειάζεται να σύρουμε τον ήχο πάνω στον χρονοδιάδρομο του Audio, 
οπότε θεωρητικά έχουμε τελειώσει. Δηλαδή, θα μπορεί πλέον να αναπαραχθούν τα δύο μέσα παράλληλα.  
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Στην περίπτωση, όμως, που η διάρκεια του ήχου είναι μικρότερη από εκείνη του βίντεο, τότε μπο-
ρούμε να σύρουμε στον χρονοδιάδρομο το ίδιο μουσικό κομμάτι ή κάποιο άλλο, το οποίο θα καλύπτει τη 
χρονική διάρκεια του βίντεο. 

 

 
  
Εικόνα 11.7 Βίντεο που περιέχει ήχο. 

 
Στην περίπτωση που θέλουμε να διαγράψουμε τον ήχο από κάποιο βίντεο, το οποίο εμφανίζεται όπως 

για παράδειγμα στην Εικόνα 11.7, τότε πρέπει να κάνουμε κλικ στο κουτάκι (λέγεται «Toggle Track Lock») 
που βρίσκεται πριν από το όνομα του χρονοδιαδρόμου, ώστε να εμφανιστεί μια μικρή κλειδαριά. Όπως παρα-
τηρούμε στην Εικόνα 11.8, το βίντεο εμφανίζεται με πλάγιες γραμμές, ένδειξη που δηλώνει ότι είναι κλειδω-
μένο. Κάνοντας κλικ στον ήχο, που εμφανίζεται στον χρονοδιάδρομο, μπορούμε πλέον να τον διαγράψουμε. 
 

 
 
Εικόνα 11.8 Βίντεο με κλειδωμένα τα οπτικά δεδομένα. 

 
Ένας άλλος τρόπος για την απαλοιφή του ήχου από το τελικό αρχείο βίντεο είναι να μην έχουμε επι-

λεγμένη την επιλογή «Export Audio», όταν τελικά εξάγουμε το βίντεο με εκτέλεση της εντολής «File > Ex-
port > Media».  

 

11.1.5. Περικοπή τμημάτων βίντεο 
 
Πολλές φορές, χρειάζεται να περικόψουμε (trim) κάποια τμήματα από την αρχή ή το τέλος ενός αποσπάσμα-
τος βίντεο.  

 

 
 
Εικόνα 11.9 Περικοπή βίντεο με χρήση του εργαλείου «Ripple Edit». 
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Εισάγουμε το βίντεο στο timeline και επιλέγουμε το εργαλείο «Ripple Edit» . Στη συνέχεια κά-
νουμε κλικ στην αρχή του βίντεο και σύρουμε προς τα δεξιά. Όπως βλέπουμε στην Εικόνα 11.9, σύροντας 
προς τα δεξιά, εμφανίζεται το χρονικό διάστημα που περικόπτεται. 

 

11.1.6. Αλλαγή χρονικής διάρκειας 
 
Αν θέλουμε να αλλάξουμε τη χρονική διάρκεια ενός βίντεο, τότε επιλέγουμε «Speed/Duration», αφού όμως 
πρώτα το τοποθετήσουμε πάνω στον χρονοδιάγραμμα. Παρουσιάζεται το παράθυρο της Εικόνας 11.10, όπου 
εμφανίζεται η χρονική διάρκεια, στην περίπτωση που εκτελεστεί στο 100% της ταχύτητας. Αν αλλάξουμε το 
ποσοστό, π.χ. στο 200%, τότε η διάρκεια του βίντεο μειώνεται στο μισό (Εικόνα 11.10). Αν η ταχύτητα μειω-
θεί στο μισό, τότε θα διπλασιαστεί η διάρκεια.  

Είναι λογικό, η αλλαγή στην ταχύτητα αναπαραγωγής να επηρεάζει τη διάρκεια προβολής. Συνεπώς, 
αν θέλουμε να δείξουμε κάποιο βίντεο σε αργή κίνηση, τότε απλά μπορούμε να μειώσουμε την ταχύτητα του 
βίντεο στο 50% ή σε ακόμη μικρότερο ποσοστό.  

Πρέπει να αναφερθεί ότι αυτό επηρεάζει και την αναπαραγωγή του ήχου. Αν απλά μας ενδιαφέρει το 
βίντεο, μπορούμε να διαγράψουμε τον ήχο ή να μην έχουμε επιλεγμένη την εντολή «Export Video», όταν 
τελικά εξάγουμε το βίντεο με εκτέλεση της εντολής «File > Export > Media». Αν έχουμε επιλεγμένο το 
«Maintain Audio Pitch», τότε, αν και μεταβάλλεται η ταχύτητα του ήχου ανάλογα με τη μεταβολή της ταχύ-
τητας του video, διατηρείται το αρχικό ύψος (pitch) του ήχου, δηλαδή το αρχικό του φάσμα συχνοτήτων. 
  

 
 
Εικόνα 11.10 Αρχική ταχύτητα και διάρκεια του αποσπάσματος βίντεο. 

 

 
 
Εικόνα 11.11 Αλλαγή ταχύτητας και διάρκειας του αποσπάσματος βίντεο. 

 

11.1.7. Σύνδεση βίντεο και χρήση εφέ μετάβασης 
 
Η σύνδεση κάποιων βίντεο στο Premiere Pro συνιστά μια σχετικά εύκολη διαδικασία. Αφού γίνει η εισαγωγή 
των βίντεο, τότε τα σύρουμε και τα δύο αποσπάσματα πάνω στο timeline.  

Όπως βλέπουμε στην Εικόνα 11.12, τα δύο βίντεο παρατίθενται το ένα μετά το άλλο, δημιουργώντας 
έτσι μια αλληλουχία αποσπασμάτων, η οποία μπορεί να εξαχθεί ως ένα ενιαίο αρχείο. 

Η μετάβαση από το ένα απόσπασμα στο άλλο είναι απότομη και, ειδικά αν υπάρχουν μαύρα τμήματα 
στο τέλος του ενός αποσπάσματος, τότε η αλλαγή θα είναι εντελώς αφύσικη. Για την εξομάλυνση της μετά-
βασης μπορούμε να χρησιμοποιήσουμε εφέ μετάβασης. Στην αριστερή πλευρά του λογισμικού πρέπει να ε-
ντοπίσετε την καρτέλα «Effects». Παρατηρούμε ότι υπάρχουν αρκετά διαθέσιμα εφέ. Πηγαίνουμε στην κα-
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τηγορία «Video Transitions» και, αφού επιλέξουμε κάποιο εφέ από, το σύρουμε και το εναποθέτουμε μεταξύ 
των δύο βίντεο. Πλέον, αν κάνουμε αναπαραγωγή του βίντεο στο παράθυρο «Program» του λογισμικού θα 
εμφανιστεί το εφέ. 

 

 
 
Εικόνα 11.12 Συνδεδεμένα βίντεο στον χρονοδιάδρομο. 

 

 
 
Εικόνα 11.13 Πλαίσιο με τα διαθέσιμα εφέ. 

 
Όπως παρατηρούμε στην Εικόνα 11.13, υπάρχουν αρκετά εφέ, τα οποία μπορούμε να σύρουμε πάνω 

σε κάποιο απόσπασμα βίντεο. Μέσω της επιλογής «Audio Effects», μπορούμε να σύρουμε κάποιο εφέ πάνω 
σε κάποιο απόσπασμα ήχου. Για παράδειγμα, μπορούμε να σύρουμε το εφέ «Crossfade» πάνω σε έναν ήχο, 
ώστε να μειώνεται σταδιακά η ένταση ενός αποσπάσματος ήχου στο timeline και να εισάγεται το επόμενο, 
χωρίς να φαίνεται απότομη η μετάβαση. 

 

11.2. Avidemux 
 

Το Avidemux (http://avidemux.sourceforge.net/download.html) είναι ένα δημοφιλές δωρεάν πρόγραμμα α-
νοιχτού κώδικα για την επεξεργασία βίντεο, το οποίο επιτρέπει: 

 Μοντάζ αποσπασμάτων βίντεο. 
 Εφαρμογή φίλτρων και ειδικών εφέ. 
 Επεξεργασία των αποσπασμάτων βίντεο, π.χ. αλλαγή μεγέθους, περιστροφή, υποτιτλισμός 

κ.ά. 
 Κωδικοποίηση σε πολλούς τύπους βίντεο (avi, mp4 κ.ά.). 

 
Το Avidemux αποτελεί ένα εναλλακτικό εργαλείο για την εκτέλεση των πιο συνηθισμένων λειτουρ-

γιών ενός μη-επαγγελματία χρήστη. 
 

11.2.1. Γνωριμία με το περιβάλλον εργασίας του Avidemux 
 
Στην Εικόνα 11.14 εμφανίζεται το περιβάλλον εργασίας του Avidemux.  
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 Στο σημείο 1 εμφανίζεται το μενού επιλογών του εργαλείου, καθώς και διάφορα άλλα χειρι-
στήρια για αναπαραγωγή του ήχου, αντιγραφή και επικόλληση τμημάτων κ.ά.  

 Οι επιλογές στο σημείο 2 χρησιμοποιούνται για τη ρύθμιση των κωδικοποιητών ήχου και βί-
ντεο, για τα φίλτρα και τη μορφή εξόδου. 

 Στο σημείο 3 προβάλλεται το βίντεο κατά την επεξεργασία του. Είναι δυνατόν να εμφανίζε-
ται είτε το αρχικό βίντεο είτε το τελικό με την εφαρμογή των φίλτρων. 

 Στο σημείο 4 περιλαμβάνονται η μπάρα πλοήγησης και τα κουμπιά πλοήγησης και επιλογής, 
ο τροχός ρύθμισης αναπαραγωγής, καθώς και πλαίσια πληροφοριών και ρύθμισης του ήχου. 

 

 
 
Εικόνα 11.14 Το περιβάλλον εργασίας του Avidemux. 

 

11.2.2. Βασικές λειτουργίες με το Avidemux 
 

Τα κουμπιά του Πίνακα 11.1 χρησιμοποιούνται για την αναπαραγωγή του βίντεο.  
 

 
 

Εκκίνηση και διακοπή αναπαραγωγής του βίντεο. 

 
 

Μετάβαση στο προηγούμενο ή επόμενο καρέ του βίντεο. 

 
 

Μετάβαση στο προηγούμενο ή επόμενο καρέ-κλειδί του βίντεο. 

 
Το πρώτο κουμπί «Α» χρησιμοποιείται για να γίνει ορισμός της θέσης (καρέ) αρχής και 
το κουμπί «B» ορίζει τη θέση (καρέ) τέλους επιλογής. Χρησιμοποιούνται για να οριστούν 
για την αποκοπή ή αποθήκευση του επιλεγμένου αποσπάσματος του βίντεο. 

 
 

Μετάβαση στο προηγούμενο ή επόμενο μαύρο καρέ του βίντεο. 

 
 

Μετάβαση στο πρώτο ή τελευταίο καρέ του βίντεο. 

 
 

Χρησιμοποιείται για να καθορίσουμε την αρχή και το τέλος μιας επιλογής. 
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Ο τροχός καθορίζει την κατεύθυνση και την ταχύτητα αναπαραγωγής. Αν τον σύρουμε 
προς τα αριστερά, αρχίζει να αναπαράγεται το βίντεο αντίστροφα, δηλαδή προς τα πίσω. 
Όσο πιο άκρη σύρουμε τον κόκκινο δείκτη, τόσο πιο γρήγορα γίνεται η αναπαραγωγή 
του βίντεο. 

 
Πίνακας 11.1 Βασικά κουμπιά αναπαραγωγής βίντεο. 

 
Μέσω της επιλογής «File > Save as Image > Save as JPEG» μπορούμε να εξάγουμε το τρέχον καρέ 

ως εικόνα jpg (π.χ. το καρέ στην Εικόνας 11.15). Υπάρχει και αντίστοιχη επιλογή για την εξαγωγή ως εικόνα 
bmp. 

Η επιλογή «File > Information» εμφανίζει τα χαρακτηριστικά του βίντεο. Όπως βλέπουμε στην Ει-
κόνα 11.16 εμφανίζονται οι codecs, η διάρκεια, η ανάλυση και ο ρυθμός πλαισίων του βίντεο. Το συγκεκρι-
μένο βίντεο χρησιμοποιεί τον κωδικοποιητή βίντεο H264, ενώ για τον ήχο χρησιμοποιεί τον κωδικοποιητή 
AAC.  

 

 
 
Εικόνα 11.15 Εικόνα που έχει εξαχθεί από το βίντεο. 

 
 

 
 
Εικόνα 11.16 Χαρακτηριστικά βίντεο. 
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11.2.3. Άνοιγμα και συνένωση αρχείων 
 

Με την επιλογή «File > Open» μπορούμε να ανοίξουμε ένα βίντεο, ενώ με την επιλογή «File > Append» το 
νέο βίντεο, που θα ανοίξει, θα προστεθεί στο τέλος του ήδη ανοικτού αρχείου. Πρακτικά, η επιλογή αυτή 
χρησιμοποιείται για τη συνένωση πολλών αρχείων βίντεο σε ένα. 

 

11.2.4. Αποθήκευση οπτικών ή ηχητικών δεδομένων  
 

Το λογισμικό μάς δίνει τη δυνατότητα για αποθήκευση μόνο των οπτικών δεδομένων ή μόνο του ήχου του 
αρχείου βίντεο. Για την αποθήκευση μόνο των δεδομένων εικόνας πρέπει να επιλέξουμε «Audio > Select 
Track» και απενεργοποιούμε το επιλεγμένο Track. Στη συνέχεια μπορούμε να αποθηκεύσουμε το αρχείο από 
το μενού «File > Save» με βάση τις επιλογές μας. 

Για την αποθήκευση μόνο των δεδομένων εικόνας πρέπει να επιλέξουμε «Audio > Save Audio», ο-
πότε δίνουμε ένα όνομα αρχείου. 

 

11.2.5. Αποθήκευση και διαγραφή τμημάτων βίντεο 
 
Για να επιλέξουμε κάποιο τμήμα πρέπει να πάμε στο καρέ αρχής, που θέλουμε, με χρήση των κουμπιών που 

είδαμε στον Πίνακα 11.1 και να πατήσουμε πρώτα το κουμπί «A» από τα εικονίδια . Έπειτα να μετακι-
νηθούμε στο τελευταίο καρέ του τμήματος που θέλουμε και να πατήσουμε το εικονίδιο «B».  

Όπως βλέπουμε στο κάτω μέρος της Εικόνας 11.17, έχει επιλεγεί ένα τμήμα του βίντεο. Με το μενού 
«File > Save» αποθηκεύουμε το απόσπασμα με νέο όνομα. 

Έχοντας επιλεγμένο ένα τμήμα του βίντεο, μπορούμε να επιλέξουμε «Edit > Delete», προκειμένου 
να διαγράψουμε το επιλεγμένο τμήμα βίντεο. 

 

 
 
Εικόνα 11.17 Βίντεο με επιλεγμένο τμήμα. 

 

11.2.6. Αλλαγή κωδικοποιητών 
 
Στην αριστερή πλευρά του Avidemux υπάρχουν δύο αναδυόμενες λίστες για επιλογή κωδικοποιητών βίντεο 
και ήχου. Για παράδειγμα, στην Εικόνα 11.18 βλέπουμε τους κωδικοποιητές του βίντεο και στην Εικόνα 
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11.19 τους κωδικοποιητές, που έχουν επιλεγεί τελικά, καθώς και τη μορφή εξόδου (Output Format). Στη συ-
νέχεια αποθηκεύουμε το βίντεο. 

 

 
 
Εικόνα 11.18 Επιλογή κωδικοποιητών βίντεο. 

 

 
 
Εικόνα 11.19 Επιλεγμένοι κωδικοποιητές και μορφή εξόδου. 

 

11.2.7. Εφαρμογή φίλτρων 
 
Το Avidemux διαθέτει αρκετά φίλτρα και εφέ, με τα οποία μπορείτε να επεξεργαστείτε το βίντεο. Τα φίλτρα 
είναι διαθέσιμα από τη γραμμή Μενού «Video > Φίλτρα» ή από το αριστερό τμήμα της εφαρμογής μέσω του 
κουμπιού «Filters». Προσοχή χρειάζεται, ώστε στη λίστα κωδικοποιητών να είναι επιλεγμένη οποιαδήποτε 
άλλη επιλογή, πλην της «Copy», η οποία δεν επιτρέπει την εφαρμογή φίλτρων. 

 

 
 
Εικόνα 11.20 Κατηγορίες φίλτρων και εφέ. 
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Το παράθυρο διαχείρισης φίλτρων βίντεο (Εικόνα 11.20) αποτελείται από τα εξής τμήματα:  
15. Κατηγορίες Φίλτρων: Τα διαθέσιμα φίλτρα είναι χωρισμένα σε κατηγορίες ανάλογα με την 

επεξεργασία που εκτελούν. Οι κατηγορίες αυτές εμφανίζονται στην αριστερή πλευρά του πα-
ραθύρου. 

16. Διαθέσιμα φίλτρα ανά κατηγορία: Μόλις επιλέξετε κατηγορία φίλτρων, στο δεύτερο τμήμα 
του παραθύρου θα παρουσιαστούν τα διαθέσιμα φίλτρα τις κατηγορίας αυτής. 

17. Ενεργά φίλτρα: Είναι τα φίλτρα που έχουν τελικά εφαρμοστεί πάνω σε ένα βίντεο. Εμφανίζο-
νται στη δεξιά πλευρά του παραθύρου. 

 

Με κλικ στην κατηγορία φίλτρων «Subtitles» και κλικ στο εικονίδιο  μπορούμε να προσθέσουμε 
αρχείο υπότιτλων στο βίντεο. Αν και, όπως θα δούμε στο επόμενο κεφάλαιο, το αρχείο υπότιτλων μπορεί να 
υπάρχει και χωριστά, στην περίπτωση που το βίντεο πρόκειται να προβληθεί μέσω εφαρμογής, η οποία έχει 
αναπτυχθεί σε HTML5. 

Με τα εικονίδια της Εικόνας 11.21 μπορούμε να διαχειριστούμε τα φίλτρα που έχουμε προσθέσει. 
Μπορούμε να τα αφαιρέσουμε ή να τους αλλάξουμε σειρά ή με το κουμπί «Configure» να αλλάξουμε τις 
ρυθμίσεις. 

 

 
 

Εικόνα 11.21 Κουμπιά διαχείρισης των φίλτρων. 

 

Η πρόσθεση ενός φίλτρου γίνεται με το εικονίδιο . Για παράδειγμα, μπορούμε να επιλέξουμε το 
φίλτρο «Resample FPS», να πατήσουμε το εικονίδιο πρόσθεσης και να εμφανιστεί το παράθυρο της Εικόνας 
11.22. 

 

 
 
Εικόνα 11.22 Επιλογές φίλτρου επαναδειγματοληψίας. 

 
Στον Πίνακα 11.2 εξηγούνται τα βασικότερα φίλτρα και εφέ του Avidemux. 
 

Φίλτρα Transform (Μετασχηματισμού)  
Crop (περικοπή) Περικόπτει το βίντεο περιμετρικά με βάση τις τιμές που θα δοθούν στις 

ρυθμίσεις. 
Resize Αλλάζει τις διαστάσεις (ύψος, πλάτος) του βίντεο μικραίνοντας ή μεγα-

λώνοντάς το, με σταθερό λόγο ή με παραμόρφωση. 
Vertical flip Αναστρέφει το βίντεο στον κάθετο άξονα. 
Horizontal flip Αναστρέφει το βίντεο στον οριζόντιο άξονα. 
Rotate Περιστρέφει το βίντεο κατά γωνία 90ο, 180ο ή 270ο.  
Resample fps Αλλάζει την ποσότητα των καρέ ανά δευτερόλεπτο. 
Logo Προσθέτει ένα αρχείο εικόνας ως λογότυπο. 
GrayScale Αφαιρεί το χρώμα, κάνει ασπρόμαυρο το βίντεο. 
Φίλτρα Interlacing (Transform) Τα φίλτρα αυτά, χρησιμοποιώντας διαφορετικές μεθόδους, ανιχνεύουν αν 

η εικόνα είναι πεπλεγμένη και θολώνουν τα interlaced μέρη, ανάλογα με 
τις ρυθμίσεις που έχουν οριστεί. 

Φίλτρα Colors  
MPlayer eq2 Ρυθμίζουν απόχρωση, κορεσμό, φωτεινότητα και γάμμα 
MPlayer hue Ρυθμίζουν απόχρωση, κορεσμό, φωτεινότητα και γάμμα 
Contrast Ρυθμίζει την αντίθεση και τη φωτεινότητα ανά χρώμα. 
Φίλτρα Noise Τα περισσότερα φίλτρα αυτής της κατηγορίας αφαιρούν τον θόρυβο από 

την εικόνα, χρησιμοποιώντας τον μέσο όρο των γύρω pixels. 
Soften Εμφανίζει τις άκρες πιο απαλές, χωρίς να προσθέτει θόρυβο. 
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Φίλτρα Sharpen/Blur Τα περισσότερα φίλτρα αυτής της κατηγορίας οξύνουν την εικόνα. 
MPlayer delogo Αφαιρεί το λογότυπο. 
Φίλτρα Subtitles  
Subtitler Προσθέτει / ενσωματώνει υπότιτλους στο βίντεο. Δέχεται ρυθμίσεις για 

το είδος και το μέγεθος της γραμματοσειράς. 

 
Πίνακας 11.2 Εξήγηση βασικών φίλτρων και εφέ του Avidemux. 

 

11.3. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο τρέχον κεφάλαιο παρουσιάσαμε τα εργαλεία επεξεργασίας ήχου Adobe Premiere Pro και το δωρεάν ερ-
γαλείο Avidemux. Το πρώτο εργαλείο είναι εμπορικό, ενώ το δεύτερο λογισμικό είναι ελεύθερο και ανοιχτού 
κώδικα. Το Adobe Adobe Premiere Pro έχει αρκετές δυνατότητες και θεωρείται ένα από τα πιο ολοκληρωμέ-
να επαγγελματικά λογισμικά. Για απλές λειτουργίες, όπως περικοπή βίντεο και πρόσθεση υπότιτλων ή εξα-
γωγή κάποιας εικόνας, το Avidemux μάς καλύπτει. Για πιο απαιτητικές εργασίες απαιτείται η χρήση του 
Premiere Pro ή κάποιου άλλου επαγγελματικού εργαλείου. 
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12. Εισαγωγή στην ανάπτυξη πολυμεσικών εφαρμογών με HTML5 
 

Σύνοψη 
Στο παρόν κεφάλαιο γίνεται επισκόπηση των βασικών χαρακτηριστικών της HTML5. Αρχικά γίνεται μια εισα-
γωγή στη γλώσσα HTML και την εξέλιξή της και στη συνέχεια εστιάζουμε στην HTML5 και τις βασικές ετικέτες, 
στις οποίες βασίζεται η ανάπτυξη πολυμεσικού υλικού. 

 
Προαπαιτούμενη γνώση 
Πρέπει να έχει γίνει μελέτη των προηγούμενων κεφαλαίων του βιβλίου. 

 

12.1. Εισαγωγή στην HTML 
 
Η HTML (Hypertext Markup Language) είναι μια απλή γλώσσα περιγραφής, η οποία χρησιμοποιείται για τη 
δημιουργία εγγράφων υπερκειμένου (hypertext), τα οποία είναι δυνατόν να μεταφέρονται σε διαφορετικές 
πλατφόρμες λειτουργικών συστημάτων. Τα αρχεία HTML είναι απλά αρχεία κειμένου με ενσωματωμένους 
κωδικούς (εμφανιζόμενους ως ετικέτες HTML), οι οποίοι υποδεικνύουν τη μορφοποίηση που θα έχει το κεί-
μενο, καθώς και με συνδέσεις hypertext. Για παράδειγμα, για να εμφανιστεί μια λέξη με έντονη γραφή πρέπει 
να εισαχθεί στις ετικέτες (tags) <b> και </b>. 

Η γλώσσα HTML εκτελείται από τους φυλλομετρητές (browsers), δηλαδή τα προγράμματα περιήγη-
σης στο διαδίκτυο. Οι φυλλομετρητές δέχονται το αρχείο κειμένου, που περιέχει τις ετικέτες και εμφανίζει το 
αποτέλεσμα. Για παράδειγμα, στην Εικόνα 12.1 εμφανίζεται ένα αρχείο HTML και δίπλα το αποτέλεσμα. Το 
κείμενο “Spectacular Mountain” εμπερικλείεται στις ετικέτες με <h2> και </h2> και συνεπώς, εμφανίζεται 
με έντονη γραφή και μεγαλύτερα γράμματα. Η φωτογραφία εισάγεται με την ετικέτα <img>. 

 

 
 
Εικόνα 12.1 Κώδικας σε HTML και δίπλα το αποτέλεσμα. 

 

12.1.1. Κάποιες βασικές ετικέτες 
 
Σε ένα αρχείο HTML οι πληροφορίες περικλείονται σε διάφορες ετικέτες της μορφής <ετικέτα>, που πρακτι-
κά δίνουν εντολή στον φυλλομετρητή για τον τρόπο προβολής του κειμένου. Οι περισσότερες ετικέτες αποτε-
λούνται από ζεύγη ετικετών, τα οποία σηματοδοτούν την αρχή και το τέλος του κειμένου, ενώ έχουν τη μορ-
φή <ετικέτα>κείμενο</ετικέτα>. Οι υπόλοιπες αποτελούνται μόνο από μία ετικέτα. Κάποιες βασικές ετικέτες 
της HTML είναι: 

 Οι ετικέτες <h1> … </h1> σηματοδοτούν ένα κείμενο ως επικεφαλίδα πρώτου επιπέδου. 
 Οι ετικέτες <p> … </p> χρησιμοποιούνται για να σηματοδοτήσουν την αρχή και το τέλος 

μιας παραγράφου. Δηλαδή, ένα τμήμα κειμένου, που εισάγεται μεταξύ των ετικετών <p> … 
</p>, εμφανίζεται ως μια ενιαία παράγραφος, αρχίζοντας σε νέα σειρά. 
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 Η ετικέτα <br> χρησιμοποιείται για να εισάγει μια αλλαγή γραμμής, δηλαδή το κείμενο, το 
οποίο ακολουθεί την ετικέτα, θα εμφανιστεί σε μια νέα γραμμή. 

 Οι ετικέτες <b> … </b> χρησιμοποιούνται για τη μορφοποίηση του κειμένου σε έντονη 
γραφή. 

 Οι ετικέτες <i> … </i> χρησιμοποιούνται για τη μορφοποίηση του κειμένου σε πλάγια 
γραφή. 

 Οι ετικέτες <u> … </u> χρησιμοποιούνται για τη μορφοποίηση του κειμένου σε πλάγια 
γραφή. 

 Η ετικέτα <hr> εισάγει μια οριζόντια διαχωριστική γραμμή. 
 
Οι ετικέτες μπορεί να περιέχουν και άλλες ενσωματωμένες ετικέτες, ώστε να επιτυγχάνεται τελικά η 

επιθυμητή μορφοποίηση. Στον Πίνακα 12.1 υπάρχει ένα παράδειγμα αριθμημένης λίστας, που δημιουργείται 
με την ετικέτα <li> (list item), η οποία ενσωματώνεται μέσα στην ετικέτα <ol>. 

 
Κώδικας HTML Αποτέλεσμα 

<ol> 
 <li>Κόκκινο</li> 
 <li> Κόκκινο</li> 
 <li>Μπλε</li> 
</ol> 

1. Κόκκινο 
2. Κόκκινο 
3. Μπλε 

 
Πίνακας 12.1 Παράδειγμα λίστας στην HTML. 

 
Μέσα στις ετικέτες μπορεί να υπάρχουν παράμετροι, που ορίζουν εξωτερικά αρχεία ή τον τρόπο εμ-

φάνισης των στοιχείων που περικλείει. Χαρακτηριστικό παράδειγμα είναι η ετικέτα <img src="όνομα αρχεί-
ου εικόνας">, όπου το img είναι η ετικέτα της εικόνας και το src είναι μια παράμετρος που καθορίζει που πε-
ριέχει τη διεύθυνση (URL ή path) της εικόνας που θα εμφανιστεί.  

Στο διαδίκτυο υπάρχουν πολλοί δωρεάν οδηγοί εκμάθησης της HTML. Συνήθως, οι προγραμματιστές 
δεν γράφουν απευθείας κώδικα HTML, αλλά χρησιμοποιούν επεξεργαστές που αναφέρονται ως WYSWYG 
(What You See Is What You Get), όπου μορφοποιούμε το κείμενο και τα άλλα στοιχεία μιας ιστοσελίδας, 
όπως σε έναν οποιονδήποτε επεξεργαστή κειμένου. Στη συνέχεια ο επεξεργαστής παράγει τον κώδικα HTML 
και, συνεπώς, το αρχείο για το διαδίκτυο. Τα συστήματα διαχείρισης περιεχομένου (CMS – Content Man-
agement Systems) και οι διαδικτυακές υπηρεσίες, που προσφέρουν πρότυπες κενές HTML σελίδες, δεν εμφα-
νίζουν σχεδόν καθόλου τον κώδικα της HTML, ενώ επιτρέπουν τη δημιουργία τους μέσω των WYSWYG 
επεξεργαστών τους. 

 

12.1.2. CSS 
 

Η HTML χρησιμοποιείται πολύ συχνά με την τεχνολογία των CSS (Cascading Style Sheets - Διαδοχικά Φύλ-
λα Στυλ - αλληλουχία φύλλων στυλ), η οποία  είναι μια γλώσσα περιγραφής που χρησιμοποιείται για τον έ-
λεγχο της εμφάνισης εγγράφων, τα οποία έχουν γραφτεί με μια γλώσσα σήμανσης. Χρησιμοποιείται, δηλαδή, 
για τον έλεγχο της εμφάνισης εγγράφων που γράφτηκαν στην HTML. Τα CSS μας βοηθούν να ξεχωρίσουμε 
τη σήμανση που κάνουμε με την HTML από την τελική μορφή εμφάνισης των αντικειμένων. 

Αναπτύσσοντας σελίδες μόνο με HTML κώδικα, έχουμε τη δυνατότητα να ορίσουμε το χρώμα και το 
μέγεθος του κειμένου, καθώς και άλλα στοιχεία της σελίδας (όπως πίνακες, συνδέσμους, λίστες κ.λπ.). Η δια-
δικασία αυτή είναι εύκολη, όταν πρόκειται μόνο για μερικές σελίδες. Σε μια ολοκληρωμένη διαδικτυακή ε-
φαρμογή, η οποία αποτελείται από πολλές σελίδες, η διαδικασία αυτή είναι περίπλοκη για πολλούς λόγους. 
Θα πρέπει να εφαρμόζουμε πολλές φορές τις ίδιες μορφοποιήσεις, εφόσον, αν χρειαστεί κάποια αλλαγή, πρέ-
πει να την κάνουμε σε κάθε ιστοσελίδα. 

Χρησιμοποιώντας CSS, μπορούμε να ορίζουμε χρώματα και μεγέθη κειμένου οργανωμένα σε στυλ 
και έπειτα να εφαρμόζουμε τα στυλ αυτά στα στοιχεία των σελίδων του site μας. Με αυτόν τον τρόπο, κάθε 
φορά που αλλάζουμε το χρώμα ενός στυλ, αλλάζει το χρώμα όλων των στοιχείων που έχουν αναφορά στο 
στυλ αυτό. Για παράδειγμα, ορίζοντας ένα στυλ για το μενού του site, αν αλλάξουμε το χρώμα αυτού του 
στυλ, αυτόματα θα εφαρμοστεί σε όλες τις σελίδες. Εκτός από την ευκολία στη διαχείριση, ένα άλλο σημα-
ντικό πλεονέκτημα της χρήσης CSS είναι και ο πιο οργανωμένος κώδικας, χωρίς πολλές ιδιότητες στις ετικέ-
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τες της HTML, στοιχείο που τον καθιστά δυσανάγνωστο. Στο παράδειγμα του Πίνακα 12.2 εμφανίζονται οι 
ρυθμίσεις εμφάνισης του κειμένου, που εσωκλείεται στις ετικέτες παράγραφου. 

 
p { 
                    font-style: italic; 
                    font-weight: bold; 
                    font-size: 30px; 
                    font-family: arial, sans-serif; 
} 

 
Πίνακας 12.2 Παράδειγμα CSS. 

 

12.1.3. JavaScript 
 
Η γλώσσα σεναρίων (script) JavaScript είναι μια γλώσσα, η οποία επιτρέπει την ύπαρξη scripts στις σελίδες 
HTML και αυξάνει τη διαδραστικότητα της εφαρμογής με τις δυνατότητες για επεξεργασία των δεδομένων 
εισόδου και των ενεργειών του χρήστη. Η Javascript εισάγεται σε μια ιστοσελίδα με την ετικέτα <script> και 
μέσα εισάγονται οι εντολές σεναρίων. Κάποια παραδείγματα θα δούμε πιο κάτω. 

 

12.1.4. Εξέλιξη της HTML 
 
Η HTML δημιουργήθηκε από τον Sir Tim Berners-Lee το 1991, δύο χρόνια μετά την εφεύρεση του WWW 
(World Wide Web), όπως βλέπουμε στον Πίνακα 12.1. Η εξέλιξη της HTML αφορά κυρίως στην πρόσθεση 
νέας λειτουργικότητας με τη χρήση νέων ετικετών. Από το 2008 έχει εμφανιστεί η HTML5 (Εικόνα 12.2) που 
προσφέρει δυνατότητες προηγμένης διαχείρισης των μέσων, π.χ. δυνατότητα σχεδίασης διανυσματικών αρ-
χείων SVG ή πολλαπλές δυνατότητες στη χρήση βίντεο. 

 
Εξέλιξη της HTML Έτος 

Ο Tim Berners-Lee δημιούργησε το WWW 1989 
Ο Tim Berners-Lee δημιούργησε την HTML 1991 
Ο Dave Raggett συνέταξε την HTML+ 1993 
Το HTML Working Group όρισε την HTML 2.0 1995 
Το W3C πρότεινε την HTML 3.2 1997 
Το W3C πρότεινε την HTML 4.01 1999 
HTML5 πρώτο δημόσιο προσχέδιο 2008 
HTML5 W3C τελική σύσταση 2014 

 
Πίνακας 12.3 Βασικοί σταθμοί στην εξέλιξη της HTML. 

 
 

 
 
Εικόνα 12.2 Λογότυπο HTML5. 

 
Στις επόμενες ενότητες εστιάζουμε στα νέα χαρακτηριστικά της HTML5 και δίνουμε παραδείγματα 

που αφορούν στη χρήση πολυμεσικού υλικού. 
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12.2. HTML5 
 
Η ακόλουθη λίστα συνοψίζει τις βασικές αλλαγές στην HTML5: 

 Παρουσιάζει αρκετές νέες ετικέτες, που ανταποκρίνονται στο σύγχρονο τρόπο κατασκευής 
μιας ιστοσελίδας σε ό,τι αφορά τη σελιδοποίηση και τη μορφοποίηση. Οι ετικέτες <article>, 
<header>, <footer>, <nav>, <section> αντικαθιστούν τα πολλαπλά <div> για την 
οριοθέτηση τμημάτων διαφορετικού περιεχομένου, τα οποία χρησιμοποιούνταν στις 
προηγούμενες εκδόσεις.  

 Η ετικέτα <canvas> ορίζει μια ορθογώνια περιοχή, που μπορεί να εμφανίσει διάφορα 
γραφικά σε μια σελίδα, από απλά διαγράμματα μέχρι κινούμενα γραφικά και εξωτερικές 
εικόνες. 

 Δυνατότητα τοπικής αποθήκευσης (offline storage), επιτρέποντας στις ιστοσελίδες να 
αποθηκεύουν πληροφορίες στον υπολογιστή του χρήστη, έτσι ώστε να μη χρειάζεται να τις 
λαμβάνουν κάθε φορά που ο χρήστης επισκέπτεται την ιστοσελίδα. 

 Δυνατότητα μεταφοράς και απόθεσης, δηλαδή ο χρήστης έχει τη δυνατότητα να μεταφέρει 
στοιχεία από μια ιστοσελίδα σε άλλη ή από εφαρμογές στον φυλλομετρητή. 

 Δυνατότητα αναπαραγωγής ήχου και βίντεο απευθείας, χωρίς την ανάγκη ύπαρξης 
πρόσθετων προγραμμάτων με τις ετικέτες <audio> και <video>. Οι ετικέτες έχουν κάποιες 
ιδιότητες/παραμέτρους, οι οποίες ρυθμίζουν τον τρόπο αναπαραγωγής του υλικού. 

 Νέα στοιχεία, όπως τα calendar, date, time, email, url και search, στην ετικέτα <input> των 
φορμών. 

 

12.2.1. Η ετικέτα <video> 
 

Η ετικέτα <video> εισάγει στη σελίδα ένα βίντεο. Η ετικέτα κλείνει με την </video> και oι βασικές παράμε-
τροι και ενσωματωμένες ετικέτες, που υποστηρίζει η ετικέτα, περιγράφονται στον Πίνακα 12.4. 

 
Ιδιότητα (εν-

σωματωμένη ετικέτα 
ή παράμετρος) 

Περιγραφή 

autoplay Η αναπαραγωγή του βίντεο αρχίζει αυτόματα, αφού ολοκληρωθεί η φόρτωση του. 
controls Με την ιδιότητα αυτή εμφανίζονται τα κουμπιά ελέγχου για το βίντεο (play, stop κ.λπ.). 
height  Καθορίζει το ύψος του παραθύρου του βίντεο. 
loop  Επαναλαμβάνεται η αναπαραγωγή του βίντεο κάθε φορά που τελειώνει. 
preload Το βίντεο θα φορτωθεί (load), όταν η σελίδα φορτωθεί, αλλά αγνοείται, όταν υπάρχει η ιδιό-

τητα autoplay. 
src  Είναι η πηγή (όνομα αρχείου ή url) του αρχείου. 
width  Καθορίζει το πλάτος του παραθύρου του βίντεο. 

 
Πίνακας 12.4 Παράμετροι και ενσωματωμένες ετικέτες της ετικέτας <video>. 

 
Η παράμετρος src χρησιμοποιείται για ορίσει το αρχείο βίντεο. Μπορεί να υπάρχει μέσα στην ετικέτα 

ως <video src="video.mp4"> ή να υπάρχει στην ετικέτα <source src="video.mp4">, η οποία ενσωματώνεται 
ως υπο-πεδίο στην <video>, όπως βλέπουμε παρακάτω στον Πίνακα 12.5. 

Στον Πίνακα 12.5 εμφανίζεται ο κώδικας για την ενσωμάτωση βίντεο σε μια ιστοσελίδα. Παρατη-
ρούμε ότι ορίζουμε το μέγεθος του παραθύρου θέασης του βίντεο με τις ιδιότητες width και height. Η παρά-
μετρος autoplay ορίζει ότι αρχίζει αμέσως η αναπαραγωγή του βίντεο. Με την ενσωματωμένη ετικέτα 
<source> μπορούμε να ορίσουμε διαφορετικές μορφές του βίντεο, ώστε, αν κάποιος φυλλομετρητής δεν υ-
ποστηρίζει την πρώτη μορφή, τότε να γίνεται προσπάθεια για αναπαραγωγή της επόμενης μορφής. Η συγκε-
κριμένη ετικέτα μπορεί να υπάρχει και περισσότερες φορές, αν διαθέτουμε το βίντεο και σε άλλες μορφές και 
θέλουμε να είμαστε σίγουροι ότι το βίντεο θα αναπαραχθεί σωστά, παρόλο που τα βίντεο mp4 παίζουν σε 
όλους τους σύγχρονους browsers. 
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<video id="video1" width="320" height="240" autoplay> 
 <source src="movie.mp4" type="video/mp4"> 
 <source src="movie.ogg" type="video/ogg"> 
 Your browser does not support the video tag. 
</video> 

 
Πίνακας 12.5 Παράδειγμα ενσωμάτωσης βίντεο σε σελίδα. 

 
Το παραπάνω βίντεο θα εμφανιστεί στην ιστοσελίδα, όπου θα αναπαραχθεί αυτόματα λόγω της ιδιό-

τητας autoplay. Αλλά δεν μπορούμε να έχουμε έλεγχο επί του βίντεο, δηλαδή δεν μπορούμε να το σταματή-
σουμε ή να μειώσουμε την ένταση του ήχου του. Για να το επιτύχουμε αυτό, θα πρέπει να προσθέσουμε την 
παράμετρο controls στην ετικέτα. Στο αντικείμενο controls μπορεί να έχει και ένα όνομα, άρα να ενσωματω-
θεί στην ετικέτα με τη μορφή controls="ctrl_video1" ή κάποιο διαφορετικό όνομα. Γενικά, αποτελεί καλή 
πρακτική κάθε αντικείμενο να έχει κάποιο όνομα, ώστε να υπάρχει δυνατότητα να αναφερθούμε σε αυτό από 
άλλες εντολές μέσα στο αρχείο. Το αποτέλεσμα φαίνεται στην Εικόνα 12.3. 

 
<video id="video1" width="320" height="240" controls> 
 <source src="movie.mp4" type="video/mp4"> 
 <source src="movie.ogg" type="video/ogg"> 
 Your browser does not support the video tag. 
</video> 

 
Πίνακας 12.6 Παράδειγμα ενσωμάτωσης βίντεο σε σελίδα  μαζί με εμφάνιση των κουμπιών ελέγχου. 

 

 
 
Εικόνα 12.3 Ιστοσελίδα με βίντεο σε HTML5 και κουμπιά ελέγχου. 

 
Και πάλι η αναπαραγωγή του παραπάνω βίντεο έχει ένα πρόβλημα. Μπορούμε να το προβάλουμε σε 

ολόκληρη την οθόνη, γεγονός που σημαίνει ότι σε μια ολοκληρωμένη εφαρμογή, όπου περιέχονται και άλλα 
στοιχεία, δεν θα υπήρχε σωστή προβολή και χρήση τους. Το συγκεκριμένο παράδειγμα μπορεί να εμπλουτι-
στεί με χρήση και κώδικα JavaScript (Πίνακας 12.7) για την εμφάνιση κατάλληλων κουμπιών για την αναπα-
ραγωγή ή παύση του βίντεο. Η συσχέτιση του κώδικα σε HTML με τον κώδικα JavaScript γίνεται με την ε-
ντολή «var myVideo = document.getElementById("video1");», η οποία δέχεται το id του βίντεο. Το αποτέλε-
σμα του κώδικα είναι η εμφάνιση των κουμπιών ελέγχου κάτω από το βίντεο (Εικόνα 12.4) και η αύξηση ή 
μείωση του μεγέθους με πλήρη έλεγχο από τον κώδικα. 

 
<!DOCTYPE html>  
<html>  
<body>  
 
  <video id="video1" width="420"> 
  <source src=" movie.mp4" type="video/mp4"> 
  <source src=" movie.ogg" type="video/ogg"> 
     Your browser does not support HTML5 video. 
 </video> 
 
 <br><br> 
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 <button onclick="playPause()">Play/Pause</button>  
 <button onclick="makeBig()">Big</button> 
 <button onclick="makeSmall()">Small</button> 
 <button onclick="makeNormal()">Normal</button> 
 
 
 <script>  
  var myVideo = document.getElementById("video1");  
 
  function playPause() {  
   if (myVideo.paused)  
    myVideo.play();  
   else  
    myVideo.pause();  
  }  
 
  function makeBig() {  
   myVideo.width = 560;  
  }  
 
  function makeSmall() {  
   myVideo.width = 320;  
  }  
 
  function makeNormal() {  
   myVideo.width = 420;  
  }  
 </script>  
 
</body>  
</html> 

 
Πίνακας 12.7 Πρόσθεση συγκεκριμένων κουμπιών ελέγχου. 

 
 

 
 
Εικόνα 12.4 Προσθήκη κουμπιών ελέγχου με χρήση JavaScript. 

 
Στην περίπτωση που είναι διαθέσιμοι υπότιτλοι σε μία ή περισσότερες γλώσσες σε κάποιο ξεχωριστό 

αρχείο με προέκταση vtt, τότε μπορούμε να τους εμφανίζουμε με το βίντεο, κάνοντας χρήση της ετικέτας 
<track>. Στον Πίνακα 12.8 δίνουμε ένα ολοκληρωμένο παράδειγμα με χρήση υπότιτλων. Η ετικέτα <track>  
μπορεί να επαναληφθεί πολλές φορές, αν έχουμε διαφορετικούς υπότιτλους. Η ετικέτα περιέχει διάφορες ι-
διότητες, οι οποίες ορίζουν τη γλώσσα των υπότιτλων και το αντίστοιχο αρχείο. Στην Εικόνα 12.5 βλέπουμε 
πώς εμφανίζονται τα αντίστοιχα κουμπιά ελέγχου του βίντεο.  
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<!DOCTYPE html>  
<html>  
<body>  
 
<video id="video" controls preload> 
 <source src="movie.mp4" type="video/mp4"> 
 <source src="movie.webm" type="video/webm"> 
 
 <track label="English" kind="subtitles" srclang="en" src="video-subtitles-en.vtt" default> 
 <track label="Ελληνικά" kind="subtitles" srclang="el" src="video-subtitles-gr.vtt"> 
 Your browser does not support HTML5 video. 
</video> 
 
</body>  
</html> 

 
Πίνακας 12.8 Πρόσθεση υπότιτλων με την ετικέτα <track>. 

 

 
 
Εικόνα 12.5 Κουμπιά ελέγχου με το κουμπί CC για την εμφάνιση ή απόκρυψη των υπότιτλων. 

 
Πρέπει να σημειωθεί ότι σε όλα τα παραπάνω παραδείγματα, εαν η μορφή βίντεο δεν υποστηρίζεται 

σε κάποιον browser, τότε θα εμφανιστεί το μήνυμα «Your browser does not support HTML5 video», το οποίο 
προσθέτουμε στο τέλος της ετικέτας <video>. 

 

12.2.2. Η ετικέτα <audio> 
 

Η συγκεκριμένη ετικέτα χρησιμοποιείται για την ενσωμάτωση αρχείων ήχου σε μια ιστοσελίδα. Στον Πίνακα 
12.9 παραθέτουμε τις ιδιότητες της ετικέτας. Η παράμετρος src χρησιμοποιείται για να ορίσει το αρχείο ήχου. 
Μπορεί να υπάρχει μέσα στην ετικέτα ως <audio src="audio.mp3"> ή να υπάρχει στην ετικέτα <source 
src="audio.mp3">,  η οποία ενσωματώνεται ως υπο-πεδίο στην <audio>. 
 

Ιδιότητα (εν-
σωματωμένη ετικέτα 
ή παράμετρος) 

Περιγραφή 

autoplay H αναπαραγωγή του audio αρχίζει με την ολοκλήρωση της φόρτωσής του. 
controls Εμφανίζει τα κουμπιά ελέγχου στο audio (play, stop κ.λπ.).  
loop  Η αναπαραγωγή του audio επαναλαμβάνεται κάθε φορά που ολοκληρώνεται. 
preload Το audio θα φορτωθεί, αφού φορτωθεί η σελίδα. Αγνοείται, όταν υπάρχει η ιδιότητα 

autoplay. 
src  Είναι η πηγή (όνομα αρχείου ή url) του αρχείου. 

 
Πίνακας 12.9 Παράμετροι και ενσωματωμένες ετικέτες της ετικέτας <video>. 

 
Στον Πίνακα 12.9 παραθέτουμε κάποιο παράδειγμα χρήσης της ετικέτας και στην Εικόνα 12.6 εμφα-

νίζονται τα κουμπιά ελέγχου του ήχου. Στην ετικέτα <audio> έχει χρησιμοποιηθεί και η ιδιότητα controls, 
προκειμένου να εμφανιστούν τα κουμπιά ελέγχου. 

 
<audio controls> 
 <source src="audio.ogg" type="audio/ogg"> 
 <source src="audio.mp3" type="audio/mpeg"> 
 Your browser does not support the audio element. 
</audio>  

 
Πίνακας 12.10 Παράδειγμα ενσωμάτωσης ήχου σε σελίδα. 
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Με το στοιχείo <source> μπορούμε να ορίσουμε διαφορετικές μορφές για το αρχείο ήχου, οι οποίες 
θα αναπαραχθούν, στην περίπτωση που δεν μπορεί ο browser να αναπαράγει την αρχική μορφή. Στο παρά-
δειγμα του Πίνακα 12.10, αν δεν μπορεί να αναπαραχθεί η μορφή ogg, θα γίνει προσπάθεια αναπαραγωγής 
της μορφής mp3. Αν ο φυλλομετρητής είναι παλιός και δεν υποστηρίζει κανέναν από τους δύο τύπους, τότε 
θα εμφανιστεί το μήνυμα Your browser does not support the audio element. 
 

 
 
Εικόνα 12.6 Κουμπιά ελέγχου του αρχείου ήχου. 

 

12.2.3. Η ετικέτα <svg> 
 
Η συγκεκριμένη ετικέτα μάς βοηθά να σχεδιάσουμε κάποιο διανυσματικό γραφικό. Πρακτικά, πρέπει να 
γνωρίζουμε πώς να φτιάξουμε γραφικά svg, τα οποία, είναι κωδικοποιημένα σε XML, όπως αναφέραμε στο 
Κεφάλαιο 2. Στον Πίνακα 12.11 εμφανίζεται ένα αρχείο HTML με ενσωματωμένο κώδικα διανυσματικών 
γραφικών svg και στην Εικόνα 12.7 είναι το αποτέλεσμα. 

 
<!DOCTYPE html> 
<html> 
<body> 
 <svg width="100" height="100"> 
 <circle cx="50" cy="50" r="40" stroke="green" stroke-width="4" fill="yellow" /> 
 Sorry, your browser does not support inline SVG. 
 </svg> 
  
</body> 
</html> 

 
Πίνακας 12.11 Παράδειγμα ιστοσελίδας με διανυσματικό γραφικό. 
 

 
 
Εικόνα 12.7 Κύκλος που δημιουργήθηκε με τον κώδικα του Πίνακα 12.11. 

 
Στο παράδειγμα, που ακολουθεί (Πίνακας 12.12), χρησιμοποιούμε την ετικέτα <svg> σε συνδυασμό 

με την ετικέτα <style>, η οποία ορίζει ένα CSS μέσα στο ίδιο αρχείο. Η δημιουργία αρχείων svg μπορεί να 
γίνει με κάποιο πρόγραμμα διανυσματικών γραφικών, όπως το Inkscape που είδαμε στο Κεφάλαιο 8. Έπειτα 
μπορεί να ενσωματωθεί σε κάποιο αρχείο HTML5 (Εικόνα 12.8). 

 
<!DOCTYPE html> 
<html lang="en"> 
<head> 
<meta charset="UTF-8"> 
<title>Rotate and Render Text with HTML5 SVG</title> 
<style type="text/css"> 
 svg { 
  border: 1px solid black; 
 } 
</style> 
</head> 
<body> 
 <svg width="300" height="200"> 
  <text x="30" y="15" style="fill:purple; font-size:22px; transform:rotate(30deg);"> 
   <tspan style="fill:purple; font-size:22px;"> 
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   Welcome to Our Website! 
   </tspan> 
   <tspan dx="-230" dy="20" style="fill:navy; font-size:14px;"> 
                  Here you will find lots of useful information. 
   </tspan> 
          </text> 
 </svg> 
</body> 
</html>                                   

 
Πίνακας 12.12 Παράδειγμα σύνθετου γραφικού σε ιστοσελίδα. 

 

 
 
Εικόνα 12.8 Κύκλος που δημιουργήθηκε με τον κώδικα του Πίνακα 12.12. 

 

12.2.4. Η ετικέτα <canvas> 
 

Χρησιμοποιώντας την ετικέτα canvas, μπορούμε να εμφανίσουμε διάφορα γραφικά σε μια σελίδα, όπως δια-
γράμματα, κινούμενα γραφικά, γραφικές παραστάσεις και εικόνες, τα οποία είναι αποθηκευμένα σε διάφορα 
αρχεία. Η ετικέτα canvas ορίζει μια ορθογώνια περιοχή στη σελίδα. Η σχεδίαση των γραφικών γίνεται με 
χρήση εντολών, συνήθως στη JavaScript. Τα γραφικά μέσα στη συγκεκριμένη περιοχή, δημιουργούνται με 
την τεχνική pixel-based drawing API, σύμφωνα με την οποία η σχεδίαση των γραφικών γίνεται με τον ορισμό 
σημείων μέσα στην περιοχή. Μολονότι ακούγεται απλό και χωρίς πολλές δυνατότητες, εντούτοις με την ταυ-
τόχρονη χρήση της JavaScript, με την οποία σχεδιάζουμε γραφικά στην περιοχή canvas, μπορούμε να πετύ-
χουμε εντυπωσιακά αποτελέσματα. Στη συνέχεια παρουσιάζονται ορισμένες βασικές δυνατότητες του canvas. 

Στον Πίνακα 12.13 ορίζουμε μια περιοχή σχεδίασης 200x100 pixel με 1 pixel περίγραμμα χρώματος 
#c3c3c3. Η σχεδίαση γίνεται με χρήση εντολών στη JavaScript. Με την εντολή c.getContext("2d") δημιουρ-
γείται ένα αντικείμενο που παρέχει μεθόδους για τη σχεδίαση δισδιάστατων γραφικών. Στη συνέχεια σχεδιά-
ζεται ένα κόκκινο ορθογώνιο (Εικόνα 12.9). 

 
<!DOCTYPE html> 
<html> 
<body> 
 
<canvas id="myCanvas" width="200" height="100" style="border:1px solid #c3c3c3;"> 
Your browser does not support the HTML5 canvas tag. 
</canvas> 
 
<script> 
 var c = document.getElementById("myCanvas"); 
 var ctx = c.getContext("2d"); 
 ctx.fillStyle = "#FF0000"; 
 ctx.fillRect(0,0,150,75); 
</script> 
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</body> 
</html>                         
   

 
Πίνακας 12.13 Παράδειγμα δημιουργίας γραφικού με χρήση του canvas. 

 

 
 
Εικόνα 12.9 Σχήμα που δημιουργήθηκε με τον κώδικα του Πίνακα 12.13. 

 
Για τη δημιουργία πιο πολύπλοκων έργων απαιτούνται περισσότερο σύνθετες εντολές και στην 

HTML5, αλλά κυρίως στην JavaScript,  παράμετρος που ξεφεύγει από τα όρια του σκοπού αυτού του βιβλί-
ου, καθώς αφορά τεχνολογίες διαδικτύου. Στην εφαρμογή της Εικόνας 12.10, η οποία δημιουργήθηκε στο 
πλαίσιο μεταπτυχιακής εργασίας στο Ελληνικό Ανοικτό Πανεπιστήμιο και είχε σκοπό να παρουσιάσει με 
παιγνιώδη τρόπο πληροφορίες για ιστορικά μνημεία, έγινε ευρεία χρήση των δυνατοτήτων της HTML5. Προ-
στέθηκαν τα απαραίτητα animations μέσα στον canvas, και με τη βοήθεια πολλαπλών σεναρίων σε JavaScript 
προστέθηκε η απαραίτητη διαδραστικότητα. 

 

 
 
Εικόνα 12.10 Διαδραστική εφαρμογή σε HTML5. 

 

12.3. Γρήγορη ανάπτυξη εφαρμογών HTML5 
 
Η σταδιακή μετακίνηση προς την HTML5 οδήγησε στην εμφάνιση προτύπων ιστοσελίδων (template), που 
επιτρέπουν τη γρήγορη δημιουργία διαδικτυακών πολυμεσικών εφαρμογών με υψηλό βαθμό διαδραστικότη-
τας. Για παράδειγμα, στον δικτυακό τόπο http://www.freehtml5templates.com/ και 
http://www.zerotheme.com/demo/index.php?cat=full&temp=zArtSchool μπορούμε να εντοπίσουμε αρκετά 
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διαδραστικές πρότυπα, τα οποία μπορούμε να προσαρμόσουμε και να δημιουργήσουμε έτσι τις δικές μας ε-
φαρμογές. 

Επιπρόσθετα, υπάρχουν αρκετοί επεξεργαστές WYSIWYG, οι οποίοι υποστηρίζουν τη δημιουργία 
ιστοσελίδων σε HTML5. Παραδείγματα τέτοιων επεξεργαστών είναι οι Adobe Dreamweaver 
(http://www.adobe.com/products/dreamweaver.html), Aloha Editor (http://www.alohaeditor.org) και οι ανοι-
χτού κώδικα Maqetta (http://maqetta.org) και H5P (https://h5p.org).  

 

12.4. Ανακεφαλαίωση 
 
Στο τρέχον κεφάλαιο γίνεται μια εισαγωγή στην ανάπτυξη ιστοσελίδων με HTML. Παρουσιάζουμε τις ετικέ-
τες <video>, <audio>, <svg> και <canvas> της HTML5. Μέσα από παραδείγματα δείχνουμε κάποιες από 
τις νέες δυνατότητες της HTML5. Η HTML5 μπορεί να συνδυαστεί με την JavaScript και να παραχθούν ε-
φαρμογές πολλαπλών μέσων με υψηλή διάδραση. Όπως αναφέρθηκε και στο Κεφάλαιο 6, οι περισσότερες 
εφαρμογές αναπτύσσονται είτε προσαρμόζοντας πρότυπα ιστοσελίδων είτε με επεξεργαστές WYSIWYG και 
ολοκληρωμένα συστήματα διαχείρισης περιεχομένου, όπως το Joomla!. Είναι απαραίτητο βέβαια να έχουμε 
μια κατανόηση του τρόπου κωδικοποίησης της πληροφορίας, π.χ. με την HTML5, ώστε να αντιλαμβανόμα-
στε τη σχετική τεχνολογία και τις δυνατότητές της. 
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Ελληνο-αγγλικό γλωσσάριο όρων1 
Ελληνικός όρος Αγγλικός όρος 

Ακίδων Dot matrix 

Ακμή Edge 

Ακολουθητής λογισμικού Sequencer  

Ακουστικότητα Loudness  

Ακουστότητα Loudness  

Ακτινοβολία Radiation 

Αλληλεπιδραστικά πολυμέσα Interactive multimedia 

Αναλογικό βίντεο Analog video 

Ανάλυση Resolution 

Ανίχνευση ακτίνας Ray tracing 

Αντίστροφη τεχνική κινηματικής Inverse kinematics 

Απαιτήσεις χρήστη User requirements 

Απόσπαση αρχείων Ripping 

Απόσπασμα βίντεο Video clip  

Απόχρωση ή χροιά Hue 

Απωλεστική Lossy 

Αργή είσοδος και έξοδος Slow in and out 

Αριθμός καρέ Frames per second 

Αριθμός των πλαισίων ανά δευτερόλεπτο Frame rate 

Α-στάθμισης A-weighting 

Ασύμμετροι Asymmetrical 

Αφαιρετικό Subtractive 

Βάθος bit Bit depth 

Βάθος πεδίου Depth of field 

Βάθος χρώματος Color depth 

Βήμα κουκίδας Dot pitch 

Γραμμές ανά πλαίσιο Lines per frame 

Γραφικά πλέγματος Bitmap graphics 

Γραφικά πλέγματος Raster graphics 

Δείγμα Sample 

Δειγματοληψία Sampling 

Δεικτοδοτούμενο χρώμα Indexed color 

Δευτερεύουσα ενέργεια Secondary action 

Διαδραστικότητα ή interactivity 

Διακριτοποίηση Discretization 

Διανυσματικές Vector graphics 

Διαφάνεια Transparency 

Διαφορική παλμοκωδική κωδικοποίηση Differential pulse code modulation 

Διεπαφή χρήστη Interface 

Δυνητικοί χρήστες Target group 

                                                           
1 Το γλωσσάριο περιέχει όρους που χρησιμοποιήθηκαν στο κείμενο του παρόντος βιβλίου προκειμένου 

να καταγραφεί η αντιστοίχιση ελληνικών όρων με τους αγγλικούς που αποδίδουν την ίδια έννοια και 

χρησιμοποιούνται στη σχετική βιβλιογραφία και πρακτική. 
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Έδρα Face 

Εικονική πραγματικότητα Virtual reality 

Εικονογραφημένα σενάρια Storyboard 

Εικονοστοιχεία Pixels 

Εικονοστοιχεία Pixels (picture elements) 

ελκυστικότητα Appeal 

Εμβύθιση Immersion 

Ένταση Amplitude 

Επαυξημένη πραγματικότητα Augmented reality 

Επικαλυπτόμενη κίνηση Overlapping action 

Επίπεδα τμήματα Lands 

Επιταχυντής γραφικών Graphics accelerator 

Ευαισθησία Sensitivity 

Ευχρηστία Usability 

Εφαρμογές ψηφιακών μέσων Digital media 

Εφαρμογές ψηφιακών μέσων Digital media applications 

Ηχεία Speakers 

Ηχητικά κύματα Sound waves 

Ήχος Sound 

Ήχος κυματομορφών Wave audio 

Ηχόχρωμα Timbre 

Θάμπωμα κίνησης Motion blur 

Θεμελιώδη σχήματα Primitive 

Θερμική φυσαλίδα Bubble jet 

Θερμική φυσαλίδα Thermal bubble 

Καμπύλη τροχιά αντί γραμμικής κίνησης Arcs versus linear motion 

Κανάλι άλφα Alpha channel 

Κανάλια Channels 

Καρέ Frames 

Καρέ Frames 

Κάρτα ήχου Sound card 

Καταγραφή κίνησης  Motion capture 

Κατακόρυφη συχνότητα Vertical frequency 

Κβάντιση Quantization 

Κλίμακα χρωμάτων Color gamut 

Κοιλώματα Pits 

Κορεσμός Saturation 

Κορυφές ελέγχου Control vertices 

Κορυφή Vertex 

Κρουστικοί ή ακίδων Dot matrix 

Κυματομορφή Waveform 

Κωδικοποιητές Codecs 

Λογισμικό Software 

Λόγος αντίθεσης Contrast ratio 

Λόγος εικόνας Aspect ratio 

Λόγος πλευρών Aspect ratio 

Μέγεθος δείγματος Bit depth 
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Μέγεθος δείγματος Sample size 

Μη απωλεστική Lossless 

Μη συμμετρικοί Asymmetrical 

Μικρόφωνο Microphone 

Μοντελοποίηση 3Δ 3d modeling 

Μοντελοποίηση με πολύγωνα Polygon modeling 

Μπάσα Bass 

Οδηγοί εκμάθησης Tutorials 

Οθόνη Monitor 

Οθόνη οργανικών φωτοδιόδων Oled 

Οθόνη τεχνολογίας υγρών κρυστάλλων Liquid crystal display 

Ολοκλήρωση Follow through 

Ομαδοποίηση Grouping 

Πακέτο Container 

Παλμοκωδική κωδικοποίηση Pulse code modulation 

Πεπλεγμένη σάρωση Interlaced 

Περιβάλλουσα έντασης ήχου Sound envelope 

Πιεζοηλεκτρικού κρυστάλλου Piezoelectric crystals 

Πίεση ήχου Sound pressure  

Πλαίσια Frames 

Πλέγμα πολυγώνων Polygon mesh 

Πλοήγηση Navigation,  

Πολυμέσα Multimedia 

Πραγματικό βάθος χρώματος True color 

Πρίμα Tremble 

Προετοιμασία Anticipation 

Προοδευτική / μη πεπλεγμένη Progressive / non-interlaced 

Προσαρμογέας γραφικών Video adapter 

Προσαρμοστική διαφορική   
παλμοκωδική κωδικοποίηση 

Adaptive DPCM 

Πρόσθετα Plugins 

Προσθετικό μοντέλο Additive 

Πρόσθια τεχνική κινηματικής Forward kinematics 

Προσομοίωση κίνησης Animation 

Πρόσοψη ή έδρα Face 

Ρυθμός δειγματοληψίας Sampling rate 

Ρυθμός μεταφοράς bit Bit rate 

Ρυθμός μεταφοράς συμβόλων ανά δευτερό-
λεπτο 

Baud rate 

Σημεία ελέγχου Control Points 

Σκελετός Wireframe  

Σκηνοθεσία Staging 

Σκίαση Shading  

Σκιές Shadows 

Στερεοφωνικός Stereo 

Στερεοφωνικός Stereophonic 

Συγχρονισμός Timing and motion 
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Σύλληψη Capture 

Συμμετρική Symmetrical 

Συμπίεση Compression  

Συμπίεση και άπλωμα Squash and stretch 

Σύνδεσμος Links 

Συνεχής ροή δεδομένων ήχου Streaming audio 

Συνεχής ροή δεδομένων πολυμεσικού χαρα-
κτήρα 

Streaming media 

Συσκευή ημιαγωγών Complimentary metal oxide semiconductor 

Συσκευή σύζευξης φορτίου Charge-coupled device 

Σύστημα σωματιδίων Particle system  

Συχνότητα Frequency 

Συχνότητα δειγματοληψίας Sampling rate 

Συχνότητα πλαισίων Frame frequency  

Σχεδιογράφοι Plotters 

Σχεδιοκίνηση Animation  

Σχεδιοκίνηση με κυψέλες Cel animation 

Σχεδιοκίνηση με παράθεση πλαισίων και κα-
θορισμός τροχιάς 

Path animation 

Σωλήνων καθοδικών ακτίνων Cathode ray tube  

Τρεμόπαιγμα Flickering 

Τρεμόπαιγμα Flickering 

Τρισδιάστατα γραφικά 3D graphics 

Υλικό Material  

Υπερβολή Exaggeration 

Υπέρηχοι Ultrasounds 

Υπερ-κείμενα Hypertext 

Υπερμέσα Hypermedia 

Υπέρ-συνδέσμων Hyperlinks 

Υπόηχοι Infrasounds 

Υπολογιστή εξυπηρετητή Streaming audio server 

Υφή Texture 

Ύψος Pitch  

Φάσμα συχνοτήτων Spectral view 

Φασματική απόκριση Frequency response 

Φασματική καμπύλη Color spectrum 

Φωτεινότητα Brightness 

Φωτεινότητα Luminance  

Χάρτης πλοήγησης Navigation map 

Χαρτογράφηση υφής Texture mapping 

Χαρτογραφικές εικόνες Bitmap images 

Χροιά Timbre  

Χρονική συμπίεση Temporal compression  

Χρωματική ανάλυση Color resolution 

Χρωματική καθαρότητα Saturation 

Χρωματική πληροφορία Chrominance 

Χρωματικό μοντέλο Color model 
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Χρωματικός τροχός Color wheel 

Χρωματικών μοντέλων Color models 

Χωρική ανάλυση Spatial resolution  

Χωρική συμπίεση Spatial compression 

Ψεκασμού μελάνης Inkjet  

Ψηφιακή διασύνδεση μουσικών οργάνων Musical instrument digital interface 

Ψηφιακός ήχος Digital audio 

Ψηφιογραφικές εικόνες Bitmap images 

Ψηφιοποίηση Digitization 
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Άγγλο-ελληνικό γλωσσάριο όρων 
Αγγλικός όρος Ελληνικός όρος 

3D graphics Τρισδιάστατα γραφικά 

3d modeling Μοντελοποίηση 3Δ 

Adaptive DPCM Προσαρμοστική διαφορική παλμοκωδική 
κωδικοποίηση 

Additive Προσθετικό μοντέλο 

Alpha channel Κανάλι άλφα 

Amplitude Ένταση 

Analog video Αναλογικό βίντεο 

Animation Προσομοίωση κίνησης 

Animation  Σχεδιοκίνηση 

Anticipation Προετοιμασία 

Appeal ελκυστικότητα 

Arcs versus linear motion Καμπύλη τροχιά αντί γραμμικής κίνησης 

Aspect ratio Λόγος εικόνας 

Aspect ratio Λόγος πλευρών 

Asymmetrical Ασύμμετροι 

Asymmetrical Μη συμμετρικοί 

Augmented reality Επαυξημένη πραγματικότητα 

A-weighting Α-στάθμισης 

Bass Μπάσα 

Baud rate Ρυθμός μεταφοράς συμβόλων ανά δευτερό-
λεπτο 

Bit depth Βάθος bit 

Bit depth Μέγεθος δείγματος 

Bit rate Ρυθμός μεταφοράς bit 

Bitmap graphics Γραφικά πλέγματος 

Bitmap images Χαρτογραφικές εικόνες 

Bitmap images Ψηφιογραφικές εικόνες 

Brightness Φωτεινότητα 

Bubble jet Θερμική φυσαλίδα 

Capture Σύλληψη 

Cathode ray tube  Σωλήνων καθοδικών ακτίνων 

Cel animation Σχεδιοκίνηση με κυψέλες 

Channels Κανάλια 

Charge-coupled device Συσκευή σύζευξης φορτίου 

Chrominance Χρωματική πληροφορία 

Codecs Κωδικοποιητές 

Color depth Βάθος χρώματος 

Color gamut Κλίμακα χρωμάτων 

Color model Χρωματικό μοντέλο 

Color models Χρωματικών μοντέλων 

Color resolution Χρωματική ανάλυση 

Color spectrum Φασματική καμπύλη 

Color wheel Χρωματικός τροχός 
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Complimentary metal oxide semiconductor Συσκευή ημιαγωγών 

Compression  Συμπίεση 

Container Πακέτο 

Contrast ratio Λόγος αντίθεσης 

Control Points Σημεία ελέγχου 

Control vertices Κορυφές ελέγχου 

Depth of field Βάθος πεδίου 

Differential pulse code modulation Διαφορική παλμοκωδική κωδικοποίηση 

Digital audio Ψηφιακός ήχος 

Digital media Εφαρμογές ψηφιακών μέσων 

Digital media applications Εφαρμογές ψηφιακών μέσων 

Digitization Ψηφιοποίηση 

Discretization Διακριτοποίηση 

Dot matrix Ακίδων 

Dot matrix Κρουστικοί ή ακίδων 

Dot pitch Βήμα κουκίδας 

Edge Ακμή 

Exaggeration Υπερβολή 

Face Έδρα 

Face Πρόσοψη ή έδρα 

Flickering Τρεμόπαιγμα 

Flickering Τρεμόπαιγμα 

Follow through Ολοκλήρωση 

Forward kinematics Πρόσθια τεχνική κινηματικής 

Frame frequency  Συχνότητα πλαισίων 

Frame rate Αριθμός των πλαισίων ανά δευτερόλεπτο 

Frames Καρέ 

Frames Καρέ 

Frames Πλαίσια 

Frames per second Αριθμός καρέ 

Frequency Συχνότητα 

Frequency response Φασματική απόκριση 

Graphics accelerator Επιταχυντής γραφικών 

Grouping Ομαδοποίηση 

Hue Απόχρωση ή χροιά 

Hyperlinks Υπέρ-συνδέσμων 

Hypermedia Υπερμέσα 

Hypertext Υπερ-κείμενα 

Immersion Εμβύθιση 

Indexed color Δεικτοδοτούμενο χρώμα 

Infrasounds Υπόηχοι 

Inkjet  Ψεκασμού μελάνης 

Interactive multimedia Αλληλεπιδραστικά πολυμέσα 

interactivity Διαδραστικότητα ή 

Interface Διεπαφή χρήστη 

Interlaced Πεπλεγμένη σάρωση 

Inverse kinematics Αντίστροφη τεχνική κινηματικής 
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Lands Επίπεδα τμήματα 

Lines per frame Γραμμές ανά πλαίσιο 

Links Σύνδεσμος 

Liquid crystal display Οθόνη τεχνολογίας υγρών κρυστάλλων 

Lossless Μη απωλεστική 

Lossy Απωλεστική 

Loudness  Ακουστικότητα 

Loudness  Ακουστότητα 

Luminance  Φωτεινότητα 

Material  Υλικό 

Microphone Μικρόφωνο 

Monitor Οθόνη 

Motion blur Θάμπωμα κίνησης 

Motion capture Καταγραφή κίνησης  

Multimedia Πολυμέσα 

Musical instrument digital interface Ψηφιακή διασύνδεση μουσικών οργάνων 

Navigation map Χάρτης πλοήγησης 

Navigation,  Πλοήγηση 

Oled Οθόνη οργανικών φωτοδιόδων 

Overlapping action Επικαλυπτόμενη κίνηση 

Particle system  Σύστημα σωματιδίων 

Path animation Σχεδιοκίνηση με παράθεση πλαισίων και κα-
θορισμός τροχιάς 

Piezoelectric crystals Πιεζοηλεκτρικού κρυστάλλου 

Pitch  Ύψος 

Pits Κοιλώματα 

Pixels Εικονοστοιχεία 

Pixels (picture elements) Εικονοστοιχεία 

Plotters Σχεδιογράφοι 

Plugins Πρόσθετα 

Polygon mesh Πλέγμα πολυγώνων 

Polygon modeling Μοντελοποίηση με πολύγωνα 

Primitive Θεμελιώδη σχήματα 

Progressive / non-interlaced Προοδευτική / μη πεπλεγμένη 

Pulse code modulation Παλμοκωδική κωδικοποίηση 

Quantization Κβάντιση 

Radiation Ακτινοβολία 

Raster graphics Γραφικά πλέγματος 

Ray tracing Ανίχνευση ακτίνας 

Resolution Ανάλυση 

Ripping Απόσπαση αρχείων 

Sample Δείγμα 

Sample size Μέγεθος δείγματος 

Sampling Δειγματοληψία 

Sampling rate Ρυθμός δειγματοληψίας 

Sampling rate Συχνότητα δειγματοληψίας 

Saturation Κορεσμός 
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Saturation Χρωματική καθαρότητα 

Secondary action Δευτερεύουσα ενέργεια 

Sensitivity Ευαισθησία 

Sequencer  Ακολουθητής λογισμικού 

Shading  Σκίαση 

Shadows Σκιές 

Slow in and out Αργή είσοδος και έξοδος 

Software Λογισμικό 

Sound Ήχος 

Sound card Κάρτα ήχου 

Sound envelope Περιβάλλουσα έντασης ήχου 

Sound pressure  Πίεση ήχου 

Sound waves Ηχητικά κύματα 

Spatial compression Χωρική συμπίεση 

Spatial resolution  Χωρική ανάλυση 

Speakers Ηχεία 

Spectral view Φάσμα συχνοτήτων 

Squash and stretch Συμπίεση και άπλωμα 

Staging Σκηνοθεσία 

Stereo Στερεοφωνικός 

Stereophonic Στερεοφωνικός 

Storyboard Εικονογραφημένα σενάρια 

Streaming audio Συνεχής ροή δεδομένων ήχου 

Streaming audio server Υπολογιστή εξυπηρετητή 

Streaming media Συνεχής ροή δεδομένων πολυμεσικού χαρα-
κτήρα 

Subtractive Αφαιρετικό 

Symmetrical Συμμετρική 

Target group Δυνητικοί χρήστες 

Temporal compression  Χρονική συμπίεση 

Texture Υφή 

Texture mapping Χαρτογράφηση υφής 

Thermal bubble Θερμική φυσαλίδα 

Timbre Ηχόχρωμα 

Timbre  Χροιά 

Timing and motion Συγχρονισμός 

Transparency Διαφάνεια 

Tremble Πρίμα 

True color Πραγματικό βάθος χρώματος 

Tutorials Οδηγοί εκμάθησης 

Ultrasounds Υπέρηχοι 

Usability Ευχρηστία 

User requirements Απαιτήσεις χρήστη 

Vector graphics Διανυσματικές 

Vertex Κορυφή 

Vertical frequency Κατακόρυφη συχνότητα 

Video adapter Προσαρμογέας γραφικών 
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Video clip  Απόσπασμα βίντεο 

Virtual reality Εικονική πραγματικότητα 

Wave audio Ήχος κυματομορφών 

Waveform Κυματομορφή 

Wireframe  Σκελετός 

 
  
 

 
 
 
  



301 
 

Ευρετήριο Ελληνικών Όρων 
 

Ακμή, 111 

Ακουστικότητα, 79 
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Άμεσο φως, 29 

Αναλογικό βίντεο, 132 
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Αριθμός καναλιών, 82 

Αριθμός καρέ, 133 

Αριθμός των πλαισίων ανά δευτερόλεπτο, 129 

Ασύμμετροι, 138 

Αφαιρετικό χρωματικό μοντέλο, 31 

Βάθος πεδίου, 107, 125 

Βάθος χρώματος (βίντεο), 130 

Βάθος χρώματος (εικόνα), 26 

Βαρύς ήχος, 79 

Βήμα κουκίδας, 68 

Γλώσσες προγραμματισμού ήχου, 88 

Γραμμές ανά πλαίσιο, 133 

Γωνία θέασης, 68 

Δείγματα, 24, 80 

Δειγματοληψία, 24, 80 

Δεικτοδοτούμενο χρώμα, 39 

Διαδραστικότητα, 17 

Διακριτοποίηση, 24 

Διανυσματικά γραφικά, 54 

Διαπλοκή, 45 

Διαφάνεια, 40 

Διτονικές, 27 

Δυαδικές, 27 

Δυναμικό πεδίο, 63 

Δυναμικό πηνίο, 101 

Έδρα, 111 

Εικονική πραγματικότητα, 126 

Εικονογραφημένα σενάρια, 156 

Εικονοστοιχεία, 23 

Εκτυπωτής Laser, 71 

Εκτυπωτής ακίδων, 70 

Εκτυπωτής ψεκασμού μελάνης, 70 

Ένταση, 77 

Επαυξημένη πραγματικότητα, 126 

Επίπεδα, 46 

Επίπεδος σαρωτής, 61 

Εργαλεία επεξεργασίας ήχου, 95 

Ευαισθησία, 101 

Ευχρηστία, 158 

Εφαρμογές ψηφιακών μέσων, 17 

Ηχεία, 103 

Ηχόχρωμα, 79 

Θάμπωμα κίνησης, 125 

Θερμική φυσαλίδα, 71 

Θεώρημα Nyquist, 81 

Ιστόγραμμα εικόνας, 43, 44 

Κανάλι Άλφα, 42 

Κανάλια εικόνας, 41 

Καρέ, 129 

Κάρτα γραφικών, 65 

Κάρτα ήχου, 102 

Κάρτας, 159 

Κατακόρυφη συχνότητα, 133 

Κβάντιση, 80 

Κινηματική, 123 

Κίνηση στον χώρο, 122 

Κλίμακα χρωμάτων, 37 

Κοιλώματα, 150 

Κορεσμός, 33, 182 

Κορυφή, 111 

Κύκλος ζωής λογισμικού, 154 

Κύμα (ηχητικό), 76 

Κυματομορφή, 76, 80 
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Κωδικοποίηση χρώματος (βίντεο), 133 

Κωδικοποίηση, 83 

Κωδικοποιητές, 137 

Λογισμικό animation, 127 

Λόγος αντίθεσης, 68 

Λόγος εικόνας, 133 

Λόγος πλευρών, 131 

Μέγεθος ασυμπίεστου βίντεο, 137 

Μέγεθος δείγματος, 81 

Μέγεθος ήχου, 82 

Μέσος ήχος, 79 

Μη απωλεστική συμπίεση, 42, 137 

Μη πεπλεγμένη σάρωση, 132 

Μη συμμετρικοί αλγόριθμοι συμπίεσης, 138 

Μηχανική ενέργεια, 76 

Μικρόφωνο, 101 

Μονοφωνικός, 81 

Μονόχρωμες, 27 

Μοντέλο καταρράκτη, 155 

Μοντελοποίηση 3Δ, 108 

Μορφές αποθήκευσης, 89 

Μορφοποιήσεις αρχείων γραφικών 3Δ, 118 

Μορφότυπο, 39, 43 

Μουσικό κείμενο, 100 

Μπάσα, 79 

Ξάκρισμα, 52 

Οθόνη 

LED, 68 

OLED, 69 

Καθοδικού σωλήνα, 67 

Πλάσματος, 70 

Υγρών κρυστάλλων, 67 

Περιβάλλουσα έντασης ήχου, 87 

Οξύς ήχος, 79 

Παρεμβολή, 62 

Πεπλεγμένη, 132 

Περικοπή, 52 

Πιεζοηλεκτρικοί κρυστάλλοι, 71, 101 

Πλαίσια, 129 

Πλάτος, 77 

Πλέγμα πολυγώνων, 111 

Πλοήγηση, 18 

Πολυμέσα (ορισμός), 17 

Πολυφωνικός, 81 

Πραγματικό βάθος χρώματος, 28 

Προοδευτική, 132 

Προσθετικό χρωματικό μοντέλο, 29 

Προσομοιώσεις κίνησης, 120 

Πρόσοψη, 111 

Πυκνωτή, 101 

Ρεαλιστική απόδοση, 114 

Ροής χρόνου, 159 

Ρυθμός δειγματοληψίας, 80 

Ρυθμός μετάδοσης, 83 

Ρυθμός μεταφοράς bit, 131 

Ρυθμός μεταφοράς συμβόλων, 83 

Ρυθμός μεταφοράς, 83, 137 

Σαρωτής 

Βιβλίων, 61 

Τροφοδοσίας φύλλου, 61 

Τυμπάνου, 61 

Χειρός, 61 

Σελίδας (εργαλείο πολυμέσων), 159 

Σημείο-προς-σημείο (μοντελοποίηση), 112 

Σκελετός (wireframe), 108 

Σκιά, 110, 116 

Σκίαση, 109, 116 

Στερεοφωνικός, 81 

Σύλληψη βίντεο, 147 

Συμπίεση, 83 

Συμπίεση βίντεο, 137 

Συμμετρική, 138 

Σύνδεσμος, 18 

Συνθετητής λογισμικού, 101 

Συσκευή σύζευξης φορτίου, 61 

Σύστημα σωματιδίων, 125 

Συστήματα διαχείρισης μάθησης, 161 

Συστήματα διαχείρισης περιεχομένου, 160 

Συχνότητα δειγματοληψίας, 80 

Συχνότητα πλαισίων, 131 
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Συχνότητα ήχου, 77 

Σχεδιογράφος, 70 

Σχεδιοκίνηση, 120 

Με κυψέλες, 122 

Με παράθεση πλαισίων, 122 

Ταινιοειδή, 101 

Ταλάντωση, 76 

Τόνερ, 71 

Τρισδιάστατη μοντελοποίηση, 110 

Υπέρηχος, 77 

Υπερ-κείμενα, 18 

Υπερμέσα, 18 

Υπέρ-σύνδεσμος, 18 

Υπόηχος, 77 

Ύψος, 79 

Φάσμα συχνοτήτων, 87 

Φάσμα χρωμάτων, 37 

Φασματική απόκριση, 101 

Φασματική καμπύλη, 37 

Φορμά, 39, 43 

Φωτεινότητα, 33, 68, 182 

Χάρτης πλοήγησης, 156 

Χαρτογράφηση υφής, 114 

Χαρτογραφική εικόνα, 38 

Χροιά, 33, 79, 182 

Χρονική συμπίεση, 138 

Χρόνος απόκρισης, 68 

Χρωματικά μοντέλα, 28 

Χρωματική ανάλυση, 130 

Χρωματική καθαρότητα, 33, 182 

Χρωματικός τροχός, 33 

Χωρική συμπίεση, 138 

Ψηφιακά μέσα, 17 

Ψηφιακή φωτογραφική μηχανή, 63 

Ψηφιακή μουσική, 99 

Ψηφιογραφικές, 38 

Ψηφιοποίηση, 23, 80, 101, 104, 105 

Ψυχοακουστική, 85 
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3d modeling, 108, 110 

3ds Max, 118, 247 

Animation, 251 

Viewports, 247 

Βασικά αντικείμενα, 248 

Επεξεργασία μορφής σχήματος, 249 

Προσθήκη υφής, 250 

3GPP, 143 

576i, 131 

AC3, 82 

Active-Matrix Organic Light Emitting Diode, 70 

ADC, 24 

ADDIE, 155 

Additive color model, 29 

Adobe Audition, 96, 229 

Fade-in, 233 

Fade-out, 233 

Αναπαραγωγή ήχου, 230 

Αφαίρεση θορύβου, 235 

Διαχωρισμός μουσικής από ομιλία, 234 

Εγγραφή φωνής, 232 

Εξαγωγή αρχείων ήχου από CD, 231 

Επεξεργασία μεμονωμένων καναλιών, 237 

Εφέ ηχούς, 235 

Μαζική επεξεργασία αρχείων, 231 

Μίξη μουσικής με ομιλία, 238 

Μίξη πολλαπλών αρχείων ήχου, 238 

Τύποι αρχείων, 229 

Adobe llustrator, 59, 205 

3Δ κείμενο, 211 

Grouping, 209 

Βούρτσες, 215 

Δημιουργία σύνθετων σχημάτων, 216 

Δημιουργία σχημάτων, 207 

Εφέ κειμένου, 210 

Κείμενο με εικόνες, 214 

Νέο έργο, 207 

Συνδυασμός σχημάτων, 209 

Adobe Photoshop Elements, 49 

Adobe Photoshop Express, 49 

Adobe Photoshop Lightroom, 49 

Adobe Photoshop, 47, 165 

Crop, 170 

Layers, 176 

Αλλαγή ανάλυσης, 171 

Αλλαγή κλίμακας, 175 

Αλλαγή μεγέθους, 171 

Ανάλυση, 169 

Αντικατάσταση συγκεκριμένων χρωμάτων, 182 

Αφαίρεση ρυτίδων, 191 

Αφαίρεση στιγμάτων, 191 

Δημιουργία σχεδίων με βούρτσες, 188 

Διαγραφή υπόβαθρου, 186 

Διαφάνεια, 174 

Επιλογή, 170 

Επίπεδα, 176 

Παραμόρφωση εικόνας, 175 

Περικοπή, 170 

Περιστροφή εικόνας, 175 

Προσαρμογή φωτεινότητας, 178 

Φίλτρα, 184 

Χρωματικές διορθώσεις, 179 

Χρωματικές προσαρμογές, 171 

Adobe Premiere Pro, 146, 265 

Αλλαγή χρονικής διάρκειας, 270 

Εισαγωγή μέσων, 266 

Εφέ μετάβασης, 270 

Ήχος, 268 

Περικοπή τμημάτων, 269 

Τίτλος έναρξης, 267 

Adobe RGB, 37 

ADPCM, 83 

AI, 59 

AIFF, 90 

A-Law PCM, 83 

Alpha channel, 42 
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AMOLED, 70 

Analog video, 132 

Animated GIF, 45, 50 

Animation, 120 

Anti-aliasing, 56 

ARML, 127 

Aspect ratio, 131, 133 

Asymmetrical, 138 

AU, 90 

Audacity, 95, 239 

Fade-in, 242 

Fade-out, 242 

Αλλαγή έντασης, 242 

Αφαίρεση θορύβου, 243 

Αφαίρεση φωνής από τη μουσική, 242 

Βασικές λειτουργίες, 240 

Εγγραφή φωνής, 241 

Επεξεργασία ήχου, 241 

Μίξη αρχείων ήχου, 243 

Φίλτρα, 242 

Augmented Reality Markup Language, 127 

Augmented reality, 126 

Autodesk Maya, 118 

Avi, 141 

Avidemux, 147, 271 

Βασικές λειτουργίες, 272 

Κωδικοποιητές, 274 

Συνένωση αρχείων, 274 

Φίλτρα, 275 

A-weighting, 79 

Basic MIDI, 97 

Baud rate, 83 

Beam tracing, 117 

Betamax, 135 

Bevel, 112 

Bit depth, 81 

Bit rate, 83, 131 

Bitmap εικόνες, 38 

Blender 117, 252 

Animation, 263 

Εξαγωγή αντικειμένων, 255 

Μετακίνηση, 258 

Περιστροφή, 258 

Μεταβολή μεγέθους, 258 

Μετασχηματισμοί αντικειμένων, 260 

Παράθυρο 3D προβολής, 254 

Τρισδιάστατος χώρος, 254 

Yλικό, 260 

Υφή αντικειμένων, 260 

Blu-ray, 150 

BMP, 43 

Brightness, 33 

Bubble jet, 71 

Bump mapping, 115 

Bush Vannevar, 18 

CakeWalk Sonar, 101 

Capture, 136 

CBR, 83, 131 

CCD, 61, 63 

CD, 85 

CDR, 58 

cdt, 58 

cdx, 58 

cel animation, 122 

CGI, 122 

Chamfer, 112 

CIE 1931 XYZ, 36 

CIE Lab, 36 

CIE Luv, 37 

CIS, 62 

CMOS, 63 

CMS, 160 

cmx, 58 

CMY, 31 

CMYK, 32 

Codecs, 84 

Coder, 84 

Color depth (video), 130 

Color depth, 26 

Color gamut, 37 
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Color resolution, 130 

Color spectrum, 37 

Component, 133 

Composite, 133 

Compression, 84 

Computer animation, 122 

Computer Generated Imagery, 122 

Constant Bit Rate, 83, 131 

Content Management Systems, 160 

Contrast ratio, 68 

Corel PaintShop Photo Pro, 50 

Corel Photo-PAINT, 49 

CorelDraw, 59 

CPT, 46, 49 

Cropping, 52 

CRT, 67 

CSound, 89 

CSS, 280 

Cubase, 101 

DAC, 24 

Decibel, 78 

Decoder, 84 

Decompression, 84 

Deep color, 28 

Depth of field, 107, 125 

Digea, 131 

Digital Rights Management, 143 

Digital Theater Systems, 82 

Digital VHS, 134 

Digital8, 135 

Digitization, 23 

DirectX, 67 

Discretization, 24 

Displacement mapping, 115 

Dithering, 42 

DivX, 140 

Dolby Digital, 82, 103 

Dolby Surround, 82 

Dot pitch, 68 

DPCM, 83 

DRM, 143 

DTS, 82, 103 

DVD, 85, 149 

D-VHS, 134 

DVI, 65 

Edge, 111 

EMF, 58 

EMF+, 58 

emitter, 125 

EMZ, 58 

environmental mapping, 115 

EPS, 58 

Extended MIDI, 98 

Extensible Music Format, 99 

Face, 111 

FLAC, 90 

Flickering, 122 

FLV, 143 

Focal point, 107 

Forward kinematics, 123 

fps, 129 

Frame frequency, 131 

Frame rate, 129 

Frames per second, 129, 133 

Frames, 129 

Frequency response, 101 

Frequency, 77 

Front Out, 103 

Full HD, 130 

Full High Definition, 130 

General MIDI, 98 

GIF, 40, 45 

GIF87a, 45 

GIF89a, 45 

GIMP, 50, 190 

Layers, 199 

Αλλαγή αποχρώσεων, 198 

Αλλαγή κορεσμού, 198 

Αλλαγή μεγέθους, 195 

Ανάλυση εικόνας, 195 
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Βασικές επεξεργασίες, 193 

Διαχωρισμός αντικειμένου, 200 

Διόρθωση εικόνων, 202 

Επιλογή τμημάτων εικόνας, 194 

Μετασχηματισμοί εικόνας, 195 

Περικοπή, 195 

Φίλτρα, 198 

Φωτεινότητα, 197 

Χρωματικές προσαρμογές, 196 

GM-1, 98 

GPU, 65 

Graphics Processing Unit, 65 

H.264, 140 

H.265, 140 

HD Photo, 45 

HDMI, 65, 135 

Hertz (συχνότητα), 77 

Hi8, 135 

High definition analogue video tape, 134 

High-Definition Multimedia Interface, 135 

HLS, 35 

HSB, 33 

HSI, 35 

HSL, 35 

HSV, 33 

HTML, 279 

Βασικές ετικέτες, 279 

Εξέλιξη, 281 

HTML5, 162, 282 

Ανάπτυξη εφαρμογών, 288 

Ετικέτα <audio>, 285 

Ετικέτα <canvas>, 287 

Ετικέτα <svg>, 286 

Ετικέτα <video>, 282 

Hue, 33, 35 

Hyperlink, 18 

Hypermedia, 18 

Hypertext, 18 

ICO, 46 

I-frame, 138 

Image channels, 41 

Image format, 39 

Indexed color, 39 

Inkjet, 71 

Inkscape, 60, 218 

Βούρτσες, 221 

Δημιουργία βασικών σχημάτων, 219 

Δημιουργία σύνθετων σχημάτων, 223 

Επεκτάσεις, 223 

Εφέ κειμένου, 222 

Συνδυασμός σχημάτων, 220 

Intensity, 35, 77 

Interactivity, 17 

Inter-frame, 138 

Interlaced, 132 

Interlacing, 45 

Interpolation, 62 

Intra-frame, 138 

Inverse kinematics, 123 

ISIS, 63 

JavaScript, 281 

JBIG2, 42 

JFIF, 44 

JND, 79 

Joomla, 160 

JPEG LS, 45 

JPEG XR, 45 

JPEG, 42, 44 

JPEG2000, 44 

Key poses, 123 

Keyframes, 122 

Kinematics, 123 

LAME MP3, 91 

Lands, 150 

Lanier, Jaron, 126 

Lasseter, John Alan, 120 

Βασικές αρχές σχεδιοκίνησης, 120 

Layers, 46, 199 

LCD, 67 

Learning Management Systems, 161 
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Lempel-Ziv Welch, 42 

Lightness, 35 

Line In, 103 

Line Out, 103 

Link, 18 

LMS, 161 

Lossless, 42 

Lossy, 42 

Loudness, 79 

LPC, 83 

LZW, 42, 45 

Mel, 79 

Mic In, 103 

Microphone, 101 

Microsoft Office Picture Manager, 47 

MIDI IN, 98 

MIDI message, 97 

MIDI OUT, 98 

MIDI THRU, 98 

midrange, 104 

M-JPEG, 138 

MKV, 142 

MoCap, 124 

Monitor, 67 

Monophonic, 81 

Motion blur, 125 

Motion capture, 124 

Motion JPEG, 138 

Motion Picture Expert Group, 138 

Megapixel(s), 63 

MP, 63 

Mpix, 63 

Mpx, 63 

MP3, 91 

MP4, 142 

MPEG AAC, 91 

MPEG codecs, 138 

MPEG, 91, 138 

MPEG-1, 138 

MPEG-2, 139 

MPEG-21, 140 

MPEG-4 ALS, 92 

MPEG-4, 139 

MPEG-7, 140 

Mu-Law PCM, 83 

Music notation, 100 

MusicXML, 98 

National Television Standards Committee, 133 

Navigation map, 156 

Navigation, 18 

Non-interlaced, 132 

Non-Uniform Rational B-Spline, 110, 113 

Normal bumping, 115 

NTSC, 133 

NURBS, 110, 113 

Nyquist, 81 

Ogg Vorbis, 92 

OpenGL ES, 57 

OpenGL, 57, 67 

OpenVG, 57 

PAL, 133 

Particle system, 125 

Path animation, 122 

PCM, 83, 89 

PDP, 70 

P-frame, 139 

Phase Alternate Line, 133 

Phon, 79 

PICT, 46 

Picture element, 23 

Piezoelectric crystals, 71 

Pinnacle Studio, 146 

Pits, 150 

Pixel pitch, 68 

Pixels, 23 

PNG, 40, 45 

Point-to-point, 112 

Polygon mesh, 111 

Pose-based, 123 

ppi, 25 
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Primitive, 111 

Procedural texturing, 116 

Progressive, 132 

PSD, 42, 46 

PSP, 46 

PSPBRUSH, 46 

PSPFRAME, 46 

PSPIMAGE, 46 

Psychoacoustics, 85 

QTFF, 142 

Quantization, 24, 80 

Radiosity, 116 

RAMDAC, 66 

RAW, 64 

Ray tracing, 116 

RealAudio, 92 

Reflectance mapping, 115 

Rendering, 113 

Resampling, 52 

Resolution, 81 

RGB, 29 

RGBA, 42, 45 

RLE, 43 

RYB, 30 

Sample rate conversion, 87 

Sample size, 81 

Samples, 24, 80 

Sampling rate, 80 

Sampling, 24, 80 

SAOL, 89 

SASL, 89 

Saturation, 33, 35 

Scorewriter, 100 

SECAM, 133 

Sensitivity, 101 

Sequentiel Coleur A Memoire, 133 

SGI, 46 

Shading, 109, 116 

Shadows, 110, 116 

Sonar, 101 

Sound card, 102 

Sound editing, 95 

Sound envelope, 87 

SoundForge, 96 

Spatial compression, 138 

Speakers, 103 

Spectral view, 87 

Sprite animation, 122 

sRGB, 37 

Standard Definition, 131 

Standard RGB, 37 

Stereophonic, 81 

Storyboard, 156 

Structured Audio Orchestra Language, 89 

Structured Audio Score Language, 89 

Subtractive color model, 31 

Super VHS, 134 

S-VHS, 134 

SVG, 57 

Symmetrical, 138 

Target group, 155 

Temporal compression, 138 

Texture mapping, 114 

TFT, 67 

Thermal bubble, 71 

TIFF, 42, 45 

Timbre, 79 

Time based, 159 

Tracing εικόνων bitmap, 54 

Transparency, 40 

True color, 28 

TWAIN, 63 

Tweeter, 104 

UHD, 130 

Ultra High Definition, 130 

Usability, 158 

User requirements, 155 

Variable Bit Rate, 83, 131 

VBR, 83, 131 

Vector graphics, 54 
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Vertex, 111 

VGA, 65 

VHS, 134 

Video Home System, 134 

Video resolution, 130 

Video8, 135 

Virtual Reality, 126 

Vorbis, 92 

VR, 126 

WAV, 89 

WebM, 143 

Wireframe, 108 

WMA, 90 

WMF, 58 

WMV, 143 

WMZ, 58 

Woofer, 104 

W-VHS, 134 

XMF, 99 

XML, 57, 286 

XviD, 140 

Y/C, 133 

YCBCR, 133 

YIQ, 133 

YPBPR, 133 

YUV, 133 

 

 
 
 
 
 
 


